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Info sulla guida per l'utente

Grazie per aver scelto questo prodotto LG. Per garantire un uso sicuro e corretto
del dispositivo, si prega di leggere con attenzione la guida per l'utente prima di
utilizzarlo per la prima volta.

Utilizzare sempre accessori LG originali. Gli elementi forniti in dotazione sono
progettati esclusivamente per questo dispositivo e potrebbero non essere
compatibili con altri dispositivi.

Le descrizioni si basano sulle impostazioni predefinite del dispositivo.

Le app predefinite presenti sul dispositivo sono soggette ad aggiornamenti e il
supporto per tali applicazioni puo essere sospeso senza preawiso. Per eventuali
domande relative alle app preinstallate sul dispositivo, contattare un Centro di
assistenza LG. Per le app installate dall'utente, contattare il provider del servizio
di riferimento.

La modifica del sistema operativo del dispositivo o linstallazione di software
provenienti da fonti non ufficiali potrebbe danneggiare il dispositivo e causare
il danneggiamento o la perdita di dati. Tali azioni costituiscono una violazione
dellaccordo di licenza LG e annullano la garanzia.

Alcuni contenuti e illustrazioni potrebbero differire dal dispositivo acquistato
a seconda dellarea, del provider del servizio, della versione del software o del
sistema operativo e sono soggetti a modifiche senza preawiso.

| software, laudio, gli sfondi, le immagini e gli altri elementi multimediali forniti
con questo dispositivo sono concessi in licenza per uso limitato. Lestrazione e
[utilizzo di questi materiali per scopi commerciali o altri scopi potrebbe costituire
una violazione delle leggi sul copyright. La piena responsabilita per ['utilizzo
illegale degli elementi multimediali spetta agli utenti.

| servizi relativi ai dati, come ad esempio messaggistica, caricamento e
download, sincronizzazione automatica o servizi di posizionamento, potrebbero
comportare costi aggiuntivi. Per evitare costi aggiuntivi, selezionare un piano
dati adeguato alle proprie esigenze. Per ulteriori informazioni, rivolgersi al
proprio gestore di telefonia mobile.

La presente guida per l'utente e redatta nelle principali lingue per ogni paese. A
seconda della lingua di redazione, i contenuti potrebbero in parte variare.



Notifiche informative

& ATTENZIONE: situazioni che potrebbero provocare lesioni all'utente e a terze parti.

ATTENZIONE: situazioni che potrebbero provocare lesioni lievi o danni al
dispositivo.

E NOTA: awisi o informazioni aggiuntive.

Info sulla guida per lutente
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Indicazioni per un uso sicuro ed
efficiente

Leggere le semplici indicazioni riportate di sequito. Il mancato rispetto di tali indicazioni pud
rivelarsi pericoloso o illegale.

Nel caso si verifichino errori, il software integrato nel dispositivo crea un registro degli errori.
Questo strumento raccoglie solo i dati specifici dellerrore come l'intensita del segnale, la “cell ID
position” quando la chiamata viene interrotta e le applicazioni caricate. Il registro viene utilizzato
solo per determinare la causa dellerrore. Questi registri sono crittografati e possono essere
aperti solo nei centri di riparazione LG autorizzati, nel caso sia necessario restituire il dispositivo
per la riparazione.

Esposizione all'energia elettromagnetica a
radiofrequenze (RF)

Informazioni sullesposizione alle onde radio e sulla SAR (Specific Absorption Rate)
Questo dispositivo e stato progettato in conformita ai requisiti di sicurezza vigenti per
lesposizione alle onde radio. Tali requisiti si basano su precise indicazioni scientifiche che
definiscono, tra laltro, i margini di sicurezza necessari per salvaguardare tutte le persone,
indipendentemente dalleta e dalle condizioni di salute.

+ Le indicazioni sullesposizione alle onde radio fanno riferimento a un'unita di misura detta
SAR, acronimo per Specific Absorption Rate. Le prove relative ai valori SAR sono state
condotte mediante metodi standardizzati con il dispositivo in stato di trasmissione al
massimo livello di alimentazione certificato, con qualsiasi banda di frequenza.

Anche se si possono riscontrare differenze trai livelli SAR nei vari modelli di dispositivi
portatili LG, questi sono comunque stati progettati con unattenzione particolare alle
normative vigenti sullesposizione alle onde radio.

La commissione internazionale ICNIRP (International Commission on Non-lonizing
Radiation Protection) raccomanda un limite SAR pari a 2 \W/kg in media per dieci grammi
di tessuto.

Il valore SAR pili elevato registrato per questo modello per ['uso vicino allorecchio & pari a
0,243 W/kg (10 g) e paria 1,497 W/kg (10 g) a contatto con il corpo.



+ Questo dispositivo e conforme alle direttive sullesposizione alle radiofrequenze quando
utilizzato nella normale posizione d'uso vicino allorecchio o posizionato a una distanza di
almeno 5 mm dal corpo. Se una custodia, una clip per cintura o un altro sostegno vengono
posizionati a stretto contatto con il corpo, tali accessori non devono contenere metallo ed &
importante mantenere il dispositivo a una distanza di almeno 5 mm dal corpo. Il dispositivo
richiede una connessione ottimale alla rete per poter trasmettere file di dati o messaggi.

In alcuni casi, la trasmissione di file di dati o messaggi potrebbe essere ritardata fino a che
tale connessione diventi disponibile. Le istruzioni relative alla separazione del dispositivo dal
corpo devono essere rispettate fino alla fine della trasmissione.

Informazioni fornite dalla FCC in merito
all'esposizione alle frequenze radio

Nellagosto del 1996, la Federal Communications Commission (Commissione federale per

le comunicazioni, FCC) degli Stati Uniti, attraverso azione in Report and Order FCC 96-326,
ha adottato uno standard di sicurezza aggiornato relativo allesposizione umana allenergia
elettromagnetica delle frequenze radio emessa dai trasmettitori con normativa FCC. Tali linee
guida sono coerenti con gli standard di sicurezza in precedenza determinati da standard sia
internazionali sia statunitensi. La progettazione del presente dispositivo & conforme alle linee
guida FCC e a tali standard internazionali.

Parte 15.19

Questo apparecchio e conforme alla parte 15 delle norme FCC. Il funzionamento e soggetto
alle due condizioni riportate di seguito:

(1) Il dispositivo non deve generare interferenze dannose.

(2) Il dispositivo deve accettare eventuali interferenze ricevute, incluse quelle che potrebbero
comportare errori di funzionamento.

Parte 15.21

Modifiche non espressamente approvate dal produttore potrebbero annullare lautorita
dellutente all'utilizzo dellattrezzatura.
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Funzionamento del dispositivo indosso all'utente

Il presente dispositivo ¢ stato testato per le tipiche funzioni in cui lo siindossa, mantenendo

la parte posteriore del dispositivo a 1 cm (0,39 pollici) di distanza da corpo dell'utente. Per
rispettare i requisiti FCC relativi allesposizione alle frequenze radio, & necessario mantenere
una distanza di separazione minima tra il corpo dell'utente e la parte posteriore del dispositivo
di 1 cm (0,39 pollici). Potrebbe non essere possibile utilizzare fermagli da cintura, custodie

e accessori simili contenenti componenti in metallo. Gli accessori da indossare che non
mantengono una distanza di separazione di 1 cm (0,39 pollici) tra il corpo dellutente e la parte
posteriore del dispositivo e che non sono stati testati per le tipiche funzioni in cui si indossa il
dispositivo potrebbero non rispettare i limiti FCC relativi allesposizione alle frequenze radio e
devono dunque essere evitati.

Parte 15.105

Questa apparecchiatura é stata testata e rispetta i limiti di un dispositivo digitale di Classe B,

ai sensi della parte 15 delle norme FCC. Questi limiti sono stabiliti per fornire una protezione
adatta dalle interferenze dannose in un'installazione residenziale. Questo apparecchio genera,
utilizza e puo irradiare energia in radiofrequenza; inoltre, se non viene installato e utilizzato
secondo le istruzioni, pud causare interferenze dannose alle comunicazioni radio. Tuttavia, non
esiste alcuna garanzia che queste interferenze non si verifichino in una particolare installazione.
Se la presente apparecchiatura causa interferenze dannose o ricezione di canali televisivi,
determinabili accendendo e spegnendo il dispositivo, si consiglia vivamente di tentare di
correggere linterferenza attuando una o piti delle sequenti misure:

Orientare o posizionare di nuovo lantenna di ricezione.
+ Aumentare lo spazio che intercorre tra lapparecchio e il ricevitore.

+ Collegare lapparecchio a una presa su un circuito differente rispetto a quello a cui &
collegato il ricevitore.

Per assistenza, consultare il rivenditore o un tecnico radio/TV esperto.
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Manutenzione e cura del prodotto

Utilizzare solo gli accessori forniti autorizzati da LG. Qualsiasi danno o guasto causato da
accessori di terze parti non é coperto dalla garanzia LG.

Alcuni contenuti e illustrazioni possono differire dal dispositivo senza preawviso.

Non smontare [apparecchio. Se & necessaria una riparazione, rivolgersi presso un centro
assistenza autorizzato LG.

La garanzia copre, a discrezione di LG, la sostituzione di parti o schede nuove o riconvertite,
funzionalmente equivalenti.

Tenere lontano da apparecchiature elettriche quali TV, radio e PC.

Tenere lontano da fonti di calore quali termosifoni o fornelli.
Non far cadere apparecchio.
Non sottoporre [apparecchio a scosse, urti o vibrazioni.

Spegnere il dispositivo nelle aree in cui e specificamente richiesto. Ad esempio, non
utilizzarlo all'interno di ospedali, in quanto potrebbe interferire con il funzionamento di
apparecchiature mediche sensibili.

Non afferrare il dispositivo con le mani bagnate mentre € in carica. Cio potrebbe provocare
scosse elettriche o danneggiare seriamente il prodotto.

Non ricaricare il telefono vicino a materiali infiammabili che potrebbero provocare incendi a
causa del calore sviluppato dal dispositivo.

Usare un panno asciutto per la pulizia esterna del cellulare (non usare solventi come
benzene, acquaragia o alcol).

Non caricare il dispositivo quando si trova su superfici morbide.

Il dispositivo dovrebbe essere caricato in unarea ben ventilata.

Non esporre [apparecchio a fumo o polvere.

Tenere lontano il dispositivo da carte di credito o supporti magnetici per evitarne la
smagnetizzazione.

Non toccare lo schermo con oggetti appuntiti per evitare di danneggiare il dispositivo.

Non esporre il dispositivo a umidita o a contatto con liquidi.
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Usare gli accessori con attenzione e delicatezza. Non toccare lantenna se non strettamente
necessario.

In caso di vetro rotto o scheggiato, non utilizzare il dispositivo, non toccare il vetro, né

tentare di rimuoverlo o ripararlo. | danni al display in vetro dovuti ad abuso o utilizzo non

corretto non sono coperti dalla garanzia.

Il dispositivo e un dispositivo elettronico che genera calore durante il normale
funzionamento. Il contatto diretto e prolungato con la pelle e lassenza di unadeguata

ventilazione possono provocare disagi e piccole bruciature. Pertanto, & necessario

maneggiare con cura il dispositivo durante o subito dopo [utilizzo.

Se il dispositivo si bagna, scollegarlo immediatamente e farlo asciugare completamente.
Non tentare di accelerare il processo di asciugatura con una fonte di calore esterna, ad
esempio un forno, un forno a microonde o un asciugacapelli.

Il liquido presente nel dispositivo bagnato potrebbe modificare il colore delletichetta del
prodotto presente allinterno. | danni al dispositivo derivanti dallesposizione ai liquidi non
sono coperti da garanzia.

Un dispositivo mobile ha bisogno di una corretta circolazione dellaria per disperdere il
calore. Il contatto diretto con la pelle ed un'insufficiente circolazione daria sul dispositivo
potrebbe causare un surriscaldamento. Il dispositivo deve trovarsi ad almeno 1,0 cm dal
corpo dellutente.

Evitare che la polvere di sostanze estranee entri nel caricatore / porta del cavo USB. Pud
generare calore o fuoco.

Funzionamento efficiente del dispositivo

Dispositivi elettronici

Tutti i dispositivi possono subire interferenze che influiscono sulle prestazioni.

Non utilizzare il dispositivo in prossimita di apparecchiature mediche senza autorizzazione.
Consultare un medico per determinare se ['uso del dispositivo possa interferire con il

funzionamento dell'apparecchio medico.

I produttori di pacemaker raccomandano una distanza minima di 15 cm da altri dispositivi e
pacemaker per evitare possibili interferenze con quest'ultimo.

Il dispositivo potrebbe produrre una luce forte o lampeggiante.
Il dispositivo potrebbe interferire con alcuni tipi di apparecchi acustici.
Il telefono potrebbe interferire con apparecchi televisivi, radio, computer, ecc.

Utilizzare il dispositivo a una temperatura compresa tra 0 °C e 35 °C, se possibile.
Lesposizione del dispositivo a temperature estremamente alte o basse puo causare danni,
malfunzionamenti o perfino esplosioni.
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Sicurezza in automobile
Verificare le leggi e le normative che riguardano ['utilizzo dei dispositivi quando si guida.

Non utilizzare il dispositivo in modalita manuale durante la quida.

Prestare la massima attenzione alla guida.

Se le condizioni di guida lo richiedono, accostare e parcheggiare prima di telefonare o
rispondere a una chiamata.

L'energia RF puo influire sul sistema elettronico del veicolo, ad esempio sullo stereo o sulle
apparecchiature di sicurezza.

Se il veicolo  dotato di airbag, non collocarvi accanto oggetti come apparecchi wireless
portatili o installati per evitare lesioni gravi causate dallerrato funzionamento dellair bag.

Durante lascolto della musica tramite il cellulare, assicurarsi che il volume sia
ragionevolmente basso da consentire il rilevamento dei rumori circostanti. Cio &
particolarmente importante in prossimita di strade.

Come evitare danni all'udito

Per evitare eventuali danni all'udito, non ascoltare audio ad alto volume per
lunghi periodi.

L'udito potrebbe danneggiarsi se viene esposto a volumi eccessivi e prolungati nel tempo. Si
consiglia pertanto di non accendere o spegnere il telefono indossando gli auricolari e di tenere il
volume di ascolto delle conversazioni e della musica a un livello ragionevole.
Quando si utilizzano gli auricolari, abbassare il volume se non si riesce a sentire le persone
nelle vicinanze o se il volume & tale da essere udito dalla persona accanto.

E « Lutilizzo di auricolari e cuffie a volume troppo elevato pud causare |a perdita
delludito.

Indicazioni per un uso sicuro ed efficiente 11



Parti in vetro

Alcune parti del dispositivo sono in vetro. Se il dispositivo cade su una superficie rigida o subisce
un forte impatto, il vetro pud rompersi. Se cio accade, non toccare o tentare di rimuovere il
vetro. Non utilizzare il dispositivo finché il vetro non viene sostituito da un centro di assistenza
autorizzato.

Aree a rischio di esplosione

Non utilizzare il dispositivo in aree dove sono in atto operazioni di detonazione. Rispettare le
restrizioni e osservare tutte le norme o i regolamenti al riguardo.

Atmosfere potenzialmente esplosive
+ Non utilizzare il dispositivo in prossimita di stazioni di servizio.
+ Non utilizzare [apparecchio in prossimita di combustibili o prodotti chimici.

+ Non trasportare né conservare sostanze esplosive, liquidi o gas infiammabili allinterno
dellautovettura in cuisi trovano il dispositivo o i relativi accessori.

A bordo di aeromobili
L'uso di dispositivi portatili pud causare delle interferenze al velivolo.
+ Spegnere il dispositivo prima di imbarcarsi su qualsiasi aeromobile.

+ Utilizzarlo a terra (prima o dopo il decollo) solo con il permesso dellequipaggio.

Bambini

Conservare il dispositivo in un posto sicuro, lontano dalla portata dei bambini. Lapparecchio
& composto da parti smontabili di piccole dimensioni che, se ingerite, possono provocare
soffocamento.

Chiamate di emergenza

Le chiamate di emergenza potrebbero non essere disponibili su tutte le reti cellulari. Pertanto,
si consiglia di non affidarsi solo al dispositivo per eventuali chiamate di emergenza. Contattare
il fornitore di servizi locale per conoscere la disponibilita dei servizi di emergenza nel proprio
paese.
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Manutenzione e informazioni sulle batterie

Non & necessario scaricare completamente la batteria prima di ricaricarla. A differenza
dialtri sistemi a batteria, questo cellulare non presenta un effetto memoria in grado di
compromettere le prestazioni della batteria.

Utilizzare solo batterie e caricabatterie LG, in quanto sono progettati per consentire una
maggiore durata della batteria.

Non smontare né cortocircuitare la batteria.
Tenere puliti i contatti metallici della batteria.

Sostituire la batteria quando le prestazioni non sono pit accettabili. La batteria puo essere
ricaricata centinaia di volte prima che sia necessario sostituirla.

Se la batteria e rimasta inutilizzata per un lungo periodo, ricaricarla per ottimizzarne le
prestazioni.

Non esporre il caricabatterie alla luce solare diretta e non utilizzarlo in ambienti
particolarmente umidi, ad esempio nel bagno.

Evitare di lasciare il dispositivo in luoghi con temperature eccessivamente basse o elevate
per non comprometterne le prestazioni.

L'uso di un tipo di batteria errato pud comportare il rischio di esplosioni. Attenersi alle
istruzioni per lo smaltimento delle batterie usate.

Quando il dispositivo e completamente carico, scollegare sempre il caricabatterie dalla presa
di corrente per evitare consumi energetici non necessari.

La durata della batteria effettiva varia a seconda di configurazione di rete, impostazioni del
prodotto, uso, batteria e condizioni ambientali.

Assicurarsi che la batteria non venga a contatto con oggetti affilati come ad esempio,
forbici, denti o unghie di animali. Cio potrebbe causare incendi.

Consumo energetico (modalita standby di rete): 0,7 W
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Protezione delle informazioni personali

+ Assicurarsi di proteggere le informazioni personali per evitare la perdita e [uso improprio
delle informazioni sensibili.

Esequire sempre il backup dei dati importanti durante ['utilizzo del dispositivo. LG non &
responsabile di eventuali perdite di dati.

Assicurarsi di esequire il backup di tutti i dati e di ripristinare il dispositivo durante lo
smaltimento del dispositivo per impedire 'uso improprio delle informazioni sensibili.

Leggere attentamente la schermata delle autorizzazioni durante il download delle
applicazioni.

Utilizzare con cautela le applicazioni che hanno accesso a piti funzioni o a informazioni
personali.

Controllare regolarmente gli account personali. In caso di uso improprio, chiedere al provider
del servizio di eliminare o modificare le informazioni del proprio account.

In caso di perdita o furto del dispositivo, modificare la password dellaccount per proteggere
le informazioni personali.

Non utilizzare applicazioni provenienti da fonti sconosciute.

A Awviso sulla sostituzione della batteria

+ Una batteria agli ioni di litio & un componente pericoloso che puo causare lesioni
gravi.

« Lasostituzione della batteria da parte di personale non qualificato puo causare
danni al dispositivo.

« Non sostituire la batteria autonomamente. La batteria potrebbe essere
danneggiata, surriscaldarsi e provocare lesioni. La batteria deve essere sostituita
da personale qualificato. La batteria deve essere riciclata o smaltita separatamente
rispetto ai rifiuti domestici.

Nel caso in cui il prodotto contenga una batteria incorporata nel prodotto che
non puo essere facilmente rimossa dall'utente finale, LG raccomanda che la
batteria venga rimossa solo da professionisti qualificati, sia per la sostituzione sia
per il riciclaggio al termine della vita del prodotto. Per evitare danni al prodotto,

e per la propria sicurezza, gli utenti non devono tentare di rimuovere la batteria,
ma contattare il Servizio clienti di LG o altri fornitori di servizi indipendenti per
ottenere consiglio.

« Larimozione della batteria comporta lo smantellamento della custodia del
prodotto, la disconnessione di cavi/contatti elettrici, e [attenta estrazione della
cella batteria utilizzando strumenti specifici. In caso di bisogno di istruzioni per
professionisti qualificati su come rimuovere la batteria in modo sicuro, si prega di
visitare http7//www.lge.com/global/sustainability/environment/take-back-recycling.
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Funzioni
personalizzate



Funzioni della fotocamera

Funzioni principali della fotocamera

Questo capitolo descrive le funzioni principali fornite dall'app della fotocamera.
Aprire lapp della fotocamera e provare le funzioni seguendo le istruzioni riportate
di seguito.

T Aprire lapp della fotocamera nella schermata Home del prodotto.

Consente di cambiare
l'angolo della
fotocamera

Imposta/annulla —<GH

limpostazione del timer & — Passa alla fotocamera

Imposta/annulla —38 anteriore/posteriore

limpostazione del flash o= — Scatta foto

Applica leffetto —%
filtro/sticker D Visualizza l'anteprima
della foto scattata/del

Imposta la fotocamera —X& video ripreso

S Oclezionare Altro

E + Alcune immagini di questo manuale sono state modificate per aiutare la
comprensione dell'utente.
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Steady Cam

Usare Steady Cam per evitare lo scuotimento della fotocamera durante la
registrazione di un video mentre si cammina o si compiono movimenti ampi.

Attivare lanti-scuotimento per ridurre o eliminare la sfocatura delle immagini
dovuta allo scuotimento della fotocamera durante la registrazione di un video.

1 Toccare Q> (&) > Video.
7 Toccare > M

3 Toccare @ per registrare un video.

Ritratto
E possibile creare foto ritratto artistiche, in cui il soggetto & a fuoco e lo sfondo &
sfocato. E possibile anche modificare limmagine applicando effetti di illuminazione
o di colore allo sfondo.

Durante lo scatto di foto, mantenere una distanza di 1,3 ~ 5 piedi dal soggetto.

Questa funzionalita non & disponibile se ambiente & buio

T Toccare Q> (&), quindi toccare Ritratto.

2 Trascinare a sinistra o a destra la barra di scorrimento per regolare il livello di
sfocatura.
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3 Quando sullo schermo appare Ritratto & disponibile, toccare () o @) per
scattare una foto.

« Lafunzione Ritratto potrebbe non essere disponibile se la fotocamera non &
in grado di riconoscere il soggetto-

Funzioni della Galleria

Contenuti correlati
E possibile modificare e personalizare i contenuti correlati nella Galleria.
1 Mentre sivisualizza lanteprima di una foto, toccare &.

2 Quando appare licona relativa alla data o al luogo in cui & stata scattata la foto,
toccare lo schermo.

- E possibile visualizzare le foto correlate alla data o al luogo scelto.
- Toccare ¢ per accedere a ulteriori opzioni.
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Realizzazione di una GIF
E possibile creare un file GIF dalla Galleria.

1 Mentre si sta visualizzando un album, toccare > Crea GIF.

2 Seleziona le foto e i video desiderati per creare un file GIF, quindi toccare Avanti.

- E possibile anche aggiungere/eliminare una fotografia, regolare la velocita o
le proporzioni dello schermo, impostare ['ordine delle fotografie ecc.

3 Tocca Salva.

E + Per creare un file GIF possono essere utilizzate un massimo di 100 immagini.

Realizzazione di un collage
Puoi creare un collage dai contenuti associati.

1 Mentre si sta visualizzando un album, toccare > Realizza collage.

7 Selezionare le immagini desiderate da aggiungere al collage, quindi toccare Avanti.
+ Selezionare il layout desiderato sul fondo dello schermo.

3 Toccare Crea.

E + Per creare un collage possono essere utilizzate un massimo di 9 immagini.
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Creazione di un filmato
E possibile creare un nuovo filmato, mettendo insieme immagini e video.

1 Aprire lapp Galleria, selezionare la cartella desiderata nellalbum e toccare & >
Crea filmato.

7 Selezionare immagini e video per il tuo filmato e toccare Avanti.

3 Modificare le immagini e i video selezionati, quindi toccare Salva.

5

l~~*4444~lw|

Eliminazione di file

E possibile selezionare le immagini e i video che vuoi rimuovere dal filmato,
toccando € nell'angolo in alto a destra di questa miniatura.

Aggiunta di file

E possibile selezionare le immagini e i video che vuoi aggiungere al filmato, toccando
— sul fondo dello schermo. E anche possibile selezionare immagini o video che
sono stati gia aggiunti.

5 « Toccare e tenere premuto un file, quindi toccare un altro file per una selezione
multipla
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Riorganizzazione dei file

Per riorganizzare le immagini e i video, toccare e tenere premuto il file che si vuole
spostare, e quindi trascinarlo nella posizione desiderata.

Aggiunta di effetti ai file

Toccare % per aggiungere un tema o una musica di sottofondo, oppure per
modificare il carattere.

Reset delle modifiche del filmato

E possibile resettare le modifiche applicate al filmato (ad es. tempo di riproduzione),
toccando &)

Anteprima di un file

Controllare il nuovo video prima del salvataggio, toccando (). Al termine dalla
riproduzione, il file seguente viene riprodotto in automatico.

E « Per creare un video possono essere utilizzate un massimo di 50 immagini e video.
« lltempo di riproduzione di un'immagine per impostazione predefinita e di 3
secondi, e non pud essere modificato. | video possono essere tagliati fino a un
minimo di 1 secondo.

Questa funzione potrebbe non supportare alcuni formati di immagini o video.
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Realizzazione di una GIF
E possibile realizzare una GIF con facilita utilizzando un video registrato.

Creazione di un video

1 Durante la visualizzazione del video, in corrispondenza del punto di partenza
desiderato, toccare @),

2 Selezionare la durata della GIF che si desidera creare.
+ Viene generata una GIF della durata desiderata a partire dal punto iniziale
specificato.
« Perivideo di durata inferiore ai 5 secondi, le immagini GIF vengono generate
automaticamente per il tempo restante.

Creazione di fotografie GIF
1 Nellelenco delle fotografie nella galleria, toccare > Crea GIF.

7 Selezionare unimmagine da trasformare in fotografia GIF e quindi toccare
Avanti.
- E possibile aggiungere/eliminare una fotografia, regolare la velocita o le
proporzioni dello schermo e impostare ['ordine delle fotografie.

A + La creazione di fotografie GIF e una funzione che consente all'utente di
produrre immagini creative. La violazione dei diritti di proprieta intellettuale o la
diffamazione della reputazione di altre persone mediante la funzione di creazione
di fotografie GIF possono comportare responsabilita civili o penali in conformita
con le leggi vigenti. Fare attenzione a non copiare o trasmettere opere di altre
persone senza autorizzazione. LG Electronics declina ogni responsabilita per tali
azioni degli utenti

Quando si crea una fotografia GIF, € possibile selezionare di produrre finoa 100
fotografie.
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Qualita audio e funzionalita effetti

DTS:X 3D Surround

E possibile riprodurre una canzone o un video con un suono vivido, immersivo e
tridimensionale. Per usare questa funzionalita, connetti auricolari, altoparlante, o
altrei dispositivi audio esterni al tuo dispositivo.
Tocca O > Impostazioni > Suono > Qualita del suono ed effetti, quindi tocca
DTS:X 3D Surround Q) per attivare questa funzione.
+ Per attivare la funzione, & possibile trascinare verso il basso la barra di stato
nella parte superiore dello schermo e toccare licona dellaudio DTSX 3D.

Se al prodotto si collegano dispositivi audio esterni come auricolari e altoparlanti,

appare un pop-up che consente di attivare laudio DTSX 3D o la funzione Hi-Fi
Quad DAC.

Funzioni personalizzate
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Floating Bar

Panoramica Pulsante fluttuante

Puoi attivare le funzioni piti frequenti, tra cui scorciatoie, screenshot, lettore
musicale e contatti rapidi, toccando e facendo scorrere la Floating Bar sullo
schermo.

Per attivare la funzione "Floating Bar", toccare () > Impostazioni > Estensioni >
Floating Bar Q).

Apertura e chiusura della Floating Bar
+ Per aprire la barra fluttuante: Toccare € oppure ».
+ Per chiudere a barra fluttuante: Toccare » oppure <.

Funzioni personalizzate
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Modificare la posizione della Floating Bar
+ Floating Bar aperta: Toccare e tenere premuta la barra fluttuante, quindi
trascinarla nella posizione desiderata.

- Floating Bar chiusa: Toccare e tenere premuta la barra fluttuante, quindi
trascinarla nella posizione desiderata lungo il margine dello schermo.

Disattivazione della Floating Bar
E possibile disattivare la barra fluttuante utilizzando una delle sequenti opzioni:

+ Toccare e tenere premuto € oppure > sulla barra fluttuante, quindi trascinarla
nell'area di eliminazione nella parte superiore dello schermo.

+ Toccare < oppure » sulla Floating Bar;, quindi toccare G=o > @ ) nella parte
superiore dello schermo.

- Toccare ) > Impostazioni > Estensioni > Floating Bar @ .
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Impostazione della barra fluttuante
E possibile selezionare gli elementi da visualizzare nella Floating Bar e modificarne
lordine di visualizzazione. Toccare =9 sulla Floating Bar oppure () > Impostazioni
> Estensioni > Floating Bar.

- Mansione: E possibile impostare unarea in cui spostare la Floating Bar

- Collegamenti: Accedi rapidamente alle app e alle funzioni utilizzate piti spesso.

+ Acquisizione schermata: Scatta un'immagine dello schermo per ritagliare la

parte desiderata oppure creare un file GIF

Z E possibile usare Capture+ sulla schermata desiderata.
w0 E possibile acquisire uno screenshot scorrevole e usarlo per Q Memo+ o
L salvarlo nella galleria.
ey E possibile acquisire larea desiderata e usarla per Q Memo+ o salvarla nella
== galleria.
Salvare la schermata corrente come un file GIF. E possibile regolare la
dimensione dellimmagine che vuoi catturare.
C.: + Per spostarla nella posizione desiderata, trascinare =.

+ Per awiare la registrazione di una GIF, toccare (o),
+ Per interrompere la registrazione di una GIF, toccare (),

Lettore musicale: Controlla la musica che stai ascoltando.
Contatti rapidi: Chiama o invia un messaggio alle persone identificate come

contatti rapidi.

5

Possono essere aggiunte alle scorciatoie fino a 5 app o funzioni.
E possibile aggiungere ai contatti rapidi fino a 5 contatti.

GIF Capture e una funzione che consente all'utente di produrre immagini creative.
La violazione dei diritti di proprieta intellettuale o la diffamazione della reputazione
di altre persone mediante la funzione GIF Capture possono comportare
responsabilita civili o penali in conformita con le leggi vigenti. Fare attenzione a non
copiare o trasmettere opere di altre persone senza autorizzazione. LG Electronics
declina ogni responsabilita per tali azioni degli utenti.

E possibile creare GIF di una durata massima di 15 secondi.
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Assistente Google

Panoramica Assistente Google

Il tuo dispositivo dispone di Assistente Google incorporato. Trova le risposte e fai
cose mentre sei in giro.

E - Per usare questa funzionalita, per prima cosa connettiti alla rete e accedi al tuo
account Google.

Awvio di Assistente Google
T Tocca e tieni premuto O dalla schermata Home per awiare Assistente
Google, oppure premi il tasto Assistente Google sul lato sinistro del dispositivo.

7 Tocca CONFIGURAZIONE INIZIALE.

3 Seguile istruzioni su schermo e pronuncia "Ok Google” o “Hey Google”.
« Il dispositivo salva i dati della tua voce per il riconoscimento.

/. Imposta se usare la funzione di sblocco con Voice Match.
« Utilizzando la funzione di sblocco con Voice Match, e possibile sbloccare il

dispositivo anche quando ha lo schermo spento o € in carica, pronunciando
“OK Google” o0 “Hey Google.".

E + Questa funzione puo risultare pit vulnerabile in termini di sicurezza rispetto ad
altri metodi di blocco schermo come Sequenza, PIN o Password.
Se si utilizza un voce somigliante o una voce registrata, & possibile che il blocco
schermo venga rimosso.

Per usare questa funzione, tocca O > Impostazioni > Blocco schermo &
sicurezza > Impostazioni di Blocco con sicurezza > Blocco Smart, e quindi usa
il metodo di blocco schermo impostato per sbloccare il dispositivo. Tocca Voice
Match, poi tocca Accedi con Voice Match — , quindi inserisci nuovamente il
metodo di sblocco utilizzato correntemente. Nota che Swipe € esclusa.

« Se non si riesce a sbloccare il dispositivo usando il riconoscimento vocale, &
necessario sbloccare il dispositivo usando il metodo specificato. Per ulteriori
dettagli, consultare la sezione Impostazione di un blocco schermo.

5 Tocca Salva.
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Accesso vocale

1 Quando la schermata Home & spenta o bloccata, pronuncia “OK Google” o
“Hey Google.".

7 Quando appare la schermata di Assistente Google, pronuncia un comando o
poni una domanda.

Accesso dalla schermata Home
1 Tieni premuto O dalla schermata iniziale.

7 Pronuncia un comando o una domanda quando sulla parte inferiore dello
schermo appare *« -«

E + In'un ambiente in cui la connessione Wi-Fi o dei dati mobili & scarsa, la funzione
Assistente Google potrebbe essere limitata e la precisione del riconoscimento
vocale potrebbe essere ridotta.

Se la pronuncia & ambigua, il microfono & coperto, un lettore multimediale &

in riproduzione o 'ambiente circostante & rumoroso, il grado di precisione del
riconoscimento vocale potrebbe essere ridotto. Quando si utilizza il prodotto
mediante i comandi vocali, pronunciare le parole con precisione in un ambiente
silenzioso per una migliore precisione del riconoscimento vocale.

Funzioni personalizzate
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Riconoscimento delle impronte
digitali

Informazioni generali sul riconoscimento delle

impronte digitali
Prima di utilizzare la funzione di riconoscimento delle impronte digitali, € necessario
registrare la propria impronta sul dispositivo.
La funzione di riconoscimento delle impronte digitali puo essere impiegata nei casi
seguenti:

« Per sbloccare lo schermo.

« Per visualizzare i contenuti bloccati nella Galleria o in QuickMemo+.

+ Per confermare un acquisto effettuando laccesso a un'app o identificandosi

tramite limpronta digitale.

E « E possibile utilizzare i dati dellimpronta digitale per lautenticazione dellutente. E
possibile che il sensore di impronte digitali possa riconoscere un'impronta digitale
diversa ma molto simile a unimpronta digitale registrata. Per una maggiore
sicurezza, si consiglia di utilizzare il metodo della sequenza, del PIN o della
password per sbloccare lo schermo
Se il dispositivo non riesce a individuare le impronte digitali o se si dimentica il
valore specificato per |a registrazione, recarsi presso il piti vicino Centro di servizio
clienti LG con il dispositivo e la scheda di identificazione.

Precauzioni per il riconoscimento delle impronte digitali
L'accuratezza del riconoscimento delle impronte digitali potrebbe diminuire a causa
di diverse regioni. Per massimizzarla, eseqguire le sequenti verifiche prima dell'utilizzo
del dispositivo.

- Il dispositivo dispone di un sensore per impronte digitali. Fare attenzione a non

graffiare o danneggiare il sensore di impronte digitali con oggetti metallici come
monete o chiavi.
In presenza di sostanze estranee (sudore, creme, acqua, Sporco, grasso ecc.) sul
sensore di impronte digitali o sul dito da applicare sul sensore, il riconoscimento
delle impronte digitali potrebbe non funzionare correttamente. Pulire il sensore
e il dito e rimuovere tutta 'umidita prima di posizionare il dito sul sensore.
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1

Se la superficie del dito & ruvida a causa di una cicatrice o di un'immersione
prolungata in acqug, il sensore potrebbe non essere in grado di riconoscere
limpronta digitale. In tal caso, registrare unaltra impronta digitale.

Se si piega il dito o si usa solamente la punta del dito, il riconoscimento
dellimpronta potrebbe non avere esito positivo. Assicurati che il tuo dito copra
lintera superficie del sensore per impronte digitali.

Eseguire la scansione di un solo dito per ciascuna registrazione. La scansione

di pits di un dito potrebbe compromettere |a registrazione e il riconoscimento
dellimpronta.

Il dispositivo potrebbe generare elettricita statica se laria circostante e secca. Se
laria circostante e secca, evitare la scansione delle impronte digitali o toccare un
oggetto metallico, quale ad esempio una moneta o una chiave, prima di eseguire
la scansione delle impronte al fine di eliminare lelettricita statica.

Registrazione delle impronte digitali

E possibile registrare e salvare la propria impronta digitale sul dispositivo per
utilizzare l'identificazione tramite impronta digitale.

Toccare (O > Impostazioni > Blocco schermo & sicurezza > Impronte digitali.

E « Per poter utilizzare questa funzione, & necessario impostare un blocco schermo.

2

+ Seilblocco schermo non e attivo, configurare la schermata di blocco sequendo le
istruzioni visualizzate sullo schermo. Per ulteriori dettagli, consultare la sezione
Impostazione di un blocco schermo.

Controllare la posizione del sensore di impronte digitali e poggiare leggermente
il dito sul sensore.

E « Assicurarsi che il dito copra completamente il sensore di impronte digitali.
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3 Seguire le istruzioni visualizzate sullo schermo.

+ Fino al completamento della registrazione dellimpronta digitale, muovere
poco a poco il dito sul sensore.

- Posizionare il dito sul sensore. Quando si avverte una vibrazione, rimuovere il
dito dal sensore.

/A Una volta completata la registrazione dellimpronta, toccare OK.

« Toccare AGGIUNGI ALTRO per registrare unaltra impronta digitale. Poiché
il grado di successo del riconoscimento delle impronte digitali dipende dalle
condizioni dellimpronta digitale registrata, si consiglia di registrare diverse
impronte digitali.

Gestione delle impronte digitali

E possibile modificare o eliminare le impronte digitali registrate.

1 Toccare > Impostazioni > Blocco schermo & sicurezza > Impronte digitali.
2 Sbloccare in base al metodo di blocco specificato.

3 Dallelenco delle impronte digitali, toccare un'impronta digitale per rinominarla.
Per eliminarla, toccare @
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Sblocco dello schermo con un'impronta digitale

E possibile sbloccare lo schermo e visualizare i contenuti bloccati utilizzando la
propria impronta digitale. Attivare la funzione desiderata:

T Toccare > Impostazioni > Blocco schermo & sicurezza > Impronte digitali.
2 Sbloccare in base al metodo di blocco specificato.

3 Nella schermata delle impostazioni dellimpronta digitale, attivare la funzione
desiderata:

+ Blocco schermo: Sbloccare lo schermo con un'impronta digitale.

+ Blocco del contenuto: consente di sbloccare un contenuto con un‘impronta
digitale. A questo scopo, assicurarsi che sia impostato il blocco contenuto.

Riconoscimento del volto

Informazioni generali sul riconoscimento del volto
E possibile sbloccare il blocco schermo utilizzando i dati di riconoscimento del volto.

5

Questa funzione pud aumentare la vulnerabilita in termini di sicurezza rispetto ad
altri metodi di blocco schermo come Knock Code, Sequenza, PIN o Password.

Se si utilizza un volto somigliante o una foto del tuo volto, & possibile che il blocco
schermo venga rimosso.

| dati del volto riconosciuti sono salvati in modo sicuro nel dispositivo.

+ Quando si seleziona il riconoscimento del volto per il blocco schermo, & necessario
immettere il codice Knock Code, la Sequenza, il PIN o la Password utilizzata per
la registrazione del volto senza utilizzare direttamente il riconoscimento del
volto dopo 'accensione. Prestare pertanto attenzione a non dimenticare il valore
specificato.

Se il dispositivo non riesce a individuare il volto o se si dimentica il valore specificato
per la registrazione, recarsi presso il piti vicino Centro di servizio clienti LG con il
dispositivo e la scheda di identificazione.

« Per risparmiare la batteria, la funzione di Riconoscimento del volto non &
utilizzabile quando la percentuale della batteria e al di sotto del 5%.
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Precauzioni per il riconoscimento del volto

l'accuratezza del riconoscimento del volto potrebbe diminuire nei casi riportati
di sequito. Per aumentarla, eseguire le sequenti verifiche prima dell'utilizzo del
dispositivo.

Se il volto e coperto da un cappello, da occhiali o da una maschera o se il volto
appare molto diverso a causa di un trucco pesante o di una folta barba.

Se sono presenti impronte digitali 0 sostanze estranee sulla parte anteriore
dell'obiettivo della fotocamera o se il dispositivo non riesce a individuare il volto a
causa di una luce troppo intensa o troppo scarsa.

Registrazione dei dati del volto
Prima di utilizzare la funzione di riconoscimento del volto, registrare i dati del volto
sul dispositivo.

1 Toccare O> Impostazioni > Blocco schermo & sicurezza > Riconoscimento
del volto.

5 - Per utilizzare questa funzione, il blocco schermo deve essere impostato tramite
Knock Code, Sequenza, PIN o Password.

+ Se non e stato impostato il blocco schermo, registrare i dati seguendo le
istruzioni visualizzate sullo schermo. Per ulteriori dettagli, consultare la sezione
Impostazione di un blocco schermo.

2 Tocca AVANTI e sblocca il dispositivo secondo il metodo specificato.
3 Tocca INIZIA e solleva il tuo dispositivo davanti ai tuoi occhi.
A Registrare il volto sequendo le istruzioni visualizzate sullo schermo.
+ Registrare il volto in un ambiente non troppo luminoso né troppo buio.

+ Posizionare l'intero volto all'interno delle linee guida sullo schermo e quindi
regolarlo eseguendo lenti spostamenti in alto, in basso, a sinistra o a destra.

Resta fermo quando registri il tuo volto. Puoi migliorare il tasso di
riconoscimento scattando foto da fermo piti volte.

5 Una volta completata la registrazione del volto toccare OK.
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Sblocco dello schermo con il volto

5 possibile rimuovere il blocco schermo con il volto anziché tramite Knock Code,
Sequenza, PIN o Password.

1 Toccare O > Impostazioni > Blocco schermo & sicurezza > Seleziona il
blocco dello schermo.

7 Sbloccare lo schermo in base al metodo specificato.
3 Toccare Consenti Riconoscimento del volto (O per sbloccare lo schermo

tramite il riconoscimento del volto.

Miglioramento del riconoscimento del volto

Per migliorare il riconoscimento del volto, e possibile aggiungere i dati del volto in
varie condizioni.

1 Toccare O > Impostazioni > Blocco schermo & sicurezza > Riconoscimento
del volto.

Sbloccare lo schermo in base al metodo specificato.
Selezionare Migliora il riconoscimento del volto.

Registrare il volto seguendo le istruzioni visualizzate sullo schermo.

u b wN

Una volta completata la registrazione del volto toccare OK.

Eliminazione dei dati del volto

Se il riconoscimento del volto non funziona correttamente, & possibile eliminare i
dati del volto registrati in precedenza e quindi registrarli di nuovo.

1 Toccare O > Impostazioni > Blocco schermo & sicurezza > Riconoscimento
del volto.

7 Sbloccare lo schermo in base al metodo specificato.

3 Selezionare Elimina volto per eliminare i dati del volto.
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Sblocco dello schermo con il volto quando lo schermo & spento

Con lo schermo spento, sollevare il dispositivo e guardare la parte anteriore dello
schermo. Il dispositivo pud quindi rilevare il volto e lo schermo si sblocca.

Per disattivare questa funzione, sequire le istruzioni riportate di sequito.

1 Toccare Q> Impostazioni > Blocco schermo & sicurezza > Riconoscimento
del volto.

7 Sbloccare lo schermo in base al metodo specificato.

3 Trascinare Consenti quando lo schermo & spento @  per disattivare la
funzione.

+ Lafunzione di riconoscimento del volto e disponibile solo quando lo schermo
& bloccato.

Sblocco dello schermo con il riconoscimento del volto seguito
da scorrimento

Con lo schermo spento, e possibile sbloccare lo schermo tramite il riconoscimento
del volto sequito dallo scorrimento.

1 Toccare O> Impostazioni > Blocco schermo & sicurezza > Riconoscimento
del volto.

7 Sbloccare lo schermo in base al metodo specificato.
3 Trascinare scorri per sbloccare dopo riconoscimento del volto QD per

attivare la funzione.

Impostazione avanzata del riconoscimento del volto
E possibile impedire che il dispositivo sia sbloccato da foto, immagini o video.

1 Toccare O > Impostazioni > Blocco schermo & sicurezza > Riconoscimento
del volto.

7 Sbloccare lo schermo in base al metodo specificato.

3 Trascinare Riconoscimento del volto avanzato Q) per attivare la funzione.

E - Quando si attiva questa funzione, la velocita del riconoscimento del volto potrebbe
diminuire.
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Funzione Multitasking

Schermata Utilizzi recenti

E possibile visualizzare le schermate delle app utilizate di recente utilizzando la

funzione di anteprima.

Per visualizzare la lista di app utilizzate di recente, toccare [_] sul pulsante a

sfioramento anteriore.

- (O> Impostazioni > Display > Barra di navigazione > Movimento e Pulsanti

e quindi scorrere verso lalto sul pulsante Home per visualizzare la cronologia
degli utilizzi recenti.

Finestra multipla
E possibile utilizzare due app contemporaneamente separando la schermata in
finestre multiple.
1 Toccare |:] dai pulsanti touch della schermata Home.
« Vengono visualizzate le app utilizzate di recente.
7 Toccare unicona e toccare =3 nella parte superiore dell'app desiderata per
usare la funzione Multi Window.
+ Le app selezionate vengono visualizzate nella parte superiore dello schermo.
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E « Per regolare la dimensione dello schermo diviso, trascinare — al centro dello
schermo.

La funzione Multi Window non & supportata da alcune applicazioni LG e
applicazioni scaricate.

AOD (Always-on display)

E possibile visualizzare la data, lora o la firma, anche se lo schermo principale &
spento.

Scorri fino in cima alla schermata di Always-on display per attivare diverse funzioni,
tra cui Camera, Capture+, Wi-Fi, impostazioni audio, Bluetooth®, Flash, Musica e
molto altro.

1 Tocca O > Impostazioni > Display > AOD (Always-on display).

2 Seleziona immagine che vuoi visualizzare e tocca Salva.

« Tocca l'immagine desiderata tra Orologio digitale, Orologio analogico, Doppio
orologio, Firma, Calendario o Immagine.

Trascina Strumenti rapidi e lettore musicale QD per scorrere sulle icone di
stato per Strumenti rapidi e il lettore musicale.

Tocca Al Pick QD per visualizzare informazioni utili fornite in base a
Context Awareness.

« Perimpostare un periodo di tempo in cui non attivare la funzione Always-on
display, toccare Timeout giornaliero.

+ Peraumentare la luminosita della funzione Always-on display, toccare
Display pill luminoso.

E « La batteria potrebbe scaricarsi piti velocemente quando si utilizza Always-on
display. Spegnere questa funzione per risparmiare la batteria.

« Per disattivare la funzione Always-on display tocca O > Impostazioni > Display
> Always-on display e quindi tocca @ .
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Quick Help

E possibile visualizzare le informazioni della quida relative alle principali funzioni del
dispositivo, le domande frequenti o la guida per [utente. Le informazioni della quida
possono essere cercate utilizzando parole chiave. E possibile risolvere rapidamente
eventuali problemi confrontandosi direttamente con un esperto.

1 Toccare > Impostazioni > Quick Help.

7 Cercare le informazioni della guida immettendo parole chiave nel campo di
ricerca.

E + Questa funzione viene aggiornata periodicamente utilizzando il feedback
dellutente.

+ Levoci del menu disponibili possono variare a seconda dell'area o del provider del
Servizio.

+ E possibile visualizzare il manuale dell'utente online dallapp Quick Help per
consultare le informazioni dettagliate relative alle funzioni del dispositivo

Note sulle proprieta di impermeabilita

Questo prodotto € resistente ad acqua e polvere in conformita con il grado di
protezione in ingresso IP68.

Il prodotto e stato sottoposto a test in un ambiente controllato ed e risultato
resistente all'acqua e alla polvere in determinate circostanze (soddisfa i requisiti
del grado di protezione IP68 specificati dallo standard internazionale [EC 60529
- Gradi di protezione per gli involucri [Codice IP]; condizioni di test: 15-35 °C, 86-
106kPa, 1,5 metri, per 30 minuti). Non esporre il dispositivo in condizioni diverse
dalle condizioni di test. | risultati possono variare in base all'uso effettivo.
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A ATTENZIONE

Sebbene il dispositivo sia conforme allo standard IP68, potrebbe non essere
resistente alle condizioni non testate in un ambiente controllato da LG. Il colore
dell'indicatore LDI (Liquid Damage Indicator) cambia se si verificano danni provocati
da tali cause. Se il colore dell'indicatore LDI situato all'interno del prodotto cambig,
il dispositivo non verra considerato idoneo per i servizi di riparazione gratuiti forniti
con la garanzia limitata del prodotto.

Evitare di esporre il prodotto ad ambienti con eccessiva polvere o umidita. Non
utilizzare il prodotto nei sequenti ambienti.

Non immergere il prodotto in agenti chimici liquidi (come il sapone).
Non immergere il prodotto in acqua salata o acqua di mare.
Non immergere il prodotto in acqua calda.

Non nuotare portando il prodotto in acqua.
Non poggiare il prodotto direttamente su sabbia (ad esempio in spiaggia)
o fango.

Non immergere il prodotto in acqua profonda piti di 1,5 metri circa.
Non immergere il prodotto in acqua per pit di 30 minuti.

RO®OD®®

+ Se il prodotto si bagna, strofinare il microfono, l'altoparlante e il jack stereo con
un panno asciutto prima dell'uso.

+ Seil prodotto o le proprie mani si bagnano, asciugarsi le mani e asciugare il
prodotto prima di toccare il dispositivo.

- Non usare il prodotto in luoghi in cui potrebbe essere raggiunto da schizzi
diacqua ad alta pressione (ad es. vicino a un rubinetto o una doccia), né
immergerlo in acqua per periodi di tempo prolungati, poiché il prodotto non &
progettato per sopportare acqua ad alta pressione.
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Questo prodotto e sensibile alle scosse elettriche. Non lasciar cadere o
sottoporre a scosse il prodotto, poiché cio potrebbe danneggiare o deformare
l'unita centrale provocando una perdita d'acqua.

Le caratteristiche di resistenza all'acqua e alla polvere del prodotto possono
risultare compromesse in sequito a una caduta o un urto.

Se il prodotto si bagna, utilizzare un panno morbido e pulito per asciugarlo
accuratamente.

Lo schermo a sfioramento e altre funzioni potrebbero non funzionare
correttamente se il dispositivo viene usato quando e bagnato.

Il prodotto e resistente allacqua solo quando il vassoio della SIM/Scheda di
memoria & inserito correttamente.

Non aprire o chiudere il vassoio della SIM/Scheda di memoria quando il prodotto
& bagnato o immerso in acqua. L'esposizione del vassoio aperto ad acqua e
all'umidita puo danneggiare il prodotto.

Il vassoio della SIM/Scheda di memoria contiene una guarnizione in gomma
che consente di impedire che polvere, acqua o umidita penetrino nel prodotto.
Non danneggiare la guarnizione in gomma perché polvere, acqua o umidita
potrebbero penetrare nel prodotto e arrecare danni.

A « Lamancata osservanza delle istruzioni fornite potrebbe rendere nulla la garanzia
limitata del dispositivo.

« Seil dispositivo & bagnato, I'LDI collocato all'interno del dispositivo cambia colore. In
questo caso, il dispositivo non sara idoneo per i servizi di riparazione gratuiti forniti
nel contesto della garanzia limitata del dispositivo

« Nonostante una valutazione IP68, il tuo dispositivo non & completamente
resistente all'acqua in tutte le situazioni.
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Componenti e accessori del prodotto

I sequenti articoli sono forniti in dotazione con il dispositivo.

- Dispositivo + Spillo di espulsione
+ Auricolare stereo + Caricabatteria
+ Cavo USB + Guida introduttiva

Gli elementi descritti sopra possono essere facoltativi.

A

Gli elementi forniti in dotazione con il dispositivo ed eventuali accessori disponibili
possono variare a seconda dell'area e del provider del servizio.

Utilizzare sempre accessori LG Electronics originali. Lutilizzo di accessori di altri
produttori puo influire sulle prestazioni di chiamata del dispositivo o causare
malfunzionamenti. Il servizio di riparazione LG potrebbe non coprire simili
situazioni.

Alcune delle componenti del dispositivo sono fatte di vetro temperato. Se si lascia
cadere il dispositivo su una superficie dura o lo si espone a un urto violento, il vetro
temperato potrebbe danneggiarsi. In questi casi, interrompere immediatamente
['uso del dispositivo e contattare un Centro di assistenza clienti LG.

E + In mancanza di uno di questi elementi di base, contattare il rivenditore presso cui &
stato acquistato il dispositivo.
« Per acquistare altri elementi aggiuntivi, contattare un Centro di assistenza clienti
LG.
« Alcuni elementi contenuti nella confezione del prodotto sono soggetti a modifica
Senza preawiso.

L'aspetto e le specifiche del dispositivo sono soggetti a modifica senza preawviso ai
fini del miglioramento del prodotto.

Le specifiche del dispositivo possono variare a seconda dell'area o del provider del
Servizio.

Rimuovere la pellicola protettiva dal sensore di impronte digitali prima di utilizzare
la funzione di riconoscimento delle impronte digitali.
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Panoramica delle parti

Sensore di
prossimita/luminosita
ambientale

Obiettivo fotocamera anteriore

(grandangolare)

Tasti volume (+/-)

Tasto Assistente Google

Jack stereo per auricolare
Microfono

Obiettivi delle fotocamere
posteriori (teleobiettivo /
super-grandangolo / angolo
standard)

Alloggiamento scheda
SIM/scheda di memoria

Altoparlante ——*

Funzioni di base

—)

000e———

Obiettivo fotocamera anteriore
(angolo standard)

Altoparlante auricolare

Tasto accensione/blocco

Touchscreen

Porta per caricabatteria/cavo USB

— Flash

i Sensore per impronte digitali

— Area antenna NFC

— Area dell'antenna per la ricarica

wireless

— Connessione doppio schermo

t  Microfono
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A Non tentare di rimuovere da sé il coperchio posteriore.
Fare cio potrebbe danneggiare gravemente la batteria e il dispositivo, e cio potrebbe
causare surriscaldamento, incendi o infortuni. Il coperchio posteriore e a batteria del
dispositivo non devono essere rimossi o sostituiti da personale non qualificato.

+ Sensore di prossimita/luminosita ambientale

- Sensore di prossimita: Nel corso di una chiamata, il sensore di prossimita
spegne lo schermo e disattiva la funzionalita touch quando il dispositivo
si trova molto vicino al corpo umano. Riaccende lo schermo e attiva la
funzionalita touch quando il dispositivo si trova al di fuori di un campo
specifico.

Sensore di luminosita ambientale: il sensore di luminosita ambientale analizza
lintensita della luce ambientale quando & attiva la modalita di controllo
automatico della luminosita.

+ Tastivolume

- Consentono di regolare il volume delle suonerie, delle chiamate o delle
notifiche.

- Durante [utilizzo della Fotocamera, premere delicatamente un tasto volume
per scattare una foto. Per scattare foto in maniera continua, tenere premuto
il tasto volume.

- Quando lo schermo & spento o bloccato, premere il tasto volume giti (-) due
volte per awiare lapp Fotocamera. Premere due volte il tasto volume su (+)
per awiare Capture+.

+ Tasto accensione/blocco
- Premere brevemente il tasto se si desidera accendere o spegnere lo schermo.
- Tenere premuto il tasto se si desidera selezionare unopzione di alimentazione.
- Tasto Assistente Google

- Il'tuo dispositivo dispone di Assistente Google incorporato. Trovale risposte
e fai cose mentre sei in giro. Per iniziare, basta toccare il tasto Assistente
Google sul lato del telefono. Tenere premuto il tasto per parlare rapidamente
con il tuo assistente. Premere due volte per aprire Google Lens.

- Awio di Assistente Google. Per ulteriori dettagli, consultare Assistente
Google.
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+ Sensore per impronte digitali
- Attivare la funzione di riconoscimento delle impronte digitali per semplificare
il processo di sblocco dello schermo. Per ulteriori dettagli, consultare la
sezione Informazioni generali sul riconoscimento delle impronte digitali.

E L'accesso ad alcune funzioni potrebbe essere limitato a seconda delle specifiche
del dispositivo.

Sul retro del dispositivo e collocata un'antenna NFC integrata. Prestare attenzione
mentre si maneggia il dispositivo, al fine di non danneggiare o coprire lantenna
NFC.

Non poggiare oggetti pesanti né sedersi sul dispositivo. In caso contrario, il
touchscreen potrebbe danneggiarsi.

La pellicola o accessori di protezione dello schermo potrebbero interferire con il
sensore di prossimita.

Se il dispositivo & bagnato o viene utilizzato in un luogo umido, il touchscreen o'i
pulsanti a sfioramento potrebbero non funzionare correttamente.

Tenete correttamente il dispositivo in mano, come mostrato di seguito. Se coprite
il microfono con una mano, dito o cover protettiva durante ['uso del dispositivo, in
caso di chiamata il suono potrebbe risultare poco chiaro.

Corretto Non corretto
Microfono Non coprite il microfono
J.
——m %;2\*:

AN

™~

Microfono Non coprite il microfono.
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Accensione o spegnimento

Accensione
Quando il prodotto e spento, tenere premuto il tasto di accensione/blocco.
E + Quando si accende il dispositivo per la prima volta, viene avviata la configurazione

iniziale. La durata del primo awio dello smartphone potrebbe essere piti lunga di
quella abituale.

Spegnimento
Tenere premuto il tasto di accensione/blocco, quindi selezionare Spegni.

Riavvio del dispositivo

Se il dispositivo non funziona oppure non risponde ai comandi, riawviarlo seguendo
le istruzioni sottostanti.

1 Tenere premuti contemporaneamente il tasto di accensione/blocco e il tasto
volume giti fino a quando il dispositivo non si spegne.

7 Quando viene riawiato il dispositivo, rilasciare il tasto.

E + Questa funzione non é disponibile quando il dispositivo & collegato a LG Dual
Screen (LM-V505N).

Opzioni di alimentazione

Tenere premuto il tasto di accensione/blocco, quindi selezionare unopzione.
+ Spegni: Spegnere il dispositivo.
- Spegni e riavvia: consente di riawiare il dispositivo.
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Installazione della scheda SIM

Inserire la scheda SIM (Subscriber Identity Module, modulo d'identita dell'abbonato)
fornita dal provider del servizio per iniziare a utilizzare il dispositivo.

E « Affinché le caratteristiche di resistenza allacqua e alla polvere siano efficaci, &
necessario che lalloggiamento della scheda sia inserito correttamente.

1 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda.

2 Estrarre lalloggiamento della scheda.
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3 Posizionare la scheda SIM sullalloggiamento con i contatti color oro rivolti verso
il basso.

E + Questo dispositivo supporta solamente le schede Nano SIM.

Nano Micro Standard

« Affinché non si verifichino problemi di prestazioni, si consiglia di utilizzare il
dispositivo con il tipo corretto di scheda SIM. Utilizzare sempre una scheda SIM
realizzata in fabbrica, fornita dall'operatore.

« Sesiinserisce lalloggiamento della scheda nel dispositivo mentre & bagnato, il
dispositivo potrebbe danneggiarsi. Assicurarsi sempre che lalloggiamento della
scheda sia asciutto.
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Inserimento della scheda di memoria

Inserire la scheda di memoria nel dispositivo.

A seconda del produttore e del tipo di scheda di memoria, alcune schede di
memoria potrebbero non essere compatibili con il dispositivo.

1 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda.
2 Estrarre lalloggiamento della scheda.

3 Posizionare la scheda di memoria sullalloggiamento con i contatti color oro
rivolti verso il basso.

Scheda di memoria (Opzionale, venduta
separatamente)

/. Inserire nuovamente lalloggiamento nello slot.

A + Alcune schede di memoria potrebbero risultare non completamente compatibili
con il dispositivo. Lutilizzo di una scheda incompatibile potrebbe causare il
danneggiamento del dispositivo o della scheda di memoria, oppure la corruzione
dei dati salvati al suo interno.

E « Operazioni frequenti di cancellazione e scrittura dei dati possono ridurre la durata

della scheda di memoria.
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Rimozione della scheda di memoria
Per ragioni di sicurezza, disattivare la scheda di memoria prima di rimuoverla.
1 Toccare > Impostazioni > Archiviazione > /\.

2 Inserire lo spillo di espulsione nel foro dellalloggiamento della scheda ed
estrarlo dal dispositivo.

w

Rimuovere la scheda di memoria.

4 Inserire nuovamente lalloggiamento nello slot.

A + Non rimuovere a scheda di memoria mentre il dispositivo sta trasferendo o
accedendo a informazioni. In caso contrario, potrebbe verificarsi la perdita o la
corruzione dei dati, oppure il danneggiamento della scheda di memoria o del
dispositivo. LG non & responsabile di eventuali perdite causate dallabuso o dall'uso
errato delle schede di memoria, compresa la perdita di dati.

Batteria

Carica della batteria
Prima di utilizzare il dispositivo, caricare completamente la batteria.
Caricare il dispositivo con il cavo USB tipo C.

Terminale del cavo di ricarica
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A « Non utilizzare il terminale esterno, il cavo di alimentazione o ['adattatore di genere
del dispositivo in presenza di umidita. Cio puo provocare incendi, scosse elettriche,
infortuni o il malfunzionamento del dispositivo. In caso di umidita, interrompere
immediatamente [utilizzo e rimuovere completamente ['umidita.

Assicurarsi di utilizzare il cavo USB fornito in dotazione con il dispositivo.

Assicurarsi di utilizzare caricabatteria e cavo di caricamento approvati da LG. Se
la batteria viene caricata con un caricabatteria di terze parti, la batteria potrebbe
esplodere o danneggiarsi.

Il dispositivo e dotato di una batteria ricaricabile interna. Per motivi di sicurezza,
non rimuovere |a batteria incorporata.

L'utilizzo del dispositivo durante il caricamento potrebbe causare scosse elettriche.
Per utilizzare il dispositivo, interrompere il caricamento.

E « Rimuovere il caricabatteria dalla presa di alimentazione una volta completato il
caricamento del dispositivo. In questo modo si evita un inutile consumo di corrente.

+ Un adattatore di ricarica che supporta |a ricarica rapida e incluso nel prodotto.

« Lafunzione di ricarica rapida potrebbe non funzionare se si utilizza un adattatore
di ricarica rapida diverso da quello originale fornito in dotazione con il prodotto.

Per caricare |a batteria, & anche possibile collegare un cavo USB tra il dispositivo
e un computer desktop o portatile. Questo metodo puo richiedere piti tempo
rispetto al collegamento delladattatore a una presa a parete.

« Non caricare la batteria con un hub USB non in grado di mantenere la tensione
nominale. Il caricamento potrebbe non riuscire o arrestarsi inavvertitamente.

Precauzioni per ['utilizzo del dispositivo

« Assicurarsi di utilizzare il cavo USB fornito in dotazione, non utilizzare cavi USB
o caricabatterie di terze parti con il dispositivo. La garanzia limitata LG non copre
l'uso di accessori di terze parti.

+ Il mancato rispetto delle istruzioni contenute in questa quida e ['utilizzo non
corretto potrebbero portare al danneggiamento del dispositivo.
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Ricarica wireless

Questo dispositivo supporta una funzione di ricarica wireless. Carica il dispositivo
con un caricabatteria wireless certificato Qi (opzionale, venduto separatamente).

Caricare la batteria con un caricabatteria wireless

1 Colloca il tuo dispositivo al centro del caricabatteria wireless, allineandolo con
I'antenna per la ricarica wireless sul retro del dispositivo.

« Per controllare ['area dell'antenna per la ricarica wireless, vedere Panoramica

delle parti.

7 Quando la batteria & stata ricaricata, rimuovere il dispositivo dal caricabatteria.

A

Quando si ricarica la batteria con il caricabatteria wireless, evitare di porre materiali
magnetici, metallici o conduttori tra il dispositivo e il caricabatteria. Infatti, questi
materiali possono disturbare la ricarica e far surriscaldare il caricabatteria. In
questo caso, il dispositivo, il caricabatteria o la carta SIM/scheda di memoria
possono essere danneggiati.

Se la temperatura della batteria supera un certo livello quando il dispositivo & in
carica, sara necessario interrompere |a ricarica.

Se materiali magnetici, metallici o conduttori dovessero trovarsi vicino al retro del
dispositivo, oppure fosse inserita una custodia protettiva, il dispositivo potrebbe
non essere caricato adeguatamente.

Se siricarica la batteria con il caricabatteria wireless in aree in cui il segnale di
rete & debole, le prestazioni di rete del tuo dispositivo potrebbero essere ridotte
ulteriormente.

Carica il dispositivo con un caricabatteria wireless certificato Qi (opzionale, venduto
separatamente). Dato che la garanzia limitata LG non copre (uso di accessori di
terze parti, contattare il produttore delle stesse.

Questo prodotto supporta la ricarica wireless. Per ricaricare il prodotto utilizzare
un caricabatterie wireless certificato Qi (venduto separatamente). Alcuni
caricabatterie wireless con cavo a spirale potrebbero non supportare |a ricarica
wireless. | caricabatterie che supportano il profilo EPP (Extended Power Profile)
consento la ricarica wireless ad alta velocita.

LG Electronics declina ogni responsabilita per problemi riguardanti accessori di
altre marche. Per tali problemi, contattare il produttore dellaccessorio.
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Utilizzo efficiente della batteria

La durata della batteria puo diminuire se sul dispositivo sono in esecuzione diverse
app e funzioni contemporaneamente e in maniera continuativa.

Annullare le operazioni in background per aumentare la durata della batteria.
Per ridurre al minimo il consumo della batteria, seguire questi suggerimenti:
« Disattivare la funzione Bluetooth o rete Wi-Fi quando non le si utilizza.
+ Impostare lo spegnimento dello schermo su un lasso di tempo il piti breve
possibile.
+ Ridurre al minimo la luminosita dello schermo.
+ Impostare un blocco schermo quando il dispositivo non & in uso.
« Controllare il livello della batteria quando si utilizza una qualsiasi delle app
scaricate.
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Touchscreen

E possibile imparare a conoscere le modalita di controllo del dispositivo mediante
[utilizzo di gesti touch sul touchscreen.

Toccare

Toccare leggermente con la punta del dito per selezionare o eseguire unapp o
unopzione.

Tenere premuto

Toccare e tenere premuto per diversi secondi per visualizzare un menu con le
opzioni disponibili.
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Toccare due volte

Toccare rapidamente due volte per eseguire lo zoom avanti o indietro su una pagina
\Web o su una mappa.

Trascinamento

Toccare e tenere premuto un elemento, ad esempio un‘app o un widget, quindi
spostare il dito in un'altra posizione con un movimento controllato. E possibile
utilizzare questo gesto per spostare un elemento.

Trascinare

Toccare lo schermo e muovere velocemente il dito senza fermarsi. E possibile
utilizzare questo gesto per scorrere un elenco, una pagina \Web, delle foto, delle
schermate e altro ancora.
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Awvicinare e allontanare le dita

Awicinare due dita per eseguire lo zoom indietro, ad esempio su una foto o una
mappa. Per eseguire lo zoom avanti, allontanare le dita.

B

Non esporre il touchscreen a eccessivi urti fisici. Il sensore touch potrebbe
danneggiarsi.

Se il dispositivo viene utilizzato vicino a materiale magnetico, metallico o
conduttore, potrebbe verificarsi un guasto del touchscreen.

Se si utilizza il dispositivo sotto luci intense come la luce solare diretta, lo schermo
potrebbe non essere visibile a seconda della posizione. Utilizzare il dispositivo

in una posizione ombreggiata o con una luce ambiente non troppo intensa, ma
sufficientemente luminosa da consentire [a lettura.

Non premere lo schermo applicando una forza eccessiva.

Toccare delicatamente ['opzione desiderata con la punta del dito.

Il controllo touch potrebbe non funzionare correttamente se si tocca lo schermo
indossando un guanto o con la punta dell'unghia.

Il controllo touch potrebbe non funzionare correttamente se lo schermo e umido
o0 bagnato.

Il touchscreen potrebbe non funzionare correttamente se sul dispositivo &
applicata una pellicola o un accessorio di protezione dello schermo acquistati da un
negozio di terze parti.

La visualizzazione di un'immagine statica per lunghi periodi di tempo potrebbe
causare il fenomeno delle immagini residue o di ritenzione delle immagini.
Spegnere lo schermo o evitare di visualizzare la stessa immagine per un lungo
periodo quando il dispositivo non & in uso.
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Schermata Home

Informazioni generali sulla schermata Home

La schermata Home ¢ il punto di partenza per accedere a diverse funzioni e app
sul dispositivo. Toccare () su qualsiasi schermata per passare direttamente alla
schermata Home.

Sulla schermata Home e possibile gestire tutte le app e i widget. Scorrere sulla
schermata verso sinistra o destra per visualizzare in un colpo docchio tutte le app
installate.

Layout della schermata Home

E possibile visualizzare tutte le app e organizzare i widget e le cartelle sulla
schermata Home.

Barra distato —¢ L LN

Hdaeemetee 4._

_0— Widget di ricerca di Google

Cartella —3¢!

Icona della pagina

le— Area di accesso rapido

Pulsanti a sfioramento anteriori *.“

E + La schermata Home puo variare a seconda della politica del produttore, delle
impostazioni dell'utente, della versione del software o del provider del servizio.
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Barra di stato: consente di visualizzare le icone di stato, lorario e il livello della
batteria.

Widget meteo: consente di visualizzare le informazioni meteorologiche e
l'orario di una zona specifica.

Widget di ricerca di Google: digita o parla per aprire Google Search.

Cartella: £ possibile creare cartelle per classificare le app in base ai criteri
desiderati.

Icona della pagina: consente di visualizzare il numero totale di aree della
schermata Home. E possibile toccare licona della pagina desiderata per
accedere alla pagina selezionata. L'icona corrispondente allarea corrente verra
evidenziata.

Area di accesso rapido: e possibile fissare le app principali nella parte inferiore
dello schermo in modo che siano accessibili da qualsiasi area della schermata
Home.

Pulsanti a sfioramento anteriori

- < consente di tornare alla schermata precedente. Consente inoltre di
chiudere la tastiera o le finestre popup.

- (O :toccare per tornare alla schermata Home. Per awiare la ricerca con
Google, tenere premuto.

- [ toccare per visualizzare un elenco di app utilizate di recente o esequire
unapp dallelenco. Per eliminare tutte le app utilizzate di recente, toccare
CANCELLA TUTTO. Per utilizzare due app contemporaneamente con la
funzione Multi window, toccare e tenere premuto il pulsante durante ['utilizzo
di unapp.
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Cambio dello stile dei pulsanti a sfioramento

anteriori
E possibile cambiare lo stile dei pulsanti a sfioramento anteriori.

1 Toccare > Impostazioni > Display > Barra di navigazione.

2 In STILE, selezionare lopzione preferita.
- Gesti:
- Vai a schermata iniziale: Scorri verso [alto dal bordo inferiore dello
schermo.
- Indietro: Scorri verso l'interno dal bordo sinistro o destro di schermo.
- Vai a Schermate recenti: Scorri verso [ alto e tieni premuto dal bordo
fondo di schermo.
- Passa da una applicazioni all'altra: Scorri verso destra sul bordo inferiore
dello schermo per accedere alle app utilizzate in precedenza.
+ Gesti e Pulsanti: Sono disponibili il pulsante Indietro < e il pulsante Home
. Per vedere le app recenti, scorrere verso lalto il pulsante Home &.

- Solo pulsanti: <]/ () /[] sono disponibili. Toccare [_] per vedere le app
recenti.

Modifica dei pulsanti a sfioramento anteriori
E possibile riorganizzare i pulsanti a sfioramento anteriori o aggiungere le funzioni
utilizzate pili spesso in questarea.
Toccare () > Impostazioni > Display > Barra di navigazione > Combinazione di
tasti e personalizzare le impostazioni.
+ Sono disponibili diverse funzioni, tra cui Notifica o Capture+. E possibile
aggiungere due elementi extra.

4« o o ‘ np @J

7

W
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Icone di stato

Quando & presente una notifica relativa a un messaggio non letto, un evento del
calendario o una sveglia, nella barra di stato viene visualizzata licona di notifica
corrispondente. Verificare lo stato del dispositivo visualizzando le icone di notifica
presenti nella barra di stato.

x

Nessun segnale

Trasmissione di dati tramite la rete in corso
=N P

© Sveglia impostata

n(d Modalita vibrazione attiva

Bluetooth attivo

Collegato a un computer tramite USB

Livello batteria

Modalita Aereo attiva

Chiamate senza risposta

Wi-Fi attivo

Modalita silenziosa attiva

GPS attivo

Hotspot attivo

Nessuna scheda SIM

La modalita NFC ¢ attiva

Alcune di queste icone potrebbero apparire in modo diverso o non apparire
affatto a seconda dello stato del dispositivo. Fare riferimento alle icone in base
all'ambiente e alla zona effettivi in cui si utilizza il dispositivo nonché al provider
del servizio.

Le icone visualizzate possono variare a seconda dell'area o dei provider dei servizi.
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Pannello notifiche
E possibile aprire il pannello notifiche trascinando la barra di stato verso il basso
sulla schermata principale.
- E possibile trascinare verso il basso la finestra di awiso o toccare l'icona della
freccia per aprire l'elenco delle icone di impostazione rapida.
- E possibile toccare 0 peraggiungere, eliminare o disporre le icone nella finestra
di awiso.
+ Tenendo premuta licona, viene visualizzata la schermata delle impostazioni
relative alla funzione in questione.

E - E possibile utilizzare il pannello notifiche anche durante il blocco schermo. Trascina
il pannello notifiche quando lo schermo é bloccato per accedere rapidamente alle
funzioni desiderate
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Cambio di orientamento dello schermo

E possibile impostare il cambio automatico di orientamento dello schermo in base
allorientamento fisico del dispositivo.

Nel pannello notifiche, toccare Rotazione nellelenco delle icone di accesso rapido.

In alternativa, toccare () > Impostazioni > Display e attivare Rotazione
automatica.
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Modifica della schermata Home

Nella schermata Home, toccare e tenere premuto uno spazio vuoto, quindi awiare
l'azione desiderata da sotto.

Per ridisporre le aree della schermata Home, toccare e tenere premuta un'area e
trascinarla in un‘altra posizione.

Per aggiungere un widget alla schermata Home, toccare e tenere premuta
un‘area vuota della schermata Home, quindi selezionare Widget.

Per modificare sfondi, temi, icone e AOD, toccare e tenere premuta un'area
vuota della schermata Home, quindi selezionare Sfondo & Tema.

E inoltre possibile toccare () > Impostazioni > Display > Sfondo & Tema,
quindi selezionare sfondi, temi, icone e AOD da applicare al dispositivo.

Per configurare le impostazioni della schermata Home, toccare e tenere
premuta un'area vuota della schermata Home, quindi selezionare Imposta
schermata home. Per ulteriori dettagli, consultare la sezione Impostazioni della
schermata Home.

Per visualizzare o reinstallare le app disinstallate, toccare e tenere premuta
un‘area vuota della schermata Home, quindi selezionare Cestino app. Per
ulteriori dettagli, consultare la sezione Cestino app.

Per cambiare la schermata predefinita, toccare e tenere premuta un'area vuota

della schermata Home, spostarsi sulla schermata desiderata, toccare £}, quindi
toccare nuovamente la schermata.

L —  Schermata predefinita
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Visualizzazione del tema di sfondo

Nella schermata Home e possibile visualizzare solo l'immagine di sfondo
nascondendo app e widget.

Allontanare due dita sulla schermata Home.

+ Per tornare alla schermata originale con la visualizzazione di app e widget,
awicinare le dita sulla schermata Home o toccare <]

Spostamento di app sulla schermata Home

Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla in
un'altra posizione.
+ Perinserire le app utilizzate pil spesso nella parte inferiore della schermata
Home, toccare e tenere premuta un‘app, quindi trascinarla nell’area di accesso
rapido nella parte inferiore.

+ Per rimuovere un'icona dallarea di accesso rapido, trascinarla nella schermata
Home.
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Utilizzo delle cartelle dalla schermata Home

Creazione di cartelle

Nella schermata Home, toccare e tenere premuta un'app, quindi trascinarla su
un'altra app.
+ Viene creata una nuova cartella e le app vengono aggiunte al suo interno.

Modifica di cartelle

Nella schermata Home, toccare una cartella ed eseguire una delle seguenti azioni.

- Per modificare il nome e il colore della cartella, toccare il nome della cartella.

« Per aggiungere app, toccare e tenere premuta una app, quindi trascinarla sopra

la cartella e rilasciarla.

+ Per rimuovere un'app dalla cartella, toccare e tenere premuta ['app, quindi
trascinarla all'esterno della cartella. Se l'app rimossa e ['unica esistente nella
cartella, viene rimossa automaticamente anche la cartella.

- E anche possibile aggiungere o rimuovere le app dopo aver toccato (+) nella
cartella.

E « Quando si utilizza un tema scaricato, non e possibile modificare il colore della
cartella.

Impostazioni della schermata Home
E possibile personalizzare le impostazioni della schermata Home.

1 Toccare O > Impostazioni > Display > Sfondo.

7 Personalizzare le seguenti impostazioni:

- Seleziona Launcher: consente di selezionare una modalita per la schermata

Home.
+ Sfondo: consente di cambiare lo sfondo della schermata Home.

- Effetto scorrimento schermo: consente di selezionare un effetto da
applicare quando si passa a un'altra area della schermata Home.

« Aspetto delle icone: consente di scegliere se si desidera che le icone
abbiano gli angoli squadrati o arrotondati.
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Schermata Home sinistra: E possibile selezionare gli effetti da usare
quando si passa a un‘altra schermata Home.

Ordina le app per:Impostare la modalita di ordinamento delle app sulla
schermata Home.

Griglia: consente di modificare la modalita di disposizione delle app nella
schermata Home.

Nascondi applicazioni: consente di selezionare le app da nascondere nella
schermata Home.

Scorrimento continuo: attivare per consentire lo scorrimento continuo della
schermata Home (ritorno alla prima schermata dopo ['ultima schermata).

+ Questa funzione non ¢ disponibile quando ¢ abilitato Google Feed.

Ricerca: consente di effettuare una ricerca scorrendo verso il basso sulla
schermata Home.

Sfondo Lock: consente diimpedire che le app o i widget siano spostati o
rimossi.

Blocco schermo

Informazioni generali sul blocco schermo

Lo schermo del dispositivo si spegne e si blocca se si preme il tasto di accensione/
blocco. Il blocco awiene anche quando il dispositivo viene lasciato inattivo per un
determinato periodo di tempo.

Se si preme il tasto di accensione/blocco senza limpostazione di un blocco schermo,
viene immediatamente visualizzata la schermata Home.

Per maggiore sicurezza e per impedire ['accesso indesiderato al dispositivo,
impostare un blocco schermo.

5

« Il blocco schermo impedisce inutili input tocco sullo schermo del dispositivo
e riduce il consumo della batteria. E altamente consigliabile attivare il blocco
schermo mentre non si usa il dispositivo.
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Impostazione di un blocco schermo

Per la configurazione delle impostazioni del blocco schermo sono disponibili varie
opzioni.

1 Toccare O > Impostazioni > Blocco schermo & sicurezza > Seleziona il
blocco dello schermo e quindi selezionare il metodo preferito.

7 Personalizzare le sequenti impostazioni:

5

Nessuno: consente di disattivare la funzione di blocco schermo.
Trascina: consente di scorrere con un dito sullo schermo per sbloccarlo.

Knock Code: Consente di sbloccare lo schermo toccandolo con una
determinata sequenza.

Sequenza: consente di disegnare una sequenza per sbloccare lo schermo.
PIN: consente di immettere una password numerica per sbloccare lo
schermo.

Password: consente diimmettere una password alfanumerica per sbloccare
lo schermo.

Impronte digitali: consente di sbloccare lo schermo utilizzando le impronte
digitali.

Consenti Riconoscimento del volto: Consente di sbloccare lo schermo
tramite il riconoscimento del volto.

« Se i tenta di sbloccare in maniera scorretta il dispositivo per 5 volte, lo schermo
viene bloccato per 30 secondi.

Impostazioni di avvio sicuro
Quando si seleziona Knock Code, Sequenza, PIN o Password come metodo di blocco
schermo, e possibile configurare il dispositivo affinché venga bloccato ogni volta che
lo si accende per proteggere i dati.
+ Finché il dispositivo non viene sbloccato, non e possibile utilizzarne le funzioni,
ad eccezione delle chiamate di emergenza.

+ Se e stata dimenticata la password di decrittografia, non € possibile ripristinare i
dati decrittografati né le informazioni personali.
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Precauzioni per la funzione "Awvio sicuro"

+ Se e stata dimenticata la password di decrittografia, non & possibile ripristinare i
dati decrittografati né le informazioni personali.

+ Assicurati di mantenere le tue password per il blocco schermo separate.

+ Seinserisci una password sbagliata per il blocco schermo piti del numero di
volte consentito, il dispositivo si resetta in automatico, cancellando tutti dati
crittografati e le informazioni personali contenute, che non possono pili essere
recuperate.

- Fare attenzione a non inserire una password sbagliata per il blocco schermo pit
del numero di volte consentito.

Quando accendi il dispositivo subito dopo averlo resettato, viene riawiata
anche la crittografia. Se interrompi volontariamente la crittografia, alcuni dati
potrebbero danneggiarsi. Assicurati di attendere il completamento del reset.

Personalizza Blocco schermo

Puoi personalizzare il blocco schermo.

1 Toccare O > Impostazioni > Blocco schermo & sicurezza > Personalizza
Blocco schermo.

7 Seleziona una funzione che vuoi impostare.
+ Sfondo: Consente di impostare lo sfondo del blocco schermo.

+ Orologio: Consente di impostare il punto in cui posizionare ['orologio sul
blocco schermo.

« Collegamenti: Consente di scegliere le app da esequire sul blocco schermo.
Questa impostazione appare solo quando uno schermo di blocco viene
impostato.

- Animazione meteo: Consente di visualizzare le animazioni meteo relative
alla posizione attuale sulla schermata di blocco.

- Informazioni di contatto per telefono perso: Consente di impostare il
testo da visualizzare sulla schermata di blocco per identificare il proprietario
del telefono.
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Impostazioni di Blocco con sicurezza
Puoi impostare blocchi schermo sicuri.

1 Toccare Q> Impostazioni > Blocco schermo & sicurezza > Impostazioni di
Blocco con sicurezza.

2 Seleziona una funzione che vuoi impostare.

5

Rendi visibile la sequenza: Consente di rendere visibile la sequenza.

Blocco timer: Consente di impostare l'intervallo di tempo prima che
lo schermo si blocchi automaticamente dopo lo spegnimento della
retroilluminazione (time out a causa di inattivita).

Blocco istantaneo con tasto accensione: Attivare questa opzione

per bloccare istantaneamente lo schermo quando si preme il tasto di
accensione/blocco. Questa impostazione supera le impostaszioni del timer
del blocco di sicurezza.

Mostra blocco: Consente di visualizzare lopzione del menu di spegnimento
per la disattivazione delle notifiche nella schermata di blocco, il blocco smart
e i blocchi biometrici.

Smart Lock: Consente di impostare dispositivi, luoghi, voce e/o rilevamento
su corpo affidabili che permettono al tuo telefono di restare sbloccato.

+ I menu che puoi impostare possono essere differenti a seconda dei metodi di
blocco dello schermi che scegli.

Toc Toc
E possibile accendere o spegnere o schermo toccandolo due volte.

5

« Questa opzione é disponibile solo sulla schermata Home fornita da LG. Potrebbe
non funzionare correttamente su un launcher personalizzato o sulla schermata
Home installata dall'utente.

+ Quando si tocca lo schermo, utilizzare la punta di un dito. Non utilizzare un'unghia.

Per utilizzare la funzione Toc Toc, assicurarsi che il sensore di prossimita/luminosita
non sia ostruito da un adesivo o da un‘altra sostanza estranea.
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Accendi lo schermo
Toccare due volte il centro dello schermo.

+ Se sitocca la parte superiore o inferiore dello schermo, a velocita di
riconoscimento potrebbe essere pill bassa.

Spegni lo schermo

Toccare due volte uno spazio vuoto nella schermata Home e nella schermata di
blocco.

In alternativa, toccare due volte uno spazio vuoto sulla barra di stato.

Disattivazione di Toc Toc
Se non si desidera utilizzare la funzione KnockON, impostare come segue:

Toccare () > Impostazioni > Estensioni > Toc Toc e trascinare per disabilitare la
funzione.

Knock Code

E possibile sbloccare lo schermo creando un codice Knock Code personale. Quando
lo schermo e bloccato, si potra accedere direttamente alla schermata Home
toccando lo schermo secondo la sequenza specificata.

E possibile utilizzare il codice Knock Code insieme alla funzione Toc Toc

+ Quando si tocca lo schermo, assicurarsi di utilizzare la punta di un dito.

Creazione di un codice Knock Code

1 Toccare O > Impostazioni > Blocco schermo & sicurezza > Seleziona il
blocco dello schermo > Knock Code.

7 Toccare i quadrantiin base a una sequenza di propria scelta per creare il codice
Knock Code, quindi toccare Avanti.

3 Asscopo di verifica, immettere di nuovo il codice Knock Code creato, quindi
toccare CONFERMA.
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Sblocco dello schermo con un codice Knock Code
E possibile sbloccare lo schermo immettendo il codice Knock Code creato.

Si puo inoltre immettere il proprio codice Knock Code sul touchscreen quando lo
schermo e spento.

- E possibile immettere un codice Knock Code anche quando la schermata di
blocco e accesa.

Crittografia della scheda di memoria

E possibile crittografare e proteggere i dati salvati sulla scheda di memoria.
l'accesso ai dati crittografati sulla scheda di memoria non sara possibile da un altro
dispositivo.

1 Toccare O > Impostazioni > Blocco schermo & sicurezza > Crittografia e
credenziali > Cripta la Scheda SD.

7 Leggere le informazioni generali sulla crittografia della scheda di memoria
visualizzate sullo schermo, quindi toccare Continua per continuare.
3 Selezionare un'opzione e toccare Codifica ora.

- Crittografia del nuovo file: consente di crittografare solo i dati salvati sulla
scheda di memoria dopo |a crittografia.

- Crittografia completa: consente di crittografare tutti i dati attualmente
salvati sulla scheda di memoria.

+ Escludi file multimediali: consente di crittografare tutti i file ad eccezione di
quelli multimediali come musica, foto e video.
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Una volta awiata la crittografia di una scheda di memoria, alcune funzioni non
sono disponibili.

i

« Seil dispositivo si spegne mentre la crittografia & in corso, il processo di crittografia
non riuscira e alcuni dati potrebbero danneggiarsi. Occorre percio assicurarsi che il
livello della batteria sia sufficiente prima di awiare la crittografia.

L'accesso ai file crittografati & possibile solo dal dispositivo in cui i file sono stati
crittografati.

La scheda di memoria crittografata non puo essere utilizzata su un altro
dispositivo LG. Per utilizzare la scheda di memoria crittografata su un altro
dispositivo mobile, formattare la scheda.

« E possibile attivare la crittografia della scheda di memoria anche se nel dispositivo
non é installata alcuna scheda di memoria. Qualsiasi scheda di memoria installata
dopo la crittografia verra automaticamente crittografata.

Acquisizione di screenshot

E possibile acquisire screenshot della schermata che si sta visualizzando.

Tramite un collegamento rapido
Tenere premuti contemporaneamente il tasto di accensione/blocco e il Tasto
volume git per almeno due secondi.

+ Gli screenshot possono essere visualizzati nella cartella Screenshots nella
Galleria.

Tramite la funzione Capture+

Nella schermata di cui si desidera acquisire uno screenshot, trascinare verso il basso
la barra di stato, quindi toccare [Z,.

E + Quando lo schermo & spento o bloccato, & possibile accedere alla funzione
Capture+ premendo due volte il tasto volume su. Per utilizzare questa funzione,
toccare (O) > Impostazioni > Estensioni > Collegamenti e attivare Apri
Capture+.

« Per ulteriori dettagli, consultare la sezione Scrittura di note su uno screenshot.
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Immissione di testo

Utilizzo della barra degli strumenti Smart

E possibile usare vari metodi di immissione da tastiera da un'unica posizione. E
possibile selezionare il metodo di immissione desiderato dalla parte superiore della
tastiera.

1

2

Selezionare il metodo di immissione da tastiera desiderato dalla barra degli
strumenti Smart.

Toccare \/ e selezionare il metodo di immissione da visualizzare nella barra
degli strumenti Smart, oppure riorganizzarli.

_—
Barradegi —so © & 4 ¢ ® & | ® 6 & % @ 6
strumenti —_—
Smart
= P 22
ke a
T

+ I metodi di immissione supportati possono variare a seconda del dispositivo.

- E possibile attivare o disattivare la barra degli strumenti Smart dalle impostazioni
della tastiera.

« E possibile anche utilizzare i metodi di immissione da tastiera toccando £63.

. @ :Aggiungere emoji.
. @ :Aggiungere avatar sticker.
@ :Aggiungere sticker animati.

0 :Sulla tastiera, toccare &

- Per ottimizzare il riconoscimento dei comandi vocali, pronunciarli in modo
chiaro.

- Per immettere testo con la voce, assicurarsi che il dispositivo sia connesso
aunarete.
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- Per selezionare la lingua per il riconoscimento vocale, toccare % > Lingue
sulla schermata del riconoscimento vocale.

- Questa funzione potrebbe non essere supportata o le lingue supportate
potrebbero variare a seconda della zona di copertura del servizio.

- §03 : Accedere alle impostazioni della tastiera.
. : Aprire Appunti. Per ulteriori informazioni, consultare la sezione Appunti.

. : Attivare a tastiera fluttuante quando si usa la funzione Multi Window. E
possibile anche spostare |a testiera nella posizione desiderata.

Utilizzo della tastiera Smart
E possibile utilizzare [a tastiera Smart per immettere e modificare testo.

Con la tastiera Smart il testo viene visualizzato mentre lo si digita, senza dover
passare dalla schermata a una tastiera tradizionale e viceversa. In questo modo &
possibile trovare e correggere con facilita gli eventuali errori durante la digitazione.

Spostamento del cursore

Con la tastiera Smart & possibile spostare il cursore esattamente nella posizione
desiderata. Quando si digita un testo, toccare e tenere premuta la barra spaziatrice,
quindi trascinarla verso sinistra o destra.

Smari keyboard

E « Questa opzione é disponibile solo sulla tastiera QWERTY.
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Suggerimento di parole

La tastiera Smart analizza automaticamente abitudini di utilizzo dell'utente per
suggerire le parole utilizzate pili spesso durante la digitazione. Quanto piu si utilizza
il dispositivo, tanto pil precisi saranno i suggerimenti.

Immettere un testo, quindi toccare una parola suggerita o trascinare delicatamente
verso lalto il lato sinistro o destro della tastiera.

+ La parola selezionata viene inserita automaticamente. Non e necessario digitare
manualmente ogni lettera della parola.

Smartphone smart  Smartphones Smartphone  Smart Smartphones

A NEEEEEER L L IALL

Aggiunta di lingue alla tastiera
E possibile rendere disponibili ulteriori lingue per linput tramite tastiera.

T Toccare Q> Impostazioni > Sistema > Lingua e tastiera > Gestisci tastiere
> Tastiera LG > Lingua e Layout tastiera>> Seleziona lingua.

2 Selezionare le lingue che si desidera rendere disponibili.
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Copia e incolla
E possibile tagliare o copiare del testo da unapp, quindi incollarlo nella stessa app. £
anche possibile eseguire altre app e incollare il testo al loro interno.

T Toccare e tenere premuta l'area attorno al testo che si desidera copiare o
tagliare.

7 Trascinare @/ B per specificare l'area da copiare o tagliare.
3 Selezionare TAGLIA o COPIA.
« Il testo tagliato o copiato viene aggiunto automaticamente agli Appunti.

/. Toccare e tenere premuta la finestra di inserimento del testo, quindi selezionare
INCOLLA.

E « Inassenza di un elemento copiato o tagliato, l'opzione INCOLLA non verra
visualizzata.

Appunti
Quando si copia o si taglia un'immagine o un testo, tali elementi vengono salvati
automaticamente negli Appunti e possono essere incollati ovunque in qualsiasi
momento.
1 Nella barra degli strumenti Smart, selezionare .
In alternativa, toccare e tenere premuta la finestra di inserimento del testo,
quindi selezionare APPUNTI.
2 Selezionare e incollare un elemento negli Appunti.
- E possibile salvare negli Appunti fino a un massimo di 20 elementi.

- Toccare £} per bloccare gli elementi salvati al fine di non eliminarli anche
quando la quantita massima viene superata. E possibile bloccare fino a
un massimo di dieci elementi. Per eliminare gli elementi bloccati, & prima
necessario sbloccarli.

- Toccare {if] per eliminare gli elementi salvati negli Appunti.

E « Gli Appunti potrebbero non essere supportati da alcune app scaricate.
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Condivisione di contenuti

Riproduzione di contenuti da un altro dispositivo
E possibile riprodurre foto, video o canzoni salvate sul proprio dispositivo da una TV,
1 Connettere laTV e il dispositivo alla stessa rete Wi-Fi.

2 Mentre sivisualizzano gli elementi dell'app Galleria o Musica, toccare Cg o + >
Riproduci su un altro dispositivo.
Oppure toccare () > Impostazioni > Dispositivi connessi > Condivisione
schermo e quindi toccare () per attivarlo.

3 Selezionare la TV a cui si desidera connettersi.

E + Per [utilizzo con Chromecast, e consigliabile che i servizi di Google Play siano
aggiornati

Visualizzazione di contenuti da dispositivi vicini

E possibile visualizzare contenuti da diversi dispositivi, come ad esempio un
computer; un dispositivo NAS o un dispositivo mobile, utilizzando le app Galleria o
Musica.

Toccare () > Impostazioni > Dispositivi connessi > Server multimediale, quindi
toccare Condivisione di contenuti () per attivarlo.

Connessione dei dispositivi

Connettere sia il proprio dispositivo che un altro dispositivo in grado di supportare
la funzione DLNA alla stessa rete wireless.

5 « Assicurarsi che la Condivisione file (DLNA) sia attiva sia nel dispositivo mittente
che nel dispositivo connesso.

Ricerca di dispositivi vicini
E possibile visualizzare un elenco di dispositivi DLNA connessi alla stessa rete
selezionando il menu + > Dispositivi nelle vicinanze in ciascuna app.

Si possono utilizzare i contenuti di dispositivi vicini come se li si stesse utilizzando
sul proprio dispositivo.
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Invio o ricezione di file

E possibile condividere file tra il proprio dispositivo e un altro dispositivo LG, oppure
un tablet o un computer.

Invio di file

Dalla Galleria, File Manager o altre app, toccare : > Condividi o <, quindi
selezionare un dispositivo nellelenco di condivisione file.

Ricezione di file
Trascinare verso il basso la barra di stato e toccare Condivisione File.

Se il proprio dispositivo non supporta la funzione di condivisione file, toccare (O >
Impostazioni > Dispositivi connessi > Condivisione File > SmartShare Beam

[®D)

5 « E possibile condividere file con determinati dispositivi che supportano DLNA.

Visualizzazione di contenuti dal cloud

E possibile visualizzare direttamente i contenuti salvati nel proprio account sul cloud
senza scaricarli sul dispositivo.

1 Dallapp Galleria 0 Musica, selezionare : > Cloud.
0O dall'app File Manager, selezionare => Cloud.

2 Selezionare un account cloud ed effettuare laccesso.

3 Salvare o riprodurre contenuti sul proprio cloud.
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Non disturbare

E possibile limitare o disattivare laudio delle notifiche per evitare di essere disturbati
per un determinato periodo di tempo.

Toccare () > Impostazioni > Suono > Non disturbare.
+ Toccare Modo e selezionare la modalita desiderata:

- Solo priorita: consente di ricevere le notifiche sonore o con vibrazione per le
app selezionate. Anche se ¢ attiva la modalita Solo priorita, le sveglie suonano
comunque.

- Silenzio totale: consente di disabilitare sia laudio che la vibrazione.

- Seleziona le priorita: rricevi allarmi e le notifiche per le app selezionate.
- Chiamate da:imposta una serie di notifiche quando ricevi una chiamata.

5 « Chiamate ripetute: [a seconda chiamata dalla stessa persona entro 15 minuti non
viene resa silenziosa.

- Messaggi da:imposta una serie di notifiche quando ricevi un messaggio.
Utilizza modalita Non disturbare: Attiva la funzionalita Non disturbare.

PIANIFICAZIONE: imposta il programma in base al quale attivare la funzionalita
Non disturbare.
Guida: Visualizzare la quida per Non disturbare.
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Installazione e disinstallazione di app

Installazione di app
E possibile accedere a uno store di app per cercare e scaricare delle app.

+ Sipuo utilizzare SmartWorld, Play Store o lo store di app fornito dal proprio
gestore del servizio.

E « Alcuni store di app potrebbero richiedere la creazione di un account e la
registrazione.

« Alcune app potrebbero essere a pagamento.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

+ SmartWorld potrebbe non essere supportato a seconda dell'area o del provider
del servizio.

Disinstallazione di app
Disinstallare le app inutilizzate dal dispositivo.

Disinstallazione con il gesto di tocco e pressione lunga
Toccare e tenere premuta unarea vuota della schermata, e quindi toccare €
dellapp da eliminare.
+ Se le app sono state disinstallate nelle ultime 24 ore, e possibile reinstallarle. Per
ulteriori dettagli, consultare la sezione Cestino app.

Disinstallazione tramite il menu delle impostazioni
Toccare (O > Impostazioni > App & notifiche > Informazioni applicazione,

selezionare un'app, quindi toccare Disinstalla.

E « Alcune app non possono essere disinstallate dagli utenti
Disinstallazione di app dallo store di app
Per disinstallare un'app, accedere allo store di app da cui & stata scaricata e

disinstallarla.
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Installazione e disinstallazione di app durante il

setup

Quando si accende il dispositivo per la prima volta, e possibile scaricare le app
consigliate.
E possibile saltare alla fase successiva senza linstallazione.

Cestino app
E possibile visualizzare le app disinstallate. E inoltre possibile reinstallare le app che
sono state disinstallate nelle ultime 24 ore.
T Toccare > Gestione > Cestino app.
Si puo inoltre toccare e tenere premuta unarea vuota della schermata Home,
quindi toccare Cestino app.
7 Attivare la funzione desiderata:
« Ripristina: consente di reinstallare lapp selezionata.
- {i1] : consente di rimuovere definitivamente dal dispositivo le app disinstallate.

E « Le app disinstallate vengono rimosse automaticamente dal dispositivo 24 ore
dopo la disinstallazione. Se si desidera reinstallare le app disinstallate, & necessario
scaricarle nuovamente dallo store di app.

+ Questa funzione e attiva solamente sulla schermata Home. Se si disinstallano delle
app mentre si utilizza la schermata EasyHome o un altro launcher, queste vengono
immediatamente e definitivamente rimosse dal dispositivo.
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Scorciatoie applicazioni

Nella schermata Home, toccare e tenere premuta l'icona di una app come Chiama,
Invia messaggio, Camera, Galleria e Impostazioni per mostrare un menu di accesso
rapido. E possibile utilizzare le app in maniera piti semplice grazie alle scorciatoie
per app.

- Toccare &) per impostare i widget per 'app.

+ Toccare (§) per visualizzare le informazioni sullapp.

E + Questa funzione e disponibile solo in alcune app.
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Telefono

Chiamata vocale

Per eseguire una chiamata vocale, utilizzare uno dei metodi disponibili, ad esempio
immettere manualmente un numero di telefono e selezionarlo dall'elenco dei
contatti o dall'elenco delle chiamate recenti.

Esecuzione di una chiamata dal tastierino numerico
1 Toccare O > (M > Componi.
2 Eseguire la chiamata utilizzando un metodo a scelta:

- Immettere un numero di telefono e toccare @@.

« Toccare e tenere premuto un numero di composizione veloce.

« Cercare un contatto toccando la lettera iniziale del relativo nome nell'elenco
dei contatti, quindi toccare 9.

E « Perimmettere "+" quando si esegue una chiamata internazionale, toccare e tenere
premuto il numero 0.

+ Consultare la sezione Aggiunta di contatti per ottenere ulteriori informazioni su
come aggiungere numeri di telefono all'elenco di selezione rapida.

Esecuzione di chiamate dalla Rubrica
T O>@®> Rubrica:

2 Dopo aver selezionato il numero da chiamare dallelenco dei contatti nella
rubrica, toccare &...
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Risposta a una chiamata

Per rispondere a una chiamata, trascinare % sulla schermata della chiamata in
arrivo.
+ Se e collegato un auricolare stereo, & possibile eseguire le chiamate utilizzando il
pulsante di chiamata/fine sull'auricolare.

+ Per terminare una chiamata senza spegnere lo schermo, toccare O >
Impostazioni > Rete e Internet > Impostazioni chiamate > Rispondi e
termina chiamate, quindi attivare Termina le chiamate con il tasto di
accensione.

E - Abiltando () > Impostazioni > Rete e Internet > Impostazioni chiamate >
Rispondi e termina chiamate > Termina le chiamate con il tasto di accensione,
& possibile terminare le chiamate premendo il tasto di accensione/blocco mentre &
attiva la schermata della chiamata in corso.

Rifiuto di una chiamata

Per rifiutare una chiamata in arrivo, trascinare @ attraverso la schermata della
chiamata in arrivo.

+ Perinviare un messaggio di rifiuto, trascinare l'opzione del messaggio di rifiuto

per la schermata.

- Per aggiungere o modificare un messaggio di rifiuto, toccare () > Impostazioni
> Rete e Internet > Impostazioni chiamate > Blocco chiamata & Rifiuta con
messaggio > Rifiuta con messaggio.

+ Quando e in arrivo una chiamata, premere il tasto volume su, volume git o il
tasto di accensione/blocco per disattivare laudio della suoneria o la vibrazione,
oppure per mettere in attesa la chiamata.

Verifica di una chiamata in arrivo durante l'utilizzo
di un'app
Quando si riceve una chiamata mentre si sta utilizzando unapp, & possibile

visualizzare una notifica pop-up nella parte superiore della schermata. Si pud
accettare la chiamatag, rifiutarla o inviare un messaggio dalla schermata pop-up.
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E + Toccare O > Impostazioni > Rete e Internet > Impostazioni chiamate > Altre
impostazioni > Mostra chiamate vocali mentre in un'app, quindi selezionare
la modalita in cui si voglio visualizzare le chiamate in entrata quando si utilizza
un'app.

La Floating Bar deve essere abilitata per poter controllare le chiamate ricevute
usando la Floating Bar durante ['utilizzo di unapp. Per maggiori informazioni,
vedere Panoramica Pulsante fluttuante.

Visualizzazione delle chiamate perse

In caso di una chiamata persa, nella barra di stato nella parte superiore dello
schermo viene visualizzato X4,

Per visualizzare i dettagli della chiamata persa, trascinare la barra di stato verso il
basso. In alternativa, toccare O > (8 > Chiamate.

Funzioni disponibili nel corso di una chiamata

Nel corso di una chiamata & possibile accedere a varie funzioni toccando i pulsanti
visualizzati sullo schermo:

Rubrica: consente di visualizzare l'elenco di contatti durante una chiamata.

Attesa: mette in attesa la chiamata corrente.

Tastiera: consente di mostrare o nascondere la testiera del telefono.

Vivavoce: consente di attivare la funzione vivavoce.

Muto: consente di silenziare la propria voce in modo che non possa essere udita
dall'interlocutore.

Bluetooth: consente di passare la chiamata a un dispositivo Bluetooth associato
€ connesso.

- @ : consente diterminare una chiamata.
-+ :consente di accedere a opzioni di chiamata aggiuntive.

E « Levoci delle impostazioni disponibili possono variare a seconda dell'area e del
provider del servizio.
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Esecuzione di una chiamata a tre vie
E possibile esequire una chiamata a un altro contatto nel corso di una chiamata.

1 Durante una chiamata, toccare + > Aggiungi.

2 Immettere un numero di telefono e toccare .
+ Le due chiamate vengono visualizzate contemporaneamente sullo schermo
e la prima chiamata viene messa in attesa.

3 Per awiare una conferenza telefonica, toccare Unisci.

E « Puo essere addebitato il costo di ogni chiamata. Rivolgersi al proprio provider del
servizio per ulteriori informazioni.

Visualizzazione dei record delle chiamate
Per visualizzare i record delle chiamate recenti, toccare O > (@ > Chiamate. E
quindi possibile utilizzare le sequenti funzioni:
« Per visualizzare i record dettagliati delle chiamate, selezionare un contatto. Per
eseguire una chiamata a un contatto selezionato, toccare &...
+ Per eliminare i record delle chiamate, toccare = > Elimina.

E + Ladurata visualizzata delle chiamate potrebbe essere diversa da quella addebitata.
Rivolgersi al proprio provider del servizio per ulteriori informazioni.

« Lacronologia delle telefonate non pud essere recuperata una volta cancellata.

Stringi due dita o allargale per regolare la dimensione del carattere per i registri
delle chiamate o i contatti.

Configurazione delle opzioni di chiamata
E possibile configurare diverse opzioni di chiamata.
T Toccare Q> (@ > Componi o Chiamate.

2 Toccare : >Impostazioni chiamate e quindi configurare le opzioni in base alle
proprie preferenze.
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Messaggi

Invio di un messaggio

E possibile creare e inviare messaqgi ai propri contatti utilizzando lapp di
messaggistica.

E « Linvio di messaggi all'estero potrebbe essere soggetto a ulteriori costi. Rivolgersi al
proprio provider del servizio per ulteriori informazioni.

1 Toccare O> 0
2 Toccare G

3 Specificare un destinatario e creare un messaggio.
- Per usare le opzioni multimediali, tocca ().
« Per accedere alle voci di menu opzionali, toccare .

4 Toccare B> per inviare il messaggio.

Lettura di un messaggio

E possibile visualizzare i messaqgi scambiati organizzati per singolo contatto.

1 Toccare O> B
2 Selezionare un contatto dall'elenco dei messaggi.
E + Nell'elenco dei messaggi o nella finestra di chat, & possibile regolare le dimensioni

dei caratteri posizionando due dita sullo schermo e allontanando o awicinando
le dita.
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Configurazione delle impostazioni dei messaggi
E possibile modificare le impostazioni dei messaggi in base alle proprie preferenze.

1 Toccare O> B

2 Toccare : > Impostazioni dall'elenco dei messaggi.

5 - E possibile specificare le impostazioni per la finestra di awiso, il blocco delle
chiamate, l'awiso di emergenza, i messaggi multimediali ecc.

Fotocamera

Awvio della fotocamera

E possibile scattare una foto o registrare un video per conservare tutti i momenti
memorabili.

Toccare O > (&)
5

Prima di scattare una foto o registrare un video, pulire ['obiettivo della fotocamera
con un panno morbido.

Prestare attenzione a non macchiare [obiettivo della fotocamera con le dita o altre
sostanze.

« Leimmagini incluse nella presente guida potrebbero essere diverse da quelle
effettive del dispositivo.

- Le foto e i video possono essere visualizzati o modificati dalla Galleria. Per ulteriori
dettagli, consultare la sezione Informazioni generali sulla Galleria.

« Non utilizzare il prodotto per scopi che potrebbero violare a privacy o i diritti di
altre persone.
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Funzioni di base dell'app Fotocamera

E possibile scattare foto o registrare video selezionando varie modalita e opzioni
della fotocamera.

1 Toccare O> (@)

2 Toccare () per scattare una foto, oppure toccare @ per registrare un video.

Fotocamera posteriore

Scatto di una foto

1 Selezionare una modalita fotocamera e toccare il soggetto su cui mettere a
fuoco la fotocamera.

7 Sfiorare () per scattare una foto.
- Einoltre possibile premere il tasto volume su o volume gili per scattare una
foto.

- E possibile scattare una foto durante la registrazione di un video premendo
@ sullo schermo.

E « E possibile aprire lapp della fotocamera premendo brevemente due volte il tasto
di accensione. Toccare (O) > Impostazioni > Estensioni > Collegamenti, quindi
toccare Apri Fotocamera per attivarla.

+ Quando lo schermo ¢ spento o bloccato, awviare la fotocamera premendo due volte
il tasto volume giti. Toccare () > Impostazioni > Estensioni > Collegamenti,
quindi toccare Apri Fotocamera () per attivarla
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Registrazione di un video
1 Toccare Q> (5) > Video e toccare il soggetto da mettere a fuoco.
7 Toccare . per registrare un video.

+ Per scattare una foto mentre si registra un video, toccare €.

- Per mettere in pausa la registrazione del video, toccare @. Per riprendere la
registrazione del video, toccare (®.

+ Mentre registri un video, puoi stringere o allargare due dita per ingrandire o
rimpicciolire.

+ Mentre registri un video, puoi toccare l'area desiderata per regolare la
luminosita.

3 Toccare (= per terminare la registrazione del video.

Personalizzazione delle opzioni della fotocamera
E possibile personalizzare varie opzioni in base alle proprie preferenze.
Toccare £G3 sulla schermata.

E + Le opzioni disponibili potrebbero variare a seconda della fotocamera selezionata
(anteriore o posteriore) e alla modalita fotocamera selezionata.

+ |%]:Consente di scattare una foto in FullVision.

+ [0]:Consente di selezionare i valori relativi a proporzioni e dimensioni per le foto
da scattare.

+ [X:Consente di selezionare i valori relativi a risoluzione e dimensioni per i video
da registrare.
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Informa ['utente quando gli occhi del soggetto erano chiusi o

Suggerimenti limmagine é sfocata, per consentire di ottenere una fotografia
ottimale.

Google Lens Quando le informazioni associate vengono trovate in modalita

Suggerimenti Auto, verra utilizzato Google Lens.
Consente di ottenere foto dai colori vividi ed effetti compensati

HDR anche quando le foto sono scattate contro luce. Queste funzioni
sono disponibili grazie alla tecnologia High Dynamic Range
(HDR) integrata nella fotocamera.

Foto dal vivo Registra ['azione prima e dopo aver scattato una foto.

Scatto al Cheese

Consente di scattare foto tramite comandi vocali.

Registrazione Stabile

Consente di minimizzare [effetto mosso durante la
registrazione di un video.

Tracking focus

Consente alla fotocamera di mantenere la messa a fuoco sul
soggetto che si tocca sullo schermo, anche se il soggetto & in
movimento. (Disponibile quando & in funzione la fotocamera
Standard.)

Tag posizione

Consente di salvare limmagine completa di dati sulla posizione
GPS.

Griglia

Consente di visualizzare le griglie di guida in modo da poter
scattare foto o registrare video in base alle linee di riferimento
orizzontali e verticali.

Aggiungi firma

Consente di visualizzare una firma personalizzata sulle foto.

Consente di selezionare se si desidera archiviare le immagini

Archiviazione e ivideo nellArchivio interno o nella Scheda SD. (Disponibile
quando la scheda di memoria & inserita.)
Guida Fornisce una guida per ciascun menu della fotocamera.
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Opzioni aggiuntive sulla fotocamera anteriore

Scatta un selfie selezionando le sue opzioni tra Scatto tramite

Scatto di selfie :
gesto della mano e Scatto automatico.

Consente di salvare le immagini come capovolte dopo aver

Salva come capovolta
scattato dei selfie.

E « E possibile applicare leffetto make-up quando si scatta un selfie con la fotocamera
anteriore

Selezione della modalita
E possibile selezionare comodamente tra le modalita visualizzate sullo schermo, che
sono selezionate per adattarsi all'ambiente di ripresa.
Toccare (O > (%), quindi toccare Altro.
- E possibile modificare l'ordine delle modalita di scena spostando l'icona della
modalita di scena tenendola premuta.
- E possibile scaricare varie modalita di scena dall'app SmartWorld e toccando 4.

S clezionare Altro
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Story Shot

E possibile combinare immediatamente le foto scattate dalla fotocamera posteriore
e dalla fotocamera anteriore.

T Toccare Q> (&), quindi toccare Altro > o8

2 Toccare () per scattare le foto.
+ Scatta una foto che fungera da sfondo dellimmagine composita.
+ Poco dopo, la fotocamera scatta automaticamente una foto.

E + Per lo sfondo dellimmagine composita & possibile anche toccare E e quindi
selezionare una foto salvata nella Galleria.
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Jump-cut flash

Le foto scattate a intervalli regolari sono salvate come file GIF

T Toccare O > (&) quindi toccare Altro > R

2 Toccare (7] per selezionare il numero di copie della fotografia da scattare.
« E possibile selezionare tra 4, 8, 12, 16 e 20 copie.

3 Sfiorare () per scattare una foto.
+ Le foto sono scattate ogni 3 secondi e sono salvate come file GIF

- Premendo @ prima di scattare il numero di foto specificato, si arresta la
ripresa.

- Le foto scattate vengono salvate come file GIF
- E possibile vedere le GIF salvate usando Iapp Galleria.

E « Nelmomento in cui la fotocamera scattala foto, si attiva il flash.

« Nella parte inferiore dello schermo vengono visualizzati il numero totale di foto
scattate e il numero di copie.

Le fotografie scattate vengono salvate solo nei file in formato GIF

Cine shot

E possibile registrare un momento e creare un video con solo una parte della scena
in movimento.

Durante la registrazione di un video, tenere fermo il dispositivo. Dopo la
registrazione de video, sfiorare larea del video che si desidera in movimento. Larea
selezionata inizia a muoversi mentre il resto del video rimane fermo.

1 Toccare O > (&), quindi toccare Altro > .

2 Toccare @ per registrare un video di 3 secondi.
« Tenere fermo il dispositivo durante la registrazione del video.
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3 Toccare (#) e sfiorare larea che si desidera in movimento con leffetto scatto
Cine.

Annulla —g Bl Ripetutamente in avanti e

indietro.
Ripeti

Riproduce ripetutamente in
avanti

Seleziona |'area da spostare. — et e e — Cancella larea selezionata,

+ Toccare (®) per cancellare l'area selezionata.
« Toccare @ per riprodurre ripetutamente in avanti larea selezionata.

« Toccare @ per riprodurre ripetutamente in avanti e indietro larea
selezionata.

A Toccare Salva.
« L'area selezionata sara in movimento.

QLens

Puoi fare acquisti, cercare immagini, o scansionare un cavo QR scattando una foto
con QLens.

1 Toccare Q> (&), quindi toccare Altro > O,

7 Selezionare l'opzione desiderata tra Visual Shopping, Ricerca visuale o
Scansiona codice QR.
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3 Tocca lo schermo per scattare una foto dell'oggetto che vuoi cercare o inquadra
il codice QR.

« Il risultato apparira dopo qualche istante.

5

Questa funzionalita e disponibile solo quando il proprio dispositivo & connesso
a una rete. Se si utilizzano dati mobili, potrebbe esserne addebitato il costo a
seconda del proprio piano tariffario.

Per le funzionalita di Ricerca visuale, & possibile selezionare l'area desiderata
dall'immagine presa, quindi cercare di nuovo.

+ Questa funzionalita e disponibile solo quando la telecamera posteriore & in
modalita automatica.

+ Questa funzione potrebbe non essere supportata a seconda della zona.

Panoramica

E possibile creare una foto panoramica spostando la fotocamera nella direzione da
fotografare e unire gli scatti continui di una vista ampia.

1 Toccare O > () quindi toccare Altro >R

2 Toccare (), quindi spostare lentamente la fotocamera in una sola direzione.

« Spostare il dispositivo sequendo la direzione della freccia sulla linea di
riferimento.

3 Toccare @ per interrompere lacquisizione della panoramica.
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Slow Motion

Crea video divertenti modificando la velocita di movimento. Questa funzione e utile
quando si desidera riprodurre un video a una velocita inferiore rispetto alla velocita
effettiva della clip originale.

E « Slow motion per lintero video
- Leffetto slow motion viene applicato all'intero video
+ Slow motion per sezioni

- Leffetto slow motion viene applicato ad alcune sezioni del video

T Toccare Q> (@), quindi toccare Altro > @Q.

7 Selezionare lasezione oppure lintero video e selezionare leffetto
slow motion desiderato.
3 Toccare e per riprendere un video.
« Se si riprende in slow motion per lintero video, l'effetto slow motion viene
applicato allintero video.
+ Se siriprende in slow motion per sezioni, l'effetto slow motion viene
applicato alle sezioni durante le quali & stato premuto @Q.
- Premere @D nel momento in cui si desidera che venga applicato leffetto
slow motion.

:Con una breve pressione, leffetto slow motion viene applicato per 0,5
secondi.

:Con una pressione prolungata, leffetto slow motion viene applicato fino
a quando non si rilascia il dito.

- E possibile premere @ per un massimo di cinque volte.

4 Per terminare la ripresa, premere (=)
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Penta shot

E possibile scattare cinque foto in serie usando tutti e cinque gli obiettivi della
fotocamera.

T Toccare Q> @), quindi toccare Altro > )

2 Sfiorare () per scattare una foto.

+ \Vlengono scattate automaticamente cinque foto in sequenza a partire dalle
fotocamere posteriori.

« Laserie di cinque foto viene salvata automaticamente nella Galleria, e
vengono offerte le opzioni di creare un collage o una GIF

E « Durante lo scatto, tenere fermo il dispositivo fino a quando sono state scattate
tutte e 5 le foto.
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Cibo

E possibile scattare una foto o registrare un video, regolando la barra di scorrimento
del colore e il bilanciamento del bianco.

1 Toccare Q> (), quindi toccare Altro> L.

7 Per scattare una foto, toccare

« Trascinare la barra di scorrimento dei colori sullo schermo per regolare il
bilanciamento del bianco e selezionare il colore migliore.

- Se non viene visualizzata la barra di scorrimento, toccare % per regolare il
bilanciamento del bianco.

Vista notturna

E possibile scattare foto notturne vivide e nitide. Quando si scattano foto, tenere
fermo il dispositivo. E possibile regolare la luminosita delle foto trascinando la barra
di scorrimento a sinistra o a destra.

Toccare O > (&), quindi toccare Altro > (.
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Modalita Video manuale

L'utente puo impostare manualmente varie funzioni per la registrazione di video. Si
possono regolare audio, bilanciamento del bianco, messa a fuoco, luminositg, ISO,
velocita dell'otturatore ecc.

1 Toccare O > (&) quindi toccare Altro > [

7 Impostare il menu della scena adeguato allambiente di ripresa.

Regolare il Resettare le
bilanciamento impostazioni.
dell'audio.

Consente di regolare il
tempo di esposizione

Consente di regolare
la velocita ISO.

Consente di regolare
la luminosita.

Consente di mettere a
fuoco.

Consente di regolare il
bilanciamento del
bianco.

3 Premere @ per awiare la registrazione.

Impostazione delle opzioni
E possibile impostare le opzioni della fotocamera in base allambiente desiderato.
Premere £33 sulla schermata.

+ || : Passa direttamente a FullVision.

+ [X:Consente di selezionare risoluzione e dimensioni.

Frequenza dei . .
q Consente di selezionare il valore dei fotogrammi al secondo.

fotogrammi
Bit Rate Consente di selezionare la qualita dellimmagine per i video.
Hi-Fi Consente di registrare un video con audio di qualita Hi-Fi.

Salva un video nel formato HDR10 per alta definizione e colori

Salva in HDR10 A
vivaci.
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Registrazione
Stabile

Consente di minimizzare leffetto mosso durante |a registrazione
di un video.

Tracking focus

Consente alla fotocamera di mantenere la messa a fuoco sul
soggetto che si tocca sullo schermo, anche se il soggetto & in
movimento.

(Disponibile quando ¢ in funzione la fotocamera Standard.)

Tag posizione

Consente di salvare limmagine completa di dati sulla posizione GPS.

Griglia

Consente di visualizzare le griglie di guida in modo da poter
scattare foto o registrare video in base alle linee di riferimento
orizzontali e verticali.

Archiviazione

Consente di selezionare se si desidera archiviare le immagini e i
video nellArchivio interno o nella Scheda SD. (Disponibile quando la
scheda di memoria & inserita.)

Guida

Fornisce una guida per ciascun menu della fotocamera.

Triple shot

Questa funzione consente di scattare una serie di foto con diversi angoli di
visualizzazione e creare un video con effetto diapositiva.

1 Toccare Q> (&) quindi toccare Altro >3],

7 Sfiorare

per scattare una foto.

« Le tre fotocamere posteriori scattano le foto automaticamente in sequenza.

« Le immagini del triplo scatto vengono salvate automaticamente nella

Galleria.

E « Durante lo scatto, tenere fermo il dispositivo fino a quando sono state scattate
tutte e 3 le foto.
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Cine Video
E possibile registrare un video cinematografico.
1 Toccare O > () quindi toccare Altro > (@)

2 Toccare @ per registrare un video.

« @ :Registrare un video selezionando la funzione "Point zoom" per
ingrandire o rimpicciolire un'area specifica.

. :Consente di selezionare un effetto da applicare durante la registrazione.
Inoltre, & possibile regolare la vignettizzazione e l'intensita di ciascun
effetto Cine. Una volta iniziata |a registrazione, non e possibile modificare la
funzione.

+ Lafunzione "Point zoom" supporta una velocita di ingrandimento fino a 3x.

+ Questa funzione supporta solo registrazioni video con un obiettivo standard.

YouTube Live

E possibile registrare un video e caricarlo direttamente du YouTube.

Per usare questa funzionalita, & necessario verificare il proprio numero di telefono.

E - YouTube Live e disponibile solo quando il proprio dispositivo & connesso a Internet.
Se si utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.
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Modalita fotocamera manuale

E possibile creare foto dal tocco professionale grazie a varie funzioni avanzate.
Regolare il bilanciamento del bianco, la messa a fuoco, la luminosita, IS0, la velocita
dell'otturatore e altre opzioni.

1 Toccare O > (&) quindi toccare Fotocamera manuale.

) Personalizzare le seguenti impostazioni della fotocamera.

Resettare le
impostazioni

Visualizza le varie
opzioni di Graphy.

P Consente diregolare il
S | - tempo di esposizione.
e SR (Consente diregolare la
“ velocita ISO.

Consente di regolare la
luminosita

e——— Consente di mettere a
| fuoco

e Consente di regolare il
bilanciamento del bianco.

3 Toccare () per scattare la foto.

5 - Laselezione degli effetti Graphy consente di scattare utilizzando il bilanciamento
del bianco, la velocita dell'otturatore e i valori di impostazione ISO applicati alla foto
consigliata.

E possibile vedere una varieta di foto consigliate scaricando l'app Graphy da Google
Play Store.
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Personalizzazione delle opzioni della fotocamera
E possibile personalizzare varie opzioni in base alle proprie preferenze.

Toccare £33 sulla schermata.

+ |7, : Consente di scattare una foto in FullVision.

+ [0]:Consente di selezionare i valori relativi a proporzioni e dimensioni per le foto

da scattare.

Foto con Graphy

Regolare il bilanciamento del bianco, [1SO e la velocita
dell'otturatore per la foto consigliata. Per ulteriori dettagli,
consultare la sezione Graphy.

Salvare come RAW

Limmagine e salvata nel formato file RAW, in modo tale che sia
possibile modificarla. Durante lo scatto vengono creatii file DNG
e JPEG, poi vengono salvati come immagini ad alta risoluzione
non compresse.

Scatto al Cheese

Consente di scattare foto tramite comandi vocali.

Tracking focus

Consente alla fotocamera di mantenere la messa a fuoco sul
soggetto che si tocca sullo schermo, anche se il soggetto & in
movimento. (Disponibile quando & in funzione la fotocamera
Standard.)

Tag posizione

Consente di salvare [immagine completa di dati sulla posizione
GPS.

Guida

Consente di visualizzare le griglie di guida in modo da poter
scattare foto in base alle linee di riferimento orizzontali e verticali.

Aggiungi firma

Consente di visualizzare una firma personalizzata sulle foto.

Consente di selezionare se si desidera archiviare le immagini e i

Archiviazione video nellArchivio interno o nella Scheda SD. (Disponibile quando
la scheda di memoria ¢ inserita.)
Guida Fornisce una guida per ciascun menu della fotocamera.
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Graphy

E possibile applicare i valori consigliati per il bilanciamento del bianco, l1SO ¢ la
velocita dell'otturatore, come quelli di un esperto.

1 Toccare O > (&), quindi toccare Fotocamera manuale.

2 Toccare @ e selezionare la scena desiderata tra le immagini consigliate.

e Immagini consigliate

3 Sfiorare () per scattare una foto.

« Le fotografie vengono scattate con le stesse impostazioni fotografiche
selezionate in Graphy.

+ Questa funzione e disponibile solo nella modalita Fotocamera manuale.

- E possibile aggiungere nuove scene, toccando i e scaricando ['app Graphy dal
Play Store. A seconda del proprio piano tariffario, potrebbe essere addebitato il
costo dei dati utilizzati per il download.

« Tocca @ quindi tocca @3 dal menu Graphy per disattivare questa funzionalita.
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Makeup Pro
Durante lo scatto di selfie e possibile applicare varie tecniche di makeup.

Quando si utilizza la fotocamera anteriore, regolare la tonalita della pelle e applicare
ombretto e rossetto.

1 Toccare O > (&) passare alla fotocamera anteriore e quindi toccare €.

2 Selezionare unopzione di makeup, quindi trascinare la barra di scorrimento a
sinistra o a destra per regolare leffetto.

+ Selezionando Nessuno, la barra di scorrimento scompare.

Seleziona leffetto make-up

Nessun effetto
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3 Selezionare vari effetti make-up e applicarli al soggetto.
- Di base o Modalita make-up, quindi toccare nuovamente lo schermo per
applicare effetti make-up pit dettagliati.

« Spostare |a barra di regolazione dell'intensita per regolare l'intensita con
la quale vengono applicati gli effetti.

Seleziona leffetto make-up

4 Sfiorare () per scattare una foto.
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Studio

E possibile creare foto a livello di studio fotografico utilizzando le funzioni
llluminazione e Sfondo della fotocamera.

llluminazione
E possibile applicare vari effetti di illuminazione mentre si scattano le foto.
1 Toccare Q> (&) quindi toccare Studio.

2 Toccare G per selezionare un effetto di illuminazione.
+ Nella parte inferiore della schermata appaiono vari effetti di illuminazione.

Icona di illuminazione —

3 Toccare licona delleffetto di illuminazione desiderato.

/. Quando sullo schermo appare Effetto Studio & disponibile, toccare () per
scattare una foto.

« La funzione Studio potrebbe non essere disponibile se la fotocamera non e
in grado di riconoscere il soggetto.
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Sfondo
E possibile applicare vari effetti per lo sfondo mentre si scattano le foto.
1 Toccare O > (&) quindi toccare Studio.
7 Toccare [g] per selezionare un effetto di sfondo.
« Nella parte inferiore della schermata appaiono vari colori di sfondo.
3 Seleziona il colore di sfondo da applicare.

- E possibile applicare Colore dello colori selezionati allo sfondo
indipendentemente dal soggetto.

17 Icona di sfondo
® o

Colori di sfondo

/. Quando appare il messaggio di guida Effetto Studio & disponibile., toccare
per scattare una

E « Se la fotocamera non riconosce il soggetto, la funzione studio non puo essere

applicata alla foto salvata.

« Sel'ambiente circostante & buio, la fotocamera non puo applicare gli effetti studio
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Funzioni AR

L'app Fotocamera offre svariate funzionalita AR (realta aumentata). E possibile
creare My Avatar, AR Emoji AR o AR Sticker per arricchire i propri contenuti. My
Avatar consente di creare una versione di sé stessi come cartone animato e
personalizzarla. AR Emoji consente di creare emoji di animali in 3D animati che
imitano le espressioni facciali. AR Sticker consente di scegliere tra diversi sticker da
usare in una foto o in un video mentre si guarda la fotocamera.

Creazione di My Avatar
1 Toccare Q> (&), passare alla fotocamera anteriore e quindi toccare & > ©).

+ Questa funzione e disponibile solo in modalita automatica.

2 Toccare §3> £ per scattare una foto.

+ Seguire le istruzioni visualizzate sullo schermo per allineare il proprio volto
con lo schermo.

« Per creare My Avatar usando una delle foto salvate nella Gallerig, toccare El
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3 Selezionare il sesso di My Avatar e selezionare dettagli quali il tipo di avatar, la
tonalita della pelle, l'acconciatura e gli indumenti, quindi toccare OK.

« Le foto scattate vengono salvate nella Galleria.
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Uso di My Avatar, AR Emoji, AR Sticker
1 Toccare O > Q passare alla fotocamera anteriore e quindi toccare @@ > @

2 Selezionare unopzione da registrare.

My Avatar AR Sticker

3 Per scattare una foto, toccare
Per registrare un video usando My Avatar, AR Emoji o AR Sticker, selezionare il
menu di registrazione video, quindi toccare &> @) per selezionare lelemento
desiderato, e toccare @) per awiare la ripresa del video.

« Le foto scattate vengono salvate nella Galleria.
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Uso degli Avatar Sticker
1 Toccare @ sulla tastiera LG.

2 Selezionare [Avatar Sticker desiderato trai My Avatar ecc. creati, quindi
selezionare B> per inviarlo.

& L Qa & L Qa

Icona Avatar Sticker

v 8

a0
e

e P

e
5.4

S

Uso degli Sticker animati
1 Toccare & sulla tastiera LG.
7 Selezionare il My Avatar desiderato.

3 Toccare @ per registrare voce e video, quindi toccare @ per salvare.
+ Vlengono creati Sticker animati con varie espressioni facciali, movimenti e
VOCi.
/' Toccare (&) per caricare uno Sticker animato.
- Toccare @) per vedere lanteprima dello Sticker animato che & stato creato.

App utili 114



-2

-2

Seleziona uno
Sticker
animato

-2

® @ e P>
2 0 & & ¢ ®& W v € O 8 a ¢ ®& H v
O O
i
Icona Anteprima _—.‘ S >
20 - e 250 = 3 & L
115

App utili



Altre funzioni utili nell'app Fotocamera

Blocco Esposizione automatica/Messa a fuoco automatica

E possibile fissare il livello attuale di esposizione e mettere a fuoco la posizione
toccando e tenendo premuta lo schermo nella modalita automatica. Per disattivare
la funzione, toccare unarea vuota sulla schermata.

E + Questa funzione ¢ disponibile solo in alcune modalita specifiche.

Utilizzo di Burst Shot

E possibile scattare foto consecutive e visualizzarle come immagini in movimento
nella Galleria.

1 Aprire lapp della fotocamera e selezionare Foto.

2 Tenere premuto
« Vengono scattate pitl foto consecutive mentre si tiene premuto

E + Questa funzione é disponibile solo in alcune modalita specifiche.
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Zoom avanti o indietro
E possibile eseguire lo zoom avanti o indietro della schermata della fotocamera
mentre si scatta una foto o si registra un video.
+ Usando la barra di regolazione che appare quando si usano due dita per
ingrandire/ridurre la schermata della fotocamera, passare tra l'angolo
telescopico, 'angolo normale e ['angolo ultra-ampio.

E + Lafunzione di zoom avanti/indietro non ¢ disponibile in modalita selfie
(fotocamera anteriore).

+ Questa funzione non & supportata in diverse modalita.

Focus peaking

Puoi regolare la messa a fuoco sul soggetto con la funzione Focus peaking.
Accedi alla funzione Focus peaking toccando il pulsante per la messa a fuoco
manuale (MF). Quando viene attivata la funzione Focus Peaking, il soggetto della
messa a fuoco viene evidenziato in giallo. Spostare la rotella di attivazione su e git
per mettere a fuoco 'area desiderata, quindi scattare la foto.

« Premere nuovamente Focus peaking per disabilitare questa funzione.

« Questa funzione puo essere utilizzata solo quando si scatta con un angolo
normale.

. E disponibile solo con la messa a fuoco manuale (MF).
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Passaggio dalla fotocamera posteriore a quella anteriore e
viceversa

E possibile passare dalla fotocamera anteriore a quella posteriore e vice versa in
base allambiente circostante.

Nella schermata della fotocamera, toccare @ o trascinare la schermata in qualsiasi
direzione per passare dalla fotocamera posteriore a quella anteriore e viceversa.

<ans

E « Utilizzare la fotocamera anteriore per scattare i selfie. Per ulteriori dettagli,
consultare la sezione Scatto di selfie.
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Scatto di selfie

E possibile utilizzare la fotocamera anteriore per visualizare il proprio volto sullo
schermo e scattare selfie.

Scatto tramite gesto della mano
E possibile scattare selfie tramite gesti.
Mostrare il palmo della mano alla fotocamera anteriore e quindi stringere il pugno.
E inoltre possibile stringere il pugno e poi aprirlo verso la fotocamera anteriore.
+ Dopo tre secondi la foto viene scattata.

)

Per utilizzare questa funzione, passare alla modalita fotocamera anteriore, quindi
toccare §33 > Scatto di selfie > Scatto tramite gesto della mano.

il

Assicurarsi che il palmo e il pugno siano allinterno della linea di riferimento in
modo che la fotocamera possa rilevarli.

Questa funzione potrebbe non essere disponibile mentre sono in uso alcune altre
funzioni della fotocamera.
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Scatto automatico

E possibile utilizzare la funzione di rilevamento del volto per scattare selfie in
maniera semplice e comoda. Si pud impostare il dispositivo in maniera tale che,
quando ['utente quarda verso lo schermo, la fotocamera anteriore rilevi il volto e
scatti automaticamente un selfie.

+ Quando la fotocamera anteriore rileva il volto, viene visualizzata la cornice guida
di colore bianco. Se il soggetto allinterno della cornice guida smette di muoversi,
la cornice guida diventa blu, quindi la fotocamera scatta una foto.

E « Toccare §83 > Scatto di selfie > Scatto automatico per attivare la funzione
Scatto automatico.

Scatto intervallato
E possibile scattare selfie a intervalli regolari.

Mentre & in uso la fotocamera anteriore, mostrare il palmo della mano alla
fotocamera, quindi stringere rapidamente il pugno per due volte.

+ Vengono scattate quattro foto a intervalli regolari dopo un timer di ritardo di tre
secondi.

Salva come capovolta

Prima di scattare una foto con la fotocamera anteriore, toccare §33 > Salva come
capovolta. 'immagine viene capovolta in senso orizzontale.

E « Durante [utilizzo della fotocamera anteriore, & possibile modificare le modalita di
scatto dei selfie nelle opzioni della fotocamera. Per ulteriori dettagli, consultare la
sezione Personalizzazione delle opzioni della fotocamera.

Firma

E possibile creare una foto personalizzata utilizzando la propria firma.
1 Toccare O > (@), quindi £03 > Aggiungi firma.

7 Immettere la firma desiderata e toccare Agg.

E « Questa funzione é disponibile solo in alcune modalita specifiche.
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Condivisione rapida

E possibile condividere una foto o un video sullapp desiderata subito dopo averli
ripresi.

1 Toccare O > (&) quindi scattare una foto o registrare un video.

2 Toccare licona dellapp visualizzata sullo schermo per effettuare la condivisione
mediante quellapp.

E inoltre possibile trascinare licona nella direzione opposta per visualizzare le
altre app utilizzabili per la condivisione di foto e video.

17 lcona quick share

E « Lapp visualizzata sull'icona di quick share puo variare a seconda del tipo e della
frequenza di accesso alle app installate sul dispositivo.

+ Questa funzione é disponibile solo in alcune modalita specifiche.
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Galleria

Informazioni generali sulla Galleria
E possibile visualizzare e gestire le foto e i video salvati sul dispositivo.

T Toccare O> 3

« Lefoto ei video salvati vengono visualizzati in base alla cartella.

7 Toccare una cartella e selezionare un file.

Visualizzare il file selezionato in modalita schermo intero.

Mentre si visualizza una foto, scorrere verso sinistra o destra per visualizzare
la foto precedente o successiva.

Mentre si visualizza un video, scorrere verso sinistra o destra per riavvolgere
o far avanzare velocemente il video.

Se si salvano le informazioni sulla posizione o si utilizza una modalita scena
durante la ripresa, viene generata una sottocartella per ogni video.

+ Per visualizzare le foto per la localita in cui la foto & stata scattata, tocca
O> @ > 03 > Tag posizione, quindi Q. Le foto sono automaticamente
raggruppate per localita nella scheda Memoria dell'app Galleria.

E « Alcuni formati file potrebbero non essere supportati a seconda del software
installato.
« Alcuni file potrebbero non aprirsi a causa della codifica.
« [file di dimensioni superiori al limite massimo potrebbero generare un errore.
+ Devi attivare la funzionalita GPS per creare album di Memoria.
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Visualizzazione delle foto
E possibile visualizzare le foto salvate nel prodotto.

Consente di avviare
Lens.

Consente di accedere

a opzioni aggiuntive

Consente di tornare —

alla schermata =
precedente

Consente di awviare la

fotocamera.

Consente di

aggiungere a o

rimuovere dai preferiti.

.
5

Consente di scrivere un

promemoria su una foto, Consente di eliminare

le immagini
Consente di visualizzare

i contenuti correlati Consente di
X condividere le
Consente di modificare immagin.

le immagini

LE" + Toccando leggermente lo schermo, appare il menu Dettagli. Toccando nuovamente
lo schermo, il menu scompare.

Riproduzione di un video
E possibile riprodurre i video salvati nel prodotto.

Consente di ‘ e — Consente di accedere
riprodurre o a opzioni aggiuntive.
sospendere la

riproduzione del video.

Consente di scegliere ———— T————— Consente di bloccare o

le proporzioni dello sbloccare lo schermo.
schermo.
Attiva/disattiva DTSX 3D Consente di

modificare il video

Realizzazione di un file GIF.
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5 « Per regolare il volume dell'audio, trascinare in alto o in basso il lato destro della
schermata del video.

Per regolare la luminosita dello schermo, trascinare verso lalto o verso il basso il
lato sinistro della schermata

Trascinando lo schermo a sinistra nella schermata di riproduzione video e possibile
riawolgere (REW) e trascinando a destra & possibile avanzare rapidamente (FF).

Modifica dei video
1 Mentre si visualizza un video, toccare f

2 Utilizzare vari effetti e strumenti di modifica per modificare il video.

Consente di creare
automaticamente una
Consente di regolare clipvideo di 15,30 o
la risoluzione. 60 secondi
Consente di creare un
Consente di ﬁlm utilizzando diversi
ripristinare la modifica. l E ffetti

§— Consente di awiare
leditor video
KineMaster.

Consente di selezionare
una sezione per cambiare
o la velocita di riproduzione.
“““““““““““ i [s — Consente di regolare
la durata del video.

3 Toccare Salva per salvare le modifiche.

Creazione di un video
E possibile unire immagini o video per creare un nuovo video.
Per maggiori informazioni, vedere Creazione di un filmato.

Creazione di GIF
E possibile modificare comodamente le foto e i video ripresi e convertirli in GIF
Per maggiori informazioni, vedere Realizzazione di una GIF.
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Eliminazione di file
E possibile eliminare file utilizzando una delle sequenti opzioni:

Toccare e tenere premuto un file nell'elenco, quindi toccare Elimina.

Toccare [11] dall'elenco di file ed eliminare il file desiderati.

- | file eliminati vengono automaticamente spostati nel Cestino e possono essere
ripristinati nella Galleria entro 7 giorni.

- Toccare [x] per eliminare completamente i file. In questo caso, i file non potranno
essere ripristinati.

Condivisione di file
E possibile condividere file utilizzando una delle sequenti opzioni:

- Mentre si visualizza una foto, toccare <& per condividere il file utilizzando il
metodo desiderato.

« Mentre si visualizza un video, toccare > Condividi per condividere il file
utilizzando il metodo desiderato.

- Toccare o< nell'elenco dei file per selezionare i file e condividerli utilizzando il
metodo desiderato.
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Rubrica

Informazioni generali sui contatti
E possibile salvare e gestire i contatti.
Toccare () > Essenziali > Rubrica.

Aggiunta di contatti

Aggiunta di nuovi contatti

T Nella schermata dell'elenco dei contatti, toccare .
« Appare un pop-up che consente di selezionare la posizione di salvataggio del
contatto. Selezionare la posizione desiderata.

7 Immetterei dettagli del contatto e toccare Salva.

Importazione di contatti
E possibile importare contatti da un altro dispositivo di archiviazione.

1 Nella schermata dell'elenco dei contatti, toccare > Gestisci contatti >
Importa.

2 Selezionare le posizioni di origine e di destinazione del contatto che si desidera
importare, quindi toccare OK.

3 Selezionare i contatti e toccare Importa.

Aggiunta di contatti all'elenco di composizione veloce

1 Nella schermata dell'elenco dei contatti, toccare > Selezione rapida.
7 Toccare Aggiungi contatto da un numero di composizione veloce.

3 Selezionare un contatto.

E + Mentre siaggiunge un nuovo contatto, toccare [3{3 per aggiungere un numero di
chiamata rapida.
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Ricerca di contatti
E possibile ricercare contatti utilizzando una delle sequenti opzioni:

+ Toccare la barra di ricerca nella parte inferiore della schermata Rubrica e inserire
il contatto o il numero di telefono che si desidera cercare.

« Scorrere |'elenco dei contatti verso lalto o verso il basso.

« Dall'indice della schermata dell'elenco dei contatti, toccare la lettera iniziale di
un contatto.

E + Toccando la barra di ricerca nella parte inferiore della schermata Rubrica e
inserendo un contatto o un numero di telefono, vengono visualizzati i risultati della
ricerca integrata dalla cronologia delle chiamate e dall'elenco dei contatti salvati
nel prodotto.

Elenco dei contatti

Modifica di contatti
71 Nella schermata dell'elenco dei contatti, selezionare un contatto.
7 Nella schermata dell'elenco dei contatti, toccare f e modificare i dettagli.

3 Toccare Salva per salvare le modifiche.

Eliminazione di contatti
E possibile eliminare contatti utilizzando una delle sequenti opzioni:
+ Nella schermata dellelenco dei contatti, toccare e tenere premuto un contatto
che si desidera eliminare, quindi toccare Elimina contatto.
- Toccare + > Elimina nella schermata dellelenco dei contatti.

E + | contatti cancellati non possono essere recuperati.
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Aggiunta ai preferiti
E possibile registrare i contatti utilizzati pili spesso come preferiti.
71 Nella schermata dell'elenco dei contatti, selezionare un contatto.

2 Nella schermata dei dettagli dei contatti, toccare sﬁ;

Creazione di gruppi

1 Dallelenco dei gruppi di contatti, toccare -

2 Immettere il nome del nuovo gruppo.

3 Toccare Aggiungi iscritti, selezionare i contatti, quindi toccare Agg.

/. Toccare Salva per salvare il nuovo gruppo.

QuickMemo+

Informazioni generali su QuickMemo+

E possibile generare note creative utilizzando una varieta di opzioni su questa
funzione avanzata del blocco note, come ad esempio la gestione immagini e gli
screenshot, che non sono supportati dal blocco note tradizionale.

Creazione di una nota
T Toccare > QuickMemo+.
2 Toccare @ per creare una nota.
- @ : consente di salvare una nota.
+ <5 :Annullare le modifiche precedenti.
+ (2 :Applicare di nuovo le modifiche annullate di recente.
+ T : consente di immettere una nota utilizzando la tastiera.
+ / :consente di scrivere delle note a mano.
+ & :consente di cancellare le note scritte a mano.
+ {7 :consente di eseguire lo zoom avanti o indietro, ruotare o cancellare
parte di una nota scritta a mano.
: :Consente di accedere a opzioni aggiuntive.

3 Toccare @ per salvare la nota.
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Scrittura di note su uno screenshot
1 Mentre sivisualizza la schermata che si desidera acquisire, trascinare la barra di
stato verso il basso, quindi toccare (2,
+ Lo screenshot viene visualizzato come tema di sfondo del blocco note.
Nella parte superiore dello schermo vengono visualizzati gli strumenti di
promemoria.
2 Tagliare limmagine (se necessario) e aggiungere note a proprio piacimento.
« Scrivere delle note a mano sulla foto.

3 Toccare @ e salvare le note nella posizione desiderata.
« Le note salvate possono essere visualizzate in QuickMemo+ o in Galleria.

« Per salvare le note sempre nella stessa posizione, selezionare la casella di
controllo Usa come predefinita per questa azione. e selezionare unapp.

E + Puoi scattare una foto dell'intero schermo, utilizzando la funzione di scatto di
scorrimento.

+ Quando si utilizza un'app come Invia messaggio o Chrome, trascinare il pannello
notifiche verso il basso, quindi cliccare Capture+ > Esteso per scattare una foto
dell'intero schermo cosi come lo si vede e salvarla in un solo file.

+ Questa funzione e disponibile solo in alcune app che supportano la funzione scatto
di scorrimento.

Stringi due dita o allargale per regolare il layout del promemoria.
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Gestione delle cartelle
E possibile organizzare e visualizzare i promemoria in base al tipo di promemoria.
T Selezionare O > QuickMemo+.

7 Toccare = nella parte superiore dello schermo e quindi selezionare la funzione
desiderata.

Tutti i memo: consente di visualizzare tutti i memo salvati in Qmemo-+.

| miei memo: consente di visualizzare i memo creati in Qmemo-+.

Capture+: consente di visualizzare i memo creati usando Capture+.

Cestino: consente di visualizzare i memo eliminati.
- Nuova categoria: consente di aggiungere cartelle.

- /P E possibile cambiare lordine delle cartelle o aggiungere/eliminare
cartelle. Premendo una cartella, & possibile modificarne il nome.

E + Alcune cartelle non vengono visualizzate al primo awio di dellapp con le cartelle.
Le cartelle inoltre vengono visualizzate solo quando contengono promemoria.

« | promemoria eliminati vengono spostati nel cestino e possono essere recuperati
entro 7 giorni dal giorno in cui sono stati eliminati. Nellapp Qmemo+, & possibile
cambiare il tipo di visualizzazione posizionando due dita sullo schermo e
allontanando o awvicinando le dita.

« Alcune cartelle non vengono visualizzate al primo awvio di dellapp con le cartelle.
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Orologio

Sveglia

E possibile impostare una sveglia in modo che si attivi a un orario specificato.
T Toccare Q> Essenziali > Orologio > Sveglia.

7 Toccare -} per aggiungere una nuova sveglia.

3 Configurare le impostazioni della sveglia e toccare Salva.

« Sesi seleziona una sveglia impostata in precedenza, € possibile modificarla.

« Per eliminare una sveglia, toccare E > Elimina nella parte superiore dello schermo.
In alternativa, toccare e tenere premuta la sveglia.

Fusi orari
E possibile visualizzare l'ora attuale delle citta di tutto il mondo.
1 Toccare > Essenziali > Orologio > Fusi orari.

2 Toccare -} e aggiungere una citta.

Timer

E possibile impostare il timer in modo da attivare un segnale acustico dopo un
periodo di tempo specificato.

1 Toccare > Essenziali > Orologio > Timer.

2 Impostare il tempo e toccare Inizio.

« Per sospendere il timer, toccare Pausa. Per riprendere il timer; toccare
Riprendi.

3 Toccare Stop per arrestare la sveglia del timer.
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Cronometro
E possibile utilizzare il cronometro per registrare un tempo.
1 Toccare O > Essenziali > Orologio > Cronometro.
7 Toccare Inizio per awiare il cronometro.
+ Perregistrare un tempo, toccare Giro.
3 Toccare Pausa per sospendere il cronometro.
+ Per riprendere il cronometro, toccare Riprendi.

+ Per cancellare tutte le registrazioni e awviare di nuovo il cronometro, toccare
Ripristino.

Calendario

Informazioni generali sul calendario
E possibile utilizzare il calendario per gestire eventi e attivita.

Aggiunta di eventi
1 Toccare O > Essenziali > Calendario.
7 Selezionare una data, quindi toccare e

3 Immettere i dettagli dellevento e toccare Salva.

Sincronizzazione di eventi

Toccare * > Calendari da sincronizzare e selezionare un calendario da
sincronizzare.

E + Quando si salvano i propri eventi dal dispositivo allaccount Google, vengono
automaticamente sincronizzati anche con il calendario di Google. E inoltre possibile
sincronizzare altri dispositivi con il calendario di Google, in modo tale che quei
dispositivi presentino gli stessi eventi del proprio dispositivo e sia possibile gestire i
propri eventi su quei dispositivi.
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Attivita

E possibile registrare attivita sul dispositivo per gestirne con facilit la pianificazione.
T Toccare > Essenziali > Attivita.

2 Toccare @ per aggiungere un‘attivita,

3 Immettere i dettagli dell'attivita, quindi toccare Salva.

Musica

E possibile riprodurre e gestire canzoni o album musicali
1 Toccare > Essenziali > Musica.

7 Selezionare una categoria.

3 Selezionare un file musicale.

Consente di impostare effetti
sonori.

Consente di tornare alla —e <« I : «—— Consente di accedere a opzioni
schermata precedente. aggiuntive.

—— Passare alla playlist.

—— Consente di riprodurre o

Accendi/spegni Boombox show. — sospendere |a riproduzione.

— Accendi/spegni Flash Light.

R *

Toccare per riprodurre il file Toccare per riprodurre il file
corrente dall'inizio / Toccare due successivo / Toccare e tenere
volte per riprodurre il file premuto per avanzare

precedente / Toccare e tenere velocemente.
premuto per riawolgere. X e ’ » o©
. . _] L— Consente di selezionare una
Consente di riprodurre in ordine —— modalita di ripetizione
casuale. ’
Consente di regolare il volume —eq 7% 1 e— Modifica velocita e intonazione.
dellaudio 7

Consente di aggiungere a o —,

rimuovere dai preferiti.
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Alcuni formati file potrebbero non essere supportati a seconda del software
installato.

i

« [file di dimensioni superiori al limite massimo potrebbero generare un errore.

| file musicali potrebbero essere protetti dai titolari di copyright internazionali o da
leggi sul copyright. Prima di copiare un file musicale, potrebbe essere necessario
ottenerne l'autorizzazione legale. Per scaricare o copiare un file musicale, verificare
prima le leggi sul copyright del relativo paese.

Questo modello supporta la riproduzione audio Hi-Fi. | file audio Hi-Fi presentano
licona Hi-Fi.

+ Quando la funzionalita Boombox Show, lo schermo mostra effetti visivi sulla
musica. |l dispositivo vibra quando lo agiti.

Launcher Del Gioco

E possibile impostare se utilizzare il launcher del gioco, dove & possibile visualizzare
l'elenco dei giochi installati nel prodotto e selezionare le impostazioni di gioco quali
la disattivazione dellaudio multimediale, la limitazione degli awvisi ecc.

1 Toccare O > Launcher Del Gioco.

7 Selezionare lopzione desiderata.

Calcolatrice

E possibile utilizzare due tipi di calcolatrici: la calcolatrice semplice e la calcolatrice
scientifica.

T Toccare Q> Essenziali > Calcolatrice.

7 Utilizzare il tastierino numerico per eseguire un calcolo.
+ Per calcolare dallinizio, toccare e tenere premuto {X]
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ThinQ
E possibile collegare facilmente il prodotto a dispositivi IoT per monitorarli e

utilizzarli comodamente.
Selezionare O > Essenziali > ThinQ

E Lavatrice, asciugatrice, styler; lavastoviglie, forno e robot aspirapolvere possono
essere registrati solo quando il prodotto & in modalita standby.

Cercare il marchio ThinQ sul prodotto per vedere se puo essere collegato all'app
ThinQ.
Toccare = per vedere le varie funzioni dellapp ThinQ.

Email

Informazioni generali sulle e-mail

E possibile registrare un account e-mail sul dispositivo e quindi controllare e inviare
e-mail dal dispositivo.

E « Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario. Rivolgersi al proprio provider del servizio per ulteriori
informazioni.

Registrazione di account e-mail

Al primo utilizzo dell'app di e-mail, registrare il proprio account e-mail
1 Toccare > Essenziali > Email

2 Selezionare un provider di servizi e-mail.

3 Immettere il proprio indirizzo e-mail e la relativa password, quindi toccare
Avanti per registrare ['account

+ Per registrare manualmente un account email, toccare Impostazione
manuale (se necessario).
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Gestione degli account e-mail

Per visualizzare o modificare le impostazioni degli account e-mail, toccare & >
Impostazioni.

« Per aggiungere un account, toccare Aggiungi account.
- Per eliminare un account, toccare + > Rimuovi account.

Apertura di un altro account e-mail

Se sono registrati vari account e-mail e si desidera visualizzare un altro account,
toccare = e selezionarne un altro dall'elenco degli account.

Controllo delle e-mail
1 Toccare = e selezionare una casella di posta.

7 Selezionare un'e-mail dal relativo elenco.
+ Viene visualizzato il messaggio e-mail.

Invio di e-mail
1 Toccare @.
7 Immettere lindirizzo email del destinatario.

3 Immettere [oggetto e il messaggio.
+ Per allegare file, toccare (.
« Per accedere alle voci di menu opzionali, toccare .

/L Toccare 9 per inviare ['e-mail.

E « Stringi due dita o allargale per regolare la dimensione del carattere secondo la
dimensione della tua lista di e-mail.
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Registratore Audio HD

Il Registratore Audio HD ti consentira di configurare manualmente le impostazioni
audio in modo tale da poter registrare audio in base all'ambiente in cui ti trovi.

Modalita di registrazione

E possibile registrare un file audio ad alta definizione selezionando e configurando
la modalita audio desiderata, adatta allambiente di registrazione.

Toccare () > Essenziali > Registratore Audio HD > =

Normale
E possibile registrare audio senza impostazioni aggiuntive.

Concerto
E possibile registrare audio durante un concerto o altri eventi musicall.

Personalizzato

E possibile configurare manualmente le impostazioni desiderate per registrare
laudio.

Modalita Studio

La modalita Studio consente di riprodurre un file audio o musicale e registrare
contemporaneamente la propria voce, creare un accordo registrando piti volte
la propria voce, nonché registrare i propri commenti sul file audio originale del
presentatore o del parlante.

1 Toccare O > Essenziali > Registratore Audio HD > = > Personalizzato.
7 Toccare J 4
3 Selezionare un file audio da utilizzare come musica di sottofondo.
4 Toccare @ per registrare la voce.
5 Toccare o per salvare il file registrato.
E + Lamusica di sottofondo puo essere riprodotta solo attraverso gli auricolari.

Assicurarsi di collegare gli auricolari prima di utilizzare questa funzione.
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Altre funzioni utili per l'uso dell'app Registratore Audio HD
GAIN

E possibile regolare la sensibilita dellaudio registrato dal microfono.

Maggiore ¢ il valore su cui & impostato il GAIN, maggiore la sensibilita di
registrazione dellaudio.

LCF

E possibile filtrare qualsiasi rumore a bassa frequenza, come il ronzio del
condizionatore.

Maggiore ¢ il valore su cui & impostato LCF (Low Cut Filter, filtro taglia-bassi),
migliore risulta il filtraggio dei rumori ad alta frequenza.

LMT

Consente di impedire il fenomeno di clipping dellaudio registrato. Piu alto & il
valore su cui e impostato LMT (Limitatore), maggiore ¢ la quantita di suoni a bassa
frequenza che non subiranno clipping.

E + Per modificare altre impostazioni, toccare E > Impostazioni, quindi personalizzare
il tipo di file, la profondita in bit, la frequenza di campionamento e altre
impostazioni.

Quando vengono selezionate le modalita Concerto o Personalizzata, verra
visualizzato L[I]*. Toccare LQ@ quindi selezionare il microfono da utilizzare.

E possibile monitorare la qualita del suono mediante [altoparlante auricolare
collegato durante una registrazione audio. Durante una registrazione audio in
modalita Studio, il monitoraggio del suono non & supportato. E possibile sentire
solamente la musica di sottofondo.
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LG Health

Informazioni generali su LG Health

E possibile gestire il proprio stato di salute e mantenere buone abitudini di fitness
monitorando lesercizio fisico svolto.

Informazioni preliminari su LG Health
E possibile configurare LG Health al primo awio dellapp o dopo averla ripristinata.
1 Toccare O> Essenziali > LG Health.

2 Sequire le istruzioni visualizzate sullo schermo per completare la
configurazione.

Utilizzo di LG Health

E possibile visualizzare le informazioni principali su LG Health e gestire la quantita di
esercizio fisico e le informazioni relative alla salute.

1 Toccare O> Essenziali > LG Health.

2 Sono disponibili le sequenti opzioni.

App utili 139



I
[LO

—r)

:consente di visualizzare il registro del proprio esercizio fisico nel giorno

che si desidera monitorare.

-2

:consente di iniziare a monitorare una sessione di esercizio fisico. Il

percorso e la quantita di esercizio fisico svolto vengono registrati per
ciascuna tipologia di esercizio.

:consente di impostare gli obiettivi giornalieri di esercizio fisico, compresi i

passi e le calorie, oppure di configurare diverse impostazioni di LG Health.

E .

App utili

Le informazioni relative alla salute fornite da LG Health sono studiate per la
comodita dell'utente e non possono essere utilizzate a scopo di prevenzione,
trattamento e diagnosi di malattie né per altri scopi medici.

LG Health potrebbe variare o potrebbe non essere disponibile a seconda del paese
e del provider del servizio. Le funzioni di LG Health disponibili e le app che possono
essere abbinate a LG Health possono variare a seconda del paese. Le variazioni
sono dovute alle diverse leggi e normative vigenti.
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Centro aggiornamenti

Puoi controllare e installare la versione pili recente dell'app o del software fornito
alG.

Toccare (> Gestione > Centro aggiornamenti.

File Manager
E possibile visualizzare e gestire i file salvati sul dispositivo o sul cloud.
1 Toccare O > Gestione > File Manager.

7 Toccare = e selezionare il percorso di archiviazione desiderato.

Smart Doctor

E possibile utilizzare Smart Doctor per eseguire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Toccare () > Gestione > Smart Doctor.

LG Mobile Switch

E possibile trasferire dati con facilita da un dispositivo usato a un dispositivo nuovo
mediante LG Mobile Switch.
1 Toccare O> Gestione > LG Mobile Switch.

In alternativa toccare O) > Impostazioni > Sistema > Backup > LG Mobile
Switch.

+ Se 'app non ¢ installata nel prodotto, scaricare e installare I'app LG Mobile
Switch dal Google Play Store.

2 Sequire le istruzioni visualizzate sullo schermo per selezionare il metodo
desiderato per il trasferimento.
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5 « | datiin un account Google non saranno sottoposti a Backup. Quando si
sincronizza l'account Google, le app di Google, i contatti di Google, il calendario di
Google, i dati delle app di promemoria di Google e le app scaricate dal Play Store
vengono archiviati automaticamente sull'app Drive.

Caricare completamente la batteria prima del trasferimento di dati per evitare lo
spegnimento involontario durante il processo.

Cestino app

E possibile vedere lelenco delle app disinstallate sulla schermata Home. Le app
eliminate nelle ultime 24 ore possono essere recuperate.

Toccare () > Gestione > Cestino app.
Per maggiori informazioni, vedere Cestino app.

SmartWorld

E possibile scaricare vari giochi, contenuti audio, app e tipi di carattere forniti da LG
Electronics. Si puo inoltre personalizzare il dispositivo in base alle proprie preferenze
utilizzando temi per la schermata Home e tipi di carattere.

E « Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

« Questa funzione potrebbe non essere supportata a seconda dell'area o del
provider del servizio.

1 Toccare O > Servizi > SmartWorld.
7 Toccare > Account LG, quindi effettuare 'accesso.

3 Selezionare e scaricare i contenuti desiderati.

Download dell'app SmartWorld

Se app SmartWorld non & installata, sequire questa procedura per scaricarla.

1 Toccare O)> Impostazioni > Sistema > Centro aggiornamenti >
Aggiornamento applicazione.

7 Dallelenco, selezionare SmartWorld e toccare Scarica.
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RemoteCall Service

Il dispositivo puo essere sottoposto a diagnostica in modalita remota per risolverne
i problemi. Innanzitutto, eseguire una chiamata telefonica a un Centro di assistenza
clienti LG come segue:

« Per servirsi di questa funzione, e prima necessario accettarne ['utilizzo.

« Sesi utilizzano dati mobili, potrebbe esserne addebitato il costo a seconda del
proprio piano tariffario.

1 Toccare > Servizi > RemoteCall Service.
2 Collegare una chiamata al centro di assistenza clienti LG.

3 Al collegamento della chiamata, seguire le istruzioni dell'addetto al servizio per
immettere un numero di accesso a sei cifre.

+ Il dispositivo viene connesso in modalita remota e viene awviato il servizio di
assistenza remota.

Messaggio CB

E possibile visualizzare trasmissioni di testo in tempo reale su situazioni di
emergenza, come tifoni, inondazioni e terremoti.

Toccare () > Servizi > Messaggio CB.
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App di Google

E possibile utilizzare app di Google impostando un account Google. Quando si
utilizza un'app di Google per la prima volta, viene visualizzata automaticamente

la finestra di registrazione dell'account Google. Se non si dispone di un account
Google, crearne uno dal dispositivo. Per i dettagli su come utilizzare un'app, vedere
la Guida contenuta nell'app.

E « Alcune app potrebbero non funzionare a seconda dell'area o del provider del
Servizio.

Chrome
Un browser web veloce, semplice e sicuro, costruito per la rete moderna.

Documenti

Docs e uno strumento collaborativo di elaborazione di testi che aumenta la
produttivita. Usa Docs per creare, modificare e lavorare insieme in tempo reale.

Drive

Drive & un'app di condivisione e immagazzinaggio di file che facilita lindividuazione,
la condivisone e la collaborazione su progetti di lavoro ovunque e in ogni istante.

Duo

Crea video chiamate semplici e di alta qualita verso i tuoi amici e famigliari su
telefoni Android e iPhones.

Gmail

Gmail & un'app facile da usare che tiene al sicuro i tuoi messaggj, rende pit smart la
tua casella di posta e ti aiuta a restare organizzato.
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Google

L'app Google ti tiene aggiornato sulle cose che ti interessano. Trova risposte rapide,
esplora i tuoi interessi e ricevi un feed di storie e aggiornamenti su argomenti
importanti per te.

Maps

Stai andando da qualche parte? Vai con Maps, l'app con GPS in tempo reale sulla
quale puoi fare affidamento per navigazione, traffico, transito e dettagli su milioni di
luoghi, come recensioni ed eventi popolari.

News

Copertura di notizie completa e aggiornata, aggregata da fonti di tutto il mondo da
Google News.

Foto

La casa di tutte le tue foto e video, organizzata automaticamente per condividere e
salvare le cose pili importanti.

Play Film
Consente di utilizzare il proprio account Google per noleggiare o acquistare film. £
possibile acquistare contenuti e riprodurli ovunque.

Play Musica

Acquista file musicali dal Play Store. E possibile riprodurre i file musicali salvati sul
dispositivo.

Fogli

Sheets e un foglio di lavoro collaborativo che aumenta la produttivita. Usa Sheets
per importare, organizzare e analizzare informazioni in tempo reale.

Presentazioni

Google Slides e uno strumento per presentazioni in tempo reale che aumenta la
produttivita. Usa Slides per organizzare informazioni, presentare risultati e prendere
decisioni insieme in tempo reale.
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YouTube

Guarda i tuoi canali preferiti, ascolta la musica che ami e carica video da condividere
con le persone intorno a te.

Note di Keep

Crea, modifica e condividi le tue note di testo e foto con l'account Google.

Assistente

Il tuo dispositivo dispone di Assistente Google incorporato. Trovale risposte e fai
cose mentre sei in giro. Per inizare, basta toccare il tasto Assistente Google sul lato
del telefono o tenere premuto il pusante home del telefono.

E « Assistente Google non & disponibile in tutte le lingue o paesi.
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Impostazioni

E possibile personalizzare le impostazioni del dispositivo in base alle proprie
preferenze.

Toccare () > Impostazioni.

E + Inserendo una parola chiave nella finestra di ricerca nella parte superiore dello
schermo, & possibile trovare comodamente gli elementi da impostare,

Rete e Internet

Wi-Fi

E possibile connettersi a dispositivi vicini tramite una rete Wi-Fi.

Connessione a una rete Wi-Fi
T Nella schermata delle impostazioni, toccare Rete e Internet > Wi-Fi.
2 Toccare Q) per attivarlo.
« Vengono visualizzate automaticamente le reti Wi-Fi disponibili.
3 Selezionare una rete.
« Potrebbe essere necessario immettere la password Wi-Fi della rete.

« Questo processo viene ignorato in caso di reti a cui é gia stato effettuato
l'accesso in precedenza. Se non si desidera eseguire automaticamente la
connessione a una determinata rete \Wi-Fi, toccare la rete, quindi toccare
Dimentica.
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Impostazioni della rete Wi-Fi
Nella schermata delle impostazioni, toccare Rete e Internet > Wi-Fi.

- Passa a rete dati: se la funzione connessione dati mobile ¢ attiva e il dispositivo
non & in grado di connettersi a Internet tramite la connessione Wi-Fi, il
dispositivo si connette a Internet tramite la connessione dati mobile.

5 + Questa funzione dipende dal provider del servizio.

-+ :consente di personalizzare le impostazioni della rete Wi-Fi.

Wi-Fi Direct

E possibile connettere il dispositivo ad altri dispositivi che supportano la funzione
\Wi-Fi Direct per condividere direttamente i dati con essi. Non & necessario disporre
di un punto di accesso. Utilizzando la funzione Wi-Fi Direct, e possibile connettere
piti di due dispositivi.

T Nella schermata delle impostazioni, toccare Rete e Internet > Wi-Fi> : >
Avanzate Wi-Fi > Wi-Fi Direct.

+ Vlengono automaticamente visualizzati i dispositivi vicini che supportano la
funzione Wi-Fi Direct.

2 Selezionare un dispositivo.
+ La connessione awiene quando il dispositivo accetta la richiesta di
connessione.

E - La batteria potrebbe scaricarsi piti rapidamente quando si utilizza il Wi-Fi Direct.
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Dati mobili

E possibile attivare o disattivare i dati mobili. E inoltre possibile gestirne [utilizzo.

Attivazione dei dati mobili
T Nella schermata delle impostazioni, toccare Rete e Internet > Dati mobili.

2 Toccare QD per attivarlo.

Personalizzazione delle impostazioni dei dati mobili
T Nella schermata delle impostazioni, toccare Rete e Internet > Dati mobili.
7 Personalizzare le sequenti impostazioni:

- Dati mobili: consente di utilizzare le connessioni dati su reti mobili.

- Limita l'utilizzo dei dati mobili: consente di impostare un limite di utilizzo
dei dati mobili in modo da bloccarli al raggiungimento della soglia.

: :consente di personalizzare le impostazioni dei dati mobil.

« Il volume di utilizzo dei dati misurato in base al prodotto e il volume calcolato
dal proprio gestore di telefonia mobile potrebbero essere diversi.
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Impostazioni chiamate

E possibile personalizzare le impostazioni di chiamata, ad esempio le opzioni per le

chiamate vocali e per quelle internazionali.

E « Alcune funzioni potrebbero non essere supportate a seconda dell'area o del
provider del servizio.

T Nella schermata delle impostazioni, toccare Rete e Internet > Impostazioni

chiamate.

7 Personalizzare le impostazioni.

Tethering
Tethering USB

E possibile connettere il dispositivo a un altro dispositivo tramite USB e condividere

i dati mobili.
1 Connettere il dispositivo e gli altri dispositivi tramite il cavo USB.

2 Nella schermata delle impostazioni, toccare Rete e Internet > Tethering >
Tethering USB e quindi toccare Q) per attivarlo.

5

Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

Quando si esegue la connessione a un computer; scaricare il driver USB da
wwwlg.com e installarlo sul computer:

Non é possibile inviare o ricevere file tra il dispositivo e un computer quando il
tethering USB ¢ attivo. Disattivare il tethering USB per inviare o ricevere file.

| sistemi operativi che supportano il tethering sono Windows XP o versione
superiore, o Linux.
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Hotspot Wi-Fi

E possibile impostare il dispositivo in modo da farlo funzionare come un router
wireless affinché altri dispositivi possano connettersi a Internet utilizzando i suoi
dati mobili.

T Nella schermata delle impostazioni, toccare Rete e Internet > Tethering >
Hotspot Wi-Fi e toccare (Q)) per attivare la funzione.

7 Toccare Imposta hotspot Wi-Fi e immettere il Nome Wi-Fi (SSID) e la
password.

3 Attivare il Wi-Fi sull'altro dispositivo e selezionare il nome della rete del
dispositivo nell'elenco delle connessioni Wi-Fi.

/4 Immettere la password di rete.

E + Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei
dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

«  Ulteriori informazioni sono disponibili su questo sito \Web:
http//www.android.com/tether#wifi
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Timer per lo spegnimento automatico dell'hotspot Wi-Fi

Se 'hotspot Wi-Fi non viene utilizzato per un determinato periodo di tempo,
viene disconnesso in automatico. Puoi impostare il periodo di tempo per la
disconnessione automatica.

Tethering Bluetooth

Un altro dispositivo connesso tramite Bluetooth puo connettersi a Internet
utilizzando i dati mobili del proprio dispositivo.

7 Nella schermata delle impostazioni, toccare Rete e Internet > Tethering >
Tethering Bluetooth e quindi toccare () per attivarlo.

7 Attivare il Bluetooth su entrambi i dispositivi e associarli
E « Questa opzione utilizza i dati mobili e potrebbe comportare costi di utilizzo dei

dati, a seconda del piano tariffario. Rivolgersi al proprio provider del servizio per
ulteriori informazioni.

« Ulteriori informazioni sono disponibili su questo sito \Web:
http7/www.android.com/tether#Bluetooth_tethering

Guida

E possibile visualizzare la quida sullutilizzo del tethering e degli hotspot.
Nella schermata delle impostazioni, toccare Retee Internet > Tethering > Guida.
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Modalita aereo

E possibile disattivare le funzioni di chiamata e dei dati mobili. Quando questa
modalita e attiva, restano disponibili le funzioni che non implicano il trasferimento di
dati, ad esempio i giochi e la riproduzione di brani musicali.

1 Nella schermata delle impostazioni, toccare Rete e Internet > Modalita aereo.

7 Toccare Attiva nella schermata di conferma.

Reti mobili
E possibile personalizzare le impostazioni delle reti mobili
T Nella schermata delle impostazioni, toccare Rete e Internet > Reti mobili.

7 Personalizzare le sequenti impostazioni:

+ Roaming dati: selezionare questa opzione per attivare il dispositivo affinché
utilizzi i dati mobili durante il roaming al di fuori dell'area della propria rete
domestica.

- Modalita rete: consente di selezionare un tipo di rete.

+ Nomi punti di accesso: consente di visualizzare o cambiare il punto di
accesso per ['utilizzo dei servizi di dati mobili. Per cambiare il punto di
accesso, selezionarne uno fra quelli disponibili nel relativo elenco.

- Operatori di rete: consente di cercare gli operatori di rete e di connettersi
automaticamente a una rete.
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VPN

E possibile connettersi a una rete virtuale sicura, ad esempio a una Intranet. £
inoltre possibile gestire |a rete privata virtuale connessa.

Aggiunta di una rete VPN

7 Nella schermata delle impostazioni, toccare Rete e Internet > VPN.

2 Toccare—+

E + Questa funzione é disponibile solo se il blocco schermo e attivato. Se il blocco
schermo e disattivato, viene visualizzata una schermata di notifica. Toccare Cambia
dalla schermata di notifica per attivare il blocco schermo. Per ulteriori dettagli,
consultare la sezione Impostazione di un blocco schermo.

3 Immettere i dettagli della rete VPN e toccare Salva.

Configurazione delle impostazioni della rete VPN
1 Toccare una rete VPN nell'elenco VPNS.

7 Immettere i dettagli relativi allaccount utente della rete VPN e toccare
Connetti.

« Per salvare i dettagli dell'account, selezionare la casella di controllo Salva le
informazioni sull'account.

DNS privato
E possibile configurare le opzioni del DNS (Domain Name System) privato.
1 Nella schermata delle impostazioni, toccare Rete e Internet > DNS privato.

2 Selezionare lopzione desiderata e toccare Salva.
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Dispositivi collegati

Bluetooth

E possibile connettere il dispositivo a dispositivi vicini che supportano la funzione
Bluetooth per scambiare direttamente i dati con essi. Connettere il dispositivo a un
auricolare Bluetooth e a una tastiera. In questo modo sara pit semplice controllare
il dispositivo.

Associazione a un altro dispositivo

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Bluetooth.

2 Toccare Q) per attivarlo.
+ Vengono automaticamente visualizzati i dispositivi disponibili.
- Per aggiornare l'elenco dei dispositivi, toccare ().

E + Nellelenco sono visualizzati solamente i dispositivi impostati come visibili.

3 Selezionare un dispositivo dall'elenco.
A Seguire le istruzioni visualizzate sullo schermo per effettuare l'autenticazione.

E « Questo passaggio viene saltato per i dispositivi cui & stato effettuato laccesso in
precedenza.

Invio di dati tramite Bluetooth

1 Selezionare un file.
- E possibile inviare file multimediali o contatti.

2 Toccare <& > Bluetooth.

3 Selezionare un dispositivo di destinazione per il file.
« Il file viene inviato non appena viene accettato dal dispositivo di destinazione.

E « | processi di condivisione di file potrebbero differire, a seconda del file.
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Condivisione schermo

E possibile riprodurre la schermata e laudio del dispositivo su un altro dispositivo,
come ad esempio una TV, in grado di supportare la funzione Miracast.

T Nella schermata delle impostazioni, toccare Dispositivi connessi >
Condivisione schermo.
2 Toccare Q) per attivarlo.

3 Selezionare un dispositivo dall'elenco dei dispositivi vicini.

+ Seil dispositivo desiderato non é visualizzato, toccare Ricerca per aggiornare
l'elenco.

+ Una volta effettuata la connessione al dispositivo, sul relativo schermo viene
visualizzata la schermata del dispositivo.

E « La Condivisione schermo si spegne automaticamente se non vi & alcun dispositivo
compatibile per la condivisione nelle vicinanze.

NFC

E possibile utilizzare il dispositivo come tessera dei trasporti o carta di credito. E
inoltre possibile condividere dati con laltro dispositivo.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > NFC.

7 Toccare Q) per attivarlo.

+ Mettere a contatto il proprio dispositivo con laltro dispositivo che supporta
NFC per consentire la condivisione di dati.

E - L'antenna NFC potrebbe essere situata in una posizione diversa a seconda del tipo
di dispositivo. Per i dettagli relativi allarea dellantenna NFC, vedere Panoramica
delle parti.
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Pannello di condivisione

E possibile condividere i contenuti delle app Galleria, Musica e File Manager con i
dispositivi nelle vicinanze. Inoltre, & possibile condividere contenuti con delle persone
specifiche nelle app che utilizzano Google Direct Share.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > Pannello di
condivisione.

2 Toccare @  per disattivare ciascuna opzione.

- Dispositivi nelle vicinanze: £ possibile visualizzare i dispositivi vicini con cui
e possibile condividere i contenuti delle app Galleria, Musica e File Manager.

« Condivisione diretta: Da unapp che supporta Google Direct Share, e
possibile visualizzare un'icona che consente di condividere contenuti con
persone specifiche.

Condivisione File

E possibile inviare e ricevere file scambiandoli tra il dispositivo e altri dispositivi o
tablet LG.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi >
Condivisione File.

7 Personalizzare le sequenti impostazioni:
+ V50 ThinQ: consente di modificare il nome del dispositivo.
+ Salva in: consente diimpostare la cartella di destinazione in cui salvare i file
inviati da altri dispositivi.
- Condivisione File: consente la ricezione di file inviati da altri dispositivi.

+ SmartShare Beam: consente di condividere file con altri dispositivi tramite
SmartShare Beam.

+ Guida: consente di visualizzare la guida alla condivisione dei file.
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Server multimediale

E possibile condividere contenuti multimediali presenti sul dispositivo con dispositivi
vicini che supportano la funzione DLNA.

1

2

Nella schermata delle impostazioni, toccare Dispositivi connessi > Server

multimediale.

Personalizzare le sequenti impostazioni:

« Condivisione di contenuti: consente di condividere contenuti presenti sul
dispositivo con dispositivi vicini.

+ V50 ThinQ: consente di impostare il nome del dispositivo.

5 « Aseconda del prodotto dell'utente, i nomi dei menu potrebbero apparire in modo

diverso

- Contenuti da condividere: consente di selezionare il tipo di contenuti
multimediali da condividere con altri dispositivi.

Dispositivi consentiti: consente di visualizzare un elenco dei dispositivi a cui
& consentito accedere ai contenuti presenti sul dispositivo.

- Dispositivi non autorizzati: consente di visualizzare un elenco dei dispositivi
a cui non e consentito accedere ai contenuti presenti sul dispositivo.

LG AirDrive

E possibile utilizzare il proprio account LG da un computer per gestire i file salvati
sul dispositivo. Non & necessario disporre di una connessione USB.

1

2

Nella schermata delle impostazioni, toccare Dispositivi connessi > LG
AirDrive.

Utilizzare un singolo account LG per accedere a LG Bridge sul computer e a LG
AirDrive sul dispositivo.

« Il software LG Bridge puo essere scaricato dal sito www.lg.com.

Gestire i file presenti sul dispositivo dal computer.
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MirrorLink

E possibile connettere il dispositivo a un'auto tramite USB per utilizzare [app
MirrorLink installata sul dispositivo dallimpianto di infotainment o dalla head unit
dellauto.

5

Questapp e disponibile soltanto nelle automobili che supportano MirrorLink.

« Scaricare [app MirrorLink da uno store o un mercato di app. Per maggiori
informazioni, visitare https7/mirrorlink.com/apps.

Alcune funzioni potrebbero essere limitate per la sicurezza del conducente quando
si usa la funzionalita MirrorLink.

1 Nella schermata delle impostazioni, toccare Dispositivi connessi > MirrorLink.

2 Collegare il dispositivo a unautomobile usando il cavo USB e attivare Collega
tramite Cavo USB.

5

Se il dispositivo viene collegato a un veicolo che supporta la connessione
MirrorLink automatica, Collega tramite Cavo USB si attiva automaticamente sul
dispositivo.

. . N
Toccare ¢ per configurare la connessione MirrorLink USB automatica.

Stampa

E possibile connettere il dispositivo a una stampante Bluetooth e stampare foto o
documenti salvati sul dispositivo.

Nella schermata delle impostazioni, toccare Dispositivi connessi > Stampa.

+ Toccare Servizio stampa predefinito per cercare le stampanti a cui & possibile
connettersi. Oppure, toccare + > Aggiungi stampante per aggiungere
manualmente una stampante.

- Toccare (+) Aggiungi servizio per scaricare lapp della stampante desiderata.

E « Questa funzione é disponibile sono quando ¢ attiva la funzione di rete mobile o
Bluetooth.

+ Per scaricare [app della stampante in @ Aggiungi servizio, & necessario prima
accedere al proprio account Google.
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Suono

E possibile personalizzare le impostazioni relative a suono, vibrazione e notifiche.

Nella schermata delle impostazioni, toccare Suono e personalizzare le seguenti
impostazioni:

Profilo audio: consente di passare alla modalita audio Suono, Vibrazione o
Silenzioso.

Volume: Consente di regolare il volume dellaudio di diversi elementi.

Suonerie: consente di selezionare una suoneria per le chiamate in arrivo. E
possibile aggiungere o eliminare suonerie.

Suono di notifica: consente di selezionare una suoneria per le notifiche. E
possibile impostare un brano musicale salvato sul dispositivo come suoneria di
notifica.

Suoneria con vibrazione: consente di impostare sul dispositivo la vibrazione e la
riproduzione di una suoneria in contemporanea.

Suoneria contatto: consente di creare una suoneria per una chiamata in arrivo
da un determinato contatto.

Allerta flash per le chiamate in arrivo:imposta il lampeggiamento secondo la
suoneria LG.

Non disturbare: consente di impostare il tempo, l'intervallo e il tipo di app per
cui ricevere messaggi di notifica. E possibile ricevere messaggi di notifica solo in
particolari giorni della settimana.

Qualita del suono ed effetti: Usare la funzione per impostare la qualita e gli
effetti audio quando si riproduce una canzone o video.

Potenza vibrazione: consente di regolare l'intensita della vibrazione.

Tipo vibrazione: consente di selezionare il tipo di vibrazione per le chiamate in
arrivo.

Vibrazione al tocco: consente di impostare la vibrazione del dispositivo quando
si toccano determinati elementi sullo schermo.

Suono della tastiera di composizione: attiva ['effetto sonoro del tastierino.
Suono della tastiera LG: attiva 'effetto sonoro della tastiera LG.
Suono touch: attiva un effetto sonoro per quando si tocca un elemento.

Suoni di blocco schermo: attiva un effetto sonoro per quando lo schermo viene
bloccato o sbloccato.
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Display

E possibile personalizzare le impostazioni dettagliate di ogni tipo di schermata.

Nella schermata delle impostazioni, toccare Display e personalizzare le seguenti

impostazioni:

+ Sfondo: consente di personalizzare le impostazioni per la schermata Home. Per
ulteriori dettagli, consultare la sezione Impostazioni della schermata Home.

- Sfondo & Tema: seleziona un wallpaper, tema, icona e AOD per lo schermo del
tuo dispositivo.

- Carattere: modificare dimensione, grassetto, o facciata.

- New Second Screen: selezionare 'aspetto della barra dello stato e dell'angolo
delleapp.

- Barra di navigazione:Impostare lo stile della barra di navigazione. Per ulteriori
dettagli, consultare la sezione Cambio dello stile dei pulsanti a sfioramento
anteriori.

- AOD (Always-on display): consente di visualizzare sempre informazioni come
data, ora e notifiche, anche quando lo schermo e spento. Per maggiori dettagli,
vedere AOD (Always-on display).

+ Vista comfort: consente di ridurre la quantita di luce blu sullo schermo del
dispositivo per limitare ['affaticamento degli occhi.

- Modalita notte: Di notte e possibile applicare un tema dello schermo oscurato
per evitare ['abbagliamento.

- Colore dello schermo: Regola colore, temperatura del colore, o valori RGB per lo
schermo desiderato.

E - Toccare O per ripristinare le impostazioni.

- Miglioramento video: Durante |a riproduzione di un video in modalita schermo
intero, & possibile modificare le impostazioni per una visualizzazione a Colore
dello piti luminosa e dinamica.
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- Ridimensionamento della app: consente di regolare le dimensioni sullo
schermo delle app.

Proporzioni
+ Questo dispositivo utilizza le proporzioni 19,59.
- Alcune app scaricate potrebbero non supportare le proporzioni 19,5:9.

In tal caso, selezionare le proporzioni dello schermo pili adatte allapp o
consultare il provider dellapp per ulteriori informazioni.

- Puoi selezionare il rapporto per app singole premendo O > Impostazioni >
Display > Ridimensionamento della app. Selezionare le proporzioni desiderate
tra Compatibilita (16:9), Standard (16.7:9), e Schermo intero.

- Dimensioni display: consente di impostare gli elementi presenti sullo schermo
su dimensioni facilmente visibili per l'utente. Alcuni elementi potrebbero
cambiare posizione.

- Risoluzione dello schermo: Regola la risoluzione dello schermo.

5 « Quando si modifica la risoluzione dello schermo, le app attualmente attive
vengono chiuse.

Luminosita: utilizzare la barra di scorrimento per modificare la luminosita dello
schermo.

Automatico: consente di impostare |a regolazione automatica della luminosita
dello schermo in base allintensita luminosa dellambiente.

Timeout schermo: consente di disattivare automaticamente lo schermo

quando il dispositivo viene lasciato inattivo per un determinato periodo di
tempo.

Rotazione automatica: consente di ruotare automaticamente lo schermo a
seconda dellorientamento del dispositivo.

Screen saver: consente di visualizzare uno screen saver quando il dispositivo &
collegato al supporto o al caricabatteria. Selezionare un tipo di screen saver da
visualizzare.

Schermo a una mano: Ridurre le dimensioni dello schermo in modo da poter
utilizzare il dispositivo con una sola mano. Trascinare il pulsante a sfioramento
Home verso 'angolo inferiore sinistro o destro dello schermo.
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Blocco schermo & sicurezza

E possibile personalizzare le impostazioni della schermata di blocco e della
sicurezza.

1
2

Nella schermata delle impostazioni, toccare Blocco schermo & sicurezza.

Personalizzare le impostazioni.

Google Play Protect: scansiona giornalmente il dispositivo per scoprire app
potenzialmente nocivi.

Trova il mio dispositivo: Tracciare a distanza a posizione del dispositivo.
Puoi anche proteggere i tuoi dati in modo sicuro se hai smarrito il tuo
dispositivo.

Aggiornamento della sicurezza: controlla gli aggiornamenti software e
configura le impostazioni di installazione automatiche.

Aggiornamento di sistema Google Play: Controllare la disponibilita di
aggiornamenti di sistema di Google Play.

Seleziona il blocco dello schermo: Seleziona il metodo di blocco schermo
desiderato. Per ulteriori dettagli, consultare la sezione Impostazione di un
blocco schermo.

Personalizza Blocco schermo: modifica le informazioni visualizzate sullo
schermo bloccato.

Impostazioni di Blocco con sicurezza: modifica le impostsazioni di blocco
sicuro.

Impronte digitali: consente di usare impronta digitale per sbloccare
lo schermo o il contenuto. Per ulteriori dettagli, consultare la sezione
Informazioni generali sul riconoscimento delle impronte digitali.

Riconoscimento del volto: consente di sbloccare lo schermo con il proprio
volto. Per ulteriori dettagli, consultare la sezione Informazioni generali sul
riconoscimento del volto.

Blocco del contenuto: consente di impostare un tipo di blocco (password o
disegno) per i propri file QuickMemo+ e Galleria.

Crittografia e credenziali: configura le impostazioni per la cifratura e le

credenziali della scheda SD.

- Cripta la Scheda SD: consente di crittografare la scheda di memoria per
impedire ['utilizzo su un altro dispositivo. Per ulteriori dettagli consultare
la sezione Crittografia della scheda di memoria.
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Awvio sicuro: consente di proteggere il proprio dispositivo con un blocco
allaccensione. Per ulteriori dettagli, consultare la sezione Impostazioni di
awio sicuro.

Protezione delle credenziali: consente di visualizzare il tipo di memoria
su cui sara salvato il certificato di sicurezza.

Credenziali di fiducia: visualizza i certificati CA root e i certificati CA
installati dallutente del tuo sistema.

Credenziali dell'utente: visualizza e modifica le informazioni dei
certificati sicuri conservati sul tuo dispositivo.

Installa dalla memoria: installare un certificato sicuro da un archivio.
Cancella archivio: cancella i certificati sicuri installati da utente e le
credenziali relative.

Impostazioni blocco SIM: consente di bloccare o sbloccare la scheda USIM
o di madificare la password (PIN).

Amministratori dispositivo: consente privilegi per limitare il controllo o
['utilizzo del dispositivo a determinate app.

Trust agents: consente di visualizzare e utilizzare agenti attendibili installati
sul dispositivo.

Puntina schermo: consente di fissare la schermata dellapp in modo che sia
possibile utilizzare soltanto lapp attiva al momento.

Accesso all'utilizzo: consente di visualizzare i dettagli sull'utilizzo delle app
sul dispositivo.

Privacy
E possibile trovare e regolare tutte le impostazioni sulla privacy.
T Nella schermata delle impostazioni, toccare Privacy.

7 Personalizzare le impostazioni.

- Autorizzazione manager: Consente di controllare e cambiare le
autorizzazioni concesse alle app.

+ Blocco schermo: Consente di impostare le notifiche da visualizzare sul
blocco schermo.

Impostazioni 165



Rendi visibili le password: attivare questa opzione per visualizzare
rapidamente ciascun carattere della password mentre si digita per vedere
cosa si staimmettendo.

« Servizio di compilazione automatica di Google: azionare questa opzione
per inserire le informazioni salvate nel proprio account come password,
indirizzo, 0 numero di carta di credito con un singolo tocco. E possibile anche
disattivare questa opzione, usare la funzione Google Autocomplete, oppure
aggiungere un nuovo account di servizio.

- Cronologia delle posizioni Google: Consente di abilitare o disabilitare
la Cronologia delle posizioni. Quando e abilitata, Google periodicamente
memorizza e utilizza i dati sulla posizione piti recenti del telefono in
connessione con account Google.
Nella schermata Cronologia delle posizioni, toccare + per visualizzare e/o
gestire i dati sulla posizione.

Controlli attivita: Seleziona attivita e informazioni che si desidera vengano
salvate da Google.

Annunci: Consente di controllare D pubblicita e impostare le pubblicita
personalizzate.

Utilizzo e diagnostica: Abilitare questa opzione per migliorare ['esperienza
Android inviando automaticamente a Google dati diagnostici e sull utilizzo
del dispositivo e delle app.

Posizione

E possibile controllare come vengono condivise le informazioni sulla propria
posizione e configurare 'autorizzazione per accedere alle informazioni sulla propria
posizione.

Nella schermata delle impostazioni, toccare Posizione e impostare la funzione
desiderata.
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Estensioni

Smart Doctor

E possibile utilizzare Smart Doctor per eseguire una diagnosi dello stato del
dispositivo e ottimizzarlo.

Nella schermata delle impostazioni, toccare Estensioni > Smart Doctor.

Context Awareness

E possibile modificare automaticamente le impostazioni del dispositivo in base alla
sequenza di utilizzo e alla posizione.

T Nella schermata delle impostazioni, toccare Estensioni > Context Awareness.

7 Attivare gli elementi per i quali si desidera modificare automaticamente le
impostazioni.

« Parking Assistant: Questa opzione memorizza i luoghi in cui si parcheggia.
Per non ricevere notifiche di parcheggio vicino a casa o al luogo di lavoro,
disattivare le notifiche | miei luoghi QD). I registri di parcheggio sono
memorizzati in QuickMemo+.

+ AUTOMATIZZATO: E possibile impostare il dispositivo in modo che modifichi
automaticamente il profilo audio, le opzioni Bluetooth e Wi-Fi in diversi
ambienti, ad esempio A casa, Fuori casa, Al lavoro e Non al lavoro. E possibile
anche impostare che unapp si apra quando vengono collegati gli auricolari o
quando viene connesso un dispositivo Bluetooth.

E + Per poter usare questa funzione, le posizioni di casa e lavoro devono essere
presenti in | miei luoghi. Nella schermata delle impostazioni, toccare Posizione > |
miei luoghi per impostare le posizioni.
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Gaming
E possibile configurare le impostazioni di gioco per gli strumenti, la grafica e il
risparmio energetico.

T Nella schermata delle impostazioni, toccare Estensioni > Gaming.

7 Personalizzare le seguenti impostazioni:

Strumenti di gioco: E possibile esequire la funzione durante il gioco

Launcher Del Gioco: Toccare QD) per usare la funzione Launcher Del Gioco.

toccando l'icona degli strumenti di gioco tra i pulsanti a sfioramento anteriori.

Grafica di gioco: Regola |a grafica di gioco.

E « Se si modifica la risoluzione video di alcuni giochi, le funzioni di visualizzazione dello

schermo potrebbero non funzionare correttamente.

« Questa funzione potrebbe non essere disponibile per alcune app di gioco.

Tempo di pausa: Riduce la luminosita dello schermo e le prestazioni, ogni
volta che si abbandonaiil gioco per piti di 5 minuti.

Registrazione schermata

E possibile configurare le impostazioni della registrazione dello schermo.

71 Nella schermata delle impostazioni, toccare Estensioni > Registrazione
schermata.

7 Personalizzare le sequenti impostazioni:

+ Includere sé stessi nel video: Selezionare una delle seguenti opzioni e
toccare Salva.

- Immagine:Include limmagine del profilo nel video durante la
registrazione. Una volta effettuata questa selezione, toccare @) e
selezionare unimmagine del profilo. Regolare quindi le dimensioni
dellimmagine usando la barra di scorrimento.

- Fotocamera anteriore: Include sé stessi registrati con la fotocamera
anteriore durante la registrazione dello schermo.

- Mai: Non viene incluso niente.
- Origine audio: Scegliere lorigine audio tra Microfono e Contenuti.

« Risoluzione video: Selezionare |a risoluzione per la registrazione dello
schermo.
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Per registrare lo schermo

1 Trascinare verso il basso la barra di stato per aprire lelenco delle icone di
accesso rapido.

7 (Se necessario, scorrere a sinistra sull'area delle icone di accesso rapido.) Toccare

G

3 Leggere la dichiarazione di non responsabilita e toccare Inizia. La registrazione
inizia in 3 secondi.

A Per arrestare la registrazione, toccare (®), nella parte inferiore destra dello
schermo. Il video registrato viene salvato nella Galleria.

E « Laviolazione dei diritti di altre persone, quali il diritto di ritratto o di proprieta
intellettuale, o la diffamazione della reputazione di altre persone utilizzando le
funzioni fornite per il servizio di registrazione dello schermo, possono comportare
responsabilita civili, penali o amministrative in conformita con le leggi vigenti. LG
Electronics declina ogni responsabilita legale per le azioni degli utenti.

Dual App

E possibile installare app di messaqgistica duplicate nel prodotto e utilizzare due

account contemporaneamente.

1 Nella schermata delle impostazioni, toccare Estensioni > Dual App.

2 Dopo aver letto la dichiarazione di non responsabilita, toccare Conferma.

3 Nellelenco delle app disponibili, toccare Installa per installare una copia dellapp
desiderata e seguire le istruzioni visualizzate sullo schermo.

+ Sullo schermo viene visualizzato lelenco delle app duplicate disponibili.
Durante linstallazione, sulla schermata Home vengono generate le icone
delle app.

Floating Bar
Puoi attivare le funzioni piti frequenti, tra cui scorciatoie, screenshot, musica,
contatti e molto altro, toccando e facendo scorrere la barra fluttuante sullo

schermo. Per ulteriori dettagli, consultare la sezione Panoramica Pulsante
fluttuante.
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Collegamenti

E possibile utilizzare pulsanti quali accensione/blocco, volume e Assistente Google
per esequire direttamente determinate app o funzioni.

T Nella schermata delle impostazioni, toccare Estensioni > Collegamenti.

7 Personalizzare le seguenti impostazioni.

+ Visualizza il pannello di notifica: scorriin alto/in basso il sensore delle
impronte digitali per il pannello delle notifiche.

+ Apri Fotocamera: Premere il tasto di accensione due volte per awiare la
Fotocamera.

+ Apri Capture+: Quando lo schermo ¢ bloccato o spento, premere due volte il
tasto volume su (+) per awiare Capture+.

« Apri Fotocamera: Quando lo schermo e bloccato o spento, premere due
volte il tasto volume gili (-) per awviare Fotocamera.

« Apri Assistente Google: Premere il tasto Assistente Google sul lato del
telefono.

- Parla con Assistente Google: Tenere premuto il tasto Assistente Google
per parlare rapidamente con [Assistente.

+ Mostra l'istantanea visiva: Premere due volte il tasto Assistente Google
per vedere un'istantanea della giornata nellapp Assistente Google.

5 « Assistente Google non supporta alcune lingue.

Toc Toc
Eseguire un doppio tocco sullo schermo per spegnerlo o accenderlo.
Per ulteriori dettagli, consultare la sezione Toc Toc.

Aumenta sensibilita al tocco

E possibile aumentare la sensibilita al tocco del touchscreen. Si consiglia di attivare
questa funzione quando si usa una protezione per lo schermo.

Nella schermata delle impostazioni, toccare Estensioni > Aumenta sensibilita al
tocco.
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Benessere digitale e controllo
parentale

E possibile visualizzare il tempo di utilizzo del prodotto e impostare il timer per
ciascuna app. E possibile inoltre gestire il tempo di utilizzo del telefono cellulare
utilizzando la modalita di preparazione al sonno e la modalita di messa a fuoco.

Nella schermata delle impostazioni, selezionare Benessere digitale e controllo
parentale e impostare la funzione desiderata.

App & notifiche

E possibile controllare lelenco delle app installate e configurare le impostazioni per
notifiche, autorizzazioni delle app e altro ancora.
1 Nella schermata delle impostazioni, toccare App & notifiche.

7 Personalizzare le impostazioni.

Batteria

E possibile visualizzare le informazioni sulla batteria corrente o attivare la modalita
risparmio energetico.

1 Nella schermata delle impostazioni, toccare Batteria.

2 Personalizzare le seguenti impostazioni:

- Utilizzo della batteria: consente di visualizzare i dettagli sull utilizzo della
batteria.

+ Percentuale della batteria sulla barra di stato: consente di visualizzare il
livello della batteria residua come percentuale sulla barra di stato.

« Ricarica ottimizzata: regola automaticamente la velocita di carica in base a
come si carica, per ridurre il calore e prolungare la durata della batteria.

- Batteria adattativa: consente di risparmiare la batteria impedendo
lesecuzione in background delle app.
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- Limitazione sfondo: abilitare questa opzione per limitare le app in
background e risparmiare la batteria durante ['uso del dispositivo. Le app
con limitazioni per il risparmio energetico potrebbero non funzionare
correttamente o potrebbero non inviare notifiche.

- Risparmio energetico: consente di ridurre il consumo della batteria

riducendo alcune impostazioni del dispositivo, come la luminosita del display,
la velocita e lintensita della vibrazione.

Eccezioni del risparmio energetico: Seleziona le app che vengono
utilizzare senza alcuna restrizione in modalita di risparmio energetico o di
ottimizzazione della batteria.

Archiviazione

E possibile visualizzare e gestire la memoria interna sul dispositivo o lo spazio di
archiviazione della scheda di memoria.

T Nella schermata delle impostazioni, toccare Archiviazione.

7 Personalizzare le seguenti impostazioni:

« Archivio interno: consente di visualizzare lo spazio di archiviazione totale
e lo spazio libero nella memoria interna del dispositivo. Visualizza un elenco
delle app in uso e la capacita di archiviazione di ciascuna app.

+ Scheda SD: consente di visualizzare lo spazio di archiviazione totale e lo
spazio libero nella scheda di memoria. Questa opzione compare soltanto
quando viene inserita una scheda di memoria. Per disattivare la scheda di
memoria, toccare

Account

E possibile aggiungere utenti con i quali condividere e registrare un account cloud.
71 Nella schermata delle impostazioni, toccare Account.

2 Personalizzare le impostazioni.
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Google

E possibile utilizzare le impostazioni di Google per gestire le proprie app e le
impostazioni dell'account di Google.

Nella schermata delle impostazioni, toccare Google.

Sistema

Centro aggiornamenti

Puoi controllare e installare la versione pili recente dell'app o del software fornito
alG

1 Nella schermata delle impostazioni, toccare Sistema > Centro aggiornamenti.

7 Personalizzare le sequenti impostazioni:

- Aggiornamento applicazione: controlla se e disponibile un aggiornamento.
Se disponibile, puoi installare 'aggiornamento.

- Aggiornamento software: controlla se e disponibile un aggiornamento
software. Se disponibile, puoi installare ['aggiornamento.

Lingua e tastiera
E possibile personalizzare le impostazioni di lingua e tastiera del dispositivo.
T Nella schermata delle impostazioni, toccare Sistema > Lingua e tastiera.
7 Personalizzare le seguenti impostazioni:
« Lingua: consente di selezionare una lingua da applicare al dispositivo.

- Gestisci tastiere: £ possibile modificare le impostazioni di base della tastiera
del prodotto, impostare gli ambienti di utilizzo per la tastiera LG o altre
tastiere installate e impostare la funzione di riconoscimento vocale per i
comandi con Google Voice. E possibile inoltre impostare se visualizzare il
pulsante della tastiera nell'area dei pulsanti a sfioramento della schermata
Home, in modo da poter passare rapidamente a un‘altra tastiera.
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- Tastiera fisica: selezionare per usare |a tastiera fisica, o controllare i tasti dei
collegamenti da tastiera.

« Servizio Compilazione automatica: azionare questa opzione per inserire le
informazioni salvate nel proprio account come password, indirizzo, 0 numero
di carta di credito con un singolo tocco. Puoi anche disattivare questa
opzione, usare Google Autocomplete, 0 aggiungere un nuovo account di
servizio.

- Uscita text-to-speech: consente di configurare le impostazioni delloutput
sintesi vocale.

Velocita del puntatore: consente di regolare la velocita del puntatore di un
mouse o trackpad.

Inverti i pulsanti del mouse: consente di invertire il pulsante destro del
mouse in modo che esegua le principali azioni di manipolazione diretta.

Data e ora
E possibile personalizzare le impostazioni di data e ora del dispositivo.
1 Nella schermata delle impostazioni, toccare Sistema > Data e ora.

7 Personalizzare le impostazioni.

Memoria

Consente di visualizzare la quantita media di utilizzo della memoria in un
determinato periodo di tempo e la memoria occupata da unapp.

1 Nella schermata delle impostazioni, toccare Sistema > Memoria.

2 Toccare w per impostare una fascia oraria per il recupero dei dati.
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Backup

E possibile esequire il backup dei dati salvati sul dispositivo su un altro dispositivo o
account.

T Nella schermata delle impostazioni, toccare Sistema > Backup.

7 Personalizzare le sequenti impostazioni:
LG Mobile Switch: consente di trasferire i dati da un vecchio dispositivo LG a
quello nuovo. Per ulteriori dettagli, consultare la sezione LG Mobile Switch.

+ Backup e ripristino: consente di eseguire il backup dei dati del dispositivo o
ripristinare i dati di un backup nel dispositivo.

A - Ilripristino del dispositivo potrebbe eliminare i file di backup salvati nellarchivio.
Assicurarsi di copiare e salvare i file di backup importanti nel proprio PC.

- Google Backup: modifica le impostazioni di backup di Google. E possibile
anche controllare 'account di backup attualmente usato, o aggiungere un
nuovo account di backup.

Riavvio & Ripristino
E possibile ripristinare il dispositivo, includendo le impostazioni di rete e app.
71 Nella schermata delle impostazioni, toccare Sistema > Riavvio & Ripristino.

7 Personalizzare le sequenti impostazioni:

+ Riavvio automatico: Riavvia e ottimizza automaticamente il telefono all'ora
impostata. Toccare QD) per attivare la funzione. Il dispositivo si riawia
automaticamente all'ora impostata e si ottimizza. Seleziona la data e l'ora
del riawvio.

E - Puoiimpostare il dispositivo affinché si riawii una volta la settimana. Il dispositivo
si riavvia automaticamente entro un'ora dall'ora impostata.

+ Unavolta che il dispositivo si riawia, le notifiche e i badge sono cancellati. Salvare i
dati importanti prima dell'ora preimpostata.

+ Lafunzionalita di riavvio automatico non ¢ attivata nelle seguenti situazioni.
Quando lo schermo ¢ acceso, quando il dispositivo & in uso, quando il livello della
batteria & il 30% o meno, quando la scheda USIM é bloccata, o quando il blocco del
dispositivo e attivo durante 'accensione del dispositivo.

- Aseconda del fornitore del servizio di telecomunicazione, la funzione di riavvio
automatico potrebbe non essere disponibile.

Impostazioni 175



+ Ripristino delle impostazioni della rete: consente di ripristinare Wi-Fi,
Bluetooth e altre impostazioni di rete.

- Ripristina preferenze applicazione: ripristina le impostazioni dio un'app. |
dati salvati nell'app non saranno cancellati.

« Ripristino dati di fabbrica: consente di ripristinare tutte le impostazioni del
dispositivo ed eliminare i dati.

5 « |lripristino e il riawvio del dispositivo elimina tutti i dati presenti sullo stesso. Inserire
nuovamente il nome del dispositivo, laccount Google e altre informazioni iniziali.

+ Dopo linizializzazione dei dati, i dati non possono piti essere recuperati.

Info sul telefono

E possibile visualizzare informazioni sul dispositivo, come nome, stato, dettagli
software e informazioni legali.

Nella schermata delle impostazioni, toccare Sistema > Info sul telefono e
visualizzare le informazioni.

Normative & Sicurezza

E possibile visualizzare i certificati normativi e le relative informazioni sul proprio
dispositivo.
Nella schermata delle impostazioni, toccare Sistema > Normative & Sicurezza.

Accesso facilitato

E possibile gestire i plugin di accessibilita installati sul dispositivo.
1 Nella schermata delle impostazioni, toccare Accessibilita.

7 Personalizzare le seguenti impostazioni:

Visione > TalkBack: consente di impostare il dispositivo in modo da
notificare lo stato dello schermo o le azioni tramite voce.

Visione > Notifiche vocali:impostare sul dispositivo (a lettura delle
informazioni del chiamante tramite voce.

Visione > Carattere: modificare dimensione, grassetto, o facciata.
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Visione > Dimensioni display: consente di impostare gli elementi presenti
sullo schermo su dimensioni facilmente visibili per l'utente. Alcuni elementi
potrebbero cambiare posizione.

Visione > Zoom touch: consente di eseguire o zoom avanti o indietro
toccando lo schermo tre volte.

Visione > Zoom della finestra: consente di eseguire lo zoom avanti o
indietro allinterno di una finestra e invertire il colore.

Visione > Puntatore del mouse grande: consente di ingrandire il puntatore
del mouse.

Visione > Schermo ad alto contrasto: consente di modificare il colore di
sfondo in nero per uno schermo ad alto contrasto.

« Visione > Inversione del colore dello schermo: consente di aumentare il
contrasto del colore del display per le persone ipovedenti.

Visione > Regolazione del colore dello schermo: consente di regolare il

colore del display.

- Visione > Monocromatica: consente di far passare lo schermo alla modalita
scala di grigi.

« Visione >Termina le chiamate con il tasto di accensione: consente di
terminare una chiamata premendo il tasto di accensione/blocco.

- Udito > Didascalia: consente di attivare il servizio dei sottotitoli durante la

riproduzione di video per non udenti.

Udito > LED lampeggiante: consente di indicare lo stato del dispositivo
tramite LED.

+ Udito > Flash allarme: consente di impostare il dispositivo in modo da
notificare all'utente le chiamate in arrivo, i messaggi e le sveglie con una luce
lampeggiante.

+ Udito > Disattiva tutti i suoni: consente di disattivare tuttii suoni e
abbassare il volume sul ricevitore.

+ Udito > Canale audio: consente di selezionare il tipo di audio.

+ Udito > Bilanciamento del suono: consente di regolare il bilanciamento
dell'uscita audio. Consente di utilizzare la barra di scorrimento per modificare
il bilanciamento.

+ Movimento & cognizione > Touch assistant: consente di attivare il pannello
touch per facilitare ['utilizzo di pulsanti e gesti.
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- Movimento & cognizione > Input tattile: consente di immettere il testo
toccando e tenendo premuto lo schermo, o di modificarlo semplicemente
toccando lo schermo.

+ Movimento & cognizione > Tastiera fisica: consente di personalizzare le
impostazioni della tastiera.

+ Movimento & cognizione > Click automatico del mouse: consente di
cliccare il puntatore del mouse automaticamente in caso di assenza di
movimento.

+ Movimento & cognizione > Tocca e tieni premuto per le chiamate:
consente di rispondere o rifiutare le chiamate toccando e tenendo premuto il
pulsante di chiamata, invece di trascinarlo.

+ Movimento & cognizione > Timeout schermo: consente di disattivare
automaticamente lo schermo quando il dispositivo viene lasciato inattivo per
un determinato periodo di tempo.

+ Movimento & cognizione > Aree di controllo tattile: consente di limitare
l'area touch in modo che soltanto una determinata porzione dello schermo
possa essere controllata dall'inserimento touch.

- Collegamento alle funzioni di accessibilita: consente di accedere
rapidamente a una funzione utilizzata di frequente toccando O tre volte.

- Rotazione automatica: consente di cambiare automaticamente
lorientamento dello schermo a seconda della posizione fisica del dispositivo.

+ Amazon Assistant: Amazon Assistant offre automaticamente confronti tra
prodotti quando fai acquisti in alcune app del tuo dispositivo.

Seleziona per ascoltare: consente di toccare gli elementi e ricevere una
risposta vocale.

+ Switch Access: consente di creare combinazioni di tasti per controllare il
dispositivo.
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Impostazioni della lingua

E possibile selezionare una lingua da utilizare sul dispositivo.
- Toccare O > Impostazioni > Sistema > Lingua e tastiera > Lingua >
AGGIUNGI LINGUA, quindi selezionare una lingua.

- Toccare e tenere premuta = quindi trascinarla in cima allelenco delle lingue
per impostarla come lingua predefinita.

LG Bridge

Informazioni generali su LG Bridge

LG Bridge e unapp che aiuta a gestire comodamente dal proprio computer le foto,
la musica, i video e i documenti salvati sullo smartphone LG. E possibile eseguire

il backup dei contatti, delle foto e di altri elementi sul computer o aggiornare il
software del dispositivo.

E « Peridettagli vedere la guida di LG Bridge.
« Le funzioni supportate possono variare a seconda del dispositivo.

« Il driver USB LG e un programma necessario per connettere o smartphone LG con
il computer e viene installato quando si installa LG Bridge.

Funzioni di LG Bridge

- Consente di gestire i file presenti sul dispositivo da un computer tramite una
connessione Wi-Fi o una connessione dati mobile.

+ Consente di esequire il backup dei dati dal dispositivo a un computer o
ripristinare i dati da un computer al dispositivo tramite un collegamento con
cavo USB.

- Consente di aggiornare il software del dispositivo da un computer tramite un
collegamento con cavo USB.
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Installazione di LG Bridge su un computer
1 Andare sul sito wwwlg.com dal proprio computer.

7 Selezionare la regione.

3 Fare clic su Supporto > Software e firmware.

4

Immettere il nome del dispositivo.
OPPURE
Selezionare Categoria prodotto.

5 Andare a Sync PC > LG Bridge per scaricare il file di installazione.

+ Andare su Dettagli per visualizzare i requisiti minimi per l'installazione di LG
Bridge.

Aggiornamento software del telefono

Aggiornamento software del telefono LG Mobile da

Internet

Per ulteriori informazioni sull'utilizzo di questa funzione, visitare
http//wwwi.lg.com/common/index,sp, selezionare il paese e la lingua.

Questa funzione consente di aggiornare facilmente il firmware del telefono a
una versione pitl recente da Internet senza la necessita di visitare un centro

di assistenza. Questa funzione sara disponibile solo se e quando LG mette a
disposizione una nuova versione del firmware per il dispositivo.

Poiché laggiornamento del firmware del telefono cellulare richiede la massima
attenzione da parte dell'utente per tutta la durata del processo di aggiornamento,
assicurarsi di controllare tutte le istruzioni e le note visualizzate a ogni passaggio
prima di procedere. Si prega di notare che la rimozione del cavo USB durante
laggiornamento puo danneggiare gravemente il telefono cellulare.

E + LGsiriservail diritto di rendere disponibili aggiornamenti del firmware

esclusivamente per modelli selezionati a propria discrezione e non garantisce la
disponibilita della versione pili recente del firmware per tutti i modelli di cellulari.
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Aggiornamento software del telefono LG Mobile
tramite Over-the-Air (OTA)

Questa funzione consente di aggiornare facilmente il software del telefono a una

nuova versione tramite OTA, senza collegamento di un cavo USB. Questa funzione
sara disponibile solo se e quando LG mette a disposizione una nuova versione del

firmware per il dispositivo.

Per eseguire [aggiornamento del software del telefono,

Impostazioni > Sistema > Centro aggiornamenti > Aggiornamento software >
Controlla aggiornamenti.

E « | dati personali dell'utente presenti sulla memoria interna del telefono, ivi comprese
le informazioni relative allaccount Google e qualsiasi altro account, i dati e le
impostazioni di sistema/applicazioni, le app scaricate e la licenza DRM potrebbero
andare perduti nel processo di aggiornamento del software del telefono. Pertanto,
LG consiglia di eseguire il backup dei dati personali prima di aggiornare il software
del telefono. LG non si assume alcuna responsabilita per eventuali perdite di dati
personali.

+ Questa funzione dipende dallarea e dal provider del servizio.
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Guida antifurto

Configurare il dispositivo per impedire ad altre persone di utilizzarlo se é stato
ripristinato alle impostazioni di fabbrica senza permesso. Ad esempio, in caso
di smarrimento, furto o cancellazione dei dati del dispositivo, solo qualcuno in
possesso delle informazioni sullaccount Google o delle informazioni sul blocco
schermo puo utilizzare il dispositivo.

Per assicurarsi che il dispositivo sia protetto e sufficiente:

+ Impostare un blocco schermo: Se il dispositivo viene smarrito o rubato, ma
si dispone di un blocco schermo, il dispositivo non puo essere cancellato

utilizzando il menu Impostazioni a meno che lo schermo non venga sbloccato.

Aggiungere il proprio account Google sul dispositivo: Se il dispositivo viene
cancellato, ma e presente un account Google su di esso, il dispositivo non
puo terminare il processo di configurazione fino a quando le informazioni
dellaccount Google non vengono nuovamente inserite.

Dopo aver protetto il dispositivo, & necessario sbloccare lo schermo o immettere la
password dellaccount Google, se & necessario effettuare un ripristino di fabbrica.

Questo fa si che il ripristino venga effettuato da una persona di fiducia.

E + Non dimenticare account Google e la password aggiunti al dispositivo prima
di eseguire un ripristino di fabbrica. Se non & possibile fornire le informazioni

sullaccount durante il processo di configurazione, non sara possibile utilizzare il

dispositivo dopo aver esequito il ripristino di fabbrica
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Informazioni avviso software Open
Source

Per ottenere il codice sorgente contenuto in questo prodotto secondo quanto
consentito dalle licenze GPL, LGPL, MPL e altre licenze Open Source, visitare
http://opensource.lge.com.

In aggiunta al codice sorgente, sono disponibili per il download tutti i termini di
licenza, le esclusioni di responsabilita e e relative note di copyright.

LG Electronics fornira anche il codice open source su CD-ROM su richiesta tramite
e-malil all'indirizzo opensource@I|ge.com addebitando il costo delle spese di
distribuzione (ad esempio il costo di supporti, spedizione e gestione).

Lofferta e valida per un periodo di tre anni a partire dalla nostra ultima spedizione
di questo prodotto. Lofferta e valida per gli utenti che avranno ricevuto queste
informazioni.

Informazioni sulle normative
(Numero ID normativa, etichetta
digitale ecc.)

Per informazioni sulle normative, andare in Impostazioni > Sistema > Normative
& Sicurezza.
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Marchi di fabbrica

« Peribrevetti DTS, vedere http//patents.dts.com. Prodotto sotto licenza da DTS
Licensing Limited. DTS, il relativo simbolo e DTS e il simbolo insieme, DTSX e il
logo DTSX sono marchi commerciali o marchi commerciali registrati di DTS, Inc.
negli Stati Uniti e/o in altri Paesi. © DTS, Inc. Tutti i diritti riservati.

LG Boombox Edition

+ Copyright ©2020 LG Electronics, Inc. Tutti i diritti riservati. LG e il logo LG sono
marchi registrati del Gruppo LG e delle sue entita correlate.

- V50 ThinQ & un marchio di LG Electronics, Inc.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Google Photos, Google Play Protect, Google Calendar, Google Docs,
Google Drive, Google Sheets e altri marchi e logo correlati sono marchi di Google
LLC.

- Bluetooth® & un marchio registrato di Bluetooth SIG, Inc. nel mondo.
- Wi-Fi®eil logo Wi-Fi sono marchi registrati di Wi-Fi Alliance.
« Tutti gli altri marchi sono di proprieta dei rispettivi titolari.

HE HEVCAdvance”

‘: Covered by Patents at patentlisthevcadvance.com
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Dichiarazione sulla sicurezza del laser

Attenzione!

Questo prodotto utilizza un sistema laser. Per garantirne un utilizzo corretto,
leggere attentamente il presente manuale dellutente e conservarlo come
riferimento per il futuro. Se 'unita richiede manutenzione, contattare un centro di
assistenza autorizzato.

Lutilizzo di controlli e regolazioni o lesecuzione di procedure diverse da quelle
specificate puo provocare lesposizione a radiazioni pericolose.

Per evitare lesposizione diretta al fascio laser, non tentare di aprire l'involucro o
entrare in contatto diretto con il laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER
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DICHIARAZIONE DI CONFORMITA

Con il presente documento, LG Electronics dichiara che il prodotto
LM-V500EM é conforme ai requisiti essenziali e alle altre disposizioni della
Direttiva 2014/53/EU.

Una copia della Dichiarazione di conformita e disponibile all'indirizzo
http7//wwwi.lg.com/global/declaration

Contattare 'ufficio relativo alla
conformita del prodotto

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

Labanda 5150 - 5350 MHz e limitata esclusivamente all'utilizzo domestico.

AT |BE |BG|CH|CY|CZ|DE|DK|EE|EL|ES|F

FR

QHR HU[IE | IS|IT| L |LT|LU|LV|MT|NL|NO

PL

PT|RO|[SE | SI | SK|UK|AL|ME|RS |MK]|TR |BA

XK
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Ulteriori informazioni

Parti in vetro temperato
Le parti in vetro temperato di questo dispositivo non sono permanenti e possono
usurarsi col passare del tempo.
+ Se silascia cadere il dispositivo su una superficie dura o lo si espone a un urto
violento, il vetro temperato potrebbe danneggiarsi.
In questi casi, interrompere immediatamente 'uso del dispositivo e contattare
un Centro di assistenza clienti LG.
+ Sul mercato sono disponibili apposite custodie per proteggere il dispositivo da
eventuali danni.
Tenere presente che tali custodie protettive non sono coperte dal servizio di
garanzia fornito da LG Electronics e non ne viene garantita la sicurezza.

CUSTOMER CARE

c 199600044

Per conoscere gli orari di apertura e i relativi costi ti invitiamo a visitare il sito di LG
Italia wwwlg.com/it
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Guida al trasferimento dati

+ Per i dati trasferibili tra dispositivi LG e tra un dispositivo LG e un dispositivo di
parti terze, vedere lo schema seguente.

Dispositivo lz\':z:;:;“;? Dispositivo
LG - i0S
parti terze
Tipo Dettagli dell'elemento — N —
DISpféItIVO Dispositivo Dlspféltlvo
LG
Contatti, messaggi, registri
chiamate, calendario, 6] 0 0
Dati registrazioni audio
i
personat Promemoria X 0
Sveglie
Datll - Foto, \Adeg canzoni, 0 0 0
multimediali | documenti
Impostazioni della schermata
) 0 X X
home (cartelle e widget)
dischermo Impostazioni della schermata
di blocco (impostazioni di 0 X X
blocco schermo escluse)
App scaricate 0 0
Applicazioni | Dzt personali contenuti nelle 0 X -
app scaricate
Certificato pubblico 0 0 X
Altri Impostazioni (Wi-Fi,
Bluetooth, chiamate, suoni
o AN 0 X X
e notifiche, accessibilita,
batteria)
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E « Alcune dati potrebbero non essere trasmessi a seconda della versione del
software, della versione delle app, del sistema operativo, e delle politiche del
produttore del dispositivo o del gestore del servizio.

Bande di frequenza supportate Potenza in uscita trasmettitore

GSM 900 337dBm

GSM 1800 30.7dBm

WCDMA B1 252 dBm

\WCDMA B8 25.5dBm

LTEB1 252 dBm

LTEB3 25.2dBm

LTE B7 252dBm

LTE B8 25.5dBm

LTE B20 25.5dBm

LTE B28 25.5dBm

LTE B38 25.5dBm

LTE B40 252dBm

SGNRnN78 232dBm

BT 2.4GHz 12.5dBm

WLAN 2.4GHz 19.5dBm

WLAN 5.15~5.725GHz 19.0 dBm

WLAN 5.725~5.875GHz 14.5dBm
NFC -22 dBuA/m

Dual Screen 60.75GHz 1.0 dBm
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Smaltimento delle apparecchiature obsolete

1. Tutte le apparecchiature elettriche ed elettroniche, contrassegnate da
questo simbolo ("bidone della spazzatura barrato da una croce”), devono
essere raccolte e smaltite separatamente rispetto agli altri rifiuti urbani
misti mediante impianti di raccolta specifici installati da enti pubblici o dalle
autorita locali. Si ricorda che gli utenti finali domestici possono consegnare
gratuitamente le apparecchiature elettriche ed elettroniche a fine vita presso
il punto vendita all‘atto dellacquisto di una nuova apparecchiatura equivalente.
Gli utenti finali domestici possono inoltre consegnare gratuitamente
apparecchiature elettriche ed elettroniche di piccolissime dimensioni (non
eccedentii 25 cm) a fine vita direttamente presso un punto vendita a cio
abilitato, senza obbligo di acquistare una apparecchiatura nuova di tipo
equivalente. Si prega di informarsi previamente presso il punto vendita
prescelto circa tale ultima modalita di conferimento dellapparecchiatura a fine
vita.

2.1l corretto smaltimento dell'unita obsoleta contribuisce a prevenire possibili
conseguenze negative sulla salute degli individui e sull'ambiente. Una gestione
responsabile del fine vita delle apparecchiature elettriche ed elettroniche
da parte degli utenti contribuisce al riutilizzo, al riciclaggio ed al recupero
sostenibile dei prodotti obsoleti e dei relativi materiali.

3. Per informazioni piti dettagliate sullo smaltimento delle apparecchiature
obsolete, contattare ['ufficio del comune di residenza, il servizio di
smaltimento rifiuti o il punto vendita in cui & stato acquistato il prodotto.
(www.lg.com/global/recycling)
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Smaltimento delle batterie/accumulatori

1. Questo simbolo potrebbe essere associato ai simboli chimici del mercurio (Hg),
cadmio (Cd) o piombo (Pb) se la batteria contiene piti di 0,0005% di mercurio,
0,002% di cadmio 0 0,004% di piombo.

2. Tutte le batterie e gli accumulatori devono essere smaltiti separatamente
rispetto alla raccolta differenziata municipale, mediante impianti di raccolta
specifici designati dal governo o dalle autorita locali.

3.1l corretto smaltimento di batterie e accumulatori obsoleti contribuisce a
prevenire possibili conseguenze negative sullambiente, sulla salute degli
individui e su tutte le altre specie viventi.

4. Per informazioni piti dettagliate sullo smaltimento di batterie e accumulatori
obsoleti, contattare ['ufficio del comune di residenza, il servizio di smaltimento
rifiuti o il negozio in cui & stato acquistato il prodotto.
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FAQ

In questo capitolo sono descritti alcuni problemi che potrebbero verificarsi durante
l'uso del dispositivo. Alcuni problemi richiedono una chiamata al provider del
servizio, ma la maggior parte e facilmente risolvibile in autonomia.

Errore scheda SIM

Assicurarsi che la scheda SIM sia inserita correttamente.

Nessuna connessione alla rete o connessione di rete interrotta
Il segnale & debole. Spostarsi verso una finestra o in uno spazio aperto.
Sei al di fuori dellarea coperta dal fornitore di rete. Spostati e controlla la rete.

Le chiamate non sono disponibili
Nuova rete non autorizzata.

Assicurati di non avere impostato il blocco chiamate dal numero che effettua la
chiamata.

Assicurati di non avere impostato il blocco chiamate dal numero che stai
chiamando.

Non é possibile accendere il dispositivo
Quando la batteria & completamente scarica, il tuo dispositivo non si accende.
Ricaricare completamente la batteria prima di accendere il dispositivo.

Errore di caricamento

Assicurarsi che il dispositivo sia in carica a una temperatura normale.
Controllare il caricabatteria e il suo collegamento al dispositivo.
Utilizzare solo gli accessori forniti autorizzati da LG.
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La batteria si scarica piu rapidamente rispetto a quando é
stata acquistata

Esponendo il dispositivo o la batteria a temperatura molto alte o molto basse, la
durata della batteria potrebbe ridursi.

Il consumo della batteria aumenta quando si usano certe app o funzionalita, come
GPS, giochi o internet.

La batteria e usurabile e la sua durata si riduce nel corso del tempo.

Messaggi d'errore vengono visualizzati quando si avvia la
fotocamera.
Ricaricare la batteria.

Liberare memoria trasferendo i file a un computer o cancellando i file dal proprio
dispositivo.

consente di riawviare il dispositivo.

Se i problemi con [app della fotocamera persistono dopo avere tentato con questi
suggerimenti, contattare il centro di assistenza LG Electronics.

La qualita delle foto e bassa.

La qualita delle foto potrebbe variare, a seconda dellambiente e delle tecniche
fotografiche usate.

Quando si realizzano foto e video, la qualita angolare standard e migliora rispetto al
grandangolo.

Realizzando foto in posti bui, di notte o interni, potrebbero essere presenti disturbi
o le immagini potrebbero essere sfocate.

In caso di problemi, azzerare le opzioni.
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Lo schermo tattile risponde lentamente o in modo non
corretto

Collegando una protezione per lo schermo o accessori opzionali allo schermo tattile,
potrebbe non funzionare correttamente.

Indossando guanti, se le mani non sono pulite quando si tocca lo schermo tattile o
si sfiora lo schermo usando oggetti affilati o le punte delle dita, lo schermo tattile
potrebbe non funzionare.

Lo schermo tattile potrebbe non funzionare correttamente in condizioni di umidita
o0 quando é esposto allacqua.

Riawviare lapparecchio per annullare eventuali bug del software.

Se lo schermo tattile e graffiato o danneggiato, visitare un centro di assistenza LG
Electronics.

Chiude la chiamata o si blocca

Riavviare il dispositivo.
+ Se il dispositivo si chiude la chiamata o si blocca, potrebbe essere necessario
chiudere le applicazioni o spegnere del tutto il dispositivo e riaccenderlo.

Eseguire un riavvio
- E possibile utilizzare un ripristino superficiale del dispositivo se lo schermo
si blocca oppure se i pulsanti, lo schermo a sfioramento o il dispositivo non
rispondono piti in modo corretto.
+ Per esequire un ripristino superficiale del dispositivo, tenere premuti i tasti
Volume giti e Power fino a quando il dispositivo non si riavvia.

Azzerare il dispositivo
+ Se i metodiillustrati sopra non risolvono il problema, esequire un ripristino dati

di fabbrica.

+ Nella schermata delle impostazioni, toccare Generali > Riavvio & Ripristino >

Ripristino dati di fabbrica.

- Questo metodo consente di ripristinare tutte le impostazioni del dispositivo
ed eliminare i dati. Prima di esequire il ripristino dei dati di fabbrica, effettuare
copie di backup di tutti i dati importanti salvati nel dispositivo.

- Seil dispositivo é associato a un account Google, effettuare laccesso allo
stesso account Google dopo il ripristino.

Appendice 195



L'apparecchio Bluetooth non € localizzato
Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo.

Assicurarsi che la funzionalita wireless Bluetooth sia attivata sul dispositivo a cui
vuoi connetterti.

Assicurarsi che il dispositivo e altri dispositivi Bluetooth siano nellarea massima del
Bluetooth (10 m)

Se i suggerimenti indicati non ti hanno aiutato a risolvere il problema, contatta un
centro di assistenza LG Electronics.

Quando colleghi il tuo apparecchio a un computer, non viene
stabilita una connessione.
Assicurarsi che il cavo USB che stai usando sia compatibile con il tuo apparecchio.

Assicurarsi che sul proprio computer siano installati e aggiornati i driver nella
versione corretta.

Un'applicazione scaricata sta causando molti errori.
L'applicazione presenta dei problemi.
Rimuovere e reinstallare applicazione.
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LG Dual Screen
(LM-V5S05N)



Descrizione di LG Dual Screen
E possibile collegare un LG Dual Screen (LM-V505N) a questo prodotto per

[utilizzo.

5

E possibile collegare LG Dual Screen (di seguito “prodotto”) a un dispositivo mobile
dedicato (di seguito “telefono mobile”) per utilizzare il prodotto.

A seconda delle prestazioni del telefono mobile dedicato, alcune funzioni di Dual
Screen potrebbero essere limitate. Il prodotto inoltre potrebbe non supportare altri
dispositivi mobili.

Questo prodotto non e resistente allacqua. Non esporre il dispositivo a liquidi o a
condizioni di umidita.

Se il dispositivo e bagnato, ['LDI collocato all'interno del dispositivo cambia colore. In
questo caso, il dispositivo non sara idoneo per i servizi di riparazione gratuiti forniti
nel contesto della garanzia limitata del dispositivo.

Il dispositivo ha un ricevitore dedicato (57~66 GHz) integrato per V50 ThinQ.

Indicazioni per un uso sicuro ed
efficiente

Leggere le semplici indicazioni riportate di sequito. Il mancato rispetto di tali indicazioni pud
rivelarsi pericoloso o illegale.

Nel caso si verifichino errori, il software integrato nel dispositivo crea un registro degli errori.
Questo strumento raccoglie solo i dati specifici dellerrore come l'intensita del segnale, la “cell ID
position” quando la chiamata viene interrotta e le applicazioni caricate. Il registro viene utilizzato
solo per determinare la causa dellerrore. Questi registri sono crittografati e possono essere
aperti solo nei centri di riparazione LG autorizzati, nel caso sia necessario restituire il dispositivo
per la riparazione.

Esposizione all'energia elettromagnetica a
radiofrequenze (RF)

Informazioni sullesposizione alle onde radio e sulla SAR (Specific Absorption Rate)

Questo dispositivo e stato progettato in conformita ai requisiti di sicurezza vigenti per
lesposizione alle onde radio. Tali requisiti si basano su precise indicazioni scientifiche che
definiscono, tra laltro, i margini di sicurezza necessari per salvaguardare tutte le persone,
indipendentemente dalleta e dalle condizioni di salute.
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Le indicazioni sullesposizione alle onde radio fanno riferimento a un'unita di misura detta
SAR, acronimo per Specific Absorption Rate. Le prove relative ai valori SAR sono state
condotte mediante metodi standardizzati con il dispositivo in stato di trasmissione al
massimo livello di alimentazione certificato, con qualsiasi banda di frequenza.

Anche se si possono riscontrare differenze tra i livelli SAR nei vari modelli di dispositivi
portatili LG, questi sono comunque stati progettati con unattenzione particolare alle
normative vigenti sullesposizione alle onde radio.

La commissione internazionale ICNIRP (International Commission on Non-lonizing
Radiation Protection) raccomanda un limite SAR pari a 2 W/kg in media per dieci grammi
di tessuto.

Questo dispositivo e conforme alle direttive sullesposizione alle radiofrequenze quando
utilizzato nella normale posizione d'uso vicino allorecchio o posizionato a una distanza di
almeno 5 mm dal corpo. Se una custodia, una clip per cintura o un altro sostegno vengono
posizionati a stretto contatto con il corpo, tali accessori non devono contenere metallo ed e
importante mantenere il dispositivo a una distanza di almeno 5 mm dal corpo. Il dispositivo
richiede una connessione ottimale alla rete per poter trasmettere file di dati o messaggi.

In alcuni casi, la trasmissione di file di dati o messaggi potrebbe essere ritardata fino a che
tale connessione diventi disponibile. Le istruzioni relative alla separazione del dispositivo dal
corpo devono essere rispettate fino alla fine della trasmissione.

Manutenzione e cura del prodotto

Utilizzare solo gli accessori forniti autorizzati da LG. Qualsiasi danno o guasto causato da
accessori di terze parti non é coperto dalla garanzia LG.

Alcuni contenuti e illustrazioni possono differire dal dispositivo senza preawviso.

Non smontare [apparecchio. Se & necessaria una riparazione, rivolgersi presso un centro
assistenza autorizzato LG.

La garanzia copre, a discrezione di LG, la sostituzione di parti o schede nuove o riconvertite,
funzionalmente equivalenti.

Tenere lontano da apparecchiature elettriche quali TV, radio e PC.
Tenere lontano da fonti di calore quali termosifoni o fornelli.

Non far cadere apparecchio.

Non sottoporre [apparecchio a scosse, urti o vibrazioni.

Spegnere il dispositivo nelle aree in cui & specificamente richiesto. Ad esempio, non
utilizzarlo allinterno di ospedali, in quanto potrebbe interferire con il funzionamento di
apparecchiature mediche sensibili.

Non afferrare il dispositivo con le mani bagnate mentre & in carica. Cio potrebbe provocare
scosse elettriche o danneggiare seriamente il prodotto.

Usare un panno asciutto per la pulizia esterna del cellulare (non usare solventi come
benzene, acquaragia o alcol).
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Non esporre [apparecchio a fumo o polvere.

Tenere lontano il dispositivo da carte di credito o supporti magnetici per evitarne la
smagnetizzazione.

Non toccare lo schermo con oggetti appuntiti per evitare di danneggiare il dispositivo.

Non esporre il dispositivo a umidita o a contatto con liquidi.

Usare gli accessori con attenzione e delicatezza. Non toccare [antenna se non strettamente
necessario.

In caso di vetro rotto o scheggiato, non utilizzare il dispositivo, non toccare il vetro, né
tentare di rimuoverlo o ripararlo. I danni al display in vetro dovuti ad abuso o utilizzo non
corretto non sono coperti dalla garanzia.

Il dispositivo & un dispositivo elettronico che genera calore durante il normale
funzionamento. Il contatto diretto e prolungato con la pelle e lassenza di unadeguata
ventilazione possono provocare disagi e piccole bruciature. Pertanto, € necessario
maneggiare con cura il dispositivo durante o subito dopo ['utilizzo.

Se il dispositivo si bagna, scollegarlo immediatamente e farlo asciugare completamente.
Non tentare di accelerare il processo di asciugatura con una fonte di calore esterna, ad
esempio un forno, un forno a microonde o un asciugacapelli

Il liquido presente nel dispositivo bagnato potrebbe modificare il colore delletichetta del
prodotto presente allinterno. | danni al dispositivo derivanti dallesposizione ai liquidi non
sono coperti da garanzia.

Un dispositivo mobile ha bisogno di una corretta circolazione dellaria per disperdere il
calore. Il contatto diretto con la pelle ed uninsufficiente circolazione daria sul dispositivo
potrebbe causare un surriscaldamento. Il dispositivo deve trovarsi ad almeno 1,0 cm dal
corpo dellutente.

Evitare che il prodotto venga a contatto con liquidi. Non utilizzare o caricare il prodotto se
& bagnato. Se il prodotto si bagna, lindicatore dei danni causati dai liquidi cambia colore.
Tenere presente che cio limitera la possibilita di ricevere eventuali servizi di riparazione
gratuiti previsti dalla garanzia.
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Funzionamento efficiente del dispositivo

Dispositivi elettronici

Tutti i dispositivi possono subire interferenze che influiscono sulle prestazioni.

Non utilizzare il dispositivo in prossimita di apparecchiature mediche senza autorizzazione.
Consultare un medico per determinare se ['uso del dispositivo possa interferire con il
funzionamento dell'apparecchio medico.

| produttori di pacemaker raccomandano una distanza minima di 15 cm da altri dispositivi e
pacemaker per evitare possibili interferenze con quest'ultimo.

Il dispositivo potrebbe produrre una luce forte o lampeggiante.
Il dispositivo potrebbe interferire con alcuni tipi di apparecchi acustici.
Il telefono potrebbe interferire con apparecchi televisivi, radio, computer, ecc.

Utilizzare il dispositivo a una temperatura compresa tra 0 °C e 40 °C, se possibile.
Lesposizione del dispositivo a temperature estremamente alte o basse pud causare danni,
malfunzionamenti o perfino esplosioni.

Sicurezza in automobile

Verificare le leggi e le normative che riguardano l'utilizzo dei dispositivi quando si guida.

Non utilizzare il dispositivo in modalita manuale durante la guida.

Prestare la massima attenzione alla guida.

+ Sele condizioni di guida lo richiedono, accostare e parcheggiare prima di telefonare o

rispondere a una chiamata.

Lenergia RF puo influire sul sistema elettronico del veicolo, ad esempio sullo stereo o sulle
apparecchiature di sicurezza.

Se il veicolo  dotato di airbag, non collocarvi accanto oggetti come apparecchi wireless
portatili o installati per evitare lesioni gravi causate dallerrato funzionamento dellair bag.

Durante lascolto della musica tramite il cellulare, assicurarsi che il volume sia
ragionevolmente basso da consentire il rilevamento dei rumori circostanti. Cio &
particolarmente importante in prossimita di strade.
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Parti in vetro

Alcune parti del dispositivo sono in vetro. Se il dispositivo cade su una superficie rigida o subisce

un forte impatto, il vetro pud rompersi. Se cio accade, non toccare o tentare di rimuovere il

vetro. Non utilizzare il dispositivo finché il vetro non viene sostituito da un centro di assistenza

autorizzato.

Aree a rischio di esplosione

Non utilizzare il dispositivo in aree dove sono in atto operazioni di detonazione. Rispettare le

restrizioni e osservare tutte le norme o i regolamenti al riguardo.

Atmosfere potenzialmente esplosive
+ Non utilizzare il dispositivo in prossimita di stazioni di servizio.
+ Non utilizzare [apparecchio in prossimita di combustibili o prodotti chimici.

+ Non trasportare né conservare sostanze esplosive, liquidi o gas infiammabili allinterno
dellautovettura in cuisi trovano il dispositivo o i relativi accessori.

A bordo di aeromobili
L'uso di dispositivi portatili pud causare delle interferenze al velivolo.
+ Spegnere il dispositivo prima di imbarcarsi su qualsiasi aeromobile.

« Utilizzarlo a terra (prima o dopo il decollo) solo con il permesso dellequipaggio.

Bambini

Conservare il dispositivo in un posto sicuro, lontano dalla portata dei bambini. Lapparecchio
& composto da parti smontabili di piccole dimensioni che, se ingerite, possono provocare
soffocamento.
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Componenti e accessori del prodotto

| sequenti articoli sono inclusi con il prodotto.

+ Prodotto + Guida introduttiva

A + Alcune delle componenti del prodotto sono in vetro temperato. Se silascia
cadere il prodotto su una superficie dura o lo si espone a un urto violento, il vetro
temperato potrebbe danneggiarsi. In questi casi, interrompere immediatamente
['uso del prodotto e contattare un Centro di assistenza clienti LG.

E « Laspetto e le specifiche del prodotto sono soggetti a modifica senza preawviso.
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Panoramica delle parti

Lato anteriore Lato posteriore
="\ 17 N
Indicatore LED &l w

] E}— Supporto cerniera

Tasto di quida del —E
pulsante del volume

Tasto di guida del —,
pulsante di -—-]

Assistente Google ] «— Supporto cerniera

N Y
Aperto
Spazio per foro ——~£—=))) R
ricevitore o Q\(
s—— Spazio per pulsante
di
Schermo del accensione/blocco
prodotto
Terminale di
— ) comunicazionera
mentazione

A « Non esporre il prodotto a forti urti quali cadute, pressioni o piegature. Esercitando
una pressione eccessiva sul prodotto, o si puo danneggiare.

E « |tastidi guida e gli spazi di questo prodotto non funzionano in modo indipendente.
Assicurarsi di collegare il prodotto a V50 ThinQ.

LG Dual Screen (LM-V505N) 204



Inserimento del telefono mobile nel
prodotto

1 Aprire completamente il prodotto.

@Ef—\\( D)
[E
[C

\— ')

7 Posizionare il telefono mobile con lo schermo rivolto verso lalto e inserire la
parte 1 del telefono nel prodotto, come illustrato nella figura. A questo punto,
assicurarsi che il terminale di comunicazione/alimentazione del prodotto sia
rivolto nella stessa direzione del terminale del telefono mobile.
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3 Premere la parte 2 del telefono mobile con la punta del dito fino a far scattare
in posizione il telefono.

o /
V@%@ o

U

A « Fare attenzione a non far cadere il prodotto o il telefono mobile durante
linserimento o la rimozione del telefono.

« Fare attenzione a non danneggiare il prodotto premendo il telefono con troppa
forza quando lo si inserisce o si rimuove dal prodotto.

+ Assicurarsi che il telefono sia completamente inserito nel prodotto prima dell'uso.
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Rimozione del del telefono mobile dal
prodotto

1 Aprire completamente il prodotto e reggerlo saldamente con entrambe le mani,
come illustrato nella figura.
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7 Premere la parte 1 del prodotto con un dito e allo stesso tempo premere sul
lato posteriore del telefono mobile con un altro dito per rimuovere il telefono
dal prodotto.

/—/?m“@/—*\—’é v

[

;@% g

A + Una parte del prodotto é realizzata in vetro temperato. Se i prodotto cade su una
superficie dura o viene sottoposto a forti urti, il vetro temperato si pud rompere
0 usurare, con conseguente danneggiamento del prodotto e possibili lesioni
personali.

In tal caso, interrompere immediatamente ['uso del prodotto e rivolgersi al centro
di assistenza clienti LG pili vicino per la riparazione.

« Non utilizzare o caricare il prodotto in presenza di umidita sui terminali di
comunicazione alimentazione del prodotto. Cio puo provocare incendi, scosse
elettriche, infortuni o il malfunzionamento del prodotto. In presenza di umidita,
interrompere immediatamente [utilizzo del prodotto e rimuovere completamente
['umidita.
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Utilizzo del prodotto

Durante le chiamate
Durante le chiamate, & possibile piegare il prodotto verso lesterno a 360° o verso
linterno a 0°.
+ Se si utilizza il prodotto piegandolo a 360°, assicurarsi che il lato anteriore e
quello posteriore del prodotto siano completamente a contatto. In questo caso,
lo schermo del prodotto si spegne automaticamente per risparmiare energia.

360 ° 0°

o 1] — coo

E - E possibile premere il tasto Assistente Google per ricevere una chiamata in arrivo
mentre il telefono mobile & inserito nel prodotto.
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Quando si utilizzano due schermi
Aprire il prodotto per affiancare i due schermi.

Schermo del ———7——

prodotto

Utilizzo dello schermo del prodotto

Quando si utilizzano contemporaneamente lo schermo del prodotto e quello del
telefono, si potrebbe notare una differenza di colore tra colore due schermi.

- Provare a regolare la temperatura del colore o Colore dello liveli RGB in (O >
Impostazioni > Display > Colore dello schermo sul telefono per ridurre al
minimo la differenza di colore.

+ Colore dello colori possono apparire diversi a seconda dell'angolo di visione,
quindi regolare Colore dello colori nello stato completamente aperto.

Utilizzo della schermata Home di Dual Screen

Descrizione della schermata Home di Dual Screen

La schermata Home di Dual Screen puo funzionare indipendentemente dallo
schermo del prodotto.

+ Fornisce icone di awio rapido e una barra a sfioramento Home.
- E possibile cambiare lo sfondo e impostare widget.

+ Nella schermata Home e anche possibile esequire diverse app dal cassetto delle
app e generare o eliminare cartelle.
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Descrizione del layout della schermata Home di Dual Screen

E possibile utilizzare varie funzioni mediante le icone presenti nella schermata
Home.

@ e Area di accesso rapido

E « Lo sfondo di Dual Screen puo differire dalla figura a seconda dei criteri del
produttore, delle impostazioni dell' utente, delle versioni del software, dei servizi
offerti dai fornitori di telecomunicazioni ecc.

+ Area di accesso rapido: e possibile fissare le app principali nella parte inferiore
dello schermo in modo che siano accessibili da qualsiasi area della schermata
Home.

Pulsanti a sfioramento anteriori: £ possibile trascinare verso lalto il lato

inferiore della schermata Home per visualizzare i pulsanti a sfioramento

anteriori nascosti.

- <] consente di tornare alla schermata precedente. Consente inoltre di
chiudere la tastiera o le finestre popup.

- (O :toccare per tornare alla schermata Home.

- [ toccare per visualizzare un elenco di app utilizate di recente o esequire

unapp dallelenco. Per eliminare tutte le app utilizzate di recente, toccare
CANCELLA TUTTO.
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Uso del pannello dual screen

E possibile aprire il pannello dual screen trascinando verso il basso il lato superiore
dello schermo.

- E possibile regolare la luminosita dello schermo nel pannello dual screen.

- Se i attiva la sincronizzazione selezionando Sincronizza, la luminosita del
dual screen si sincronizza con quella del prodotto connesso.

- E possibile toccare Capture+ per scattare una foto dello schermo del prodotto.

- E possibile salvare limmagine acquisita usando QuickMemo+ o salvarla nella
Galleria.

- E possibile spegnere lo schermo del prodotto toccando Dual Screen.
- Ildual screen e il telefono mobile connesso vengono disconnessi.
- E possibile toccare [ per accedere al menu delle impostazioni del dual screen.

& —— Impostazioni Dual Screen

Regolare la luminosita

Capture+ —g—e @

l | Dual Screen
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Modifiche della schermata Home di Dual Screen

Tenere premuta unarea vuota della schermata Home del dual screen ed esequire la
funzione desiderata.

Per aggiungere un widget alla schermata Home, toccare e tenere premuta
un‘area vuota della schermata Home, quindi selezionare Widget.

Per modificare sfondi, temi e icone, toccare e tenere premuta un‘area vuota della
schermata Home, quindi selezionare Sfondo.

Per cambiare la schermata predefinita, toccare e tenere premuta un'area vuota
della schermata Home, spostarsi sulla schermata desiderata, toccare 0, quindi
toccare nuovamente la schermata.

e S>chermata predefinita

Sfondo

Widget
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Visualizzazione dello sfondo del dual screen

Nella schermata Home & possibile visualizzare solo l'immagine di sfondo
nascondendo app e widget.

Allontanare due dita sulla schermata Home.

+ Per tornare alla schermata originale con la visualizzazione di app e widget,
awicinare le dita sulla schermata Home o toccare <]
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Impostazione dell'ambiente del dual screen

E possibile impostare I'ambiente del dual screen sul telefono mobile ad esso
connesso.

1 Selezionare O > Impostazioni > Display > Dual Screen.

5

« Per visualizzare la voce di menu per [impostazione dellambiente del dual screen, &
necessario connettere il telefono mobile al dual screen.

7 Selezionare e impostare le funzioni desiderate.
« Strumento Dual Screen: Quando si collega il telefono mobile al dual Screen,

sullo schermo appaiono gli strumenti del dual screen. I livello di luminosita e
sincronizzato con quello del prodotto.

- Usa Dual Screen: E possibile attivare e disattivare il dual screen, cambiare

schermate tra il telefono mobile e il dual screen e usare le app.

« Luminosita: Consente di regolare la luminosita dello schermo trascinando la

barra di controllo a sinistra o a destra.

- Come lo schermo principale: Consente di sincronizzare il livello di

luminosita con quello del telefono mobile collegato.

+ Sfondo: Consente di selezionare lo sfondo della schermata Home.

« lcona Cassetto delle app: Consente di visualizzare o nascondere il cassetto

delle app del prodotto.

+ App My Pick: Ogni volta che si accende il dual screen, le app dual screen

5

preimpostate vengono esequite automaticamente.

« Lelenco delle app che vengono visualizzate sullo schermo puo variare a seconda
delle app installate.
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Utilizzo di Capture+ di Dual Screen

Acquisizione delle schermate con Capture+ di Dual Screen
Trascinare verso il basso la barra di stato della schermata di cui si desidera scattare
una foto, quindi toccare [, Capture+.

+ Per salvare immagine acquisita, toccare 9 e salvarla nella posizione desiderata.

- E possibile salvare limmagine acquisita usando QuickMemo+ o salvarla nella
Galleria.

- Per salvare i dati sempre nella stessa posizione, selezionare Usa come app
predefinita e selezionare lapp desiderata.

Scrittura di note sullo schermo con Capture+ di Dual Screen
1 Trascinare verso il basso la barra di stato della schermata desiderata, quindi
toccare (&, Capture+.
+ Llimmagine acquisita appare come desktop promemoria, e lo strumento
promemoria appare nella parte superiore dello schermo.
2 Aggiungere liberamente note nellimmagine acquisita.
+ Toccare /Z per aggiungere una nota sullo schermo scrivendo a mano.
« Toccare T per inserire testo nella parte inferiore dello schermo.

3 Per salvare il promemoria, toccare 9 e salvarlo nella posizione desiderata.

- E possibile salvare il promemoria usando QuickMemo+ o salvarlo nella
Galleria.

- Se siimmette solo testo, viene salvato automaticamente da Qmemo-+.

+ Per salvare i dati sempre nella stessa posizione, selezionare Usa come app
predefinita e selezionare [app desiderata.
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Strumento Dual Screen
Quando si connette il telefono mobile al dual screen e si accende il dual screen, sullo
schermo del telefono mobile appaiono gli Strumento Dual Screen &),

Quando si accende il dual screen, appare lo Strumento Dual Screen, come
illustrato sotto.

Toccare leggermente per visualizzare o nascondere lo strumento Dual Screen.

E possibile passare tra il dual screen e il telefono mobile.

E possibile inviare la schermata dal telefono mobile al dual screen.

E possibile riportare la schermata dal dual screen al telefono mobile.

Se si utilizza solo il dual screen, & possibile ridurre il livello di luminosita dello
schermo del telefono mobile (schermo principale) per risparmiare la batteria.
Per non utilizzare questa funzione, scorrere sullo schermo principale.

Se si desidera che il telefono mobile e il dual screen mostrino la stessa
schermata, & possibile utilizzare la Vista ampia.

@6 ® 660600

E possibile spegnere il dual screen scollegandolo dal telefono mobile.

«— Strumento Dual Screen

+—— Passare da uno
| schermo allaltro

+— Visualizzare lo schermo
principale su dual screen

i e— Visualizzare il dual screen
sullo schermo principale

+—— Mettere in sospensione lo
schermo principale
e — Vista ampia

«—— Spegnere il dual screen
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Spegnendo il telefono mobile, si spegne anche il dual screen. Tuttavia, se si spegne
il dual screen, il telefono mobile rimane acceso.

i

+ Questa funzione non ¢ disponibile nella schermata di blocco e si attiva sbloccando
lo schermo.

« Licona di Estendi schermo appare tra gli strumenti del dual screen solo quando e
in esecuzione lapp Chrome.

Uso di Estendi schermo

Per comodita & possibile estendere 'uso di unapp allo schermo principale e allo
schermo del dual screen.

E + Questa funzione e disponibile anche in app partner in aggiunta alle app
Fotocamera e Galleria.

« Linterfaccia utente puo variare a seconda dellapp utilizzata.

Uso di Estendi schermo nell'app Fotocamera

E possibile riprendere una fotografia o un video sul prodotto o sul telefono mobile e
visualizzare il risultato sul dual screen dallaltro lato.

7 Aprire la Fotocamera del prodotto o del telefono mobile e riprendere una
fotografia o un video.

2 Dopo aver ripreso una fotografia o un video, selezionare licona Anteprima.

« E possibile visualizzare la fotografia o il video ripresi sul dual screen dall‘altro
lato.
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Icona Anteprima

5 « Sesi visualizza una fotografia o un video premendo l'icona di anteprima una volta,
non e pit necessario premere l'icona per visualizzare le fotografie o i video che
vengono ripresi nella doppia visualizzazione.

Questa funzione non rimane attiva se si chiude e si riapre 'app Fotocamera.
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Uso di Estendi schermo nell'app Galleria

Toccare 4[] mentre & aperta la cartella dell'app Galleria sul prodotto o sul telefono
mobile per una visualizzazione ingrandita della foto o del video sullo schermo
opposto.

1 Aprire lapp Galleria sul prodotto o sul telefono mobile.

7 Selezionare la cartella dellalbum e quindi toccare [}

« Lafoto ol video vengono visualizzati in una vista ingrandita sullo schermo
opposto.

+ Toccare BJ(J per uscire da questa funzione.

Icona di Estensione
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Uso dell'app My Pick

Ogni volta che si accende il dual screen, le app dual screen preimpostate vengono
eseguite automaticamente.

T Selezionare O > Impostazioni > Display > Dual Screen > App My Pick.

2 Selezionare le app da eseguire automaticamente ogni volta che si accende il
dual screen.

+ Alcune app non possono essere eseqguite come app dual screen.

« Lelenco delle app che vengono visualizzate sullo schermo puo variare a seconda
delle app installate.

Utilizzo di Vista ampia di Dual Screen

Durante ['uso dellapp Chrome o Naver, & possibile utilizzare Vista ampia per fare in
modo che il telefono mobile e il dual screen mostrino la stessa schermata.

7 Coniltelefono mobile connesso al dual screen, aprire lapp Chrome.
2 Tragli strumenti del dual screen, selezionare Estendi schermo (=}
3 E possibile estendere lo schermo orizzontalmente o verticalmente.

E «+ Quando si utilizza Vista ampia, & possibile anche estendere il campo di immissione
della tastiera per adattarlo alla modalita orizzontale o verticale.
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Passaggio tra le schermate delle app sul dual screen

E possibile scorrere sullo schermo con tre dita per spostare la schermata di un'app

dallo schermo del prodotto allo schermo del telefono mobile.

+ Scorrere sulla schermata dellapp con tre dita verso sinistra o verso destra per
spostarla liberamente dallo schermo principale al dual screen e viceversa.

Scorrere sulla schermata dellapp con tre dita Sposta la schermata di un‘app sullo schermo
principale

Scorrere sulla schermata dellapp con tre dita Sposta la schermata di un'app sul dual screen
E « Per usare questa funzione, le tre dita devono toccare lo schermo
contemporaneamente.
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Utilizzo della doppia tastiera sul dual screen

In modalita orizzontale, & possibile toccare il pulsante della doppia tastiera & per
inviare la tastiera allaltro schermo in basso.

E possibile espandere la tastiera in alto e in basso per utilizzare lo schermo
superiore come schermata di unapp e lo schermo inferiore come schermo tastiera.

1 Portare il dual screen in modalita orizzontale nella schermata di immissione da
tastiera.
7 Toccare £ nella finestra di immissione da tastiera del dual screen.

- E possibile controllare quanto immesso da tastiera sul dual screen e usare la
finestra di immissione del prodotto.

« Toccare B8 nello stato espanso per riportare la tastiera inferiore nella
posizione originale.

Doppia tastiera

E - Per spostare la schermata dellapp verso lalto o verso il basso, toccare lo schermo
con tre dita contemporaneamente e spostarla verso lalto o verso il basso. Per
ulteriori dettagli, consultare la sezione Passaggio tra le schermate delle app sul
dual screen.
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Uso di Tripla anteprima

E possibile visualizzare simultaneamente tre anteprime della fotocamera posteriore
sul dual screen.

1 Toccare O > Fotocamera.

2 Toccare [§(J nella parte superiore della schermata della fotocamera.
- LaTripla anteprima appare sul dual screen.

E « Selezionando [immagine desiderata dalla schermata della Tripla anteprima, &
possibile visualizzarla nello schermo principale.
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Uso di Mirror Mode

Quando si scattano foto con la fotocamera, & possibile visualizzare le foto in
anteprima sul dual screen.

1 Toccare O > Fotocamera.

2 Toccare [§(J nella parte superiore della schermata della fotocamera.
+ La Mirror Mode appare sul dual screen.

Mirror Mode

E - E possibile anche scattare foto o riprendere video direttamente dal dual screen

Usare il dual screen per regolare l'angolo per varie situazioni, come illustrato sotto.
+ Scatto di foto con un angolo alto: Da utilizzare per scattare una foto di molte
persone a un concerto o altro evento oppure per scattare foto di spazi ampi.

+ Scatto di foto con un angolo basso: Da utilizzare per scattare immagini di
bambini allaltezza dei loro occhi o per scattare foto di edifici alti ecc.

A

Scatto con angolo basso Scatto con angolo alto
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Utilizzo della modalita Riflettore sul dual screen
Quando si scatta un selfie, & possibile usare il dual screen come riflettore.
1 Toccare O> Fotocamera e scattare una foto con la fotocamera anteriore.

2 Toccare due volte il pulsante di flash nellangolo superiore destro.
+ Il doppio schermo illumina fortemente il soggetto, fungendo da riflettore.

oy —— |CONa della modalita
riflettore

Barra di regolazione —s
del bilanciamento del
bianco

E + Spostare la barra di regolazione del bilanciamento del bianco per regolare il colore
del riflettore.
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Utilizzo di Instant Capture sul dual screen
Quando il telefono mobile & collegato al prodotto, la funzione Instant Capture 37, &
disponibile nella tastiera LG.

E possibile usare la tastiera nello schermo principale, scattare una foto dello
schermo del dual screen e inserirla direttamente nella finestra di immissione da

tastiera.
Toccare [ sulla schermata di immissione della tastiera LG.
+ Lo schermo del dual screen viene acquisito e allegato automaticamente alla
schermata di immissione da tastiera.

— Instant Capture

Schermata acquisita

E + Non ¢ possibile utilizzare contemporaneamente entrambi gli schermi come
schermata di immissione da tastiera.
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LG Game Pad

E possibile usare comandi virtuali sullo schermo del prodotto mentre si usano giochi
nel telefono mobile. Durante il gioco, allontanare lo schermo principale dal dual
screen, in modo che i comandi non blocchino lo schermo di gioco.

1 Toccare > Launcher Del Gioco e selezionare LG Game Pad @

i LG Game Pad

+ LG Game Pad appare sullo schermo del prodotto.

2 Toccare @l e scorrere a sinistra e a destra per selezionare lo stile di LG Game
Pad preferito.
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E possibile giocare reggendo il prodotto come illustrato sotto.

+ LG Game Pad ¢ disponibile solo per i giochi che supportano i gamepad fisici

+ A seconda del gioco, alcune app o pulsanti potrebbero non supportare the LG
Game Pad.
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Marchi di fabbrica

+ Copyright ©2020 LG Electronics, Inc. Tutti i diritti riservati. LG e il logo LG sono

marchi registrati del Gruppo LG e delle sue entita correlate.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,

Chrome, Google Photos, Google Play Protect, Google Calendar, Google Docs,

Google Drive, Google Sheets e altri marchi e logo correlati sono marchi di Google

LLC.

Tutti gli altri marchi sono di proprieta dei rispettivi titolari.

DICHIARAZIONE DI CONFORMITA

Con il presente documento, LG Electronics dichiara che il prodotto

LM-V505N e conforme ai requisiti essenziali e alle altre disposizioni della Direttiva
2014/53/EU.

Una copia della Dichiarazione di conformita e disponibile allindirizzo

http7//wwwi.lg.com/global/declaration

Contattare 'ufficio relativo alla
conformita del prodotto

LG Electronics European Shared Service Center BV.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands
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Ulteriori informazioni

Precauzioni per la manipolazione del prodotto

Questo prodotto non puod essere utilizzato da solo.

Non utilizzare o caricare il prodotto in presenza di umidita sui terminali di

comunicazione alimentazione del prodotto.

- Cio puo provocare incendi, scosse elettriche, infortuni o il malfunzionamento
del dispositivo.

- In caso di umidita, interrompere immediatamente ['utilizzo e rimuovere
completamente 'umidita.

+ Illiquido presente nel telefono bagnato potrebbe modificare il colore

delletichetta del prodotto situata allinterno del telefono. | danni al dispositivo
derivanti dallesposizione ai liquidi non sono coperti da garanzia.

Parti in vetro temperato

Le parti in vetro temperato di questo dispositivo non sono permanenti e possono
usurarsi col passare del tempo.

Se si lascia cadere il dispositivo su una superficie dura o lo si espone a un urto
violento, il vetro temperato potrebbe danneggiarsi.

In questi casi, interrompere immediatamente ['uso del dispositivo e contattare
un Centro di assistenza clienti LG.

+ Sul mercato sono disponibili apposite custodie per proteggere il dispositivo da

eventuali danni.

Tenere presente che tali custodie protettive non sono coperte dal servizio di
garanzia fornito da LG Electronics e non ne viene garantita la sicurezza.

Utilizzo della batteria

Questo prodotto non utilizza una propria batteria.

Quando e collegato a un telefono mobile, il prodotto utilizza la batteria del
telefono mobile.
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Smaltimento delle apparecchiature obsolete

1.Tutte le apparecchiature elettriche ed elettroniche, contrassegnate da

questo simbolo ("bidone della spazzatura barrato da una croce”), devono
essere raccolte e smaltite separatamente rispetto agli altri rifiuti urbani

- misti mediante impianti di raccolta specifici installati da enti pubblici o dalle
autorita locali. Si ricorda che gli utenti finali domestici possono consegnare
gratuitamente le apparecchiature elettriche ed elettroniche a fine vita
presso il punto vendita allatto dellacquisto di una nuova apparecchiatura
equivalente. Gli utenti finali domestici possono inoltre consegnare
gratuitamente apparecchiature elettriche ed elettroniche di piccolissime
dimensioni (non eccedenti i 25 cm) a fine vita direttamente presso un punto
vendita a cio abilitato, senza obbligo di acquistare una apparecchiatura nuova
di tipo equivalente. Si prega di informarsi previamente presso il punto vendita
prescelto circa tale ultima modalita di conferimento dellapparecchiatura a
fine vita.

2.1 corretto smaltimento dell'unita obsoleta contribuisce a prevenire possibili
conseguenze negative sulla salute degli individui e sullambiente. Una
gestione responsabile del fine vita delle apparecchiature elettriche ed
elettroniche da parte degli utenti contribuisce al riutilizzo, al riciclaggio ed al
recupero sostenibile dei prodotti obsoleti e dei relativi materiali.

3. Per informazioni pit dettagliate sullo smaltimento delle apparecchiature
obsolete, contattare ['ufficio del comune di residenza, il servizio di
smaltimento rifiuti o il punto vendita in cui e stato acquistato il prodotto.
(wwwilg.com/global/recycling)

LG Dual Screen (LM-V505N) 232



EAAHNIKA
MAnpo@opieg OXETIKA UE AUTO TO

gyxepidio xpnong

Yag euxaploToUpE Tou eMAEEaTE AUTO To TTPOIOV LG. Nal Tnv ao@ali Kat owoTn
XPrion TG CUOKEUNG, TAPAKAAEIOTE va SIaBACETE MPOTEKTIKA AUTO TO EYXELPISI0
TIPWV XPNOIHOTOIOETE TN CUCKEUH yla TIPWTN QOPA.

- Na xpnotpomoleite mavtote yvriola agecoudp LG. Ta mapexopeva e§apTripata
TipoopiCoval AmOKAEIOTIKA YIal XPrioN HE AUTHY TNV GUOKEUN Kal EVOEXETaL va
unv eivat oupBatd pe AMNEG CUOKEUEC,

« Otmeplypagéc Bacifovtal oTig MpoemAeYUEVEG PUBIOELS TNG OUOKEUNG.

OL TIPOEYKATECTNHEVES EPAPLIOYEG 0T GUOKEUK UTIOKEIVTAL OE EVNUEPWOELG,
Kal 1 TTapoxT| UMOOTAPIENG VIO AUTEC TIC EQAPHOYES EVOEKETAL VA SLOKOTTE
Xwpi¢ mpoeidomoinon. Ev éxeTe EpWTHOELC OXETIKA LIE L0l EQAPLOYI TIOU
TIAPEXETAL LIE Tr) OUOKEUN), EMKOWVWVAOTE PE éva KEvTpo emokeuwv TG LG.
TXETIKA HE EQAPHOYE TIOU EXOUV EYKATAOTABEL A6 TOV XPHOTN, UMOPEITE Val
ETMIKOWWVIOETE PIE TOV APHOSIO TIAPOXO UTINPECIWV.

+ H tpomomoinon Tou A&lToupykoU GUGTAKATOC TNG CUOKEUNG 1 N EYKATAOTACN
MOyIopIKOU amo avemionpeg myég umopei va mpokahéoel BAABN oTn ouokeur
Kat va 0dnynoel o€ Kataotpo®n 1 anwAela Sedopévwvy. Tétolou gidoug
evépyelec anmoteholy mapaBiaon g adelag xpriong e LG Kat €xouv w¢
QmOTENEGHA TNV AKUPWON TG EYYUNONG 00G.

Kdmolo meplexOpeVo Kal EIKOVEC UMopE( va Sla@épouv oe axéon He TN
GUCKEUN 00C, avAAoya LE TNV TIEPLOKT, TOV TIAPOXO UTINPESIWY, TV €KSoon
TOU AOYIGUIKOU 1 TNV €KS00N TOU AEITOUPYIKOU CUOTAKATOC, KAl UMOpEi va
aMdG€ouv xwpic mpoeidomoinon.

+ To MoyIOUIKO, OL XOl, Ol TATETOAPIEC, Ol EIKOVES Kat BAAA Uéoa TTou TIapExovTal
padi pe Tn GUOKELN 0ag ouVOSEVOVTAL OO AGEL VIO TIEPIOPICUEVN XPriON.
Tuxdv e€aywyn Kat Xprion autwv Twv VMKWV Yia UTopIKoUG r AAOUG OKOTIOUG
evOEXETAL VO OLVIOTA TTAPABIcN TWV VOUWY TERT TIVEUMATIKWV SIKAUWUATWV.
Q¢ TENKOG XPAROTNG, EXETE TNV TP EUBUVN yia TUXOV TTAPAVON XPHoN TwV
HEOWV QUTWV.

EvSéyetat va umdpyouv mpAoBeTeS XpeWTELS yia TN peaieg SeSopévwy, OTwG
Yia TIC U peoieg avTaAayng INVURATWY, T @opTwon i T Mjwn Sedopévwy,
TOV QUTOHATO CUYXPOVIOUO Kal TIG UTinpeaieg TomoBeaiag. MNa va unv
€MBOPUVEDTE Ue MPOOBETEC XPEWTELC, EMAECTE éva TpOypappa dedopévwv
TI0U VOl KAAUTITEL TIG AVAYKEG GG, ETTIKOIVWVIOTE L TOV IAPOXO UTTNPECIWV 0O
Y10 TTEPIOOOTEPEC NETTTOUEPELEG,



- To mapdv eyxelpidio xpriong éxet ouvtayBei oTig BaoikéC Y\wWooeC yia KdBe
Xwpa. Avaloya pE T YAWooa TTou XPnOLHOTIOLEITAL, TO TIEPLEXOUEVO EVEEKETAL
va Slagoporoleital.

ZUUBOVAEUTIKEG AVAKOIVWOELC

MPOEIAONMOIHZH: KaTtaoTACEIG TIOU PITOPE( VO TIPOKANEGOLV TPAUUATIONO
TOU XPAOTN KAl TPITWV.

A MPOXOXH: KATAOTAGEIG TOU UMOPE( VA TTPOKAAETOUV ENAPPU TPAUUATIOHO 1)
{nWa ot CUOKELN.

5 THMEIQZH: avakovwoelG 1) TPOOOETEC TANPOPOPIEC.

MAnpo@opieg OXETIKA PE AUTO TO EYXELPISIO XPrIONG
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0d6nyisg yia ac@aln Kat amoteAEGUATIKA
Xpnon

AlaBaoTe TIg mapakdtw amég odnyieg. H un tpnon autwv Twv odnyiwv pmopei va
amnofei emkivéuvn 1 mapdvopn.

Y& MePIMTWon oQAAUATOE, N GUCKELN 0ag SlaBETel éva epyaleio Aoyiopikol Tou Ba
SnuioupyroeL éva apyxeio kataypagrg o@aiuatog. To epyaleio cuMéyel Sedopéva
€151KA Y10 TO CUYKEKPIUEVO OPAAua OTIwG Ta £€AG: LoxUG onpatog, cell ID position

0€ TIEPIMTWON AmPACHEVNG AMOPPIYNG KARONG KAl EQAPHOYEG TTOU UTIAPXOULV 0T
GUOKeUN. To apXEio KATaYPAPrG XPNOIUOTIOLETAL AMTOKAEIOTIKA YI0l TOV TPOGSIOPIoHO
NG AITiag Tou OQAAUATOG. AUTA Ta OPXEQ KATAYPAPG Eival KpUTTToypag@nuéva Kat n
TIPOORacn o€ auTd gival EPIKTH POvVo amd e€0uCIoS0TNHEVA KEVTPA EMIOKEVAG TNG LG,
O€ TIEPITTTWON TIOU XPELOOTEL Va EMOTPEWETE TN OUOKEUR OAG VIO ETIIOKEVN.

'EkBeon o¢ evépyela padlocuyvotritwy

MAnPoPopieC OXETIKA HE TNV €KBETN O€ PASIOKUHATA Kall TO GUVTENEDTH EIOIKIG
amoppd@nong (XEA).

AuTH N GUOKEUN €XEl OXESIAOTEL WOTE VOl GUMUOPPWVETAL LE TIG LOXUOUOEG AMAITHOELS
aopaleiag yia tnv ékBeon og padiokupata. Ot amartioelg autég BaciCovtal og
EMOTNUOVIKEG 0dnyieg Tou ephapBavouv mepBwpLa aopaleiag yia Ty TPooTasia
OAWV TWV aTOPWY, ave€apTnTa amod TNV NAKia fj TNV KATtdoTaon TG Uyeiag Toug.

+ XTI 08nYieg OXETIKA pE TNV éKBEDN OE PASIOKUHATA XPNOIMOTIOLETA Miat HovASa
UETpNOoNG N omoia gival yvwoTh w¢ CUVTENEDTAG EISIKNG amoppoenang i XEA. Ot
é\eyyol yla 1o XEA Sie§dyovtal pe Tumomoinpéveg HeBdS0UC, e Tn GUOKEUN va
EKTTENTTEL OTO PEYIOTO TIIOTOMOINMEVO ETMESO 10XVOG O ONEG TIC {WVES CUXVOTATWY
TIOU XPNOIUOTIOLE.

« Av Kal umopei va umapyouv Sla@opég petady Twv emmédwv Tou LEA yia
S1apopa povTéNa BUOKEUWV TNG LG, OAa Ta HovTéAa €xouv oXedIOTEl WOTE Va
QVTATIOKPIVOVTaL OTIG OXETIKEG 0dNYiEG yia TV ékBeon o€ padlokupata.

« To 6pto Tou ZEA mou ouviotatat amd t Alebvr) Emtporm Mpootaciag améd  Mn
loviCouoa AktivoBoAia (ICNIRP), givat 2 W/kg pe Bdon Tov UMoAoYIoHS TG HENG
TG ya 10 ypappdpla owpatikol 10Tou.

+ HuynAotepn T tou ZEA yia autd To povTého, Omwe éxel eheyxDei yia xprion oto
auri, eivat 0,243 W/kg (10 g) kat yia xprion oto owpa givat 1,497 W/kg (10 g).



« AutA n cuokeur MAnPEOI TIG MPOUTTOBETELS Yia TN ékBEaN OE PadlooUXVOTNTEG
€iTe TAV XpNolHomolETal TNV Kavovikr Béon xpriong Sima ato auri gite dtav
Bpioketal og amdoTacn TouAdxioTov 5 mm amnd to owpa. Otav xpnotpomnoleital
BrKn petagopdg, KA {wvng fi Brkn yia xprion oto owua, Sev mpémel va
mepthapBavel pETAMIKA oTolxEla Kal TTPETEL VO GUYKPATEL TO TIPOIOV G€ amdoTaon
TOUAdXI0TOV 5 mm amd To owpa oac. Na tn petadoon apyeiwv Sedopévwy iy
UNVUPATWY, N GUOKELR amaitei Tnv Umapén moloTikA¢ oUvEeonc oTo Siktuo. Xe
OPIOHEVEG TIEPITTTWOELG, N METAS00N apyeiwv SeSopEVWY 1} UNVUPATWY UMOpPEi
va kaBuoTteproel éwg 6Tou givat Slabéoiun pia Tétota ouvdeon. Beaiwbeite ott
TNPOUVTAL Ol IAPATTAVW 08NYIEG OXETIKA HIE TNV AMAOTACK AT TO CWHA UEXPL VA
olokAnpwbei n petadoon.

MAnpo@opieg oxeTIKA pe TNV €KOEDN GE PASIOCUXVOTNTES
ané tnv Opoomnovdiakn Emrpornn Emkowvwviwy twv HIMA

Tov AlyouoTo Tou 1996, n Opoomovdiakr Emtporr Emkowwviwv (FCC) Twv Hvwpévwv
MoNTewwv, pe tn Spdon tng Report and Order FCC 96-326, ui0B£tnoe éva evnuepwpévo
TPATUTIO AOPANELQG YIa TNV €KBEON TOU AVBPWTTOU OTNV NAEKTPOUAYVNTIKY EVEPYEL
padioouyvotitwy (RF) mou ekméumeTal amd MOUMOUE ot 0TToiot TEAOUV UTIO ToV
puBpIOTIKG éNeyxo TnG FCC. Ot odnyieg auTEC €ival CUVETEIG HIE TOUG KAVOVIOHOUG
acpaleiag mou eixav 1ebei 0To MapeN@OV amd Ta Siebvny Kal apepikavika mpotuma. H
oxediaon auTrg TG CUOKEURG CUMHOPPWVETAL UE TIG 0dnyieg Tng FCC kat pe autd ta
S1ebvry mpdruma.

AnAwon Part 15.19

AUTH 1 CUOKEUH} CUHHOPPWVETAL HE TO ApBpo 15 Twv Kavoviopwv T FCC. H xprion
UMOKEITal 0TI akoAouBe¢ 500 mpoUmoBEéaelc:

(1) AutA n cuokeun Sev pmopei va mpokaléoel emPBAaPeic mapepBoAEC kat

(2) auTr n ouokeun Mpémel va amodéxeTal omoladnmoTe MAPEUPOAN,
oupnepAapBavopévwy mapeUBOAWV TIOU HITOPET va IPOKAAEGOUY avemBUpnTn
Aertoupyia.

AnAwon Part 15.21

Tuxov ahayég iy TPomoTToloEI TToU GV EYKPIVOVTAL PNTA amd TOV KATAOKELAOTH
MIOPOUV VA AKUPWOOUV TO SIKaiwua xpriong Tou e§omAiopoU.

Od8nyieg yla ac@alr Kat amoTEAECHATIKN XPrion 7



Xpron oto cwpa

AUTH 1 OUOKEUT €XEL ENeYXDE( Y10 TUTIIKN XPriON OTO OWHA, HE TO TTOW MEPOC TNG

og anéotaon 0,39 vtowv (1 cm) amoé To oW Tou XPHOTN. [a CUPHOPPWON PE TIG
anaitrioelg g FCC yia tnv ékBeon o€ padioouyvdtnteg, mpémel va Statnpeitat eNdyiotn
anéotaon 0,39 vtowv (1 cm) avapesa To WA TOU XPROTN KAl TO THow PéEPOG TNG
OUOKEUNG.

Evééxetat va pnv pmopolv va xpnaotpomotnBouv KA otipténg oe {wvn, Brikeg kat
napepepn afeaoudp mou Slabétouv peTarika e§aptripata. Ta afecoudp yia xprion
0TO OWHa 1o Sev umopouv va Slatnpricouv amdotaocn 0,39 vtowv (1 cm) petady

TOU OWHATOG TOU XPHOTN KAl TOU TToW MEPOUG TNG CUOKEUNG Kall Ta ortoia Gev €xouv
GOKIHOOTEL yia TUTTIKEG XPROEIG 0TO OWHA, EVOEXETAL va Uy TANpolv Ta 6pia T FCC yia
Vv €kBeon o€ PadlooUXVOTNTEC Kall TIPETEL VOl AMTOPEVYOVTAL.

AfAwon Part 15.105

AUTOG 0 £EOMANIGHOG ExEL ENEYXBEL KOl CUUOPPWVETAL LIE TA OPLA VIO TIG PNPLAKES
OUOKEVEG Katnyopiag B, cuppwva pe To Part 15 twv kavoviouwv FCC. Autd ta 6pta
eival oxedlaopéva yia va Tapéxou EMAPKI TPOOTAsia évavTt eMPAABWY mMapepBoAwY
o€ OIKIaKr eykatdotaon. O €0mNOHOC QUTOG TTAPAYEL XPNOILOTOLE KAl MMTOPE( val
EKTTEUDEL EVEPYELD PASIOOUXVOTHTWY Kal, av Sev eyKaTaoTabe( Kat xpnotpomoindei
oUpPWvVa pe TIG 0dnyieg, umopei va mipokahéoel empPAapeic mapepBolég oTig
padioemkowwvieg. QaTo00, Sev uTApxEL £yyunon 6Tt Sev Ba undp&ouv mapepPoAEG
O€ M0 GUYKEKPIPEVN EYKATAOTAON. AV auTOG 0 EE0MAIOHOG TIPOKaNEDEL emPAapEic
TIAPEUPONEG OTNV TNAEOTTIKA AN, YEYOVOG TTOU UMOpPEi vat SlamoTwOei pe Thv
amevepyomoinon kai evepyomoinan Tou eE0mAIGHOU, 0 XpoTng evBappuvetal va
Sokipaoel va SlopBuwoel Tic mapepBolég Ue éva 1y eploodtepa amd Ta e§RG PETPa:

AMGETE TV TPOsaVATONOHO 1y TN Béon TG Kepaiag ARYnG.

Auénote v amdotacn petal eEomiopou Kat SkTn.

« ZuvdéaTe Tov e§0MAIOUO o€ TIPIla TTOU AVIAKEL 08 AANO KUKAWHA QO QUTO WE TO
ormoio eival ouvSeSepEvog 0 SEKTNC.

+ YUMPOUNEUTEITE TO METAMWANTH 1} évav EUTTEIPO TEXVIKO pado@uvwv/TnAedpaonc
yia Boribela.

Opovtiba kal GUVTHPNON TOU TIPOIOGVTOC
+ Na xpnotporoleite pdvo ta e€aptrpata mou mepthapBdvovtat 0Tn CUCKELATia Kal
eival e§ovatodotnuéva amod v LG. H LG Sev mapéyel eyyunoelg yia Tuxov BAapes
anotuyieg Aettoupyiag mou opeilovtal o€ e£apTAHATA GAWY KATAOKEUATTRV.

+ Oplopéva meplexdpeva Kat EIKOVEG eVOEXETAL VA S10QEPOLY armd T OUOKEUN 0ag
Xwpic mpogidomoinon.

Od8nyieg yla ac@alr Kat amoTEAECHATIKN XPrion 8



+ Mnv amoouvappo)oyeite Tn povada. Otav amattolvTal EPYaieq EMOKEUNG,
TAPASWOTE TNV OF ECEIBIKEVHEVO TEXVIKO.

« Katatn Slakprtikn euxépela tng LG, ol emMOKeVEG Tou KAAUTITOVTAL AT ThV £yyUnon
evdéxeTal va mepAapBavouv Ty TomoBETNon avTaMAKTIKWV LEPWV f TIIVAKWV (€iTE
KOVOUPIWV EITE EMOKEVAOHUEVWV), LIE TNV TTIPOUTTOOECN 0TI N AEITOUPYIKOTNTA TOUG
€lval 10050vaun e TN AEITOUPYIKATNTA TWV PEPWV TIOU AVTIKATAOTAONKAV.

« Kpatdre T ouoKeun HOKPLd amd NAEKTPIKEG CUOKEVES OTIWG TNAEOPATELC,
PadIo@WVa Kal UTTONOYIOTEG,

« H ouokeur| mpémet va QUAACOETAL LOKPLG OO TNyEG BepUOTNTAG, OTIWG KANOPIPEP 1)
NAEKTPIKEC KOUTiveC.

« Mpoo€€Te va pnv méoel.

+H ouokeun Sev mpémel va UTTOKEITaL OE PnXavIKéG SOVATELG I} Kpadaopoug.

+ ATevepyomoIEiTE T OUOKEUN OTIG TIEPIOXEG OTTOU AMAYOPEVETAL N XPRON TG
OUUPWVA HE EIBIKOUC KAVOVIOHOUG. Ma TapdSelypa, LNV XPNOILOTIOLEITE TN GUOKEUN
0€ VOOOKOUE(a, kaBuwg n xprion TG pmopei va ennpedoet uaiobnTo 1aTpiko
€§OMAIONO.

+ Mnv mdvete T ouokeun pe Bpeyuéva xépla, otav goptilel. Mmopei va mabete
nAektpomAnéia kat va mpokAnBei coPapri BAABN otn cuokeun.

+ Mnv @oprilete T0 TNAEPWVO KOVTA O EVPAEKTA UAIKG, KaBWG evOéxeTal va
BepuavOei kat va dnuovpynBei Kivuvog mupkayldag.

+ Xpnowormotjote éva oTeyvo mavi yia va KaBapioeTe To mePIBANUa TG OUOKEUNG
(Hnv xpnotpomoteite SlaNuTeg OMwG Bev{ivn, SIGAUTIKS 1) OVOTVEUHA).

+ Mn @oprtilete T ouokeun 6Tav BpioKeTal MAVW 08 HOAAKA LPAcUATa.

+H ouokeun mpémet va gopTiletal og KaAd agpt{Opevo XWwpo.

+ Mnv a@rVeTe Tn GUOKEUN OE XWPOUG LE UTIEPBONKS Kamvo 1 okovn.

+ Mnv tomobeteite T cUoKeLN SiMAa OE MMOTWTIKES KAPTEG N EIOITHPIA MECWV
HETaQOPAg. Mmopei va emnpedoel TIC TANPOPOPIEC TTOU TIEPIEXOVTAL OTIG HAYVNTIKEG
TAWVIEC.

+ Mnv xtumdte tnv 086vn e agpuned aVTIKEMEVa, KABWGS EVEEXETAL VA TIPOKANEDETE
BAApn ot cuokeun.

+ Mnv ekBéteTe Tn cUOKEUN O€ LypPA 1y uypacia.

+ XPNOIMOTIOLEITE PE TTPOTOXT Ta AEECOUAP, OTIWG TT.Y. TA AKOUGTIKE. Mnv ayyilete
AoKoma TV Kepaia.

+ Mnv XpnOlWOTIOLEITE, UNV ayyi(ETE Kal PNV TPOOTIABEITE VOl AQAPETETE 1 va
embI0pBWOETE OTIAOUEVO, KOUUEVO 1} paylopévo YUaAi. H eyylnon dev kahumtel
BAaeg mou ogeilovTal o€ Kakh xprion Tng yuahivng 08ovng.

Od8nyieg yla ac@alr Kat amoTEAECHATIKN XPrion 9



«H ouokeun givat n\ektpovik Kat mapdyet OepudTnTa Katd T SIGPKELA TG KAVOVIKAG

Aerroupyiac, H mapatetapévn, dpeon emagn pe 1o dépua oag umo cuvenkeg
avenapkoUg e§aepIopoU evEEXETaL VO EM@PEPEL SUCPOPI 1 MIKPA EYKAUHATA.
YUVETTWG, XEIPIOTEITE PE TIPOOOKT] T OUCKEUI 0ag KATd T AgiToupyia 1 apécwe META.

+ Av Bpaxei n GUOKEUN, AMOCUVSEDTE TNV APECWE KAl OTEYVWOTE TNV KaAd. Mnv

ETTIXEIPIOETE VOl EMOTTEVOETE TO OTEYVWHA KE LDt EEWTEPIKA TINYR BEPUOTNTAC, OTTWE
€lval o1 poUPVOoL, Ol POUPVOL LIKPOKUHATWY 1 Ol OTEYVWTAPEG LOANIWV.

« To uypd 0N Ppeypévn ouokeur AAALEL TO XpWHA TNG ETIKETAC TOU TTPOIOVTOG

0TO EOWTEPIKO TNG OUOKEVNC. H eyyUnon Sev kahumTel BAABEG TG GUOKEURAE TTOU
o@eilovtal otnv €kBeor TG o€ Lypd.

M @opn T cuoKeun amaitei owoTH KUKAo@opia aépa yia tn Sidyuon tng

Bepuotntag. H dueon emagr pe 1o Sépua Kat n avemapKrig KUKAOQopia Tou aépa
0T OUOKEUN propei va odnynoet o uniepBéppavar tng. H ouokeur) Ba mpémel va
Bpioketal og amdoTacn TouldxioTtov 1,0 cm amd To oWHa Tou XPROTN.

« Eumodiote v gicodo okdvng ) AMwv EEvwv ouaiiv 0T BUpa Tou PoPTIoTH/ToU

kaAwdiou USB. Evoéxetat va mpokAnBei umepBéppavon i mupkayld.

Amoteleopatiki Xprion TG CUCKEVNG

HAeKTPOVIKEG CUOKEVEC

'O\EG Ot GUOKEVEG MTOpEi va GéxovTal TapeUBONEG Tou emmpealouv Ty anddoor Toug.

+ Mnv XPNOIUOTIOLEITE TN GUOKEUT KOVTA OF LATPIKO EE0MAIOUO XWpiG va €xeTe Adfel

OXETIKN GdEla. ZUUBOUNEVTEITE TO yIaTPO GG Yia va SIOMOTWOETE av n AgiToupyia
TNG OUOKEUNG UMOpEi va TTPoKahéoel TapeUBONEG 0TN AelToupyia TG laTPIKAG 00
OUOKEUNG.

+ Ol KATOOKEVOOTEG BNUATOSOTWY OUVITOUV EAAXIOTN amdaTaon 15 cm petay

MWV CUCKEUWV KAl TOU Bpatodotn, yia Ty ano@uyn moavwv mapepuBoAwy.
AUTH N GUOKEUN UmopEi va apdyel vTovo Qg 1 ewg TTou avaBooPrvel
Optopéva Bondruata akong evOEXETal va u@ioTavTal TaPEUBOAEG OO GUOKEVEC,

« MiKpEG TapEPPBONEC EVOEXETAI VOl EMTNPEACOUV OUOKEVES, OTTWG TNAEOPATEL,

PadIOeWVa, UTOAOYIOTEG KT

« Av gival duvatd, xpnolpomoIoTE T OUCKEUN O Beppokpacie uetagd 0 °C Kat

359C. H ékBeon tng ouokeunig o€ MOAD XapnAEG 1 uNAEC Beppokpacieg evoéxetal
va IPOKAAEDEL (i, SUOAEITOUPYia 1y KO Kat EKPNEn.
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0481Kn ao@alela

ENéyE€Te TOUG VOMOUG KOl TOUG KAVOVIGHOUG YIaL Tr XPr0N OUCKEUWY OTAV OONYEITE.

+ Mnv XPNOIUOTIOLEITE TTIOTE GUOKEUN XEIPOG OTAV OSNVYE(TE.

Eotiaote OAn oag Ty mpoaooyr oty odriynon.

YTAPOTAOTE OTNV AKPEN TOU SPAOU Kal 0TABUEVOTE TO OXNKA 0ag TPV
TIPOYHOTOTOINOETE 1 AMAVTHOETE O€ M KAON, €GV TO amaitouv ol ouvBriKeg
odriynong.

+ H evépyela padloouyvoTATWY EVOEXETAL VO EMNPEAGEL OPIOUEVA NAEKTPOVIKA

GUOTAUATA 0TO OXNHA 00E, OTIWE TO PASIOPWVO TOU QUTOKIVITOU Kall TOV E§0TTANICHO
acgaleiag.

« Eav 10 0xnpa oag ivat §omAiopévo e évav 1y TIEPICOATEPOUG AEPOCAKOUCG,

unv eykabioTdte Kat Pnv tomobeteite actppato eomiiopd o onpeia omou Ba
eumodietal n Aerroupyia Tou agpooakou. Evaéxetal va mpokAnbei Suohettoupyia
TOU 0EPOOAKOU 1 00PBaPAC TPAUUATIONAE AOYw aKATAANANG anddoond.

« 'Otav akoUTe HOVOIKN eV BpiokeoTe £§w, PePaiwbeite OTi éxete pubuioel Tnv

£€vtaon og éva Aoyiko eminedo, yla va €XeTe emiyvwon Tou Tt cupBaivel yopw oag.
AUTO gival IBLAITEPA CNUAVTIKO OTAV KIVEIOTE KOVTA 08 SPOUOUC.

MpokAnon BAAPNC otnv akon cag
Ta va mpogulayteite amd mBavr) PAGPN TG akorig oag, amo@UyeTe TV
aKpdaon o€ UPNAG emimeda oL yia Peyala Xpovikd SlaoTtruarta.

Evééxetat va mpokAnBei BAGPN otnv akor) oag eav ekTiBeoTe og Suvatd fixo yia
TIAPATETAPEVO XPOVIKO SIA0TNUA. EMOPéVG, 0aG GUVIGTOUE Va NV EVEPYOTIOIEITE
1] AMEVEPYOTIOLEITE TO TNAEPWVO KOVTA 0Ta aUTId 0aG. Emiong, oag cuvioToUpe va
pUBpieTe TNV évTaon TNG HOUGIKG Kall TOU fi¥ou KAong o éva hoyikd emimedo.

« '0tav XPNOIHOTOLEITE OKOUOTIKE, VA MEIWVETE TNV €VTacon TOU XoU av Sev akoUTe

600U HINOUV YUpw 00 1} av To dTopo Tou KABeTal Sim\a o0 UMOPE va aKoUoEL
QUTO TTOU OKOUTE.

E + H umepPoNkn nNTIKr TEn amd Ta AKOUOTIKA UITOPE( va TTPOKOAEDEL

QMWAELD TNG AKONG.
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luvdhiva e§aptrpata

Oplopéva P€pn TNG CUOKEUNG 00C Eival KATAOKEUAOHEVA amd YUANL To yuai pumopei

VOl OTIAOEL AV I CUOKEUT 00 TTECEL TIAVW OE OKANPEN EM@AVELD 1) SEXTEL IOXUPOUG
Kpadaopoug. EGv omdoel kdmoto YuaAvo e€ApTNHa, KNV TO ayYIEETE Kat pnv
ETTIKEIPHOETE VA TO APAIPECETE. TAHATHOTE VO XPNOIHOTIOLEITE Tr) CUCKEUH 0ag PéXPL VA
avTikataoTaBei To Yuahi amo e0uatoSoTnuévo TTAPOYO UTTNPECIWV.

Media avativaéewv

Mnv xpnotpomolgite Tn CUOKEUN O TTEPLOXES 0oL YivovTal avaTtivaelc. Na akohouBeite
TOUG TTEPLOPIOUOUG KAl OTTOLOUG KAVOVIGHOUG 1) KAVOVEG LOXUOUV.

MepiBdaMovta 6mou umdpyel Kivduvog ekpnéewv
+ Mnv XpNOILOTOIEITE TN OUOKEUN OE ONEI QVEPOSIAGHOU KAUGTUWV.
+ Mnv XpnOIHOTOLEITE TO TNAEPWVO KOVTA OE KAUGIHA 1} XNHIKA.

« Mnv pETaQEPETE Kal Pnv amoBnKeVETE EVPAEKTA AEPLD, UyPd 1} EKPNKTIKA OTOV iS10
XWPO TOU AUTOKIVATOU 0agG OTIOU TOTOBETEITE TN GUCKEUN 1} TA a§E0OUdp TNG.

Xpnon o€ agpooKAPog
O1 00UPUATEG CUOKEVEG UMOPOUV VA TIPOKAAEGOUV TIAPEUBOAEG OTA CUOTAHATA
AEPOOKAPWV.

« MNpw empPiBaoTeite o€ AEPOOKAPOG, OTTEVEPYOTIOIOTE TN GUCKEUN).

+ ‘000 TO aEPOOKAPOG BPICKETAL OTO £50POG, UNV XPNOILOTOIEITE TO TNAEPWVO XWPIG
adeia amd o mMipwya.

MNadia

Oulagte Tn ouoKeur Og AoPANEG HéPOG, pakpla amod maudid. MepapPavel e§aptrhpata
MIKPOU pEeYEBOUG TTOU EVOEXETAI VAl TIPOKANETOUV KiVEUVO TIVIYHOU EQV AMTOOTIAOTOUV
amé 1o TNAéQwvo.

Eneiyouoec KA\oEIC

O1 emeiyouoeg KANOELG evEéxeTal va pnv ivat Slabéotpeg og OAa Ta Siktua KIvnTrg
Aepwviag, Ma to Adyo auto, Sev mpémel va Bacileate amokAEIOTIKA OE auTr TN
GUOKEUN YIa EMEIYOUTEG KANTELC. ETIKOIVWVIAOTE HIE TOV TOTTIKO TIAPOXO UTINPETIAV Yial
Va EVIUEPWOEITE OXETIKA UE AUTO TO Bépa.
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H}\npocpoplac Kal @PovTida pumataplwv
Aev ival amapaitnTo va anogopTioTel Mpw N ratapia yia va Ty
EMAVAPOPTIOETE. Z& avTiBeon pe GAa ouoTApaTa prataplwy, Sev epgavifetal 1o
QAIVOLEVO UVIALING TTOU UMTOPE VOl EMNPEACEL TNV amdS00n TNG Unatapia.

« Xpnoworoleite uovo pmatapieg kat opTioTég LG. Ot popTioTéq LG éxouv oxediaoTei
UE TPAOTO TETOI0, WOTE Va peyloTomololy Tn Sidpkela {whg TG Prmatapiod.

+ Mnv amoouvappoNoYEiTe Kat unv BPOUKUKAWVETE TV Pmatapia.

« Alotnpeite KaBapEG TIG METAANKES EMOPES TNG PmaTapiag.

« AvtikaBiotdre v pmatapia otav pelwdei onuavtika n anddoon e, H umatapia
UMOPEL VOl POPTIOTEL EKATOVTASES POPES LEXPL VA XPEIAOTE AVTIKATAOTAON.

« Edav n umatapia Sev éxel xpnotpomoindei yia moAl kaipd, popTioTe T yia va
UEYIOTOMOINOETE TN SIAPKEL XPAONG TNG.

+ Mnv a@rivete ekTeBeIpévo To PopTIoTH TG umatapiag ameubeiag otnv nAakn
QKTIVOBONIC Kall NV TOV XPNOIMOTIOLEITE OE XWPOUG HE TTOAR LYPAGia, OTTWE TO
umavio.

+ Mnv a@rivete v pratapia og Beppolc i KPUOUG XWPOUE, KaBWG evaéxeTal va
pewwbei n amdédoor e,

« Eav avtikataotiioete T pratapia pe AavBaopiévo TOmo pmatapiag, umdpyel
Kivouvog ékpnéng. H amdppudn Twv XpnotuomotnuéVWY Hmatapliv PEMEL va yiveTat
oUPPWVa PE TIG 08nyieC.

« o va amo@UyeTe TNV AOKOTIN KATAVAAWGN EVEPYELAG AMTO TO YOPTIOTH, VA TOV
QmoCUVSEETE TAVTOTE Mo TNV TPICa META TNV T PN YOPTION TNG CUCKEUNC.

H mpaypatikn Sapketa {wng Tng umatapiog e§aptdatat amoé t Slapdpewon Tou
SIKTUOU, TIG PUBHITELG TV TTPOTOVTWY, TIC CUVIBELEG XPrONG, TV MmaTapia Kat Tig
TEPIBANNOVTIKEG OUVORKEG,

« BePawwBeite mwg n prmatapia Sev EpeTal o€ EMAQN HE AIUNPA QVTIKEIPEVT, OTIWE
Sovtia {wwv 1 kap@ld. Ydpyxel Kivduvog avaphegne.

+ Katavalwon evépyelag (\ettoupyia avapovig Siktuou): 0,7 W

Ac@ANEIQ TIPOCWTTIKWV GTOIXEIWV
+ Na TIpooTATEVETE IAVTA TA IPOCWTTIKA GO OTOIKEID, WOTE VA EUMOSIOETE TUXOV
S1appoég Sedopévwy 1 KATAXPNON EVAIcONTWY TANPOPOPILV.
+ Na énpioupyeite mavta avtiypaga ac@aleiag Twv onpavtikwv oag Sedopévwy dtav
XPnolpomoleite Tn ouokeun. H LG Sev ivat umevBuvn yia Tuxov anwAeleq SeSopévwv.

« Mpv meTd&eTe TN OUOKEUR, Va SNUIOVPYATETE avTiypaga ac@aleiog OAwv Twv
Sedopévwv Kal va KAVETE EMavapopd TG SUOKEUNG WOTE Va EPMOSIOETE TUXOV
Katdypnon euaiocbnTwv MANPOPOPIWV.
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« 'Otav katePalete pappoyég, va SlaPalete MPOOEKTIKA TNV 006V TwV SIKAIWHUATWV.

+ Na €ioTe MPOOEKTIKO{ OTAV XPNOILOTOIEITE EQAPHOYES TIOU €xOUV TTPOORacH oe
TIOMEG NETOUPYIEC 1) OTA TTPOCWTTIKA 0O OTOIXEICL.

+ Na eNéyxeTe TAKTIKG TOUG TTPOOWTTIKOUE GOG AOYOPLACHOUG. AV EVTOTIIOETE TUXOV
€eVOEICEIC KATAYPNONG TWV TTPOCWTTIKWY GAC OTOIXEIWY, {NTAOTE amod ToV TAPOXO TNG
umnpeoiag va dtaypayet ry va aMdgel Ta oTolyeia Tou Aoyaplaopol oag.

« Av n ouokeun oag xabei ) Kharei, aMate Tov Kwdiko MpdoPacng Tou Aoyaplacpou
00G WOTE Va SI00PANCETE Ta TIPOOWTTIKA 0AG OTOIXE(Q.

+ Mnv xpnolHOTIOLEITE EPOPHOYES TTOU TIPOEPKOVTAL ATTO AYVWOTES TINYEG.

A Eiomoinon yla tThv avtikatdotaon th pmatapiog
+H umatapia 1dviwv AiBiou eivat emkivéuvn kabwg pmopei va mpokahéoel

TPAUHOTIOO.

H avTikatdotaon TG umatapiag amo pUn KatapTIopEVO EmayyeAUaTia pmopel

Va TIPOKANEDEL (NG 0T GUCKEUT 00C.

+ Mnv avtikaBiotarte tn pmatapia pévol oag. Mmopei va mpokAnOei BAaBn otn
umatapia mou Ba odnyroel o€ unepOEpuavan Kat TpavpaTiopd. H pmatapia
TIPEMEL va avTikataoTaBel amd katapTiopévo enayyeApatio. H pmatapia
TIPETEL VA AVOKUKAWVETAL ) VOl AOPPITTTETAL EEXWPLOTA ATTd Tal OIKIAKA
amoppippaTa.

3TNV MEPIMTWON oV TO TIPOIGV S1aBETEl EvowpATWEVN UaTapia TTou &g
umopei va agatpebei amd To xpriotn, n LG oag mpoteivel va ameuBuvBeite
0€ EMAYYENUATIO YIa TNV AQAipEDN TNG Umatapiag, Qv MPOKELTaL va TV
QVTIKOTOOTHOETE I Va TN OTEINETE Yl aVAKUKAWON 0T0 TENOG TG (WG TG,
Ma v mpoAnwn BAGRNE 0To POV, KAl yia T Ao@ANEL TOU XPROTN,

MNV ETIXEIPHOETE VOl APAIPECETE TN prmatapia. AmeuBuvBeite otn Mpapun
BonBeiag g LG, fj o€ dA\o emayyehuaria.

+ Hagaipeon tng pmatapiag mpoumoBétel amoouvapuoAdynon
TOU TEPIBARLATOC TOU TTPOIOVTOG, AmOCUVEEDN TWV NAEKTPIKWV
KaAwSiwv/ EMaPWV, Kal TPOCEKTIKK AMOPAKEUVON TNG Umatapiag
e e€e10IKeUpéva epYaNeia. EQv XpelGleaTe TIG EMmayYEAUATIKES
odnyieg yla TV agaipeon g pmatapiag, emokepOeite T SievBuvon
http://www.lge.com/global/sustainability/environment/take-back-recycling.
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XapaktnPIoTIKA KApEPaAG

Kupleg Aettoupyieg KApEPQC

AuTO TO KEQAAALO TIEQIYPAPEL TIC KUPLEG AEITOUPYIES TTOU TIOPEXEL N EPAPHOYH TNG
Kdpepac.

ExteNéoTe TV epappoyr TG KAMEPAS Kat SOKIMAOTE TIG AeToupyieg
AKOAOUBWVTAG TIC TTAPAKATW 0dnyiec.

T Extehéote TV eQappoyr TG KApepag otny apyikry 08dvn Tou mpoidvToc.

ANayr TG ywviag
KAPEPAG

pUBUIONG XPOVOUETPOU ey '
EmAoyr/Akipwon —3 = = epTTPAG/Tiow Kapepag
pUBLIONG PAag g o ) = Aj

PWTOYPAPIWV

o — [1pOETTIOKOTINGN
pwToypagiag/Bivreo

ool = IVeIY}
TIEPICCOTEPWV

E + Oplopéveg amd TIG EIKOVEG TOU TTAPOVTOG EYXEIPIGIOU EXOUV UTTOOTET
enefepyacia, WOTE 0 XProTNG va Pmopei va avtiAn@Bei KaAUTEPa Tl TPETEL
Va KAVEL
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Ztabepn KApepa

Xpnotpomolriote n Asitoupyia ZTabeprg KAUEPAC yia va AMOTPEPETE TO KoUVNUa
TNG KAPEPAC KATA TNV £yypa@n Bivieo 600 MEPTATATE 1 KAVETE PHEYANEC KIVOELG.
Evepyomoirjote T Aertoupyia Katd Tou KouvriUaToq yia va HEIWOETE 1 va
e§aheipeTe TIC OONEC EIKOVEC TTOU TIPOKUTTITOUV OO TO KOUVNMA TNG KAUEPAC KATA
v gyypaen Bivteo.

1 Nathote O> (=) > Bivteo.

7 Natqote > uMn.

3 Ayyi€te 1o koupmi @ yia va eyypdiete éva Bivreo.

Moptpaito

Mriopeite va SnUIoupynOETE pia KAANTEXVIKY QWTOYpaia opTpaitou, n omoia
eoTialel 0To B€pa evw To POVTO gival Bod. Mmopeite emiong va eme€epyaoTeite
TNV €IKOVa £QapPOlOVTag P GWTIOHOU 1 XPWHATOG 0TO POVTO.

E «+ Kata m Aqyn ewtoypagiag, Satnpeite pia andotaon 0,5 pe 1,5 pétpo ano

10 Bépa oag.
+ AutA n Aerroupyia Sev eivat S1abéoipn o€ TON) OKOTEWVO TIEPIBANOV.

1 MNathote O> (&) kau énerta emhéte Moptpaito.

7 METOKIVAOTE TN Ypapur KUMONG Ipog Ta aploTepd f Ta Se€id yia va
TIPOCAPHATETE TNV LoXL TNG BOAGTNTAC.

- 4
.. +——— PUBuion 1oxU0g

BoAwpaTog.
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3 ‘Otav epgpaviotei oty 086vn To moptpéto eivat StaBoipo, natriote () 1 @
yia va BydAeTe pwia utoypagia.
+ H Aerroupyia Moptpaito evdéxeTal va pn AelToupynoel €Gv N Kapepa Sev
umopei va avayvwpioel To Bépa.

Nertoupyieg TG e@appoyng AAUTOUp

ZXETIKO TIEPIEXOEVO

Mriopeite va eme§epyaoTeite Kal va SIAHOPPWOETE OXETIKO TTEPLEXOUEVO OTO

AAumoup.

T 'Oco BAémete Wia MPOEMOKOTNGN EIKGVAG, AyYIETE TO KOUWTTE .

7 MONGC eppavioTe To elkovidio Tou OxeTileTal e TV NUEPOMNVia 1 TV
TonoBeaia omou TpaBréate Tn pwtoypaia, ayyi§Te Tnv 00ovn.

« Mmopeite va Seite TIC pwToypagieg mou oxeTi{ovTal e TV NUepoUNnvian
Tnv tomoBeaia mou emAégate.

- Ayyi&te To koupni  yia va anoktroete pdoBaon oe MpAobeteg emMoyéc.
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Anpiovpyia GIF

Mmopeite va dnpioupynoete éva apyeio GIF amd to Ahumou.

T Koty mpoBohr evég dhpmouy, en\é€te + > Anpioupyia GIF.

7 Em)\é€te TIC pwToypaiec kat Ta Bivieo mou BENETE yia va SNUIOUPYAOETE éval
apyxeio GIF kau émerta matote Emop.

+ Mmopeite emiong va mpoobéoete/SiaypdPeTe pia pwTtoypagia, va
TIPOCOPUOCETE TNV TAXUTNTA I} TOV AOyo 08Ovng, va 0piceTe TN Oelpd Twv
PwTOYPaAPIWY, K.A.

3 Em\é€te AmoBrkeuon.

E « Tt Snpiovpyia apxeiou GIF, pmopeite va xpnotpomolroete éwg 100
EIKOVEC,

Anpoupyia KoAGL
Mriopeite va dnpioupynoete éva KoAA( XPNOILOTOIWVTAG OXETIKO TIEPIEXOHEVO.
T Koté v mpoBoh evog dumouy, matiote - > Anuoupyia KoAGd.
7 Em\é€te Tig elkdveg mou BéNeTe va ipoabéoeTe 0To KOAAL Kal EMelta matioTe
Emop.
+ EmAé€Te Tn S1atagn mou BéNeTe amo To KATw PéPOG TG 006V,
3 Emé€te Anpovpyia.

5 « Tlatn Snpiovpyia KONAL, UMOPEITE VAl XPNOILOTIOIOETE WG 9 EIKOVEC.
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Anovpyia Tawviag

Mriopeite va SnpioupynoeTe pia véa Tatvia cuvdualovTag eikOve kat Bivteo.

T Exteléote TV epappoyr) ANUTTOUY, EMAEETE TOV PAKENO TIOU MBUELTE péoa
0TO0 GAUTOU KA TIATAOTE + > Anpioupyia Tawiac.

7 Em\é€te TIC e1kdveC i Ta Bivieo mou BéAeTe va oupmepIAIBETE 0TV Tawvia oag
Kat matrjote Emop.

3 Eme€epyaoTeite TIG EIKOVES KAl Ta BIVTEO TIOU £XETE EMAECEL KL TTATHOTE
Amobrkeuon.

4

l~<<~ii~ii-iw

Awaypagn apyeiwv

Mropeite va emAé€eTe elkOVeC 1 Bivieo mou BéNeTe va Slaypdypete amo To Bivied
oag mat@vTag 1o koupr ) ot kétw Se€id ywvia T pikpoypapiag mou
avTIoTOIXEl 0TO KaBéva.

Mpoabrikn apyeiwv

Mmopeite va mpooBEoeTe elkdvec 1y Bivieo mou BENETE TATWVTOG TO Koupri -+ oTo
KATW P0G TG 080vNG. Mmopeite emiong va emAEEeTe €IKOVEC 1) Bivieo TTOU éxeTe
1on mpooBEaeL

5 « [atAote mapateTapéva mavw ot éva apyeio Kal Emerta mavw o€ éva AANo yia
moMamA emAoyr apxeiwv.
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Avadiaraén apyeiwv

Mo va aMNGEeTe T S1atagn Twv eKOVwY Kat Twv Pivteo, TATHOTE KAl KPATAOTE
TIOTNHEVO TIAVW OTO OPXEIO TTOU BENETE VOl PETAKIVIOETE Kall GUPETE TO 0TV
TomnoBeoia mou BéAeTe.

Mpocbrkn epé apyeiwv
Avyyi€te 1o elkovidio & yia va pooBEoete éva Bépa iy LOUGIKK GOvVToU 1 va
ONAEETE TN YPAUUATOOELPA.

Enmavagopd twv pubpicewv Tawviag
Mriopeite va avaKaéOETE TIC PUBIOELS TIOU EXETE OpITEL TNV Tawvia (TT.Y. XPOVOS
Qvamapaywyrg) ATWVTAS T0 KOUUT &).

Mpoemaokomnon apyeiov

Atite 10 Bivteo oL dnuioupyRoaTe TPLV TO AMOBNKEVCETE, TATWVTAC TO
Koupmi @ ‘Otav ohokAnpwbEei n avamapaywyry, TPAYHATOMOLETal QUTOHATA
avanapaywyr Tou EMGEVOU apxeiou.

E + Mot dnpioupyia Bivteo, pmopeite va xpnolpomolioeTe wg 50 EIKOVEG Kalt
Bivteo.

+ O mpoemAeypévog XpOVOG avamapaywyng yla pia ikova ivat 3
Seutepoherta kai Sev pumopei va aMd&eL. H Sidpketa Twv Bivieo pmopei va
pewBei o €wg 1 GeuTtepOAeTTO.

+ Autij n SuvatdtnTa pmopei va unv umootnpilel OPIoHEVES LOPPEG EIKOVWY
1 Bivteo.
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Anovpyia GIF
Mmopeite ebkoha va SnuoupynoeTe éva apyeio GIF xpnotpomolwvag
nxoypagnuévo Bivteo.

Anpioupyia Bivteo
1 Tnouypr mou Ba emAé€ete otnv apyr TG MPoPoi¢ evog Bivieo, matrote G).
7 Em)\é€te 1o urikog Tou GIF iou B4AeTe va SnuioupynoeTe.
+ To GIF dnuioupyeitat yia To Xpovikd S1dotnpia mou éxel emAeYei amé To
KaBOPIOPEVO XPOVIKO ONueEio évapéng.
« Ta Bivreo pe Sidpkela Aiydtepo amo 5 SeutepoAemta, ot eikoveg GIF
SnioupyoLVTaAL AUTOMATA Yia TV UTIOAOITN WPA.

Anpovpyia pwrtoypa@iwv GIF
T ¥ Niota pwroypagiiv otn cuNoyH, TathoTe + > Anpioupyia GIF.
7 Em\EETe Wia €IKOVA Yia va TN PETOTPEYETE O wToypagia GIF kat émerta
natiote Emop.
+ Mmopeite va mpooBéoete/SlaypAPeTe pia pwToypagia, va TPOCapHOCETE
TNV TaxUTNTa 1 Tov Adyo 086vnG Kalt va OpIoETE TN OELPA TWV QUTOYPAPILV.

A « Hénpioupyia gwtoypagiwv GIF givat pia Aertoupyia mou mapéxetal yla Tov
XPOTN WOTE VOl UMOPE Vo TIOPAYEL SUIOUPYIKES ElkOVES. H mapafiaon
SIKAWHATWY OTIWG TO SIKAiWA TVEVHATIKAG 1GloKTNaiag fi n SlafoAr

NG PriENG GANOU ATOHOU XPNGIHOTIOIWVTAS TN A&lToupyia Snptoupyiag
Qwtoypaplwv GIF evdéxetal va mPoKaNEDEL AOTIKI 1 TTOWVIKF Siwén
OUPPWVA UE TOUG LoXVOVTEG VOpOUG. Mnv avTiypdpeTe i petadidete To €pyo
AaMou atdpou xwpic mponyoupevn e§ovatoddtnon. H LG Electronics dev
PEPEL Kapia uBUVN Yl TETOLEG EVEPYELEC ATTO TOUG XPOTEG.

Mmopeite va emAéEeTe €wg 100 wTOypaPiES OTAV SNUIOUPYEITE Hia EIKOVA
GIF.
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MowdtnTa Kat EMMTWOELG TOU YOV
XOPAKTNPIOTIKA

DTS:X 3D Surround

Mmopeite va avamapaydyete éva tpayoldi r éva Bivteo pe tpiodidotato, {wvtavd
Kat {wvtavo ryo. MNa va Xpnotuomoli oL auTo TO XAPAKTNPIOTIKO, GUVOEDE
OKOUOTIKG, NXEIO 1) AMEG EEWTEPIKEG CUOKEVEC XOU OTN GUOKEUH GOU.

NatAote O > Pubpioeig > Hyog > MoléTnTa AXOU Kat EPE KAl ETEITA TTATHOTE
DTS:X 3D Surround QD) yia va evepyoToIfoeTe auTrv TN Aertoupyia.

« Mmopeite va KATEPATETE TN YPAUUI KATAGTAONG A0 TO EMAVW UEPOG TG
086vng kat va ayyi&ete To eikovidlo yia o DTS:X 3D yia va evepyomoIoeTe Tn
Aertoupyia.

Edv ouvdEoeTe e€WTEPIKEC CUOKEVEC X0V, OTTWG AKOUOTIKA Kall NXEQ, OTO mPOIdV,
Ba epgavioTel éva avaduoduevo mapabupo GTIou UMTOPELTE Va EVEPYOTIOICETE TOV
rxo DTS:X 3D 1y T Aertoupyia Hi-Fi Quad DAC.
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Floating Bar

Floating Bar - Mapouaciaon

Mriopeite va evepyoTioIOETE AEITOUPYIES TIOU XPNOIHOTIOLEITE CUXVA, OTTWG
GUVTOEVOELS, AMOTUTIWGN 08OVNE, AVAapaywyr LOUGIKAG KAt YPrYOPES EMAQEC,
matwvTag mavw oto Floating Bar otnv 08évn.

MNa va evepyormoioete T duvatotnta Floating Bar, matiote O) > PuBpioeig >
Emektaoeic > Floating Bar QD).

Avotypa Kat KAgiowo Floating Bar
- Ta va avoiéete 1o Floating Bar: Ayyi&te ta eovibia € i .
- Ta va k\eioete 10 Floating Bar: Ayyi€te ta eikovidia > i <.

E181kég Aertoupyieg 24



Memklvnon ¢ Oéonc¢ tou Floating Bar
‘Otav 1o Floating Bar ivat avoiyto: matiote mavw oTnv PImapa Kat GUPETE T
otnv embupunth Bon.

- 'Otav to Floating Bar givai KA€IGTO: TATAOTE MAVW OTNV PIAPA KAl GUPETE TN
otnv embupuntr B€on amoé v akpn g 0Bévng.

Anevepyomoinon tou Floating Bar
Mmopeite va amevepyomoinoete to Floating Bar xpnaotgomotwvtag pia amo Tig
mapakdtw pebodoug:
« Ayyi€te kai KpatioTe To €ikovidio < 1 1o lkovidio > oto Floating Bar kat
£MeITa OUPETE TO OTNV TEPLOKH SlaypaPri¢ 0To MAvw PEPOG TNG 086VNG.
+ Ayyi€te 1o ekovidio < i To eikovidlo > oto Floating Bar kau émerta motriote
o> @® o010 mdvw péPog Tng 08évng.
- Emegre O > PuBpioeig > Enektdoelc > Floating Bar @ .
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PUBuion tou Floating Bar
Mriopeite va emAé€ete To meplexdpevo mou Ba epgavietal oo Floating Bar katva
aMG&ete T oelpd epgaviong. Ayyi€te To eikoviblo == oto Floating Bar 1 emAé€te
(> PuBpioeig > Enektdoeig > Floating Bar.

Oéon: Mmopeite va opioeTe TV meploxr Péoa oty omoia Ba pmopeite va
uetakiveite 1o floating bar.

Suvtopevoelg: a ypriyopn mpooBacn o€ eQappoyEC 1 AelToupyieg mou
XPNolpomolouvTal Mo GuyVdA.

- Amotumwon 006vng: TpaPr&te éva otiypudtumo 080vNng Kal &ite KAvTe

TIEPIKOTI €iTE SNUoupyNoTe éva apyeio GIF.

r o | Mmopeite va xpnoipomnotrjoete v epappoynr Capture+ otnv 086vn mou
< | Béhete.

Mrmopeite va KataypAayeTe €va oTIYUIOTUTTIO 000VNG e KOMON Kat val TO
XpnotpomolnoeTe yla 1o Q Memo+ 1 va 1o amoBnKeVuoeTe 0T GUANOYN.

o | Mmopeite va kataypapete pia emOupNTA PO Kalvatn

XpnotpomolnoeTe yla 1o Q Memo+ r va v amoBnkeVoeTe 0T GUNOY.

AnoBnkevoTe T Tpéxouca 086vn we apxeio GIF. Mmopeite va
TIPOCAPUOCETE TO péyeBOG TNC EIKOVAG TTOU BENETE VO AMOTUTTWOETE.

« TNa va §eKivioeTe TV eyypan evog apxeiou GIF, matriote Q)
+ Tia va S1aKOYETE T eyypar evog apyeiou GIF, matrote ().

» - Na va yetakivnBeite otnv emBuuntr TomoBeaia, cUPETE TO PUOUIOTIKO —.

Mpoypappa avamapaywyng pouctkig: EAéyETe T HOUGIKN TTOU OKOUTE.

- Tpriyopn ema@n: KaAéote 1 oTeiNte pnvOpaTa o€ ATOO TIOU £XOUV OPIOTE! WG

5

YPrYOPEC EMOPEC.

« 3TIC YPrYOPEG EMAPES UMOPEITE VA IPOOOECETE WG 5 EMAPEG.

+ Hkataypaer GIF gival pia Aetroupyia mou mapéxeTal yia Tov XprioTn WoTe

va Popei va mapdyet SnuioupyIkég elkoves. H mapapiaon Sikaiwpatwy

0w To SIKaiwpa IVEVHATIKAG S1okTNaiag i n SlaBoAr T eripng dAAou

atdpou XpNoIomoIVTAG T AgiToupyia Kataypa@nic GIF evoéxetat va
TIPOKOAAEDEL AOTIKN ) TIOWIKT Siwén GUHPWVA PE TOUG IOXUOVTEG VOHOUG,

Mnv avtiypdgete 1 petadidete 1o £pyo GANOU aTOOU XwPIG TPoNyoUevn

g§oualodotnon. H LG Electronics dev pépel kapio euBOVN yia TETOLEG
EVEPYELEG ATTO TOUG XPAOTEG,
+ Eva apyeio GIF pmopei va éxel Sidpkela éwg 15 Seutepolema.
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Google Assistant

Google Assistant Emokomnnon

H ouokeun oag €xel evowpatwpévn ™ Suvatotnta Google Assistant. Bpeite
QMAVTACELC KAl KAVTE TIC SOUAEIEC 0O EKTOC OTITIOU ) YPOPEIOU.

5 « 10 va xpnolHOTIOIAOEIC AUTO TO XAPAKTNPIOTIKG, TPWTA OUVSEGOU OTO
S1adikTuo Kal kave icodo e Tov Aoyaplacpd cou ato Google.

Ekkivnon tou Google Assistant.

1 NatAote napatetapévato O) and v apyikiy 086vn yia va ekKIVATETE T
Google Assistant rj matrjote 10 MAKTPO Google Assistant otnv aptotepn
TINEUPA TNG OUOKEUNG.

7 Ayyi€te to ZEKINHXTE.

3 AkohouBroTe TIC 0dnyiec ou epaviloval otnv 086vn Kai mieite “Ok
Google"n “Hey Google".

+ H ouokeur amoBnkevel Ta wvnTika oag Sedopéva yia avayvwpion.

/A EmAé€te eav Ba xpnotpomoinBei n Aertoupyia EekNeSWMATOC K Taiplaopa
Pwvic.

+ Edv xpnotpomoleite T Aertoupyia EEKAEIOWHOTOG LIE TAIPIAOHA QWVAC,
Umopeite va EEKAEIOWOETE TN CUOKEUH AKOUA KI 6TaV N 088vN TG OUOKEUNC
Sev eival avappévn 1 av n cuokeun @optiCel, Aéyovtag “OK Google” iy “Hey
Google!.
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E + Autij n Suvatdtnta pmopei va gival mo evaAwtn 6oov apopd Ty acedleia,
0€ ox€on pe AMoug Tpomoug KAEWwpaTog 086vng, 6mwg to Motifo, o
Kwdikog kKAeldwpatog iy o Kwdikog mpdoPaong.

H 086vn pmopei va EekAeldwOe( kat piE pia @wvr mapopota pe T SiKr oag i
HE TV NXoypagpnuévn gwviy oag.

+ [a va xpnoluomoINoETe AUTO TO XOPOKTNPIOTIKG, TATAOTE O > PuBpioeig
> Kheidwpa 006vng & ac@aheia > Pubpicelg ac@aloig KAEWSWpaTog
>'E€unvo KAeidwpa, kat UETA XpnotpomoloTe T PéBodo KAEIOWHATOG
0006vng mmou BéNeTe yia va EekNeldwaoeTe T cuokeur. Matrote Taiplaopa
QWVNG, peta matriote MpooPacn pe Taiplacpua wviig M Kat PeTd
EexheldwoTe Eavd T cUOKeUN pe T Tpéxouca péBodo. Inpeiwoe 6Tt T
touchscreen v mepappavetal.

« Av bev pmopeite va EeKAEISWOETE TN OUCKEUN LIE avayvwpion ewvrg, Ba
TIpEMEL va TNV EEKAEIOWOETE XPNOlUoTOLWVTAG TV KaBopiopévn péBodo. Na
AemTopépeleg, avatpé€te oty evotnta PUBpion kAeidwpatog 08ovng.

5 EmAé€te AmoBrikeuon.

MpoaoBaon pe pwvi

T 'Otav n apyikr 086vn eivai amevepyomnoinpévn 1 KAelbwpévn, meite “OK
Google” 1} “Hey Google.".

7 Otav epgaviotei n 086vn Tou Google Assistant, Teite pia eVTOM 1 KAVTE piat
£PWTNON.

MpdoBacn amo tnv apxikn 086vn
T Ayyi€e katkpatioou O oty Apxiki 086vn.
7 Meite pia evioAr f pWTNON 6TaV SETE TO * » - » 0TO KATW PEPOC TNC 000VNC.

5 « e évamepiBaov dmou n obveon tou acupuatou Siktvou Wi-Fi rj Tou
SIKTUOU KIvnTAG TNAEQVIAE ival xapnArig molotnTag, n Asttoupyia Google
Assistant evexopuévwg va meplopiletal Kat 0 pUOUOE TIOTHAG avayvwplong
opiNiag va givat xapnAdTePoG.

« Eav n opNia givat aca@ric, To PIKpd®wvo KAAUTITETAL, AEITOUPYED piat
GUOKEUN avamapaywyng téowv fj o mepiBaMwv rxog ivat Suvatog, o
PUBPOE TOTHG avayvwplong ophiag pmopei va gival xapnAdtepog. Otav
XPNOIUOTIOIETE TO TPOIOV HE PWVNTIKEG EVTIOAEC, MAOTE e KOAT) TPO®Oopd
0€ 1ouxo TEPIBANOV yia PeyahUTEPN aKpiBEla avayvwpiong OpNaG.
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Avayvwpion SAKTUAIKWV amoTUNTWHATWVY

Avayvwpion SaktuAikwv amotunwpdatwy - Mapouaciaon

MpoToU XPNOILOTOINCETE TN A&lToUpyia avayvwplong SAKTUAKWY amoTunwpdtwy,

TIPEMEL VA KATaXWPIOETE Tal SAKTUNKA GO AMOTUTTWUATA 0T GUOKEUH.
Mriopeite va XpnolomoloeTe TN AelToupyia avayvwpiong SOKTUANKWV
AMOTUNWUATWY OTIG AKONOUBEC TIEQIMTWOELG:
« Ta Eexeibwpa tng 086vNg.
+ Ta mpoPolr Tou KAeldwuEvou TEPLEXOUEVOU TTOU BPIoKETAL 0TO ANMTTOUN 1y
otnv epappoyr QuickMemo+.
« o emPeBaiwon piag ayopdg Péow tng oUVEECNC O€ LIa EQAPHOYN i
TOUTOTOINONG e TO SAKTUNIKO 0ag amOTUMWHAL.

E « Mmopeite va xpnotpomolroete Sedopéva SAKTUNKWY amoTumwudTwy yia

TauTomoinon Tou Xprotn. Ymdpxel n mbavdtnta o aiedntripag SakTuNKwv

QMOTUNIWHATWY Va avayvwpilel éva S1agopeTikd ald oxedov idlo
SAKTUNIKO amoTUNTWHA WG KaTaxwpnuévo SakTuNiké amotunwya. MNa va
€VIOXUOETE TV a0@dAela, cuvioTatat n xprion potifou, PIN i kwdikol
npdoBaonc yia to EekAeidwpa tng 00ovnc.

Av n ouokeur| dev avayvwpilel Ta SayTUNIKA GaG AmOTUMIWUATA 1) AV
EexaoeTe TNV KABOPIGHEVN TIH IO TNV KATAXWPLOT, ETMOKEPTEITE TO
mnatéotepo Kévtpo e§unnpétnong mehatwv g LG mpookopifovtag
OUOKEUN KOl TNV TAUTOTNTA 00G.

Mpo@uldagerg yia tnv avayvwplon SaKTUMKWY amoTUNWHATWY

H akpifela avayvwpiong SAKTUNKOU AmoTUMWUATOG UIOPE( va EwBEL yia

S1agpopouc Mdyouc. Na va peytotomotnBei n akpiBela tg avayvpiong, eAéyEte Ta

aKoouBa TPV XPNOIOTIONOETE TN GUOKEUN.

+ H ouokeun Slabétel aiobnTpa SAKTUNKWY amoTumwpdTwy. MPooéxeTe WOoTe

va pnv ypat{ouvioete 1 mpokaléoete Bopd oTov alodnTtrpa SAKTUNKWY
AMOTUTTWUATWY ME PETANIKA QVTIKEIMEVA OTIWE KEPUATA 1 KAEISIA.

Edv umapyouv &éveg ouaieg (15pwTtag, Aooiov, vepo, okovn, Aimm, K.4.) oTov
aedntrpa daktuAKwv anotunwpdtwy 1y 0To SdyTulo Tou Ba TomoBetn Ol

oTovV AIoONTPA, N avayvwELon SAKTUNKWY amOTUNTWHATWY EVOEXETAL VA NV

Aertoupyei owoTd. LKoumioTe Tov aloBnTApa Kat To SAXTUAO Kal apalpéoTe
KaBe ixvog uypaoiag mpiv TomoBeTroeTe To SAXTUNO GTOV alEONTHPA.

E181kég Aertoupyieg
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+ Edv n emdveia tou Saytulou eivat okAnpr emeldn €xel oUAEG N €xel {apwael
amo 1o vePd, 0 ALoONTAPAG EVOEXETAI VO PNV PITOPET VAl aVayVWPIOoEL TO
SAKTUNIKS amoTUMWIAL. Z€ TETOLO TIEPITTTWON, KATAXWPIOTE £va AANO SAKTUAIKO
amotimwua.

+ Edv huyilete o 8AKTUAG 0OG 1) XPNOIHOTIOLEITE POVO TNV AKPN TOU SAKTUAOU
00, To SAKTUAIKO amoTUMWHA 006 EVOEXETAL VA UNV avayvwploTei. BeBalwBeite
OT1 70 SAKTUNG 0O KAAUTITEL OAOKAN PN TNV EMIPAVELD TOU AloBNTAPA
SAKTUNKWV QmOTUNTWUATWV.

+ Xapwote Povo €va GAKTUMO yia kdBe kataxwplon. H cdpwon mepIocoTepwv

SaKTUAWV UMTOpE va €xel EMMTWOELG 0Th Sladikacia Kataxwplong Kat

EYYPAPAC.

H ouokeun evoéxetal va SnUIoUpPYEl 0TATIKO NAEKTPIONO OE TEPIMTWon mou

Aertoupyei o€ mepIBANov pe Enpd aépa. Edv o mepiBdMwy aépag ivat Enpdc,

QmMOUYETE T 6APWOoN Tou SAKTUNKOU 0a¢ amOTUNUATOC iy ayyiTe éva

UETAMIKO QVTIKEIEVO, OTIWE EVa VOUIOHA 1) €va KAEWS], TPV TN 0dpwon Tou

GOKTUAIKOU OmOTUTIMATOC YIal VA EE0UOETEPWOETE TOV OTATIKO NAEKTPIOMO.

Kataywpion SaKTUMK®WY amoTunwudatwy

Mriopeite va KataxwpioeTe Kalt va amoBnKeVOETe T0 SAKTUNKO 0aG AmOTUNWHA

0TI GUOKEUN YO VO TO XPNOIUOTIOIETE HE TNV QVAYVWPLOT SOKTUNKWV

QMOTUNTWHUATWV.

1 Natiote O > Pubpioei> Kheibwpa 086vng & acpdaheia > Aaktul.
Anotunwparta.

E « Tla va XpnoIHOMOICETE auTrv T AEIToupYia, TPEMEL VAl EXETE OPIOEL
KAEibwpa 006vNg.
+ Edv 1o K\eibwpa 086vn¢ bev gival evepyomoinpévo, SIapopQWOTE TIG
puBbpioelg KAedWaTog 006vNG akoAouBwvTag TG 0dnyieg Tng 08vne. MNa
hentopépele¢, avatpéTe otny evétnta Pubpion kAsibwuatog 06évne.

7 Evtomiote T 840N Tou aloBnTrpa SAKTUNKWY OMOTUTTWHATWY Kol
OKOUUTOTE ENAPPWE TO SAKTUNO GTOV aleONTrPa.

E + To dayTtuho mpémel va KAaAUTTTEL AT pwG ToV aloBnTripa SAKTUNIKWY
AMOTUNTWHATWV.
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3 AkolouBriote Ti 0dnyie¢ mou epgavilovtal atnv 08évn.
+ Méxpt va ohokAnpwBei n Kataywpton Tou SaKTUNKOU amoTunwuaTog,
KOuvnoTE ENaPPWE TO i810 dyTUNO TAvw oToV ALeBNTrPa.
+ TomoBetrote 10 SdyTulo oTov alednTpa. Otav Ba vinoete pa ddvnon,
apapéote To SAxTUNO amod Tov aloBnTAPa.
/A 'Otav n Kataywpton tou SakTuNKoU amotunpatog oAokAnpwoel, matfote
OK.
+ Matote NPOXOHKH EMIMA. yia va Kataxwpioete AMO SAKTUNKO
anotunwya. Emeidr 1o mooootd emrtuyiag oty avayvwplon SAKTUNKWY
QAMOTUMWHATWY 0PTATAL OO TNV KATAOTAON TOU SAKTUAIKOU

QMOTUTIWHATOG TTOU EXETE KATAXWPIOEL, OUVIOTATAL I KATOXWPION APKETWV

S10QOPETIKWY SAKTUNKWY AMOTUTTWHATWVY.

Awayeipion SAKTUNMKWY aMOTUMWHATWY

Mriopeite va eme§epyaoTeite 1 va SlaypaPeTe KataywpIopéva SAKTUAKA
AmoOTUNWHATAL.

1 Natote O > PuBpioeig > Kheibwpa 006vng & ao@dleta > AakTul.
Anotunwparta.

7 ZekAelbWoTe GUMPWVA ME TNV KaBOPIoEVN UEB0SO KAEIGWUATOC.
3 A6 NoTa Twv SAKTUNKOV amoTUNIWHATWY, TTATAOTE TTAVW OF éva

SAKTUAIKO OmOTUTMIWA Y10 VO TO HETOVOHAOETE. 10 va T SlaypAYETE, TATAOTE

0 KOUTT {i1].
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ZekAeibwpa tnG 006vNng pe xprion dakTuikol
ATTOTUTIWHOTOG
Mriopeite va Eexheldwoete Tnv 006vn 1 va Seite To KAEIOWHEVO TIEPIEXOHEVO
XPnotpomolvTag To SakTulkd cag amotunwua. Evepyomoinon emOupntrig
Aertoupyiac:
1 Natiote O > Pubpioei> Kheibwpa 086vng & acpdaheia > Aaktul.
Anotunwparta.
7 ZekAEldWoTE CUPPWVA HE TV KaBoplopévn uéBodo KAeIGWuaTOC.
3 v 086vn puBpicEWV SAKTUNKWY OMOTUTTWHATWY, EVEPYOTIOIAOTE TV
emBuunTh Aettoupyia:
+ Kheibwpa 006vng: ZekAeidwpia TG 086vng pe Xprion SakTuAikol
QMOTUTIWHATOC,
+ K\eidwpa mepiegopévou: yia va EEKAEISWVETE TO TTEPIEXOMEVO HIE XPrioN
SaKTuNKOU amoTunwpaTog. Ma va to kdvete autd, PePatwbeite 6T éxel
£QAPUOOTEL KAEISWA TIEPIEXOUEVOU.
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Avayvwpion TpocwItov

Avayvwpion ipoowmou - Mapouaoiaon
Mriopeite va {exheldwoete v 006vn xpnaotpomolwvag ta dedopéva
XOPAKTNPIOTIKWY TIPOOWTTOU TTOU EXETE AMOBNKEVTEL.

5 + Autij n SuvatdtnTa pmopei va gival Aiyotepo ao®alric o€ oxéon e AANOUG
TPOMoUC KAedwpaTog 086vng, 6nwg to Knock Code, To Motifo, 0 Kwdikog
KAeldwpatog 1y o Kwdikog mpooBaong.

« Ho6B6vn umopei va EekNeldwOE( Kal e éva mPAoWTTO MAPOLOLO LE TO SIKO
00 1 HE M0 QWTOYPAPIa TOU TIPOCWTTOU GOG.
« Ta 6edopéva XapaKTNPIOTIKWY TIPOCWITOU TIOU £X0UV AVAYVWPLOTE!
amoBnkevovTal e aopAAEIa OTN GUCKEN 0aG.

Av éxete EMAEEEL TNV QVaYVWPLON TTPOOWTTOU Yia PéB0S0 KAEIGWHATOG

086vng, mpénel va elodyete To Knock Code, To MoTifo, Tov Kwdikog

KAEBWHaTOG 1 Tov KwdIKOG MPAoRaong mou XpnolHomoLoate KAtd TV

KOTaxwplon TwV XOpaKTNPIoTIKWY TTPOCWTIOU LETA TNV EVEPYOTIOINGN TNG

OUOKEUNG. Mpooé€te, emiong, va pnv §exAoeTe TV KaBopiopévn TIpn.

+ Avn ouokeur 8ev avayvwpiel To TPOCWTO 0ag 1y av EEXACETE TV
KaBopIopévn TIUA VIO TNV KATAXWELON, EMOKEPTEITE TO MANCIEOTEPO
Kévtpo e§ummpétnong mehatwv g LG mpookopiovtag Tn GUOKEUH Kal Ty
TaUTOTNTA 00C.

« Tla e§oikovopnon evépyelag, n duvatdtnta avayvwpiong mpoowrou dev Ba
Aettoupyei dtav To enimedo umatapiag eivat Katw amd 5%.

Mpo@uAdagerc yia tnv Avayvwplion pocwiiou
H akpifela g Avayvwpiong mpoowmou Mmopei va PElwBEl oTIG akOAOUBEC
MeQTWOELG. Na va au€roete Ty akpiPela, eréyEte Ta akdhouba mpv
XPNOILOTIOIOETE TN CUOKEUN.
+ ‘Otav popdrte KaméNo, YUaAld 1} LAOKa TIou KAAUTTTOLV TO TIPOOWTIO 0 1 v
£xeTe €évTOVO paKIyIdd 1y yévia mou aAAa{ouv oAU To pOowmd oag.
- ‘Otav umdpyouv SayTUNKA aMOTUTIWHATA 1) §EVA CWHATA OTO UMPOOTIVO UEPOG
TOU PaKOU TNG KAMEPAG 1} €4V N ouoKeun Sev pmopei va Slakpivel To MPOowmno
060G AOyw TIOAU QWTEVOU 1} OKOTEIVOU GWTIGHOU.
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Kataywpion 6edopévwv XapakTneIGTIKWVY TTPOGWITOU

Mptv xpnotpomotoeTe Tn AgToupyia Avayvwplion TPoowou, IPEMEL va

KoTaxwpioeTe Ta SeSopEVa XAPAKTNPIOTIKWY TPOCWTTOU 0Ag 0T GUCKEUT 0.

1 Natote O > PuBpioeig > Kheibwpa 006vng & ao@dleta > Avayvwplon
TIPOCWITOV.

5

« [la va XpnolpomoloeTe auTrv T duvatotnTa, Ba mpémel va opioeTe To
KAeibwpa 006vng og Knock Code, MotiBo, Kwdikog KAEGwHaTOg 1) KwOIKAG
mpoopacng.

« Av bev éxel oploTei kAeidwpa 086vng, akoAouBRoTe TG 08nyieg atnv 006vn
yla Ty Kataywplon dedopévwv. MNa AeNTopEPELES, avaTpEETE 0TV EvOTNTA
PuBuion kAslbwpatog 066vng.

7 Matiote EMOM kat EekNelGWOTE TN CUOKELH GUMQWVA PE TV KaBopIopEVN
uébodo.

3 Natfote ENAPZH Kal OnKWOTE TN OUCKEUR 00 UTPOOTA 0TA MATIA OQC,

/I KataywpioTe Ta XapaKTnPIoTIKA TOU IPOGWTTOU Ga¢ GUUPWVA UE TIC 08nyieg
iou epgaviovtal otnv 08dvn.
+ H kataxwpnon Twv XapaktnploTIKWy Ba mpémel va yivel oe XWpo mou dev

€lval TOAD QWTEIVOG I OKOTEIVOG.

TomoBetrioTe OGN0 TO MPOOWMO 0ag EVTAS TOU 08nyoU Tou eppavileTal 0T
006vn Kal HETA TPOoaPUAOTE TN BE0N TOU HETAKIVWVTAC TO ApYd PO Ta
TIAVW, KATw, aplotepa 1y e€id.

Kpatrote To mpoowmno oag eyyeypappévo. Mmopeite va tpapréete

Hia 0tabepr} pwToypaia APKETEC POPEC Yia va BeATIWOETE TO pUBPS
£yKupATNTAC.

5 'Otav ohokANpwBE( N KATaKWPLoN TWV XAPAKTNPLOTIKWY TTPOGWTTOU, TIATHOTE
OK.
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ZekAeibwpa TNG 006VN¢ pE To MPOCWTO Gag

Mriopeite va amevepyomoloete To KAeibwua 006vng xpnotpomolwmvtag tTo

npdowmd oag avti yia Knock Code, Motifo, Kwdikog khetdwpatog 1 Kwdikdg

npdoBaonc.

1 Natiote O > Pubpioeig> Kheidwpa 086vng & ac@aleia > Alahé€re
KAeidwpa 006vng.

7 Zekheldwote Ty 006vn cUpEWva pe Ty kaBopiopévn pébodo.

3 Matiote Emrpénetat xprion Avayvapion mpoowov (3D ToU 6aG EMTPENEL
va EEKAEIBWVETE TNV 086VN XPNOILOTOLWVTAG TV QVAYVWPLON TIPOCWTTOU.

BeAtiwon Tng avayvwpiong mpocwiiov

Mriopeite va mpoobéoete SeSopéva XOPAKTNPIOTIKWY TTPOCWITOU UTIO SAQOPES

OUVONKEC, WOTE VA BENTIWOETE TNV AvayvwpLon TPOCWITOU.

1 Natote O > PuBpioeig> Kheibwpa 006vng & ao@aleia > Avayvwpion
TIPOCWITOV.

7 Zexheldwote v 006vn cUp@wva pe Ty kabopiopévn pebodo.

3 Em\é€te BeATiwpévn avayv@pion mpoowou.

A KataywpioTe T XapaKTNPIOTIKA TOU TIPOGWITOU 00 CUUPWVA UE TIG 0dnYieg
ou gppavifovtal otnv 086vN.

5 'Otav oMokApwBEl n KATayWPLoN TWV XAPAKTNPLOTIKWV TTPOGWITOU, TIATHOTE
OK.

Aaypapni SeSopévwv XapaKTNPICTIKWY TPOCWITOU

Av n Avayviplon TIpoowrtou Gev AEITOUPYEL KAVOVIKQ, UTOPEITE va SlaypAayeTe Ta

Sedopéva XapakTnPIoTIKWV TIPOCWTIOU TTOU EXETE KATAXWPIOEL KAl va emavaldBeTe

TNV Kataxwplon.

1 Natote O > PuBpioeig> Kheibwpa 006vng & ao@aleia > Avayvwpion
TIPOCWITOV.

7 Zexheldwote Ty 000vn cUpewva pe Ty kabopiopévn pebodo.

3 Em\é€te Maypagn mpoowmou yia va Slaypdpete ta SeSopéva
XOPAKTNPIOTIKWV TTPOOWTTOU.
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ZekAeidwpa tng 000vNG pe To MPOSWTTO oag 6Tav n 0Bovn givat

OTTEVEPYOTTIOINMEVN

Me amevepyomoinpévn Tnv 08vn, ONKWOTE TN GUOKEUN KAl KOITAETE 0TV

0006vn. H cuokeun pmopei va avayvwpioel To mpoowmd oag 6tav n 08ovn givat

QTEVEQYOTIOINHEVN.

Mo va amevepyomoloeTe TN AEIToUpYia, akoAouBAOTE TIC TapaKAdTw odnyiec.

1 Natote O > Pubpioeic> Kheidwpa 086vng & acpdheia> Avayvipion
TIPOCWTIOV.

7 Zekhalbwote TV 006vn oOp@wva e Ty kaBopiopévn uébodo.

3 Em\é€te Na emTpémeTal To amoTUNWHA TPOGWITOU Tav n 086vn eivat
opnotA @ ) yla va amevepyoToIOETE TN AElToupyia.

+ H duvardtnta Avayvwplon mpoowmou ival Slabéotun povo étav ivat
KA wpEVN n 0Bovn.

ZekAeibwpa TG 006vNng e Avayvwpion mposwIToU Kal apwon

00o6vn¢

Otav gival anevepyorolnévn n 086vn, umopeite va v EeKAeIOWOETE Péow

QVayvVWPLoNG TPOGWTTOU Kal 6Apwang 006vng.

1 Natote O > PuBpioeig > Kheibwpa 006vng & ao@dleia > Avayvwplon
TIPOCWITOU.

7 Zexheldwote v 000vn cUpewva pe Ty kabopiopévn pebodo.

3 Z0pete v emhoyn ZUpeTe yia EeKAeibwpa HETA TRV OANOKAPWON TNG
avayvwpiong mpoowmou () Yia Va EVEPYOTIOIOETE TN A&Toupyia.

Evioxuon ¢ Avayvwplong mpoowiou

Mriopeite va amoTpéPete To EeKAEIBWA TNG CUOKEUNG Ao GWTOYPAPIES, EIKOVES

1 Bivteo.

1 NatAote O > PuBpioeig> Kheibwpa 006vng & ac@dleia > Avayvapion
TIPOCGWTIOU.

7 Zekheldwote Ty 006vn cUPQWva pe Ty kaBopiopévn pébodo.

3 Ta va evepyoToIRoETe T SuvaTdTNTA, CUPETE TO PUBUIOTIKG OTNV EMAOYH
Avayvwplon Tpocwou yia mpoxwpnuévous OD).

E + HTtayUmta g Avayvwpiong mpoowrou pmopei va pelwdel dtav
EVEPYOTTOINOETE QUTHV Tr SuvatoTTa.
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Aertoupyia moAudigpyaciag

066vn npoécpaTwv XpRoEwv

Mropeite va Seite TIC 080VES TwV EQAPHOYWY TTIOU XPNOIUOTOIoaTE TPdoPaTa

H€Ow TNG AEITOUPYIaC TPOEMOKATNONG.

MNa mpoPoAr) TG NioTa Twv TPOOPATA XPNOIHOTOINUEVWY EQAPHOYWY, TIATHOTE TO

[] amoé ta MRKTEA arig TG apxIKNG 08évne.

« (O > PuBpioei> MpoBolr > Mpappur Morynong > Xelpovopieg kat TARKTea
Kall, 0N OUVEXELD, COPWOTE TO TANKTPO ApXIKHG 086vVNE TTPOG Ta Mavw Yia va
OE(TE TO I0TOPIKO TTPOCPATWV XPHOEWV.

MoA\amAd mapdBupa

Mrmiopeite va xpnotpomoleite SU0 papHOYEC TauToxpova Xwpiovtag Tnv 0Bovn

o€ moMNam\d mapabupa.

1 Amé ta nMiKTpa agrig otV apxikr 086vn, matrote []

+ Epgavifovtatl o1 mpoo@ata XpnotUoToINUEVES EQAPHOYES.

7 ZT0 TIAvw PEPOC TNG EQAPHOYAC TIOU BEAETE, TATHOTE €val EIKOVIBIO EQAPHOYAG
KaLTIaTAOTE To = yia va xpnotpomotfoete T Suvatdtnta NMoMamd
mapdbupa.

+ HemMeypévn epappoyn Ba eppavioTei 0to mavw piod g 08dévng.
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5

« [la va TpooapUOoETE To PéyeBog Twv TUNUATWY 0Tn Slaywplopévn 086vn,
OUPETE TO EIKOVISIO — OTO KEVTPO TNG 006vNG.

+ Oplopéveg epappoyég TG LG kaBwg Kat epappoyég mou éxeTe KatePAoel,
Sev umoatnpifouv T Aertoupyia MoMamd mapabupa.

AOD (always-on display, Aertoupyia
EUPAvionG mavra)

Mriopeite va Seite TNV nUEPOUNVIQ, TV WPA ) TV UTTOYPAPH OTAV N KEVTPIKY
066vn eivat oBnotn.

SUPETE TO KATW MéPog TG 08vng Always-on display yia va evepyomotrioete
Aettoupyieg omwg n kapepa, To Capture+, To Wi-Fi, ot puBpioeig you, 1o
Bluetooth®, To pAag, n HouoIkn Kat AAa.

1 Natiote O > PuBpioeig > Mpopolr > AOD (always-on display).

7 Em)\é€te v ekdva mou BéNeTe va eppaviletar kai atriote AmoBrikeuon.

Matote Ty emBupunTA €kdVa HETAEL TwV Wn@lakd pordt, Avaoyikd
POAOL, Ao poo, Ymoypaer), Hugpohdyto r Eikéva.

YUpete v emhoyn Fpryopa epyaleia & mpdypappa avamapaywyng
povaikic QD yia va MaTHOETE Ta EKOVISIA KATAOTACNC Yia Ta £PYOAEia
YPAYOPNG EKTUMWONG KAl TO TIPOYPAMMA AVATTApaYwYAG LOUOIKAG.
Matote Al Pick QD yia va Seite xprioipec minpogopieg ou Bacilovta
oto Context Awareness.

- Ta va opioete tn Xpovikr mepiodo evtdg Tng omoiag Sev Ba evepyoroleitat n

Suvarotnta Always-on display, matrjote KaBnuepvo opto Ai&ng.

Mo va evioxUoeTe T gwTevotnTa yia T Sduvatétnta Always-on display,
emAé€te Mo pwtevr 006vn.

« H pmatapia evdéxetal va eavtAnBei ypnyopotepa £V XpnOIOTOLETE TN
Aertoupyia Always-on display. Amevepyormolr|ote autryv T Suvatdtnta yia
va e€olkovoprioeTe Sidpkeia {wiig TG prmatapiag,

- Tava anevepyomnolfjoete T Aertoupyia epgdviong mévta, natiote O >
PuBpioeig> NMpoBoAr > AOD (always-on display) kat petd natrjote @ .
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INHEIDOELG Yia TIG IB10TNTEG AVTOXNHG OTO
VEPO

AuTO TO TIPOIOV €ival AVBEKTIKO 0T OKOVN KAl TO VEPO, CUMPWVA e TO Babuo
npootaciog and eloxwpnon IP68.

To mpoiov oag éxel uoPAnBei oe eENéyxoug o€ eAeyxOpEeVo TrEpIBAANOV Kalt Exel
amodelyTel 0Tt gival avOEKTIKG 0T OKOVN KA TO VEPO OE GUYKEKPILEVES GUVONKEC
(m\npoi i amartoeig e Katatagng IP68 cupewva pe To SieBvég mpoTumo

IEC 60529 - BaBpoi mpootaciag mapexopevng amd mepiPAfpata [Kwdikdg IP].
JuvOnkeg ehéyyou: 15-35 °C, 86-106 kPa, 1,5 p€Tpo, yia 30 Aemtd). Mnv ekBétete
OUOKEUN 0€ SlaQOPETIKEG OUVBNKEG amd TIC cuUVOrKeG eNéyxou. Ta amotehéopata
evoéxeTal va S1apEPOUV KATA TV TIPAYHATIKN XPron.

A MPOEIAONOIHZH

Napd tv Katnyoptomoinon IP68, n cuokeur oag dev eival adlaPpoxn o€ CUVONKEG
iou Sev €xouv eAeyyDei o€ eheyxdpevo mepiBdAlov TG LG. AdBete umown ott
TuxOV BAAREG Tou éxouv TPoKUPEL amd TETolou gidoug ouvorKeg, aldlouwy To
xpwpa tou LDI (Liquid Damage Indicator). Av To xpwpia Tou LDI tou Bpioketat
€VTAC TOU TTPOIOVTOC aANGEEL, To Tpoiov Ba mpémel va BewpnBei akatdAAnAo yia
TIC SWPEAV UTINPEGIEC EMIOKEVNC TIOU TIAPEKOVTAL CULPWVA LIE TNV TIEPIOPIOUEVN
€yYyUNon TOU TIPOIOVTOC.

AmopeUyete TV ékBeon Tou TPoIOVTOC o TepIBAAovTa e uTePPBONIKN oKOVN iy
uypaacia. Mnv xpnolpomoleiTe To MPoidv oTa mapakdtw mepiBdilovTa.

@ Mnv BubileTe To TPOIOV 0€ LYPA XNIIKA (CATTOUVL K.ATL) EKTOG amo VEPO.

@ Mnv Bubilete To TPOidV o€ aAaToUXO VEPO, CUMTEPIAAUBAVOEVOU TOU
Balacotvol vepou.

@ Mnv BuBilete To mPoidv o OePPES (IOUATIKEC) TTNYEC.

@ Mnv kohupmdte padi pe autod To mPoiov.

Mnv TomoBeteite To mpoidv ameubeiag mavw TV APO (OTWG LY. OF
W napalio) f otn Adonn.
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Mnv BuBilete To mpoidv og vepod PaBouc mavw amd 1,5 pétpo mepimou.
Mnv BuBilete To mpoidv o€ vePo yia SidoTtnpa peyalutepo amd 30 Aentd.

+ Av 10 TIPOI6V Bpayei, OKOUTIHOTE TO HIKPOPWVO, TO NXEIO KAl TO OTEPEOPWVIKO

BUopa pe éva oTeyvo mavi TPOTOU TO XPNOILOTOIOETE.

+ Av 10 TTPOIOV 1 Ta XEPLa 0aG BPaxOULY, OTEYVWOTE Ta TIPOTOU XEIPIOTEITE TO

TIPOIOV.

+ Mnv xpnotuomoleite To mPoidv o€ uépn Omou Pmopei va MITOINOTEL e vepo

uPNARG Tieanc (.. Kovtd o€ Bpuon 1 TNAEPWVO VToug) Kalt unv To Bubilete o€
vePOD yla TTapATETAPEVA XPOVIKA StaoTrpata, KabBwg Sev €xel OXeSIOOTEL yia va
QVTEXEL O€ VEPO e LPNAN TTigaN,.

AuTo T0 TIPOidV Sev gival avOEKTIKS OTIC KPOUTELG. My piXVETE TO IPOIOV KATW
Ka pnv to umoBAAeTe o€ KpoUoEeIC. H kUpla Hovada evoéxetal va umooTei
{npia ry va mapapop@wbei kat va mpokAnBei Stappor vepou.

+ O16uvaTtdTNTEG AVTOKNG TOU TIPOIGVTOC 0T OKOVN Kall TO VEPO EVOEXETAL Va

unoPabpioTouv Adyw mTwong fi kpouong.

« Av 1o Tipoidv Bpayel, xpnotpomolnote éva Kabapo, LaAaKd mavi yla va To

OTEYVWOETE OXOMAOTIKA.

+ Ho0Bdévn agric kat GAeG SuvatoTnTeG EvEEKETAL VA UNV AEITOUPYOUV OWOTE, Qv

1 OUOKEUN Xpnolpomoinbei evw eival Bpeypévn.

+ Tompoidv ival avOeKTIK 0T0 VEPO HOVO 6TaV N Brikn KapTag SIM/pvipng €xel

TonoBetnOei 6wWOTA PEGA OTO TPOTOV.

+ Mnv avoiyete/kheivete T Brikn kdptag SIM/puvAung evw To poiov eivat

Bpeypévo n Pubiopévo oe vepo. H ékBeon Tng avolyTig BriKng o vepo 1y
vypaoia evdéxetal va mpokaléoel BAAPN 0To TPOIOV.

+ H Orkn T¢ Kaptag SIM/pviping mepiéxel kKaoutooUK [ouokeuaaial, yia va

unv €10éABeL oKOVN, VEPS 1) uypacia oTo mPoidv. Mnv mpokaléoete {nuid
07O KAOUTOOUK [ouoKeuaoia], KabBwg €Tot pumopei va eloéNBeL oKOvN, VEPO 1
uypaoia oTo TPOIGV Kat va POoKANOEi {nuid.

A + Av 6ev aKoNoUBNOETE TIG TOPEXOUEVES 0ONYiES, EVOEXETAI VA KATAOTEL

AKUPN N TIEPIOPIOHEVN EYYUNON TG CUOKEUNG.

« Eav n ouokeun éxel Bpayei, ToTe To LDI péoa otn cuokeur) alalel xpwua.
Y€ QUTAV TNV TIEPITTWON, N GUCKELN SeV gival EMAEEIUN yia oTToLEaSHToTE
UTINPEDIEG SWPEAV EMOKEVNG TTOL TTAPEXOVTAL BATEL TNG TTEPIOPICHEVNG
£yYUNONG TNG CUOKEUNG.

« TMapd tn Babuoloyia IP68, n cuckeun oag Sev gival EVIEAWDG KATAXPNOTIKN
Y10 TO VEPO O OMOIAdHTIOTE KATAOTAOM.

E181kég Aertoupyieg 40



Baoikég
AEITOVUPYIiEC



E€aptiparta kat a§eocovdp Tou mpoiovtog

Ta mapakdtw otolyeia mepNapBdvovTal 0Tn GUOKEUH GO,

+ UOKeUR + Kapeitoa e€aywyng
+ ZTEPEOPWVIKA OKOUOTIKA + QopTIoTAC
+ KaAwdio USB + 08nYd¢ ypriyopng ekkivnong

A + Ta oTOIXEIO TTOU TIEPIYPAPOVTAL TTO TTAVW UTITOPE( VAl EiVal TTPOAIPETIKA.

+ Ta oTolxEi0 TOU TTAPEXOVTAL LE TN GUOKEUN Kall TuXOV Slabéotpa agecoudp
umopei va SlapéPouy, avaloya UE TV TTEPLOXT KA TOV TIAPOXO UTTNPECIWV.

« Na xpnotporoleite mavtote yviiola ageoouvdp LG Electronics. H xprion
a&eooudp ANWVY KATAOKEUAOTWY EVOEXETAI VOl ETTNPEACEL TNV amoS00n
TwV KAOEWV 0TN OUOKEUN 00 1} va TIPOKAAETEL TIPOPAfaTA KATA TN
Aertoupyia. H emokeur) evog Tétolou mpoBAHaTOg EVOEXETAL VA PV
KAAUTITETAL QMO TNV UTINPEDIA EMOKEVWY TG LG.

+ MepIKd amo Tal PEPN TNG CUOKEUNG £XOUV KATAOKEUAOTE( OO EVIOUUEVO
YUoi. EGv n cuokeur| oag méoel mavw G€ pia okANpr emM@Avela i
TIPOOKPOUGEL KATTOU e SUvapn, umopei va mpokAnBei {nwud oto
OKANPUHEVO YUONL. Z€ QUTHV TV TTEPITTTWOT, SIAKOYTE AUECWGE TN XProN TNG
OUOKEUNG KAl EMKOWVWVAOTE e éva Kévtpo e§umnpétnong mehatwv tne LG.

E « Edv Aeimel omolodrmote amd autd Ta BaCIKA OTOIXEID, ETMKOIVWVIOTE UE TOV
aVTITPOOWTIO Amd TOV OTI0I0 AYOPACATE TN CUCKEUH.

« Tava ayopdoete mpooBeta oToIKElD, EMKOIVWVAOTE pE éva KEvipo

e§unnpétnong mehatwv Tne LG.

+ Oplopéva atolxeia mou mepIAapBavovTal TN GUOKEUAGIO TOU TIPOIOVTOG

evoExeTal va aMd&ouv xwpig mpogidomoinon.

« Hepgpavion Kat ol mpodiaypagEg TG GUOKEUNG 0ag evoéxeTal va aAdgouv
Xwpic mpogidomoinon pe oToxo TN BEATILGCN TOU TTPOIOVTOC.
O1mpodiaypa@ég TG GUCKEUNG EVOEXETaL va Sla@épouy, avdhoya pe TV,
TIEPIOXN 1) TOV TTAPOXO UTINPECIWV.

+ AQaIpé0TE TV TPOOTATEVTIKY MEMBPAVN armd Tov alaBnTrpa SAKTUNKWMV
QMOTUNIWHATWY TIPOTOU XPNCIHOTOIOETE TN AElToUpYia avayvwpiong
SAKTUNKWY OIMOTUTTWUATWV.
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Emokoénnon otoygiwv

AioBnTpag Pakog PTIpooTIviig
£yyuTNTAG/QWTICHOU l Kuugpu)g (kavovikng
TepIBaAAovTog fn: 2 ywviag
gl )
DakdG PTTPOCTIVAG I I AKouoTIKO
KAPEPOAG (EUPUYWVIOG)
MARKTPa évtaong fxou (+/-) -I: o lox0c / MAiKTpO
KAEIDWHATOG
Google Assistant KA€Idi —s 086vn agric
|\ —
YTT080)1 OTEPEOPWVIKWV ! t OUpa gopTioTh/KaAwdiou USB

QKOUOTIKWV
Mikpdpwvo —

Dakdg Mow KapePag — Tt

(TnAepwroypaeiag /
YTep-upeiag ywviag / ©00Oc PAag

Kavovikng ywviag)

7 AloBNTAPAG SAKTUANIKWY
ATTOTUTTWHATWV

Ymodoxn kaptag —s «—— Mepioxn kepaiag NFC

SIM/pviung i
]—— Mepioxn kepaiag
acUppaTng opTIoNg
©00e————— 3 vdean dUo oBovwv
Hyeio ——— L Mikpdowvo
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A MHN €my€IPOETE VA APAIPECETE POVOL GG TO THOW KANUHHAL.
Y SlaQOopETIKN TePImTwan, evoExeTal va umooTei coBapr {nud n pmatapia
Kall 1 GUOKEUN TIOU UMOPE( va 08nyRoeL o€ umepBéppavan, Tupkaytd kat
TPAUMATIONO. TO TToW KAAUMMA KAl N HITaTapia auTrG TG CUOKEUNG Sev TIPEMEL
va a@apouvTal 1 va avtikabiotavtal amd pn KaTapTIoUEVO EMayYENUATIO.

+ Alobntrpag eyyutnTac/@wtiopou mepiBaNhovTog

- AoBntipag eyyutntag: Katd t Sidpkeia piag kKAong, o aiodntripag
€YYUTNTAC QmmevePYOTIOLEL TV 086V Kall T SuvatdTnTa agng, otav
1 ouokeur Bpioketal o€ piKpr amdoTaon armd To GWA ToU XPAOTN.
Evepyorotei Eavd tnv 066vn Kat Tn SuvatdtnTa g OTav n GUCKEUN
Bpioketat €€w amd pia ouyKekpIpEvn EPPENeLa.
AloONTHPAC PWTICHOU TTEPIBANOVTOC: 0 AICONTHPAC PWTICHOU
mePIRAAOVTOG avVaAUEL TNV £VTAOH TOU QWTIOHOU TEPIBAAoVTOG dTav gival
EVEPYOTTOINPEVN N AEITOUPYIO AUTOPATOU EAEYXOU QWTEIVOTNTAG.
« TAAKTpa évtaong xou

- Mmopeite va TPOCAPUOCETE TV £VTAON TwV AXWVY KAONG, Twv KAACEWY i
TwV €I60TOINCEWV.
Evw xpnotuomoleite Tnv KApePa, TATAOTE AmaAd KAToLo armé Ta MRKTpa
€vTaong Nxou yia va Tpapngete pa gwtoypagia. Ma ouveyeic Muelc, ayyi€te
KOl KOATAOTE TO TMARKTPO €VTaong fixou.

- o va eKKIVAOETE TNV e@appoyn Kapepa dtav n 086vn eival KAeldwpévn
QTTEVEPYOTIOINPEVN, TIATAOTE TO AMKTPO PEiwONG TG évtaong fxou (-) duo
@opéc. MNatrote To MAKTPO alénong Tng évtaong fixou (+) SUo Qopéc yia va
EKKIVAOETE TNV Epappoyn Capture+.

+ lox0¢ / NMAKkTpo KAeldwpaTOg

- Matiote ouvtopa 1o MAAKTPO GTav BENETE Va EVEPYOTIOINOETE 1 Va
QTEVEPYOTIOINOETE TNV 0006V,

- TatoTe T MARKTPO TAPATETAMEVA OTAV BENETE Va EVEPYOTIOICETE UIa
emMoyn eNéyxou Aettoupyiag.

+ Google Assistant Khel6i

- H ouokeur oag €xel Tov BonBd Google evowpatwpévo. Bpeite amavioeig
Kall Kave mpdypata otny mopeia. Na va Eekvioglg, amid mata o KA
BonBd¢ Google atnv mieupd tou TNAepwvou. Mdta kat kpata o KAed{ yia
va MARCELS Ypriyopa pe Tov BonBd cou. Ndta §Uo gopég yia va avoitelg To
Google Lens.

- Evepyomoinote 1o Google Assistant. Aeg to Google Assistant yia
AEMTOUEPELEC.
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+ AloBNTAPAC SAKTUNKGV AMOTUMTWUATWY
- EvepyomoioTe tn Aettoupyia avayviplong SakTuNKWY amoTunmwpdtwy yia
va amorotrjoete T Sladikaoia EekAeldwpatog Tng 08dvne. MNa Aemtopépeleg,
QAVaTPELTE TNV EVOTNTA Avayvwpion SaKTUAIKWY amoTumWUATwy -
Mapouaiaon.

E « Avaloya e TIg podSiaypagég TG GUCKEUNG, EVOEXETAL VA NV EMTPEMETAL N
TIPOOROCN O€ OPIOUEVEG AEITOUPYIEG,

370 TMiow PEPOC, N oUCKeLN Slabétel pia evowpatwpévn kepaia NFC. Na

€(0TE TIPOOEKTIKOI KATE TOV XEIPIOUO TNG OUOKEUNG WOTE Va amOPUYETE TV

mipokAnon BAGRNG otnv kepaia NFC A Ty KAAUYH TG

+ Mnv tomoBeteite Baptd avTiKeipeva TAvw 0T GUOKEUN i UnV KABEOTE TTAVW
0€ QUTHV. X€ avTiBetn mepimwon, umopei va mpokAnBei BAGRN otnv 08évn
agng.

« Hxprion mpootateuTikig MepBpdvng 08ovng iy agecoudp evdéxetal va
TiPOKaAéoouv aPEUBOAEG GToV alobNnTrpa eyyUTnTaG.

+ Edv n ouokeun oag ival bypr| | XPNOIUOTIOIEITAL O UEPOG UE LYPATIa, N
006vn 1} Ta Koupmd agrg evEEKeTal va unv Aertoupyolv owoTd.

MidoTe GWOTA T CUOKELN, OTIWE PAIVETAL TTAPAKATW. AV KAAUTITETE TV

OTT LIKPOPWVOU E TO XEPL, TO SAXTUAO 1y TNV IPOOTATEUTIKY Brikn 6Tav
XPNOILOTIOLEITE T GUOKEUT, UMOPE( va UNnv akoUYeTat kaBapd n ewvr 6ag Kata n
Sidpkela TG KAonG.

ZwoTo AdBog
Mikpdowvo Mnv KaAUTITETE TO PIKPOPWVO.
¢’JI‘~
\
) —a N
\ ,

AN

10
R
=

Mikpoowvo Mnv KC()\l'J'I'erETE TO HIKPOPWVO.
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Evepyomnoinon 1) anevepyonoinon

Evepyonoinon
‘OTav n OUCKEUN Eival ATIEVEPYOTTOLNEVN, TIATAOTE TTAPATETAUEV TO TTARKTPO
evepyomoinon/KAEIOWHATOG.

5 + 'Otav n oUOKEUR evepyomolLEiTal YIa TTPWTN POoPA, TTPAYUATOTOLETAL N
apxikn Slapopewon. H mpwtn ekkivnon tou smartphone evééxetal va
Sl0PKETEL TTEPIOOOTEPN WPA ATTO O,TL CUVIHBWG.

Amnevepyomoinon
MaTAOTE Kal KPATHOTE TATNHEVO TO TANKTPO EVEPYOTTOINONG/KAEIGWHATOG KAl
emAé€te Amevepyomoinon.

Emavekkivnon tng 6UoKeURG

‘Otav n cuokeur 6ev AeITOUPYE OWOTA ) GV AVTATIOKPIVETAL, EMAVEKKIVAOTE TV

aKoAoUBWVTAC TIG TAPAKATW 08nyieC.

T Notote kat kpatoTe mATNPEVO TO MAAKTPO EVEPYOTIOINONG/KAEISWUATOG
KOl TO MARKTPO HEIONG TNG £VTOONG X0V TAUTOXPOVA LEXPL N GUCKEUN Val
amevepyomolnOei.

7 ‘Otav n ouokeun emavekkivnBei, aprioTe Ta MAAKTPA.

E « Autr n Aertoupyia Sev eival Slabéoun dtav n cuokeun éxet ouvdedei atn
Sumhr} 086vn LG Dual Screen (LM-V505N).

EmMoyéc eAéyxou Aettoupyiag
MoTAOTE Kal KPATHOTE ATNHEVO TO TTARKTPO EVEPYOTTOINONG/KAEIOWHATOG Kal, 0TN
OUVEXEL, EVEPYOTIOIOTE pia EMAOYN.

+ Amevepyomoinon: AevePYOTIOIOTE Tr) CUOKEUN).

+ Amevepyomoinon Kat EMAVEKKIVNOT: EMAVEKKIVEL TN GUCKELN.
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TonoBétnon tn¢ kaptag SIM

TomoBetriote tnv kdpta SIM (Subscriber Identity Module) mou oag éxet
TIPOUNOEVGEL 0 TAPOXOC UTNPETIAV YIa VA EEKIVIOETE VA XPNOILOTOLEITE TN
OUOKEUN 00,

E « [la va givat n UOKELT 00 AMTOTENEGUATIKA TTPOOTATEVLEVN amtd TO VEPS Kal
Tn oKovn, Ba mpémel va TomoBeTeiTal owoTd n BriKn KApTaC.

1 TomoBetiiote v Kapeitoa efaywyrg otny omr mou Ppioketal otnv umodoyxr
NG KAPTAG.
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3 TonoBetiote TV K&pTa SIM aTNV UTTOSOKA TNC KAPTAC ME TIC XPUOEC EMAPEC
OTPOMMEVEC TTIPOG T KATW.

E « Auti) n cuokeur) umootnpiel povo kapteg Nano SIM.

Nano Micro Kavovikr
L

« Ta amodoon xwpi¢ mMEoBAHATA, CUVIGTATAL VA XPNOLUOTIOLEITE TN
OUOKEUN e Tov owaTo TUMO TG KdpTag SIM. Na xpnaotuomoleite mavta tnv
£PYOOTACIAKNAG KATAOKEUNG KApTa SIM TTou mapéxetal amod Tov mapoxo.

« Edv tomoBetrioeTe TN Brikn KAPTAG 0TN GUOKELR 0ag eV N Brikn KapTag
€ivat uypn, n cuokeur oag umopei va umootei BAARN. Na gpovtilete mavtan
BrKn Kaptag ivat oTeyv.
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TonoBétnon tng Kaptag PvMNG

TomoBeTAOTE TNV KAPTA UVIUING 0T GUOKEUN 00C.

Avdoya e TOV KATAOKEVAOTH Kal TOV TUTTO TG KAPTAG UVANG, KATTIOLES KAPTES

MVIALING UITOPEL va PNV €ival CUMBATEG LE TN GUOKEUH 0.

T TomoBethote v Kap@itoa e§aywyrg oTn omr Tiou Bpioketal otny umodoxr
NG KAPTAG,

2 Tpapréte mpog ta £&w v umodoxn T¢ KApTac.

3 TomoBetAoTE TNV KAPTA UVAKNG 0TV UTIOS0X TNE KAPTAG KE TIC XPUTEC
EMAPES OTPAUUEVEG TIPOG TA KATW.

D
D

N

@ L Kapta SIM

Kapra pvipng i .
(TTwAEITaI EEXWPIOTA, TIPOQIPETIKE)

/I Emotpéyte T umodoxn TS KAPTag oTnv apyIkr T Béon.

A + OpIOPEVEG KAPTEG MVAUNG MITOPEL va UNV gival TAPWS CUPBATEG LE TN
ouokeun. H xprion piag pn oupBatic kaptag prmopei mpokaléoel BAGBN g
GUOKEUNG ) TG KAPTAG MVAKNG, 1 va KaTAoTpE e Ta Gedopéva mou gival
anoBnKeupéva OE aUTHV.

E «H ouyvn eyypagn kai Staypagr Sedopévwv Umopei va Pelwael Tn SidpKela
(WN¢ TG KAPTAG UVAUNG.
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A@aipgon TG KAPTAG UVIUNG

la AOyouc ao@aleiag, amevepyomoloTe TV KAPTA UVAKING, TIPV TNV AQAIPEDETE.

1 Natiote O > PuBpioeig> AmoBrikeuon >

7 TomoBetriote T kap@itoa e€aywyng otnv omr mou Bpioketal oTnv umodoxn
NG KApTag Kat émetta TPAPAETE TN BrKN TG KAPTAC TTPOE Ta £§W.

3 AQaIpéoTe TNV KAPTA PVAUNG amé Tn Brkn KapTag.

/A Emotpéyte Ty umodoxn TG KAPTag oTnv apyIkn g B£on.

A + Mnv agaipeite TV KAPTA PVARNG, EVW N CUOKEUN HETAPEPEL 1} XPNOIHOTIOLE!
Sedopéva. Mmopei va mpokAnBei amwAela iy KataoTtpogr dedopévawy, i
BAGPN TG KApTAG PVAHING 1 TG ouokeunc. H LG dev euBuvetar yia amwAeleg
TIOU €ival amOTENEGHA KAKNAG ) AKATAANANG XPONG TWV KAPTWV UVAKNG,
oupmeptAapBavopévng tng anwAelag SeSopEvwy.

Mnatapia

Odption TN prarapiag
TPV XPNOILOTOICETE TN GUOKEUN, POPTIOTE APWE TNV UraTtapia.
Oopriote T ouokeun e To Kahwdio USB tumou C.

ANayH akpodEKTn kaAwdiou =
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Mnv GUVOEETE TN OUOKEUN O EEWTEPIKO TEPHATIKO, KAAWSIO POPTIONG

1) dtav umapyeEl vypaoia. Yapye! kivduvog mupKaytdg, nAektpomngia,
TpaupatiopoL fi PAGPNG TNG CUOKEUNG. Z€ TIEPIMTWON LYPAGIAC,
OTOMOTAOTE QPEOWG VA XPNOIOTIOIEITE TN OUOKEUN KOl AMOUAKPUVETE Ta
oTolxEia Lypaoiag.

+ OpovrioTe va xpnotpomnoleite To kKaAwsio USB mou mapéxetal Ue T GUOKEUN

0ag.
Na xpnotpomoleite mavTa YopTIoTH Kat KAAWSIO POPTIoNG TTOU XUV
eykp1Bei amd v LG. H pdpTion g umatapiag Ue ¢opTioTh Tpitou
KATOOKEVAOTH Umope( va pokaAéoel ékpnén tng umatapiag i BAGRN otn
OUGOKEUN.

H ouokeun oag Slabétel eowTepikn emavagopTi{dpevn pmatapia. Ma Sikr
00G AOPANELQ, LNV APAIPEITE TNV EVOWUATWHEVN PmaTapia.

Y€ TEPIMTWON XPrONG TG OUOKEUNG VW auTr) YopTilel, evoéxeTal va
mpokAnBei n\ektpomAnéia. MNa va XpnOIHOTOIOETE TN GUOKEUT, OTAHOTHOTE
TN POpTION.

AQaIPEDTE TOV POPTIOTH Ao TV TPICa a@ol oAokAnpwBEL n EOPTION TG
OUOKEUNG. ETOL amoTpémeTal n AOKOTTN KaTavaAwaon VEPYELQG.

Madi pe to mpoidv mephapBAavetal évag mPOoapHOYENG YOPTIONG TTOU
umootnpilel Tn ypriyopn @opTion.

H Aertoupyia tayeiog pépTiong pmopei va unv Aeitoupyei eav
XpnotporolnOei GAANOG TPOCAPHOYEAG POPTIONG EKTOG TOU YVIGLOU
TIPOCAPLOYEQ TTOU GUVOSEVE TO TIPOIOV.

« 'Evag GAN\OG TpOTTOG YIa VOl POPTICETE TNV piatapia ival va ouveEceTe

€va KaAwd1o USB peta&l Tng cuoKeung Kat evog emtpamédiou 1 gopntol
uroloy1oTr. H evépyela auTr) umopei va ival mepIocoTePO xpovoBopa amod
TN QOPTIOoN TNG Umatapiag o€ emroiyia mpila.

« Mn @opriete v umatapia xpnotpomolwvrag USB hub mou dev

Suvarat va Slatnpriogl oTabepr TNV 0vopaoTIKN Tdon. Evoéxetat va unv
mipaypatonoinBei @opTion 1 va Slakorei.
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HPO(pU}\GEElC Kot m Xpnon e O'UOKEUT]C

- BeBawBeite ot ypnopomoleite To mapexdpevo Kahwdio USB. Mnv
Xpnotpomoteite KaAwdia USB fj popTIOTEG TPITWV KATAOKEUAOTWY HE TN
OUOKeLN 060G, H meplopiopévn eyyunon e LG Sev KahUmTel T xprion
a€e00VAP TPITWV KATAOKEUAOTWV.

Tuxdv aduvapia Thpnong Twv odnylwv mou mepthapBdvovTal oTo mapdv
€YXEIPIBI0 Xpriong Kat n akatdAANAN Xprion EVEEXETAL VA £XOLV WG ATTOTENECHA
v mpdkAnon BAAPNG 0Tn GUOKEUH.

AcUpuatn @opTion

H ouokeun umootnpiel T Suvatotnta acuppatng options. PopTioTe T
OUOKEUN L€ €vav EYKEKPIEVO aoUppato @opTioth Qi (mpoalpeTikd, mwAeiTal
Eexwplotd).

Doption pmatapiag pe acUPUATO POPTIOTH
T TomoBetAioTE T GUOKELN| GAG OTO KEVTPO TOU AOUPHATOU POPTIOTH, £T0L WOTE
N KEPAia acUPUATNG POPTIONG OTO TTHOW UEPOG TNG CUOKEUNG KAl O POPTIOTAG
va gival EUBUYPAUIOUEVOL.
« Ta va Bpeite TNV ePPENeLa TG KEPAIAG AOLPUATNG POPTIONG, AVATPECTE
0TNV €VOTNTA E7TIOKOTTN 0N OTOIKEIWV.
7 Otav n unatapia gopTioel MARPWCE, aPalpéoTe T CUOKEUN amd TOV QOPTIOTH.

A « ‘Otav @opTileTe TNV Unatapia oW acUPUATOU GOPTIOTH, Unv TomoBeTE(Te
HayvNTIKG, METAANKA 1) AANa aywyipa UNKA avapeoa 0T GUOKEUT Kal ToV
QOPTIOTH, KABWE auTd eVOEXETAL Va SnuIoupYoUV TAPEUBOAEG OTN (OPTION
TNG CUOKEUNG KAl 0 POPTIOTAG Mmopei va umepOeppavOei. Ze autrv T
Tepimwon evéxetal va mpokAnBei BAGBN oTn GUOKELN, TOV QOPTIOTH 1 TIG
Kapteg SIM/pvApne.
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5 « Avn Beppokpaacia tng umatapiag unepPei To kaBoplopévo 6plo Katd Tn
SIAPKELD TNG POPTIONG, N POPTION EVEEXETAL VA OTAUATIOEL.

+ Av 010 TTioW PEPOG TNG CUOKEUNG £XOUV TTPOCAPTNOE! MayVNTIKG, METOANKA
1) GAa aywyIpa OTOIXEID, 1) TTPOOTATEUTIK BriKN, TOTE N CUOKELN EVEEXETAL
Va UnV @opTiCeTal KAVOVIKA.

+ Edv @optileTe TV pmatapia pe acUPUATO YOPTIOTH OE TIEPLOXES OTTOU N
100G Tou orpaTog SIKTUOU gival XapnAr, n amddoaon SIKTUOU 0T CUOKEUH
oag evoéxeTal va HEWBE] TEpAITEPW.

+ DopTiOTE TN CUOKEUN PE Evav EYKEKPIPEVO aoUppaTo @opTioTr Qi
(mpoatpeTika, mwheital EexwploTd). H meplopiopévn eyyonon e LG
Sev KANUTTTEL TN XPron a§ecoudp TPITWV KATAOKEVOAOTWV. Mol TuyOV
TIPOPAHOTA, EMKOWVWVIOTE UE TOV EKAOTOTE KATAOKELAOTH.

+ AuTo T0 TIPOI6V UTooTNPIlel acUpuatn edpTion. PopTioTe TO TPOIGV
JE évav aoUpUaTO YopTIOTH pe motomoinon Qi (MwAeital EexwploTd).
OplopEVOL EVOUPUATOL POPTIOTEG EVOEXETAL VA UNV UTTOoTNP{(ouV acupuUaTh
@opTion. Ot acupuatol popTioTéG mou umoaTtnpiouv EPP (Extended Power
Profile) emtpémouv Tnv acupupatn @opTIoN VYNARG TaxUTNTAG.

+ HLG Electronics 6ev @épet kapia euBOvn yia mpoPAfjpata mou oxetiCovat
ue ageooudp ANwv etatpelwv. Na tétola Bépata, aneubuvbeite otov
KOTAOKEVAOTH TOU QVTIOTOLXOU TIPOIOVTOG.

Amnoteleopatiki Xprion Tng pmatapiog
H 8idpkela {wng TnG Umatapiag Pmopei va Uelwdei Gv 0Tn 6UOKEUR eKTENOLVTAL
TIOMNEG EQAPLOYEG Kall AEITOUPYIEG TAUTOXPOVA KAl OUVEXWG.
Mo va augroete n Sldpketa {wiig TG Umatapiag, TEPUATIOTE TIC AEITOUpYIEC TTOU
EKTENOUVTAL OTO TTAPACKAVIO.
Mo va eENayIoTOTOINOETE TNV KATAvAAwoN TNG LoXVOG TNG Uratapiag, akohoubnote
TIC TAPAKATW CUUBOUAEG:
+ Na amevepyomoteite n Suvatotnta Bluetooth iy Siktou Wi-Fi dtav Sev Tig
XPNOIHOTIOLEITE.
+ PuBpiote 10 Xpovikd 6plo TnG 088vng 0T HikpdTEPN SuvaTH TIN.
+ PuBpiote T pwtewotTa TG 006vng 010 EAAXIOTO.
« Evepyomoliote 1o kAeidwpa TG 006vng 6Tav Sev XpnOILOMOIETaL N GUOKEUR.
« ENéyETe Tn 0TABUN pmatapiag evw XPNOLUOTIOIEITE EQOPUOYEG TTOU EXETE
KateBaceL
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006vn agn¢

Mriopeite va e§oikelwBeite Pe TOV ENeYXO TNG CUOKEUAC GAG XPNOILOTIOIWVTAG TIG

KIVOELG TIOU UTTOPEITE VOl KAVETE e Ta SAKTUAG 0ag oTnv 006vn aQng.

Matnpa
Mathote eENa@pd To SAKTUNS GaC yia va KAVETE pia emhoyn fj va emAEEETE kat va
EKTENEDETE IO EPAPHOYH.

Mapatetapévo matnua
M0 VO EUPAVIOTEL TO EVOU e TIC SIaBETIUES EMAOYEC, ) EVEPYELD TIOU AMAITELTAL
€{val To dyylypa Kat TO KPATNUA Yio OPKETA GEUTEPONENTAL.
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A\ matnua
MatAoTe ypriyopa SU0 GOPEC yia va LEYEOUVETE 1} va OUIKPUVETE Jia LIOTOOEAISA 1y
Evav xaptn.

Metakivnon

Ayyi€te Kal kpatrioTe €va oTolyElD, OTWE Hia epapuoyn 1 éva widget Kat, 0tn
OUVEXELD, METOKIVAOTE To SAXTUNG 0ag og Ao onueio akolouBwvTag pia
e\eyxopevn kivnon. Mmopeite va xpnotpomoljoeTe auTrv Ty Kivnon yla va
METAKIVAOETE £Val OTOIXEIO.

KaBetn kO\ion

Ayyi€te v 006vn e To SAXTUNS GOC Kall ETAKIVIOTE TO YPIyopa XWPIc Kapia
Tavon. Mmopeite va XpnoILOTOINCETE QUTH TNV Kivnon yla va UETAKIVNOE(TE Ot pia
NoTa, pia 1oTooeNiBa, TIC PWTOYPAPIES, TIC 00OVES Kal ANAQ.

55
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Avotypa Kat KA€io1p0 Twv SakTUAWV

KAeioTe Ta U0 SAKTUAG 0aG YIa va GUYETE amo Wi EQAPOYH, OTIWG Yid
TapAdelypa amd pia pwtoypagia fy évav xaptn. MNa va peyeBovete Kamolo oTolxeio,
avoite ta SAKTUAA oag.

A « Mnv ekbétete TV 006vn agrig og umepBolika Suvatolg Kpadaopoug.
Mmopei va mpokAnBei BAGBN otov aloOntrpa agic.

E « XemepImwon XPriong TG CUCKEUNG KOVTA OE HAyVNTIKO, METAANIKO 1y
QywyLpo UAIKS, n 086vn a@rig VEEXETAL VA UNV AMOKPIVETAL.

Y& MePIMTWON XPriong TNG CUOKEUNG KATW A6 £VTOVO PWTIOHO, OTIWG TO
Apeco NNaKoO Gug, n 086vn pmopei va pnv givat opatr, avaloya pe T Béon
0aG. XpnOIHOTIOLEITE TN CUOKELN OF pial OKIEPH TomoBeaia r pia TomoBecia
E HETPIO QWTIONO, OE EVTOAON TIOU APKEL yia TNV avdyvwon evog BiBAiou.

« Mnv matdre mdvw oty 006vn pe umepPoNikr Suvaun.

« TotAote amald pe To SAKTUNG oag TV emAoyr TTou BENETE.

O éNeyx0G aPrC EVOEXETAL VO LNV AEITOUPYATEL CWOTA OE TIEPITTWON TTOU

(POPATE YAVTIA I} TTATATE IE TO AKPO TOU VUXIOU Ga.

0 é\eyxoc aQriG eVOEXETAL VA NV AEITOUPYHOEL OWOTA Qv 0TV 086VN €xel

OXNMATIOTE( bypacia.

« HoB6vn agrig evdéxeTal va pnv AEIToupyei GwoTd £V 0T OUOKEUN €XEL
TonoBetnOei mpootateuTikn pepBpdavn i aecoudp mou mpopunBeutrikate
amnd TpiTo KataoTna.

+ H eupavion piag oTaTiKG EIKOVAG Yia TTOPATETAMEVA XPOVIKG SlaoTrpaTa
umopei va 08nynoel otn Snpioupyia HETEIKAOHATOG 1 EI6WAOL 0TV 086V,
AmevepyorolioTte Tnv 086vn 1) ano@uyete Thv mPoBoAr| Tne idlag ikdvag
yiat peydho Sldotnpa otav Gev XpnGILOTIOIETE Tr) CUOKEUN.
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Apxikn 086vn

Apxkn 006vn - Mapovaiaon

H apykr) 08évn gival To onpeio ekkivnong yia tnv mpoopaocn o S1apopeg
ettoupyieg kat epappoyég ot ouokeun oag. Matriote o koupni O oe
omoladnmote 086vn yia va petapeite aneubeiag otnv apxikry 08ovn.

Mriopeite va SlaxelploTeite ONeG TIC EQapuOYEC Kat Ta widget otnv apykri 08dvn.
JUpeTe T0 SAKTUNG 0ag 0TV 086vN TIPOC Ta aploTePd 1y Pog Ta Se€1d yia va Seite

ONEC TIC EYKATEOTNUEVES EPAPIOYEC LE JIa HaTIAL

Adra&n apxikng 086vng
Mriopeite va Seite ONe TIC EQOAPHOYEC Kall VO OPYAVWOETE Tal widget kat Toug
(QaKENOUC 0TV apxIKr 006V,

Ipappn katdotacng — NN
T L LA

idget aipot 4._

G v Re=—— [pa@Ik6 GTOIKEID
Avadritnong Google

Ddkehog —e

Eikovidio oeAidag
>— Mepioxn ypriyopng

mpdoBaong
MAAKTPa agrg apxikrg 086vng — KON

E + Hapyikr 086vn evoéxetat va Slagpépetl avdAoya pe Ty TONITIKI TOU
KATOOKEVAOTH, TIG PUBKIOELG XPAOTHN, TNV €KS00N TOU AOYIGHIKOU I} TOV
TIGPOXO UTINPECIWV.
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- Tpappn katdotaong: eppavilel eikovidla KaTdoTaong, TNV WEA Kal Tn oTAdun

NG pmatapiag.

Widget KatpoU: egavion mMnpo@opiiv Kalpol Kat XpOVOoU Yio GUYKEKPIHEVN

TIEPLOXN.

- Tpagiko atoiyeio Avalritnong Google: Aaktuhoypdgnae iy pika yia va
avoielg v Avadrtnon Google.

+ Odakelog: Mmopeite va Snpioupyeite pakéNoug yla va TomoBeTeite Tnv
€pappoyn pe Baon ta emBupnTd KpiTipla.

« Eikoviblo oghidag: ppavion Tou ouvolikou aplBuou Twv KapBddwv otnv
apxIkn 086vn. Mmopeite va ayyi&ete To emBupnTo elkovidio oehidag yia va
petapeite otn oehida TG emAoync oac. Oa emonuavOei o ekovidlo mou
eppaviCel Toug KapPBASEC EKEVNG TG OTLYUNG.

- Meproxn ypriyopng mpdaBaong: TomoBeTrioTe PACIKES EQAPHOYEC OTO KATW
Uépog TG 086vN¢ yia va gival Suvath n mpdoRaon oe AUTEC amd omolovanmoTe
KOPBA TG apxIkrg 006vNnc.

+ MAAKTPa AR apxIkig 08dvng
- < emotpoen oty mponyoUpevn 086vn. K\eioto Tou mnktpohoyiou 1y

avadudpevwy mapabupwv.

- O: ayyi&e yia emotpépel oV apyikr 086vn. Na va Eekivioete Ty Google
Assistant, ayyi€te mapatetapéva.

- [ ayyite yia mpoBor piag NioTag pie T mpéo@aTa XpnOILOMOINUEVEC
EQAPHOYEC 1} EKTENEDN IO EQapPHOYNE amd T AioTa. MNa va dlaypdpete
ONEG TIC TIPOCPATA XPNOILOTIOINUEVES EQAPHOYEG, ayyi€te AIATPAOH
OAQN. TNa va xpnotpomotoeTe SUO EQAPHOYES TAUTOXPOVA HE TN
Aetrtoupyia MoAamwv mapaBUpwy, TATAOTE KAl KOATAOTE TO KOUMTT VL)
XPNOIHOTIOIEITE LIa EQAPHOYN.
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AMN\ayn Tou oTIA TwV MARKTPWY AP apXIKG 006vNng
Mmopeite va aAGEETE To OTIA Twv MARKTPWY ARG apxIKAG 006vng.
1 Natiote O > PuBpioeig> MpoBoh > Mpapur mofynong.
7 T pvBwon STYLE, KAvTe pia emAoyr avaNoya e TIG TIPOTIUACELS GO,
+ Kivnon:

MetdaBaon apxikr 080vn: ZUpeTe mMPOg Ta MAvw amd Ty KATw ywvia
NG o0dvng.
- Emotpo@n: ZUpete mpog Ta péoa amo aplotepn 1 Se€id ywvia amo
0B06vn.
MetdBaon oto NMpoo@ateg 006veG: SUPETE MPOC TA TAVW KAl KPATHOTE
amo Baon ywvia amd oBévn.
EvaAhayn epappoyég: Z0pete mpog Ta de&1d amd 1o KATw Pépog
NG 084vNG yia va PETAPEITE OTIC EQAPLIOYEC TTOU XPNOOTOIoATE
TIPONYOUUEVWG.
Kivnon kat NMAriktpa: Eivat Stabéotpa ta miiiktpa Miow <€ Kat apxIkng
0006vn¢ . Ma va Seite TIC MPOOPATEG EPAPHOYEC, GUPETE TO TAIKTPO
apXIKRG 086vNG S MPOo¢ Ta AVW.
+ Mévo miiktpa: AtiBevtaita <]/ O / E] Matjote [:] yia va Seite T

nPOOPATES EPAPUOYEC.

Ene€epyacia Twv MARKTpWY a@ig apxikng 00évng
Mmopeite va aAG&ete T Slatagn Twv MARKTPWY agrg oTnv apxikr 08ovn 1 va
TIPOCOETETE OUKVA XPNOILOTOLOUUEVES AEITOUPYIES OTNV TIEPLOXT| TWV KOUUTTIWV
agriG TNG apxIKrG 0BovNG.
Natiote O > PuBuioeig > NMpoBoAr > Mpappr morRynong > ZuvSuaoudg
TMARKTPWV KAl TTPOOAPUOOTE TIC pUOUICELC.

- TMapéxovtal apketég Suvatotnteg, dmuwg ot Eildomoinon Kat n epappoyn

Capture+. Mmopouv va mipooteBouy éwg SU0 akOua OTOIKED.
ra

L iy @J

)

< [©] a
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Ewkovidia katdotaong

Otav umdpyel pia idomoinon yia éva adidaoTo privuua, éva cuppav
nuepoloyiou 1 umvntripy, N ypappn katdotaong epgaviel To avtiotolyo
elkoviblo eidomoinong. EAéy&Te TNV KaTAoTaon TNG GUOKEUAG 0OC UECW TWV
elkoviSiwv e1domoinong mou eppavifovtal 0T ypauur Katdotaong.

Aev undpyel oripa

H petddoon dedopévwv mpaypatomoleitat péow SIKTUOU

[c] ‘Exet pubpiotei unvntrpt

ng ‘Exel evepyoroinOei n Aerroupyia ddvnong

b4 ‘Exel evepyoroindei 1o Bluetooth

YUvdeon pe umohoyloTh péow USB

Y140un unatapiag

AerToupyia TACNG EvepyoToiNpévn

AvamdvnTteg KAAOELG

‘Exet ouvdeBei To Wi-Fi

‘Exel evepyoroinBei n Aerroupyia oiyaong

' ‘Exel evepyoroinOei 1o GPS

(0] ‘Exel evepyoroindei To gpopnTto onueio mpdoBaong

N Aev undpyel kdpta SIM
N

H Aerroupyia NFC givat evepyomoinpévn

E + Oplopéva amo autd ta eikovidla evogxetal va epgpavifovtal S1a@opeTIKA iy
va pnv pgavifovtat kaBoAou, avahoya LE TV KATAOTACN TNG CUOKEUNG.
AlaBaoTe Ty meplypagn Twv eikoviSiwv avaloya He To mePIBANOV Kat Thv
TIEQLOXT| OTTOU XPNOIHOTIOIETE TN GUOKEUN KOl TOV TIAPOXO UTTNPETLWV.

+ Ta ekovibla mou epgpaviovtal evdéxetal va Slagépouv avaloya HE Thv
TIEPLOXI) KL TOV TTAPOXO UTINPECLWV KIVNTHG TNAEQWVIAG,
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Mivakag eldomoioewv
Mmopeite va avoiete Tov mivaka e60moIoewv CUPOVTAG T YPAUU KATAOTAONG
TIPOG Ta KATW 0TNV KUpla 08dvn.

« Mmopeite va oUpEeTE MPOE T KATW TO APdBupo E160MOICEWVY 1 VO TIATAOETE
T0 €IKovidlo BENoug yia va avoifete T AioTa pe Ta elkovibia ypriyopwv
pubuioswv.

Mnopeite va matroete /9 yia va mipocbEoeTe, SlaypaypeTe 1 TAKTOMOOETE Ta
elkovibla 0To mapabupo eI8OTOICEWV.

Edv matroete mapatetapéva 1o €ikovidlo, Ba eppavioTei n 006vn pubuicewv
yla TV avtioTolyn AtToupyia.

E « Mmopeite va XpnoILOTOICETE TOV TivaKa EI60TOICEWY aKOUa Kal dTav
n 086vn eivat KAelSwpévn. ZUPETE ToV Tivaka EI50MOIRCEWVY VW N 086vN
eivat KAeldwuévn, yla va amoKTHoETE ypriyopn mpooRacn oTig SuvatotnTeg
TIou BéNETE.
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Evalayn otov mpocavatoAoué g o0dévng

Mriopeite va opioete va aAAalel auTOpaTa 0 TPOCAVATONOMOC TG 086vNng
QVANOYQ [IE TOV UOIKO TIPOCAVOTONGHO TNG CUCKEUNG.

2oV mivaka eidomotjogwy, emAEETe Mepiotpo@n amd tn Aiota Twv elkoviSiwv
ypryopnc mpoéofaong.

EvaMaktikd, matiote O > PuBpioeig > MpoBolr kai evepyorotrjote v emhoyn
Autépatn mepLotpo@r 000vng.
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Ene€epyaaia tng apxikng 00ovng
SV Apxikr) 086vn, ayyi€Te Kal KpaToTe O€ éva KEVO OnEio Kal, 0T CUVEKELD,
€MAECTE TNV EMOUUINTY EVEPYELD OO TIG TIOPOKATW.

+ Ta va aAagete ™ Sidtaén Twv kapddwv otnv apxiki 086vn, matiote
TapateTapéva mavw o€ évav KapBd Kat CUPETE Tov o€ pia ANAN Bon.

- Ta vampooBéoete éva widget otnv Apxikri 086vn, ayyi&te éva kevo onpeio TG
ApxIkric 086vng kat kpatriote To emAéyovtag Widgets.

« Tava aMdete Tametoapiec, Bépara, eikovidia kat AOD, ayyi€te mapatetapéva
i Kevi TIEPLOXN TNG apXIKAG 080vNng Kal, oTn cuvéxela, emAécte Povto &
Oépa.

Mropeite emiong va natioete O > PuBpioeig > MpoBohi > DévTo & Oépa
emAéCTe Tanetoapiec, O€pata, elkovidia kat AOD, yla va EQapUooTel 0Tn
GUOKEUN.

+ Ta va Slapop@uoeTe Tic PUBUIcEIG TNG APXIKAG 088vNG, ayyi€Te €va kevo
onueio TG ApXIKRG 006vVNG KOl KPATAOTE TO EMAEYOVTAG OTN GUVEXELD
PuBpioeig apxikric 006vng. Na Aemtopépeleg, avatpéCte 0Tny evoTnTa
PuBuioeic apyikric 086vng.

+ Ta va Seite 1) va YKATAOTACETE §aVA TIG LN EYKATEGTNHEVES EQAPLOVES,
ayyi€te éva kevo onpeio Tng ApXIKNG 006vNG Kat KPATAOTE TO EMAEYOVTAG
Tkoumidia epappoy. a AemTopEPELES, avaTpECTe 0TV evotnTa ZKoumidia
EQPapLOYwWV.
la va aMGEeTe T mpoemileyévn 0006vn, ayyi€Te Kal KOATAHOTE HIa KEVH
mieptoxn TG ApXIKRG 086vNng, uetakivnOeite otnv emBupnTr 086vn, ayyi€te 1o
koupri 1Y, kail 0T ouvéxela ayyi€Te TNV 086vn yia GAn pia eopd.

MpoeTiAeypévn 006vn
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MpofBoAn Tov Béuarog pévtou
H mpoBoAi TG EIKGVAC POVTOU €ivat SuvaTr LOVO e TNV amdKpuyn Twv
€QAPUOYWV Kal Twv widget otnv apxikri 086vn.
AmA\WOTE Ta SUO SAKTUAG 0ag OTNV apXIKr 08N,
- T va emoTpéPeTe 0TNV apxIKr 000VN LE TIG EQAPUOYEC Kal Ta widget, evioTe
Ta GAKTUNG 00C EVG) TOl AKOUUTTATE GTNV apXIKr 086vn A ayyi€te To koupmi <.

Metakivnon epappoywv aTnv apxikr 086vn
TNV apxIKf 006vn, TATHOTE MAPATETAUEVA TTIAVW OF L0l EQAPHOYN KOl CUPETE TV
o€ Jia AA\n Béon.

+ [0 va KOPPITOWOETE TIG EPAPHOYEC TIOU XPNOIHOTOI00VTAL CUXVE OTO KATW
UEPOG TNG APXIKAG 0BOVNG, TIATHOTE MAPATETAMEVA TIAVW OF [ EQAPLOYR, Kal
OUPETE TNV 0TNV TIEPLOXT YPHYOPNG TPOCRACNE OTO KATW PéPOg TG 08dvne.

+ Tla va aQaipéoeTe €va €lkovidlo amd Tnv TEPLOXN YPNYOPNE TPOoRacng, oUPETE
T0 €IKoViSI0 oTnV apykr 08dvn.
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Xprion @akéAwv amd Tnv apyIikni 086vn
Anuovpyia akélwv

TNV apxIKf 006vn, TATHOTE MAPATETAUEVA TTIAVW OF MOl EQAPHOYI KOl CUPETE TV
TIAVW OE [t GAAN EQAPHOYN.
+ Anuioupyeital évag vEog PAKeNOG KAl Ol EQAPHOYEC TPOOTIOEVTAL OTOV PAKENO.

Ene€epyacia pakélwv
TNV apxIKf 006vn, ayyi€te £vav GAKENO Kal, EMEITA, EKTENEDTE pia amd TIG
OKONOUOEG EVEPYELEG.
« a va enegepyaoTeite To Gvoua KAl TO XPWHA TOU QAKENO, TATHOTE 0TO GVoUa
@aKéhou.

+ [0 va mpooBEoETe EQAPHOYES, AyYIETE KAl KPATAOTE TO EIKOVIOIO HIag

£(QAPHOYNG, CUPETE TO TIAVW AT TO PAKENO Kall, OTN GUVEXELD, AQHOTE TO.

+ [0 va aQaIPECETE JIa EPAPHOYR ammd TOV QAKENO, TATAOTE APATETAPEVA
TIAVW O0TNV EQAPHOYN KAl CUPETE TNV £§w amod Tov PakeMo. Eav n katapynOeica
€pappoyn givat n Hovadikn epappoyr oTo QAkeNo, o pdakehog Ba Katapynbei
autopara.

Emiong, umopeite va mpooBETETE 1 va aQaIPECETE EQOPHOYEC TTATWVTAG OTO
Koupri (+) Tou @akélou.

E « Aev pmopeite va aANAEETE TO XPWHO TOU GAKENOU GTAV XPNOIUOTIOIETE
Kamolo Bépa mmou €xeTe KaTePATEL

PuBuioeig apxikig 006vng
Mriopeite va TPOCAPHOCETE TI PUBHITELS TG aPXIKNG 08dvNG.
1 Natote O > Pubuioeig> MpoPohr > Apxikr 006vn.
7 Mpooapp6oTe TIC TapaKaTw pudpicelc:
- EmAé€te Apxikn oghiba: emAE€Te pia Aettoupyia amo v apyikr 08dvn.
« Tametoapio: aMAETe TV TAMEToaPIa POVTOU TG APXIKAG 08dVNG.
« E@é 006vng: emAéETe TO €€ TIou Ba epappdleTal KaTd Ty evalhayr Kappd
oTnV apxlkr 08évn.
« IxAHata eikovidiwv: emAECTe £dv OENeTE Ta glkovidla va éxouv
TETPAYWVIOPEVEG 1} OTPOYYUAEHEVEC AKPEG.

Baoikég Aertoupyieg 65



- Apiotepn) apxikn 080vn: Mmopeite va emAéCeTe Ta £pé mou Ba

XPNOLUOTIOIOUVTAL GTAV AVOIYETE TNV APXIKK 0806VN.

Ta&wopnon epappoywv avd: Seite pe molov Tpdmo TaivopouvTal oL

EQAPHOYEG OTNV apXIKr 006vn.

+ MAéypa: aMGETe T Asttoupyia avadiatagng EQapHOYwY yia TNV apxIKr
o0ovn.

+ AmOKpUYN EQAPHOYWV: EMAEETE TIG EPAPHOYEC TTOU BENETE VAl AMOKPUPETE
amoé v apxIkr 08ovn.

+ Na emrpénetat KUKAIKN emavaAnyn ApXIKwv 08ovwv: evepyorolioTte
QUTAY TNV EMAOYN YA VO EMTPEPETE TN OLVEXH KUAION 0TV apxIKn 006vn
(emoTpéPTe Péow BPOXOL oTNV MPWTN 006V YETA TNV TEAEUTAia 006vN).

5 « Auti n Aertoupyia Sev eivat Slabéoipn otav €xel evepyomoinBein
Tpogodoaia Google.

+ Avalitnon: kavte avadTnon oépvovTag mPog Ta KATw otnv Apxikr 08dvn.
- K\eidwpa apyikig 086vng: EvepyomolroTe To yia va pny yivetat
avadidtaén r) amopdkpuvon epappoywy Kat widget.

KA&idwpa 006vng

Mapouaiaon kKAeldwparog 006vng

H 086vn Tn¢ OUOKEURG 0OG ATEVEPYOTIOLEITAL KAl KAEIOWVEL AUTOUATA OV TIOTHOETE
70 M\AKTPO Aettoupyiag/kheldwpatoc, To iSlo oupPaivel emiong kail OTav n GUKeUH
Tapapeivel og adpavela yia éva kaBoplopévo Xpovikd Sldotnua.

Eav matroete 10 MAKTPO evepyomoinanc/KAEIOWHATOE XwpiG va €XEL
evepyoroinOei 1o KAeibwua 086vng, Ba epgavioTel autopata n apyikr odovn.

Mo va e€ao@aNioeTe TNV A0PAAEIQ TNG CUCKEUNG KAl VO AMTOTPEVETE AVemOUUNTN
TPOGRAON G AUTH, EvEPYOTTOINOTE TO KAEidwHa 086vNnG.

E + To KAeibwua 006vNC amOTPEMEL TNV TIEPITTH EI0AYWYI| EVIOADV AQRG OTN
GUOKEUN Kal MEIWVEL TNV KATavAAwon 1ox00g TG Pmatapiag. Zuviotdtal
VOl EVEPYOTIOIOETE TO KAEISWHa TG 006vNG 6Tav SV XpnOILOTOIETE TN
OUOKEUN.
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PUBuIoN KAE1dWaTog 006vNng
AlatiBevTal apKeTEC EMAOYEC Yia TN SIOUOPPWON TwV PUBUICEWY KAEWSWUATOC TG
0Bovng.

1
2

Natiote O > PuBpioeic > Kheidwpa 086vng & acpdheta > AoNé€te

KA&idwpa 006vNg Kal 0T cuvéxela EMAEETE TN PEB0SO TTOU TIPOTIUATE.

MpooapudoTe TIC TapaKATw PUBUICEIS:

« Kavéva: amevepyomoinon Aettoupyiag KAeildwpatog 08ovne.

+ JUPETE: 0aPWOTE TNV 006VN yia va EEKAEIOWOETE TV 086V

+ Knock Code: la va Eekheidwoete Tnv 006V, oxnUatioTe pe 1o SAXTUAG 0ag
70 poTifo mavw otnv 066vn.

- Morifo: oxediaote éva potifo yia va EekNeldwvete Tnv 006vn.

+ Kwd1Ko¢ KAEISWHATOG: E10AYAYETE évav aplOUNTIKO KWSIKS POoRaong yia
va ekAeldwoeTe TV 004vn.

- Kwdkog mpooPaong: loaydyete évav aApapiBpntikd kwdikd mpdofaong
yia va EeKNeldwoeTe Ty 006vn.

+ AakTtul Amotunwpata: EEKAEISWOTE TNV 006V XPNOIUOTIOIWVTAG TO
SOKTUNKO 0O amoTUMWHA.

Emtpénetal xprion Avayvwplion mpoowmou: =ekKAEIOWaoTe TNy 086vn
XPNOIHOTIOIWVTAG TV avaYVWPLOT TIPOCWTTOU.

E + Metd and 5 eo@alpéveg amomelpeg EEKAEISWHATOG TNG OUOKEUNG, N 086vn

um\okdpel yia 30 SeutepolenTa.

PUBuon acpalol¢ ekkivnong
Otav, we pébodo kheldwpatog 08évng, emiéyete Knock Code, Motifo, Kwdikog
KAEISWuaTog 1) KwSIkAg mpooRaong, UMOpEiTe va SIaHOPQWOETE Tr GUCKEUN 0a¢
WOTE VA KAEIGWVEL OTIOTE TNV EVEPYOTIOIEITE WOTE VO TTPOOTATEVCETE T SESOEVA
oag,

+ Méxptva EekNeIOWOETE T OUOKEUN 0ag, SeV PITOPEITE VAl XPNOIHOTIONOETE TIG

AEITOUPYIEC TNE EKTOC amd TIC KAMOELG EKTAKTNG AVAYKNG.

« Yemepimwon mou EexdoeTe Tov KwdIKO mpooBaong yia Ty

AmOKPUMITOYPAPNON, dev Ba UMOPEITE VA EMAVAPEPETE TA KPUTTTOYPAPNUEVA
Sedopéva Kal Ta TPOOWTTIKA OTOIKEID 0aC.
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Mpo@uldéelg yia t Sduvatdtnta ac@alol¢ eKKivnong

- Yemepimwon mou EexdoeTe Tov KwdIKO mpooBaong yla Ty

QIOKPUTTITOYPAPN 0N, Sev Ba PMOPEITE VOl EMAVAPEPETE TA KPUTTTOYPAPNUEVA

Sedopiéva Kal Ta TPOOWTIKA OTolXEla 0.

Oulaooete Toug kwdiKoug TPOoBaong yia 1o KAeidwpa 086vng EexwpioTa.

Av MANKTPOAOYNOETE E0PAAUEVO KWOIKO TTPOOBACNS TTEPIOOOTEPEC

(POPEC OIS AUTEC TIOU £XOUV OPIOTEL, N GUOKEUN TIPAYUATOTOLE] AUTOHOTA

EMAVAPOPA OTIC EQYOOTACIAKES PUBITELS Kal SlaypapovTal auTopaTa

TUXOV Kpuntoypagnuéva dedopéva Kal TpooSWIKES Gag TANPOPOPIES, XWPIC

SuvatétnTa AvaKTNoNG.

Na €ioTe MPOCEXTIKO{ KATA TNV €l0aywyr Tou KwdiKou TpdoBacng yia 1o

KAeibwpa Kat To EekAeidwpa TNE 000vVNC, £TOL WOTE va NV El0aydyeTe

€0QANUEVO KWOIKO TIEPIOTOTEPEG POPEC O AUTEC TIOU £XOUV OPIOTEL

+ 'OTav evVEPYOTIOLEITE TN OUOKEUN Yla TTIPWTN YOPA AUECWG META TNV EMAVAPOPd,
EeKIvael TaUTOXPOVA Kal N KPUTTToypd@non. Av SIAKOYETE TV KPUTTTOYPA®non
auBaipeta, evoéxetal va mpokAnBei opdhua os Sedopéva. BeBaiwbeite Ot €xel
olokAnpwBei n emavagopd.

Mapapetponoinon KAeWdwpatog 006vng KAEIdwaATOG

Mriopeite va TposappOCETE TV 006V KAEISWUATOG.

1 Natote O > PuBpioeig> Kheibwpa 006vng & acpaheia >
Mapapetpomnoinon KAWOwuatog 086vng.

7 Em\é€te wia Aerroupyia mou BéNete va puBpioeTe.

- Tametoapio: Xag EMTPEMEL VA OPICETE TO POVTO yla TV 086vN KAEISWUATOC
0ag.

+ PoMGt: Zag emrpémel va opioeTe oL va TOMOBETAHOETE TO POAOL 0TV 00vn
KAeLdwpaTog,

+ TUVTOUEVOEIG: G EMTPEMEL VA EMAEEETE TNV EQAPHOYN TTOU Ol EKTENEDTEI
otnv 086vn KAedWHaTOG oac. AuTh n pUBHION gival opatr POvVo OTav Exel
0ploTei T0 KAEidwua 086vne.

+ Kivoupievn €1kova Katpou: Evepyomolrote autiv Ty mAoyn yia va
EUPAVIOETE KIVOUpEVa OxéSIa kalpoU yia Tnv Tpéxouaa Béon otnv 006vn
KAEWBWHATOG,

+ ZTOlKEI0 EMAPNG GTNV TTEPIMTTWON AMWAELAG TOU TNAEPWVOU: ZaC Sivel
n SuvatdTnTa va opiceTe Keipevo oTnv 086vn KAEWSWHATOG yia va
TIPOOSIOPICETE TOV KATOXO TOU TNAEQWVOU.
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PuBpioeic ao@alol¢ KAEIdbwuaTog
Mriopeite va opioete aopaleic pubpioelC KAeWGWPATOC,

1 Natiote O > PuBpioeig> Kheibwpa 006vng & ac@aleia > Pubpioeig
ao@alolg KAEWSwpaATOC.

7 Em\é€te wia Aerroupyia mou BéNete va puBpioeTe.

Na @aiverat o potifo: Zag divel Tn Suvatotnta va eppavilete 1o poTifo.

XpovodiakdmTng KAEISWHATOG: Yag emTPEMel va puBUifeTe TO XPOVIKO
S1éoTnua TPV TO AUTOUATO KAEISWHA TNE 006VNE aPoU KAEIOETE TOV
omioBlo PWTIoUO (XPOVIKO 6plo Adyw adpdvelag).

To koupmi tpo@odooiag KAeldwvel oTiypaia: Evepyomolote autr v
emAoyn yla va KAeISWOETE apéowg Tnv 006vn 6Tav TMECETE TO KOUKTT
gvepyomoinong / KAeldwpatog. Autr n puBuion uneploxVel TG pUBUIoNG
XPOVOSIAKOTTN KAEIOWHATOC A0PAAEiQG.

Epgavion emMoyn KAeSwpaTog: Lag emtpémel va ePeavileTe Tnv emhoyn
TOU MevoU LoxUOG YIa TV amevepyomoinon idomotogwy otnv 086vn
KAELBWHATOG, TNV AMEVEPYOTTOINGN TOU £EUTVOU KAEIOWHATOG KAl TWV
BlOPETPIKWY KAEIBWUATWV.

+ Smart Lock: Zag divel tn Suvatdtnta va opioete afldmoTn CUOKELN,

TomoBeaia, Guwvr Kat / 1} avixveuon oTo WA TIou Ba eMTPEPEL 0TO
TNAPWVO 0ag va mapapével EEKeISwEVo.

« To kAeidwua 006vNng pevol Tiou emMAEYETE Popei va SLlaépeL avaloya UE
TIG ueBddoug 006vNG.

KnockON

MropeiTe va EVEPYOTIOINTETE I VO ATEVEPYOTIOINOETE TNV 006VN pe SIMAS maTnpa
mavw TG,

5

« Auti n emoyn eivat Slabéoiun pévo atnv apxikr 086vn g LG. Aev
AerToupyei owoTd o€ Kamola E181KN EQapuoyn EKKIVNONG 1) 0TV apxIKn
006vn mou éxel eykataoTabei amd Tov Xprotn.

« Tla va matioete v 086vn agrig, xpnotpomolroTe To SAKTUAS oag. Mnv
XPNOILOTIOLEITE TO VUYL 0OC.

« Ta va xpnotpomoiroete tn Aeitoupyia KnockON, BeBaiwbeite 61 0
aebnTpag eyyutnTag/ewtiopou dev eumodietal amd KAmolo autokOAMNTO
1) G\\n &évn ouaia.
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Evepyomoinon 00dvng
MotAote pe 1o SAKTUNS oag SU0 PopEC 0TN péan TG 086vNG.
« EQv matAoeTe 0TO £MAVW 1) 0TO KATW HEPOG TNE 006vNG, 0 BabBudC avayviplong
NG Kivong evOEXETal va PNV ivall EMAPKNG.

Angvepyomnoinon 006vng

Ayyi€te pe 1o SAKTUNG 60 SU0 PoPEC TTAVW O€ €va KEVO onueio oTnv ApXIKH
066vn kat otnv K\etlbwpévn 0Bovn.

Eva\akTikd, matrote SU0 popEg o€ évav KEvVO XWPO 0T YPauHI KATdoTaong.

Anevepyomoinon KnockON
Edv ev BéNete va xpnotpomoleite T Aertoupyia KnockON, kavte Ta e€A¢:

Natote O > Pubuioelg > Enektaoeig > KnockON Kat GUPETE T0, WOTE va
QIEVEPYOTIOINOETE TN AEITOLpYia.

Knock Code

Mmopeite va Eekheldwoete TV 006vn SnpioupywvTag Tov Siké oag Knock
Code.Otav n 086vn €ivat KAelbwpévn, pumopeite va €xete ameubeiog mpoopaon
otV apxIKr 086vn maTWVTaC MAvw 0TV 086V Hia CUYKeKPIEVN akohoubia
XTUTTNUATWV.

E + Mmopeite va xpnotpomoiroete 1o Knock Code padi pe Tn Asttoupyia
Evepyomoinon 08évne.
« Mnv &exvdre va xpnaotpomoleite To SAKTUAG 0aE yia To TTATNA TG 006vng.

Anpovpyia Knock Code

1 Natmote O > Pubpioeig> Kheibwpa 086vng & acpdheia > Aohé€te
KAgidwpa 006vn¢ > Knock Code.

7 Ayyi€te ta tetpdywva pe T ogipd ou BENETE yia va SnpioupyroeTe évav
Knock Code kay, émetta, ayyi§te Emop.

3 Karaywpiote Eava tov Knock Code mou Snpioupyroate yia va tov
enmaAnBevoete kat ayyite ENIBEBAIQXH.
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Zekheidwpa tng 000vng pe Knock Code

Zexheldwote v 086vn mMinktpohoywvtag Tov Knock Code mou éxete
SnuioupynoeL.

MAnktpohoyrote Tov Knock Code otnv 086vn agnig dtav n 08évn eivat
QTEVEQYOTIOINHEVN.

- Mmopeite emiong va elcayayete évav Knock Code 6tav n 086vn kAeldwpaTtog
lval evepyomoinpévn.

Kpumrroypagnon kaptag pvipng
Mrmopeite va KpUTTTOYPa@rOETE Kal Va TTPOOTATEVCETE Ta Sedopéva Tou
amoBnKevovTal 0TNY KAPTA UvAHNG. Agv givat Suvatr n mpoopacn amo AMn
GUOKEUN 0T KPUTTTOypa@npéva SeSopéva oTnv KAPTA VARNG.
1 Natiote O > Pubpioeig> Kheibwpa 006vng & acpdleia > Kpumrtoypagnon
& Slamotevutiipla > Kpuntoypdagnon kdptag SD.
7 NaBaoTe TV apousiaon yia Ty KpUntoypa@naon The KAPTAC JVHUNG TTou
epaviCetal otnv 086vn Kal TATHOTE ZUVEXELD VIO VO GUVEXIOETE.
3 Evepyomotote pia emoyn kai ayyiéte Kpunrtoypagnon:
+ Kpuntoypdgnon véou apygiou: yla va KpUTToypa@roeTe Hovo
Ta 6edopéva Tmou amoBnKeUTNKAV 0TNV KAPTA MVAUNG META TNV
Kpumtoypdagenon.
+ MAPNE KPUTTTOYPAPNON: YIa VO KPUTTTOYpa@roeTe OAa Ta Sedopéva mou
€lval amoBnkeupéva oTnv KApTa pvrpng tn dedopévn oTiyun.

E€aipeon apxeiwv mOANUPEOWV: yla VO KPUTTTOYPAQHOETE ONA TA APXEID,
€KTOC AMO APXEiD TTONUHESWVY, OTIWG APXEIQ LOUOIKAG, PUTOYPAPIWY Kal
Bivteo.
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5 + MONG §eKIVOEL N KPUTTTOYPAPNGN TNG KAPTAG UVAHING, OPIOHEVEG AEITOUPYIES
kaBiotavral pn Slabéotpeg,

« Edav n ouokeun amevepyorolnBei evw n kpurrtoypdenon Bpioketal og eEENEN,
n Sladikacia kpUMTOYPAPNONG Ba AMOTUXEL KAl EVOEXETAI VA KATACTPAPOUV
oplopéva dedopéva. MNa autd, IV EEKIVATETE TNV KPUITTOYPAPNON, EAEYETE
KaTd OO0V N 0Tabun TG pmatapiag eivat EmapKic.

+ Takpurrtoypagnuéva apxeia eival TpooBAaotpa LOVO amo Th GUOKELK TNV
omoia ylve n KPUITOypAPNOr TOUG.

+ H kpuntoypa@npévn kapta pvipng Sev pmopei va xpnotpomnoinBei oe
@M\ ouokeur LG. MNa va pnoIHOTIOIOETE TNV KPUITTOYPa@npévVn Kapta
MVAUNG O€ Kamola GAAN GUOKEUR KIVATOU TNAEPWVOU, TIPEMEL VOl EKTENETETE
pop@oroinon Tng KAPTaC.

+ Mmopeite va EVEPYOTIOINCETE TNV KPUTITOYPAPNON TNG KAPTAG UVAKNG OKOHA
KL Otav Sev umdpyel KapTa Vg otn ouokeur). Kabe kdpta pviung mou 6a
TomoBetnOei ueTd TV KpumToypdpnon Ba KpumToypaPEiTal AUTOUATA.

AQYn oTiypotunwy

Mrmiopeite va SnpioupynoeTe oTyoTuUTIa TG 006vnG mou BAEmeTe.

Méow ouvtopeuong

MaTAOTE TAPATETAUEVA TO TARKTPO EVEPYOTIOINONG/KAEIOWHATOG KAL TO TTARKTPO
MEIWONG TNG €VTaoNG XOU TAUTAXPOovA Yia TouAdxloTov SUo SeutepoAemTa.
- Mmopeite va Seite Ta oTiypdTUna 086vng mou €xeTe TpaPrel oTov QAKeNo
Screenshots 070 pevoly ANUmOU.

Méow tnG epappoyn¢ Capture+
Evw BpiokeoTte otnv 006vn To oTtyIdTumo Tne omoiag Oéhete va Tpaprtete,
OUPETE Tr YPaWHI KATAGTAONG TIPOG TA KATW KAt TTATHOTE (2.

E + ‘Otav n 086vn €ival amevepyomoinpévn 1 KAESwévn, Pmopeite va
QMOKTAOETE MPOGRacN oTnV pappoyr Capture+ matwvtag SU0 PoPEG

TO MARKTPO AENONG TNG EVTAONG IXOU. N0l VOl EVEPYOTTOICETE AUTAV TN

Merroupyia, matiote ) > PuBuioelg > Enektdoeig > ZUVTOUEVGEIG Kat

evepyoroinote To Open Capture+.

MNa Aemrtopépeleg, avatpé€te oty evotnta Anuioupyia ONUEIDOEWY O€ Eva

oTlyptétumo o8évne.
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Elcaywyn keipévou

Xprion Tn¢ Ypaupne epyaleiwv Smart

Mriopeite va xpnotpomotrioete Slapopeg peBoSoUG e10aywynG MANKTPOAOYiou OE

éva Pépog. Mmopeite va emAé€eTe Ty emBupNT HéBodo eloaywyng amd To endvw

U€POG TOU MANKTPOAOYIOU.

1 EmAéEre n péBodo sioaywync minktpoloyiou ou BENeTe amo T ypauun
epyoheiwv Smart.

7 Natfote \/ kat emAé€te T uebodo elcaywync mou BéNete va eupaviletal oto
epyaheio Smart | aAa€te T Sidtan Twv PeBOSWV loaywyNS.

. (e —
Mpopypi —— @ © @ & ¢ @ = | © & & % @ M 6
epyaieiwv
Smart
i3 ke)

E + Oplopéveg umooTtnpi{opeves pEBodol eloaywyng evaéxetal va Slagépouv
QVANOYQ L€ TN GUCKEUN 0aG.
+  Mmopeite va EVEPYOTTOICETE I} VO ATEVEPYOTTOICETE TN AeIToupyia
epyaheiou Smart amo Ti¢ puBpicelC MAnKTpoAoyiou.

« Mmopeite emiong va xpnolpomolioeTe Tig peBOSOUE El0ayWYNG
TIANKTPOAOYIOU TaTWVTAC OTO §03.

+ ©:Mpoacbrikn emojis.
« £&3:Mpoodkn autokOMNTWY dBatap.
. @ MpooBrikn auTokOMNTWY ani.
+ U T10 minktpodyio, matote ..
- Tl va PEyIoTOMOINCETE TV AVAYVWPLON GWVNTIKWY EVTOAWY, TIPEMEL VA
WINGTe kaBapd.
- Tla el0aywyn KEWEVOU XPNOILOTIOIWVTAG TN Gwvr 0ag, BePatwdeite 6Tin
OUOKeLN 00 eival ouvdedepévn oe diktuo.
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- Tia va emhé€eTe YAWOOO yia TN QwVNTIKA avayvaplon, atiote X% >
M\waooeg oTNV 006VN PWVNTIKAE AVayvwpeIone.
- Auti n Aertoupyia pmmopei va pnv umootnpiletal, fi ot umooTnPI{OEVES
YAWOOEG EVOEXETA VO SIaPEPOUV AVANOYQ HE TNV TIEPLOXH.
« §63: MpdoPBaon ot pubpioe; mMnktpooyiou.
. : Avotyua tou diokou clip. BA. Clip Tray yia meploodtepeg MANPoQopieg.
. : Evepyomoinon tou aiwpoUpievou minKTpooyiou 6Tav xpnolpomoleite
N Aertoupyia moAamwv mapabupwv. MIopeiTe miong va PETAKIVAOETE TO
TANKTPOAYI0 0TNV emBuNTH Béon.

Méow Tou mAnktpoloyiou Smart

Mriopeite va xpnotpomoloete To MANKTPOAGYI0 Smart yia va elaydyeTe kat va
EMECEPYOOTEITE KEeiUIEVO.

Meé to mAnkTPoAdyl0 Smart, Umopeite va BAEMETE To Keipievo kaBuwg mMAnktpoAoyeite
Xwpig va xpeldletal va evaAAooeoTe avapesa oTny 086vn Kal To GUpBaTIKG
TIANKTPOAOYI0. ME QUTOV TV TPOTIO, PMTOPE(TE EUKOAA VOl EVTOTTIOETE Kall va
S10pBwoeTe AAON evw MANKTPONOVYEITE.

Metakivnon tov dpopéa

Mée o MAnKTPoAdylo Smart, UMOpEITE va LETAKIVEITE TOV Spopéa akpIBwe otn
Béon mou Béhete. Otav MANKTPONOYEITE KEipEVO, ayyiETe KAl KPATAOTE TO IARKTPO
S100TAHATOG Kat TN oUVEXEla oupeTe Se€Id iy aploTepd.

>

< Smart keyboard

E « Auti n emoyn SlatiBetat povo yia to mnktpoAdylo QWERTY.
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Mpotdoeig Aé§ewv
To mMAnKTpoAdylo Smart avalVel auTopaTa Ta HoTiBa Xpriong 0ag yia va oag
nipoteivel KaBwg MAnKTpoloyeite AEEeIC TTou xpnotpomoleite ougvd. Oco
TIEPIOOATEPO XPNOILOTIOLEITE TN OUCKEUN 0aG, TOOO TIO AKPIBE(C gival oL
TIPOTEIVOUEVEC NECEIC.

MANKTPOAOYNOTE KEIUEVO KAl TTATAOTE TIAVW OF L0 TIPOTEIVOUEVN AéEN 1y oUpETE
amald v aplotepn 1 T Se€1d MAeuPA TOU TANKTPOAOYIOU TIPOG Ta TAVW.

- Eloayayetat autopata n Aé€n mou eméyete. Aev xpetdletat va

TIANKTPOAOYNOETE £0EiG KAOE YpAupa auThG TG AEENG.

Smartphone smart  Smartphones Smartphone  Smar Sharibhohes

I'fl.lllll LI IL]]/ !

Mpoodrkn YAwoowv 0to MAnKTPoAdylo

Mriopeite va mpocbéoeTe YAWOOEC yia €i0od0 MAnKTpoAoyiou.

1 Natiote O > Pubpioeig> Zootnua > Mwoca & mMAnktpoldylo > Alayeipion
mnktpoloyiwv > MAnktpoAdyto LG > Nwaooa kat Aidra&n minktpoloyiou >
Emoyn yYAwooag.

7 Em\éETe TIC yAWOOEC TIOU BENETE VOl KAVETE SIOBEDIEC,
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Avtiypagn Kot emKOANGN

Mmopeite va amoKOYETE 1 va avTlypaPETE KEIEVO amo pia EQAPHOYH Kal, 0Tn

OUVEXELD, Va EMKONMAOETE TO Keipevo otnv ila epappoyn. H, umopeite va avoiete

ANNEC EQAPOYEC KAl VL ETIIKOMNIOETE TO KEIMEVO OE AUTEC.

1 Natote mapatetapéva og £va onueEio KOVTA oTo Keipevo mou BéAeTe yia
avTlypa®n iy amokor.

7 Zopeteta bpla @/ B yia va oploBetroete Ty epLoxr Tou Tipoopiletat yia
QVTIYPO®N 1) ATTOKOTTH.

3 Em\éCe eite AMOKOIH eite ANTIFTPAOH.
+ To Keipevo mou éxel eMAeYei yla avTlypagr| 1} AmOKOTT PooTiOeTal

AUTOHATA OTO TIPAXELQO.

/' Natfiote napateTapéva 1o mapabupo eloaywync KEMEVOU, Kal EMNEETE
EMIKOAAHZH.

E - Edv ev undpyel aTotyeio Tou éxel emheyei yia avTypagn 1y amokor, n
emMoyn EMIKOAAHZH Sev 6a epgaviletal.

Clip Tray

Otav éxete eMAEEEL pia EIKOVA 1 €va KEIPEVO YA avTlypa@r 1 AmoKoTT, TO
OTOIYEI0 QUTO AMOONKEVETAL QUTOUATA OTO TIPOXELPO Kal UMTOPE( va eMKOMNBei o€
OTIOIOSATTOTE CNUEI0 AVA TTACA GTIYHI).

1 Zto epyaheio Smart, em\é€te ().

EvaA\aKTIkG, TaTAOTE MapateTapéva To mapdlupo Eloaywyng KELEVOU, Kal

emAé€te MPOXEIPO.

7 Em\é€te Kal emKoAROTE éva oTolyEo amd To TIPOKELPO.

+ XT0 IPAXELPO UIOPOUV va amoBnKeUTOUV éwg 20 OTOIKEID.

- matfjote 1o koupri L3 yia va KAelboeTe Ta anobnkeupéva oTolyeia £T0L
WOTE Va N Slaypagouy, akOua Kal OTav UTEPREITE ToV PéYIoTo aplBpud
oTolxeiwv. Mmopeite va Kheldwoete éwg 10 oTolkeia. Na va dlaypdpete ta
KAeldwpéva oTolxeia, mpémel mpWTa va Ta EEKAEIOWOETE.

- TMatrote 1o Koupri {11] yta va SlaypayeTe Ta oTolxEla TTou £xouv
amoOnKeuTel 01O MPOKELPO.

E + H \erroupyia mpoxelpou evEEKETaL VAl NV UTTOOTNPIlETAL OO OPIoHEVEG
An@Beioeg epapuoyEg.
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Kown xprion mepiexopévou

Avanapaywyr mepLEXOpEVOL ammo AAAN cuaKeUn

Mriopeite va TpayLOTOTOICETE AvVATapaywyr GWToypapLwy, BIVTEO 1) LOUGIKAG

TIOU €XOUV AMOBNKEUTEL GTN GUOKEUN Ao pia TNAEOPAON.

T Zuvbéote v tn\edpaon kal T cLokeur) oTo ib1o Siktuo Wi-Fi.

7 Evw yivetai mpoBoli meptexopévou amo Ty e@appoyr AAUToup f Mouoiki
natote o kouuni Cg R + > Avamapaywyr g GAAn GUOKEU.
'Hniatiote O > PuBioeig > Tuvdedepéveg cuokevéc > Kown xprion 086vng
Ka Yetd mathote Q) yla va TNV EVEQYOTIOIOETE.

3 Em)é€te Ty tNAebdpacn otnv omoia OéNeTe va ouvSeDsite.

« Ta xprion pe ouokeury Chromecast, ot unpecieg Google Play mpémet va givat
EVNUEPWHEVEG.

MpoBoAn mepleXOHEVOU AMO KOVTIVEG GUOKEVEC

Mriopeite va Seite mepiexdpevo amd SIAQOPES GUOKEVEC, TL.Y. UTTOAOYIOTH, GUOKEUN
NAS 1} opnTr) GUCKEUN, XPNOIHOTOIWVTAS TIG EPAPHOYEG AApTOUU i} MOUOIKH.
Natiote O > PuBuioelq > TuvSebepéveg GUOKEUEG > AIAKOUIOTHG TOAULECWY,
Ka ot ouvvéxela matiote Kowvn xprion meptexopévou D) ylava v
EVEPYOTIOINOETE.

Z0vdeon TwV CUCKEVWY

YUVO£OTE TN GUOKEUN 0OG Kall Lt GAAN CUOKEUT Tou umooTnpiel Tnv unnpeaia
DLNA o0 i610 acUppato diktuo.

« BePawBeite 6t n Aertoupyia kowng xpriong apxeiwv (DLNA) ivat
gvepyomoinuévn Kal oTn SIKr) 0ag GUCKEUN Kal 0T OUVSESEUEV GUOKEUN.

AvaliTnGn KOVTIVWV GUOKEUWV

Mriopeite va Seite pia NioTa pe Ti ouokeuég DLNA mou gival ouvdedepéveg oto
{810 SikTUO EMAEYOVTAG TO pevOU = > KovTivég GUOKEUEG € KABE EQappOYN).

XPNOIOTIOIOTE TO TIEPIEXOUEVO AMO TIC KOVTIVEG GUOKEVEC OTWE Ba TO
Xpnotpomolovoate v BplokdTav oTn SIKr) 6ag GUCKEUN.

Baoikég Aertoupyieg 77



AmootoAi ) AjYn apxeiwv
Mmopeite va KAVETE Kolvr) Xprion apxeiwv HETAE TG GUOKEUNG 0ag Kat AANG
OuOKeUr¢ LG, tablet iy umoloyioTh.

AnooToln apxeiwv

TV epappoyr ANumouy, Alaxeipion apyeiwv 1 0 GAEG EQAPUOYEC, TIATHOTE
> KowvA Xpron A << Kat, 0T OLVEELD, EMNEETE LI GUOKEUH amd T NioTa KOWAG
XPriong apxeiwv.

AAqYn apyeiwv

ZUPETE TN YPOAUUI KATAGTAONG TPOG T KATW Kal TaTHoTe To Koupri Kowvi) Xprion
Apxeiov.

Edv n ouokeun oag dev umootnpilel TV Kovr XPrion apxeiwy, TATHOTE TO
eikovidio O) > PuBpioeig > Tuvbedepéveg ouokevéc > Ko Xprion Apyeiou >
SmartShare Beam ().

5 « Mmopeite va polpaleoTe apyeia U GUYKEKPIEVEG GUOKEVEG TTOU
unootnpiCouv DLNA.

Mpofoln nepiexopévou ano to cloud

Mriopeite va deite dpeoa To EPIEXOUEVO TTOU Eival amOBNKEVUEVO OTO

Moyaplacué oag oto cloud xwpic va xpetdletal va 1o APeTe 0T GUOKEULN 060G,

1 An6 ) Aertoupyia A\pmoup 1y T Aettoupyia Mouoikn eni\é€te + > Cloud.
'H am6 v epappoyn Ataxeipion apyeiwv, emié§te = > Cloud.

7 Em\é€te évav hoyaptaoud oto cloud kai ouvdebeite.

3 AmobnKeOOTE f TTPAYUATOTIOIOTE avamapaywyn ToU TIEPIEXOHEVOU TTOU
Bpioketai oto cloud.
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Mnv evoxAeite
Mmopeite va TepLopIOETE ) va ameVEQYOTTOINOETE TIC EGOTTOIATEIS YIA VA NV 0ag
€VOXAOUV Y10 €VOl GUYKEKPIUEVO XPOVIKO SIdoTnua.
Natiote o koupni O > Pubuioelg > Hyo¢ > Mnv evoyheite.
- Nerroupyia kat emAEETe TN Aertoupyia mou BéeTe:
- Movo mpotepatdtnTa: mpaypatonoteitatl Ajjyn idomotrioewy Ke fxo i
86vNnon yla TIC EMAEYUEVES EQAPUOYEC. AKON Ki GTaV €lval evepyomoinuévn
n emoyr Mdvo mpotepaldtnTa, §aKkohouBolv va nxoLv ei50moINCELG.
- Xuvolikd aBo6pufo: amevepyorolei Kal Tov Yo Kal T dovnon.
- Emoyn mpotepatotitwv: AdBeTe e160mMOINTELC Kal TIG EIGOTOINTELS YIa TIC
EMAEYHEVES EQAPOYEC,
- K\rjoeig amd: Pubpiote pia oglpd eidomomrioewv Katd T APn KAogwv.

E « Emavalappavopevn KAjon: Méoa oe 15 Aemtd, n Sevtepn kKAon amd tov
{510 kahoUvTa Sev gival olwmnEn.

- Mnvopara ané: PuBpiote pia oglpd eidomoroewy Katd T Ajpn UnNvUpATwy.
+ Xprion Mnv evoyAeite: Evepyomoinote tn Aettoupyia Mnv evoxAeite.
+ MpOrpamma: OpioTe TO MPAYPAUUA YI0l TO OTTo{0 BENETE VA EVEPYOTTOIOETE TN
Aettoupyia Mnv evoyAeite.
- BonBeia: MpoPohn T forBeiag yia ™ Aettoupyia Mnv evoyAeite.
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Xpnoipeg
EPAPHOYEG



Eykatdaotaon Kal aneykataotacn
EPUPHOYWV

Eykatdotaon epapuoywv
Mrieite o€ éva KATAoTNHA EQAPHOYWV Yia va avalnTAOETE KAl Va KATERAOETE
EQAPHOYEG.
« Mropeite va xpnotporotfjoete 1o SmartWorld, To Play Store fj To katdotnpa
EQAPHOYWV TOU TIAPOXOU UTINPECIWV.

E + [lo opIopEVa KATAOTHHATA EQAPHOYWY EVEEXKETAL VA AmaITETaAL N

Snuioupyia Aoyaptacpou Kat n o0vSEan O QUTOV.

+ Tl0 OPIOPEVEG EQOPHOYEG EVOEXETAL VA UTIAPXEL XPEWDT.

« Edv xpnotpomoleite Sedopéva Kivntrg TNAepwviag, pmopei va emPBapuvBeite
E XPEWOELG Yia TN Xprion Sedopévwy, avaloya HE To TPOYPAUMA XPEWTEWY
TIOU €XETE EMMEEEL

+ HAerroupyia SmartWorld evééxetat va pnv umootnpietat avaloya pe Thv
TIEPLOXN 1 TOV TTAPOXO UTTNPECIWV.

Katdpynon eyKatdotaong eQappoywv
Katapynote amo Tn OUOKEUN 0ag TNV EYKATACTAC EQAPHOYWV TIoU Sev
XPNOUOTOLOUVTAL TIAEOV.

AMEYKATAOTOON PE MAPATETAMEVO AT A
MoTAoTE TAPATETAMEVA OF HI0L KEVE TIEPLOXT) OTNV 08OV KAl 0TN OUVEXELD TIOTAOTE
10 € TG £Qappoyn¢ o BéAeTe va SlaypayeTe.
- Edv ot epappoyég ixav ameykataotadei T TENEUTaiES 24 WPEC, UmopEite va
TIC eyKaTAOTAOETE EaVd. MNa AeMTOUEPELES, AVATPEETE OTNV EVOTNTA ZKOUTTISIOL
EQAPLIOYWV.

AmeyKatdoTaon Ke XPron Tou pevou pubpicewv

Natote 1o koupni O > Pubuioeg > Egapuoyég & eidomotfoeig > Mnpogopieg
£QAPHOYNG, EMAECTE Lia eQappoyn Kal matioTe Katdpynon eykatdotaong.

E « Aev gival Suvatr n KATAPYNON OPICHEVWY EGAPHOYWV OO TOUG XPHOTEG.
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Katdpynon eykatdotaong epappoywy amd 1o Katdotnpa
EQAPHOYWV

Mo va KaTapyHOETE TNV EYKATACTACN HIAG EQAPHOYAG, UMEITE OTO KATAOTNHA
EQAPHOYWV ATTO TO OTTO{0 KATEBACATE TNV EQAPHOYN KAl KATAPYAOTE TV
€yKATAoTAOH TNC.

Eykatdotaon Kat Katapynon eyKataotaong EQapUoywyv
KaTd T pLOuIon

‘OTaV EVEPYOTTIOIEITE T GUOKEUN IO TIPWTN YOPJ, UMOPE(TE va KATERAOETE TIG
TIPOTEIVOUEVEC EQAPOYEC.

Mmopeite va TapaKAUYETE AUTO TO BrKA KAl VA TIPOXWPNOETE OTO EMOUEVO XWPIG
V0l EXETE OAOKANPWOEL TNV EYKATACTACH.

Zkoumibia epappoywv
Mriopeite va Seite TIC epapuoyég ou €xouv ameykataoTtabei. Emiong, pmopeite va
EMAVEYKATOAOTHOETE TIC EQAPLOYES TTOU £XOUV aMEYKATAOTABE! TIC TEAEUTaES 24
WPEG.
T Ayyi€e Sadoxika O > Miayeipion > Zkoumidia epappioy.
Mmopeite akopa va ayyi€eTe pia Kevr TIEPLOXH 0TNV apxIKr) 086vn Kat va thv
Kpatroete ayyiovtag To Kouuni Zkoumidia epappoy.
7 Evepyoroinon emBuuntric Aertoupyiag:
+ Emavagopd: emaveykataotaon eMAEyUEVNG EQAPOYAC.
- {II] : KATAPYNOTE MOVIPIA TIG OMEYKATETTNLEVES EQAPUOYEC ATTO TN GUOKEUN.

E Ol ameyKaTeoTNUEVEG EQAPHOYEG KATAPYOUVTAL AUTOUATA OO T CUCKEUN
24 MPEC UETA TNV ameyKaTdoTaor) Toug. Edv BéAeTe va eykataoTrioete Eava
TIC AITEYKATEOTNHEVES EQApPLOYEC, Ba mpémel va Ti¢ katefdoete Eava amod To
KOTAOTNUO EQOPHOYWV.

+ Auti n Aettoupyia givat vepyoroinpévn HOVO 0TV MPOEMAEYHEVN APXIK

006vn. Edv ameykabloTdte eQappoyEG Katd tn xprion tng 08évng EasyHome
1) GANOU TTPOYPANHOTOG EKKIVNONG, AUTEG KATAPYOUVTAL ad T GUCKEUN
QMEOWG KA HOVIPAL.
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ZUVTOHEVCELG EPAPHOYWV
TNV apxIkr 086vn, ayyi€Te Kat KpATHOTE MATNHEVO £val €IKOVISIO EQaPHOYNG,
onw¢ Ta eikovidia KAron, Mrivupa, Kapepa, ANumouy, PUBICELG, yia va eavioTei
10 avtioTolo pevol ypriyopng mpooBaonc. Kavte mo evkohn ) xprion
EPAPHOYWV A&IOTOIWVTAC TIC CUVTOHEVTEIS EQOPHOYWV.

+ NatAote &) yia va pubuioete Ta widget yia Ty epappoyn.

+ Matiote (§) yia va Seite TIg TANPOPOpiES TG EQAPHOYAG.

E + AutA n SuvatotnTa givat SlaBEotun MOVO YIo GUYKEKPILEVEC EQAPLOYEC.
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TnAépwvo

OwvnTikn KAjon

MpaypatomoloeTe TNAEQWVIKY KAON XENOILOTTOIWVTAG KATTOLA OO TIG
Slabéoipeg peBddoug, Gmwg TNV MNKTPOAOYNoN Tou aplBoU TNAEPWVOU HE TO
XEPL, Kat emAéyovTag pia emagr amd tn Aiota enagwv 1 T Aiota mpdo@atwy
KA OEWV.

Mpayuatomoinon KAGng amo 1o MANKTPoAGylo
T Natiote to kouuni O > (W > Khjon.
7 MpaypatonolfoTte pia KAon xpnotpomolovTag t uébodo e emhoyrg oag:
« TAnktpoloyaTe évav apiBud TAe@wvou kai matiote To koupri (®.
« Ayyi€te Kat kpatoTe €vav apiBpd taxeiag KAong.
+ AvalnTAOTE Hia EMOQH TTATWVTAG TO APXIKO YPALA TOU OVOUATOG TG
EMAQPNE 0TN NOTA EMAPWY, KAl TIATAOTE TO KOUTT Q

E « [la va eloaydyete 1o oUPPOMO «+» OTav mpaypatomoleite SieBveic KAOELS,
TIOTAOTE MAPATETAPEVA TOV APIOPO 0.

« BA. [lpoafikn ema@wv yio NemTOUEPELEG OXETIKA LE TOV TPATIO TPOOBRKNG
apIBuWV TNAEPWVOL GTN NioTa HE TIG Taxeieg KAOELC.

Mpayparomoinon KAoEwVY amo emagEg

T O>@®>Enagéc.

7 A@oU emAéEeTe Tov apIBPO TIoU BENETE val KAONEDETE a6 TN AioTa EMOPQY,
natiote &..
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Amndavtnon o€ KA\fjon

Mo va amavTroeTe O€ Wia KAON, CUPETE TO KOUWTTE t. aTnv 086vn €10€pKOUEVNG
KAfjong.
« 'Otav gival ouvEESEEVA TO OTEPEOPWVIKA OKOUOTIKE, UTTOPE(TE val
TIPAYHATOTOLEITE KA OELG XPNOIUOTIOIWVTAG TO KOUUTT KAjONG/TEPUATIOHOU
0TO OKOUOTIKG.

Mo va Teppatioete pia KAon xwpig va k\eioete Tv 08vn, matrote Sladoxika
(> PuBpioeig > Aiktuo & Internet > KAfjon > ATGvtnon Kai Teppatiopdg
KAOEWV KL, 0T GUVEXELD, EVEPYOTTOINOTE TN SuvaTOTNTA TEPHATIOHOG
KAONG e To TARKTPO TPOPodoaiag.

E « Edv evepyorotoete tv emhoyr (O > Pubpiceig > Aiktuo & Internet >
PuBpiogi> Pubpiceig kK\joewvATIAVTNON Kt TEPHATIOUOE KA|OEWY
> TeppaTiopnog KAoNG pE To MARKTPO TPOoPodoaiag, Umopeite va
TEPUATIOETE i KON TTIATWVTAG TO KOUTTE KAEWSWHATOC/EvEpyomoinong
0600 gival evepyomoinpévn n 086vn enegepyaaiag KAone.

Anoppupn kKAong

Mo va anoppieTe Wia eicepydpevn KAHon, oUpete To koupni @) otnv 086vn

€10EPXOHEVNG KAONG.

- Ta va oteilete éva privupa amdpping, GUPETE TV MAOYH PUNVOHOTOG
anoppupng () og 6An v 086vn.

la va IpooBEoeTe 1 va eme§epyaoTeite éva uvupa amdppidng, matioTe T0

kouprni O > PuBpioeig > Aiktuo & Internet > PuBpioeic kKAjogwv > Apvnon

Kol amoppiPn KAOEWV PE PAVURA > AIOpEIYN HE HVUHA.

+ Katd tnv eloepxopevn KAon, MatAoTe To MARKTPO alénong Tng évtaong
X0V, TO MAKTPO HEIWONG TNG évTaong oV i To MARKTPO evepyomoinong/
KAEISWUATOG Yia 6iyacn Tou HXou KARoNG 1 TG S6vnong 1y yia 6éon g kAong
O€ QVapovh.

'EAeyx0¢ e10€pXOMEVNG KANGNG EVW N E@apuoyn BpiokeTal
o€ Aertoupyia

Otav £XeTe pia El0EPXOUEVN KAON VW XPNOIHOTOLEITE Hia pappoyn, 6a
EUQAVIOTEL i avaduopevn €16omoinon 0To endvw PéPog TG 086vng. Mmopeite
val GeXTEITE TNV KAjoN, va TV anmoppiPeTe 1 va OTENETE prjvupa amoé v
avaduopevn 08ovn.

XPAOIUEG EPAPHOYEC 85



5 « Matfote O > Pubpiceic> Aiktuo & Internet > PuBpioeiq K\joewv >
MpooBeteq pubpioel > Eppavion pwvnTIKWY KACEWV OTAV Ei0TE GE pia
£@appoyn Kat eMAEETE Tov TPATIO e Tov omoio BéNeTe va epgavifovtal ot
€10€PXOHEVEC KA OEIG EVW XPNOILOTIOIETE HIal EQApUOYN.

« Tpémeiva éxete evepyorotrioel T floating bar av BéNete va eAéyxeTe Tig
AnpBeioeg KA oEIS xpnotpomolwvTag To floating bar evw xpnotpomnoleite
Wia pappoyn. Na mePIOOOTEPEG AEMTOPEPELEC, avaTPEETE OTO Floating Bar
- [Mapovoiaon.

MpoBoAr avamavinTwv KAoEwV

Eav undpyel avamavtntn KAjon, n YPOUr Kataotaong 0To EMavw HEPOG TG
0B86vn¢ eppavilel v €voeign X,

la va Seite oTOIXEI YA TIC AVATTAVTNTEG KA OELG, CUPETE TN VPO KATAOTAONS
TIpog Ta Katw. Evalakikg, matiote to koupuri O > (B> Apxeia katayp. KAjG.

Mpoofdoiueg Aertoupyieg katd tn didpkela KAong
Katd n Sidpketa piag kKA\jong, pmopeite va éxete mpodoRaon og mARBog
AEITOUPYIWV TTATWVTAG TA KOUUTTA IOV ppaviovtal otnv 086vn:

Ema@éc: Seite T Niota ena@wv Katd T SIdpKela piag KAjong.

Avapovny: Balet tnv Tpéxouca KAON O avapovn.

MANKTP: yla va EUQQVICETE 1 va KPUYPETE TO TANKTPOAGYIO KAONG.

Hyeio: yia va evepyomoloeTe Tn Aettoupyia nyeiwv.

Ziyaon: yla va TpayUaTomoloETe Oiyaon 0To MIKPOQWVO 0ag €101 WOTE N
@WVI} 00G VA NV OKOVYETAL GTOV CUVOUIANTH 0QG.

Bluetooth: mpowBnote tnv kKAon o€ pia ouleuypévn kat ouvSeSepévn
ouokeun Bluetooth.

. ° 1 Yl0 VO TEQUATIOETE TNV KAjoN.
-+ :mpdoPaon oe MpAoBeteg emMoyEg KAoNG.

E + Ta Sabéoipa otolyeia pubpioewv evdéxetal va Slagépouv avaloya Ue Tnv
TIEQIOXT 1) TOV TTAPOXO UTINPECIWV.
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Mpayuaromoinon TpiUePoUE KARONG
Mriopeite va mpayUaTomoIoETe KAMON G€ AN EMAQR Katd T SIGEKELD oG
KAjong mou Bpioketat o€ eEENEN.
T Katén 8idpketa piag kAfong, matfote to kouprni = > Mpoobrikn kKAjong.
2 Mnktpohoynote évav apiBpd TAepwvou kat athote To koupri .

+ O16vo K\joelg eppavifovtal oTny 086vn TauToXPOVa Kal N TPWTN KAjon

Umaivel o€ avapovn.

3 Tiava EekivAoeTe pia kAo ouvSIdokePng, ayyi€te Zuyxwveuon.

L;'] « Tla kdBe KAjon evdéxeTal va loxUEl Xpéwan. Ma TIEPICCOTEPES TTANPOPOPIES,
OUMPBOUNEUTEITE TOV TAPOXO UTINPECILWV.

Mpofoln apxeiwv KAoEWV
MNa va Seite Ta mo mpoogata apyeia kK\joewy, matiote to kovpni O > (9>
Apxeia katayp. KAfo. ETelta, Hmopeite val XpnoILOTIONOETE TIG TAPAKATW
\ertoupyiec:
+ Ta va Seite NemTOUEPEC I0TOPIKO KAOEWY, EMAEETE pia emagn. Ma va
TIPOYMATOTIOIOETE ia KAjON TIPOG TV EMAEYHEVN EMAPH, TIOTAOTE TO KOUTTE

- Nava daypdyete apyeia K\joewy, matfote = > Alaypagn.

E + H&1dpkeia KAong mou epgavietar evoéxetal va Slagépel amd tn didpkela
L0l TNV OTT0ia XPEWVEDTE. Ma TIEPIOOATEPES TTANPOYOPIES, CUMBOUAEUTEITE
TOV TIAPOYO UTTNPETILV.
Agv gival Suvatrj n amokatdoTaon Tou SlaypapuéVou I0TOPIKOU KANOEWV.
+ Ta va mpocappOoETE To PéyeBOC YPAUUATOOELPAG TWV NUEPONOYiwV
KAOEWV ) TwV EMAQWV, TETTE pe SUo SayTula fj am\woTe Ta SAXTUNG oag.

Alapopewaon Twv emAoywv KARong

Mmopeite va puBpioete Ti S1dpopeg emAoyég KAong.

1 NatAote to koupmi O > (W > KAjon 1 Apxeia katayp. kKAjo.

7 Natiote 1o koupri : > PuBpioeig KNoEwV Kay, EMElta, SIapopeuoTe TG
€MAOYEG CUHPWVA IE TIC TTPOTIUNCELS 0G.
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Mivupa

AnootoAf pnvopaTog

Mriopeite va SnIoupynoETe Kal va OTEINETE UNVUKATA OTIC EMAPES 0O
XPNOILOTIOIWVTAG TV £Qappoyn «Mnvopata.

E « [0 TV amooToA UNVULATWY 0TO EEWTEPIKO EVOEXETAL VA LIOXUOLY EMTMAEOV
XPEWOELG, M0l TEPIOOOTEPES TANPOPOPIES, CUMPBOUNEUTEITE TOV IAPOXO
UTTNPECLWV.

1 Natiote to koupni O > 6.
2 Natiote 1o koupn| G-
3 Opiote mapaAATTTN Kat SNUIOUPYHOTE £val VLA,
+ T va XpNOIHOTIOAOETE TI EMMOYEC TONUEOWY, TIaToTE ().
+ [0l va amoKTrioeTe MPOGPaoN O TPOALPETIKA OTOIKEID LEVOU, TTATHOTE TO
Koupri +.

A Em)\é€te 1o B> (AMOoTON) yia va OTEINETE TO PV,

Avayvwon pnvopatog

Mriopeite va Seite T pnvupaTa ou €XeTe AVTAANAEEL avA ETOQN.

1 Natiote to kouuni O > 6.

7 Em\é€te wa emagr armo tn \ioTa pnvupatwy.

E « ‘Otav Bpiokeote 0T AioTa pnvupdtwy fj o€ éva mapabupo cuvopiNiag,

MMOpE(Te va pUBpIcETE TO PéyeBOG TNG YPAUUOTOOEIRAG av BAeTe SUo
SayTula otV 086vN Kal T AMOUAKPUVETE 1) TANCLACETE PETAEY TOUG.
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Alapdpewaon Twv pUBUIcEWY PNVUHATWV

Mrmopeite va aM3EeTe TIC pUBITELC aVTAMAYNG UNVULATWY TOL WOTE VAl
QVTOTTOKPIVOVTAL OTIG TIPOTIUACELG.

1 Natiote to koupmi O > ).

7 Natiote o koupni + > PuBpioeig amd Tn NoTa unvupdTwV.

E « Mnopeite va em\é€ete puBpioeig yia To Tapdbupo eidomoIoEwY, ToV
amoKAEIOS KAOEWY, TNV EI60MOINGN KATAGTPOPHG, T HNVUKATA
TIONULEOWY, KT,

Kapepa

Ekkivnon tng kauepag

Mnopeite va TpaPriéete pwtoypagia 1y va eyypayete Bivieo yia va anabavartioete
ONEC TIG ACEXOOTEC OTIYUES OOG.

NatAote 1o koupmi O > [@).

5 « Tl amd t AN Hiag ewtoypagiag 1 Tnv eyypaer evog Bivieo, okoumiote
TOV QOKO TNG KAPEPAG ME Eva amahd mavi.

MPod£€Te va Pnv AeKIAOETE TOV PAKS TNG KAMEPAG HE Ta SAXTUAG Gag 1) GAAN

&évn ouoia.

+ O1ekoveg mou mep\apBavovtal og autd To yxelpidlo xpriong pmopei va
Sla@EPOLV Ao TNV TIPAYHATIK) GUOKEUN.

+ Mmopeite va mpoBANETE Kal va EMEEEPYAOTEITE TIG PWTOYPAPIEG KA TAL

Bivteo péow Tou ANumou. Na Aemtopépeleg, avatpé€te 0Ty evotnTta

Emokomnon epapuoync AAUTOUL.

Mnv xpnolpomolEiTe AUTO TO TIPOIGV Yia GKOTIOUE TTOU EVOEXOUEVWG

napaptafouvy To IBIWTIKO andpEnTo 1 Ta SiKalwpata GAAwV.
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Baoikéc Aertovpyieg otnv e@appoyn «Kapepar»

Mriopeite va TpaPriéete pwtoypagieg fy Bivreo emAéyovrag amd éva mdog

NETOUPYIWV Kat EMAOYWY KApEPAG.

1 Natiote to koupmi O > (&)

7 Notiote () yia va papriéete pwrtoypagia A matiote @ yia va eyypapete
éva Bivteo.

Miow kapepa

Myn pwtoypaepiag
T EmAé€te pia Aertoupyia kapepag Kat maTAOTE TAVw 0To BEUa EMTPEMOVTAG
0TNV KAUEPA VA E0TIAOEL EKEL
7 Matiote () yia va BydheTe pia pwtoypagia.
+ Mmopeite emiong va matroeTe To MARKTPO avénong TG évtaong nxou 1y 1o
TIAVAKTPO HEiwong TG évtaong fXoU yia va TPaPAEETE pia pwToypapia.
+ Mnopeite va TparEeTe pia wToypagia evw YPAPETe BivTEO TATWVTAG TO
® omv obovn.

E « Mmopeite va EKTENETETE TNV EQapUOYH KAUEPAG TTATWVTAG Ypryopa SU0
9opéc o mikTpo Tpogodoaiac. Matrote () > Pubpiceig > Emektdoeic>
Zuvtopeloelq Kat YeTd matrote Avolypa Qwtoypa@ikig Mnxavig yia va
TNV EVEPYOTTOINOETE.

« ‘Otav n 086vn €ivat amevepyomoinuévn 1) KAESwévn, Pmopeite va
EKKIVIOETE TNV KAUEPA TIATWVTAG SUO YOPEC TO TMANKTPO HEIWONG
¢ évtaong. Matiote O > PuBpioeig > Enektdoelg > ZuVTOHEUTEIG
kat Petd matrote Avotypa Owtoypagikig Mnxaviig QD) yia va
EVEPYOTIOINOETE.
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Eyypaon Bivieo
1 Natote O > () > Bivteo kau matiote endvw oto Bépa ou BéeTe va
€OTIAOETE.
7 Ayyi€te 1o koupmi @ yia va eyypaypete éva Bivteo.
« Ta va tpaPrdete pia puToypagia katd Ty eyypaer Bivieo, matioTe To
koupri @.
- Tiava Slakoyete mpoowpvd Ty eyypagn Bivieo, matiote to koupri @.
[0 va ouveyioeTe T eyypagr Bivieo, ATHOTE TO KOUNT (@),
Katd v eyypagr evag Bivteo, UMOpE(Te va TEVIWOETE Ny va AoeTe SU0
Saytula yla peyeBuvon r opikpuvon.

+ Katd tnv eyypan Bivteo, propeite va ayyi€ete Ty emBupnTr meploxn yla
va pUBLICETE TN PWTEVOTNTA.
3 TATAOTE TO KOUM (= yial va TEPUATIOETE TNV eyypa®n Bivteo.

Mpocappoyn Twv emMAOYWV TG KAUEPAG

Mrmiopeite va mpocappoceTe MARBOG EMAOYWV KAEPAS AVANOYA HIE TIC
TIPOTIUNOELG 0ag.

Ayyi€te To koupmi £53 oTtnv 0BvN.

E + O18108éo1peg emMoyég Slapépouv avaloya Ue TV EMAEYMEVN (LTPOOTIVA 1
TMOW) KAUEPA Kalt TNV EMAEYHEVN AEITOUPYIa KAUEPAC.

- [L]: Myn ewroypagiag oo FullVision.

+ [0]: EmAéyertic Tipég Tou Adyou SlaoTdoewv Kat To peyeBog yia T Afyn
PWTOYPAPIWV.

+ [X: EmAéyel Tig Tipég yia Ty avaluon Kat o péyebog yia tnv eyypaen Bivteo.
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Eidomolei Tov xpriotn étav ta pdtia Tou Béuatog

TupBoulég €ivat KAeLoTd 1 6tav n €1kdva ivat BoAr yia BéAtiotn
PWTOYPAPLON.

Google Lens 'Otav BpeBolv OXETIKEG TTANPOPOPIEG TNV AUTOHATN

Mpotdoeig Aetrtoupyia, Ba xpnotpomoinBei n Aettoupyia Google Lens.
Tpapa ewtoypagieg pe {wnpd xpwaTa Kat Snptoupyei
€Qé QVTIOTABIONG OKOMA KL OTAV Ol PWTOYPAPIES

HDR TpaplouvTal pe KOVTPA WG, AUTEC Ol AEIToUpYiEG
TIapéxovTal amo Ty Texvoloyia upnAol Suvauikol e0poug
(HDR) pe TV omoia ivat eEonmA\iopévn n Kapepa.

Zwvtavi Kataypayte tn Spdon mpiv kat petd T Mpn piag

puroypagia PWTOYPAPIaC.

Egappoyn 'Cheese'

TpaPrETe QWTOYPAPIES LE PUVNTIKEG EVTONEC,

EAayiotomolei To @AOUTAPIOA KATA TV KATaypagn

ZtaBepn eyypopn Biveo.

OpioTe OTL N Kdpepa Ba mapapével 0TIAOUEVN OTO
MapakohovBnon QVTIKEipEVO TIoU ayyileTe oTnv 080VN, akduN KL av autd
gotiaong Kiveital. (AlatiBetal dtav XpnoILOMOIETal N KAPEPQ LE TOV

TUTTIKO PaKO.)

TomoBsaia eTIKETAC

AmoBnkeVel T eKOva el0dyovTag Ta Sedopéva
TomoBeaiag GPS.

Eugpaviote otnv 006vn kaBodnyntikd miéypata yia Mjyn

MAéypa QWTOYPAPLWV fj Eyypaen Pivieo BAoel Twv opt{ovTiwy Kat
KATAKOPUQWV YPAUUWY avapopdg.

ﬂpooenm’] Epgaviel pia umoypagr oTiC puToypapieg.

uroypaeng

AMOBNKEUTIKOG
Xwpog

EmAé€te edv BéNeTe va amoBnKeVETE TIC pWTOYPAPIE Kal
Ta Bivteo otov Eowtep. amoB. xwpog ri otnv Kapta SD.
(AlatiBeTan otav €xel TomoBeTnBei kKAPTA UVAUNG).

Bonfsia

Mapéxel BorBeta yia kdBe pevou Tng Kapepag.

XpriolpeG papuoyeg
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Mpdabeteg emAoyég 0TV PMPooTIvi KApEpa

TpaPr&re pia selfie emAéyovtag eite AjPn pe xelpovopia

Selffie XEPLOU ite AuTOpaTn AqYn.
Amnobrkeuon ATIOONKEVEL TIG EIKOVEC WG AVACTPAUHEVEG APOU TPAPAEEL
avacTpoprg selfie.

E « Mmopeite va epapUooeTe To £ pakiyldd dtav tpapare pia selfie
XPNOIHOTIOIWVTAG TN UMPOCTIVA KAUEPQ.

EmAoyn Aettoupyiag

Mrmiopeite va em\éyete UKOAA TN AelToupyia ou BENETE amo TIC AerToupyieg mou
eppavifovtal otnv 08évn, ot omoieg EMAEyoVTal GUUPWVA HE TO TTEPIBANOV

Myng.

Natote O > (&) kat émerta matote Nepioootepa.
+ Mmopeite va aAEEETE TN OELPA TWV AEITOUPYIWV OKNVWVY LETAKIVWVTAG TO
€1KOVISI0 AEITOLPYIOG OKNVAG EVW) TIATATE TTAPATETAUEVA TO EIKOVIBIO.
+ Mmopeite va AdBete S1agpopeg Aettoupyieg oKnvAG amod Ty eQappoyn
SmartWorld matwvtag | .

XprolHEC EQappoyEg

e C1TIAOYI
TIEPICOOTEPWV

93



AAqYn 1oTopiag
Mriopeite va GUVOETETE AUESO PWTOYPAYIES TIOU EXETE BYAAEL LE TNV TTIoW KAl amo
TN YMPOCTIVA KAPEPQ.

1 Nomiote O> (&) kay, 0T cuvéxela, matriote Nepioadtepa, > &4,
7 Matiote () yia va tparete putoypagia.
+ Tpapnréte wa pwtoypagia mou Ba amoTeNéoel To PAVTO TG oUVOEDNC.

+ Metd ano Niyo, n umpooTivr kdpepa Ba Tpapretl autdparta pa
pwTtoypapia.

- Mnopeite emiong va atroete B kau énerta va emhé€ete pa pwtoypagia
oV éxeTe amoBnKeVOEL GTO ANUTTIOU Yla TO QOVTO TNG GUVOEDNG.
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lpriyopo @Aag
Ot pwtoypagieg mou AapAvovTal o€ KavoviKo S1AoTnHa amobnKevovTal w
apxeia GIF.

1 Natiote O > (&) kay, 0T cuvéxela, matiote Mepiocétepa. > KA.
2 Notote (7] yia va emAé€ete mooa avtiypaga g pwroypagias 8a AngBoiv.
« Mnopeite va emAé€ete petadl 4, 8, 12, 16 kai 20 avTiypapwv.
3 MNatAote () yia va PYAAETE pia pwtoypagia.
- Otowroypapieg AapBavovtal kabe 3 SeutepOAemTa Kal amobnKevovTal wg
apyeio GIF.
- Mmopeite va matrioete @ mpw T Mjyn Tou ipokaBopiopévou aptBpol
PWTOYPAPLLV YA VO OTAUATACETE TN AP,
- Orpwtoypagieg mou €xouv An@Bei amoBnkevovtal wg apyeia GIF.
« Mmopeite va beite Ta amobnkevpéva apyeia GIF xpnotpomoiwvtag tnv
£pappoyr AAUmou.

E «+ 0tav n KAUEPA AmOTUTIWVEL TN QWToYPAQia, avaPel pAag.
+ 270 KATW UéPOG TNG 006VNG EPPAVICETAL 0 GUVONKOG APIBUOG TwV
PWTOYPAPLWV TIOU £XOUV ANPOE( Kal 0 APIBUOE TWV AVTIYPAPWV.
+ O1puwtoypaepieg mou éxouv AneOei amoBnkevovtal povo wg apyeia GIF.

Cine shot

Mriopeite va KataypAYeTe pia oTiypur Kat va Sniioupynoete éva Bivteo pe éva
UEPOG MOVO TNG OKNVAG O€ Kivnon.

Katd ty kataypa@n evog Bivteo, kpatdte otabepr Tn 6UoKeun. Metd v
kataypa®n Tou Biveo, Tpite pia meploxr Tou Bivieo n omoia BéAeTe va kiveital H
emAeypévn TEPIOXT EEKIVAEL Va KIVELTAL Kall TO UMTONOITTO BIVTED pEVEL OTATIKO.

1 Nardore O> (&) kay, ot ouvéyela, matiote Nepioootepa. > .
2 TNatrote @ yia Kataypagr evog Bivieo 3 SeuTepONEMTWY.
+ Kpatrote otabepn Tn GUOKELN KaTtd TV £yypaen Tou Bivreo.
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3 Natfote (#) kau tpiPte Ty meployn mou BéNete va Kiveital pe e@é Cine shot.

Avaipgon — Bge— EmavelAnupévn

. avaTapaywyn Tpog Ta
EmavaAnyn EUTTPOS Kal TTPOG Ta THOW.
EmaveiAnupévn
avaTapaywyn Tpog Ta
EUTTPOG.

EmAEETE TNV TTEPIOXN TTOU —ee o i
Ba JETAKIVAOETE.

Alaypagn TNG emAeypévng
TIEPIOXNAG.

+ Matote (©) yia va oprioete v emAeypévn meploxn.
- Matiote () yia enavahapBavopevn avamapaywyn Ue UmpocTivy Kivnon
NG EMAEYHEVNG TTEPLOKNG.
+ [Matnote @ yia emavalapBavopevn avanapaywyn Ue WPOoTIV KAl THow
Kivnon g emAeypévng mepLoXNG.
4 EmAé€te AmoBrikevon.
+ HemMeypévn meploxr Ba kiveitat.

QLens

Mriopeite va TpaypOTOMOIOETE AyOpEC, avaliTnon EKOVWVY i Va GOPWOETE évav

Kwdika QR Byadovtag pia puwrtoypagia pe to Qlens.

1 Natiote O> (&) kay, 0Tn ouvéxela, matriote Meplocdtepa. > <.

7 Kavete v emhoyn mou Béhete petall twy Visual Shopping, Otk
Avalfitnon i Zdpwon kwdikov QR.
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3 Ayyi&te v 086vn yia va BYANETE Wi QUTOYPAPIA: TOU AVTIKEIUEVOU YIa TO
omoio BéAete va mpaypatomolioete avalitnon 1 e0TIdoTe oTov Kwdikd QR.
+ To amotéeopa Ba eppavioTei Peta amd Aiyo.

E «+ Auti n Aertoupyia givat StaBéotun uovo 6tav n GUCKEUH oag gival
ouvdedepévn oe Siktuo. Eav xpnotpomoleite Sedopéva KivnTtrig TNAEQwViag,
umopei va empBapuvOeiTe e XpEWTELC yia TN Xprion dedopuévwy, avdoya pe
TO TIPOYPAHUA XPEWTEWV TIOU EXETE EMAECEL

« NMaTig Aerroupyieg Omrtikr) Avaliitnon, Umopeite va emAEEETE Ty TEpLox T
TIou BENETE QMO TN PWTOYPAPia TTOU EXETE BYANEL Kall, OTN GUVEXELD, Va
Kavete Eava avadrtnon.

+ Autij n Suvatdtnta eivat Slabéoiun udvo dtav n mow Kapepa BpiokeTal oe
Autopatn Aertoupyia.

+ Auti n Aertoupyia evaéxetal va unv umooTnPi(eTal 0€ OPIOUEVES TTEPIOXEG.

Mavopapa
Mriopeite va SnUIoUPYNGCETE pid TTAVOPAMIKE QWTOYPAPIa METOKIVWVTAG TV
KApePa TTPOG pia KateuBuvaon yia AP ewToypagLiV Kal GUPPAPY TWV CUVEXWV
MUewv Hiag evpuywviag mPoBoAng.
1 Natiote Q> (&) kay, 0T ouvéyela, matiote Nepiocétepa. >,
7 TMatioTe 10 Kouumi () Kal, £MEITa, METAKIVAOTE TV KAUEPX TTIPOG Wiat
KatevBuvon.
+ METAKIVAOTE TN GUOKEUT akoAouBwvTag TNV Kateubuvon Tou BEAoug oTnv
KOTEUBUVTAPLD YPOUN.

3 Ayyi€te 1o koupni @ yia va Stakoyete Ty mavopapki Aqyn.
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Apyn Kivnon

Anpioupynote éva SlaokedaoTiko Bivieo petafaiovtag Ty Taxltnta g
Kivnong. Autr n Aertoupyia ivat xpriotun dtav BéNete va avamapdyeTe éva Bivieo
HE XapnAOTEPN TaXUTNTA O€ OXEON ME TNV TIPAYHATIK TAXUTNTA TOU APXIKOU
Bivreo.

E - Apyn kivnon yia Mo To Bivteo
- To €€ TG apyng kivnong epappdleTal og ONo To Bivteo.
+ Apyn Kivnon yta tppata
- To €@é G apyng Kivnong epappoleTal oe OPIOpEVA TUAHATA TOU BiVTEo.

1 Natote O > (&) kay, ot ouvéxela, matiote Mepiooétepa. > 0.
7 Emére TUAUA 1} OAOKANPO TO BivTeD Kat MAEETE TO EMBUPNTO £
apyn¢ kivnong.
3 MatAote o yiava tpaPrgete Bivteo.
- Edv emAé€ete apyn kivnon yia Ao 1o Bivteo, To £9€ apyn¢ kivnong Oa
£pappooTei o€ 6o 1o Pivteo.
+ Edv emAé€ete apyn kivnon yla TpApaTa, To £9€ apyng kivnong 6a
€QAPUOOTE] 0T TURpaTA 0Ta ommoia matBnke 1o CO).
- Nathote @ 61av BENETE VA EQAPHOCTE TO EPE APYNG KivONG.
: Mé éva oUvtopo mdtnpa, To €€ apyr¢ Kivnong epappdletat yia 0,5
SeutepdhenTa.
: Mg éva mapatetapévo matnpa, To Q€ apyng Kivnong epappoletat
péxpt va a@rioeTe To SAXTUNG 0.
- Mnopeite va matrioete 10 QO wg MEVTE POpEC.
A Eav Béhete va ohokAnpaoete T Ajyn, atiote (=),
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MevtanAi Ayn
Mriopeite va BYANETE TTEVTE PWTOYPAYIES OTN OELPA XPNOIUOTIOIWVTAG KAl TOUG
TIEVTE PAKOUG KAPEPQG.
1 Natiote O > (&) kai, 0T cuvéxela, matiote Mepioadtepa. > 5],
7 Matiote () yia va ByGAeTe pia wtoypagia.
+ Byaivouv autépata mévte S1a00xIKES PWTOYPAPIES EEKIVWVTAG LE TIG TTIOW
KAUEPEC.

+ H ogipd Twv mévTe QWTOYPAPIWY amoONKEVETAL AUTOUATA OTNV EQAPHOYN
ANUTOUN Kal Tpoo@épel emAOYEG Snuoupyiag koAal iy GIF.

E + Kata m Myn piog gwtoypagiag, Kpatrote oTabepr) T GUOKELN UéxpLva
oNoKANPWOEL N AYN KAl TWV 5 GUTOYPAPIWV.
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Oayntd
Mropeite va TpaPri&ete pia ewtoypagia rj éva Bivteo mpooapuolovtag To xpwua
Kall TV 100pPoTTiat A€UKOU ammd To pUBLOTIKO.
1 Natote O > (&) kay, 0T ouvéxela, matriote Meploadtepa. > HQ.
2 Tava tpaBigete pa pwtoypagia, aTHOTE TO KOUWT
+ YUPETE TO PUBMIOTIKO XPWHATOG 0TNV 086VN YIa Va TTPOCAPHOCETE TV
10opporia AeUkoU Kal va EMAEEETE TO KAAUTEPO XPWHA.
+ EQv 10 pUBIOTIKG 8EV EUQAVIOTE], TATHOTE 0 Yia VAl TIPOOAPUACETE TV
1oopporia Aeukou.

Nuxtepivii 6éaon

Mrmiopeite va Byalete {wvTavég kat KaBapég VUXTEPIVEC pwToypapies. Katd

N AN piag wtoypagiag, Kpatdte otabepr Tn cuokeur. Mmopeite va
TIPOCAPUOTETE TN PWTEVATNTA TG PWTOYPAPIAE OUPOVTAC TO PUBUIOTIKG TTIPOG
10 aploTePA 1y mpog ta Se€id.

Natote O > (&) kay, o ouvéxela, matiote Nepoodtepa. > (S,
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Aertoupyia xelpokivntou Bivteo

0 xprotng umopei va pubpicel xelpokivnta S1aQopeg AelToupyieg yia T
kataypa@n Bivreo. Hyo, looppomia Aeukov, eotiaon, pwtevotnta, ISO, TaxUtnta
KAeioTPOU, KATT.

1 Natiote O> (&) kay, otn ouvéxela, matrote NMepioodtepa. > [X.
7 Em\éEte T0 pevou oknviAE Tou Taiptédel oTo mepIBAANoV AN

O¢AeTe Va
pnOevioeTe TIg
pubpioeig;

Mpooappoyn
100PPOTTIaG NXOU.

Mpooappoyr
TaxutnTag
KAgioTpOU.
Mpocapuoyn
TayutnTag ISO.

Mpooappoyn
PWTEIVOTNTAG.

Mpooapuoyr
£aTioong.

{tM-——— [pocappoyr
100pPOTTIag
Agukou.

3 Motote @ yia va EeKIVAOEL N eyypagn.

PUBMIoN emAoyn¢
Mropeite va puBpioeTe Ty emhoyn kdpepag avéhoya pe To emBuuntd
miePIBANOV.
MatioTe §33 oTnv 086vN.
« [1]: Autépatn petdBaon ot FullVision
- [X: EmMoyn avdhuong Kat peyéBoug Bivteo.

PuBuocg kapé Em\éyel Ty Tiun Twv kapé avd Seutepdlero.

PuBuoG Yn@lakng . , , .

HETaBOoNC EmAéyel v molétnTa elkévag yia ta Bivreo.

Wi-Fi Mpaypatomolei eyypaen Bivieo pe rxo mowdtntag Hi-Fi.

Anobrkeuon o AmoBnkevote éva Bivteo otn poper) HDR10 yia uynAn
HDR10 €UKpivela Kat {wvtavo xpwpa.

Ttabepn eyypaeprny | EAaxiotomolei To pAouTtdpiopa Kata Ty kataypagr Biveo.
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Opiote 611 n kApepa Ba Mapapével E0TIOOUEVN OTO
QVTIKEIMEVO TIOU ayYiCeTe 0TV 000V, KON KL av auto

ﬂuQuKo}\ouenan KWL

gatiaong ) ) . . .
(AtoTiBeTat GTav XPNGILOTOLEITAL N KALEPQ UE TOV TUTTIKO
PaKO.)

TomoBesia etkétac AmoBnkevel TV eikova elodyovtag Ta dedopéva tomobeaiag

GPS.

Epgaviote otnv 006vn kaBodnyntikd méyparta yia An
M\éypa PWTOYPAPIWV 1} Eyypadn Bivieo Bacel Twv opt{ovTIwY Kal
KATAKOPUQWV YPOAUUWY avapopdg.

Em\é€te edv BéNeTE va amoBNKEVETE TIC PWTOYPAPIEC K

AmoOnKeUTIKOG 1a Bivteo oTov Eowrep. amod. xdpog i oty Kapta SD.

Xupoc (AramiBetan dTav éxel TomoBeTnBei kApTa PVAUNC).
Bonfsta Mapéyel BorBela yia k4Be pevou TG KAPEPAG.
TpumAi Mg

Mée auTd 10 XapaKTNPIOTIKG PMOPEITE VA BYGANETE HIal GEIPA PWTOYPAPIWV ATTO
Sl0(QOPETIKEG YWVIES Kal va SnIOUPYROETE éva BivTeo pe e@é oAiobnong.
1 Natiote O > (&) kay, 0T cuvéxela, matiote Mepiooétepa. > (3]
7 Matiote () yia va ByaAeTe pia pwtoypagia.
+ Ottpeig mow Kapepeg Byalouvv autopata SladoxIKEG WTOYPAPIES.

i
Ot wtoypaieg TPIMAi¢ AMYng amoBnKevovVTal AUTOUATA OTNV EQAPHOYH
Ahumou.

E + Katam Myn piog gwtoypagiag, Kpatrote oTabepr) T GUOKELN UL Va
oMokANPpwOEL N AN Kal TwV 3 GUWTOYPAPIWV.
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Cine Video
Mriopeite va eyypdaypete éva BIVTEO KIVNLATOYPAPIKNG TOIOTNTAG.
1 Namote Q> (&) ka, 0T ouvéxela, matrote Nepioadtepa. > &,
7 Ayyi€re 1o koupmi @ yia va eyypayete éva Bivreo.
e Kata v eyypaen Bivieo Umopeite va 0TIAOETE G€ UIa TIEPLOXT| TTIOU
Oé\eTe 1y va amopakpuvBeite amé autry, emiéyovtag tn duvatotnta Point
Zoom.

. : Mmopeite va emAECeTe va eQAPUOOETE Eva EQE OTNV EYYPOQN).
Mmopeite emiong va mpoCcapHOCETE TO BIVIETAPIOUA Kall TNV €VTAON Yia KABe
Kivnpatoypa@iko epé (Cine Effect). Aev umopeite va aMagete autriv T
SuvatdTNTa Ao EEKIVAOETE TNV EYYPAPH.

+ Hduvatétnta Point Zoom umootnpilel Taxutnta (Oup € 3X.
« Autij n Suvatdtnta umooTnEilel HOvVo eyypagr BiVIED OE TUTTKI ywvia.

YouTube Live
Mrmiopeite va KataypAyeTte éva Bivteo Kal va To amooTeileTe ameubeiog oTo
YouTube.

Mo va XpnotuomoioeTe auThy T Suvatotnta, Ba xpelaoTei va empBeBaloETe Tov
TNAEPWVIKS Gag aplOpo.

5 « To YouTube Live givat StaBéotuo povo 6tav n cuokeun oag sivat
ouvdedepévn ato Sladiktuo. Edv xpnotpomoleite Sedopéva Kivntig
TNAEQWVIaC, UMopei val MBAPUVOELTE HE XPEWTELS yia T Xprion dedopévawy,
QVANOYQ E TO TIPOYPAUMA XPEWOEWV TTOU EXETE EMAECEL.

XPAOIUEG EPAPHOYEC 103



Xeipokivntn AetTtoupyia Kapepag

Mropeite va SnIoUPYNOETE WTOYPAPIEG EMAYYENUATIKNG TOIOTNTAG
XPnotpomolwvtag MR Bog mponyuévwy Asttoupylwv. NMpooappdoTe Ty Ioopporia
AEUKOU, TNV €0TiA0N, TN QWTEWVOTNTA, TNV Tipr 1SO, TV TaxUTNTa Tou KAEIOTPOU Kal
AN\eC emAOYEC.

1 Natmote O > (&) kay, 0T cuvéxela, Tatiote M autépatn Kapepa.
7 MpocappooTE TG TAPAKATW PUOLICELC TG KAPEPAC.

—— OéAete va pndevioete

Epgpavige Tig TIG puBioEIg;
diapopeg

€TMAOYEG TOU 0 X

Graphy. pooappoyr

TaxuTnNTag KAEioTpou.

Mpocappoyn
TaxutnTag 1ISO.

Mpooapuoyr
PWTEIVOTNTAG.

~—— [pooappoyr
| €0TiOONG.

e———— lpooappoyr
100pPOTTIag AeUKOU.

3 MNatfote To koupni () yia va tpaBigete wa putoypagia.

E « Em\éyovtag Ta @é Graphy, umopeite va AaPeTe pwtoypapieg
XPNOLUOTIOIWVTAC TNV LGOPPOTTIA AEUKOU, TNV TAXUTNTA KAEIOTPOU Kal TIG
TIpEC pubpicewv 1SO mou epapuolovTal TV MPOTEIVOUEVN PWTOYPAPIAL.
« Mmopeite va beite SIAPOPES TPOTEWOUEVEG PWTOYPAPIES AV ANABETE TV
epappoyn Graphy amé 1o Google Play Store.
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Mpocappoyn Twv emAoywv TNE KAPEPAS
Mriopeite va mpocappoceTe MARBOG EMAOYWV KAPEPAS AVANOYA HIE TIC

TIPOTIUNTELG 0aG.

Ayyi&te To koupmi §33 otV 086vn.
] AMuin ewroypagiag oto FullVision.
+ [0]: EmAéyerTic Tipég Tou Adyou SlaoTdoewv Kal To PéyeBog yia T Aqyn

PWTOYPAPIWV.

MPocapUOCTE TNV Ioopporia AeukoU, Tnv Tiur ISO kat tnv

Graphy } ] . .
wToveasia Tax0TNTa KAEIOTPOU YIa TNV TIPOTEIVOUEVN pwToypaia. MNa
pwroypag Aemtopépeleg, avatpé€te otny evotnta Graphy.
H eikéva amobnkeveTal og poper apyeiou RAW wote
AmoBriKeuan we vl UTTOPETE Val TV TPOTIOTIOIAGETE. KaTa mAYn
RAW pwtoypagiag dnuouvpyouvtal ta apxeia DNG kat JPEG Kat,

0T OUVEXELD, AMOBNKEVOVTAI WG LN OUPTTIECHEV EIKOVA
uPnArg avéhuong.

Epappoyn 'Cheese'

TpaPrte WTOYPAPIES LIE PWVNTIKES EVTONEG.

MapakohovBnon
gotiaong

OpioTte Ot N Kdpepa Ba mapapével 0TIA0UEVN OTO
avTIKEipevo Tou ayyiete otnv 086vn, akdpn Ki av autd
Kiveital. (AlatiBetal dtav XpnoILOTOIETaL N KAUEPQ LE TOV
TUTIKO PaKO.)

TomoBsaia eTIKETAC

AnoBnkeVel T ekova elodyovTag Ta Sedopéva Tomobeaiag
GPS.

Epgaviote otnv 006vn kaBodnyntikd miéypata yia Agn

0dnyog QWTOYPAPIWV BATEL TV 0PI{OVTILWV KAl KATAKOPUPWY
YPOUUWY avapopdg.
Mpoadiikn . i .
. EpgpaviCet pia umoypagr oTIC QuToypaieg.
unoypagric Hoavilet pia uTToypapn OTIC QUTOYPapiES

AmoOnKeUTIKAG
Xwpog

EmAé€te edv BéNeTe va amoBnKeVETE TIC PWTOYPAPIEC Kal
1a Bivreo otov Eowtep. amoB. xwpog 1 atnv Kapta SD.
(AlatiBetat 6tav €xel TOmoBeTNBEl KAPTA UVANG).

BoriBeia

Mapéxel BorBeta yia kdBe pevou Tng KapePag.

XpriolpeG papuoyeg
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Graphy

Mriopeite va eQapUOOETE TIC TPOTEIVOUEVEG TILEC VIO TNV LOOPPOTTia AEUKOU, TV
TIpn 1SO Kat Ty TaxUTnTa KAEITTPOU, Yia va €a0QaNOETE €val EMAYYEAUATIKO
amoTéNeopa.

1 Nathote O> (&) kay, 0Tn ouvéxela, matriote Min autopaTn Kapepa.
7 Ayyi€te 1o eikoviSio (@ kat emAEETe TV emBupnT oKV amod Tig
TIPOTEIVOUEVEG EIKOVEG,

MpoTeIvopeveg eIKOVEG

3 MNatAote () yia va PYAAETE pia pwtoypagia.
+ Otowroypagieg AapBavovtat e Tiq ibleg pubpioelc pwTtoypagiag mou
€xouv emhexOei oto Graphy.

E + Auti n Suvatdtnta eivat Slabéoiun udvo oe Xelpokivntn Aettoupyia
KAPEPQG.

+ Mmopeite va mpoobEoETe MEPIOOOTEPEG OKNVEG TATWVTAG i Kalt
TIpAyUATOMOLWVTAG AN TG E@appoyrg Graphy amo to Play Store. Eav
xpnotporoleite Sedopéva KivnTig TNAEpviag, pmopei va empBapuvBeite pe
XPEWOELG Y10 TN Xprion Sedopévwy, avaloya e TO TTPOYPAHHA XPEWTEWY
TIOU €XETE EMAEEEL

« Ayyi€te €§3, 0Tn ouvéxela matioTe ) amo To pevou Graphy yia va
QITEVEPYOTTOICETE AUTH TN A€IToupyia.
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Makeup Pro
Katd t Aqyn oéA@l, Umopeite va QapUOcETe SIAQOPES TEXVIKES LaKIIAL.

Katd tn xprion g UmpooTiviig Kapepag, aANAETE To xpwua Sépuatog Kat
XPNOMOTOOTE PaKIYLAC 0Ta pdTia Kat Ta XEIAN.
1 Namote O> (&), petapeite otV PMpooTIv Kapepa Kat MatHoTe .
2 Aahé€re Ty emdoyr HOKIYIAL TTou BENETE Kt PETAKIVAGTE Tr YPOUF KONONG
TIPOG Ta APLOTEPA 1 Ta O€EIA YA VO TIPOCAPUOTETE TO EPE.
+ Otav emAé€ete Kavéva, n ypapun KUAong e§agavietat.

EmiAoyn e@¢ pakiyiag

Kavéva epé
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3 Em\é€te S14@opa epé pakiylad Kal EpappooTe Ta oTo Bépa.
+ Matjote Baoko 1) Aerroupyia pakiylad Kot oTn CLVEXELQ TATAOTE Eava TV
006vn yla va eQapUOCETE TO AeTTOUEPH €QE HaKIylad,
+ MetakivioTe T MPapUR TPOCAPHOYNG EVTAoNG YIa va pUOUIcETE TV
€vtaon e v omoia epappdloval Ta EQE.

Mmépa pUBuiong R ————

MaTAoTe TO — e, T‘. 3 ,T‘-
R ﬁ

Makiyidg 800 @opég
/A Natfote () yia va Bydhete pia wtoypagio.

Emihoyn @€ pakiyiag
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Ztouvtio

Mmopeite va TpaBdte pwToypagies oav g GTOUVTIO XPNOIMOTIOIWVTAG TO
OwTIoTIKO OmoT Kail To YoRadpo oty kdpepa.

OwTtioTikd oMot
Mriopeite va eQapuooeTe S1APopa EQE GWTIOUOU KATA TN AN QWTOYPAPIWY.
1 Natjote O> (&) kau énerta emhé€te ZTouvTio.
7 Matiote 6 yla va emAEEETE éva Q€ WTIONOU.
+ Ald@opa £ GWTIOHOU ep@avi{ovTal 0To KATw PEPOG TNG 006VNG.

Eikovidio @wTioTIKOU OTTOT —

3 MatAoTe To £IKOVIBI0 Tou eMBUUNTOV EPE PWTIOOU.
/I 'Otav eppaviotei otnv 086vn To £@é oTolVTIO ival Slabéaipo, TatroTe
yla va ByAAeTe pia gutoypagia.
+ H Suvatdtnta ZTouvTio evOEXETAL Va N AEITOUPYHOEL EQV N KApEPA Sev
umopei va avayvwpioel To Bépa.
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Ynofabpo
Mriopeite va epapuOoeTe SIAPOPA EQE OTO YAVTO KATA TN GWTOYPAPION
TIOPTPETWV.
1 Natpote O > (&) kot énerta emAé€te TTouvTio.
2 Natrorte [ yia va emhégete éva epé umoPadpou.

+ Aldgopa xpwpata eévtou eugavifovtal 0To KaTw péPog tng 08évng.
3 EmAEETE TTOL0 XPWHA POVTOU DENETE VA EQOPUOOETE.

+ Mmopeite va eQapUOOETE Ta EMAEYHEVA XPWHOTA OTO YOVTO TéPA amo TO
B¢ua.

17 Eikovidlo utrofd6pou
e ®

*— Xpwuata @évTou

/. 'Otav eppavioTei To urivupa kabodriynong To pé otobvTio ivat Stabatpo.,
TTAOTE () yla va TpaPrete pia pwtoypagia.

E « Eavn kapepa dev avayvwpilel To B€pa, n Aettoupyia oTouvTio dev umopei
Va EQAPUOCTEL 0TNV amoBnkeupévn pwToypagia.
« Eav 10 ovTO €ival okoUpo, N KAPEPA SEV UMOPE VOl EQAPUOOEL TA EPE
OTOUVTIO.
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Nertoupyieg AR

Mriopeite va xpnotpomnotjoete diapopeg Aettoupyieg AR (Augmented Reality

- Emauénuévn Mpayuatikdtnta) pe Ty epappoyn Kapepa. Mmopeite va
Snuioupynoete ta Sikd oag My Avatar, AR Emoji iy AR Sticker yia mhovaoto
neplexopevo. To My Avatar oag BonBdet va Snpioupynoete éva Kaptolv Tou
€0UTOV 0ag Kal va 1o ipocappdoete. To AR Emoji oag BonBdet va dnuioupyrioete
TpIo61a0TaTa emoji {Wwwv TOU MIHOUVTAL TIG EKPPATELS Tou TTpoowmou. To AR
Sticker oag emtpémel va emMAEEETE avapeoa o€ APKETA SIaQOPETIKA AUTOKONNTA
Kall Va TOL XPNOIOTIOINOETE O€ [ puToypagia f éva Bivieo evw xpnotuomoleite
TNV KAYEPA oag.

Anpioupyia My Avatar
1 Natiote O> (&), petaBeite oy prpootivr kapepa kai matiote & > ©).

+ AuTA n Asttoupyia pmopei va xpnotpomolndei povo oe Autopatn Aettoupyia.
7 MNatote n > Q yia va ByAAeTe pia wtoypagia.

+ AkolouBroTe Tic odnyieg mou epgaviovtal otny 086vn yia va
£UBUYPAUMICETE TO TTPAOWTO Gag We TV 086V,

« Ta va dnuioupynoete éva My Avatar XpnotpomolwmvTag pia ormd Tig
PWTOYPAPIEC TTOU Eival amoONKEVPEVEC OTNV EQapOYr AAUTTOUY, TTATAOTE

+
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3 Em\é€te To ONO Tou My Avatar Kat NeTTOPEPELEC OXETIKA WE TOV TUTIO TOU
apatap, To XpwHa Tou SEPHATOC, TO OTUA TwV HOANWY, T poUXa KAl TTATHOTE
OK.

- Otowroypaeieg mou Ba TpaPri&ete amobnkevovTal TNV EQappoyn
ANUTIOUL.
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Xpnon My Avatar, AR Emoji, AR Sticker
1 Nomote O> (&), petapeite oty pmpooTivi kapepa kat matiote (&> ©).
7 Kavte wa emhoyr mou O4AeTe va KaTaypAYETE.

My Avatar AR Emoji AR Sticker

3 Tavatpaiete pia puToypagia, atHoTe To KOU
Mo va kavete eyypaen Bivteo xpnotpomnolwvtag My Avatar, AR Emoji 1) AR
Sticker, em\é€Te To pevo eyypagnc Bivteo, matrote (> © yava emhétete
0 emMBUPNTO OTOIKE(O Kall émerta maTroTe @) yia va EEKIVATEL N eyypagr Tou
Bivteo.
+ O1pwtoypaieg mou Ba TpaPri§ete amobnkevovtal oTnV EQapuoyn
AAumou.
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Xpnon Avatar Stickers
1 Natote & 010 MnkTPoAdYI0 LG.
7 Emé€te éva auTOKOMITO avatar ou BENeTE va xpnoIoToINoETe PETAE) Twv

My Avatar mmou €xeTte SnIoUPYROEL KA, OTN CUVEXELD, EMAEETE B> yia va To

oteilete.

<« L a Qi

Eikovidio Avatar —=— [

Sticker

A ¢ @ E v
aete
neem
Ve U N
08+

Xprion Ani Sticker

1 Nomote @ 070 MANKTPOAOYIO LG.

7 Em\é€te To My Avatar mou BéAete.

3 MNatfote @ Yla TNV Eyypagr @wvrg Kat Xou Kal, 0T CUVEXELD, TTATHOTE @
yia amoBrikeuon.
+ AnuoupyolvTat Ani Stickers pe SI6POPEC EKPPATEL TTPOOWTTOU, KIVACELS

Kall QWVEG.

/' NatAote (>) yia va oteilete Ani Sticker.

- Matote @ yia mpoemok6mnon tou Ani Sticker ou Snptoupyrnke.
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AN\gg Xpnotpeg AetToupyieg oTnv e@appoyn «Kapepar

KAeidwpa autopatng ékBeong/autépatng eotiaong

Mriopeite va mpocappooeTe T0 Tpéxov eminedo ékBeong kat Tn B¢on eotiaong
TIOTWVTOC TAPATETAUEVA TIAVW 0TV 086vn oTnv Autdpatn Asrtoupyia. MNa va
amevepyorolrioeTe TN AerToupyia, ayyi&Te pia Kevr epLoxr TG 086vNng.

E « AutA n duvatotnta gival SlaBéotun HOVO O GUYKEKPIUEVES AEITOUPYIEC.

Xpnon g Aerroupyiag MoAamhi Aqyin

Mriopeite va TpaPri&ete ouveXOUEVEC PUITOYPAPIEC Kall VAl TIG SEITE WG KIVOUUEVES
€IKOVEC 0TO ANUTIOUHL.

T Avoi€te v epappoyr kdpepa kat emhé€te Qutoypaeia.
7 Natote mapateTapéva 1o

+ Ev) Kpatate matnuévo o ) AapBavovTal TOAEC, OUVEXOUEVEC
PWTOYPAPIEC.

5 + Autij n Suvatdtnta eivat S1aB€oIUN MOVO GE GUYKEKPIUEVES NEITOUPYIEG,
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MeyéBuvon 1 opikpuvon
Mriopeite va peyeBUVETE 1} va GIKPUVETE TV 006vN TNG KAKEPAG KATA TN AN
QwToypagiag i v eyypaen Bivteo.

+ XpnOOTIOIWVTAG TN VPO TTPOGAPHOYAG TTOU Eppavi(eTal 6Tav
xpnotuomoleite SUo dayTuAa yia peyEBuvon 1y opikpuvon tng 08évng Tng
KApepag, EMAEETE evaANAE ywvia TNAEQAKOU, KAVOVIKN Ywvia Kat Eupuywvia
ywvia.

E + HAerroupyia peyéBuvong/opikpuvong Sev eival Slabéoiun otn Aerroupyia
selfie (umpoaoTivi kdpepa).
« Auti n Aertoupyia Sev umooTtnpileTal 0€ APKETEG KATAOTATEIG AETOUpYIaC.

Méyiot gotiaon

Mmopeite va TPOCAPHOOETE TNV £0TiaoN 0TO BEPA XPNOIMOTIOLWVTAG TN
SuvatotnTa péylotng eotiaonc.

Ma va petapeite otn Suvatdtnta Méylotn £0Tiaon, TATAOTE TO KOUTT XElpokivnTn
eotiaon (MF). Apou evepyomoinBei n Suvatotnta Méyiotn gotiaon, To Bépa oto
omoio eotialete Ba epgavileTat Kitpvo. METAKIVAOTE TOV TPOXO EVONNAYNG TTPOG
TO TTAVW KAl TTPOG TA KATW Y10 VAL ECTIACETE 0NV EMBUKNTI TIEPLOXT, KL ETTEITA
TpaPRtTe ™ YwToypapia.

E + [Matriote MéyioTn €0TiOGN OKOUA it OPA VIO VO OTIEVEQYOTIONOETE AUTHY.
n Aertoupyia.
+ Auti n Aertoupyia pmmopei va xpnotpomoindei pévo 6tav yivetat Ajyn e
KavovIKh ywvia.
« Eivat 6106éo1un yia xprion pévo pe t xelpokivntn eotiaon (MF).
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EvaAhayn petadi Kapepwv

Mriopeite va evaANAooETe T Aettoupyia HeTady TG EPMPAC Kall TTow KAPEPAG yia
va taiptalel oto mepiBAMov Mjuing.

TtV 086vn TG KAHEPa, ayyiEte To koupmi {o} f UpeTe TNV 086vN TIPOG
omoladnmoTe KAteVBUVON yia EVOAAAyr QVALESA OTNY UTTPOCTIVH KAl TV TToWw
Kapepa.

E + XpnoIHOMOoIOTE TV UMPooTIvViy KApEPa yia va TpaBri&ete selfie. MNa
Aemtopépeleg, avatpé€te oty evotnta Selfie.
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Selfie

Mmopeite va XpNOIUOTOOETE TNV ITPOCTIVI KApEPA Yia va Seite To mpdowmnd

oag otnv 086vn kai va tpaprifete selfie.

NAYnN pe Kivnon Tou Xepiov

Mriopeite va TpaPriéete selfie Sivovtag evTolég e AmAEC KIVROELG TwV XEPLWV GG,

AvoiTe TV TOAAWN 0AC OTPAMMEVN TIPOG TNV MITPOOTIVH KAEPQ KA, EMTELTA,
KAeioTe Ta SAKTUAG 0ag o€ ypobid.

Mriopeite akopn va kAeioeTe Ta SAxTUAG 0ag o€ YpoBid Kal va Ta avoi§eTe TPog TN

UMTPOOTIVH KApEPQ.
« XeTpia SeutePONEMTA TTPAYUATOTIOLETAL AU QWTOYPAPIAG.

m

W

E « [la va xpnolpomoloeTe auTrv T Aeitoupyia, UeTapeite otn Aertoupyia
HITPOOTIVAG KAHEPAC KA, OTN GUVEXELD, ayyi€Te Slasoxikd §83 > Selfie >
Aqyn pe xelpovopia xeptov.
+ BeBawwbeite o1t n mahdun oag Kat n ypobid oag Bpiokovtal eviog g
YPOUUAG QVa®OPAC YIal VO UTTOPEL N KAPEPX VA TIG avaYVWPIOEL
+ AuTA n Aertoupyia evoéxetat va pnv givat Slabéotun dtav xpnoluomoleiTe
OPIOEVES amd TIG AEITOUPYiES TG KAUEPAG.

XpriolpeG papuoyeg
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Autopatn Aqgn

Mropeite va XpnOILOTIOIOETE TN AEITOUPYIQ AViXVEUONG TIPOCWITOU YIa VAl

Tpapnéete selfie ypriyopa ki ebkoha. Mmopeite va puBpiceTe Tn GUOKEUR £TOL

WOTE, OTAV KOITATE TNV 086VN, N UMPOCTIVH KAUEPQ QVIXVEVEL TO TIPAOWIO GAG Kt

Tpafdel autopata pia selfie.

+ MONG n pmpooTivi KApEPa avixveloel To IPOOWO oag, epgaviletat éva

Aeukd maiolo-o8nyoc. Eav o Bépa evtdg Tou mhaiciou-o06nyol otapatrioel
Va KIVEITAL, TO XpWHa TOU MAQLGIoU-08nyoU YIVETaL KITPIVO, KAt TOTE N KAUEPQ
Tpapdel pwToypaPia.

E « Ayyi€re S1a801kd $33 > Selfie > Autépatn Aqyn yia va evepyonoloeTe T
Aertoupyia «Autopatn Ajwny.

MecoSiaotnua AqPng
Mmopeite va tpapriéete selfie pe xpovikn amooTaon YeTagu Toug.
Evw XpNOILOTOIETE TV PIMPOOTIV KAWEPQ, AVOIETE TNV TAAALN GOG OTNV KAHEPA
Kal, €metta, KAgioTe Ta SAKTUAG oag ypriyopa o€ ypoBid emavaappdvovtag thv
id1a kivnon dvo popéc.
+ ©a AneBouv Téooepig pwToYPaPie SladoyIKa META amd KaBuoTéEPNON TPIWV
SeUTEPONEMTWV Yial KaBepiaL.

AnoBnKevuon avaotpoPig
Mpwv TPABAEETE LA GWTOYPAPIa e TV UTPOCTIVH KAMEPQ, QYYIETE TO KOUWT §G3 >
Amnobrkeuan avaotpo@nc. H eikdva avaotpépetal oe opllovtio dova.

E « Katdn xprion TG WmpoaTiviG KAUEPAG, UMOpE(Te va aMAEETE Tov TpoTo
Mg Twv selfie oTig emMoyég kapepag. MNa AemTopépeleg, avatpé€te oty
evétnta lMpooappoyr) Twv emAoywv ¢ KAUEPAG.

Ymoypagn

Mriopeite va SnpioupynoeTe pia Sikr oag pwtoypagia falovag tnv umoypaen
oag.

T Ayyi€e ta ewovidia O > (&) kat émerta matiote £G3 > MpooBrkn umoypagnc.
7 Ewoaydyete Ty umoypa@n kai atriote NMpoa6.
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5 + Auti n Suvatdtnta eivat S1aB€01UN MOVO GE GUYKEKPIUEVES NEITOUPYIEC,

ypriyopn Koivormoinon
Mriopeite va KoWVOTIOINOETE ia pwToypaia fi éva Bivieo otnv epappoyr mou
BéNeTe apéowg HETA TN AYn Toug.
1 NavatpaBigete pwtoypagia iy Bivteo, natiote 1o kouuni O > (&).
7 Ayyi€te 1o elkovidio Tn¢ epappoyrc mou epgaviletal otnv 086vn yia va 1o
KOIVOTIOIOETE PEOW TNG EQAPHOYAG.
Mmopeite emiong va oapwoeTe To €1Kovidlo TPog TV avTiBetn kateubuvon
yla va Seite TToleq AANEG EQAPUOYES UMTOPEITE VA XPNOIHOTIOINTETE Yla VAl
LOlPACTEITE TIC PWTOYPAPIES Kal Ta Bivied oag.
£IKOVidIO
17 yprivopn

Kolvotroinon

E « Hepappoyr mou pgaviel To ekoviblo ypriyopn Kolvomoinon umopei
va Slapépel avaloya Ke Tov TOTIO Kall T GUXVATNTA IPOGRACNS Twv
EQAPHOYWV TTOU £XOLV EYKATAOTAOEI OTN GUOKELN).

+ Auti n Suvatotnta gival SlaBéotun HOVO O GUYKEKPIUEVES AETOUPYIEC.
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ANuUTTOUM

Emokonnon epappoyng ANUmoup

M TI¢ pwToypapieg Kat Ta Bivieo mou €xouv amoBnKeUTEN 0T GUOKEUH Gag
napéxovtal Suvatdtnteg mpoPBoAng kal SLaxeipLong Toug.

1 Natiote to koupmi O > Y.

+ Orpwtoypaeieg kai Ta Biveo mou €xouv amoBnkeuTei ppavifovat
Tagvopnpéva avd GAakeAo.

7 Matiote évav pAkeAo kat MAEETE éva apyeio.

+ TpoBaNete To emAeypévo apyeio o€ Aertoupyia mrpoug 0B6vnc.

+ Evw) PAémete pia pwtoypagia, capwote Se€id iy aplotepd yia va Seite v
TiponyoUEVN A TNV EMOUEVN QWTOYpaPiaL.

+ Evw BAémete éva Bivteo, oapwoTe SeE1A ) apLOTEPA VI VA TO UETAKIVIOETE
TIPOG Ta EUMPAG A TTPOG Tal TTOW.

+ EQv amoBnkevoeTe TI¢ MAnpo@opieg Tomobeaiag f xpNoIMOToIoETE
ia Agttoupyia oknvi katd T Ajyn, yla kabe Bivieo dnuioupyeitat évag
UTTOQAKENOG.

+ T va mpoBANeTe TIC pwToypagieg katd Tomobecia otnv omoia AjeOnke n
owtoypaoia, matiote O > () > £53 > TomoBeoia eTikéTag, 0T OLVEXELD,
natiote QD). Ol pwrtoypagieC opadomnololvtal autdpata amo T 6éon
KATW amo T KapTtéAa Mvipn tne epappoyng Mkahepi.

E + Oplopéveg HopPEG apyeiwv evdéxetal va unv umootnpiCovtat avdhoya pe T
EYKATEOTNUEVO AOYIOUIKO.
« Evdéxetat va pnv eivat Suvatd to dvotyua oplopévwy apyeiwv e§artiog g
KwSIKoToinar¢ Toug.

« Apyeia mou umepPaivouv To EMTPEMOUEVO Oplo peyEBoUG evdéxeTal va
TIPOKOAETOUV GQANUATA.

« [pémel va evepyorolroete T Aetoupyia GPS yia va dnuioupyroete éva
GATTOUp PVAHNG.
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MpofBoAn pwToypagiwv
Mmopeite va Seite TIC puToypaieg mou £Xouv AmoBNKEUTE! 0TO TTPOTOV.

Ekkivnon tou
QLens.

MNpoéoBaon oe

EmoTpoen oty —3

TIPONYOUMEVN GAAeG eTTIAOYEG.
0Bovn.
‘Evapgn mg
KAPEPQG.
Mpoobrkn A

KaTdpynon amo Ta

Q ayaTrnUéva.
Anpioupyia onpeIoEWY ; Alaypa@r] EIKOVWV.

0€ pia puToypagia.
MpoBoAn oxeTiKoU

TTEPIEXOHEVOU. Eﬁgvﬁw)ffﬁcn
Emegepyaoia
EIKOVWV.

+ To pevou Aemrtopepelwv eppaviletat dtav ayyilete Ehappwg tnv 08vn. Av
ayyi€ete TV 086vn akopa pia gopd, To pevou Ba e€apavioTei.

Avamnapaywyn Bivteo
Mriopeite va deite Ta Bivieo mou €xouv amoBnKeuTel 0To TPOTOV.

Mavon n ’ c— MNpooBaon o€
avamapaywyn —l GAAeg eTTIAOYEG.
Bivreo.

EmAoyy ——08 — T KhAcidwpa 4
avaloylwv 086vng. EekAgidwpa
oBoévng.
DTS:X 3D on/off Emegepyaoia
Anuioupyia Bivreo.
apxeiou GIF.
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5 « Tla va puBpioete TV évtaon tou Yo, TpaPrte T 6e§id meupd oty
0006vn evog Bivteo mPog Ta KATW 1) TPOE Ta TMAvVw.
« Tla va puBHIoETE TN PWTEIVATNTA TNG 006VNG, CUPETE TNV APLOTEPK TTAEUPA
otV 086vn PO Ta ENAVW I TTPOG TA KATW.
«+ Av oUpete v 086vn TPog Ta aploTepd oTnv 006vn avamapaywyng Pivteo,
7o Bivteo Kiveital mpog ta miow (REW) kat av oUpete mpog Ta Se€14, umopeite
va KIVOETE To BivTeo mpog Ta eumpdc kat ypriyopa (FF).

Eneepyaocia Bivieo

1 '0oo BAémete éva Bivteo, matrfiote To Koupri .

7 Mnopeite va xpnotonorjoste mABog epé kal epyaleiwv emefepyaciag yia va
emefepyaoTeite To Pivteo.

Autépatn
Snuioupyia
PuBpion g BIVTEOK)\I'IT 15,301
avaAuong. BeuT.
Anpioupyia Taiviag
Emavagopd Tng H‘- Xpron
aAayng. l 5|u(popwv EQE.

E— Ekkivnon tng
eTegepyaoiag
Bivreo KineMaster.

EmAoyn evotnTag yia
ahayn Tng TaxiTnTag
" avaTapaywyng.
***** bbbl [E— [Npocappoyn Tng
didipkelag Bivreo.

3 Natiote AmoBrKeuon yia va anoBnkeOoeTe TIC aMayEC.

Anuovpyia Bivteo
Mmopeite va eVWOETE EIKOVEC 1 BivTEO yia va dnpioupyrnoeTe éva véo Bivteo.
M0 TEPIOoOTEPEG AEMTTOPEPELES, AVATPESTE OTO AnLioupyia Taviag,

Anpovpyia GIF
Mriopeite va emefepyaoTeite eUKOAa TI PWTOYPAPiES kal Ta Bivteo o poper| GIF.
la meploodtepeg Aemropépeleg, avatpéte oto Anpioupyia GIF.
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Awaypa@n apxeiwv

Mmopeite va SiaypAaeTe apxeia XpNOILOTOIWVTAC Ui ard TIG TAPAKATW EMAOYEG:

MNatrote mapatetapéva mdvw o€ éva apxeio amd tn Niota apxeiwv kay, merta,
emAéCte Alaypan.

MatioTe 1o Koupn [11] ané tn Niota apxeiwy kat Slaypdwte To emBupntd
apyxeio.

Ta Siaypappéva apxeia petapépovtal autdpata otov Kado amoppippdrwv
Kal Hmopouv va avaktnBolv eMOTPEPOVTAC 0TO ANUTTOUM EVTOC 7 NUEPWV.
MatAoTe T0 KO [x] yia va S1aypAaPeTe povIHa Ta apyeia. S€ QUTAY TV
mepimTwon, Ta apxeia dev umopolv va avaktnBolv.

Kown xprion apxeiwv
MmopeiTe val KOIVOTIOIOETE £Val APXEIO XPNOILOTOIWVTAG Hia armd TIG TAPaKATw
EMNOYEC:

- BAémovtag pia gwtoypaeia, ayyi€Te To KO o< yia va KOWVOTIOIOETE TO

apyeio xpnotpomolwvtag T uéBodo mou BéAeTe.

- BAémovtag éva Bivieo, ayyi€te o koupmi ¢ > Ko Xp yia va KOWOTIOWOETE T

apyeio xpnotpomolwvtag T uéBodo mou BéAeTe.

- NatAote 1o koupmi o< amd T AioTta apyeiwv yia va en\éEete éva apyeio katva

TO KOIVOTIOIOETE XPNOIUOTIOIWVTAG TN HEB0SO ou BéNETE.
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Emagég

Enagéc - Mapouoiaon
Mriopeite va amoBnKeVoETe Kal va SIAXEIPIOTEITE TIC EMOAPES.
Ayyi€te Siadoxikd O > Ta anapaitnta > Enagéc.

MpocOnkn emagwv

MpooBnkn véwv emapwv
T Zv 0B6vn e Niotag Mgy, mathoTe To KOUUTT—-.
+ Oa gppaviotei éva avadudpevo mapdBupo yia va emiéEete T Béon
amoBriKeuong yla va Tnv Kovorolroete. EmAEETe Tn B€on mou BéheTe.

7 Eloaydyete ta otolyeia enmkowwviag kai matote AmoBrikevon.

Eicaywyn emagpwv

Mmopeite va eloayayeTe emagég amo i GAAn GUOKEUN amoBrikeuonc.

T Zmv 086vn ¢ Niotag emagav, ayyi€te ladoyikd = > Alaxeipion enagwv >
Ewcaywyn.

7 Em)\é€te TIc TomoBeaieC poEAELONC Kal TTPOOPICHOU Yia TV EMAQH TV
mipoopiletal yla elcaywyn kai matriote OK.

3 EmMé€te TIc emagéc kat ayyi€te Eloaywyn.

MpocBrikn ema@wv otn Aiota Taysiag KAjong

T Zmv 086vn e Niotag emagav, TatioTe 1o koupri + > Tayeia KAjon.
7 Ayyi€te NMpoaBrkn ema@ic and évav apiBuoé Tayeiag KAonc.

3 Em\é€te pua emagn.

« ‘Otav mpooBETeTe pia KavoUpyla emagn, TaTHoTE (57 yia va mpooBéoete
évav aplBuo tayeiag KAong.
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Avalfitnon emagwv
Mmopeite va mpaypatomoloete avadtnon MA@V XpNOOToLWVTag pia amd Tig
TOPAKATW EMAOYEG:

+ MotAoTe T ypaupr avalitnong oto Katw uépog TG 086vng Emagég Kat
€10AyeTE TNV EMOUUNTA EMAQN 1} TOV ApIBUO TNAEPWVOU TTOU BENETE Val
avalntroeTe.

Mpaypatomnotiote KUAIoN TG NOTAC EMAQWV TIPOE Ta TIAVW 1 TTPOG TA KATW.
« A6 10 EUPETAPIO GTNV 006VN TNG NOTAG EMAPWY, EMAECTE TO APXIKS YpAppa
yia pia eman.

E « Avnatrioete T ypappr avalitnong oto KAtw pépog TG 08ovng Emagég
Kal El0GyeTe pia ena@n 1y aptOpo TNAepwvou epgavifovtal Ta evomoinpéva
anoteléopata avalitnong amo To I0TOPIKO KAOEWV Kal T NioTa EMaQwy,
OTWE UTIAPXOLV AMOBNKEVUEVA OTO TIPOIOV.

Niota ema@wv

Ene€epyacia emagpuwv

1 Zmv 006vn e NoTag emagwy, eMAEETE pia emagn.

7 v 086vn Twv OTOIXEIWV WOG EMAQAC, TIATAGTE TO KouuTi /2 Kat
€MECEPYAOTEITE Ta OTOIYED.

3 MNatAote AMoBAKELVON yia va anmoBnKeUoeTe TIC AANAQYEC.

Awaypa@n emagwv
Mriopeite va SlaypAYEeTe EMAPEC XPNOILOTIOIWVTAC Lidl Ao TIC TAPAKATW
EMNOYEC:
+ XV 084vn Tng NioTag EmMagy, ayyiETe Kal KPOTHOTE TV EMAPN TIou BEAETE va
SlaypAYETE Kal, 0N OUVEXELD, ayyi§Te Alaypa®n ETAQAG.
- Ayyi€te Siadoyikd + > Alaypagr mou Bpioketat oTnv 086vn NioTag emagav.

E Ol amoUAKPUOHEVEG ETTAPES EVOEXETAL VA NV AITOKATAOTABOUV.
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Mpocbrikn ayammpévwv

Mmopeite va KATaxWPICETE TIG EMAPES TTOU XPNOLUOTIOLEITE GUXVA WG AYATTNEVEG.
71 Zmv 006vn e NoTag ema@wy, emMAEETE pia emagn.

7 v 0B6vn Twv OTOIXEIWV WOG EMAQAC, IATAGTE TO KOUTT Y.

Anpioupyia opadwv

T T Nota tg opadag enagiv, natiote —-.

2 MAnktpohoyroTe éva véo dvopa yia Ty opdda.

3 Natfote MpooBikn pehwv, em\é€te emagéc kat matrote NMpoab.
/' Natfiote AmoBrikeuon yia va anoBnkeVoeTe T véa opdda.

QuickMemo+

Mapouaiaon TG e@appoyng QuickMemo+

Mriopeite va @TIAEETE SNUIOUPYIKES ONUEIWOELS XPNOILOTIOIWVTAG TV YKAUA
emAoywv mou S1aBETEL AUTA N TIPoNYUEVN SuVATOTNTA TOU ONUEIWHATAPIOU, OTTWG
n Siaxeipion ekévwv Kat otiypdtunwy. Ot emioyé auté Sev umootnpilovtat amd
TO GUUPBATIKO ONUEWUATAPLO.

Anpioupyia onueiwong

1 NatAote to koupmi O > QuickMemo+.

7 Natote 1o koupri @ yia va SnuoupyACETE pia onpeiwon.
. Q : anmoBrikeuon onueiwong.
+ < : Avaipeon tng mponyoUHEeVNG evépyelag eme€epyaoiac.
7 EmavéAnyn Twv Mo mpdo@atwy eVEPYEIWY Slaypaprc.
T : el0aywyn onueiwong xpnotLOmoIVTAE TO TANKTPOAGYIO.
/1 dnpioupyia XEpOypaQwy ONUEIWOEWV.
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+ & : iaypagr XEPOYPAPWY ONUEIDTEWV.
« () : ueyéBuvon 1y opikpuvon, TEPIOTPOPR 1y Slaypagr onueiwy piag
XEPOYPAPNC ONUEIWONC.
: :Mp6oPacn oe AAEG EMAOYEC.
3 MatAoTe To Koupmi Q Yl va amoBnKeVoETe T onpeiwon,.

Anuovpyia onueloEWY o€ éva oTIyOTUNIO 006VNG
1 Katd mv mpoBoAr Tng 086vng mou BENETE va AMOTUNIWOETE, GUPETE TN YPOUUN
KATAOTaONG TTPOG T KATW KAtl, 0T GUVEXELD, ayYIETE To Koupi (7,
+ To oTiypotumo 086vng eppavifetal we B€pa AVToU 0To ONUEIWUATAPLO.
Ta epyaleia onpewoewv eppavifovtal oTo Mavw PEPOS NG 086vNG.
7 Kavte mepikomm Tng eKOVaC (av xpelaleTat) Kat TPOoOEOTE TIC ONUEIDOELC TTOU
BéNete.
+ Snpioupyia XEIPOYPUPWY CNUEIWOEWY 0T PWTOYPAPIa.
3 MatAoTe To Koupmi Q Kall amoBnKeUoTE TIC ONUEIWOELG 0TV TomoBeaia Tou
BéNete.
+ Mmopeite va Seite Ti¢ onewaelg mou amoBnkevoarte gite 01o QuickMemo+
€ite 0T0 AANUMOU.
+ [ va anoBnkeVoeTe ONUEIWOEIS 0TNV iSla TomoBeaia pe TV ponyouevn
(POPA, EVEPYOTIOINOTE TO TAAioL0 EAéyXou Xprion amé mpoemAoyn yia
AUTHVY TNV EVEPYELD. KAl EMAECTE IO EQAPHOYN.

E « Mmopeite va amotunwoete 0AOKANPN TV 086vN XPNCIHOTIOIWVTAG TN

SuvatétnTa KUNoNG.

+ Evw pnotpomoleite kamola epappoyr, omwg yla mapddetypa ta Mnvopata
1 1o Chrome, 6UpETE Tov Tivaka EIGOMOITEWV TPOG Tt KATW Kalt TOTHOTE
Capture+ > Eméktaon, yia va anotunioete oOAOkAnpn tnv 066vn mou
BAémete T Sedopévn OTIYHNA WG Eva APXEID AMTEIKOVIONG.

« Autij n SuvatdtnTa eivat S100£01Un MOV YIa OPICHEVEG EQAPHOYEG TTOU
umootnpiouv T SuvatdtnTa KUNONG.

« Maote 6Vo ddyTula i amWOTe Ta SAXTUNG 0aG yia va aAAEETE T SidTagn
TWV Onyeiwv.
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Awayeipion @akéAwv
OpYavWVETE Kal BAEMETE ONUEIWTELS AVANOYA HE TOV TUTTO ONEiWONG.
1 EmAé€re O> QuickMemo+.
7 Natfote = oo endvw PéPog TG 08vNnG Kat £merta emAETe TV emBupnT
Aertoupyia.
+ 'O\eg o1 onpewoelg: Mmopeite va Seite padi OAEG TIC ONUEIWOELS TIOU €XOUV
amoBnkeutei 6To Qmemo+.
+ Ol ONPECEL Mov: MTopeiTe va SETE TIG ONUEIWOELG TTOU £XETE
Snuoupynoel oto Qmemo-.
- Capture+: Mmopeite va Seite TIG ONUEWOEIG TOU S poupyRBNKav LE T
Capture+.
+ Kadog amoppippdtwv: Mmopeite va Seite TIC ONUEITELS TIOU £K0UV
Slaypagei.
+ Néa katnyopia: Mmopeite va mpoobéoete pakéAoug.
+ /P : Mnopeite va aMAEeTe Tn 0Epd TwV PakéAwv 1 va ipoobéoete/
Slaypayete pakéloug. Matwvtag Tov Gakelo, Umopeite va aAaeTe 1o
GVOLA TOU PaKENOU.

E « Kdmotot @akehot Sev eppavifovtal dtav EeKIva apxIkd n epappoyn
paké\wv. Eppavifovtal emmiéov GAKeNOL HOVO GTav UTTAPXOUV OXETIKES

ONUEIWCEIC.

O1 S10YpAPUEVES ONHEIWOELG LETAPEPOVTAL OTOV KASO AmOpPILUATWY Kat

UmOPOUV Va avaktnOoUV evidg 7 NUePWV amo TV nuéPa Slaypagng Toug.

'Otav Bpiokeote otnv e@appoy) Qmemo-, pmopeite va aMNAEeTe Tov

TUmo 086vng av BdAete Suo SdyTula 0TV 08VN Kal Ta AMOMAKPUVETE 1y

TIANOLAOETE METAEU TOUG,

+ Kdmotot pakehot Sev epgpavifovtal dtav EeKIva apxIkd n epappoyn

QAKENWV.
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PoAot

A@unvion

Mriopeite va opioete va xtummoet To umvntript pia kaBopiopévn wpa.

1 Ayyi€te O> Ta anapaitnta> PohéL> A@umvion.

7 Natote 1o koupri -} yia va pooBEoeTe £va kawoupylo umviTrpL.
3 Alapop@woTe TIG pUBICEIS apUMVIONG Kat TIaTroTe ATToBAKEUON.

E « EQv em\é€eTe pia Kataywpion apumviong mou &ixe puBpIoTEl aTo TTAPENBOV,

UMOPEITE Va EMEEEPYAOTEITE Tal OTOIXEID TNG.

- Nava Slaypawete pia emhoy agumviong, matAOTE To koupri + > Alayp.

0TO EMAVW PEPOG TNG 006vVNG. EVAANAKTIKE, TOTHOTE MapATETAPEVA TV
agumnvion.

Maykoaouo poAdt

Mmopeite va Seite TNV TpéKouca WPa OTIG IOAELG O€ OAO TOV KOGHO.

T Ayyi&e to koupmi O > Ta anapaitnta > PoAd1 > Maykdouio poréL.
7 Natiote o koupri -} Kat TpooBEaTe pia mOAN.

Avtiotp. Xpovop.
Mriopeite va opioete va XTummoel To umvnTript META amod €va KaBoplopévo
XPOVIKO SidoTtnua.
T Ayyi&e 1o koupmi O > Ta anapaitnta > PohdL > AvtioTp. Xpovop.
7 Pubuiote Tnv wpa kai matiote Evapén.
- Ta avaoToAr Tou xpovodiakdmtn, matriote Mavon. Na cuvéyion Tou
XPOVOSIOKOTTN, TIATAOTE ZUVEXELD.

3 Matfote AlakomH yia va SIOKOYETE TOV XPOVOSIOKOTTH.

XpriolpeG papuoyeg
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Xpovopetpo
Mmopeite va XpnOIOTIOIOETE TO XPOVOUETPO YIa VO LETPHOETE TOV XPOVO yla
€vav yopo.
1 Ayyi&te O> Ta anapaitnta > Pohdt > Xpovopetpo.
7 Matiote 1o Kouuri Evapé&n yia va EEKIVHOEL TO XPOVOUETPO.
+ Tova PETPROETE TOV XPOVO yia €vav YUpo, TaToTe Lap.
3 Matfote Mavon yia va avacTe\eTe TO XPOVOUETPO.
+ [0l va OLVEXIOEL TO XPOVOUETPO, IATAOTE ZUVEXELQD.
+ Ta va dlaypdpete ONeG TIG £YYPAPES KAl VA EEKIVAOETE TO XPOVOUETPO OO
v apxn, ayyi€te Emavagpopd.

HpepoAadyto

HuepoAoyio - Mapouaiaon
Mrmiopeite va XpnolUOTOLEITE TO NPEPOAGYIO Yia TN SlayEipton CUUBAVTWY Kal
EPYOACIWV.

Mpocdrikn cupfaviwv

T Ayyi€e Sdoxika O > Ta amapaitnta > Huepohdyto.

7 EmAé€te pia nuepopinvia kat matiote To koupri €.

3 Ewoaydyete ta otolxeia Tou oupBavTog kat iatriote AMOOHKEYZH.

ZuyxpovIopog cuppdaviwy
MatioTe 1o Koupni : > Hpepohdyla yia cuyXpoviopd Kat emMEETe éva
NUEPOAGYIO VIOt GUYXPOVIOWO.

5 « ‘Otav o1 ekdNAWOELG oou amoBnKeVOVTAL Ad TN CUCKEUN GTOV Aoyaplacuod
oou 1o Google, autépata cuyxpovifovtat pe To HuepoAdyto Google,
eniong. TOTE, UMOPEIC VA OLYXPOVIOELG ANNEG CUOKEVEG piE TO HEPONGYIO
Google yia va KAVEIG QUTEG TIG CUOKEVEG Val £XOLV TIG {S1EG EKSNAWOELG TTou
£€XEL N OUOKEUN 00U Kal yla va SlayelpiCeaat TiG EKSNAWOELG 6ou TTAvw o'
QUTEC TIC OUOKEUVEC.
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Epyaoieg

Mriopeite va KataxwpioeTe EpYAOieC 0TN CUOKEUN 0ag yla EVKOAOTEPN Slayeipion
TWV XPOVOSIayPapHATWY 0ag.

1 Ayyi€e Sdoxika O > Ta anapaitnta > Epyaoieg.

7 Matiote 1o Koupmi e yla va pooBéceTe ia epyacia.

3 El00yAyeTe TIC TANPOPOPIEC yia TNV epyacia Kal iatrote ATOBARKEUOT.

Movuoikn

Mriopeite va akoUoETE Kal va SIaXEIPLOTEITE TPAYOUSIA ) LOUCIKA AAUTTOUL.
1 Ayyi&e Sudoxika O > Ta amapaitnta > Mouoikn.
7 Em\é€te wia katnyopia.
3 EmAé€te éva apyEeio MOUOIKAC.
PUBpION NXNTIKWV EPE.

EmoTtpogr oty — : e—— [1pdoBacn oe GAAeg
TrponyoUpevn 0Bovn. €TTIAOVEG.
— MeTéBaon otn AioTa
avaTrapaywyng.
— [Madon 1 avamapaywyr.
Avoige/KAeioe To Boombox — nn pavevi
show.
— Avoige/KAeioe 10 Pwg
PAag.
R *
MarhoTe yia avamapaywyr amo MatAoTe yia avatapaywyn
TNV apx TOU TPEXOVTOG apyeiou / - TOU ETTOPEVOU QpXEiOU /
MNarnore 500 GopEg yia l MarroTe TapareTapéva yia
avarmapaywyf 1ou TponyoUpEVoU ypriyopn Tpowenon.
apxeiou / MatAoTe mopaTeTapéva [ ’ » o
yia mMoTPo@r aTNV apX. L
. . _] — Emoyn Aeitoupyiag
Avarapaywyn og Tuxaia ——J ETavaANyNg.
oeipd.
Mpooapuoyr TG éviaong —e 7 +e—— AhAayn Briparog ka
fixou. it TaXUTNTaG.

MpoaBnkn 1| dlaypagn atrd
Ta ayoTrnUéva.
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5 + OplopéVEG MOPPEG apXEiwv evOExeTal va unv urtooTtnpilovTat avdhoya pe To
EYKATEOTNUEVO AOYIOUIKO.

Apyeia mou umepBaivouy To EMTPEMOPEVO OpIO HeEYEBOUG EVOEXETAL VA

TIPOKAAEGOUV GQANUATA.

+ Ta apxeia pousIKiG evoéxeTal va mpoaotatevovTal amd Siebveic katdyoug
TIVEUUOTIKWV SIKAUWUATWY 1} TOUG VOHOUG TIEQT TIVEUUATIKWV SIKAUWUATWV.
Mo va avTlypAapeTe KAmolo apxeio MOUGIKNG, UMOPE( va XPelaoTel va AaPeTe
vopipn adeia. Na va mpayatomnoloete AjPn i avtypagr vog apyeiou
MOUGIKNG, ENéYETE TPWTA TN VOLOBEDIia TTEP TIVEUUATIKWY SIKAIWUATWY 0T
XWpa 6mmou BpioKeoTe.

+ Autd to povtého umooTnpilel avamapaywyn fxou Hi-Fi. Ta apyeia rixou Hi-Fi
epgavifovral pe To ekovidio Hi-Fi.

+ ‘Otav 10 XapaktnploTiké Boombox Show eival evepyomoinuévo, n 086vn
Oeixvel OMTIKA EQE 0TN MOUGIKT. Kat  GUOKEUN Soveital Vi) TNV KOUVAG,

Launcher maiyvidiwv

Mnopeite va emAé€ete av Ba xpnotpomoteital To launcher maiyvidiwv 6mou
umopeite va Seite T AioTa pe ta maiyvidia mou €xouv eykatacTabei 0To mpoiov
Kall va eMAEyETe pUBLIoELC yia Ta TTatgvidia, OTiwG amevepyomoinon Tou RXOU Twv
TIOAUHECWV, TIEPIOPIOUO EIGOTTOINCEWY, KA.

1 Natiote O > Npdypappa Exkiv. Nayxvid..
7 Em\é€te v emoyr ou BéAeTe.

ApiOpopnxavn
Mriopeite va xpnotpomoljoete SU0 TUTOUG UTOAOYIOTWV: TO AITAG KOMTTIOUTEPAKI
KOl TN MNXQVIKK oplOpopnyav.
T Ayyi€e sdoyika O > Ta amapaitnta > ApiBpounyavi.
7 XpnoomoIoTE T0 TANKTPOAGYIO YA VOl KAVETE £VAV UTTONOYIOHO.
« Edv Bé\ete va yivel véog umohoyiopdc, matroTe mapartetapéva o {XJ.
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ThinQ

Mmopeite va cuvdéoeTe EUKONA TO TIPOIOV e GUOKEUVEG 10T yia va TIG
TIOPAKOAOUBEITE Kall Val TIG XPNOILOTIOIEITE pE Aveon.

EmAégre O > Ta anapaitnta > ThinQ,

5 + Mmopeite va KataywpioeTe MUVTHPIO POUXWY, OTEYVWTHPLO, CUCTNHA
@povTidag evéupdtwv styler, MAUVTHPLO MATWY, GOUPVO Kal GKOUTIA POMTTIOT
oTaV TO TIPOIOV BPIOKETAL OE KATAOTOON AVALOVAG.

+ Avalntiiote To orjpa ThinQ oto mpoidv yia va kataAdBete av pmopei va
ouvdeDei e TV epappoyr ThinQ.

« MNatiote = yia va udbeTe MePIOTOTEPA Yia SIAPOPEG AEITOUPYiEG TG
gpapuoyrig ThinQ.

E-mail

Email - Napouvoiaon
Mrmopeite va KataxwpioeTe éva hoyaptaopud email 0Tn GUOKELN 0ag Kal, 0T
GUVEXELD, UTTOPEITE Vo TTOPaKOAOUBE(Te Kal va oTéNveTe email ammd Tn GUoKeLR 6aG.

E « Edv xpnotuomoleite Sedopéva Kivntrg TnAepwviag, propei va emPBapuvBeite
E XPEWOELG Yia TN XPrion Sedopévwy, avaloya He To TPOYPAMMA XPEWOEWY
TIoU éxeTe EMAEEEL N0 TTEPIOOOTEPEC TANPOYOPIES, CUMPBOUNEUTEITE TOV
TIGPOXO UTINPECIWV.

Kataywpion Aoyapiacpwv email

‘OTav XPNOIHOMOIETE TNV EQapOYr email yia TpwTn Qopd, pémel va

KaTaywpioeTe Tov Aoyaplacud email oag.

T Ayyi&e Sdoyika O > Ta amapaitnta > E-mail.

7 Em\é€te éva mapoyo umnpectwv e-mail.

3 Ewaydyete T SieuBuvon email oag kat Tov KwSIKO TTPOoRaoNC, Kal TaTROTE
Emop yia va KataxwpioeTe Tov Aoyaplaopo 6ag.
+ [ va KaTaywpioeTe Pe Pun autopaTo TPOTO évav hoyaplacud email, ayyi€te

Mn autdpatn puBpion (€dv kpivetal anapaitnTo).
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Awayeipion Aoyapracuwv email
Mo va Seite 1y va emeepyaoTeite TiC pUBIoELS yia Tov Aoyaplaoud email oag,
TIaToTE T Koupni = > PuBpioelc.

« TNavampooBéoete évav hoyaplaopd, matriote Mpoabrkn Aoyaplacuou.

- Tava Slaypdyete évav ANoyaplaops, matfote To koupri = > Katdpynon
Aoyaptacpov.

Avolypa dA\hou Aoyaplacpou email

Edv éxouv Kataywptotei moAoi Aoyaptaopoi email kat BéNeTe va Seite évav dho
M\oyaplacud, ATAOTE TO KOUPTTE = Kall EMAEETE Tov GANO Aoyaplacpd amod T
Nota.

‘EAeyyo¢ email
1 Natfote 1o Koupmi == Kat eMAEETE £va YPAUMATOKIBWTIO.
7 Em\é€te éva email am6 tn Aiota email.

+ Epgavietat to privupa email.

AmooTtol email
1 NarAote to koupmi @.
7 Tupmnpwote Tn SieuBuvon email Tou AP,
3 MANKTPOAOYAOTE TO BEpA KAl TO KEILEVO TOU UNVUUATOC,
+ [a va emouvayete apyeia, TatioTe 1o Kouuni (.
« Ta va anoktroete mpdoPaon og MPOAIPETIKA OTOIKEID EVOU, TATAHOTE TO
Koupmi ¢ .
4 NartAote To koupni B> yia va oteilete 1o email.

E « [la va IpPoCapUOOETE To pPéYEDOG TG YPAUUATOOEIPAG TG AioTag
NAEKTPOVIKOU TauSpopeiov, méoTe pe U0 SdxTUAA 1 amWOTE Ta SAXTUAG
0ag.
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Eyypaen nxov HD

Me v Eyypaon fixou HD umopeite va SIapop@uveTe elpokivnta TIg puBicElg
X0V, £T01 WOTE N EYYPAPK| TOU 1XOU va TPooapuoleTal KAbe popd oTo
niepiBdov oag.

Nertoupyieg eyypagpng

Mriopeite va eyypdgete éva apxeio ixou uWNAng avaluong emAéyovtag
Kal Slapop@wvovTag T AerToupyia fixou mou BéNeTe, woTe va Taiplalel oTo
miepIBEANOV EYYPOPNG.

Ayyi€te Siadoyikd O > Ta amapaitnta > Eyypagn fxou HD > =.

Kavoviko
Mriopeite va eyypapeTe 0 Xwpic va opiceTe emmAéov pUBIOELG.

Tuvavlia
Mmopeite va eyypAyeTe fixo o€ pia cuvauvlia fj GAAN HOUGIKY eKSHAwaN.

Mpocappoopévo
Mriopeite va SlI0popQWOETE TIG EMOUUNTEG PUBLICELC VIO TNV EYYPAQK XOU.

Aerroupyia ZtouvTio

Meé tn Aertoupyia ZTouvTIo, Umopeite va TaiSETe €va apyeio RXOU i HOUGIKAG

KQl TAUTOXPOVA VOl NXOYPAPELTE TN YWV} 6aG, Va SnUIOUpYNHCETE pia ouyxopdia
NXOYPAQWVTAG TN GV 0ag TOMES POPES, KAl VA NXOYPAPHOETE Ta oXONId 0ag
TIAVW amo T0 ApXIKS APXEIO XOU TOU TAPOUCIAOTH f TOU OMIANTH.

T Ayyi&e ta eovibia O > Ta amapaitnta > Eyypagn fixou HD >=>
Mpocappoopévo.

MatAoTe To Koupi J 1.

EmAé€te éva apyeio xou mou Ba XpNOILOMOICETE WG MOUGTIKI POVTOU.
Ayyi€re o koupmi @ yia eyypaer fxou.

Ayyi€te o koupmi o yla amoBriKeLON TOU NXoyPaPnHEVOU apxeiou.

b WwWwN

E « Havamapaywyr HOUGIKRG @ovVTOoU ivat Suvath HOVO HEGW OKOUCTIKWV.
BePaiwBeite OTI £(eTE OUVEEDEI TA AKOUOTIKA TIPOTOU XPNOIHOTOIOETE
autv T AetToupyia.
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ANEG XpriOIUEG AEITOUPYIES TTOU UITOPOUV Va Xpnoipomoindouv
amo v epappoyn «Eyypaen nxou HD»

GAIN

Mriopeite va TPOGAPHOCETE TNV £VAICONGIC TOU XOU TTIOU €XEL NXOYPAPHTEL TO
MIKPOPWVO.

‘000 o uPnAd éxet optoTei n Tiur GAIN 600 o guaioBnTn €ivat n nxoypaenon
TOU fixou.

LCF

Mriopeite va @INTPApETE TUXOV UMAGOUC XOUG OTIWG TO XauNnAG BounTod Tou
KNMATIOTIKOU.

‘000 vPnAoTePa €xel pubuioTei n Tipr LCF (Low Cut Filter) téo0 kaUtepa
@NTpdpovTal ot YNNG CUXVOTNTAG HXOL.

LMT

Mrmiopei va amoTtpé el TV TIEPIKOTIH TOu nYoypa@nuévou rixou. 0co uPnAotepa
€xel oploTel n Ty LMT (Limiter) 1000 au€dvetat o aptOpog Twv fxwv xapnAig
ouxvoTNnTaG TTou Sev Ba TepIKOTTOVTAL.

E « Ta va aMd€ete Tig mpoobete pubpioelg, ayyifte > PuBuioeig, kat

0T OUVEXELD TIPOOAPUOOTE TOV TUTTO apxEiou, To BAog bit, To pubud
SetypatoAniag Kat AMEG pUBIoEIC.

« ‘Otav emAéyete Aerroupyia amo To pevol Zuvaulia Kat Mpooappocpévo,
T6TE eppaviletal 1o £kovidio Ug. Ayyi€te To Koupmi Ug kat oTn cuvéyeia
EMAECTE TO LIKPOPWVO TIOU BENETE VOl XPNGILOTIOIOETE.

« Mmopeite va ENEYXETE TNV TTOLGTNTA TOU YOV ME TO GUVEESEUEVO AKOUOTIKO
EVW EYYPAPETE TOV 1X0. KaTd TV €yypaer Xou o€ Aeroupyia ETouvTio,
n Aerroupyia mapakoAotBnong rxou Gev umootnpiletal Mmopeite va
OKOUOETE POVO TN HOUGTIKH POVTOUL.
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LG Health

Emokomnnon tn¢ epappoyng LG Health

Mriopeite va SlaxelploTeite Bépata mou agopouv T Lyeia 0ag Kal va UIoBETHoETE
KOAEC OUVIHBEIEC OWUATIKIG GOKNONG TAPAKOAOUBWVTAC TIC AOKICELG TTOU
EKTENEITE.

Elocaywyn otn Xxprion g epappoyn¢ LG Health

Mriopeite va TpoGapHOCETE TIG pUBUioELS TNG eQappoyrs LG Health dtav ekkiveite

TNV EQAPUOYH Y10 TIPWTN POPA LETA TNV EMAVAPOPA TNG.

T Ayyi€e Sdoxika O > Ta amapaitnta > LG Health.

7 AkolouBroTe Tic 08nyieg mou epgavifovTal 0TV 086vn yia va OMNoKANPWOETE
N Slapopewon.

Xpnon ¢ epappoync LG Health

v epappoyn LG Health pmopeite va Seite Baoikég minpogopieg kat va
SIOXEIPIOTEITE TO EUPOG TWV TTANPOPOPIWV UYEIDG KAl QUOIKAG AOKNONG.
1 Ayyi€te 610doxka O > Ta anapaitnta > LG Health.

7 DAiatiBeval ol Tapakatw eMAOYEG.
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= : Oeite To apyxEio KATaYPAPHC TWV CWHATIKWY OOKAOEWY 060G TN
OUYKEKPIUEVN NUEPa TIOU BEAETE Va eENéyEeTe.

- @ : &exviote va mapakolouBeite pia doknon. Kataypagetat n Sladpoun
Kall N V100N TG OWHUATIKIAG AOKNONG Yial KABE TUTTO AOKNONG TTOU EKTENEITE.

.+ :0piOTE TOUG NUEPHOIOUC OTEXOUC OWHATIKAC AoKNONG, TI Beppideg ou
B¢éNeTe va KatavohwVeTe kal Ta Bripata 1y opioTe Sid@opeg pubuioeig otnv
gpappoyn LG Health.

E « Otm\npogopieg o€ BEpata vyeiag mou mapéxovTal amod Ty Epapuoyn
LG Health mpoopiCovtal yia tnv eukolia Tou XprioTn Kai Sev mpémel
va xpnotpomoinBouv yia v mpoAnyn, Tn Bepaneia kat T Siayvwon
aoBevelv 1 AMwv MPoBANUATWY 1ATPIKAG PUONG.

+ H epappoyn LG Health evbéxetai va Slagépel rj va unv ivat Siabéotun,
avaloya E T XwPea Kal Tov TTApoxo umnpeativ. Ot Aettoupyieg ou
SwatiBevtat yia Ty epappoyn LG Health, kaBwg kat AANEG eQappoYEG
TIOU UMOPOUV Va TTPooTeBouv oty epappoyr LG Health, evdéxetal va
Slapépouv avaoya pe Tn xwpa. Autd o@eileTal GTOUG SIAPOPETIKOUG
VOUOUG KAl KAVOVIGHOUG TTOU [0XUOUV.
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Kévtpo evnuépwong

Mropeite va poBAAETE Kal VA yKOTAOTHOETE TNV TENEUTAD €kS0ON TNG
EQAPHOYNG I TOU AOYIOHIKOU TIou TTapéXeL N LG.
Ayyi&e Siadoyika O > Miayeipion > Evnuépwon eQappoync.

Awayeipion apyeiwv

Mo Ta apyeia o €xouv amoBnKEUTEl 0Tn GUOKEUN o 1 oTo cloud mapéyovTat
Suvatdtnteg mpoPolnig kat Saxeipiong.

T Ayyi&e Sadoxika O > Mayeipion > Alayeipion apyeiwv.

7 NatAote 10 koupmi = kat emAEETe TV mBupnTr TomoBecia amobrikeuong.

Smart Doctor

Mrmiopeite va xpnotpomnolroete 1o Smart Doctor yia va SlayVwoeTe Ty KataoTtaon
TNG OUOKEUNG KAl va T BENTIOTOMOINOETE.

Natfote O > Aaxeipion > Smart Doctor.

LG Mobile Switch

Méow Tou LG Mobile Switch petagépete elkola Sedopéva amod pia HETOXEIPIOHEVN
OUOKEUN O€ [0 VEQ CUOKEUN.
T Ayyi&e Sdoyika O > Mayeipion > LG Mobile Switch.
Evalaktikd, ayyi€te diadoyika O > Pubpioeig > Z0otnua > Avtiypago
ao@aleiag> LG Mobile Switch.
+ Edv n epappoyn Sev €xel eykataotadei oto mpoidv, Aapete Kat
£YKATAOTAOTE TNV €Qappoyr LG Mobile Switch amé to Google Play Store.
7 Akoloubriote Ti 08nyieg Tn¢ 006vng yia va emhé€ete T emBupunt pébodo
UETAPOPAC.
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5 « Aev Ba dnuoupynBouv avtiypaga aopaleiag yia ta dedopéva ot Evav
Noyaplaopo Google. Otav cuyxpovielg Tov Aoyaplaopé cou ato Google, ot
epappoyéc Google, ot emapég Google, To Huepohdyio Google, Ta Sedopéva
NG EQaPHOYNG ONUEIWHATWY Google Kal ot EQappoyég Tou KateRaivouv
am6 1o Play Store amoBnkevovtal otnv epappoyn Drive autépata.

+ QoprioTe MApwE TV pratapia mptv and T peTapopd Twv Sedopévuwy yia
Va amo@eUOEi N AoKOTTN amevepyomnoinon TNG CUOKEURG KaTd T SldpKela
g Sadikaaoiag,

Ikoumidia epappoy.

Mriopeite va Seite pia NioTa pe Slaypappéves EQAPHOYEG 0TV apxIKr 08ovn.
MmopeiTe va avakTAOETE pia eQappoyr Tou Slaypd@nKe TIC TENEUTAIES 24 WPEC.
Ayyi&e Siadoyika O > Mayeipion > Zxoumidia epappioy.

M0 TEPIOOATEPEG AEMTOEPELES, AVATPEETE OTO JKOUTTISIO EQAPLIOYWV.

SmartWorld

Mrmiopeite va KaTeBATETE i MEYAAN YKAMA TIAXVISIV, NXNTIKOU TIEPIEXOMEVOU,
EQAPUOYWV KAl YPAUUATOCEIPWY TTOU TIapEXovTal amod Tnv LG Electronics.
MPocapUOOTE TN GUOKELT AVANOYA LE TIC TTPOTILNTELS GAG XPNOILOTOIWVTAG Tal
Béuarta TG apykng 0ddévne.

E « Edv xpnotpomoleite Sedopéva Kivntrg TNAepwviag, pmopei va emPBapuvBeite
JE XPEWOELG Y1a TN XPrion SeSopévwy, avaloya e TO TPOYPAMA XPEWOEWY
TIOU €XETE EMAEEEL
+ Auti n Aertoupyia pmopei va pnv umootnpiCetar, avahoya e T ePLoXn
TOV TIAPOYO UTTNPEDILV.

Ayyi€te Siadoyika O > Ynnpeaieg > SmartWorld.
MNatiote + > Aoyapiaopoi LG kat cuvSedeite.

EmAé€Te Kat paypaTomolote Ain Twv OTOIXElWY TIEQIEXOUEVOU TNG
apEeoKeiag oag.

wWwWN =
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AAqYn ¢ epappoyng SmartWorld

Eav n epappoyn SmartWorld dev éxel eykataotadei, akohouBriote autd ta frypata

yla va v KateBAoeTe.

1 Natiote O > Pubpioeig> Z0otnua > Kévtpo evnpépwong > Evnuépwon
£pappoyne.

7 An6n Nota, emMé€te SmartWorld kot matiote ARYN.

RemoteCall Service

Mriopei va yivel amopakpuopévn S1ayvwon TG GUOKEURG 0a¢ yla TV emAucn
Twv mpoBAnuaTwy. ApxIKd, KahéoTe To Kévtpo e§umnpétnong mehatwv tne LG
aKoAoUBWVTAC T MAPAKATW Bripata:

E « Tla va XpnoIHOMOINCETE AUTHV T AETOUPYia, TPEMEL TTPWTA Val
OUMQWVIOETE LE TOUG OPOUE XPONG TG Aettoupyiag.
«+ Edv xpnotpomoleite dedopéva kivntig TNAEQwviag, umopei va emPapuvbeite
E XPEWOELG Yia TN XPrion Sedopévwy, avaloya e To TPOYPAUMA XPEWOEWY
TIOU €XETE EMAEEEL

1 Ayyi€te 6odoxka O > Ynnpeoieg > RemoteCall Service.
7 Mpaypartomotote kKAjon mpog To Kévtpo e€unnpétnong mehativ g LG.
3 Otav amavtnBei n kKAjon, akoAoubraTe TIG 08Nyieg TOU GLVEPYATN EMOKEVWY
Yla va el0ayAyeTe évav eEaPneLo apiBpo.
« ExTeNeiTal amopakpuopévn 6UVEEDN 0T GUOKEUN 0ag Kal EeKIVAeL n
QTMOPAKPUOHEVN UTTOOTAPLEN.

Exmopnn KupéAng

Mrmiopeite va SeiTe TIC EKTOUTTE KEIEVOU OE TIPAYHATIKO XPOVO OE KATAOTACEIG
€KTOKTNG QVAYKNG, OTIWG TUQWVES, TANUUUPEG KAl GEIGHOUG.

Ayyi&e Siadoyika O > Ynnpeoieg > Ekmopmt KUPENNG.
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Epappoyéc Google

Mriopeite va xpnotpomoljoste epappoyég Google opilovtag éva Aoyaplaoud
Google. Otav xpnotuomoleite pia epappoyr Google yia mpwtn @opd, eppavifetal
éva mapabupo kataxwplong Aoyaplacpou Google. Edv Sev éxete Aoyaplaopd
Google, SnpioupynoTe évav amoé Tn CUOKEUN 0ag. Ma AEMTOUEPEIEG OXETIKA ME TN
XPrion Hiag epappoyng, oupBouleuteite Tn BorBela otnv idia v epappoyn.

+ Oplopéveg pappoyEG evaExeTal va pnv Aettoupyolv, avaloya HE Thv
TIEPLOXN 1 TOV TTAPOXO UTTNPECIWV.

Chrome
‘Evag ypriyopog, am\og, KL ac@alng mepinynTig, @TIayUEVOG yia TOV GUYXPOVO (0TO.

Eyypaga

To Docs gival éva cuNoyIkd epyaleio emeepyaciag KelpEvou Tou eVIoXVEL
TNV MapaywytkodtnTa. Xpnotpomolrote to Docs yia va dSnuoupynoeTe, va
EMECEPYOOTEITE KAl VO GUVEPYOOTEITE OE TIPAYMATIKO XPOVO.

Google Drive

To Drive gival wpog amobrKeuong apxeiwv Kat KOV G EQAPHOYNG TTou O€
S1EUKONUVEL VA BPELG, Va MOLPACTEIG KAl UVEPYAOTEIG O projects SOUAEIAG amo
mavtou, dpeoa.

Duo

Kdve amég, upnAri¢ molotntag BIVTEOKANTELG 0TOUG GIAOUG GOV Kal 0TV
OlKOYéVeLa e Ta TNAé@wva Android kat iPhones.

Gmail

To Gmail eivat pia eUkoAn TN xprion epappoyr email mou diatnpei Ta pnvopaTd
600G A0Qar, KAVEL TO YPAUHATOKIBWTIO oag eEumvaTepo Kal oag BonBdet va giote
OPYQAVWHEVOL.
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Google

H epappoyri Google o€ KpaTAEL EVALEPO Y10 TA TIPAYHATA TIOU OE EVOIAPEPOUV.
Bpeite ypriyopeg anavtioelg, €epeuvioTe Ta evOlaQEpovTd oag, Kal Hdbete
IOTOPIEG KO TIAPTE EVNIEPWOELS Yl BEHATA TTOU GO EVOIAPEPOUV.

Xdpteg

MNdte kamov; MnyaiveTe pe Toug XAPTES, N EPAPUOYH 0TV OMOoia PMOPE(TE
va BOOIOTEITE Yio TAOAYNON OE TIPAYHATIKS XPAVO, yia Thv KukAogopia, Tn
GUYKOWVWVIQ, KOl YIol NEMTTOPEPELEC VIOl EKATOUUUPIA HEPN, OTIWG KPITIKEG Kall
SNUOPINEIC WPEC.

Eériocig
MARPNGS KAAUYN €8 OEWVY, TIC OTTOIEC CUYKEVTPWVEL ATTO TINYEG OAOU TOU KOGHOU N
epappoyn Ednoeic Google.

Owrtoypagia
To omiTl yla OAEG TIC QWTOYPAYIES KAl Tal BIVTES 0AC, AUTOLATA OPYAVWHEVD ETOL
WOTE VO YITOPE(TE va HoIpACEDTE Kall val amoBnKeVETE O,TL £XEL OHaciol.

Tauvieg Play
XpnotpomolioTe Tov Aoyaplacué oag Google yia evoikiaon r ayopd Taviwy.
Mmopeite va ayopAoeTe EPIEXOEVO Yia avamapaywyr mavtou.

Mouaikn Play

Ayopaoe pouaikr amd to Play Store. Maie T pouoikr mou givat amoBnkeupévn
0TN OUOKEUN oOu.

YnoAoyloTIKA QUANG

To Sheets eival éva cuNoYIKO epyaleio eme€epyaciag UTOAOYIOTIKWV QUANwY
TIOU EVIOXVEL TNV TTAPAYWYIKOTNTA. XpNnolpomoljote To Sheets yia va el0AyeTe, va
OPYOVWOETE Kalt va avaAUoETE MANPOPOpIES Hali O€ TPAYUATIKO XPOVO.

Mapouaoidoelg

To Google Slides €ivat éva cuNoyiko pyaleio Snpioupyiag mapousiaong mou
€VIOXVEL TNV TTapaywylKoTnTa. Xpnotpornotjote to Slides yia va opyavwoete
TIANPOPOPIEC, VO TOPOUCIACETE AMOTEAEGHATA, Kall VO TTAPVETE amopAcelg pali oe
TIPAYHATIKO XPOVO.
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YouTube
MapakoAouBnoe Ta ayammpéva cou Kavahia, GKOUOE Tr LOUCIKH TTou ayarmdg, Kat
avéPace BivTeo yla va HOIPAOTEIG e avOpwToug améd GAo ToV KOGHO.

TrRpnon onpelwcEwy
ANHIOUPYNOTE, EMEEEPYOOTEITE KOl HOIPAOTEITE TIG CNUEIWOEIG KEIEVOU Kal
QWTOYPAPLWV 0OG KE éva Aoyaplaopo Google.

Bon6dg

H ouokeun oag €xel Tov BonB6 Google evowpatwpévo. Bpeite amavtioelg Kat Kave
Tipdypata oty mopeia. MNa va Eekivioelg, amd mdta 1o kKAedi Bonbog Google oty
TINEUPA TOU TNAEPWVOU 1 AYYIEE Kl KOATA TO APXIKO KOUMTT TOU TNAEQWVOU.

E + O BonBd¢ Google dev givai S1aBECIHOG OE GUYKEKPILEVEG YAWOOES KAl
XWPEC.
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PuBpiosig

Mmopeite va TpooapUAOETE TIC PUOUITELS TNG CUOKEURC CUUPWVA HE TIC
TIPOTIUNCEIG 0QG.

Natote o koupni O > Pubpioeic.

« Edv ei0ayete Mé€n k\eidi oto mapdBupo avaditnong 0To endvw pépog
NG 006VNG, UMOPEITE va EKTENECETE TTO EUKOAA TOL OTOIXEIC TIOU TIPETTEL VOl
pubuioTOLV.

Aixtuo & Internet

Wi-Fi

Mriopeite va ouvOEDEITE e KOVTIVEC OUOKEVEC Péow SikTuou Wi-Fi.

Z0vdeon oe diktuo Wi-Fi
T Zmv 086vn pubuicewy, matfiote Aiktuo & Internet > Wi-Fi.
7 NartAote 1o koupmi () yia evepyomoinon.
+ TadaBéoua diktua Wi-Fi epgaviovtal avtopata.
3 EmAéETe éva Siktuo.
+ Mmopei va Xp€elaoTei va eloaydyeTe Tov Kwdiko mpooBaong Tou SIKTuou
Wi-Fi.
+ H ouokeur mapaleinet autrv T Stadikacia yia diktua ota omoia ixe

ouvdebei 0To mMapeABOV Wi-Fi. Av Sev BéeIC va ouvdebeic autoparta e éva
oplopévo Siktuo Wi-Fi, mdra 1o Siktuo Kat petd mdta Ataypaen.
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PuBpioeig Siktoou Wi-Fi
SV 086vn pubpioswy, matrote Aiktuo & Internet > Wi-Fi.

- Metdfaon oe diktuo KivnTA¢ ThAe@wviag: edv n Aeltoupyia tng ouvdeong
Sedopiévwv KvnTrig TNAEPwVIaE ivat evepyomoinuévn, aANG n CUCKeUN
Sev pmopei va ouvdebei oo Internet péow g olvdeoncg Wi-Fi, n cuokeun
ouvdEeTal autopata oo Internet péow tng ouvEeong SeSopéVwY KIVNTAG
AEQwviag.

E + Autij n SuvatdtnTa e€aptdTal amod ToV TAPOXO UTINPESILV.

- :TMpocappodote Ti¢ pubpioel; Tou Siktuou Wi-Fi.

Wi-Fi Direct
Mrmiopeite va GUVOEDETE T GUOKEUN 060G 0 GANEG OUOKEUEG TIOL UMooTnpi{ouv
Wi-Fi Direct yia ameuBeiag kowvr xprion Sedopévwy Ue autég. Agv gival amapaitntn
n xprion onueiov mpdoPaonc. Mmopeite va cuvdebeite e meploodTepeg amd SUo
OUOKEVEG xpnotpomolwvtag Wi-Fi Direct.
1 Zmv 0B6vn pubpicewy, matriote Aiktuo & Internet > Wi-Fi> ¢ > Wi-Fi yia
nipoxwpnuévoug > Wi-Fi Direct.
+ Ot kovTIvéG ouokeuég mou umoatnpiouv Wi-Fi Direct epgavifovtat
autopara.
7 Em\éETe Wi GUOKEUN.
+ YUvdeon mpaypaTomoLEiTal GTav n CUOKELN amodexTel To aitnpa ouvdeong.

E « Hpmatapia evdéxetat va e§avtAnBei ypnyopotepa dtav XpnollomoLeTtal
Wi-Fi Direct.
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Agdopéva KIvnTAG ThAEQWviag

Mmopeite va evepyomoleite Kal va amevepyoroleite Ta SeSopéva KvnTig
Aepwviag. Mmopeite emiong va SlaxelploTeite Tn xprion dedopévwv KIvnTrg
TAeQwviag.

Evepyomoinon 6edopévwv Kivnti¢ ThRAEQwviag

1 Zmv 086vn pubuicewy, matfjote Aiktuo & Internet > AsSopéva KIvNTHG
TAepwviag.

7 Natote 1o kouuni QD) yia evepyomoinon.

Mpocappoyn Twv pubpicewv dedopévwv KIvnTAG TRAEPWViag
1 Zmv 086vn pubuicewy, matfjote Aiktuo & Internet > AsSopéva KIvNTHG
TAgpwviag.
7 MpocappooTe TIG TapaKATw puBpicel:
+ Aedopéva KivnTrg TNAEPwviag: pUBpIoN yia xprion cuvdéoewv dedopévwv
o€ KivnTd SikTua.

Meplopiopdg xpriong petadoong dedopévwv: Béate éva dplo yia T xprion
Sedopévwy KIvNTAS TNAEPWVIAC, X€ TIEPIMTWON TTOU PTACETE AUTO TO OPIO,
Sev Oa empémetat mAéov n xprion Sedopévwy KIvNTAG TNAEQWVIAG,

. & :TIpooapuOYA TwV PUBKIoEWY SeSopEVWY KIVATAG TNAEPWVIA,

0 6ykog xpriong Sedopévwy umoloyiletal e BAon To mMPoidv Kai 0 dyKog
10U UTTOAOYI{€EL 0 IAPOXOG 0ag EVOEXKETAL VO SIAPEPEL
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PuBpioceic KAjoswv
Mriopeite va TIPOGAPHOCETE TIC PUBHITEIS KAOEWY, OTIWE Y10 TIC QWVNTIKEG
KANOELG Kal TIG EMAOYEC S1EBVWY KAOEWV.

+ Oplopéveg Aettoupyieg evdéxetal va unv umootnpifovtal, avahoya HE TV
TIEQLOXN 1 TOV TTAPOXO UTINPECIWV.

T Zmnv 086vn pubuicewy, matriote Aiktuo & Internet > Khijon.
2 MpocappooTe TIg pUBKIoELC.

Tethering

Z0vbeon Péow KIVNTIG OUOKEVNRC e USB

Mriopeite va ouvOEDETE T GUOKEUN 0€ AMN cuokeun péow USB yia kovi xprion

Sedopévwv KIvnTiG TNAEPWVIag.

T Zuvbéote T cUOKeUR 0aG Ue ANNEG CUOKEVEG Uéow Karwdiou USB.

7 Tnv 0B6vn puBpioswy, motiote Aiktuo & Internet > ZUvSeon péow KvnTAg
OUOKEUNG > ZUVEEon HEOW KIVNTAG CUOKEVNG pe USB kat 0Tn ouvéyela
nathote 1o koupri (D) yla evepyoroinon.

E + T autrv Ty emAoyn xpnotpomolovvratl dedopéva KIvnTriG TNAEQWVIag
Kal Umopei va emBapuvOEiTe pe XpEWOELS yia TN Xprion Sedopévwy,
avaoya HE TO TIPOYPAHHA XPEWOEWV TTOU EXETE EMAECEL M TIEPIOOOTEPE
TIANPOYOPIES, CULBOUNEUTEITE TOV TTIAPOYO UTINPETLWV.

« [l oUvdeon og umoAoyIoTH, KATERAOTE TO TTPOYpauua odrynong USB amd
TNV TomoBecia Www.lg.com Kat YKATAOTAOTE TO GTOV UTIOAOYIOTH.

« Aev givat Suvatr n amoatolr 1 N AYn apxeiwv PeTagld Tng CUOKEUNG
0ag Kal vog umooyloTr dtav gival evepyomoinuévn n ovvdeon USB.
Amevepyorotjote T ouvdeon USB yia tnv amootoAr i Aiin apxeiwv.

+ Ta AerToupyIk@ GUCTHAHATA TTOU UTTOOTNPI(OVV AUTOV ToV TUTIO CUVOEDNG
eivar ta Windows XP | petayevéatepn ékdoon, fj To Linux.
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®opnt6 onpeio mpocPaong Wi-Fi

Mmopeite va opioeTe TN OUOKEUT WG ACUPHATO SPOUOAOYNTH, £TOL WOTE Ol ANNEC

GUOKEVEG va umopolv va ouvdeBouv oo Internet xpnotpomolwvtag ta dedopéva

KIVNTAS TNAEQWVIOC TG CUOKEUNG 0ag.

1 Zmnv 0B6vn pubuicewy, matfjote Aiktuo & Internet > ZUvbeon péow KvNTig
ouokeunig > Qopntd onpeio mpdoBacng Wi-Fi kat énerta matjote QD) ya
gvepyomoinon.

7 Ayyi€te PUBon @opntol onpeiou mpdaBaocng Wi-Fi kat kataywpioTe T
avayvwpLoTiko kat Tov kwdikd mpdoPaong tou Ovopa Wi-Fi (SSID).

3 Evepyomotjote o Wi-Fi 0TV G\ 0UOKEUR Kal EMAEETE TO OVOpa TOU SIKTUOU
NG ouokeung otn Aiota Wi-Fi.

/' NAnktpoloyrote Tov Kwdikd mpdoBacnc SIKThou.

E « T autv Ty emdoyn xpnotpomolotvtal Sedopéva KIvTrG TNAEQWVIOG
Kal Umopei va emBapuvOEiTe e XPEWTELS yia TN Xprion Sedopévwy,
QVANOYQ E TO TIPOYPAUMA XPEWOEWV TTOU EXETE EMAEEEL M TEPIOTATEPEG
TIANPOYOPIES, CULBOUNEVTEITE TOV TTIAPOYO UTINPETIWV.

«  Mmopeite va Bpeite mepIoodTEPES TANPOPOPIEG OE AUTOV TOV LOTATOTIO:
http://www.android.com/tether#wifi
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Xpovodiakomng amevepyonoinong popntou onpeiov npoécPacnc Wi-Fi

‘Otav 1o onpeio mpoopaong Wi-Fi Sev €xel xpnotpomolnbei yia oplopévn mepiodo,
amevepyoroleital autdpata. Mmopeite va opioeTe Ty wpa o BEAETE va
EKTENEOTEI AUTOMATN AMOCUVSEDH.

Bluetooth tethering

Mia ouvdedepévn e Bluetooth cuokeun pmopei va cuvdebei oto Internet

Xpnotpomolwvtag ta Sedopéva KIvnTrg TNAEPWVIAG TG CUCKEUNG 0OG.

1 Zmv 086vn pubuicewy, matfjote Aiktuo & Internet > ZUvbeon péow KIVNTAG
OUOKEUNG > ZUV8EON HEOW KIVNTHG OUGKEUNG pe Bluetooth kai otn ouvéxeia
natrote 1o kouprti (D) yla evepyoroinon.

7 Evepyororote To Bluetooth kai 0TIC 500 GUOKEUEC, Kl TIPAYUATOTIONOTE
Ceoén.

E + o autv Ty emAoyn xpnotpomolovvral dedopéva KIvNTHG TNAEQWVIag
Kal Umopei va emMBapuVOE(Te pie XPEWTELS yia TN Xprion Gedopévwy,
QVANOYa HE TO TIPOYPAUMA XPEWOEWV TTOU €XETE EMAEEEL M TEPIOTATEPEG
TIANPOYOPIES, CULBOUNEUTEITE TOV TTAPOYO UTTNPETLWV.

«  Mmopeite va Bpeite meploodTepeg MANPOQOPIEC O€ AUTOV TOV IOTATOTIO:
http://www.android.com/tether#Bluetooth_tethering

BonBeia
Mrmopeite va mpoBalete T BoriBeta oxeTIKA pe TN Xprion ouvdéoewv kat hotspot.

TV 086vn pubpioswy, matrote Aiktuo & Internet > Z0vdeon péow KivnTiig
OUOKEUNG > BorjBela.
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Nertoupyia mtiong

Mriopeite va amevepyomolfoeTe TIC Aettoupyieg KAong kat SeSopévawv KivnTig
Aepwviag. Otav auth n Aertoupyia givat evepyomoinpévn, ot Aeltoupyieg mou
Sev amartolv T Xprion Sedopévwy, OTwg matkvidia Kat avamapaywyr HOUCIKAG,
Tapapévouy SlaBEoIpEC.

T Zmv 0Bovn pubuicewvy, matriote Aiktuo & Internet > Aettoupyia mriong.

7 Matote Evepyomnoinon otnv 086vn empBeBaiwong.

Aiktua KIvn TG TNAEQWViag
Mrmiopeite va TPOCAPHOCETE TIC PUBKITELS SIKTOWV KIVNTAC TNAEQWVIAC,
T Zmv 0B6vn puBpicewy, matiote Aiktuo & Internet > Aiktua KivnTrg
mAepuwviag.
7 Mpooapp6oTe TIC TapaKATW pUBpIcEI:
- Mepraywyn dedopévwv: Opiote autrv TV emMAOYH yla VA EMTPENETE OTN
OUOKEUN 600G va Xpnolpomolei ta dedopéva KivnTtrg TnAepuviag dtav
BpiokeoTe o MePLAYWYI EKTOG TOU KAVOVIKOU GaG SIKTUOU.

Aertoupyia Siktuou: EmAEETe TUMO SikTUOUL.

- Ovopata onpeiov mpdaBaong: MNa epgdvion 1) aAlayr Tou onpeiov
TIPOOaoNG yla T XPron UNPESIwV SEGOHEVWY KIVNTAG THAEQVIAC. MNa
va aMGEeTe To onpeio mpooBaong, emAéETe éva aTolyEio amd Tn Aiota
onueiwv mpooBaong.

+ Etaipeieg Siktvou: Na avarnon mapdxwv SiKTuou kal autopatn ouvdeon

o€ kamolo Siktuo.
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VPN

Mmopeite va ouvdebeite o€ éva ao@aNég eIKOVIKO SiKTUO, TIX. O EVa ECWTEPIKO
€TAPIKO SiKTUO. MMTOpE(TE £MONG Vol SIOKEIPIOTEITE TA GUVSESEPEVA EIKOVIKA
1SlwTiKa SikTua.

Mpoa6rikn VPN
1 Zmv oBdvn pubuicewy, matfjote Aiktuo & Internet > VPN.
7 Matiote To koupmi -

5 + Auti n Aertoupyia givat StaBaotun Lovo epdoov gival evepyomoinuévn n
Aermoupyia Kheldwpatog 006vne. Edv n Aertoupyia kAeldwpatog 006vng
eival amevepyomoinuévn, eppavifetal pia 086vn eidomoinong. Ltnv 066vn
eldomnolrioewv matriote ANayn Yl va EVEPYOTIOICETE TN AerToupyia

KAELBWHATOG 000VNG. MNa AEMTOPEPELE, AVATPEETE OTNV EVATNTA PUBLION
KAglbwpatog 066vng.

3 Ewaydyete ta otoixeia tg ouvdeong VPN kat matriote AmoBrkeuon.

Aapdépewon Twv pubpicswv VPN
T Tt Aota VPNS, emAé€te éva VPN.
7 Ewoaydyete Ta otolyeia Moyapiacpou xprotn VPN kat matriote Zovéeon.

- [a va anoBnkeVoETe Ta oTOIXEIQ TOU Aoyaplacpoy, mAEETe To MAaiolo
ehéyyou AmoBrikeuan aTolxeiwv Aoyaplacuov.

I61wTtikd DNS

Mriopeite va Slapop@woeTe TiG emhoyég IS1wTikoy DNS (Domain Name System).
T Zmv 086vn pubuicswy, matiote Aiktuo & Internet > I8wtikd DNS.

7 Kavte v emhoyr mou Bé\ete kai motriote AmoBrikevon.
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Tuvdedepéveg CUOKEVEG

Bluetooth

Mriopeite va GUVOEDETE T GUOKEUN GOG O€ KOVTIVEG CUOKEUEG TIou umtooTnpilouv
Bluetooth yia avtaMayr SeSopévwv e QUTEC. ZUVOEDTE T GUOKELN 00 O éva
OKOUOTIKS Kat éva MANKTPOAOGYI0 He Suvatdtnta Bluetooth. Etot o éNeyxog Tng
OUOKELNC Bal gival EUKONOTEPOC,

Z0Ceuén pe AN cuokeun
1 Zmv 0Bovn pubuicewy, matiote Zuvdedepéveg ouokevéc > Bluetooth.
2 NartAote 10 koupni () yia evepyomoinon.

+ O18100¢01uEC OUOKEVEC EavifovTal auToHaTa.

- Tava avaveqoete T Nota ouokeuwy, atfote ().

E + Movo 01 GUOKEUEG TTOU €XOULV OPIOTE! WG 0paTEC EPaviCovTal ot AioTa.

3 EmAé€Te pia ouokeur amd tn Aiota.

/I AkohouBroTe TIC 08nyie¢ Tou pgavifovtal atny 006vN yia va
TIPOYHOTOTIOIOETE EAEYXO TAUTOTNTOC.

E + Autd T0 Bripa TAPCAAEITETAL YIa CUOKEVEG OTIG OTIOIEG EXEL UTTAPEEL
TP6oPaon oTo MaPeNBoV.

Anootoln edopévwy péow Bluetooth
T EmAé€te éva apyeio.
« Mmopeite va oteilete apyeia MOAUPESWY 1) OTOIXEIQ EMAPWV.
7 Natjote < > Bluetooth.
3 EmAEETE ot GUOKELK TIPOOPIGHOU VLA TO apXEiD.
+ To apyeio amooTENETAL LONIG YiVeEL AOSEKTO A Tr CUOKEUK TTPOOPICHOU.

E «+ O181ad1Kacieg Kovrg xpriong apxeiwv evoéxetat va Slapépouv avahoya e
TO apxeio.
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Kowvn xprion 0066vng
Mmopeite va avamapaydyete Tnv 08vn Kal Tov X0 TG OUOKEUNG OF i
Sl0(OPETIKI) GUOKELN, OTIWE Jia TNAEOPacn, Tou umooTnpilel Tn Aettoupyia
Miracast.
T Zmv 0Bovn pubpiccwy, matriote Tuvdedepéveg cuakevég > Ko xprion
006vnc.
7 Natote 1o koupni (D) yia evepyormoinon.
3 EmAéETe pia GUOKEUR a6 Tn Ai0Ta TWV KOVTIVGV GUCKEUWV.
+ Edv n ouokeun mou Béete Sev epgaviletar, matriote Avalitnon yia va
QVAVEWOETE TN NioTa.

« Agou emteuyOei oUvdeon, oTn ouokeun Ba eppavioTei n 08évn Tou
TNAEPWVOU 0aC.

« Hepappoyn Kowig xpriong 006vng amevepyoroleital autopata v dev
UTTAPXEL KOVTA CUOKEUN GUURATH HE TN SuVATOTNTA KOIVAG XPHONG.

NFC

Mrmopeite va XpnOILOTIOICETE TN GUOKEUN WG I KAPTA Yia Ta Péoa MalIKNG
METAQOPAC 1 WG TMOTWTIKA KApTa. Emiong, pmopeite va kovorolrioete Sedopéva
o0& GN\EC CUOKEVEC,

T Zmv 0Bovn pubuicswy, matrote Zuvdedepéveg ouokevéc> NFC.
7 Natote 1o koupni (D) yia evepyormoinon.

« Ayyi€te T ouokeun oag e AMn cuokeun ou umootnpilel NFC yia
avtohayn dedopévuwv.

5 + Hkepaia NFC umopei va Bpioketal o€ SlaQopeTIkd onpeio avaloya Ue Tov
TUMO OUOKEUNG. 0l AEMTOPEPELEG OXETIKA HE TNV TIEPLOXT TNG KEPaiag NFC,
avatpé€te otV evotnta EmMokomnon otolxeiwv.

PuBuioeig 157



Mivakag kovomoIoewv

Mmopeite va KoOToIOETE EPIEXOUEVO a6 To ANUTTOUR, TN MOUGIKR Kat T
Alayeipion apyeiwv oag og KOVTIVEG OUOKEVEG. Mmopeite emiong va KovomoloeTe
TO TIEPLEXOUEVO OE OUYKEKPIUEVA ATOHO OE EQAPUOYEG TTOU UTTOOTNPI(oLV TN
Suvardtnta dueong kotvomoinong tng Google (Google Direct Share).

T Zmv 080vn pubpicewy, matriote Zuvdedepéveg ouokevég > Nivakag

KOIVOTIOINCEWV.

7 Anevepyornojote kdOe emoyn xpnotponotwvtag 1o pubuoTikd @ .

+ Kovtivég ouokevég: Mmopeite va EPQAVIOETE TIG KOVTIVEG OUOKEUEG HIE TIG
OTIOIEC UMOPEITE VAL IOIQAOTEITE TIEPIEXOLEVO QMO TIC EPAPHOYEC ANUTTOUY,
Mouaikn kat Alaygipion apyeiwy,

- AmeuBeiag Kowvr Xprion: Amé pia epappoyr mou umootnpilel
Suvatdtnta dueong kovoroinon tng Google (Google Direct Share),
UTOPEITE VA EPPAVIOETE €val EIKOVISIO TTOU 0O EMTPEMEL Va PolpAleaTe
TIEPLEXOEVO |IE CUYKEKPIEVOUC AVOPWITOUG.

Kowvi Xprion Apxeiou
Mriopeite va oteileTe 1 va AAPETE apyeia avapesa 0Tn GUOKEUN 0ag Kal 08 ANAN
ouokeun 1 tablet tng LG.

T Zmv 0Bovn pubpicewv, matriote Tuvdedepéveg cuakevég > Ko xprion
apxeiov.

7 MpooappdoTe TIC TapaKATw puBpicEl:
+ V50 ThinQ: yia va aAAEeTe To GVopa TG GUOKEUNAG.

- AmoBrKeuon GE: 0PIOTE TOV PAKENO TIPOOPIOHOU YIa TNV ATTOBNKEVON TWV
apxeiwv mou amooTéNovTal armd AANEG GUOKEUEC.

+ Kown Xprion Apxeiou: yia va emrpépete T Ajbn apxeiwv mou
anootéNovtat and AAEC GUOKEVEC.

- SmartShare Beam: yla va HOIPAGTEITE APXEID e ANNEG CUOKEUEC LEGW TOU
SmartShare Beam.

- BonBeia: umopeite va Seite T BoriBeta yia Tnv kovomoinon apxeiwv.
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Alakopioti¢ mMoAUpEowY

Mriopeite va oIpAOTEITE TIEPIEXOMEVO TTOAUMEOWV OTN CUOKEUN| 0QG HE KOVTIVEC
OUOKeVEG Tou umooTnpiCouv DLNA.

1 Zmv 006vn pubuioswy, matote ZuvSESEUEVEC CUOKEVEC > AIOKOUIOTHG
TOAUHECWV.
7 Mpocapp6oTe TIG TapaKATw pudpicel:
+ Kotwn xprion meplexopévou: HoIpaoTEiTe TIEPLEXOMEVO TTOU BPIOKETAL OTN
GUOKEUTN 00 € AANEC KOVTIVEG GUOKEVEC.
+ V50 ThinQ: opioTe T0 6vopa TNG GUGKEUNG 0aG

E +Avaloya P To TIPOI6V TOU XPrOTN, T OVOMATA TWV UEVOU EVOEKETAL VA
Sla@épouv.

+ To mepIEXONEVO POV GE KOWVI) XPrioN: EMAECTE TOV TUTTO TOU TIEPIEXOHEVOU
TIOAUPECWV TIoL Ba POoIPATEDTE e ANNEG GUOKEUEC.

- E§ouolodotnuéveg ouokeuég: Seite Lo NioTa e TIG CUCKEVEG TTOU
EMTPEMETAL VA £XOUV TIPOGRAON OTO TIEPIEXOEVO TNG OUOKEUNC OOIC.

+ Mn-eYKeKPIPEVEG CUOKEVEG: SEITE Lial NiOTal IE TIC CUOKEUEC TTIOU Sev
EMTPEMETAL VA £XOUV IPAGPAON OTO TIEPIEXOEVO TNG OUOKEUNG OOIC.

LG AirDrive

Mmopeite va xpnotpomolroeTe Tov Aoyaplacuo oag LG yia va Stayeipioteite
Ta apyeia mou €xeTe amoBnkeVOEL OTN GUOKEUH PEow UTIOAOYIOTH. AV gival
amnapaitntn n cuvdeon USB.

T Zmv 0Bovn pubuicswy, matriote Zuvdedepéveg cuokevég > LG AirDrive.

2 Xpnowomotote évav uévo hoyaplaopo LG va ouvdebeite oo LG Bridge otov
uroloy1oTh kat To LG AirDrive oTn cuokeun).

+ Mmopeite va katePaoete To Moylopiko LG Bridge amo  Sievbuvon
www.lg.com.

3 MOXEPIOTELTE AT TOV UTIONOYIOTH Ta APXEia TTOU BPIOKOVTAL 0T GUOKEUN.
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MirrorLink

Mriopeite va GUVOEOETE T GUOKELN O€ éva auToKivnTo péow USB yia va
XPNOIHOTIOIOETE TNV EYKATEGTNHEVN 0T CUOKeUN @appoyn MirrorLink amé to
ovotnpa infotainment 1 TV KEVTPIKI HovAda TOU AUTOKIVATOU.

E « Auti n egapuoyn Siatibetat pévo o€ autokivnta mou umooTnPilouv
MirrorLink.
« KateBaote v epappoyr MirrorLink amé éva katdotnpa epappoywv. Ma
TIEQIOOOTEPES MANPOYOPIEC, EMOKEPTEITE https.//mirrorlink.com/apps.
+ Oplopéveg Aettoupyieg evdéxetal va meplopioval 0Tny mpooTacia Tou
TIPOYPApHaATog 0drynong 6tav xpnotpomnoleite T Aettoupyia MirrorLink.

1 Zmv 0B6vn pubuicewy, matfiote Zuvdedepéveg ouokevEG > MirrorLink.

7 TUvB£0Te TN OUOKEUN O QUTOKIVITTO XPNotpomolovTag To KaAodio USB kat
evepyomolwvtag T emhoyr ZOvSeon péow KaAwdiov USB.

E « Edv n cuokeun oag givat ouvdedepévn o Oxnpa mou umoatnpilet
autépatn avvdeon MirrorLink, n Aertoupyia ocuvdeong péow kahwdiov USB
EVEPYOTIOIEITAL QUTONATA OTN GUOKEUN GO,

« Matote = yiova Slapop@oeTe T autdpatn cOvseon MirrorLink USB.

Extomwon

Mriopeite va GUVOEDETE T GUOKEUN GO O évav ekTumwTr Bluetooth kat va
EKTUTIWOETE TIC PWTOYPAPIEG 1} TA Eyypapa TTOU £XOUV AITOBNKEUTE( OTN GUOKEUN.
SNV 086vn pubpicswy, matrote Zuvdedepéveg CUOKEVEG > EKTUTIWON.

+ MNatAote MpoemAeypévn UNINPEGia EKTUMWONG yia va Yivel avalitnon
EKTUTIWTAV LE TOUG OTT0IoUC popeite va ouvSeBeite. H natiote + >
MpooBrKn eKTUNWTWV yla va TPOCBECETE XEIPOKIVNTA évav EKTUNTWTH.

+ Matote (+) NpooBrikn utmpesiag yia va A\ABETE TV EQAPUOYN TOU EKTUNIWTH
mIou BéAeTe.

E + AutA n Suvatotnta givat Stabéotun povo otav To Siktua KIvnTrg
TAe@wviag 1 n Aetoupyia Bluetooth gival evepyormoinpévn.
« Tava NaBete TV epappoyr extunwtr oto (+) Mpoadiikn ummpeciag, 6a
TIPEMEL TPWTA va ouVSEDE(TE aTOV Aoyaplacpo oag Google.
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Hxo¢
Mriopeite va TpooapHOCETE TI PUBITELS ixou, Svnong kal eildomotioewv.
SV 086vn pubuioewv, matriote HYog Kal TPOCUPHOGTE TIG TAPAKATW PUOLICEIG:
« Hynmikd mpoil: aA\d€te T Aettoupyia fixou o€ ‘Hxog, Mévo dévnon, ry

Tiyaon.

- 'Evraon: puBuion Tng évtaong nxou yia ta Sidpopa oToIxE(a.
+ 'Hxog kAfong: EmAE€Te évav xo KAong yia eloepxopeves KAoeLS. MpooBéote

1) Slaypayte rixoug KAjong.

+ 'Hxog ei8omoinang: EmAéEte évav rixo eidomoinong. OpioTe éva HouGIKO

KOUMATI TTOU £€XEl AmOBNKEUTEL 0TN GUOKELN WG X0 e18omoinoNG.

+ 'HYo¢ kAfjong pe d6vnon: Pubpiote Tn ouokeur yia dévnon Kat avamopaywyn

X0V KAONG TauToXpOva.

« Ringtone ID: Snpioupyei évav rixo KAong yla pia El0EPXOHEVN KARON amo pia

OUYKEKPIUEVN EMTOQN.

+ To @Mag avapel otav umdpyxet eloepXOpevn kKAfjon: Pubpiote va avaBooprivet

TO QAAG CUUPWVA PE TOV X0 KAonG TG LG.

+ Mnv evoyAeite: OpioTe TV wpa, T SIAPKELD Kal Tov TUTTO EQappoYG yia Ta

omoia 6a AapBavete unvopata eidomoinong. Mmopeite va AapBavete unvopata
€160TOI0EWV POVO OE GUYKEKPIHEVEG NUEPEC TNG ERGOUASAC.

ModTNTa RXOU Kalt £QE: XpNnoIUOTIOIoTE TN AgIToupyia yia va pubuioeTe TNV
TOIOTNTA X0V Kal TA EPE KATA TV avamapaywyr vog Tpayoudiou 1y Biveo.

- 'Evtacn 86vnong: mpooapuooTe Ty évtaon tng S6vnong.

Tunog 66vnong: pmopeite va emAé€ete Tov TUMo ddvnong mou Ba
evePYOTIOLETAL KOTA TN AYN KAOEWV.

Advnon katd 1o matnua: 0pioTe T cUOKeUN va Soveital 6Tav ayyileTte
0pLopEva aTOlYEl TNV 006VN.

"Hyog mAnktpoloyiou kKAfjoewv: EvepyomolroTe To NXNTIKO EPE Yia TO
TANKTPOAOYI0.

"Hyog mAnktpoloyiou LG: EvepyomoioTe To NYNTIKO QE yia To TANKTPOAGYLO
LG.

‘Hyog a@nig: EvepyomolfioTe éva @€ fxou yla dTav MOTATE O€ €va OTOIKEIO.

+ 'Hxo¢ kAedwpatog 080vNng: EvepyomolrioTe éva ep€ rxou yia otav KAEIGwveL iy

Eekheldwvel n 0Bovn.
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MpofoAn

Mmopeite va TpooappOoeTe AeMTOUEPEIC PUBHIOELS yial kABE TUTO 0BGVNC.
3TNV 086vn pubpicswy, matrote MpoBoAr Kal TPOCAPHOCTE TIC TOPAKATW
pubpioelc:

« ApxiKr 006vn: TPOCUPHOOTE TIG PUBKITELS yia TV apxIKr 086vn. Ta

AemTopépeleC, avaTpESTE 0TV EvOTNTa PUBLITEIC ap)IKn¢ 086vNG.

- OOvto & Opa: EmAéCTe pia Tametoapia 086vng, éva Bépa, éva eikoviblo Kau

éva AOD yla T ouoKeun 0ac.

« Tpappatooelpd: ANAETE TO PEYEDOC TNC YPAUMATOOEIPAC, TV VTN TNG

YPA@NG 1 TN YPAPUATOCEIPA.

+ New Second Screen: EmiAe€e mw¢ n ypappr KATAOTAONC KAl Ol YWVIES TG

€pappoyns Ba gaivovtat.

« Tpapun moriynon: PuBpiote o 0TUA TG ypaupng morynong. MNa
AemTopépeteg, avatpé€te otnv evotnta AAayr] Tou oTiA Twv MANKTPWY a@rg
apxIKr¢ 086vng.

AOD (always-on display, Aetroupyia eugpaviong mavra): va eugavifovtat

TIGVTA TIANPOPOPIEC OTIWG N NUEPOUNVIQ, N WPA KAl Ot EISOTIOIATELC, AKOHA Kal

otav n 084vn sival anevepyomolnuévn. MNa Aemtopépeleg BAéme AOD (always-on

display, Aerroupyia epgaviong mavta)

« Avetn mpoBoAr: pUBUIOTE TN CUOKEUN €TOL WOTE VA LEIWOETE TNV TOOOTNTA
TOU MIMAE QWTAC 0TNV 086V Kall VA TIEPLOPIOETE TNV KATATIOVNGON TWV HOTIGV.

« Nerroupyia vuxTag: Mmopeite va eQapUOCETE éva axvo Béua 08évng yia va
amo@UYETE TNV €vtovn Adpyn tng 08évng katd T Sidpkela TG VOXTAC,

+ Xpwpa 086vng: Pubpiote to xpwia, T Beppokpacia xpwpatog A Ti¢ Tiuég RGB
yia tnv embupnT 084vn.

5 « Matiote O IO VOl EMAVOPEPETE TIG PUOLICELG.

- Evioxuon Bivteo: Katd tnv avamapaywyr evog Bivieo og Aettoupyia mirpoug
0006vng, pmopeite va aMAEETe TIG puBUIioEL WOTE Ta xpwHaTa va mpodAloval
MO PWTEIVA KAl SUVAMIKA.
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+ KMHAKwon eQappoyng: TPOCAPHOOTE TO UEYED0g 0B8OVNE TWV EQAPHOYWV.

Noyog SlaoTdoewv
« Auti n ouokeur éxel Aoyo Slaotdoewv 19,5:9.

- Evdéxetat kamoleg An@Beioeg epappoyEg va pnv umootnpifouv Tov Adyo
Slaotdoswv 19,5:9.

Y& aQUTAV TNV TEPIMTWO, EMAEETE TIC PENTIOTEC avahoyieg 086vNn¢ yia Thv
£papuoyn 1} amoTadeite 0ToV MAPOXO TNG EPAPHOYNAG VIO TTEPIOOOTEPES
TIANPOYOPIES.

- Mmopeite va emAéEeTe TV avaloyia EIKOVAG yla EEXWPIOTES EQAPUOYEG
natwvtag oto () > Pubpiceig > MpoPolr > KMipdkwon epappoyic.
Emé€te Tov Adyo Slaotdoewv mou Bélete: ZupBardtnta (16:9), Tumkn
(16.7:9) kau MAREng 006vn.

-+ MéyeBog 006vng: Opiote 1o péyebog Twv oTolxEiwv 0TV 006VN 6MWE 6ag
BoAevel Kamota otolyeia evdéxetal va ald&ouv Béon.
« Avaluon 006vng: PuBpiote Tnv avdhuon tng 08évng.

E « Otav aM\alete v avéhuon tng 086vng, KAEiVouv Kal ol EQappoYEG TTou
€EKTENOUVTAL EKEIVN TN OTIYUA.

- QwTEVOTNTA: XPNOIUOTIOIOTE TN YPAWr KUAONG Yial Vo OANGEETE TN

QWTEVOTNTA TNG 08OVNG TNG CUOKEUNG.

AuTOpaTO: PUBIOTE TN CUOKEUN TOL WOTE N PWTEIVOTNTA TNG 086VNG va

puBpieTal auTépaTa CUPPWVA LUE TNV EVTAOT GWTOE TOU TTEPIBANOVTOC.

N\ xpovikol opiou 086vVNG: ATEVEPYOTTOLEITAL AUTOHATA N GUOKEUN 6TV
Tapapével og adpAvela yia éva KaBoplopévo Xpoviko Sidotnpa.

+ Autopartn mepiotpo@r 000vng: Meplotpépetal autdpata n 086vn avaloya pe
TOV TPOGAVATONGHO TNG GUCKEUNG.

+ Mpo@UuAaén 086vne: EpgpaviCetat mpo@UAagn 0Bévng 6Tav n CUCKEUR €xel

ouvdebei otn Bdon ry Tov @opTioTh. EmAEETe Tov TUMO MPo@UAAENG 006vVNG

mou BéAeTe va eppavietal.

006vn pe 1o éva xépt: MiKpUveTe To péyeBog TG 08vng, £T01 WOTE va

UTTOPEITE VOl XPNOIUOTIOIELTE Tr) GUOKEUN LIE TO €Vl XEPL. ZUPETE TO TTANKTPO

APRG APXIKNAG 08AVNE 0TO KATW PEPOC TNG 086VNE P0G Ta aploTepd 1y Se€id.
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KAeidwpa 006vng & ac@paleia

Mmopeite va TpooappOoETE TIC pUBIOELS TNG 00OVNE KAEIGWHATOC KL TNG
ao@alelag.

1
2

YV 08dvn pubpicswy, matiote KAeidwpa 080vng & acpdleta.

MpooappooTE TIG pUBUIoELC.

+ Google Play Protect: Zapwvel Tn cuokeur} cou kabnpepva yia mbavég
BAapepéc epappoyéc.

- EOpeon ouokeunq: Mapakoloubriote v Tomobeoia TG GUOKEUNG
QMOUOKPUOMEVA. MTTOPEITE EMIONG VA TIPOOTATEYETE HUE AOPANEL TA
Sedopéva oag edv XAOATE T GUOKELN GOG.

+ Evnuépwon aogdletag: EAeyxog yla evnuépwon AoyiopIKou Kat
SlapopPWon PUBUIcEWV AUTOUATNG EYKATACTAONG,

+ Evnpépwon cvotiparog Google Play: EAeyxoc yla evnpépwon
ovotripatog Google Play.

Alohé€te KAeidwpa 000vng: EMAEETE T uéBodo Kheldwpatog 08dvng mou
OéNete. Mo NemTopépeleC, avaTpé€te 0T evotnTa PUBLION KAEIGWLIOTOG
06dvne.

« Mapapetpomoinon KAEWWpatog 000vng KA wpatog: ANayr Twv
TIANPOPOPILWV TTOU ppavifovtal TNV KAEWGwpEVN 006V,

PuBpioeig acpaloug kKAeldwpatog: ANMAETE TIC pubpioelg KNS wHaATog

ao@aleiag.

+ AAKTUA. ATOTUNIWHATA: XPNOILOTOOTE TO SAKTUNKG 00 amoTUMwHa yia
va EekAeldwoeTe TNV 086V 1 To TIEPIEXOLEVO. N0l NeMTOpEPELEC, avaTPESTE
atnv evétnta Avayvwplon SakTUNIKWv amotunwudtwy - [apouvaiaon.

+ Avayvwplon TPoowou: Yag emtpénel va EEKAEIOWOETE TV 006vn pe
TO TTPOOWTIO GAC. Mol AETMTOUEPEIEC, AVATPEETE OTNV EVOTNTA Avayvwplon
npoowmou - [lapouaciaon.

+ Kheibwpa mepieyopévou: ag eMTpEmel va 0pioeTe TUTTO KAEWSWHATOG
(kwd1kd mMpdoPaong 1 poTiBo) yia ta apxeia QuickMemo+ Kat ZuAoyrc.

+ Kpunrtoypdgnon & Siamoteutripia: Alapop@woTe TIC PUBUITEIC yia ThV

KPUMTOYpA@non Kai Ta SlamoTeuTrpla Tg kdptag SD.

- Kpumnrtoypd@non kdptag SD: Kpuntoypa@rioTe TV KEPTA PVAKNG Yia va
AMOTPEPETE TN XPRON TNG 0€ AN CUOKEUN. Mo AETTTOUEPELEG, VaTPESTE
0TV evoTtNnTa Kpurmroypdenan Kaptag UviunG.
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- Ao@aAG EKKIVNON: TTPOOTATEVOTE T CUOKEUN 00 opilovTag va gival
KAeISwuévn Katd v evepyomoinor e Ma Aemtopépete, avatpédte
oTnV evoTNnTa PUBLION aopaloUg ekkivhong.

Mpootacia Stamoteutnpiou: MPoBoAr TUTOL TOU XWPEOU AMOBrKEUONG

omou Ba amoBnKeUTE TO MOTOMOINTIKO ACPAAEIQC.

- A&iomota Siomoteutripia: Mpofolr Twv pilikwv motomoinTikwv CA

TOU OUGTAHOTOE 00G Kall TwV ToToToINTIKWY CA Tou €xouv eyKataoTtadei

amnd 1o xprotn.

Aamotevutiipla Xpriotn: MpoBoAr kat ahayn Twv ac@aiwy

TIANPOPOPIWVY TOTOTMOINTIKOU TTOU €ival amoBNKEVHEVES 0T GUOKEUN

oag.

- Eykatdotaon amo Tov amoBnkeuTiko xwpo: Eykatdotaon evog
00@QANoUE TOTOTOINTIKOU amd pia povada amobrKeuong.

- ExkaBdpion Siamoteutnpiwv: Aaypa@r ao@awV TMOTOMOINTIKWY TOU
£€XEL EYKATAOTIOEL O XPIOTN KAl TWV OXETIKWV SIAMOTEUTNPIWV.

+ PUBMon kKAeldwpatog kdptag SIM: KAEWOWOTE 1 EeKAEISWOTE TNV KAPTA

USIM, i aMG€te Tov Kwdiko mpooBaonc (PIN).

AlOYEIPIOTEG GUOKEUWV: EKXWPNOTE SIKAIWHATA Yia Va TIEPIOPICETE TOV

€NeyXO0 N} TN XPON TNG OUOKEUNG OE GUYKEKPIUEVEG EQAPUOYEG.

+ Trust agents: EygpavioTe Kat xpnotpomoote ta trust agent mou €xouv
€YKATAOTAOE 0T GUOKEUN.

+ Kapeitoa 006vng: Pubpiote v 086vn epappoywv £T01 WOTE va gival
Suvatr HOvo N xPrion TNG EGAapUOYNE TToU €ival evepyr TNV eKAOTOTE
atiyun.

+ MpdoPacn xpriong: Seite AeMTOPEPELEG OKETIKA LIE TN XPHON EQAPUOYWV
OTN OUOKEUH.

Anodppnto

Mrmopeite va Bpeite kat va aM3EeTe ONeC TIG pubicelg amopprTou 6ag.
1 Zmv 086vn pubuicswy, matote AméppnToO.
7 MpooappooTe TIC PUBKITELC.
- SlayeplotigAdeia: Tag emrpémel va Seite kal va aMdeTe Ta Sikaiwpata
TIOU €XETE SWOEL OTIG EQAPHOYEG.
+ K\eidbwpévn 086vn: Zag emrpénel va opioeTe TIG E160MOIRTELS Tou Ba
epgpavifovtal otnv 086vn KAeldwpaTog.
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- Na @aivovtat ot Kwdikoi mpdcacng: Evepyomolote autriv Ty emoyn
yla va ep@avifetal yia 6UVTopo SlaoTnpa KABE XapakThpag Tou Kwdikou
TIPOGRACNC KABWC TOV MANKTPOAOYEITE WOTE VO BAEMETE TL ELOAYETE.

+ Ymnpeoieg autopatng supmiiipwaong and tn Google: Evepyomolrote
auTAV TV €MAOYN yia va Yivetal l0aywyr Twv TANPOQopIV TIou
ival amoBnkeupEveC 0TO Aoyaplacpo oag, omwe Kwdikd mpdoBaong,
S1euBuvon 1 apIBpoL TMOTWTIKNAG KAPTAC Ue éva Povo Tatnpa. Mmopeite
€TONG VOl ATEVEPYOTIOIOETE AUTHV TNV EMAOYH, VA XPNOIUOTIOIOETE TN
Aetrtoupyia Autopatng cupmipwong tng Google iy va mpocBéaete éva véo
Moyaptaoud urnpeoiog.

- lotopiko TomoBeciag Google: Lag eMTPEMEL VO EVEPYOTIOINOETE 1 va
amevepyoroloeTe To loTopiko TomoBeaiwv. Otav €xel evepyomoindei, n
Google amoBnkevel MEPIOSIKA Kall XPNOIUOTIOLE! Ta IO TTPOoPaTa Sedopéva
TomoBeaiag Tou TNAEQWVOU 0ag o€ GUVSUACHS HE TO AOYOPLAOHO 0OC
Google.

TtV 066vn loTopikd TomoBeoiwy, TATAOTE + yia va Seite Kayf va
Slayelploteite Ta Sedopéva TOMOBESINV 0.

+ 'EAeyxol Spactnpidtntag: EmAECTE TIC SpaotnpIoTNTES Kt TIC TANPOPOPIES

iou BéAete va amoBnkevet n Google.

Ala@npioelg: Zag emrpénel va Seite To avayvwploTIKO Sla@npicewv kal va

0pIOETE EEATOUIKEVEVEC DIOPNUIOELC.

+ Xprion kat SiayvwaoTikd: Evepyomoiote autrv tnv emAoyn yla va
ouvTeNéoeTe 0TN BeTiwon TG epmelpiag Tou Android Péow TG autopaTng
amooTolr¢ SlayvwoTiKwy dedopévwy, SeSopévwv GUOKEUNE Kal Xprong
gpappoywv otn Google.

TomoBecia

Mriopeite va eNéyEETE TOV TPOTIO TIOU KOVOTIOIOUVTAL Ol TANPO@OpiEC TomoBeaiag
00 Kal va puBpiceTe Ta SIKawpaTa TPOGRACNE OTIC MANPOPOpieg TOMoBEeTiag
oag,

3V 086vn pubpioswy, matrote TomoBeoia kal puBpioTe Tn Asttoupyia mou
BéNete.
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Enextaosig

Smart Doctor

Mriopeite va xpnotpomotrjoete 1o Smart Doctor yia va SlayvwoeTe Ty KataoTtaon
TNG OUOKEUNG KAl Vol TN PEATIOTOTIOINOETE.

YV 086vn pubuicgwy, matriote Emektaoeig > Smart Doctor.

Context Awareness

Mriopeite va aAdleTe autopaTa TIC pUBHICEIG TNG CUCKEUNG 00G avAAoya e TO
potifo xpriong kai tnv Tomobeaia.

1
2

Ynv 086vn pubpioswy, matrote Emektdoeig > Context Awareness.
Evepyomoiriote ta oTolxeia yia Ta omoia OéAeTe o1 puBpioelg va alalouv
autopara.

+ BonBo¢ otabpeuong: Auth n emhoyn anmoBbnkevel To onpeio 6mou
otabuevoate To Oxnud oac. Edv Sev Béhete va AapPdvete ldomolrnoelg
0TabEUONG OTaV EXETE TAPKAPEL KOVTA OTO OTIITL ) TOV XWPO EPYATIAg
oag, amevepyomnoloTe TG eidorotroelg Ta pépn pouv QD). Ot eyypagé
otabueuong amobnkevovtat oto QuickMemo+.

+ AYTOMATOIOIHMENA: Mmopeite va puBLICETE TN GUOKEUN £TOL WOTE
va aAaouv autopata ot emhoyég mpo@il fixou, Bluetooth kat Wi-Fi og
Slagopetikd mepiBalovta, omwg Oikia, Ektog oikiag, Epyaaia, Ektdg
epyaoiac. Mmopeite emiong va puBpioeTe va avoiyel pia epappoyn otav
ouvdeBolv aKouoTIKA 1 ia cuoKeun Bluetooth.

E « [la va XpnoIHOMOICETE AUTHY T SLVATOTNTA, TTPEMEL VA EXETE OPIOEL OTN

pUBIoN Ta uépn pou T TomoBeaia TnE oIKiag 1 TG Epyaciag oag. Ty

0006vn pubuiogwy, matriote TomoBeaia > Ta pépn Hou yia va puBUIcETE TIG

Tomobeoiec.
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Mawyvidt

Mmopeite va Slapop@UOETE TIG PUBITELC yia epYalEia Kal Ypa@Ikd matxviSiwy,
KaBw¢ Kat yia tn SuvatdtnTa 0IKOVOUINONG UMATAPIAG.

T Zmv o0bovn pubpicewy, matriote Enektaoelg > Matyvidia.

7 MpooappéoTe TIC TapaKATW puBpIcEIC:

- Npéypappa Exkiv. Nagvid: Matiote QD yia va XpnoIuonooeTe 1o
launcher maiyvidiwv.

+ Epyaleia magvidio0: Mmopeite va ektehéoete T Aettoupyia otav mailete
matgvidia maTwvTag Ta epyaleia maixviSiol amoé Ta KOUPTA agnc NG
apXIKRG 006vNG

« Tpagika matxvidiou: Pubpiote ta ypagikd Tou maixvidiov.

5 + Eav aMd€ete Tv avdhuon og oplopéva maiyvidia, n Suvatdtnta mpoBoArg
0006vNg evEEXETAL Va PNV AEITOUPYET OWOTA.
+ Auti n Aertoupyia evoéxetat va puny gival S1aB€o1pn o€ EQAPHOYEG
TIAKVISIWV.

+ Adhelppa: Melwote T QuTEVOTNTA TG 006VNG Kat Ty amodoon Kabe
POPA TTOU SIOKOTITETE TO TalYVIOL Yia TIEPIOGATEPO AMO 5 NemTd.

Kataypagn 006vng
Mriopeite va Sl0pop@WOETE TIG PUBLICELC yia Kataypagr 08dvng.
1 Zmv 006vn pubuicswy, matfote Enektdoeig > Kataypagr 086vng.
7 MpooappooTe TIC TAPaKATW PUBIcEIC:
+ TupmePINGPETE TOV EAUTO 0OG OTO BIVTED PE TIG TAPOKATW EVEPYELEG:

Kavte pia amo Ti¢ mapakdtw emAoyEC Kat matriote AmoBrkeuon.

- Ewkova: MephapBavel v ekova mpo@il cag oTo Bivieo Katd tnv
kataypagr. AQATou KaveTe autriv Tny emhoyn, matiote @) kau emhégte
pia ekova mPo@il. XTn cuvéxela, pubuioTe To PEyeB0E TG EIKOVAC
XPNOOTOIWVTAG TO PUBHIOTIKO.

- MnpooTtivij Kapepa: ZupmepNapBavel kataypagr Tou autol oag
XPNOILOTIOIWVTAG TNV MITPOCTIVH KAEPT, KATA TV KATAYPAP TNG
08ovng.

- Moté: Aev mepihapBavetal Timota.
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« Tnyn rixou: EmAEETe TV myn riou peta&y Mixpogpwvou kal
Mepieopévwv.
+ Avaluon Bivteo: EmAéETe TNV avaluon yia Ty Kataypaer 08évng.

Ma kataypagn ¢ 00dvng

1
2

METaQEPETE TN ypapun KaTAoTaonG oG Ta KATw yia va avoi§eTe Tn Niota
elkoviSiwv ypriyopng mpoéofacnc.

(Edv xpelaoTei, mepdoete To SAKTUAO apPIOTEPA EMAVW QMO TNV TIEPIOXT| TWV
eikoviSiwv ypriyopne mpooBaonc.) Matrote o koupmi .

Awapdote ™ SnAwon amomoinong eubuvng kai matrote Evapén. H kataypaen
Ba &exviioel og 3 Seutepolena.

Ma va Slakopete Ty Kataypagr, matrote o (=) mou Bpioketat 0To Katw Seli
uépog TN 08évnc. To Katayeypaupévo Bivieo Ba amobnkeutei 0o AAUTOUH.

E «+ Edv mapapidoete ta Sikaiwpata AAou atépou, omwg To Sikaiwua

TIOPTPETOU 1 TO SiKaiwpa TTVEUHATIKAG I810KTNGIOG 1} SIABANAETE T Gripn
AM\ou aTtépOoU XPNOIUOTIOIWVTAG TIG AEITOUPYIES TTOU TTAPEXOVTal Yia TNV
UTINPEDIa Kataypagrg 086vng, VEEXETAL VA UTIOOTEITE AOTIKN ) TIOWIKT
Siwén 1 S10IKNTIKO TPOOTIHO CUMPWVA E TOUG IoXVOVTEG VOpOUG. H LG
Electronics dev @épel kapiia euBOVN YIa TIG EVEPYELES TWV XPNOTWV.

AR E@appoyn
Mmopeite va eykataotioete SU0 Popég pia epapuoyr avtoAayfig UNVURATWY
07O TIPOIOV Kal va XpnotpoToleite SU0 AoyaplacpoUg Tautdxpova.

1
2
3

Ynv 08dvn pubpicswy, matriote Emextdoeig > A Eappoyn.

Metd thv avdyvwon tng SAwong amomoinong, matriote EmpPeRaiwon.

Y Aiota StaBéoipwy epappoywy, matrote Eykatdotaon yia va

EYKATAOTAOETE £va QVTiypapo TG EQappoyng Kat akoAoubnoTe Tic odnyieg

iou epgaviovtal otnv 08dvn.

+ XV 08dvn gppavietal n Niota Twv Slabéoipwv Stmwv epappoywv. Katd
TN SIAPKELD TN EYKATACTACNG, OTNV apxIKr 086vn mpooTiBevtal eikovidla
TWV EPOPHOYWV.
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Floating Bar

Mmopeite va eveQYOTIOIOETE AEITOUPYIEG TTOU XPNOIHOTIOIEITE CUXVE, OTTWG
GUVTOUEVDELG, OTIYUIOTUTTA 086VNG, HOUCIKN KAl EMAYEC, TATWVTAG TTAVW OTO
Floating Bar atnv 086vn kat o0povTdc To yia va Bpeite Tn Asttoupyia mou BéNeTe.
MNa Aemtopiépeieg, avatpéte otny evotnta Floating Bar - [apouaiaon.

JUVTOMEVCEIG

Mriopeite va xpnolpomoLEiTe KOUUTIA GTTWG TO KOUITTE evepyomoinong /
KAEISWUATOC, TO KOUTTE évTaong Xou kat To Google Assistant yla ApEo eTéNeon
GUYKEKPILEVWY EQAPHOYWV 1) AETOUPYIWV.

T Zmv 0Bovn pubuicswy, matriote EMeKTAoEL > ZUVTOUEUOELC,

7 MpooappooTE TIC TAPAKATW PUBICEIC.

MpoBoln mivaka eidomooewv: MepdoTe To XéPL 0aG MPOG TA KATW/EMAVW
oToV AloONTAPA SAKTUNKWY AMOTUNTWHATWY YIa VO EUPAVIOTEL O TTIVAKAC
e16omoloEwWV.

Avotypa Owrtoypagikiic Mnxavig: Matriote 500 @opég To MARKTPO
EVEPYOTTOINONG YIa VA AVOIETE TNV KApEPQ.

Avotypa Capture+: Matriote 5U0 QOPEC TO MARKTPO AlENONG TNG

£€vTaonG nxou yla va avoiete tn Aertoupyia Capture+ dtav 1o KAeISi givat
KAELSWHEVO 1) aTTEVEPYOTIOINPEVO.

Avotypa Qwtoypagikiig Mnxavig: Matrote o miriktpo Meiwong évtaong
800 Popéc yia va avoiete Tn Asttoupyia Kapepa dtav to kAedi ivat
KAELSWHEVO 1) QmEVEPYOTIOINKEVO.

Avotypa Google Bon04g; Matriote to mArjktpo Tou Google Assistant oTo
TINGL TOU TNAEPWVOU.

- Milfjote oto Google Bon8o¢: Kpatriote matnuévo 1o mriktpo tou Google

Assistant yia va LIAAoETE ypriyopa e Tov Bon0o oag.

« TpoPoAr ontikoU ottypiétumou: MNatriote 1o MAKTPo Google Assistant

5

SU0 POPEC Yia va SeiTe €va OTIYUIATUTIO TNG NUEPAC 0AG OTNV EQAPHOYN
Google Assistant.

+ To Google Assistant dev umootnpiCel OAEG TIG YAWOOEG.
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KnockON

Kdvte StmAo mdtnpa ot 006vn yia Vo VEQYOTIOIOETE 1) VOl AMTEVEQYOTTIOIOETE
Tnv 0Bdvn.

Ma Aemrtopépeleg, avatpéte otnv evotnta KnockON.

Auénon evaieOnoiag 006vng agng

Mmopeite va kdvete Ty 006vn a@rg Mo guaioBntn oTo dyytyud oac. Mpoteivetat
VQ EVEPYOTIOIEITE TO XAPAKTNPIOTIKO AUTO OTAV XPNOIUOTIOLEITE TPOOTATEUTIKO
0Bovnc.

3TNV 086vn pubpioswy, matrote Emektdoelg > AvEnon evaiabnoiag agng.
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Wneakn eunpepia & yovikoi éAeyyot
Mriopeite va Seite Tov Xpdvo Xpriong Tou mpoidvTog Kat va pubpiceTe 1o
XPOVOUETPO Yla KABe epapoyr). Mmopeite emiong va SIaxelpIOTEITE ToV XpOvo
XPioNG Tou KIvNToU TAAEPWVOU XPNOILOTIOIWVTAC TN Aettoupyia MpogTotpacia
Umvou kat T Aertoupyia Eotiaon.

EmAé€te Wnelakn eunpepia & yovikoi éNeyyot otnv 086vn pubpicewv kat
puBpiote Tn Aettoupyia mou BéeTe.

Epappoyéc & eidomoinoeig

Mriopeite va Seite pia NioTa yKaTaoTNHEVWY EQAPHOYWY KAl VA SIAHOPQWOETE
TIC PUOLIOELS YO E160TTOINTELC, SIKAUWUATWY EQAPHOYWV Kat GANAL.

1 Zmv oBo6vn pubuicewy, matriote EQappoyég & E160MOINOE,

7 MpocappooTe TG pUOKIoELC.

Mnatapia
Mriopeite va Seite TIC TpéXoUTEC TANPOYOPIES YA TNV prmaTapia 1 va
€VEPYOTIOIOETE TN AEITOUPYia EE0IKOVOUNONG EVEPYELQG.
1 Zmv 0Bdvn pubuicswy, matote Mmatapia.
7 MpooappooTe TIC TapaKATW pUBpIcEIC:
+ Xprion pmatapiog; Ggite AeMTOPEPELEG YIa TN XPrON TNG UMATApio.
+ Z1a6pn pmatapiog ot ypappn Katdotaong: Epgavifetal n otddun tng
HmaTapiag wg mocoaTd 0T YPOUM KATACTACNG.
+ Bekuiotomoinpévn @option: NMpocappdote Ty TaxlTnTa pOpTIoNG
OUMPWVA HIE TOV TPOTIO POPTIONG Yia va PelwBei n BeppdtnTa Kat va
napatabei o xpdvog (wn¢ NG prmatapiag.

+ MNpoocappoyn pratapiag;: Emtpémnel €oikovounon evépyelag SIOKOMTOVTAC
TN AEIToUpYia EQAPUOYWV 0TO TTAPACKIAVIO.
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- Meplopiopoi povTou: EvepyomolroTe QUTAv TV EMAOYH Yl va TIEPIOPICETE
TNV EKTENEON EPAPHOYWVY OTO TTAPACKIVIO YIa EE0IKOVOUNCN EVEPYELQG
KaTd TN XPron TG cuokeung. Ot papuoyég mou meplopiovTat yia Adyoug
£€0IKOVOUNONG EVEPYELAG EVEEKETAL VA NV AEITOUPYOUV OWOTA 1 va UNnv
00 OTEAVOUV EIGOTIOINCEL.

- E§olkovopnon evépyetag: Melote TV katavaAwan 1ox0og TG pmatapiag

emAéyovTag XapnAOTePN TIUK O€ OPIOPEVES PUBLICELS TG GUOKEUNG, OTTWG

TN QWTEVATNTA TNG 08OVNG, TNV TAXUTNTA TOU AEITOUPYIKOU OUGTHHATOS

Kal v évtaon tng Sévnong.

E€aipéoeig e§oikovopnong evépyetag: EmAECTe TIC epapployég mou

ONETE VO XPNOIHOTIOLEITE XWPIG KAVEVAV AEITOUPYIKO TIEPIOPIOHO TIOPA TN

Aettoupyia e€otkovopnong toxvog fi BeAtioTomoinong pmatapiag.

AmoONKEeUTIKOC XWPOG

Mrmopeite va TpoBANETE Kall va SIOEIPIOTEITE TOV ECWTEPIKO XWPO AMOONKEUONG

0T OUOKEUN 1} TOV OmOBNKEUTIKS XWPO 0NV KAPTA VNG,

T Zmv 066vn pubpicewy, matriote AMOBNKEUTIKOG XWPOC,

7 MpooappooTe TIC TapaKATW puBpIcEIC:

+ EowtepIkOG amoOnKeUTIKOG XWPOGE: A€iTe TOV CUVOAIKO XWPO

amoBrKeVoNG Kal Tov ENEVBEPO XWPO OTOV ECWTEPIKS XWPO amoBrikeuong
TNG OUOKEUNG. AgiTe pia NoTa e TIC EQApPUOYEG TIOU XPNGILOTOLoUVTaL KAl
TOV XWPO amoBAKEVONG TTOU KATAVOAWVEL N KaBepia.

+ Kapta SD: Agite Tov 6UVOAIKS XWPO amoBrikeuong Kat Tov eAelBepo
XWPEO 0TNV KAPTA PVANG. AUTr N emAoyn epeaviletal Lovo otav Exel
TomoBeTnBei kApTa PvApNG. Ma va amevepyomoIoETE TNV KAPTA PVARNG,
TIATAOTE

Noyapracpoi

Mrmopeite va mpooBEoeTe XPNOTEC LE TOUG 0moioug Bal XPNOIUOTIOLEITE OO KOWVOU
Tn GUOKEUN Kal va Snpioupynoete éva Aoyaptaopd oto cloud.

1 Zmv 0B6vn pubuicewy, matiote Aoyapilacpoi.

7 MpooappooTe TIg pUOKITELC.
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Google

Mriopeite va xpnotpomolioeTe TG pubpioel; Tou Google yia va SIaxeIpIOTEITE TIG
€pappoyéc Google Kal Tig pUBLICELS TOu AoyapLaopoU.

SV 086vn puBpicswy, matiote Google.

Zuothua

Kévtpo evnpépwaong

Mriopeite va TpoBANETE Kall VOl YKATAOTAHOETE TNV TEAeUTaia €KSoon TG
€(QapUoyNG 1 Tou AoyIopIKoU Tiou mapéxel n LG.

1 Zmv 086vn pubuicswy, matfote Z0oTnpa > KEvtpo evnuépwonc.

7 Mpooapp6oTe TIC TapaKATW pUBIcEIC:

+ Evnuépwon pappoyng: EAeyxog edv undpyel SlaBéotpn evnuépwon
£QApHOYNG. EQv umdipxel, UMOpEiTe va EYKATAOTHOETE TNV EVNUEPWHEVN
ékdoon.

+ Evnpépwaon AoyiopikoU: Eheyxog eGv umdpyel S1abéoipn evnuépwon
Noytopikou. Edv umdipyel, UTOPE(TE Va EyKATAOTAOETE TV EVNHEPWUEVN
£kdoon.

Mwooa & eloaywyn

Mmopeite va mpooapudoETe TIC pUBUITELS YA\WOOAC Kat TANKTPOAOYIOU yia T
OUOKEUN 00,

T Zmv 0Bovn pubuicgwy, matrote Zuotnpa > NAWooa & TANKTPOAGYIO.

7 MpooappooTE TIC TAPaKATW PUBIcEIC:

- M\waooa: EmAéETe Y\wooa yia T GUOKEU.

- Aayeipion minktpoloyiwv: Mmopeite va aAagete T pubuion yia 1o
Baotko MANKTPOASGYLO TOU TIPOIOVTOC, Va pUBIcETE Ta EPIBANOVTA
XPoNC yia To MANKTPOAGYI0 LG 1} GANa eyKATESTNUEVA TTANKTPOAOYIA KAl VOl
puBpioeTe TN Asrtoupyia avayvwpiong opthiag yia €ioodo pe Ty epappoyn
Google Voice. Mmopeite emiong va emAéEeTe av To Koupmi MAnKTpoloyiou
Ba eppavifeTal 0TV MEPIOX TWV KOUUMWY aPriG 0NV apxIkr 086vn, wote
Va UMOPE(Te va PETaBeiTe ypriyopa o€ AN TANKTPOAGYLO.
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+ Mpaypatiko MAnKTpoAoyto: EMAEETE yia va XpnOIUOTIOIOETE TO KAVOVIKO
TIANKTPOASYIO 1 yia va TTPOBAANETE TIG GUVTOUEVTELG TTANKTPOAOYIOU.

+ Ymnpeoia autopatng cupmAnpwong: Evepyomoote autriv Ty emioyn
yia va yivetal eloaywyn Twv MANPOQoPLWV TV €ival amoBnKEUUEVEG
070 Aoyaplacpé oag, omwg kwdiko mpdoPaong, Sievbuvon ry
ap1BpoL MOTWTIKAG KAPTAC UE éva Povo mdtnua. Mmopeite emiong va
QITEVEQYOTIOIOETE AUTHY TNV EMAOYK, VA XPNOILOTOICETE TNV AUTOHATN
ouumAnpwon tn¢ Google fj va mpocBéoete éva véo Aoyaplaopd umnpeciog.

+ Metatpomnn Kelpévou o€ pwvn: AlapopPWOTE TIC PUBLICELS YA HETATPOTTH
KEIEVOU O OUINIQL

+ Tayutnta Tou Seiktn: PubpioTe v TayUtnTa Tou SeiKTn TOu TOVTIKIOU 1)
Tou trackpad.

AVTIOTPO®N TTARKTPWV GTO TTOVTIKL: avTIOTPEWTE TO Se€i Koupi Tou
TIOVTIKIOU Y10 Va EKTEAEL PAOIKEG EVEPYELES ALIETOU XEIPIOHOU.

Hpepopnvia & wpa

Mriopeite va TPOOAPUOCETE TIC PUBHIOELG NHEPOUNVIAG KAt WPAG YL TN CUCKEUN
oag.

T Zmv 066vn pubuicswy, natote Zuotnpa > Hpepopnvia & wpa.

2 MpocappooTe TIig pUBKIoELC.

Mvripn

Mmopeite va Seite évav Péco o yia TNV KATAVAAWON MVAKNG Yia éva

GUYKEKPILEVO XPOVIKO SIA0TNHA, KABWGE KAl TNV TOGATNTA UVANG TTOU

KOTOVOAWVEL L0l EQOAPHOYT.

1 Zmv 0Bdvn pubuicewy, matote ZooTnpa > MvAun.

7 MatioTe To KOUTT w yia va opioEeTe Wia XpovoBupida yia avaktnon
Sebopévv.
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Avtiypago ac@aleiog

Mriopeite va SnpioupynoeTe avtiypaga acpaleiag yia Sedopéva mou eivat
amoBnKeUPEVA 0T GUOKEUN 0OG O€ i GAAN GUOKEUN 1) AoyapLaopo.

1 Zmv 086vn pubuicswy, matote Zootnpa > Avtiypago ac@aleiac.

7 MpooappéoTe TIC TapaKATW puBpIcEIC:

+ LG Mobile Switch: Zag emtpémel va petagépete Sedopéva amo pia malid
OUOKeUN LG o€ pia véa ouokeun LG. MNa Aemtopépeleg, avatpé€te otnv
evotnta LG Mobile Switch.

+ Anpioupyia avtlypd@wv ac@aleiag Kat emava@opd: Snpioupynote
avtiypaga ao@aleiog Twv GES0UEVWY TNG CUCKEVNG 1 EMAVAQEPETE
Sedopéva 0Tn GUOKEL 0ag amd KATolo avTiypa@o acaleiag.

A + Me tnv emava@opd Tng oUOKEUNG evEéxeTal va Slaypagpouv apyeia
avTIypa@wv acpaleiag mou €xouv amobnKeUTEl oTOV XWPO amoBrKEUONG.
BeBaiwBeite 61 éxete avtypdel kat amoBnKeLOEL GTOV UTTOAOYIOTH 0aG Ta
avtiypagpa ao@aAEiag Twv OnUAvVTIKWV apxeiwv oag.

« Avtiypago acp. Google: ANayr Twv pubuicewv avtypd@ou acealeiog
Tou Google drive. Mmopeite emiong va mpoBaNeTe Tov Aoyaplacpd
Snuioupyiag avtypdewv ao®aleiag o xpnolpomoleital i va mpooBéoete
€vav véo Aoyaplacpo dnuioupyiag avtlypdewv ac@aleiag.

Enavekkivnon & emavagopad
Mriopeite va KAveTe EMavaQopdA TG GUOKEUNG TEPAApBavOUEVWY Twv PUBHIcEWY
SIKTUOU Kal EQAPHOYWV.
T Zmv 066vn pubuicewy, matriote ZuoTtnua > Emavekkivnon & emavagopd.
7 NpooapudoTe TIC Tapakdtw pubpiceIC:
+ Autdpatn emavekKivnon: AUTOUATN EMAVEKKIVNON Kal Tpooapuoyn
TOU TNAEYWVOU € KaBopIopévo Xpdvo. Matrate To koupni QD yia va
£VEPYOTIOINOETE AUTH TN AelToupyia. H GUOKEUT EMAVEKKIVETAL AUTOHATA
o€ KaBoplopévo xpdvo kai BeAtioTomoteitat autdpata. EmAégte Ty
NUEPOUNVia Kal TNV wPa yia TO Bloypa@ikd onueiwpa.
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E + Mmopeite va pubuioete T cuokeun va §ekivd Eavd pia opd Ty eBdoudda.
H GUOKEUI EMaVEKKIVETAL AUTOUOTA OE pial Wpa amo TV MPokaBoplopévn
wpa.

MEeTA TV EMAVEKKIVNON TNG GUOKEUNG, Ol EI60TOINCELS Kat Ta EUBARpaTa

Katapyouvtal. AmoBnkevoTte onpavtikd Sedopéva mpiv amod v

mipokaBopIopévn wpa.

+ H Aertoupyia autopatng emavekkivnong dev ivat evepyr oTi¢ akOAoubeg
nepmwoelg: Otav n 086vn gival evepyomoinuévn, dtav n CUCKEUN ivat oe
Xprion, 6tav n otéun tng pmatapiag eivat 30% f Aiydtepo, dtav n Kapta
USIM eivat kAeldwpévn 1 To KAeidwua 0UOKEUN gival evepyomoinuévo dtav
I GUOKEUN ElVal EVEPYOTIOINPEVN.

- Avdloya e ToV TTAPOYO UTINPEDLWV TNAEMKOVWVIWY, N AElToupyia
QUTOUATNG ETTAVEKKIVNONG EVOEXETAL Va NV gival SlaBéotpn.

- Emava@opd twv pubpicewv SIKTUoU: emavagépel Tic pubpioelg Wi-Fi,
Bluetooth kat d\\eg pubpioeig Siktuou.

Mnd&eviopog mpotiuioewy epappoyng: Emavagopd twv pubpicswy yia pia
epappoyn. Aev Ba Staypagpouv ta dedopéva mou gival amoOnKeupéva 0TV
£pappoyN.

Emava@opd epyooTactakwV SES0PEVWV: EMAVAPEPEL ONEC TIG PUOLICELC
yla T ouokeun Kat Staypagel ta dedopéval.

E + H emavekkivnon Kat n emava@opd TnG CUGKEUG 00U Slaypapel OAEG
Ta edopéva mavw 6" auTrv. BANTE To Gvoua TG OUOKEUNG 0ag, TOV
Noyaplacpd Google Kat GANeG apxIKEG TANPOQopiES Eava.
« Metd v apyomoinon twv Sedopévwy, Sev gival duvatr n Emavagopd
TOUG.

ZXETIKA pE To TNAEPWVO

Mriopeite va Seite MANPOQOPIES OXETIKA LIE TN OUCKEUN 0ag, OTIWG TO OVOud TG,
TNV KaTAoTaON, TA OTOIXEIX YIa TO AOYIGHIKO KOl VOLIKEG TTANPOQOPIEC.

3TNV 086vn pubpioswy, T oTe ZVOTNHA > IXETIKA Ue TO TNAEPWVO Kal SEITE TIG
TIANPOYOPIEC TTOU 0AG EVOLAPEPOLV.

PuBuioTiko mhaicto & ac@dlela

Mmopeite va SeiTe TIC PUBUIOTIKEG ETIKETE TIG OXETIKEG TANPOPOPIES OTN GUOKEUN|
oag.

2tnv 00vn pubpicgwy, matiote ZOoTpa > PUBIOTIKO MAaicio & Ac@alela.
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Mpoofacipotnta
Mriopeite va SlaxelploTeite TI TPOOONKES TPOOaCIUATNTAG TTOU £XOUV
€yKataoTabel 0T OUOKEUN 0aG,

1
2

Ynv 08dvn pubuicewy, matriote NpooPacipétnra.

MPoCaPHOOTE TIC TAPAKATW PUOLICELS:

‘Opaon > TalkBack: PuBpiote tn cuokeur| va oag ei8omolel péow Guvng yla

TNV KATAOTAoN TNG 006VNG 1) V1o EVEPYELEC.

+ 'Opacn > Owvnikég eildomomoeig: Pubpiote T ouokeur va SlaBalet ta
OTOIXEID EI0EPKOUEVNG KAONG HEOW QWVIG.

- 'Opaon > lpappatocelpd: AANAETE To pPéyeBoC NG YPAUUATOOELPAC, TV

£VTaon NG YPAPAG N TN YPAUUATOOEIPA.

‘Opaon > MéyeBog 006vng: Opiote 1o péyebog Twv oTolxeiwv otnv 086vn

omwg oag BoAevel. Kdmota atolyeia evdéxetal va aMda&ouv Béon.

+ 'Opaon > MeyéBuvon a@nig: yla peyéBuvon i opikpuvon maTwvTag oty

0006vN TPEIC POPEC.

‘Opaon > Mey£Buvan mapabupou: mpaypatomolnote peyébuvon 1

OikpLVON EVTOE TOU TaPABUPOU Kal AVTIOTPEWTE TO XPWHA.

+ 'Opaon > Meydahog Seiktng movTikioU: peyeBuvete Tov Seiktn Tou
TIOVTIKIOU.

+ 'Opacn > 006vn uPnAig avTiBeang: OKOUPUVETE TO XPWHA YOVTOU Yia

006vn uPnAng avtiBeonc.

‘Opaon > AvTioTpo@r XpwHATWY 006vNnG: AunoTe Tnv avtifeon

XPWHUATWY TNG 086VNG 1o ATOMA PE TIEPIOPIOHEVN Opach.

+ 'Opaon > PUBon xpwpdtwv 080vng: MpooapuooTE To XpWHA TG
0Bovng.

+ 'Opaon > Movoypwpn: aMAEte Tn Aeitoupyia tng 086vng o KAipaka Tou

YKPL

‘Opaon > Teppaniopog KAong pe To MARKTPO Tpopodosiag: TEpHaTIoTe

Mo KAon e To TATNA TOU TTARKTPOU EVEPYOTIOINCNG/KAEISWHATOC.

+ Akon > Aeldvteg: EvepyomolioTe Tnv umnpeacia UMoTiTAWY KaTA TV
avamapaywyn Bivteo yia dtopa pe mpoBAUaTa akong.

Akon > AvaBooprivetl LED: S10moTwOoTE TV KATAGTAON TNG CUOKEUNG PEOW
LED.
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« Akon} > Eidomotjoeig @Aag: pubLioTe T GUOKEUN Va 0O EVNUEPWVEL LE
QWG IOV avaBooPrVEL YIa EI0EPXOUEVEG KAATELS, UNVUUATO KOl AQUTTVIOELG.

+ Akor} > ATopOvVWwGn OAWV TWV AXWV: AIMOUOVWON OAWV TwV AXWV Kal
XOUNAGTEPN OTABKN évTaong fixou oTov SéKTN.

« Akor> Kavaht rixou: emAé€Te Tov TUTTO rYOU.

+ Akor> looppomia You: TPOcapUOOTE TNV I6oppoTTia 650U fXOU.
XpNOMOTOIOTE Tr VPO KOMONG Yia va aANAEETE TNV IG0PPOTTIL.

+ Kwnuikétnta kat yvwon > Touch assistant: evepyomolr|ote Tov mivaka
QPG YIa EVKOAGTEQN XPHON TWV KOUUTTIIWV KOl TWV KIVAGEWV.

+ Kivnuikétnta kat yvwon > Elcaywyn agrg: KatoywproTe Keipievo
TIOTWVTOG TAPATETAUEVA TNV 080VN 1} TPOTIOMOIOTE TO MATWVTAC ONAG TV
006vn.

+ Kivntikétnta kot yvwon > Mpaypatikd mAnKTpoAdyLo: mposaprOOoTE TIG

puBpioelg Tou MnKTPOoAOYiOU.

KivntikotnTa Kat yvwon > Autopato KAIK TovTIKoU: Snuoupynote

auTdpata KNIK Tou G€IKTN TOU TTOVTIKIOU O€ TIEQIMTWON amouciag kivnong.

+ Kwvnuikétnta kat yvwaon > Ayyi§te mapatetapéva yla va KAvete KAjon:

amavTAoTE fj amoppiPTe KAOEL TATWVTAC TOPATETAEVA TO KOUWTTE

KAjong, Kat Ox1 e 0apwary Tou.

Kivntikotnta kat yvwon > AREn xpovikou opiov 006vng: va

QTEVEPYOTTOLEITAL AUTOUATA N CUOKEUN OTav Tapapével oe adpdvela yia éva

KaBopIOoPEVO XPOVIKO SIdoTnpa.

Kivntikétnta kat yvaon > Mepioxr eENéyxou apng: meplopioTe tnv meploxn

APNG £TOL WOTE 0 ENEYXOG APG Va Eival SUVATOG OVO OE VA GUYKEKPIUEVO

TUAMA TG 006vNG.

+ ZuvTtopeuan AeToupylwv TPooBactudTnTag: yia ypriyopn mpdopaon oe
NEToUPYiEC TTIOL XPNCIUOTIOIETE CUXVA TIATAOVTAG TPEIS POPEG TO koupi ).

+ Autopatn mepiotpo®r} 080vng: aMAlel auTOPATA 0 TPOCAVOTONOHOG TNG
006vng avaloya e TovV IPOsavATONOMO TNG CUOKEUAC.

+ Amazon Assistant: To Amazon Assistant mpoo@épel autopatn oUyKpLon
TIPOIOVTWV VW YwVICETE O EMAEYHEVES EQOPHOYEC TNG GUOKEUNG OAG.

- EmAEETE y1a EKQWIVNON: Zag EMTPEMEL VO TTATATE OPICHEVA OTOIYEID YIa VOt
NapBAvete TPoYopIKN avatpo®odoTnon.

+ AN\ayn mpoopacng: Anpioupyriote cuvéuacpoUg MMKTPWY yia va
ENEYXETE TN GUOKELN 00G.

PuBuioeig 179



Mapaptnua



PuOpiosic y\wooag LG
Em\é€te Y\OOA yla TN GUOKEU.
« Ayyi&e siadoyika O > Pubioeig > Tuotnpa > FAdooa & TANKTpoAGyio >
Mwaooa > NMPOZOHKH MQXTAY kat emAEETE pia yY\ooa.
- Ayyi€Te Kal KPATAOTE TO KOUHTTI == Kal GUPETE TO OTO EMAVW PEPOG TNG
NoTaG Y\wOoOoWV Yia Vo TO 0PIOETE WG T YAWOOoa POEMAOYNG.

LG Bridge

LG Bridge - Mapouaiaon

To LG Bridge eivat pia epappoyr mou oag Bon6a va Slayelpileote eVkoAa Ti¢
(QPWTOYPAYIES, TN MOUOIKN, Ta BIVTED Kal Ta £yypaPa TV gival amoBnKeupEVa 0TO
smartphone LG amo tov umoloyloth oac. Mmopeite va SnuioupynoeTe avtiypaga
Q0QANEIOG TWV EMAPWY, TWV QWTOYPAPIWV Kal ANWV OTOIKEIWY OTOV UTTONOYIOTH
1 VO EVNUEPWOETE TO AOYIOMIKO TNG CUOKEUNC.

E « [la meploooTepeg Mnpogopieg Borbelag, avatpé€te oty evotnta LG
Bridge.

Ot umootnpI{OUEVEC AerToupyieg EvOEXETaL va Sla@EPOuV avANoya LE TN

OUOKEUN.

To mpdypappa odriynong USB LG gival amapaitnTo yia va 6uvO£CETE TO

smartphone LG pie Tov umoAoy1oTr kat ykabioTtartal Katd Thv eyKataoTtaon

Tou LG Bridge.

Aetroupyieg Tng e@appoyng LG Bridge

- MiayelploTeite Ta apyeia mou givat amoBnkeupéva oTn ouoKeun amd évav
umoAoyloTr péow olvdeonc Wi-Fi ) ouvdeong dedopévwv Kivntig TNAeQwviag.
AnuioupynoTe avtiypaga ac@aleiag Twv Sedopévwv amod Tn CUOKEUN o€ évav
UTTOAOYLOTH 1 EMaVa@EPETE Ta SeGOUEVA Ao VAV UTTOAOYLOTH| 0T GUOKEUN
péow ouvdeong kawdiou USB.
+ Evnpépwon AoyIopIKoU TNG GUOKEUNE Ao évav UTTOAOYLOTH Eow OUVEETNC

kaAwdiou USB.
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Eykatdotaon epappoync LG Bridge og umoloyloth

T MetaBeite otn SiebBuvon www.lg.com amé Tov umoAoyIoTH 0aG.

7 Em\é€te v mepioxn oac.

3 MatAote YIooTthpi€n > AOYIOUIKO Kat UNIKOAOYIGMIKO.

/' TANKTPONOYAOTE TO OVOUA TNG GUOKEUNC 0ag.
H
EmAé€te TV katnyopia mpoiovToc.

5 Tava kateBdoete 1o apyeio puBiong, emAéCte Zuyxpoviopog PC> LG Bridge.
« EmAé€Te Aemropépeleg yia va Seite TIG ENAXIOTES OMAITATELS Yia TV

£yKaTAoTaON TNG EPapHoy¢ LG Bridge.

Evnuépwon AoylGHIKOU THAEQWVOU

Evnuépwan Aoyilopikou Kivntol TnAepwvou LG améd 1o
Internet

M0l TEPIOCATEPES TANPOPOPIES OXETIKA HIE TN XPr|0N AUTAG TG AelToupyiag,
emoke@Oeite Tn dievbuvon http://www.lg.com/common/index.jsp kat emAEETe T
XWpa Kat T yAwooad 6.

Meé autrjv Tn Aertoupyia pmopeite e0koAa va evnUEPWVETE Péow Internet To
UANIKONOYIOMIKO OTO TNAEPWVO 0aG OE HIat TTO TIPOoPATN €kS0on XWwpic va
XPEdleTal va eMOKePOEITE KATTOLO KEVTPO EMOKEVWV. AUTH N Aeltoupyia

Ba eivat Slabéoiun edv kat 6tav n LG diabéoet otny ayopd veotepn ékdoon
UNIKOAOYIGHIKOU Yla TN GUCKEUN G0,

Eme16n n evnpépwaon Tou UNIKOAOYIGHIKOU TOU TNAEQWVOU TIpoUmoBETEL

TNV E0TIOOPEVN TTPOCOKN TOU XPNOTN KaBOAN TN Sidpkela Tng Stadikaciag
evnuépwong, PePatwbeite 6Tt SraBalete mpooeyTIKA ONeC TIG 08NYiES KAl TIC
ONUEIWOELS TTOU epgavi{ovTal oe KABe Bripa PV MPOKwPENOETE TNV EKTENEDH
Tou. Adfete umoYn 6T edv agatpéoete To kahwdio USB katd tn Sidpkela tng
Sladikaoiag avaBabpiong, evoéxetat va mpokAnBouv coBapd mpoBAfjuata oto
TAéQWVO 0ag.

E + HLG em@uldooetal Tou Sikaiwpatog va S1abétel, katd tn SlakpiTikn
TNG EVXEPELD, TIG EVNUEPWOELG TOU UNKOAOYIGHIKOU MOVO Yia EMAEYUéVa
povtéha kai Sev eyyudral Tn S1aBeoiudTNTA TG VEOTEPNC £KSOONG
UANIKOAOYIGHIKOU Y10l OAG TOl LOVTEAD TNAEPWVWV.
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Evnuépwan Aoylopikou Kivntol ThAe@uwvou LG péow
Over-the-Air (OTA)

AuTH N AeToupyia 0AG EMTPETEL VA EVNUEPWVETE EVKOAA TO AOYIOMIKS TOU
TNAEPWVOU 0ag o€ pia o mPooath ékdoon péow OTA, xwpic ouvdeon Kahwbdiou
USB. Auth n Aertoupyia Ba givat StaBéoiun eav kat 6tav n LG diabéoel otnv ayopd
VEOTEPN €KOOGT UNKONOYIOHIKOU YL TN GUCKEUN 0OC,

M0 Vol EKTENEOETE EVNUEPWOT TOU AOYIGHIKOU TOU TNAEQWVOU, aKOAOUBAOTE TV
€€nc Sladpoun:

PuBpioeig > Mevikég > Kévtpo evnuépwong > Evnpuépwon Aoytopikou > EAeyxog
EVNUEPWONG AOYICHIKOU.

5

+ Katd  1ad1kaoia evnpépwong Tou AOYIGHIKOU TOU TNAEQWVOU Gag

evdéxeTal va xaBolv Ta poowmika oag SeSopéva amo Tov ECWTEPIKO
XWPO amobrjKELONG TOU TNAEPWVOU, OTIWG YIal TAPASEIYUA, OL TTANPOPOPIES
OXETIKA UE TOV TIPOOWTTIKO 0ag Aoyaplacpd Google Kat GANoug
Aoyaplaopoug, Ta Sedopéva Kat ot PUBHICEIC TOU CUCTAKATOC KAl TWV
EQAPHOYWV 0aG, Ol amoBnNKEUpEVES EQappoyEC amo To Internet kai n ddeia
xprionc DRM. Emopéviwg, n LG 0dg ouviotd va dnpioupyeite avtiypapa
ao@aleiag Twv MPOCWTIKWY 6ag SeS0HEVWV TIPIV aTtd TV EVNUEPWON TOU
MoyiopikoU Tou ThAEpwvou oag. H LG ev pépel euBuvn yia evdexdpevn
QMWAELD TIPOCWTTIKWY SESOpEVWV.

« Auti n Aertoupyia eaptatal amd v mEPLOKT 1) TOV TAPOXO UTINPECIAV.
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06nyo¢ kata NG KAOmNG

PuBpiote Tn ouokeun oag va Pnv eMTPEMEL TN XEroN amd dANa ATopa £4v Exel
TIPAYHATOTOINOEL EMAVAPOPA EPYOCTACIOKWY PUBHICEWV XWwpig TV Adeld oag. MNa
TaPASELYHa, EQV N OUOKELR oa¢ xabei i KAamei, 1 edv Slaypagpolv ta dedopéva
NG, HOVO KATolog ke Aoyaplaopo Google fy Minpogopieg yia To KAEidwua Tng
086vn¢ Ba pmopei va xpnoIUOTOIOEL TN GUCKEUH.
To povo mou ypetdletat va Kavete yia va Befatwbeite 61 n cuokeur oag gival
TIPOCTOTEVPEVN €ival Ta E§1G:

+ Na opioete KAeibwpa 086vnc: dv n cuokeur oag xabei fy kKharmei, al\d éxete
opioel kAeidwpa 086vng, Sev gival duvatn n Slaypaer Twv dedopévwy
TIou BpIOKOVTAI OTN CUOKEUT HEOW TOU pevoU pubpioewv mapd pévo v
EekheldwOei n 0Bovn.

Na mpooBéate Tov Aoyaplacpd oag oto Google 0T cuoKeLr 0ag: £Gv Ta
Sedopiéva TG UOKEUNG oag Slaypapoly alAd ExeTe opioel Aoyaplaopo
Google, n cuokeur gv umopei va oAokANpwael Tn Sladikacia pUBUIONG UEXPL
va gloayBouv avd ta oTolxgia Tou Aoyaplacpou oag oto Google.
A@OU TIAPETE TA AMOPAITNTA HETPA VIO TV TIPOOTAGHA TNG CUOKEUNG 0ag, £4v
XPELOOTE VO TIPAYMATOTIOIOETE EMAVAPOPA TNG OTIC EPYOOTACIAKEC PUBicELS, Oa
Tipémel va EeKAEIOWOETE TV 086vN 0ag ) va EloaydyeTe Tov KwdIKO TpooBaong
yia Tov Aoyaplaopd oag 0to Google. Me autév tov Tpdmo Siacpahiletal 6T n
EMAVOPOPA UTTOPE( VO EKTENETTEI IOVO QMO KATTOIOV TTOU EUMIOTEVEDTE.

E « Tpwv ekteNéoETe EMaVaPOPd TwV EpYOoTaCIaKwY pubpicewy, Befaiwbeite
6T BupdoTe Tov Aoyaplacpo oag oto Google Kat Tov KwdIKo mpooBaong
TIoU éXETE MPOOBETEL OTr GUOKELN 0ag, EQv Sev Umopeite va mapéxete autd
Ta oTolkEia Aoyaplacpou katd T Sladikacia puBpiong, Sev Ba umopeite
VOl XPNOILOTIONOETE T CUOKEUT KaBONOU HETE amd TNV eKTENEON TNG
ENAVAPOPAG EPYOCTACIAKWY PUBHICEWV.
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MAnpo@opisg onueiwong yia to
AOYIGHIKO AVOIKTOU KWOIKA

MNa ™ AN Tou mnyaiou kwSika mou Siémetat amd TG adeleg xpriong GPL, LGPL,
MPL kat GAeG adeteg xpriong avolytou Kwdika, o omoiog mepthapBavetat 6To
Tipoidv, emoKeTeite Tn SlelBuvon http://opensource.lge.com.

Ext0¢ amo Tov mnyaio Kwdika, Slatibevtat mpog An 6Aot ot avapepdpevol 6pot adelmv
XPONG, Ol AMOTOICEIG EYYUOEWV KAl Ol ONPEIGELG TIVEUHATIKWV SIKAWHATWV.

H LG Electronics Ba oag mapéxel emiong Tov Kwka avolx g mnyng o poperi CD-
ROM évavtt xpéwaong mou Ba kaAumTel Ta €€06a TG Slavopnic (OMwe To KHOTOC Twv
TIOAUHECWVY, TNG AIMOOTOAG Kalt TNG SLayeiplong), KATomy artuatog Yéow email
otn SievBuvaon opensource@lge.com.

H mpoopopd 1oxUEL yia TEPInS0 TPIWV ETWV amd TNV TEAEUTAIN LA ATOCTOAN
auTou To TTPOIGVTOG. H poo@opd 1oXVEL yia GAOUG TOUG TTAPAAATITES AUTHG TG
TIANPOYOpIaC.

MAnpo@opieg OXETIKA UE TOUG
KaVOVIOHOUG (ApIOROC avayvwploTIKOU
KAVOVIOMOU, NAEKTPOVIKEG ETIKETEC KAL)

Mol NeTTTOPEPELEC OXETIKA LE TOUG KAVOVIOpOUG, emAEETe Sladoyikda PuBpiceig >
Y0oTnua > PubpioTiko maicio & Ac@alela.
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Epnopu(a onfpara

Mo matévteg Hyoouotnpdtwy (DTS:Dedicated To Sound=A@iepwpévo Ztov
'Hxo), 6¢¢ http://patents.dts.com. Kataokeuaopévo umo v ddeta amd DTS
Licensing Limited. To DTS, To Z0ufoAo, & DTS kat 1o ZupBolo 6Aa padi, DTS:
X kat To Aoyoturo DTS: X gival orjpata KaTateévTa 1 UMopIKA OHaTA TG
DTS, Inc. o1 Hvwpéveg MoAreieg kat / 1y og GAeg xwpeg. © DTS, Inc. Oha ta
Akaiwpata Mpootatevoval.

dts =

A

LG Boombox Editio

« Mvevpatika Sikaiwpata ©2020 LG Electronics, Inc. Oha ta Sikaiwpata

npootatevovTal H emwvupia LG kat To Aoyoturo LG givat orjpata Katatefévta

Tou Opilou LG Kal Twv OXETIKWY OVIOTATWY TOU.

To V50 ThinQ eivat éva eumopiko onpa tne LG Electronics, Inc.

+ Ta Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,

Chrome, wtoypagiec Google, Google Play Protect, Hugpohdyio Google,

Google Docs, Google Drive, Google Sheets kit GA\a oxeTika orjuata kat

Noydtuma eival epmopikd orjpata tng Google LLC.

To Bluetooth® amotelei ofjua katateBév tng Bluetooth SIG, Inc. maykoopiwg.

+ H enwvupia Wi-Fi® kat To Aoyétumo Wi-Fi eivat orjpata katatedévta e Wi-Fi
Electronics.

+ 'ONa T UTTOAOITAl EUTTOPIKA CHMATA KAl TIVEUHATIKA SIKaWATA amoTteholv
1510KTN G0 TWV QVTIOTOLWVY KATOXWVY TOUG,

HE HEVCAdvance”

‘E Covered by Patents at patentlist.hevcadvance.com
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AnAwon acpaleiag Aélep
Mpoooxn!

Auto To Tpoidv xpnaoiuomolei cloTnpa Aéilep. MNa va BePaiwbeite mwg
XPNOlHoToLEiTe KATANNAa AUTO To TTPOTOY, SIaBAOTE MPOTEKTIKA TO EYXEIPISIO
XPNoTN Kat UAGETE TO yial LEAOVTIKY avagopd. Xe MePIMTwon mou n povada
XPELQOTE CUVTHPNON, EMKOWVWVAOTE E EEOUTIOS0TNHEVO KEVTPO EMOKEVWV.
H xprion otolxeiwv eAéyxou, pubpicewv r n ektéAeon Sladikaotwy mou dev
TIEPYPAPOVTAL 0TO TTAPOV EVOEXETAL VA EMPEPOLV eMmKivouvN €kBeon o
padlevépyela.

Mo va amo@UYeTe Tnv dpeon €kBeon otnv aktiva Aéilep, unv mpoomabroeTe va
avoi&ete 1o mepiBAnua fy va éxete dueon emaen e To Aéilep.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER
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AHAQZH ZYMMOPOQZHX

Me to mapdv, n LG Electronics SnAwvel 6Tt to mpoiov LM-V500EM cuppop@uveTat
ME TIC BACIKEC QMAITAOELC KAl LE TIG UTTONOTEC OXETIKEC Slatdelg Tng Odnyiag
2014/53/EU.

‘Eva avtiypago tne AnAwong Zuppdpewong Siatifetal otn Sievbuvon
http://www.lg.com/global/declaration

AevBuvon evnpépwong yla Oépara
GUHHOPPWONE WG TTPOG TN XPRON TOU
TPOIOVTOG

LG Electronics European Shared Service Center B.V.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

H ouyvétnta 5150 - 5350 MHz mpoopileTat amoKAEIOTIKA yia Xprion O
EOWTEPIKOUG XWPOUG.

AT [BE|BG|CH|CY|CZ|DE|DK|EE|EL|ES|Fl |FR

QHR HU|IE [ IS|IT|L |LT|LU|LV|MT|NL|NO|PL

PT|RO|SE | SI [ SK|UK|AL|ME|RS [MK]|TR |BA]|XK
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Meproootepeg MAnpoopicg

E€aptipara and okAnpupévo yuai

Ta e§aptripata auTrig TG CUOKEURG ammd OKANPUEVO Yuai Sev xouv SIdpKela ¢’

6pou {wrig, CUVETWC, EvOEXETAL Va BAPOUV e TNV TTdPodo Tou xpdvou.

+ Edv n ouokeun oag méoel TAvw O€ pia OKANPN EMEAVELD 1) TPOOKPOUGTEL KATTOU
e Svvapn, wmopei va mpokAnBei {nptd 6To oKANPUHEVO YUaA.
Ye QuTAv TV TePImTwan, SIaKOYTE APESWE TN XPHON TNG CUCKEUNG Kall
EMKOWVWVAOTE PE éva Kévtpo e§umnpétnong mehatwv tng LG.

TNV ayopd KUKANOQOPOUV TIPOOTATEVTIKEG BIKEC TTOU UMTOPEITE Va
TIPOUNOEUTEITE YIa VA TTPOOTATEVOETE Tr) GUOKELN 0ag amd Tn {npid.
N&Bete umOYN OTL AUTEC OL TTPOOTATEUTIKES Brikeg Sev KaAUTTOVTAL amd TV
€yyunon ¢ LG Electronics kat 6ev eyyuwvTal Tnv ao@alela.

TNa mep1ocoTeEPE MANPOPOPIEC
mAepwviiote 6To: 801 11 200 900
1 and Kvnto oto: 210 4800564
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06nydc yia petagopd dedopévwv
+ Ta Sedopéva mou Pmopouy va LETaPepBouv PETay cuokevwy LG iy petay
Uiag ouokeung LG Kal piog GUOKEUNG TPITOU KATAOKEUAOTH, GUUBOUAEUTEITE

Tov mapakdTw mivaka.
ZuoKeur Tpitou
SUOKEUH LG KatooKeuaoT ZugKeun
e AerToupyIko i0S
Tumog Nemtopépeleg oTOIXEIOU — Android .
Zuokevn LG - Zuokeun LG
Tuokeu LG
Emagéc, unvopata, apxeia
KAOEWV, NUEPOAOYIO, @) O O
Mpocwmka PWVNTIKEG EYYPAPES
Sedoptva 2nUEWUATAPIO X O
Zunvntipla X X
Agdopéva | Dwroypagieg, Pivteo, o o o
mohupéowv | Tpayoudia, éyypaga
PU’QHIOEIC apiknc 066vng o X X
(pakehot kat widget)
PU?““’E'C PUBpioEIC KAEIS(PATOC
086vng ¢ 086vNC (e€apouvTat o X X
ol puBpioelC KAeldwuatog
006vng)
An@Beioec epappoyég @) e)
Egappoyéc Mpoowmika dedopéva yia .
. . @) X
™ An@Beioa epappoyn
Anpdoto moTtomoNTIKd O @) X
PuBpioeig (Wi-Fi,
ANa Bluetooth, kAroelig,
X0 Kat E80TTONCELG, @) X X
mpooBacipotnta,
umatapia)
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E « Evdéxetal va pnv ivat QIKTr N HETAQopd oplopévwy dedopévwy avaloya
ME TV €KE0ON AOYIOUIKOU Kal EQAPOYNE, TO AEITOUPYIKO 0UOTNA, TOV
KATAOKEVAOTH 1) TNV TTONTIKY) TOU TIAPAXOU UTTNPECIAV.

Ymootnpi{opeveg {WVEG CUXVOTHTWV loxug e€680u mopmou
GSM 900 33.7dBm
GSM 1800 30.7dBm
WCDMA B1 25.2dBm
WCDMA B8 25.5dBm
LTEB1 25.2dBm
LTE B3 25.2dBm
LTE B7 25.2dBm
LTE B8 25.5dBm
LTE B20 25.5dBm
LTE B28 25.5dBm
LTE B38 25.5dBm
LTE B40 25.2dBm
5GNRn78 23.2dBm
BT 2.4GHz 12.5dBm
WLAN 2.4GHz 19.5dBm
WLAN 5.15~5.725GHz 19.0dBm
WLAN 5.725~5.875GHz 14.5 dBm
NFC -22 dBuA/m
Dual Screen 60.75GHz 1.0dBm
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Anoppudn tng maAidic cag GUOKEVNG

1. AuTo o Slaypappévo oUPBOAO TOU TPOXOPOPOU KASOU UTTOSEIKVUEL OTL
Ta amoBANTA NAEKTPIKWV Kat NAEKTPOVIKWY TTpoiovTwy (AHHE) mpémetva
amopP{MTOVTAl XWPIOTA OO Ta YEVIKA OIKIAKA AmoppipuaTa.

B 2 TanaNd NAeKTPIKA TPOIGVTa UMOPE( va TIEPIEXOUV EMIKIVOUVEG
0UOIEC KAl WG EK TOUTOU N 0WOTH AmoppiPn TG MaNAG 0ag GUOKEUNG
QMOTPEMEL EVEEKOUEVEC APVNTIKEG CUVETTELEG Yiat TO TIEPIBANOV
Kat v avBpwmivn uyeia. H maAid 6ag GUOKEUR PMOPE( va TIEPIEKEL
EMAVOXPNCIUOTIOOIA AVTAMAKTIKE TTou Ba pmopouoav va
XPnotpomonBouy yia Ty MoKeur GAwV TPoIOVTwWY, KaBWE Kat GMa
UAIKA a&iag mou umopouv va avakukAwBoLv yia e§oikovopunon Twv
TIEPIOPIOUEVWY PUOIKWVY TIOPWV.

3. Mmopeite va TTATE TN CUOKEUR 00, iTE 0TO KATAOTNO amd TO
0TI0i{0 AyOPACATE TO TIPOIGV, I} Va EMKOIVWVAOETE TO TOTIKS YpaPEio
AMOPPIUUATWV Yia AETTOPEPELEC OXETIKA HE TO TTANCLETTEPO EYKEKPILEVO
onueio ouloync AHHE (AnépAnTa HAektpikwv kat HAEKTpOVIKWV
JUOKEUWV). M0 TIG TTIO TPOOPATES TTANPOPOPIES YIA TN XWPA 0AG
emokepOeite T SievBuvon www.lg.com/global/recycling

AmoppPn TWV XPNOIUOTTOINMEVWY prrataplwv/
CUCCWPEUTWY

1.To oOpBolo autd pmopei va cuvdualetal pe Ta XnUikd cupBoAa yia
Tov udpdpyupo (Hg), To kadpo (Cd) rj To pdAuBso (Pb), av n pmatapia
TIEPIEXEL TOOOTNTEG PEYaNUTEPES a6 0,0005% udpdapyupo, 0,002%
Kadpio 1} 0,004% poAupso.

2. H améppun OAwv Twv PIaTaplwv/CUCoWPEUTWY TTPEMEL vVal
YIVETOL XWPIOTA A0 TA YEVIKA OIKIAKA AMOPIpaTa, HEow EISIKWY
EYKATAOTACEWY CUNOYIG AOPPIUHATWY TTou €xouv kaBoploTei amd v
KUB£€PVNON 1 amo TIG TOTTIKEG APXEC.

3. H owotr andppipn Twv maNwy HmaTapiwv/cCUCowPEUTWY AITOTPETEL
EVOEXOUEVES OPVNTIKEG CUVETTELEC VIO TO TIEPIBANOV, KABWE Kal yia Thv
uyeia Twv {Wwv Kal Twv avBpwmwv.

4. Na Mo avaAUTIKEG TTANPOPOPIES OXETIKA LE TNV amoppIPn Twv MV
UMTOTAPIWV/CUCOWPEUTWY, EMKOIVWVAOTE WE TO TOTIKO YPaQEio, TNV
apuodia umnpeaia SIGBETNC OIKIOKWY AMOPPIMUATWY 1} TO KATAoTNHA
amné to omoio ayopdoate To TPoidv.
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LUXVEG EPWTIOELG

370 KEQAAILO QUTS avaPEPOVTAL OPLopEVA TIPOPBAUATA TTOU EVOEXETAL Va
QVTILETWTTIOETE KATA TN XPrioN TNG OUOKEUNG 0aC. Na optopéva mpoPAruata Oa
XPELOOTE VOl EMKOWWVHOETE LIE TOV TTAPOYKO UTNPECLWV 0ag, AANG Ta TTEPIOCOTEPA
pmopeite va Ta S1opBwoETe Kal HOvol 0.

Z@ahpa kaptag SIM

BeBaiwOeite 6T n kdpta SIM gival owoTa TomoBeTnpévn.

Agv uniapyel ouvdeon SiktUou 1 undpxel anwAela SIKTUOU
XapnAd orjua. MetakivnBeite kovtd og mapabupo 1y o€ avoiyxTd Xwpo.

Eiote extog TG meploxng kahung diktuou tou médpoyou. ANAETe Béon kat eNéyEte
70 SikTuo.

Aev givan S1a0£o1peg ol KAAoEIg

To véo iktuo Sev eival e§ouaiodotnpévo.

S 1lyOUpEUTEITE TIWG SV EXETE OPIOEL PPayr KNOEWV yIa TOV EI0EPKOHEVO aPIOUO.
S1youpeuTEiTe WG Sev EXeTe OpioEl Ppayr KAOEWV yia TOV apIBUO TTOU KOAEITE.

Aev givat Suvatn n evepyomnoinon TG CUOKEVNG

Otav n pmatapia €xel amo@optioet Mpw¢, Sev Ba givat Suvatr n evepyomoinon
TNG GUOKEUNG 00,
DopTtiote MAMPWG TN UMATAPIA TIPLV VA EVEPYOTTOI\OETE TN GUCKEUH.

ZPAaApa eopTiong

BeBauwbeite 61 n cuokeur @optiletal o€ KavoVIKr Beppokpacia.

ENéy€Te TOV QOPTIOTH Kalt TN GUVOEDT) TOU OTN GUOKELN).

Na xpnotuomoleite pdvo ta e§aptripata mou mepIAapBAvovTal 0T CUCKEVAGIA Kal
eivat e€ovotodotnuéva amd v LG.
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H pmatapia teAewwvel mo ypriyopa o€ oxéon pe 6tav aydpaca
OPXIKA TN CUCKEUN

'Otav ekTiBETAL N GUCKELN 1 N Umatapia og TOA) UYNAEG 1 xapnAég Bepuokpaaieg,
evdéyetal va pelwbei n Sidpketa (wng NG pmatapiag.

H katavéAwon pmatapiog a au§nbei dtav xpnotoToLETE OPIoHEVES
XOPOKTNPLOTIKA 1 EQAPHOYEC, OTwE To GPS, maikvidia i 1o Internet.

H pmatapia ivat avaAwotpo kat n {wn tg pmatapiog 6a petvetal pe tnv mapodo
Tou Xpdvou.

Epgavi{ovtal pnvopota 6AAHaTog Katd T KKivnon tng
KAMEPG

Oopriote TV umatapia.

AmeNeuBEPWOTE VAN LETAPEPOVTAC apxEia O Evav uTToAoyloTh f Staypdgovtag
apyxeia amd T ouokeun oag.

ETOVEKKIVE( TN GUOKEUN.

Eav e€akohouBeite va avtipetwmifete mpdBAnUa Ke TNV QapOoYR TG KAUEPAS
0QOTOU AKONOUBNOETE AUTEC TIC GUUBOUAEG, EMKOIVWVHOTE e €va Kévtpo Z€pPIg
NG LG Electronics.

H moiétnta tn¢ pwtoypagiag givat Kakn

H mo1dtnTa Twv QuToypagiwy 0ag VOEXETAI VA TIOIKIAEL avahoya pe Tov
TEPIBAANOVTA XWPO KAl TNV TEXVIKI GUTOYPAPNONG TTOU XPNOILOTOIE(TE.
'Otav Bydlete pwtoypagieg kal Bivteo, n molotnTa anod otabepr ywvia givat
KOAUTEPN OE OXEON HE TNV QVTIOTOIYN QMO EUPEIA ywvia.

Edv Bydlete putoypaieg o€ OKOTEVA PEPN, TO BPASU 1 O€ ECWTEPIKO XWPO,
evdeyetal va umdpyel 00puBog oTIC pwToypagieg i va givat Boléc.

Edv avtipetwnilete mpoBAUOTa, KAVTE EMAVAPOPA TWV EMAOYWV.
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H 00dvn agng avtamokpivetat apyd i AavOaopéva

Edv TomoBetrioeTe mpooTaTeuTIKO 006VNG 1 TPOAIPETIKA €€APTARATA OTNY 08dVN
AQPAG, AUTH EVOEXETAL VO NV AEITOUPYEL OWOTA.

Eav @opare yavtia, €dv Ta xépla oag Sev eival kaBapd 6tav ayyilete Tnv 08ovn
ARG A €av ayyigete Tnv 006vN PE aiUnEA AVTIKEILEVA 1) L Ta akpoSAKTUAG oag,
QUTH EVOEXETAL VA NV AEITOUPYNOEL GWOTA.

H 0086vn agn¢ evoéxeTal va unv Aerroupyrogl owoTd og ouvBrKeg uYNARiG
uypaoiag ry étav ektedei oe vepo.

EmavekKIVOTE T 6UOKEUN 060G yla va §lopBwBolv Tuxov mpoowptva mpoBArata
Aoylopikou.

Edv n 086vn agrq éxel ypatoouvioTei ) umooTel {Nd, EMOKePTEiTE éva Kévtpo
Y£€pPig TG LG Electronics.

KaBuotepei i) koAdel

EmavekKivijoTe T oUOKEUR
+ Av n ouokeun oag KoMdeL i kaBuoTepei, pmopei va XpelaoTei va kheioete
KATTOLEG EQAPHOYEG 1) VO ATIEVEQYOTTOIOETE T GUOKEUN Kal Vol ThV
evepyoroloete {ava.

EKKIVAOTE TN OUOKEUR
- Hemavagopd umopei va xpnotpomolndei av n 086vn maywael, 1) av Ta Koupmd,
n 086vn agnic fi n ouokeun Sev avtamokpivovTal Tma.
- [l va EnavagépETe T GUOKELN 0G, TATAOTE TAUTOXPOVA T TIARKTPA HEiwoNg
£VTOONG X0V Kal AEITOUPYIaG LEXPL N CUCKEU Vol EMAVEKKIVNOEL.

Emavagopd tng cUoKeung
+ Edv n xprion twv mapandvw pefodwv Sev amokataotrioel To mpoBAnua,

EKTENEDTE EMAVAPOPE EQYOOTACIAKWY SESOUEVWV.

« YV 08dvn pubpicewy, ayyi€te Sladoxikd Mevikég > Emavekkivnon &

Emavagopd > Emavagopd epyooTtaclakwv SeSopévuwv.

- Emavagépet ONeg TIG pUBLIoELC yia TN ouokeun Kat Slaypdgel Ta Sedopéva.
Mpwv MPOXWPNOETE 0NV EMava@opd epyooTactakwv Sedopévwy, Bupnbeite
va SnuoupynoeTe avtiypapo ac@aleiag yia 0Aa ta onuavtika dedopéva
TIOU €XETE AmOONKEVPEVA OTN GUOKEUN.

- Av Kataywpnoeg évav hoyaplaopo Google 0T OUOKEUN, TTPEMEL v KAVEL
€i0060 pe Tov (610 Moyapiaoud Google LETA TV EMAVAPOPA TNG CUOKEUNG.
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Agv BpéBnke ouokeur Bluetooth
Y1youpeuTeite mwg n Aertoupyia Bluetooth €xel evepyomoinBei otn cuokeur oag.

TlyoupeuTeite wg n Aettoupyia Bluetooth €xel evepyomoinBei otn cuokeun pe T
omoia BéAete va ouvdeDeite.

BePaiwbeite 611 n cuokeur) oag kat n dAAn ouokeun Bluetooth gival vtog tng
péylotng epPéhelag Bluetooth (10 m).

Edv ot mapamdvw cupBoulég Gev Auoouv To IPARANUA GaG, EMKOIVWVACTE HE Eva
Kévtpo ZépPig ¢ LG Electronics.

Aev mpaypatomoleital 0vOEDn OTaV CUVOEETE TN GUCKEUN O€
évav umohoyloTh

Y1youpeuTeite mwg to KaAwdio USB mou xpnotuomoleite givatl oupBato pe
OUOKEUN 00,

S IYOUPEUTEITE TIWG EiVal EYKATAOTNEVO Kall £XEL EVNUEPWOEL TO KATAANAO
TIPOYPALLA 08ryNONG GUCKELNG OTOV UTTOAOYIOTH GOIC.

H e@appoyn mou Aj@Onke mpokalei moANd o@aApata
H epappoyn mapouatalel mpoPAfuata.
AQaIPEOTE KAl EYKATAOTAOTE EaVA TNV EQAPUOYH.
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AwmAn O06vn LG
(LM-V505N)



I'vwpiote tn AmAn 006vn LG

Mmopeite va ouvdéoete o€ auTd To POIOV pia AtmAry 086vn LG (LM-V505N).

E « Mmopeite va ouvdéoete T Sumry 086vn TG LG (e@e€rig, To «mpoiov»)

0€ JIa 81K KIVNTr) OUOKEUN (EPEEAE, TO «KIVNTO TNAEPWVO) yla va

XPNOILOTIOIOETE TO TIPOIOV.

+ Avaloya pe TIG EMOOOEIG TOU KIVNTOU TNAEPWVOU, OPIOHEVEG AEITOUPYiES
NG Stmiig 086vNg evdéxetal va pnv eivat Stabéatpeg. Emiong, To mpoiov
€VOEXETAI VOl PNV UTTOOTNPICEL ANNEG KIVNTEG OUOKEVEG,
To mpoidv dev eival avBeKTIKO 0TO VEPO. MV eKBETETE TN GUOKEUN| OE LYPA
1 vypaocia.
Eav n ouokeun éxel Bpayei, ToTe To LDI péoa otn cuokeur) alalel xpwua.
T& QUTAV TNV TEPIMTWON, N SUOKeUN Sev eivat emAECIUN yia omoleadnmoTe
UTINPETIEG SWPEAV EMOKEVNG TTOL TIAPEXOVTAL BATEL TNG TTIEPLOPIOHEVNG
£yYUNONG TNG CUOKEUNG.
+Houokeun oag Slabétel evowpatwpévo Séktn (57~66GHz) 161kd yia o V50
ThinQ.

Od6nyiec yia ac@ali Kat amoTeAECHATIKA
Xpnon

AlaBAaoTe TIg mapakdTw omég odnyieg. H un tpnon autwv Twv odnyiwv pmopei va
amofei emkivéuvn 1 mapdvopn.

Y& MePIMTWOn 0QAAUATOC, N GUCKELN 0ag SlabETel éva epyaleio hoyiopikoU Tiou Ba
Snuioupyrioel éva apxeio kataypagrg opaipatoc. To epyaleio cuMéyel Sedopéva
€161KA Y10 TO OUYKEKPIUEVO OPAAUa OTIwG Ta £€AG: LoxUG onparog, cell ID position

O€ TIEPIMTWON amPAGHEVNG AmOPPIPNG KARONG KAl EQAPHOYEG TIOU UTIAPXOLV 0T
OUOKEUN. To 0pXEio KATAYPAPIG XPNOLUOTIOLETAL AMTOKAEIOTIKA Y10l TOV TTPOOSIOPIoHO
NG AITiag Tou GpAAHaToC. AuTd Ta apyeia Kataypa@ric gival KpUIToypaPnHEVA Kal N
TIPOORasN 0€ QUTA gival EPIKTH POVO amd eE0uCIoS0TNHEVA KEVTPA EMOKEVAC TNG LG,
O€ TTEPITTTWON TIOU XPEINOTE! Va EMOTPEPETE TN CUOKEUH OOG VIO ETMOKEVH.

Ay O86vn LG (LM-V505N) 198



'EkBeon o¢ evépyela padloouyxvoTriTwy

MANPOYOPIEC OXETIKA LE TNV €KBETN GE PASIOKULATA KOl TO GUVTENEDTH EIOIKAG
anoppd@nong (XEA).

AUTH 1 CUOKEUT €€l OXESIAOTE! WOTE VO GUUHOPPUVETAL HIE TIG IOXVOUCES OTMAITHCELG
aogaleiag yia tnv ékBeon oe padiokUpata. Ot amatthoelg autég Baoiovral oe
EMOTNHOVIKES 08nYieg Tou mepAapBavouy mepBwpta ac@aleiag yia tnv mpootacia
OAWV TWV aTOPWY, ave€aptnTa amd Tnv NAKia fj TNV KATdoTaon g Vyeiag Toug.

« 2TIG 08nYieC OXETIKA pE TNV éKBEON OE PaASIOKUUATA XPNOIUOTIOLETAL Miat povASa
uétpnong n omoia ival yvwoTr w¢ SUVTENEOTHG EI8IKAG amoppdenong i ZEA. O
€\eyxol yia To ZEA Sle§ayovtal pe Tumomolnpéveg LeBASouG, e Tn OUOKEUN va
EKTTEPTTEL OTO PEYIOTO TIIOTOTOINMEVO ETTMESO 10XVO0G O OAEG TIG {WVEG CUXVOTATWY
TIOU XPNOIUOTIOLEL

« Av Kat umopei va umrdpxouv Slo@opég PeTagl Twv emmédwv Tou ZEA yia
Slagopa povtéha cuokeuwv TG LG, OAa ta povTéAa éxouv oxedlaoTel woTe va
QVTAMOKPIVOVTAl OTIG OXETIKEG 00nyieg yia Ty ékBeon oe padlokvpata.

« To 6pto Tou ZEA mou cuviotatat and t Alebvr Emtpor Mpootaciag amé T Mn
loviCouoa AktivoBolia (ICNIRP), eivat 2 W/kg pe Baon Tov umoAoyIopo TG péong
TipAg ya 10 ypappdpla owpatikol 10To0.

« AuTtA n cuokeur MAnPEOi TIG MPOUTIOBETEIS Yia T ékBEaN Og PadloouXVOTNTEG
€(Te OTAV Xpnotpomoleital oTnv Kavovikr B€on xpriong Sima oto auti ite dtav
Bpioketal og améoTacn TouldyioTov 5 mm amo To owpa. Otav xpnotyomoleital
Orkn petapopdc, KA {wvng ri Brikn yia xprion oTo owpa, Sev mpémet va
mepthapBdvel peTAMIKE oTolxEla Kal TPEMEL VO GUYKPATEL TO TIPOIOV G€ amdaoTaon
TOUNAXIOTOV 5 mm armd To owpa oag. Ma T petddoon apxeiwv Sedopévwy i
UNVUPATWY, N GUOKELR amaitei Tnv Umapén moloTIKrA¢ oUvEeonc oTo Siktuo. Xe
OPIOPEVEG TIEPITTWOELS, N HETAS00N apxeiwv SeSopévwy 1 unVUPdTwWY Umopei
va kaBuoTeproel éwg 6Tou givat Slabéoiun pia Tétota ouvoeon. Beaiwbeite ott
TNEOUVTAL Ol TAPATTAVW 08NYIEG OXETIKA HE TNV AmGOTACN aMd TO CWHA PEXPL VA
olokAnpwbei n petddoon.
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Opovtiba kal GUVTAPNON TOU TIPOIGVTOC

+ Na xpnotpomoleite pdvo ta e€aptrpara mou mepthapBdvovtat 0Tn CUoKELATia Kal
eival e§ovotodotnuéva amod v LG. H LG Sev mapéyel eyyunoeiq yia uxov BAaBes iy
anotuyieg Aettoupyiag mou ogeilovtal o€ eEapTUATA AMNWY KATAOKEVATTWV.

+ Oplopéva meplexdpeva Kat EIKOVEG eVOEXETAL VA S0QEPOLV armd T OUOKEUN 0ag
Xwpic mpogidomoinon.

+ Mnv amoouvappo)oyeite Tn povdda. Otav amartouvtal pyacieg EMOKEVNAG,
TAPASWOTE TNV O€ EEEIBIKEVUEVO TEXVIKO.

« Katd n Slakprtikn euxépeia tng LG, ol eMOKeVEG Tou KAAUTITOVTAL Ao ThV £yyOnon
evOexeTal va epAapBavouv Ty TomoBETNon avTAAAKTIKWY LEPWV ) TIIVAKWY (€iTe
KavVOUPIWV E(TE EMOKEVAOUEVWV), LE TNV TTPOUTTOBEDN OTIL N AEITOUPYIKATNTA TOUG
€lval .0odUvVapN UE TN AEITOUPYIKOTNTA TWV UEPWV TTOU AVTIKATACTAONKAV.

+ Kpatdre T oUoKeUN HOKPI armd NAEKTPIKEG CUOKEVES OTIWG TNAEOPATELC,
padié@wva Kal UTTONOYIOTEC.

«H ouokeur mpémet va GUAACOETAI LOKPIG o TyEG BEpUOTNTAG, OTIWG KANOPIPEP 1)
NAEKTPIKEG KOUTivEC,

« Mpoo£€Te va pnv méoeL.

+H ouokeun Sev mPEMel va UTTOKEITAL OE UNYaVIKEG SOVRATELG 1} KpadaopoUg.

« ATIEVEPYOTIOLEITE TN GUOKEUH OTIG IEPLOXEG OTTOU AMAYOPEVETAL N XPON TG
oUPPWVA e EI8IKOUE KaVoVIoHOUG. Ma MapdSelypa, Unv XPNOIUOTIOLEITE TN GUOKEUR
0€ VOOOKOEi, KaBuwg n xprion TG Umopei va emnpedoet uaiobnTo 1oTpIKo
e§om\iopo.

+ Mnv mdvete T ouokeun pe Bpeypéva xépla, 6tav goptilel. Mmopei va mabete
nAektpomAnéia kat va mpokAnBei coPapr PAGRN ot cuokeun.

Xpnotpomolnote éva oTeyvo mavi yla va KaBapioeTe To mePIBANA TG CUOKEUNG
(Hnv xpnotpomoleite SlaNuTeg OMwE Bevdivn, SIGAUTIKS 1) OVOTVEUNA).

+ Mnv a@riveTe Tn CUOKEUN OE XWPOUG HE UTIEPBONIKS Kamvo 1 okovn.

+ Mnv tomobeteite T GUOKeLN| SiMAa OE MOTWTIKEG KAPTEG 1 EIOITHPIA MECWV
UETaQOPAG. Mmopei va emnpedael TIC TANPOPOPIEC TTOU TIEPIEXOVTAL OTIG LAYVNTIKEG
Tavie.

« Mnv xtumdre Tv 08vn e agunpd avtikeipeva, KaBwg evaExeTal va TPOKANEOETE
BAapn ot cuokeun.

+ Mnv ekBETETE TN GUOKEULN OE LYPA I} LYPAGIaL.

+ XPNOIWOTIOLEITE UE TTPOTOYXT T AEETOUAP, OTIWG TT.X. TA AKOUOTIKA. Mnv ayyilete
AoKOTIa TNV KEPaa.
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+ Mnv XpNOIWOTIOLEITE, UNV ayyi(ETE Kal PNV TPOOTIABEITE VOl AQAPETETE 1 va
embI0pBWOETE OTIAOUEVO, KOUUEVO 1} paylopévo YUaAL. H eyylnon dev kahumtel
BAAeg mou ogeilovTal o€ Kakh xprion TG yuahivng 08ovng.

+H ouokeun eival NAEKTPOVIKR Kal Tapdayel BepUATNTA KATA TN SIAPKELX TNG
KavoviKig Aerroupyiag. H mapatetapévn, dueon emaen pe to dépua oag umd
OuVONrKeC avemapkoUg e€0EPIOUOU EVEEXETAL Va EMPEPEL SUCPOPIA 1) LIKPA
EYKAUHATO. ZUVETWG, XEIPIOTEITE e TIPOCOXT TN CUCKEUT 00 KATA TN A&ttoupyia iy
OMEOWG PETA.

+ Av Bpayei n GUOKEUN, AMOCUVSEDTE TNV APECWE KAl OTEYVWOTE TNV KaAd. Mnv
ETXEIPIOETE VA EMOTTEVOETE TO OTEYVWHA HE LA EEWTEPIKN Ty BgpudTnTag, 6mwg
€{val oL poUPVOL, Ol POUPVOL LIKPOKUMATWVY 1y O OTEYVWTAPESG MAANIGV.

« To vypd otn Bpeypévn ouokeur] aAMNATEL TO XPWHA TNE ETIKETAG TOU TTPOIOVTOG
0TO EOWTEPIKO TNG OUOKEUNC. H eyyUnon Sev kahumtel BAABEG TG GUOKEUNG TTOU
opeilovtal oTnv €kBeor TG o€ LypPd.

+ Mia popnTr cuckeun amaitei owoTH Kukhoopia aépa yia tn Siduon tng
BeppotnTag. H dueon emagr pe 1o Sépua Kat n avemapkrig KUKAOQOpIa Tou aépa
0T OUOKeUN propei va odnynoet og umepBéppavar Tne. H cuokeun) Ba mpémel va
Bpioketal og amdotacn Touldxiotov 1,0 cm and To oWpa Tou XPRoTN.

« OpovtioTte va unv €pBet 1o MPOIdv o€ emagn e Lypd. Mnv XPNOIUOTIOLEITE 1y
enavapopTiCeTe To MPOIOV av éxel uooTel {npid. Av To Tipoidv Bpayei, n Auxvia
BAABNG amd uypd Ba aMGEel xpwia. AdBete umdYn oag OTL G€ QUTHV TNV TIEPIMTWON
Sev Ba SikaloUoTe TIG SwpEdV UTTNPEGTES EMOKEVNG TOU KAAUTITOVTAL Ao TV
gyyunon.
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Amnoteleopatiki Xprion TG CUOKEVNC

HAEKTPOVIKEG OUOKEVEC

'O\eG 01 GUOKEVEG pmopei va G€xovTal TapePBOAEG Tou emmpealouv Ty anddoar Toug.

+ Mnv XPNOIUOTIOLEITE TN GUOKEUI KOVTA OE IATPIKO EE0MAIOUO XwpiG va €xeTe Adfel

OXETIKN A8ela. ZUUBOUNEUTEITE TO yIaTPO GG Yia va SIOMOTWOETE av N Aeroupyia
TNG OUOKEUNG UMopEi va TIPOoKaAéoEL TApEUBOAEG 0TN AelToupyia TG IaTPIKAG 0ag
OUOKEUNG.

+ Ol KATOOKEVAOTEG BNUaTOS0TWY OUVIOTOUV ENAXIOTN amdoTaon 15 cm petad

ANV CUOKELWV Kall TOU BnuatodoTn, yia Ty amo@uyr moavwv mapeUBoAwv.

+ Autn n ouokeun pmopei va mapdyel évtovo ewe iy wg mou avaBooPrveL.

« Opiopéva BonBrpata akorg evaExeTal va uioTavVTal TTOPEUPONEC AMO GUOKEVEG.

+ Mikpéc mapeUBoNéC evEEXETAI v EMMNPEACOUV OUOKEVEC, OTTWG TNAEOPACELS,

padoeWVa, UTONOYIOTEG KA.

« Av gival Suvato, XpnoluomoloTe T GUCKEUR o€ Beppokpaocieg petagd 0 °C kat

40 °C. H ékBeon TG CUOKELNG O TOND XAHNAEG 1y UPNAEC Beplokpaoieg evaéxeTal
va TIPoKaAéael {npid, Suohertoupyia iy akdpa Kat €Kpnén.

0481Kn ao@alela

ENéy€Te TOUG VOMOUE KOl TOUG KAVOVIGHOUG YIaL Tr XP0N OUOKEUWY OTAV OONYEITE.

+ Mnv XPNOIUOTIOLEITE TTIOTE GUOKEUN XELPOG OTAV OSNVYE(TE.

« Eotidote OAn oag v mpogoxr| otV odrynon.

+ ZTAUATAOTE 0NV dKPN Tou SPOHOU Kal OTABUEVOTE TO OXNUA OO TPV

TIPAYLOTOTIOIOETE 1) AMAVTHOETE O ia KAon, €4V TO anaitoiv ol oUVONKeg
odrynong.

H evépyela padloouyvoTrTwy eVEEKETAL VA EMNPEATEL OPIOUEVA NAEKTPOVIKA
OUOTHMATA OTO BXNHA 0Ag, OTWE TO PASIOPWVO TOU AUTOKIVATOU Kall TOV EE0MAIGHO
acgaleiag.

« Edv 10 oxnua oag ivat §omAiopévo e évav 1y TIEPIGOATEPOUG AEPOCAKOUG,

unv eykaBioTdte Kat pnv TomoBeTeite acuppato eomliopd o onpeia émou Ba
eumodietal n Aerroupyia Tou agpooakou. Evééxetal va mpokAnBei Suohettoupyia
TOU 0EPOCAKOU 1 00BaPOE TPAUHATIONOG AOyw akatdAANANG amddoong.

« 'Otav akoUTe HOUOIKN eV BpiokeoTe £§w, PePaiwbeite OTi éxete pubuioel tnv

£€vtaon og éva Moyiko eminedo, yla va éXeTe emiyvwon Tou Tt cupBaivel yopw oag,
AUTO gival IBIAITEPA ONUAVTIKO OTAV KIVEIOTE KOVTA 08 SPOUOUC.
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luvdhiva e§aptrpata

Oplopéva P€pn TNG CUOKEUNG 00C Eival KATAOKEUAOHEVA amd YUANL To yuai pumopei

VOl OTIAOEL AV I CUOKEUT 00 TTECEL TIAVW OE OKANPEN EM@AVELD 1) SEXTEL IOXUPOUG
Kpadaopoug. EGv omdoel kdmoto YuaAvo e€ApTNHa, KNV TO ayYIEETE Kat pnv
ETTIKEIPHOETE VA TO APAIPECETE. TAHATHOTE VO XPNOIHOTIOLEITE Tr) CUCKEUH 0ag PéXPL VA
avTikataoTaBei To Yuahi amo e0uatoSoTnuévo TTAPOYO UTTNPECIWV.

Media avativaéewv

Mnv xpnotpomolgite Tn CUOKEUN O TTEPLOXES 0oL YivovTal avaTtivaelc. Na akohouBeite
TOUG TTEPLOPIOUOUG KAl OTTOLOUG KAVOVIGHOUG 1) KAVOVEG LOXUOUV.

MepiBdaMovta 6mou umdpyel Kivduvog ekpnéewv
+ Mnv XpNOILOTOIEITE TN OUOKEUN OE ONEI QVEPOSIAGHOU KAUGTUWV.
+ Mnv XpnOIHOTOLEITE TO TNAEPWVO KOVTA OE KAUGIHA 1} XNHIKA.

« Mnv pETaQEPETE Kal Pnv amoBnKeVETE EVPAEKTA AEPLD, UyPd 1} EKPNKTIKA OTOV iS10
XWPO TOU AUTOKIVATOU 0agG OTIOU TOTOBETEITE TN GUCKEUN 1} TA a§E0OUdp TNG.

Xpnon o€ agpooKAPog
O1 00UPUATEG CUOKEVEG UMOPOUV VA TIPOKAAEGOUV TIAPEUBOAEG OTA CUOTAHATA
AEPOOKAPWV.

« MNpw empPiBaoTeite o€ AEPOOKAPOG, OTTEVEPYOTIOIOTE TN GUCKEUN).

+ ‘000 TO aEPOOKAPOG BPICKETAL OTO £50POG, UNV XPNOILOTOIEITE TO TNAEPWVO XWPIG
adeia amd o mMipwya.

MNadia

Oulagte Tn ouoKeur Og AoPANEG HéPOG, pakpla amod maudid. MepapPavel e§aptrhpata
MIKPOU pEeYEBOUG TTOU EVOEXETAI VAl TIPOKANETOUV KiVEUVO TIVIYHOU EQV AMTOOTIAOTOUV
amé 1o TNAéQwvo.
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E€aptiparta kat a§eocovdp Tou mpoiovtog
To mpoiov cuvodelouv Ta akdhouBa oTolxeia.

+ [poidv + 08nYd¢ ypriyopng ekkivnong

A + Opiopéva amd Ta e§0PTALOTA TOU TIPOIOVTOG EiVAL KATOOKEUACUEVA
an6 okAnpupévo yuali. Edv To mpoidv méoel mavw oe okAnpr) em@avela
1) TPOOKPOUOEL KAmou P SUvapn, evoéxeTal va IPokAnBei {nid oto
OKANPUPEVO YUONI. € QUTHV TV TIEPITTWON, SIaKOWTE apéowg T xprion
TOU TTPOIOVTOC Kall EMKOWVWVAOTE P éva Kévtpo e§umnpétnong mehatwv
e LG.

H gpgavion Kat ol mpodiaypagEg Tou TPOIOVTOC 0aG UTTOKEIVTAL GE AANAYEG
Xwpic mpogidomoinon.

i

At 086vn LG (LM-V505N) 204



Emokoénnon otoygiwv

Eptrpég Nicw
Auyvia LED (7 :j (7 W
] [E}— OnKnN pevTeTE
Bonénrikd
TIAAKTPO €viaong
fixou
Bonénrikd —
TARKTPO BonBou ’Z‘]
Google ] J._ OnKn pEVTECE
o J 2

ZedIAwpévo

XWpog yia ot —F——<l——=J \
QKOUOTIKOU ( Y‘
o—— Xwpog yia
KOUTTI
. S00iag/KAEI
0806vn TPogo
TIPOI6VTOG duparog
AKpOdEKTNG
7j\) ETTIKOIVWViaG/Tp

ogodoaiag

A + Mnv umoBAaAAeTe TO TIPOIGV GE IXUPES GUYKPOUTELG, OTIWG €ivall N TTTWoN, N
miieon 1 n Kauyn tou. EGv méoete 1o mpoidv pe umepBoAkn Suvapn, umopei
Vv TIPOKOAEDETE (Nt

E + Ta BonBnTikd MAKTPa Kal ol XWPol autou Tou TPoidvVTog Sev AelToupyouv
avegaptnta. Opovtiote va ouvdéoete To TPoidv pe To V50 ThinQ.
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Eicaywyn Tou Kivtou THAEQWVOU 0TO
TPOIOV
1 Zedm\ioTe evieMwg To MPOIOV.

m

A

\

7 BePawwbeite 6Tt n 086V TOU KIVTOU TRAEPWVOU KOITAEL TTPOG TA EMAVW Kl
€100YAYETE TO TUAHA T TOU TNAEPWVOU OTO TIPOIOV, OTIWE PAIVETAL TNV EIKOVA.
Befaiwbeite 411 0 akpoSEKTNG EMKOIVWVIAY/TPOoP0d0aIag Tou MPoIdvVTog
BAémel otV (610 KaTELBUVON PE TOV AKPOSEKTN TOU KIVNTOU TNAEPUWVOU.
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3 MéoTe TO TUAKA 2 TOU KIvTOU TNAEPWIVOU LE TO AKPO TOU SAKTUAOU 0alC,
WodTOU TO TNAEQWVO KOUPTMIWOEL 0T B€on Tou.

o /
F@%@ o

7

A « [pooé€te va unv PIEETe TO MPOIGV 1) TO KIVNTO TNAEQWVO KaTd Ty Eloaywyn
1 TV AQaAipEDN TOU TNAEPWVOU.
« [poaoé€te va unv mpokahéoete {nuid ato mpoidv mélovtag To TNAEQWVO
TIOAU SUVATA KATA TV EI0QYWYI 1) AQAIPEDN TOU TNAEPWVOU Ao TO TIPOIOV.
+ BePaiwBeite 6T To TNAéPWVO GG €xEl EloayBel TARPWG 0TO TIPOIGV TTPIV TN
Xxenon.
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A@aipeon Tou KivnTtol THAEQPWVOU and

TO MIPOIOV

T Zedmhiote M\pwE TO TIPOIOV Kall KPATHAOTE TO KAA Kalt e Ta SU0 XépLa Omwg
@aiveTal 0TV €IKOVA.
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7 Miéote 1o TUAKA 1 TOU TTPOIBVTOG UE TO SAKTUAG GaC Kall, TAUTOXPOVA, TIECTE
TN pAxN TOU KIVNTOU TRAEPWVOU pE AAAO SEKTUO yia va aQapECETE TO
TNAEQPWVO amo TO TIPOIOV.

/—/?0@/—*—’% v

[

;‘@\,\% g

A + Mepikd amd ta pépn Tou MPOIGVTOC £XOUV KATAOKEUAOTEL MO EVIOXUUEVO
YUOAi. H T@on Tou mpoidvtog og okAnpr| em@Avela iy n duvatr) Kpouon Tou
UmTope( va TPOKAAEDEL TO OTIAOIHO 1 TN PBOPE TOU EVIOXUHEVOU YUaAIOD Kat
VO TIPOKOAAEDEL TPAUHATIOHO 1 (LA 0TO TIPOIGV.

« EdQv oupPei auto, SlakoYTe apéowg Tn XPrion Tou IPOIOVTOG Kat
EMIOKEPTEITE TO MANCIETTEPO KEVTPO EEUMTNPETNONG EAATWV TNG LG yial
emdiopbwon.

+ Mn xpnotgomolgite oUTE Vo QopTICETE TO TPOIOV OE TIEPITTTWOT TIOU UTIAPXEL
Uypaacia 0Tov aKPOSEKTN EMKOIVWVIAG Kat TPo@odoaiag Tou TPOIOVTOG,
Yndpyel Kivbuvog mupkayldg, nAektponinéiag, tpavpatiopol fi BAGRNG Tou
TIPOIOVTOG. Z€ IEPITTTWON TTOU UTIAPXEL UYPADIa, OTAPATHOTE AUEOWE VAl
XPNOIHOTIOIEITE TO TTIPOIOV OUCKEUI KAl AMOPAKPUVETE EVIEAWG TNV LYpacia.
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Xpnrion Tov mpoidvtog

Katda tnv mpaypatomoinon KAfjong

Katd tv mpaypatomoinon KAong, Umopeite va SIMAWGOETE To TIPOIOV TIPOG Ta 6w

MEXPLTIC 360° 1) val TO SIMAWGCETE TTPOG Tal PéCA OTIG 0°.

- Edv xpnouomoieite 1o mpoiov Simwpévo oTig 360 ©, BePaiwdeite 6T To EPMPOS
Kal TTiow PEPOG TOU TIPOIOVTOG £XOUV TARPN EMAQN HETAED TOUG. Z€ QUTHY
TNV mePImTwon, n 086vn Tou MPoidvTog ofrVel AUTOHATA yia EE0IKOVOUNON
umatapiog.

0°

5 + Mmopeite va matrioete 1o MAfikTpo Google Assistant yia va dexBeite
€10€pyOpEVN KAON 600 TO KIVNTO TNAéPWVO 0ag BpiokeTal uéoa oto
TIPOIOV.
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Katd tn xprion duo oBovwv
ZeSIM\WOTE TO TIPOIOV yia va TomoBeTroeTe TIC SU0 08veC Sima-Gimia.

08dvn
KIvnToU
TNAEPUIVOU

066vn
TIPOI6VTOG

Xpnon TN 006vn¢ Tou MPoidvTog
‘Otav xpnotpomoleite Tautdypova Tnv 086vn Tou PoIdVToE Kat Ty 08dvn Tou
TNAEQWVOU, Umopei va umdpéel Slagopd oTa Xpwpata HETASY Twv Vo 0Bovav.

+ AOKIJAOTE VO TPOCAPUOCETE T BepHOKPATia xpwHaTog 1 Ta emineda RGB
ané 1 () > Pubpioeic > MpoPolr > Xpwipa 086vng oto AWV 0ag yia va
€NaIOTOTIOINOETE TN SIAPOPA XPWHATOC,

+ Ta xpwuata evaéxeTal va gaivovTal SIapopETIKA avANoya HE TN Ywvia, oToTe
TIPOCAPHOLETE Ta XPWHATA OTAV EXETE EESIMAWOEL TARPWE TO TTPOTOV.

Xprion apxikig 086vng Dual Screen

Tvwpiote TV apyikn 086vn Dual Screen
H apykr) 086vn Dual Screen pmopei va Aettoupyei ave€aptnta amd tnv 086vn Tou
TIPOIOVTOC.
- TMapéxel eovibla ypriyopng KKIVNGNG Kl L0l YPOUUE AQNG ME KOUPTIA
Bacikwv Aerroupylav.
+ Mmopeite va aMAEeTe To PAVTO Kat va eyKaTaoTroeTe widget.
+ XNV apyIKr 086vn, UMopEiTe €MoNG va KTENEITE SIOPOPETIKES EQAPUOYES OO
TO OUPTAPL EQAPHOYWV KAl VO SNUIOUPYEITE 1} va SIaypdPeTE PaKENOUC.
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Mvwpiote T Siatagn Tng apyikng 086vng Dual Screen
Mriopeite va xpnolpomoloeTe SIaQopeS AEITOUPYIEC TATWVTAG T EIKOVISIA TTOU
UmdipxouV otV apyxIkr 0B6vn.

TMepioxn ypriyopng
TpdoRacng

E + To @ovTo NG Simii 086vNG Umopei va SlagEépeL amod Ty lkOva Tou
BAémete e6w avaloya pe TIC TTOMTIKEG TOU KATAOKEUAOTH, TIG PUBHICEIC TOU
XPOTN, TIG EKSOTEIG AOYIOUIKOU, TIG UTTNPEGIES TTOU TTIAPEXOUV OL TIAPOXOL
TNAEMKOWVWVILY, K.A.

- Meproxn ypriyopng mpoopaocng: TomoBetrote BaoikéG EQapHOYES 0TO KATW
Ué€pog T 08dvng yia va gival Suvatr n mpdoPaon oe AUTEG amd omolovaRToTe
KapPd g apxikig 08évng.

- MAfKTpa a@rig apxIkng 006vng: Mmopeite va 0apwoeTe mPog Ta mavw Ty
apyikr} 086vn yia va poPdAeTe Ta KPUPHEVA TTAKTPO APRG TNG APXIKAG
oBovng.

- <] emotpor ot Tponyoluevn 086vn. Kheiotpo Tou minktpohoyiou A
avadudpevwy mapadipwv.

- O: ayyi&e yia emotpépel oV apxikr 086vn.

- []: ayyiére yia mpoBor piag NioTag pie T mpéo@paTa XpNOILOMOINUEVEC
EQAPUOYEC ) EKTENEDN LG EQapOYr¢ amd T AioTa. [Na va Slaypapete Oheg
TIC TPOOPATA XPNOUOTIOINMEVES EQAPUOYEG, ayyi€te AIATPAOH OAQN.
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Xprion tou mivaka eAéyxou tng Dual Screen
Mropeite va avoiete Tov Nivaka eNéyxou Tng Dual Screen tpaBwvrtag mpog ta
KATw TNV Kopuen tng 006vng.

- Am6 tov Mivaka eAéyyou Tng Dual Screen pmopeite va puBpioete T

QWTEVOTNTA TNG 086VNC.

- Edv evepyomoIOETE TOV GUYXPOVIOHO EMAEyOVTAG ZUYXPOVIOHOG, N
QWTEVOTNTA TNG SIMARG 088vNG ouyxpoviletal Ue ekeivn Tou ouVSESepEVOL
TIPOIOVTOC.

« Tava kavete AN kdvag Tng 08dvng Tou mPOIGVTOC, UMOPEITE VA TIATHOETE

10 Capture+.

- Mrmopeite va amoBnkevoeTe Tnv €lkdva xpnotpomolwvtag 1o QuickMemo+ iy
va TV amobnkevoete otny EkBeon.

- Mmopeite va amevepyorotfioete Tv 086vn Tou mpoidvTog matwvtag 1o Dual
Screen.

- H &umAr 086vn kat to cuvdedepévo kivntd TNAéPwVO amocuvdéovTal.
- Ta va petapeite oo pevol pubpioewv g SUm¢ 086vng, mathoTe (g

=— PuBpioeig dITTARG
086vng

Mpoodppoy) —p———————

mertes s | ————]e

Capture+ ———
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Mpayparomoinon aAaywv otnv apxiki 006vn tng Dual Screen
MoTAOTE MAPATETAPEVA [Ia KEVR TIEPLOXN 0TV apxIKr) 006vn Dual Screen kat
EKTENEOTE TN AelToupyia Tou BéNeTE.

la va mpooBéoete éva widget otnv Apxikr 006vn, TatrioTe mapateTapéva éva
Kevd onpeio TG ApxIkrG 086vng Kat kpatrioTe To emAéyovtac Widgets.

Mo va aMa&eTe Tametoapieg, O€pata kat elkovidla, TATAOTE MAPATETAUEVA OE
£€va Kevo onueio otnv Apyikr) 08évn kai emAé€te Tanetoapieg.

Mo va aAGEeTe TV mpoemeypévn 006V, TATHOTE MAPATETAEVA I KEVH
mieploxn TNG ApXIKRG 006vNng, uetakivnOeite otnv emBupnTr 086vn, ayyi€te 1o
koupri Y, kal 0T cuvéxela ayyi€Te TNV 086vn yia GAn pia eopd.

MpoemAeypévn 086vn

Widget TameToapia
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MpoBoAr @dvtou Simirig 006vng
H mpofoln Tn¢ eKGvag ovTou ivat Suvatr HOVo HE TV amdkpun Twv
€QapUOywV Kal Twv widget otnv apxikr 086vn.
Am\oTe Ta SU0 SAKTUAG 0ag OTNV apXIKK 08N,
« T va emoTpéPete 0TV apxIKr 006vN LE TIG EQaPHOYEC Kal Ta widget, evioTe
Ta SAKTUAA 00 €V TA AKOUUTTATE GTNV apyIK 086vn A ayyi€te To koupmi <.
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PUOon mepiBailovrog Simrig 006vng

Mropeite va puBpioete To mepIBAaNov Stmrig 086vng 6To KIvnTo TNAEQWVO TIou
£xete ouvSEael oTn O 006V,

1 EmAé€re O > PuBpioeig> MpoBohr > Authr 006vn.

5 « [pémel va cuvOEETE To KIVNTO TNAEPWVE oag oTn SimAry 086vn yia va Seite
TO OTOIYEIO TOU PEVOL yia Th puBion Tou TepIBaANovTog Simrig 08dvng.

7 Em\é€te kal opioTe TIC Aertoupyieg Tou emBUpEITE.

- Dual Screen Tool (epyaleio Simrig 086vnc¢): Edv cuvdéoeTe To Kivnto
AEQWVO oag otn Simhr) 086vn, oTtnv 086vn epgavifovtal Ta epyalsia
Simiic 086vnc. To eminedo PwTEVOTNTAG GUYXPEOVIETA LIE EKEVO TOU
TIPOIOVTOC.

+ Use Dual Screen (xprion imrig 086vn¢): Mmopeite va evepyomolrioete
Kall armevepyomoloeTe Tr SimAr) 086vn, va eVOAAOOETE eIKOVEC PETA&
TOU KIVNTOU TNAEPWVOU Kall TNG St 006vVNG KAl va XPNOIOTIOLEITE TIG
EQOPHOVEC.

- Qwtavétnta: MMopeite va TPOCGAPUOCETE TN QWTEIVOTNTA TNG 086VNG
HETAKIVWVTAG TV UMApa EAEYXOU TTPOG Tal APLOTEPA 1 TTPOG Ta SedId.

Keep the same as main screen (Aiatripnon 6polag e Ty Kupia 086vn):
Mropeite va cuyxpovioeTe To eMinedo PWTEIVITNTAG LE EKEVN TOU
ouvOESEUEVOU KIVNTOU TNAEQWVOU.

Tametoapia: Mmopeite va eMAEEETE TV TAMETOOPIA TN APXIKAE 080VNG.

App drawer Icon (eikoviblo cupTaplol epappoywv): Mmopeite va
EUPAVIOETE 1) VO KPUYETE TO CUPTAPL EPOPHOYWV OTO TTPOIOV.

- E@appoyn My Pick: KdBe @opd mou evepyomoleite tn SimAr) 086vn,
€KTENOUVTAIL AUTOATA OL TIPOKABOPICHEVES EQAPUOYES SITARG 006VNC.

E + H\iota epappoywv mou pgaviovtat otnv 086vn evoéxetal va SlagEpel,
QVANOYQ E TIG EYKATEOTNUEVES EQAPUOYEC.
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Xprion tn¢ Aetroupyiag Dual Screen Capture+

Amotinwon 086vng pe to Dual Screen Capture+

TpaPréte mpog Ta KATW TN YPAUWN KATdoTaong otnv 08dvn mou BéNete va
QMOTUNIWOETE KAl TATHOTE ¢, Capture+.

« Tava amobnkeloeTe TV €lkdVa, TATAOTE O «a amoBnkevoTe TV oTn Béon
TIOU EMOUEITE.

- Mrmopeite va amoBnkeVoeTe Tnv €lkdva xpnotpomolwvtag 1o QuickMemo+ iy
va TV amobnkevoete oty EkBeon.

- Ta va amoBnkevete dedopéva mavta oty idia Béon, emAé€te Xprion
TipoeMAEYHEVNG EQAPHOYNG KAl EMAEETE TNV EQapPLOYN TIOU BEAETE.

Anpiovpyia onpelwoswv otnv 086vn pe 1o Dual Screen
Capture+

T TpaBntte mpog ta Katw TN ypappr Katdotaong otny 086vn mou BéAeTe Kat
TIaTHOTE T0 7, Capture+.

+ H ewova mou amotunwoate epgavietal wg meAavela pyasiog Twv
ONUEWOEWV KAl TO EPYAAEIO ONUEWOEWV EUPAVICETAl OTNV KOPUPH TN
00évnc.

7 InUedoTe EAelBEPa EMAVW GTNV EIKOVA TIOU AMOTUTIWOOTE.
+ MNatoTe 2 yio va KpOTAOETE Hia XElpOypapn onpeiwon atny 08ovn.
- MatAote T yia va mnKTpoAoyROETE KEIEVO OTO KATW HEPOC TNC 086VNC.

3 Tava amobnkedoeTe T onpeiwon, TatRoTe Q Kall armoOnKeVoTE TNV 0N
6¢on mou emBupeite.

+ Mmopeite va amoBnKeVoETE T ONPEIWON XPNOILOTOWWVTAG TO
QuickMemo+ ) va Tnv amobnkevoete otnv ‘EkBeon.

- Edv e10dyeTe povo Keipevo, auto amobnkeVETal autoUATa amé To
Qmemo+.

- Nava anmoBnkevete Sedopéva mavta otny idla Béon, emAé€te Xpron
TIPOEMAEYHEVNG EQAPHOYNG KAl EMAECTE TNV EQapUOYH TIOU BEAETE.
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Epyaheio dimAng 00ovng
Av ouvSEeTe TO KIVNTO TNAEPWVO 0ag ot Simiry 086vn Kat evepyoToleite T SImin
086vn, otV 08vn Tou KivnTou TNAePwvoU eugavifovtal Ta Epyaheio SimArig

086vn¢ @.

Ao evepyorotrioete T StmAr 08vn, pmopeite va deite To epyaleio Epyaleio
8¢ 006vn¢, dmwg amekoviCeTal MapakaTw.

la va eupavioeTe i va KpUYETE To epyaleio Stmrg 08évng, matriote To
e\agpa.

Mmopeite va evaldooete 086veg PeTa&l TG Simiig 08évng Kat Tou
KIVNTOU TNAEPWVOUL.

Mmopeite va oteilete TV 006vn amo To KIvnto ThAéPwvo otn Simi
oBovn.

® 06

Mmopeite va peta@épete v 086vn and tn Simr} 086vn aTo KIvnto
TAéQwvo.

Eav xpnotpomolgite pévo t Stmhiy 086vn, UMopEiTe va HEICETE TO
eninedo PuTeVATNTAG TNG 006VNG TOU KIvTou TNAEPWVOU (KUpLa 08dvn)
yia e€olkovopnon pmatapiac. Av 6ev BENETE va XPNOIUOTIOINOETE QUTHY
N Aettoupyia, GapWOoTe TNV KUpLa 006vn.

Eav Bé\ete 010 KIvnTo TNAéQVO Kat 0N Sty 086vn va epgavidetat n
{1 086V, umopeite va xpnotpomooeTe TVEUpuywvia mpoBoAr.

® 6

Mmopeite va amevepyomolroete tn Simry 086vn amoouvdéovtag T
SImAr) 086vN Kal To KIvNTO TNAéPWVO.
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+—— EpyaAeio SITTAAG
| 086vng
| EvaAAd&gTe 086veg

“— Epgdvion tTng kupiag

I

oTn dITAR 086vn
e— Epgavion Tng dITARg
|| 086vng aTnv Kupia
[ le— BAATE TV KUpIA 086V OF
AerToupyia avaoToAng
«— Eupuywvia TTpoBoAn

H— ATTEVEPYOTIOINOTE TN
J SITTAR 086vn

« Edv amevepyomolroeTe To KivTd TNAéPwVO oag, Ba amevepyomolnei miong
n &imhr 086vn. Qotd00, av anevepyomotioeTe T Sy 006vn, To KIvnTo
TNAEQUWVO TIOPAPEVEL EVEPYO.

+ H\eroupyia autr Sev eivai S1aBéotpn otnv 086vn KAEGWHATOG Kat
evepyomoleital LONG EeKNEIBWOETE TNV 086V,

« To eiKovidlo TG Eupuywviag mpoBoArs eppaviletal ota epyaleia SImArg
086vng dtav ekteNeite TV e@appoyr) Chrome.
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Xprion ektetapévng mpoBoAng
Mmopeite va EMEKTEIVETE TN XPHON HIOG EPAPHOYNE 0TV KUpLa 006vN Kal oTn
SImAr) 086vn yla AGyoug TPaKTIKOTNTAG.

E + Autij n cuvaptnon eivat miong SlaBéotun O EQAPHOYEG CUVEPYATWY EKTOG
amo TIG EQappoyEC Kapepa kat ANumou.
+ H&iemagn xprotn pmopei va Slagpépel avaloya Pe Ty EQappoyr Tou
XPnolgormoleital.

Xprion ektetapévng mpoPoAng otnv epappoyn Kdpepa
Mmopeite va TpaPriéete pia ewtoypagia ri éva Bivieo oTo mpoidv iy 6To KIvntd
TAEQWVO oag kat va Seite To amotéheopa otn Sty 006vn ot GAANn Agupd.

1 Extehéote v e@appoyn Kapepa oto mpoiov 1y To Kivntd TnAEQwvo oag Kal
TPaPnETe pia pwtoypagia ry éva Biveo.
7 A@oU Tpapr&ete pia pwrtoypagia rj éva Bivteo, emAéEte To elKovidio
Mpogmokomnnon.
+ Mmopeite va beite T pwtoypaeia rj To Bivteo mou Tpapriate otn Simn
KApePa otV AAAN MAgLPA.

Eikovidio
TIPOETTIOKOTTNONG

A\ 086vn LG (LM-V505N) 220



5 « Eav BAémete wia pwroypagia fj éva Biveo matwvTag To ikovidio
TIPOETIOKATNONG Hia Popd, Sev XpeldleTal MAEOV va TIATHOETE TO EIKOVIOI0
yla va Seite Tic puToypaepies fy Ta Bivieo mou éxete TpaPrigel otn SimAn
mpofoAn.

+ Auti n Aettoupyia Sev MAPAEVEL EVEPYI AV ATIEVEPYOTIOIOETE TNV
epappoyn Kauepa kat v evepyorotoete Eavd.

Xpron ektetapévng mpoBoAng otnv e@appoyn AAUToup
MNatrote (<[] evd exTeNeital 0 PAKENOG TNG EQAPUOYNC AMUITOUW GTO TIPOIOV 1} 0TO
KIvnTo TNAéQWVO yia va Seite o peyeBuvon T eutoypagia iy To Bivieo otnv dAAn
o0ovn.
1 Extehéote TV e@appoyr ANUIOU GTO TIPOIOV 1y GTO KIvTO TNAEQWVO.
7 Em)é€te Tov pakeho Tou dAumoup kat ot cuvéyeia matrote (<.
+ Howtoypagia i To Bivteo Ba eppaviotoly o€ peyéBuvon otnv AAn 0Bovn.
- Natrote p)(] yia va Slakopete autry T Aertoupyia.

Eikovidio etréktaong
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Xpnon ¢ epapuoyng My Pick

KdBe popd mou evepyomoleite Tn Sy 006V, eKTENoUVTAL QUTOHATA OL

nipokaBoplopéveg epappoyE Simng 0Bévng.

1 EmAé€re O> Pubpioeg > MpoPohi > Aumhi) 086vn > egappoyr My Pick.

7 Em\é€te TIc epappoyé o Ba ekteholvTal autdpata KA popd Tou
gvepyoroleite TNV 086vn Tou TMPOIOVTOG.

+ Oplopévec epappoyeg dev eival duvato va ekteholvTal o€ Simiry 086vn.
+ H\iota epappoywv mou epgaviovtat otnv 086vn evoéxetal va SlagEpel,
QVANOYQ E TIG EYKATEOTNEVES EQAPMOYEC.

Xprion tn¢ Aertoupyiag Eupuywviag mpoP oA tng SimAig

0Bovn¢

'Otav xpnotpomoleite tnv epappoyr Chrome ry Naver, propeite va

XPnotomooeTe Tn Asttoupyia Eupuywviag mpoBoArg wote n Simry 086vn Katn

086vn Tou KivnTou TNAEQWVOL va pgpavifouy v idla eiova.

T Evd 0 KIvnT TNAEQUVO gival ouvSedepévo, ektehéate Ty epapuoyr Chrome.

7 Metall twv gpyaleiwv Simric 086vng, emAé€te T Aertoupyia Eupuywvia
TPoBoA @).

3 Mrnopeite va enekteivete Tnv 006vn opillévTia i K&BeTa.

E . Otav xpnotponoleite tn Aertoupyia Eupuywvia mpoPor, prmopeite

Va EMEKTEIVETE emiong To Tedio £1l06Sou MAnKTpoAoyiou £T0L WOTE va
mpocapuoletal otny opi{évtia ) TV KABeTn TPOBOAN.
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Metakivnon petagu oBovwv e@appoywv otn Stmn 086vn
Mol VoL ETAKIVAOETE TNV 080vN KATOLaC EQapUOoynE METAgY TnG 086vng Tou
TIPOIGVTOC Kall TG 086vNG TOU TPOIGVTOE KAl TOU KIVNTOU TNAEPWVOU, CAPWOTE TV
006vn pe Tpia SayTula.
+ YapwoTte TV 086vN NG EQapUOYNE mPOG Ta aploTepd 1 Ta Sedid Le Tpia
SAxTUAA yla VA TV LETAKIVAOETE EAEUBEPA PETAEY TNG KUPLAG Katt TNG SeUTEPNG
obovng.

ZapwaTe TNV 086VN EQAPUOYNG HE Tpia Metakivnon Tng 086vng epappoyng otnv
SaxTUAa KUpIa 086vn

ZapwoTE TNV 086VN EQAPUOYNG HE TPia MeTakivnon tng 08évng £Qapuoyrg otn
dayTula SITTAR 086vn
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« [la va xpnotpomoloete auth T Aeitoupyia, Ba mpémel Ta tpia SdyTula va
ayyiCouv Tnv 086vn TauTOXPOVA.

Xpnon dumAov mAnktpoAoyiou otn StmAr 006vn
Mnopeite va matioTe To koupri Stmhol minktpoloyiou B3 otn Aertoupyia
opt{évTIag mPOROANRG YIO VA LETAPEPETE TO TTANKTPOAOYIO 0TO KATW UEPOC TG
amévavti 086vnc.
Mriopeite va emekTeiveTe T0 MANKTPOAOYLO TIPOG TA TTAVW K TIPOG Ta KATW WOTE
VOl XPNOLUOTIOIEITE TNV EMAVW 00GVN Yid TV EQAPOYR Kal TV KATw 006vn wg
TIANKTPOAOYIO.
T And v 086vn minktpoAdynong netaBaete T Sumhiy 086vn oe opilovia
TIPOROAN.
7 Xto mapdBupo mnktpoloyiou TnG SImArG 086vng matiote S,
« Mnopeite va BAémete Ta Sedopéva mou mAnktpoloyeite 0Tn SeuTePn 006vN
KOl VOl XPNOIOTIOLEITE TO TTapdBupo MANKTPOAGYNONG OTO TTPOIOV.
[a va EMava@éPETe To KATW MANKTPOAGYIO 0TV apyIKH Tou Béon, matroTe
&8 6tav eivar peyeBupévo.

AITAS TTANKTPOAGYIO

E « [1a va PETaKIVACETE TNV 080VN TNG EPAPHOYNE EMAVW 1 KATW, ayyi&Te
TN e Tpia SAXTUAA TAUTOXPOVA KAl METAKIVAOTE TV EMAVW 1 KaTw. MNa
AemTopépeleg, avatpé€te oty evotnta Metakivnon petaét oBovay
gpappoywv otn SimAr) 086vn .
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Xprion TPImARG TPOEMOKOTNONG

Mmopeite va BAémete Tautdxpova otn SImAr) 086vn TIG TPEIG TTPOETIOKOTCEIG TG
omiobiag kapepag.

1 Natjote O > Kapepa.
7 Matiote 10 [{(J 010 MAvw uéPog Te 086vNnE KAUEPAC.

+ Epgaviletai otn 6eUtepn 086vn n emhoyn Triple Previews (tpimAn
TIPOEMOKOTINON).

E « ‘Otav emAéyete TNV emBUpNTH €IKOVa and tnv 086vn Triple Preview,
umopeite va tn deite 0TV KUpLa 0Bdvn.
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Xprion Aetroupyiag kaBpéetn
Mriopeite va BAEMETE TNV TPOEMIOKOTNGN TWV GWTOYPAPIWV 0Tn SeUTePn 006VN,
otav Byalete WTOYPAYIES PE TNV KAPEPQ.
1 Natjote O > Kapepa.
7 Matiote 10 [{(J 010 MAvw uéPog Te 086vNnE KAUEPAC.
+ X &mhry 086vn epgaviletal n Asttoupyia Aertoupyia KaBpéptn,

Aerroupyia kaBpéptn

E + Mmopeite, emiong, va Bydlete pwtoypagies i Bivieo ameubeiag amd
Seltepn 0Bovn.

XpnotpomotjoTe Tn SeUTePn 006vN yia va pubLiceTe T ywvia Aqing oTig
S1APOPES TIEPITTWOELS TTOU AVAPEPOVTAL TIAPAKATW.

+ Ajun ewtoypaeiag amd YnAd: Xpnotpomoleital yia T AMjin ewtoypagiog
TIOAU KOGHOU O€ KAmola ouvaulia i ekdnAwon A yia T Aun ewtoypagiag
Heyalou Xwpou.

+ Ajun ewtoypagiag amd xapnAd: Xpnotpomoleital yla T AMin ewtoypagpiog
Tou Matdlov 6ag amo To eMIMESO TWV LATIWV TOU 1 yia TN MjPn ewTtoypagiag
YNAWV KTIPiwV KAT.

AN

AAqYn ewTtoypagiag atd ynAd  ARyn gwToypagiag atod XapnAd
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Xpnon Aetrroupyiag Katomtpou otn SimAn 006vn
Otav Byadete pia oL, UMTOPEITE Vot XpNOIHOTOIOETE T SeUTEPN 006VN WG
KATOTTPO.
1 Natote O > Camera (@wtoypa@ik unyavr) kat Byakte wa putoypagia pe
TNV UIPOCTIVA KapePa.
7 Natiote 500 PopPEC TO KO TOU PAAG 0TV EMavw Se1d ywvia.
+ H &umAr 006vn pwriCel {wnpd To avTikeievo, akpIBwg Omwe éva KAtomTpo.

% Eikovidio Aertoupyiag
KOTOTITPOU

E + Metakiviote T pmdpa pUBpIong Tou WB yia va MposappOCETE TO XpWHA
TOU KOTOTTPOU.
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Xprion tn¢ Aetroupyiag otiypiaiog Aqng otn SimAn 066vn
To mM\nktpoAdylo LG Keyboard mpoogépel T Aettoupyia otiypiaiac \yng G2 étav
T0 KIvNTO TNAéQWVO gival ouvdedeuévo 0To POV,
Mriopeite va XpnolpomoloeTe To MANKTPOAGYLO TNV KUpla 086vn, va BydAete
oTIypoTUno TG SIMA¢ 086vNg Kal va To €lodyeTe aneubeiag oto mapabupo
TIANKTPOAOYNONG.
SV 086vn Tou mMinktpoloyiou LG matiote [,

+ NapPdvetat otiypdtumo g Simiiig 086vng To omoio TPosapTATal AUTOMATA

070 TapdBupo MANKTPOAGYNONG.

—— ZTIypiaio Ajyn

2ZTIYMIOTUTTO 086VNG

E « Agv pmopeite va xpnotpomoleite Tautdxpova Kat Tig SUo 08ves wg 0Bévn
TANKTPOAGYNONG.
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LG Game Pad

Mmopeite va xpnotpomoleite oTnv 086vn Tou TPOIGVTOG EIKOVIKA XEIPIOTHPLA

yta va mailete maixvidia 010 Kivntd Aéewvo. Otav mailete Kamolo magvidl,

QMOHOVWOTE TNV KUPLa 006vn amod T eitepn 080vN, WOTE TO XEIPIOTAPIO VA PNV

eumodidel tv 086vn Tou mayviSiov.

1 NamgoreO> I'ql;)éypauuu Exkiv. Matvid (ekkivnon matyvidiwv) Kat emAéETe
LG Game Pad [®).

LG Game Pad

7 Matiote @ Kall, Katdmy, oUPETe aplotepd kat Se€1d yia va emAEEeTe TO OTIA
Tou LG Game Pad mou mpotipdre.
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Mrmopeite va maiete To maixvidt KpATWVTAE T TPOIOV OMWE amelkovileTal
TIAPAKATW.

E « To LG Game Pad eivat S1aBéotpio pdvo yia matyvidia mou umootnpilouv
TIPAYHOTIKA XEIPIOTHPIA game pad.

+ Avaloya e To Tatyvidl, OpIoUEVES EQAPHOYEG 1) TANKTPA EVOEXETAL VA NV
unootnpiCovtat amd 1o LG Game Pad.
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Epmopikd ojpara

+ Mveupartikd Sikaiwpara ©2020 LG Electronics, Inc. Oha ta Sikauwpata
npooTtatevovTal. H emwvupia LG kat o Aoyotumo LG eival oripata katateBévia
Tou Opilou LG Kal Twv OXETIKWY OVTOTATWY TOU.

- Ta Google, Google Maps, Gmail, YouTube, Google Duo, Google Play, Android,
Chrome, Owtoypagiec Google, Google Play Protect, Huepohdylo Google,
Google Docs, Google Drive, Google Sheets kit GAMa OXeTIKA orjpaTa Kal
Noydtuma givat epmopikd orjpata g Google LLC.

- 'O\ Ta UTTOAOITAL EPMOPIKA CAHATA KAl TIVEUHOTIKA SIKAUWLATA OIMOTEAOUV
1510KTN G0 TWV QVTIOTOLKWVY KATOXWVY TOUG,

AHAQXZH ZYMMOPOQXIHZ

Meé 1o mapdv, n LG Electronics Sn\wvel 6Tt To mpoiov LM-V505N cuppop@wvetat
HE TIG BACIKEG OMAITAOELG KAl LE TIG UTTONOUTEC OXETIKEC Slatdelg Tng Odnyiag
2014/53/EV.

‘Eva avtiypago tng AnAwong Zuppdpewong SatiBetal otn Sievbuvon
http://www.lg.com/global/declaration

AievBuvon evnpépwong yia Oépara
CUHUOPQWONG WG TTPOC T Xprion Tou
TPOIOVTOC

LG Electronics European Shared Service Center B.V.

Krijgsman 1, 1186 DM Amstelveen, The Netherlands
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Meproootepeg MAnpoopicg

Mpo@UAAEEIC KATA TOV XEIPIOHUO TOU TTPOIOVTOG

« To mpoidv Sev pmopei va xpnaotuomoinBei amd pévo tou.

Mn xpnotpomoleite oUTe va QopTileTe T TPOIOV O MEPIMTWOT TTOU UTIAPKEL

UypaGia 0TOV AKPOSEKTN EMKOVWVIAE Kal TPo®odoaiag Tou mpoiovToc.

- Yndpyel kivbuvog mupkaytdg, nAektpomingiag, Tpavpatiopol fi BAGBNG T
OUOKEUNG.

- Y€ MEPIMTWON LYPAGIAG, OTAPATHOTE AUEOWG VA XPNOILOTIOLETE TN CUOKEUN
Kall AMMOHOKPUVETE T OTOIXE(D LYPasiag.

To vypd mou éxel S1El0SUOEL 0TO GUOKEUN GaC AMALEL TO XPWHA TNG ETIKETAG

TIPOIOVTOC TTOU BPIoKETAL OTO ECWTEPIKOG TNG CUOKELNG. Omoladrmote BAAPN

TNG CUOKEUNG 00¢ TIOU TIPOKOAEITAL WG AMOTENEGA TNG €KBEONC TNG OE LYPO

Sev KAAUTTTETAL OO TNV €yyUNoN.

E€aptripata amd okAnpupévo yuaAi
Ta e§aptripata auTrig TG CUOKEURG ammd OKANPUKEVO Yuai Sev xouv SidpKela ¢’
6pou {wnig, ouvenwg, evdéxetal va eBapouV Ue Ty Tdpodo Tou xpdvou.
Edv n ouokeun oag méoel mavw O€ pia OKAnpr em@Avela 1y TpooKpoUsEL KATIoU
ue Suvapn, pumopei va mpokAnBei {nid 0To okANPUKEVO YUaAL.
Ye qutrv TV mePImTwan, SIakOYTE APESWE TN XPHON TNG GUCKEUNG Kall
EMKOWVWVAOTE Ye éva Kévtpo e§umnpétnong mehatwv g LG.
+ 2TNV ayopd KUKANOQOPOUV TIPOOTATEVTIKEG BIKEC TTOU UMTOPE(TE Va
TIPOUNOEUTEITE YIa VO TTPOOTATEVOETE Tr) GUOKELN 0ag amd Tn {npid.
N&Bete umOPN OTL AUTEC OL TIPOCTATEUTIKES Orikeg Sev KaAUTTTOVTAL amtd TV
€yyunon tn¢ LG Electronics kat 6ev eyyuwvTal Tnv ao@ahela.

Xpron ¢ prmatapiag
+ Tompoidv auto Sev xpnotpomolei SIkr Tou pmatapia.
- ‘Otav 010 MPOIGY TPOCAPTNBEL KATTOLO KIVNTO TNAEPWVO, AUTO XENOILOTIOLE
TNV YIatapia Tou Kivntol TNAEQWVou.
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Anoppudn tng maAidic cag GUOKEVNG

1. AuTo o Slaypappévo oUpBOAO TOU TPOXOPOPOU KASOU UTTOSEIKVUEL
OT1 Ta amOBANTA NAEKTPIKWV Kalt NAEKTPOVIKWV TTpoiovTwv (AHHE)
TIPETEL VO AMTOPPITTTOVTAL XWPLOTA amd TA YEVIKA OIKIAKA amoppiupaTa.

EE 2. Ta oA NAEKTPIKA TTPOIGVTA UMOPE VA TIEPIEXOLV EMIKIVOUVE
0UGIEC KAl WG EK TOUTOU N 6WOTH amoppidn TG MaMAG 0aG GUOKEUNG
QMOTPEMEL EVEEKOUEVES APVNTIKEG CUVETTELEG YIat TO TIEPIBAANOV
Kat v avBpwmivn uyeia. H maNid 6ag GUOKELr) UMOPE( va TTEPIEEL
ETAVAYXPNOILOTIONACIUA AVTAAAAKTIKE TIou Ba prmopovoav va
XpnotpomonBolv yia Ty emokeur) AAwv TPoidvTwy, KaBwg kat dAAa
UNIKa a&iag mou umopouv va avakukAwBoOv yia e€0IKovOpnon Twv
TIEPIOPIOUEVWY PUOIKWY TIOPWV.

3. Mmopeite va mATe T CUOKEUN 0, €[TE 0TO KATAOTNHA Ao TO
omoio ayopdoate To TPOIGY, I Va EMKOIVWVACETE TO TOTIKO YPAPEi0
QAMOPPIUHATWY VIO AETTTOPEPELEG OXETIKA HE TO TTANCLEGTEPO
€YKeKpIpEVo onpeio ouhoyrig AHHE (AmdBAnta HAekTpiKwy Kat
HAeKTPOVIKWY ZUOKEUWV). Mat TIG TTO TIPOGPATEC TANPOPOPIES YIa TN
Xwpa oag emokepBeite T SievBuvon www.lg.com/global/recycling
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ENGLISH

About this user guide

Thank you for choosing this LG product. Please carefully read this user
quide before using the device for the first time to ensure safe and proper
use.
+ Always use genuine LG accessories. The supplied items are designed
only for this device and may not be compatible with other devices.

+ Descriptions are based on the device default settings.

- Default apps on the device are subject to updates, and support for
these apps may be withdrawn without prior notice. If you have any
questions about an app provided with the device, please contact an
LG Service Centre. For user-installed apps, please contact the relevant
service provider.

- Modifying the device's operating system or installing software from
unofficial sources may damage the device and lead to data corruption
or data loss. Such actions will violate your LG licence agreement and
void your warranty.

- Some content and illustrations may differ from your device, depending
on the area, service provider, software version, or OS version, and are
subject to change without prior notice.

- Software, audio, wallpaper, images, and other media supplied with
your device are licenced for limited use. If you extract and use these
materials for commercial or other purposes, you may be infringing
copyright laws. As a user, you are fully responsible for the illegal use of
media.

+ Additional charges may incur for data services, such as messaging,
uploading, downloading, auto-syncing and location services. To avoid
additional charges, select a data plan suitable to your needs. Contact
your service provider to obtain additional details.

- This user guide is written in major languages for each country.
Depending on the language used, content may partly differ.



Instructional notices

A WARNING: Situations that could cause injury to the user and third
parties.

A CAUTION: Situations that may cause minor injury or damage to the
device.

E NOTE: Notices or additional information.

About this user guide
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Guidelines for safe and efficient use

Please read these simple guidelines. Not following these guidelines may be
dangerous or illegal.

Should a fault occur, a software tool is built into your device that will gather a
fault log. This tool gathers only data specific to the fault, such as signal strength,
cell ID position in sudden call drop and applications loaded. The log is used only to
help determine the cause of the fault. These logs are encrypted and can only be
accessed by an authorised LG Repair centre should you need to return your device
for repair.

Exposure to radio frequency energy
Radio wave exposure and Specific Absorption Rate (SAR) information.

This device has been designed to comply with applicable safety requirements for
exposure to radio waves. These requirements are based on scientific guidelines that
include safety margins designed to assure the safety of all persons, regardless of
age and health.

+ The radio wave exposure guidelines employ a unit of measurement known
as the Specific Absorption Rate, or SAR. Tests for SAR are conducted using
standardised methods with the device transmitting at its highest certified
power level in all used frequency bands.

+ While there may be differences between the SAR levels of various LG device
models, they are all designed to meet the relevant guidelines for exposure to
radio waves.

+ The SAR limit recommended by the International Commission on Non-lonizing
Radiation Protection (ICNIRP) is 2 W/kg averaged over 10 g of tissue.

+ The highest SAR value for this model tested for use at the ear is 0.243 W/kg
(10 g) and when worn on the body is 1.497 W/kg (10 g).

+ This device meets RF exposure guidelines when used either in the normal use
position against the ear or when positioned at least 5 mm away from the body.
When a carry case, belt clip or holder is used for body-worn operation, it should
not contain metal and should position the product at least 5 mm away from
your body. In order to transmit data files or messages, this device requires a
quality connection to the network. In some cases, transmission of data files
or messages may be delayed until such a connection is available. Ensure the
above separation distance instructions are followed until the transmission is
completed.



Information about the RF exposure from FCC

In August 1996, the Federal Communications Commission (FCC) of the United
States, with its action in Report and Order FCC 96-326, adopted an updated safety
standard for human exposure to radio frequency (RF) electromagnetic energy
emitted by FCC regulated transmitters. Those guidelines are consistent with the
safety standard previously set by both international and US. standards. The design
of this device complies with FCC guidelines and these international standards.

Part 15.19 statement

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions:

(1) This device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that
may cause undesired operation.

Part 15.21 Statement

Changes or modifications not expressly approved by the manufacturer could void
the user's authority to operate the equipment.

Guidelines for safe and efficient use 7



Body-worn Operation

This device was tested for typical bodyworn operations with the back of the device
kept 0.39 inches (1cm) between the user’s body and the back of the device. To
comply with FCC RF exposure requirements, a minimum separation distance of
0.39 inches (1cm) must be maintained between the user's body and the back of
the device.

Any beltclips, holsters, and similar accessories containing metallic components
may not be used. Body-worn accessories that cannot maintain 0.39 inches (1cm)
separation distance between the user’s body and the back of the device, and have
not been tested for typical body-worn operations may not comply with FCC RF
exposure limits and should be avoided.

Part 15.105 Statement

This equipment has been tested and found to comply with the limits for a class

B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates uses and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

+ Reorient or relocate the receiving antenna.

+ Increase the separation between the equipment and receiver.

+ Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.

Guidelines for safe and efficient use 8



Product care and maintenance

+ Use only in-box accessories which are authorised by LG. LG does not guarantee
any damage or failure which is caused by third party accessories.

+ Some contents and illustrations may differ from your device without prior
notice.

+ Do not disassemble this unit. Take it to a qualified service technician when repair
work is required.

+ Repairs under warranty, at LG's discretion, may include replacement parts
or boards that are either new or reconditioned, provided that they have
functionality equal to that of the parts being replaced.

- Keep away from electrical appliances such as TVs, radios and personal
computers.

+ The unit should be kept away from heat sources such as radiators or cookers.
+ Do not drop.
+ Do not subject this unit to mechanical vibration or shock.

+ Switch off the device in any area where you are required to by special
regulations. For example, do not use your device in hospitals as it may affect
sensitive medical equipment.

+ Do not handle the device with wet hands while it is being charged. It may cause
an electric shock and can seriously damage your device.

+ Do not charge a handset near flammable material as the handset can become
hot and create a fire hazard.

+ Use adry cloth to clean the exterior of the unit (do not use solvents such as
benzene, thinner or alcohol).

+ Do not charge the device when it is on soft furnishings.
+ The device should be charged in a well ventilated area.

+ Do not subject this unit to excessive smoke or dust.

Do not keep the device next to credit cards or transport tickets; it can affect the
information on the magnetic strips.

+ Do not tap the screen with a sharp object as it may damage the device.

Guidelines for safe and efficient use 9



+ Do not expose the device to liquid or moisture.

+ Use accessories like earphones cautiously. Do not touch the antenna
unnecessarily.

+ Do not use, touch or attempt to remove or fix broken, chipped or cracked glass.
Damage to the glass display due to abuse or misuse is not covered under the
warranty.

+ Your device is an electronic device that generates heat during normal operation.
Extremely prolonged, direct skin contact in the absence of adequate ventilation
may result in discomfort or minor burns. Therefore, use care when handling your
device during or immediately after operation.

If your device gets wet, immediately unplug it to dry off completely. Do not
attempt to accelerate the drying process with an external heating source, such
as an oven, microwave or hair dryer.

+ The liquid in your wet device, changes the colour of the product label inside your
device. Damage to your device as a result of exposure to liquid is not covered
under your warranty.

A mobile device requires proper air circulation in order to dissipate heat. Direct
skin contact and inadequate circulation of air flow to the device may cause the
device to overheat. The device must be at least 1.0cm from between the user's
body.

+ Prevent dust of any other foreign substances from getting into the Charger/
USB cable port. It may cause heat or fire.

Efficient device operation

Electronics devices
All devices may receive interference, which could affect performance.

+ Do not use your device near medical equipment without requesting permission.
Please consult your doctor to determine if operation of your device may
interfere with the operation of your medical device.

+ Pacemaker manufacturers recommend that you leave at least 15 cm of space
between other devices and a pacemaker to avoid potential interference with the
pacemaker.

+ This device may produce a bright or flashing light.
+ Some hearing aids might be disturbed by devices.
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+ Minor interference may affect TVs, radios, PCs etc.

+ Use your device in temperatures between 0 °C and 35 °C, if possible. Exposing
your device to extremely low or high temperatures may result in damage,
malfunction, or even explosion.

Road safety

Check the laws and regulations on the use of devices in the area when you drive.
+ Do not use a hand-held device while driving.
+ Give full attention to driving.

+ Pull off the road and park before making or answering a call if driving conditions
SO require.

+ RF energy may affect some electronic systems in your vehicle such as car
stereos and safety equipment.

+ When your vehicle is equipped with an air bag, do not obstruct with installed
or portable wireless equipment. It can cause the air bag to fail or cause serious
injury due to improper performance.

If you are listening to music whilst out and about, please ensure that the volume
is at a reasonable level so that you are aware of your surroundings. This is of
particular importance when near roads.

Avoid damage to your hearing

To prevent possible hearing damage, do not listen at high volume
levels for long periods.

Damage to your hearing can occur if you are exposed to loud sound for long
periods of time. We therefore recommend that you do not turn on or off the
handset close to your ear. We also recommend that music and call volumes are set
to a reasonable level.

+ When using headphones, turn the volume down if you cannot hear the people
speaking near you, or if the person sitting next to you can hear what you are
listening to.

E + Excessive sound pressure from earphones and headphones can cause
hearing loss.
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Glass Parts

Some parts of your device are made of glass. This glass could break if your device is
dropped on a hard surface or receives a substantial impact. If the glass breaks, do
not touch or attempt to remove it. Stop using your device until the glass is replaced
by an authorised service provider.

Blasting area

Do not use the device where blasting is in progress. Observe restrictions and follow
any regulations or rules.

Potentially explosive atmospheres
+ Do not use your device at a refueling point.
+ Do not use near fuel or chemicals.

+ Do not transport or store flammable gas, liquid or explosives in the same
compartment of your vehicle as your device or accessories.

In aircraft
Wireless devices can cause interference in aircraft.
+ Turn your device off before boarding any aircraft.

- Do not use it on the ground without permission from the crew.

Children

Keep the device in a safe place out of the reach of small children. It includes small
parts which may cause a choking hazard if detached.

Emergency calls

Emergency calls may not be available on all mobile networks. Therefore you should
never depend solely on your device for emergency calls. Check with your local
service provider.
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Battery information and care

+ You do not need to completely discharge the battery before recharging. Unlike
other battery systems, there is no memory effect that could compromise the
battery's performance.

+ Use only LG batteries and chargers. LG chargers are designed to maximise the
battery life.

+ Do not disassemble or short-circuit the battery.

+ Keep the metal contacts of the battery clean.

Replace the battery when it no longer provides acceptable performance. The
battery pack may be recharged hundreds of times before it needs replacing.

Recharge the battery if it has not been used for a long time to maximise
usability.

Do not expose the battery charger to direct sunlight or use it in high humidity,
such as in the bathroom.

Do not leave the battery in hot or cold places, as this may deteriorate battery
performance.

+ Risk of explosion if battery is replaced by an incorrect type. Dispose of used
batteries according to the instructions.

+ Always unplug the charger from the wall socket after the device is fully charged
to save unnecessary power consumption of the charger.

+ Actual battery life will depend on network configuration, product settings,
usage patterns, battery and environmental conditions.

+ Make sure that no sharp-edged items such as animal's teeth or claws, come
into contact with the battery. This could cause a fire.

+ Power Consumption (Networked Standby Mode) : 0.7 W

Securing personal information

Make sure to protect your personal information to prevent data leakage or
misuse of sensitive information.

Always back up important data while using the device. LG is not responsible for
any data loss.

Make sure to back up all data and reset the device when disposing of the device
to prevent any misuse of sensitive information.
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+ Read the permission screen carefully while downloading applications.

+ Be cautious using the applications that have access to multiple functions or to
your personal information.

+ Check your personal accounts regularly. If you find any sign of misuse of your
personal information, ask your service provider to delete or change your account
information.

+ If your device is lost or stolen, change the password of your account to secure
your personal information.

+ Do not use applications from unknown sources.

A Notice for Battery replacement

Li-lon Battery is a hazardous component which can cause injury.

- Battery replacement by a non-qualified professional can cause damage

to your device.

Do not replace the battery by yourself. The battery can be damaged,
which can cause overheat and injury. The battery must be replaced by
a qualified professional. The battery should be recycled or disposed
separately from household waste.

In case this product contains a battery incorporated within the product
which cannot be readily removed by end-users, LG recommends that
only qualified professionals remove the battery, either for replacement
or for recycling at the end of this product’s working life. To prevent
damage to the product, and for their own safety, users should not
attempt to remove the battery and should contact LG Service Helpline,
or other independent service providers for advice.

Removal of the battery will involve dismantling of the product case,
disconnection of the electrical cables/ contacts, and careful extraction of
the battery cell using specialised tools. If you need the instructions for
qualified professionals on how to remove the battery safely, please visit
http7/wwwi.ge.com/global/sustainability/environment/take-back-recycling.
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Custom-designed
Features



Camera features

Camera Main Functions

This chapter describes the main functions that the camera app provides.
Run the camera app, and try the functions by following the below
instructions.

T Run the camera app on the product’s home screen.

Change the camera
angle

Set/Cancel timer —38]

setting e — Switch to front-facing
Set/Cancel flash —3 /rear-facing camera
setting - Take photo
Apply filter/sticker —
effect g — Preview photo

taken/video filmed

e — Select More

L?'| « Some of the images on this manual were staged to help the user’s
understanding
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Steady cam

Use Steady Cam to prevent the camera from shaking when recording a
video while walking or making large movements.

Activate Anti-shake to reduce or eliminate blurry image resulting from
camera shake while recording a video.

1 TapO> (@ > Video.
2 Tap>uf
3 Tap @ to record a video.

Portrait

You can create an artistic portrait photo, whereby the subject is in focus
and the background is blurred. You can also edit the image by applying
lighting or colour effect to the background.

- While taking a photo, keep the distance to your subject to 1.3 ~ 5 feet.
« This feature is not available if the surroundings are too dark.

1 Tap O>(E) and tap Portrait.
2 Drag the slide bar to the left or right to adjust the blur strength.

Adjust blur strength.
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3 When Portrait is available. appears on the screen, tap () or @ to
take a photo.

+ The Portrait feature may not work if the camera cannot recognise
the subject.

Gallery features

Related content
You can edit and customise related content in the Gallery.
T While viewing a picture preview, tap &.

2 When the icon related to the date or location where you took the
photo appears, touch the screen.

+ You can view the photos related to the date or location of your
choice.

+ Tap ¢ to access additional options.

Custom-designed Features
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Making a GIF
You can create a GIF file from the Gallery.
1 While viewing an album, tap : > Create GIF.

2 Select the desired photos and videos to create a GIF file and then tap Next.

+ You can also add/delete a photograph, adjust the speed or screen
ratio, set the photograph order, etc.

3 Tap Save.

E + A maximum of 100 images can be used to create a GIF file.

Making a collage
You can make a collage from the associated content.
1 While viewing an album, tap : > Make collage.

2 Select the desired images to add to the collage and then tap Next.
+ Select the desired layout from the bottom of the screen.

3 Tap Make.

r—
e

I_;,] A maximum of 9 images can be used to create a collage.
[ ool
Ll <]
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Creating a movie
You can create a new movie by putting images and videos together.

1 Run the Gallery app, select a desired folder in the album and tap >
Create movie.

2 Select images or videos for your movie and tap Next.

3 Edit the selected images and videos and then tap Save.

7

|~~w<4«uq~b«<~|
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Deleting files

You can select images or videos to delete from your video by tapping €
at the top right corner of its thumbnail

Adding files

You can select images or videos to add after tapping -+ at the bottom
of the screen. You can also select the images or videos you have already
added.

E + Touch and hold a file, and then tap another file for multiple selection.

Rearranging files

To rearrange the images and videos, touch and hold the file you want to
move, and then dragging it to the desired location.

Adding file effects

Tap 7. to add a theme or background music or change the font.

Resetting the movie edits
You can reset the edits made to the movie (e.g. play time) by tapping .

Previewing a file

Check your new video before saving it by tapping (). After the playback
time elapses, the next file is played automatically.

A maximum of 50 images and videos can be used to create a video.

+ The playback time for an image is 3 seconds by default and it cannot be
changed. Videos can be trimmed down to a minimum of 1 second.

« This feature may not support some image or video formats.
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Making a GIF

You can easily make a GIF file using recorded video.

Creating video
T At the desired starting point while watching a video, tap @e.

2 Select the length of the GIF you want to create.
« GIF is generated for the time selected from the specified starting
point.
- Forvideos that are less than 5 seconds, GIF images are
automatically generated for the remaining time.

Creating GIF Photographs
T Inthe photograph list in the Gallery, tap : > Create GIF.

2 Select a picture to turn into a GIF photograph, and then tap Next.
+ You can add/delete a photograph, adjust the speed or screen ratio,
and set the photograph order.

A « Creating GIF photographs is a function provided for the user to produce
creative images. Violating rights such as intellectual property right
or defaming the reputation of another person by using the creating
GIF photographs function may lead to a civil or criminal liability in
accordance with the related laws. Be cautious not to copy or transmit
another person’s work without authorisation. LG Electronics is not liable
in any way for such acts by users.

+ You can select up to 100 photographs to produce when you create a
GIF
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Sound quality and effects features
DTS:X 3D Surround

You can play a song or video with three-dimensional, immersive and vivid
sound. To use this feature, connect earphones, speaker or other external
audio devices to your device.
Tap O > Settings > Sound > Sound quality and effects, then tap DTS:X
3D Surround D to activate this feature.
+ You can bring down the status bar in the upper part of the screen and
tap the icon for DTSX 3D sound to activate the function.

If you connect external sound devices such as earphones and speakers to
the product, a pop up appears where you can turn on the DTSX 3D sound
or Hi-Fi Quad DAC function.
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Floating Bar

Floating Bar overview

You can activate frequently used features, including shortcuts, screen
capture, music player, and quick contacts, by touching and then swiping
the Floating Bar on the screen.

To enable the Floating Bar feature, tap O > Settings > Extensions >
Floating Bar Q).

Opening and closing the Floating Bar
- To open the Floating Bar:Tap < or >.
+ To close the Floating Bar. Tap > or <.
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Moving the Floating Bar position
- Floating bar open: Touch and hold the Floating Bar, then drag it to the
desired location.

+ Floating bar closed: Touch and hold the Floating Bar, then drag it to
the desired location along the edge of the screen.

Disabling the Floating Bar
You can disable the Floating Bar by using one of the following methods:
- Touchand hold < or » on the Floating Bar and then drag it to the
delete area at the top of the screen.
- Tap < or » on the Floating Bar, and then tap G=» > @ ) at the top of
the screen.
« Tap O > Settings > Extensions > Floating Bar @ .
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Setting the Floating Bar

You can select the content to display on the Floating Bar and change
its display order. Tap &=» from the Floating Bar or tap O > Settings >
Extensions > Floating Bar.
+ Position: You can set an area within which you can move the floating
bar.

Shortcuts: Quickly access frequently used apps or features.

Screen capture: Capture the screen to crop the desired part or to
create a GIF file.

r o

Nz You can use Capture+ on the desired screen.

o You can capture a scrolling screenshot and use it for Q Memo+ or
- save it in the Gallery.

) You can capture a desired area and use it for Q Memo+ or save it in
L

the Gallery.

Save the current screen as a GIF file. You can adjust the size of the
image you want to capture.

E»" + To move to the desired location, drag —.

- To start recording a GIF, tap (o).

- To stop recording a GIF, tap ().

+ Music player: Control the music you are listening to.
- Quick contacts: Call or message people set as quick contacts.

E + Amaximum of 5 apps or features can be added to the shortcuts.
+ Amaximum of 5 contacts can be added as quick contacts.

+ GIF capture is a function provided for the user to produce creative
images. Violating rights such as intellectual property right or defaming
the reputation of another person by using the GIF capture function may
lead to a civil or criminal liability in accordance with the related laws.

Be cautious not to copy or transmit another person's work without
authorisation. LG Electronics is not liable in any way for such acts by
users.

+ AGIF can be created up to 15 seconds long.
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Google Assistant

Google Assistant overview

Your device has the built-in Google Assistant feature. Find answers and
get things done while on-the-go.

+ To use this feature, first connect to the network and sign in to your
Google Account.

Launching Google Assistant

1 Touch and hold O from the Home screen to launch Google Assistant
or press the Google Assistant key on the left side of the device.

2 Tap GET STARTED.

3 Follow the on-screen instructions and say “Ok Google”or “Hey
Google”.
« The device saves your voice data for recognition.

4 Set whether to use the voice match unlock function.

+ If you use the voice match unlock function, you can unlock the
device even when the device screen is turned off or the device is
charging by saying “OK Google” or “Hey Google”.
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E .

This feature may be more vulnerable to security than the other screen
locks, such as Pattern, PIN, and Password.

When a similar voice or your recorded voice is used, the screen may be
unlocked.

To use this feature, tap (O > Settings > Lock screen & security >
Secure lock settings > Smart Lock, and then use the screen lock
method you set to unlock the device. Tap Voice Match, then tap Access
with Voice Match B, then enter the currently used unlock method
again. Note that Swipe is excluded.

You need to unlock the device by using the specified method if you fail

to unlock the device with voice recognition. See Setting a screen lock
for detalils.

5 Tap Save.

Accessing by Voice

7 When the home screen is turned off or locked, say “OK Google” or
“Hey Google”.

7 When the Google Assistant screen appears, say a command or ask a
question.

Accessing from Home Screen
1 Touch and hold O on the Home screen.

2 Say acommand or question when you see «« -+ on the bottom of the
screen.

E .

In an environment where Wi-Fi or mobile data connection is poor, the
Google Assistant function may be restricted and the speech recognition
accuracy rate may be lowered.

If the speech is ambiguous, the microphone is covered, a media player is
playing, or the surrounding is loud, the speech recognition accuracy rate
may be lowered. \When you are using the product via voice commands,
say with accurate pronunciation in a quite environment for better
speech recognition accuracy.
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Fingerprint recognition

Fingerprint recognition overview

You must register your fingerprint on your device first before using the
fingerprint recognition function.

You can use the fingerprint recognition function in the following cases:
- To unlock the screen.
+ To view the locked content in the Gallery or QuickMemo+.

- Confirm a purchase by signing into an app or identifying yourself with
your fingerprint.

E + You can use fingerprint data for user authentication. There is a
possibility that the fingerprint sensor might recognise a different but
very similar fingerprint as the same registered fingerprint. To strengthen
security, it is recommended that you use the pattern, PIN, or password
method for unlocking the screen.

+ If the device cannot detect your fingerprint or you forgot the value
specified for registration, visit the nearest LG Customer Service Centre
with your device and ID card.

Precautions for fingerprint recognition

Fingerprint recognition accuracy may decrease due to a number of

reasons. To maximise the recognition accuracy, check the following before

using the device.

+ The device has a fingerprint sensor. Be careful not to scratch or
damage the fingerprint sensor with metal objects such as coins or
keys.

If there are foreign substances (sweat, lotion, water, dirt, grease, etc.)
on the fingerprint sensor or on the finger to be put on the sensor,
fingerprint recognition may not work properly. Wipe the sensor and the
finger clean and remove all moisture before putting the finger on the
sensor.
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If the finger's surface is rough due to it being scarred or pruney from
water, the sensor may not be able to recognise the fingerprint. In such
a case, register another fingerprint.

If you bend your finger or use the fingertip only, your fingerprint may
not be recognised. Make sure that your finger covers the entire surface
of the fingerprint sensor.

Scan only one finger for each registration. Scanning more than one
finger may affect fingerprint registration and recognition.

The device may generate static electricity if the surrounding air is dry.
If the surrounding air is dry, avoid scanning fingerprints, or touch a
metallic object such as a coin or a key before scanning fingerprints to
remove static electricity.

Registering fingerprints
You can register and save your fingerprint on the device to use fingerprint
identification.

1 Tap O > Settings > Lock screen & security > Fingerprints.

+ Alock screen must be set to use this feature.
« If the screen lock is not active, configure the lock screen by following the
on-screen instructions. See Setting a screen lock for details.

2 Check the location of the fingerprint sensor and lightly put the finger
on the sensor.

E + Make sure that the finger fully covers the fingerprint sensor.
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3 Follow the on-screen instructions.

+ Until the fingerprint registration is completed, move the same finger
around on the sensor little by little.

+ Put the finger on the sensor. \When you feel a vibration, remove the
finger from the sensor.

4 When the fingerprint registration is done, tap OK.

- Tap Add more to register another fingerprint. Since the fingerprint
recognition success rate depends on the condition of the registered
fingerprint, it is recommended that you register several different
fingerprints.

Managing fingerprints

You can edit or delete registered fingerprints.

1 Tap O > Settings > Lock screen & security > Fingerprints.
2 Unlock according to the specified lock method.

3 From the fingerprint list, tap a fingerprint to rename it. To delete it, tap
[}

Custom-designed Features 31



Unlocking the screen with a fingerprint

You can unlock the screen or view the locked content by using your
fingerprint. Activate the desired function:

1 Tap O > Settings > Lock screen & security > Fingerprints.
2 Unlock according to the specified lock method.

3 On the fingerprint settings screen, activate the desired function:
« Screen lock: Unlock screen with a fingerprint.

+ Content lock: Unlock content with a fingerprint. To do this, make
sure that the content lock is set.

Face Recognition
Face Recognition overview
You can unlock the screen lock by using the saved facial data.

E « This feature may increase security vulnerabilities compared to other
screen locks, such as Knock Code, Pattern, PIN, and Password.

.

When a similar face or a photo of your face is used, the screen may be

unlocked.

« The recognised facial data is securely stored in your device.

« When the face recognition is selected for screen lock, you must enter
the Knock Code, Pattern, PIN, or Password that has been used for face
registration without directly using the face recognition after the power
is turned on. Accordingly, be careful not to forget the specified value.

« If the device cannot detect your face, or you forgot the value specified

for registration, visit the nearest LG Customer Service Centre with your

device and ID card.

- To save power, the Face Recognition feature will not work when the
battery level is below 5 %.
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Precautions for Face Recognition

Face Recognition accuracy may decrease in the following cases. To
increase its accuracy, check the following before using the device.

+ When your face is covered with a hat, eyeglasses, or mask, or your face
is significantly different due to heavy makeup or beard.

+ When there are fingerprints or foreign substances on the front of the
camera lens, or your device cannot detect your face due to a too bright
or dark light.

Registering facial data

Before using the Face Recognition feature, register your facial data on
your device.

1 Tap O > Settings > Lock screen & security > Face Recognition.

E « To use this feature, the screen lock must be set with a Knock Code,
Pattern, PIN, or Password.

+ When the screen lock is not set, register the data by following the
on-screen instructions. See Setting a screen lock for details.

2 Tap NEXT and unlock the device according to the specified method.
3 Tap START and raise your device in the front of your eyes.
4 Register your face by following the on-screen instructions.

+ Register your face in a room that is not too bright or dark.

+ Position your entire face inside the guideline on the screen, and then
adjust it by slowly moving up, down, left, or right.

« Keep still while registering your face. You can improve recognition
rate by taking steady photos multiple times.

5 When the face registration is done, tap OK.
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Unlocking the screen with your face

You can release the screen lock with your face instead of a Knock Code,
Pattern, PIN, or Password.

1 Tap O > Settings > Lock screen & security > Select screen lock.
2 Unlock the screen according to the specified method.

3 Tap Allow face recognition D to allow you to unlock the screen
using facial recognition.

Improving the Face Recognition

You can add facial data in various conditions to improve Face Recognition.
1 Tap O > Settings > Lock screen & security > Face Recognition.

2 Unlock the screen according to the specified method.

3 Select Improve face recognition.

4 Register your face by following on-screen instructions.

5 When the face registration is done, tap OK.

Deleting facial data

You can delete the registered facial data and register it again if the Face
Recognition does not work properly.

1 Tap O > Settings > Lock screen & security > Face Recognition.
2 Unlock the screen according to the specified method.
3 Select Delete face to delete the facial data.
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Unlocking the screen with your face when the screen
is turned off

With the screen turned off, raise your device and look at the front of the
screen. The device can detect your face and the screen is unlocked.

To deactivate this feature, follow the instruction below.
1 Tap O > Settings > Lock screen & security > Face Recognition.
2 Unlock the screen according to the specified method.

3 Drag Allow when screen is off @  to deactivate the feature.
« Face Recognition feature is available only when the screen is locked.

Unlocking the screen with Face Recognition and then
screen swiping

With the screen turned off, you can unlock the screen by performing Face
Recognition and then swiping the screen.

1 Tap O > Settings > Lock screen & security > Face Recognition.
2 Unlock the screen according to the specified method.

3 Drag Swipe to unlock after face recognised (D to activate the
feature.

Enhancing the Face Recognition

You can prevent your device from being unlocked by photos, images, or
videos.

1 Tap O > Settings > Lock screen & security > Face Recognition.
2 Unlock the screen according to the specified method.

3 Drag Advanced face recognition QD to activate the feature.

E + Face Recognition speed may decrease when you activate this feature.
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Multi-tasking feature

Recent Uses Screen

You can view the app screens that you used recently by using the preview
function.

To view the list of apps that you used recently, tap [] of the home touch
button.

- (O> Settings > Display > Navigation bar > Gesture and Buttons and
then swipe the Home button upward to view the recent use history.

Multi window
You can use two apps at the same time by separating the screen into
multiple windows.
1 Tap[]from the Home touch buttons.
+ Recently-used apps appear.
2 Tapan app icon and tap 5 at the top of the desired app to use the
Multi window feature.
+ The selected app appears at the top half of the screen.
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5 + To adjust the size of the split screen, drag — at the centre of the
screen.

+ The Multi window feature is not supported by some LG apps and the
apps downloaded.

AOD(always-on display)
You can view the date, time or signature when the main screen is turned
off.

Swipe the bottom of the Always-on display screen to activate features
including Camera, Capture+, Wi-Fi, sound settings, Bluetooth®, Flash,
Music and more.

1 Tap O > Settings > Display > AOD(always-on display).

2 Select the image you want to display and tap Save.

- Tap the desired image among Digital clock, Analog clock, Dual clock,
Signature, Calendar or Image.

+ Drag Quick tools & music player D to swipe over the status
icons for Quick tools and the music player.

Tap Al Pick QD to see useful information provided based on
Context Awareness.

- To set the time period not to activate Always-on display feature, tap
Daily timeout.

- To enhance brightness for the Always-on display feature, tap
Brighter display.

E + The battery may drain faster when you use Always-on display. Turn this
feature off to save battery power.

- To deactivate Always-on display feature, tap (O)> Settings > Display >
AOD(always-on display), and then tap @ .
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Quick Help

You can view help information about the main features of the device,
frequently asked questions or the user guide. Search for help information
using keywords. You can solve your problems quickly by consulting
one-on-one with a specialist.

1 Tap O > Settings > Quick Help.

2 Search for help information by entering keywords in the search field.

E « This feature is periodically updated utilising user feedback.
+ Available menu items may vary depending on the area or service
provider.

+ You can view the user manual online from the Quick Help app to view
detailed information about the device's features.

Notes on Water Resistant
Properties

This product is water and dust resistant in compliance with the Ingress
Protection rating IP68.

Your product has undergone testing in a controlled environment and is
proven to be water and dust resistant in certain circumstances (meets
the requirements of classification IP68 as described by the international
standard IEC 60529 - Degrees of Protection provided by Enclosures [IP
Code]; test conditions: 15-35 °C, 86-106kPa, 1.5 meter, for 30 minutes).
Do not expose the device in conditions that are different from the test
conditions. Results may vary in actual use.
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/\ WARNING

Despite a rating of IP68, your device is not impervious to conditions not
tested in LG's controlled environment. Please note that any damages that
occur due to such causes changes the colour of the LDI (Liquid Damage
Indicator). If the colour of LDl located inside the product changes, the
product is to be considered ineligible for any free-of-charge repair services
provided under the product’s limited warranty.

Avoid exposing the product to environments with excessive dust or
moisture. Do not use the product in the following environments.

Do not immerse the product in any liquid chemicals (soap, etc.)
other than water.

Do not immerse the product in salt water, including seawater.
Do not immerse the product in a hot spring.

Do not swim with this product.

Do not place the product directly on sand (such as at a beach) or
mud.

Do not immerse your product in water deeper than approximately
1.5 meters.
Do not immerse your product in water for longer than 30 minutes.

RO®WOD®

- If your product becomes wet be sure to wipe the microphone, speaker,
and stereo jack with a dry cloth before use.

+ Should your product or your hands become wet, dry them before
handling the product.

+ Do not use the product in places where it may be sprayed with high
pressure water (e.g. near a faucet or shower head) or submerge it in
water for extended periods of time, as the product is not designed to
withstand high water pressure.
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This product is not resistant to shock. Do not drop the product or
subject it to shock. Doing so might damage or deform the main unit,
causing water leakage.

The product’s water and dust resistant features may be damaged by
dropping or receiving an impact.

If the product gets wet, use a clean, soft cloth to dry it thoroughly.

The touch screen and other features may not work properly if the
device is used while wet.

Your product is water resistant only when the SIM/Memory card tray is
properly inserted into the product.

Do not open or close the SIM/Memory card tray while the product is
wet or immersed in water. Exposing the open tray to water or moisture
may damage the product.

The SIM/Memory card tray contains rubber [packing] to help prevent
dust, water, or moisture from entering the product. Do not damage the
rubber [packing] as this may allow dust, water, or moisture to enter
your product and cause damage.

A « Failure to follow the provided instructions may invalidate your device's
limited warranty.
« If the device is wet, the LDl located inside the device changes in colour.
In this case, the device is ineligible for any free-of-charge repair services
provided under the device's limited warranty.
- Despite a rating of IP68, your device is not completely impervious to
water in any situation.
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Product components and
accessories

The following items are included with your device.

+ Device + Ejection pin
+ Stereo headset + Charger
+ USB cable + Quick Start Guide

A .

« The items supplied with the device and any available accessories may

Basic Functions

The items described above may be optional.

vary depending on the area and service provider.

Always use genuine LG Electronics accessories. Using accessories made
by other manufacturers may affect your device's call performance or
cause malfunctions. This may not be covered by LG's repair service.

« Some of the device parts are made of tempered glass. If you drop your

device on a hard surface or subject it to severe impact, the tempered
glass may be damaged. If this happens, stop using your device
immediately and contact an LG Customer Service Centre.

If any of these basic items are missing, contact the dealer from which
you purchased your device.

« To purchase additional items, contact an LG Customer Service Centre.

Some items in the product box are subject to change without notice.

- The appearance and specifications of your device are subject to change

without prior notice for product improvement.
Device specifications may vary depending on the area or service provider.

Remove the protective film from the Fingerprint sensor before using the
fingerprint recognition feature.
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Parts overview

Proximity/Ambient light
sensor

Front camera lens
(Wide-angle)

Volume keys (+/-) -I:

Google Assistant key —e

Front camera lens
I (Standard angle)
1 Q00— \)
I I Earpiece

«— Power/Lock key

Touch screen

Stereo headset jack 1 Charger/USB cable port
Microphone ———
Rear camera lenses — —‘_Elﬁ_l
(Telephoto / © Co—i—
Super wide-angle / ©00 Flash
Standard-angle)
@ — Fingerprint sensor
SIM/Memory card tray —[ '—— NFC antenna area
I—— Wireless charging antenna
area
©©oe————— Dual screen connection
Speaker ——— t——— Microphone
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A Do NOT attempt to remove the back cover by yourself.

Doing so may severely damage the battery and device, which could cause
overheating, fire, and injury. This device's back cover and battery are not to
be removed or replaced by a non-qualified professional

+ Proximity/Ambient light sensor

- Proximity sensor: During a call, the proximity sensor turns off the
screen and disables touch functionality when the device is in close
proximity to the human body. It turns the screen back on and enables
touch functionality when the device is outside a specific range.

- Ambient light sensor. The ambient light sensor analyses the ambient
light intensity when the auto-brightness control mode is turned on.

- Volume keys
- Adjust the volume for ringtones, calls or notifications.

- While using the Camera, gently press a Volume key to take a photo.
To take continuous photos, press and hold the Volume key.

- Press the Volume Down (-) key twice to launch the Camera app
when the screen is locked or turned off. Press the Volume Up (+) key
twice to launch Capture+.

+ Power/Lock key
- Briefly press the key when you want to turn the screen on or off.
- Press and hold the key when you want to select a power control
option.
+ Google Assistant key

- Your device has the Google Assistant built-in. Find answers and get
things done while on-the-go. To get started, just tap the Google
Assistant key on the side of the phone. Press and hold the key to
quickly talk to your Assistant. Double tap to open Google Lens.

- Activate Google Assistant. See the Google Assistant for details.
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+ Fingerprint sensor

- Turn on the fingerprint recognition feature to simplify the process
of unlocking the screen. See Fingerprint recognition overview for
details.

E + Some functions may be restricted for access, depending on the device

specifications.

+ The rear of the device includes a built-in NFC antenna. Be cautious when
handling the device to avoid damaging or covering the NFC antenna.

+ Do not put heavy objects on the device or sit on it. Failure to do so may
damage the touch screen.

+ Screen-protective film or accessories may interfere with the proximity
sensor.

« If your device is wet or is being used in a humid place, the touch screen
or buttons may not function properly.

Hold the device correctly as shown below. If you cover the microphone
hole with a hand, finger, or protective case while using the device, you may
sound unclear during a call

Good example Bad example
Microphone Do not cover the microphone.
e

N

/

Microphone Do not cover the microphone.
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Turning the power on or off

Turning the power on
When the power is turned off, press and hold the Power/Lock key.

E + When the device is turned on for the first time, initial configuration
takes place. The first booting time for the smart phone may be longer
than usual

Turning the power off
Press and hold the Power/Lock key, then select Power off.

Restarting the device

When the device is not working properly or does not respond, restart it by
following the instructions below.

1 Press and hold the Power/Lock key and the Volume Down key at the
same time until the power is turned off.

2 When the device is restarted, release the key.

E « This function is not available when the device is connected to LG Dual
Screen (LM-V505N).

Power control options

Press and hold the Power/Lock key, then select an option.
- Power off: Turn the device off.

- Power off and restart: Restart the device.
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Installing the SIM card

Insert the SIM (Subscriber Identity Module) card provided by your service
provider to start using your device.

E + In order for the water-resistant and dust-resistant features to work
effectively, the card tray must be inserted correctly.

7 Insert the ejection pin into the hole on the card tray.

2 Pullout the card tray.
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3 Put the SIM card on the card tray with the gold-coloured contacts
facing downwards.

E + This device supports only Nano SIM cards.

Micro Standard
L)

« For problem-free performance, it is recommended to use the device
with the correct type of SIM card. Always use a factory-made SIM card
supplied by the operator.

« If you insert the card tray into your device while the card tray is wet,
your device may be damaged. Always make sure the card tray is dry.
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Inserting the memory card

Insert the memory card into your device.

Depending on the memory card manufacturer and type, some memory
card may not be compatible with your device.

7 Insert the ejection pin into the hole on the card tray.
2 Pullout the card tray.

3 Put the memory card on the card tray with the gold-coloured contacts
facing downwards.

Memory card
(optional-sold separately)

4 Insert the card tray back into the slot.
A + Some memory cards may not be fully compatible with the device. If you

use an incompatible card, it may damage the device or the memory card,
or corrupt the data stored in it.

« Frequent writing and erasing of data may shorten the memory card
lifespan.
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Removing the memory card
Unmount the memory card before removing it for safety.
1 Tap O > Settings > Storage > /\.

2 Insert the ejection pin into the hole in the card tray and then pull out
the card tray from the device.

3 Remove the memory card from the card tray.
4 Insert the card tray back into the slot.
A + Do not remove the memory card while the device is transferring or
accessing information. This may cause data to be lost or corrupted, or
may damage the memory card or the device. LG is not responsible for

losses that result from the abuse or improper use of memory cards,
including the loss of data.

Battery
Charging the battery

Before using the device, fully charge the battery.
Charge the device with the USB Type-C cable.

=

Charging cable terminal
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A « Do not use the external terminal, charging cable or gender for the
device in presence of moisture. This may cause fire, electric shock,
injury, or device malfunction. If there is moisture, stop using the device
immediately and remove the moisture completely.

« Make sure to use the USB cable provided with your device.

« Make sure to use an LG-approved charger and charging cable. Charging
the battery with a third-party charger may cause the battery to explode
or may damage the device.

+ Your device has an internal rechargeable battery. For your safety, do not
remove the embedded battery.

« Using the device when it is charging may cause electric shock. To use the
device, stop charging it.

E « Remove the charger from the power socket after the device is fully
charged. This prevents unnecessary power consumption.

.

A charging adapter that supports fast charging is included with the
product.

« The fast charging feature may not work if a fast charging adapter other
than the genuine adapter provided with the product is used.

« Another way to charge the battery is by connecting a USB cable
between the device and a desktop or laptop computer. This may take
longer time than plugging the adapter to a wall outlet.

« Do not charge the battery by using a USB hub that is unable to maintain
the rated voltage. Charging may fail or unintentionally stop.

Precautions when using the device

- Make sure to use the USB cable provided; do not use third party USB
cables or chargers with your device. The LG limited warranty does not
cover the use of third party accessories.

+ Failure to follow the instructions in this guide and improper use may
damage the device.
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Wireless charging

This device supports wireless charging feature. Charge the device with a
Qi certified wireless charger (optional, sold separately).

Charging the battery with a wireless charger

1 Place your device on the centre of the wireless charger aligned with
the wireless charging antenna on the back of the device.
+ To check the wireless charging antenna area, see Parts overview.

2 When the battery is fully charged, remove the device from the charger.

A + \When you charge the battery with a wireless charger;, do not put a
magnetic, metallic or conductive materials between the device and the
charger. This may disturb charging or the device and the charger may
become heated. In this case, the device, charger or SIM/Memory cards
may be damaged.
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If the battery temperature exceeds a certain level while charging the
device, charging may be stopped.

If magnetic, metallic or conductive materials are attached on the back
of the device or a protective case is inserted, the device may not charge
properly.

If you charge the battery with a wireless charger in areas where the
network signal strength is weak, the network performance of your
device may be further degraded.

Charge the device with a Qi certified wireless charger (optional, sold
separately). Because the LG limited warranty does not cover the use of
third party accessories, contact the third party manufacturer.

This product supports wireless charging. Use a Qi certified wireless
charger (sold separately) to charge the product. Some coiled wireless
chargers may not support wireless charging. Wireless chargers that
support EPP (Extended Power Profile) allow high-speed wireless
charging.

LG Electronics is not responsible for any issues concerning accessories
of other brands. For such issues, contact the manufacturer of the
accessory product.

Using the battery efficiently

Battery lifespan may decrease if you keep many apps and functions
running simultaneously and continuously.

Cancel background operations to increase battery life.

To minimise battery consumption, follow these tips:
+ Turn off the Bluetooth or Wi-Fi network function when not using

them.

Set the screen timeout to as short a time as possible.
Minimise the screen brightness.

Set a screen lock when the device is not used.

Check the battery level while using any downloaded apps.
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Touch screen

You can familiarise yourself with how to control your device by using
touch screen gestures.

Tapping

Lightly tap with your fingertip to select or run an app or option.

Touching and holding

Touch and hold for several seconds to display a menu with available
options.
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Double-tapping

Tap twice quickly to zoom in or out on a web page or map.

Dragging

Touch and hold an item, such as an app or widget, then move your finger
to another location in a controlled motion. You can use this gesture to
move an item.

Swiping

Touch the screen with your finger and move it quickly without pausing.
You can use this gesture to scroll through a list, a web page, photos,
screens, and more.
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Pinching and spreading
Pinch two fingers to zoom out such as on a photo or map. To zoom in,
spread your fingers apart.

.

.

.

.

S

/,'

« Do not expose the touch screen to excessive physical shock. You might

damage the touch sensor.

« A touch screen failure may occur if you use the device near a magnetic,

metallic or conductive material.

If you use the device under bright lights, such as direct sunlight, the
screen may not be visible, depending on your position. Use the device

in a shady location or a location with an ambient light that is not too
bright and bright enough to read books.

Do not press the screen with excessive force.

Gently tap with your fingertip on the option you want.

Touch control may not work properly if you tap while wearing a glove or
by using the tip of your fingernail.

« Touch control may not work properly if the screen is moist or wet.

« The touch screen may not function properly if a screen-protective film

or accessory purchased from a third party store is attached to the
device.

Displaying a static image for extended periods of time may result in
after-images or screen burn-in. Turn off the screen or avoid displaying
the same image for a long time when you do not use the device.

Basic Functions 56



Home screen

Home screen overview

The Home screen is the starting point for accessing various functions
and apps on your device. Tap O on any screen to directly go to the Home
screen.

You can manage all apps and widgets on the Home screen. Swipe the
screen left or right to view all installed apps at a glance.

Home screen layout

You can view all apps and organise widgets and folders on the Home
screen.

Status bar — I
) LSaRe-e |

eather widget 4._

G ¢+ J*— Google Search widget

Page icon

&= aa =— Quick access area

Home touch buttons — K

E + The Home screen may differ depending on the manufacturer policy, user
settings, software version or service provider.
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- Status bar: View status icons, the time and the battery level.

- Weather widget: View the information of weather and time for a
specific area.

- Google Search widget: Type or speak to pull open Google Search.

+ Folder: You can create folders to classify the app based on desired
criteria.

+ Page icon: Display the total number of Home screen canvases. You
can tap the desired page icon to go to the page you selected. The icon
reflecting the current canvas will be highlighted.

- Quick access area: Fix main apps at the bottom of the screen so that
they can be accessed from any Home screen canvas.

+ Home touch buttons

- <:Return to the previous screen. Close the keypad or pop-up
windows.

- (O :Tap to go to the Home screen. To launch Google Assistant, touch
and hold.

- [J:Tap to view alist of recently used apps or run an app from the
list. To delete all the recently used apps, tap Clear all. To use two
apps at the same time with the Multi window feature, touch and
hold the button while using an app.
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Changing the style of the Home touch buttons
You can change the style of the Home touch buttons.
1 Tap O > Settings > Display > Navigation bar.

2 Under STYLE, select an option to suit your preferences.
- Gestures:
- Go to Home screen: Swipe up from the bottom edge of the
screen.
- Go back: Swipe in from the left or right edge of the screen.
- See the Overview screen: Swipe up and hold from the bottom
edge of the screen.
- Switch between apps: Swipe right at the bottom edge of the
screen to go to previously used apps.
- Gesture and Buttons: Back button < and Home button & are
available. To see recent apps, swipe the Home button & up.

- Buttons only: <]/ /[ are available. Tap [] to see recent apps.

Editing the Home touch buttons
You can rearrange the Home touch buttons or add frequently used
functions to the Home touch buttons area.
Tap O > Settings > Display > Navigation bar > Button combination and
customise the settings.
+ Several functions, including Notification and Capture+, are provided. A
maximum of two additional items can be added.

4 o o ‘ iy @J

[

Basic Functions 59



Status icons

When there is a notification for an unread message, calendar event or
alarm, the status bar displays the corresponding notification icon. Check
your device's status by viewing notification icons displayed on the status

bar.
x No signal
Data is being transmitted over the network
® Alarm is set
e Vibrate mode is on
b4 Bluetooth is on
e Connected to a computer via USB
[ Battery level
4+ Airplane mode is on
A Missed calls
= Wi-Fiis connected
N Mute mode is on
Q GPSison
3 Hotspot is on
N | NoSMcard
N The NFC mode is on

«+ Some of these icons may appear differently or may not appear at all,

depending on the device's status. Refer to the icons according to the
actual environment and area in which you are using the device and your
service provider.

Displayed icons may vary, depending on the area or service provider.
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Notifications panel

You can open the notifications panel by dragging the status bar
downward on the main screen.

+ You can drag down the notice window or tap the arrow icon to open
the list of quick setting icons.

- You can tap ~® to add, delete or arrange icons in the notice window.

- If you touch and hold the icon, the settings screen for the
corresponding function appears.

+ You can use the notifications panel even on the lock screen. Drag the
notifications panel while the screen is locked to quickly access the
desired features.
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Switching the screen orientation

You can set the screen orientation to automatically switch according to
the device’s physical orientation.

On the notification panel, tap Rotation from the quick access icon list.

You can also tap O > Settings > Display and activate Auto-rotate
screen.
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Editing the Home screen
On the Home screen, touch and hold on an empty space, then select the
desired action from below.

- Torearrange the Home screen canvases, touch and hold on a canvas,
then drag it to another location.

- To add a widget to the Home screen, touch and hold on a blank area of
the Home screen, then select Widgets.

- To change wallpapers, themes, icons, and AOD, touch and hold on a
blank area of the Home screen, then select Wallpaper & theme.

You can also tap O > Settings > Display > Wallpaper & theme, then
select wallpapers, themes, icons, and AOD, to apply to the device.

- To configure the Home screen settings, touch and hold on a blank area
of the Home screen, then select Home screen settings. See Home
screen settings for details.

- To view or reinstall the uninstalled apps, touch and hold on a blank area
of the Home screen, then select App trash. See App trash for details.

+ To change the default screen, touch and hold on a blank area of the

Home screen, move to desired screen, tap £, then tap the screen once
more.

Default screen
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Viewing the background theme

You can view only the background image by hiding the apps and widgets
on the Home screen.

Spread two fingers apart on the Home screen.

- Toreturn to the original screen, which displays apps and widgets, pinch
your fingers on the Home screen or tap <]

Moving apps on the Home screen

On the Home screen, touch and hold an app, then drag it to another
location.

+ To keep frequently used apps at the bottom of the Home screen, touch
and hold an app, then drag it to the quick access area at the bottom.

+ To remove an icon from the quick access area, drag the icon to the
Home screen.

Basic Functions 64



Using folders from the Home screen

Creating folders

On the Home screen, touch and hold an app, then drag it over another
app.

A new folder is created and the apps are added to the folder.

Editing folders
On the Home screen, tap a folder and do one of the following actions.
- To edit the folder name and colour, tap the folder name.

- To add apps, touch and hold an app, then drag it over the folder and
release it.

+ To remove an app from the folder, touch and hold the app and drag it to
outside the folder If the removed app is the only one app that existed
in the folder, the folder is removed automatically.

- You can also add or remove apps after tapping (+) in the folder.

I_;'] + You cannot change the folder colour while using downloaded theme.

Home screen settings
You can customise the Home screen settings.
1 Tap O > Settings > Display > Home screen.
2 Customise the following settings:
- Select Home: Select a Home screen mode.
- Wallpaper: Change the Home screen background wallpaper.

- Screen swipe effect: Select an effect to apply when the Home
screen canvas switches.

+ Icon shape: Choose if you want icons to have square or rounded
corners.
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Left Home screen: You can select the effects to be used when
switching the home screen.

Sort apps by: Set how apps are sorted on the Home screen.
Grid: Change the app arrangement mode for the Home screen.

Hide apps: Select which apps you want to hide from the Home
screen.

Loop Home screen: Enable to allow continuous Home screen
scrolling (loop back to first screen after the last screen).

« This function is not available when Google feed is enabled.

Search: Search by swiping down on the Home screen.

Home screen lock: Enable to prevent apps and widgets from being
rearranged or removed.

Screen lock

Screen lock overview

Your device's screen turns off and locks itself if you press the Power/Lock
key. This also happens after the device is left idle for a specified period of

time.

If you press the Power/Lock key when a screen lock is not set, the Home
screen appears immediately.

To ensure security and prevent unwanted access to your device, set a
screen lock.

5

+ Ascreen lock prevents unnecessary touch input on the device screen
and reduces battery consumption. \We recommend that you activate the
screen lock while not using the device.
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Setting a screen lock
There are several options available for configuring the screen lock settings.
1 Tap O > Settings > Lock screen & security > Select screen lock and
then select the method you prefer.
2 Customise the following settings:
+ None: Deactivate the screen lock function.
- Swipe: Swipe on the screen to unlock the screen.
+ Knock Code: Tap the screen in a pattern to unlock the screen.
- Pattern: Draw a pattern to unlock the screen.
+ PIN: Enter a numeric password to unlock the screen.
- Password: Enter an alphanumeric password to unlock the screen.
« Fingerprints: Unlock the screen by using your fingerprint.

- Allow face recognition: Unlock the screen by allowing the device to
recognise your face.

E « If you incorrectly attempt to unlock the device 5 times, the screen is
blocked for 30 seconds.

Secure start-up settings
When you select Knock Code, Pattern, PIN or Password as a screen lock
method, you can configure your device to be locked whenever turning on
the device in order to secure your data.
+ You cannot use all functions, except for emergency calls until you
unlock the device.
- If you forget your decryption password, you cannot restore encrypted
data and personal information.
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Precautions for the secure start-up feature

- If you forget your decryption password, you cannot restore encrypted
data and personal information.

- Be sure to keep your screen lock passwords separately.

- If you enter the screen lock passwords incorrectly more than the
specified times, the device automatically resets itself and the encrypted
data and your personal information are deleted automatically and they
cannot be restored.

- Be cautious not to enter incorrect screen lock passwords more than
the specified times.

+ When you turn on the device right after the device resets, encryption
also starts. If you stop the encryption arbitrarily, the data may be
damaged. Be sure to wait until the reset is completed.

Customise Lock screen

You can customise lock screen.

1 Tap O > Settings > Lock screen & security > Customise Lock
screen.

2 Select a function you want to set.
- Wallpaper: Allow you to set the background for your Lock screen.

+ Clock: Allow you to set where to position the clock on the Lock
screen.

« Shortcuts: Allow you to choose apps to run on your Lock screen.
This setting appears only when a screen lock is set.

- Weather animation: Enable this option to display weather
animations for the current location on the Lock screen.

- Contact info for lost phone: Allow you to set text to be displayed
on the Lock screen to identify the phone's owner.
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Secure lock settings
You can set secure lock settings.

1 Tap O > Settings > Lock screen & security > Secure lock settings.

2 Select a function you want to set.

Make pattern visible: Allow you to make pattern visible.

Lock timer: Allow you to set the amount of time before the screen
automatically locks after the backlight turns off (time-out due to
inactivity).

Power key instantly locks: Enable this option to instantly lock the
screen when the Power/Lock key is pressed. This setting overrides
the Security Lock timer setting.

Show lockdown option: Allow you to show power menu option to
turn off Lock screen notifications, Smart Lock and biometric locks.
Smart Lock: Allow you to set trusted devices, places, voice, and/or
on-body detection that will allow your phone to remain unlocked.

+ Menus you can set may be different depending on lock screen methods
you choose.

KnockON

You can turn the screen on or off by double-tapping the screen.

5

- This option is available only on the Home screen provided by LG. It may
not function properly on a custom launcher or on the Home screen
installed by the user.

+ When tapping the screen, use your fingertip. Do not use a fingernail.

+ To use the KnockON feature, make sure that the proximity/light sensor
is not blocked by a sticker or any other foreign substance.
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Turning the screen on
Double-tap the middle of the screen.

- Tapping the top or bottom of the screen may decrease the recognition
rate.

Turning the screen off
Double-tap on an empty space on the Home screen and Lock screen.
You can also double-tap an empty space on the status bar.

Disable KnockON

If you don't want to use the KnockON function, set as follows:

Tap OO > Settings > Extensions > KnockON and drag it to disable the
function.

Knock Code

You can unlock the screen by creating your own Knock Code. When the
screen is locked, you can directly access the Home screen by tapping the
screen in a specified sequence.

+ You can use your Knock Code together with the KnockOn feature.
« Make sure to use your fingertip when tapping the screen.

Creating a Knock Code

1 Tap O > Settings > Lock screen & security > Select screen lock >
Knock Code.

2 Tap the squares in a pattern of your choice to create a Knock Code
and tap Next.

3 Input the created Knock Code again for verification, then tap Confirm.
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Unlocking the screen with a Knock Code
Unlock the screen by inputting the Knock Code you have created.

You can also input your Knock Code on the touch screen when the screen
is turned off.

« Itis also possible to enter a Knock Code when the lock screen is turned
on.

Memory card encryption

You can encrypt and protect data saved on the memory card. The
encrypted data in the memory card cannot be accessed from another
device.

1 Tap O > Settings > Lock screen & security > Encryption &
credentials > Encrypt SD card.

2 Read the on-screen overview of memory card encryption and then tap
Continue to continue.
3 Select an option and tap Encrypt now.

- New data encryption: Encrypt only data that is saved on the
memory card after encryption.

+ Full encryption: Encrypt all the data currently saved on the memory
card.

+ Exclude media files: Encrypt all files, except for media files such as
music, photos and videos.
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E + Once memory card encryption starts, some functions are not available.

« If the device is turned off while encryption is underway, the encryption
process will fail, and some data may be damaged. Therefore, be sure to
check if the battery level is sufficient before starting encryption.

+ Encrypted files are accessible only from the device where the files were
encrypted.

+ The encrypted memory card cannot be used on another LG device. To
use the encrypted memory card on another mobile device, format the
card.

« You can activate memory card encryption even when no memory card
is installed into the device. Any memory card that is installed after
encryption will automatically be encrypted.

Taking screenshots

You can take screenshots of the current screen you are viewing.

Via a shortcut

Press and hold the Power/Lock key and the Volume Down key at the
same time for at least two seconds.

- Screenshots can be viewed from the Screenshots folder in the
Gallery.

Via Capture+

On the screen where you want to take a screenshot, drag the status bar
downwards, then tap (7,

E + \When the screen is turned off or locked, you can access Capture+
by pressing the Volume Up key twice. To use this feature, tap O >
Settings > Extensions > Shortcuts and turn on Open Capture+.

- See Writing notes on a screenshot for details.
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Entering text

Using the Smart toolbar

You can use various keyboard input methods in one place. You can select
the desired input method from the top of the keyboard.

1 Select the desired keyboard input method from the Smart toolbar.

2 Tap v and select the input method you want to show on the Smart
tool, or reorganise them.

I .
Smart —@ © & &4 ¢ 8 & ~| @ & a ¢ @ ®

toolbar

= 8 22

E - Some supporting input methods may differ depending on the device
you have.

+ You can turn on or off the Smart tool feature from the keyboard
settings.

- You can also use the keyboard input methods by tapping £63.

- ©:Add emajis.
+ &) :Add avatar stickers.
« &Y Add ani-stickers,
+ 0 :0n the keyboard, tap 0.
- To maximise the voice command recognition, speak clearly.

- To enter text with your voice, make sure that your device is
connected to a network.
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- To select the language for voice recognition, tap £ > Languages
on the voice recognition screen.
- This function may not be supported, or the supported languages
may differ depending on the service area.
+ §63 : Access keyboard settings.
« [B2]: Open the clip tray. See Clip Tray for more information.

. : Activate floating keyboard when you use the Multi-window
feature. You can also move the keyboard to the desired location.

Using the Smart keyboard
You can use the Smart keyboard to enter and edit text.

With the Smart keyboard, you can view text as you type without
bothering to alternate between the screen and a conventional keyboard.
This allows you to easily find and correct errors when typing.

Moving the cursor

With the Smart keyboard, you can move the cursor to the exact position
you want. When typing text, touch and hold on the space bar and then
drag left or right.

< Smart keyboard

E « This option is available only on the QWERTY keyboard.
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Suggesting words

Smart keyboard automatically analyses your usage patterns to suggest
frequently used words as you type. The longer you use your device, the
more precise the suggestions are.
Enter text, then tap a suggested word or gently drag the left or right side
of the keyboard upwards.
+ The selected word is automatically entered. You do not need to
manually type every letter of the word.

Smartphone smart  Smartphones Smartphone  Smarf Sharibhohes

I'fllll-l- l--llll !

Adding languages to the keyboard
You can make additional languages available for keyboard input.

1 Tap O > Settings > System > Language & keyboard > Manage
keyboards > LG Keyboard > Language & keyboard layout > Select
languages.

2 Select the languages you want to make available.
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Copy and Paste
You can cut or copy text from an app, and then paste the text into the
same app. Or, you can run other apps and paste the text into them.
7 Touch and hold around the text you want to copy or cut.
2 Drag @/ W to specify the area to copy or cut.
3 Select either Cut or Copy.
+ Cut or copied text is automatically added to the clipboard.

4 Touch and hold the text input window, then select Paste.

- If there is no item that has been copied or cut, the Paste option will not
appear.

Clip Tray
If you copy or cut an image or text, it is automatically saved to the clip tray
and can be pasted to any space at any time.

1 On the Smart tool, select [iF]
You can also touch and hold the text input window, then select Clip
Tray.

2 Select and paste an item from the clip tray.
+ Amaximum of 20 items can be saved to the clip tray.

+ Tap &3 to lock saved items in order not to delete them, even when
the maximum quantity is exceeded. A maximum of ten items can be
locked. To delete locked items, unlock them first.

+ Tap [if] to delete the items saved to the clip tray.

5 + The clip tray may not be supported by some downloaded apps.
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Content sharing

Playing content from another device
You can play photos, videos or songs saved on your device froma TV.
71 Connect the TV and your device to the same Wi-Fi network.

2 While viewing the items from the Gallery or Music app, tap Cgor : >
Play on other device.
Or tap O > Settings > Connected devices > Screen sharing and then
tap Q) to activate it.

3 Select the TV you want to connect to.

5 « For use with Chromecast, Google Play services should be up to date.

Viewing content from nearby devices

You can view content from various devices, such as a computer, NAS or
mobile device, by using the Gallery or Music apps.

Tap O > Settings > Connected devices > Media server, then tap
Content sharing O to activate it.

Connecting the devices

Connect both your device and another device that support DLNA function
to the same wireless network.

E + Make sure that File sharing (DLNA) is activated on both the device and
the connected device.

Searching for nearby devices

You can view a list of DLNA devices on the same network by selecting the
: > Nearby devices menu in each app.

Use content from nearby devices as if you were using it on your device.
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Sending or receiving files

You can share files between your device and another LG device, or a tablet
or computer.

Sending files

From the Gallery, File Manager or other apps, tap : > Share or <<, then
select a device on the file sharing list.

Receiving files
Drag the status bar downward and then tap File sharing.

If your device does not support the file sharing feature, tap O > Settings
> Connected devices > File sharing > SmartShare Beam ().

E + You can share files with certain devices that support DLNA.

Viewing content from your cloud

You can directly view the content saved on your cloud account, without
downloading it to your device.

1 From the Gallery or Music app, select : > Cloud.
Or from the File Manager app, select => Cloud.

2 Select a cloud account and sign in.

3 Save or play content in your cloud.
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Do not disturb

You can limit or mute notifications to avoid disturbances for a specific
period of time.
Tap O > Settings > Sound > Do not disturb.
+ Mode and select the mode you want:
- Priority only: Receive sound or vibrate notifications for the selected
apps. Even when Priority only is turned on, alarms still sound.
- Total silence: Disable both the sound and vibration.
- Select priorities: Receive alarms and the notifications for the selected
apps.
- Calls from: Set up a range of notifications when receiving a call.

+ Repeated calls: Second call from the same caller within 15 min is not
silenced.

- Messages from: Set up a range of notifications when receiving a
message.
+ Use Do not disturb: Turn on the Do not disturb feature.
+ SCHEDULE: Set the schedule for which you want to turn on the Do
not disturb feature.
- Help: View the help for Do not disturb.
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Installing and uninstalling apps

Installing apps
Access an app store to search and download apps.

+ You can use SmartWorld, Play Store or the app store provided by your
service provider.

E + Some app stores may require you to create an account and sign in.
+ Some apps may charge fees.

« If you use mobile data, you may be charged for data usage, depending
on your pricing plan.

+ Smart\World may not be supported depending on the area or service
provider.

Uninstalling apps

Uninstall apps that you no longer use from your device.

Uninstalling with the touch and hold gesture

Touch and hold any empty area on the screen, and then tap @ of the app
you want to delete.
- If apps were uninstalled within 24 hours from now, you can reinstall
them. See App trash for details.

Uninstalling by using the settings menu
Tap O > Settings > Apps & notifications > App info, select an app, then
tap Uninstall

I_;'] + Some apps cannot be uninstalled by users.
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Uninstalling apps from the app store

To uninstall an app, access the app store from which you download the
app and uninstall it.

Installing and uninstalling apps during the

setup

\When you turn on the device for the first time, you can download
recommended apps.

You can skip to the next step without installation.

App trash
You can view the uninstalled apps. You can also reinstall apps which were
uninstalled within 24 hours from now.
1 Tap O > Management > App trash.
You can also touch and hold an empty area of the Home screen, then
tap App trash.
2 Activate the desired function:
+ Restore: Reinstall the selected app.
« {ij : Remove the uninstalled apps permanently from the device.

E + Uninstalled apps are automatically removed from the device 24 hours
after they were uninstalled. If you want to reinstall the uninstalled apps,
you must download them again from the app store.

- This feature is activated on the default Home screen only. If you
uninstall apps while using the EasyHome screen or other launcher, they
are immediately and permanently removed from the device.
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App Shortcuts

On the Home screen, touch and hold an app icon such as Call, Message,
Camera, Gallery and Settings to display a quick access menu. Use apps
more easily through App Shortcuts.

- Tap & to set the widgets for the app.
+ Tap () to check the app information.

E « This feature is available only on some apps.
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Phone

Voice call

Make a phone call by using one of the available methods, such as manually
entering a phone number and making a call from the contact list or the
list of recent calls.

Making a call from the keypad

1 TapO>®> Dial.

2 Make a call by using a method of your choice:
- Enter a phone number and tap @@.
+ Touch and hold a speed dial number.

« Search for a contact by tapping the initial letter of a contact name
in the contact list, and then tap @@.

E + Toenter "+" when making an international call, touch and hold number
0.

+ See Adding contacts for details on how to add phone numbers to the
speed dial list.

Making Calls from Contacts
T O>@®> Contacts.

7 After selecting the number you want to call from the list of contacts,

tap &...
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Answering a call
To answer a call, drag '« on the incoming call screen.
+ When the stereo headset is connected, you can make calls by using the
call/end button on the headset.

+ To end a call without turning off the screen, tap O > Settings >
Network & internet > Call > Answer and end calls and then activate
End call with the Power key.

5 - Ifyou enable (> Settings > Network & internet > Call > Answer
and end calls > End call with the Power key, you can end a call by
pressing the Lock/Power key while the call-in-process screen is turned
on.

Rejecting a call
To reject an incoming call, drag @ across the incoming call screen.

- To send a rejection message, drag the rejection message option
across the screen.

+ To add or edit a rejection message, tap O > Settings > Network &
internet > Call > Call blocking & Decline with message > Decline
with message.

+ When a callis coming in, press the Volume Up, Volume Down or Power/
Lock key to mute ringtone or vibration, or to hold the call.

Checking an incoming call while using an app

When a call comes in while using an app, a pop-up notification can be
displayed at the top of the screen. You can receive the call, reject the call,
or send message from the pop-up screen.
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E - Tap (D> Settings > Network & internet > Call > Additional settings
> Show voice calls while in an app and then select the desired way you
would like to display the incoming call while using an app.

- Floating bar must be enabled if you want to check the calls received
using the floating bar while using an app. For more details, refer to the
Floating Bar overview.

Viewing missed calls
If there is a missed call, the status bar at the top of the screen displays X.

To view missed call details, drag the status bar downwards. You can also
tap O > (@ > Call logs.

Functions accessible during a call

During a call, you can access a variety of functions by tapping the
on-screen buttons:

Contacts: View the contact list during a call.

Hold: Place the current call on hold.

Dialpad: Display or hide the dial pad.

Speaker: Turn on the speakerphone function.

Mute: Mute your voice so that your voice cannot be heard by the other
party.

Bluetooth: Switch the call to a Bluetooth device that is paired and
connected.

- @ :Endacal

« ¢ :Access additional call options.

« Available settings items may vary depending on the area or service
provider.
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Making a three-way calling
You can make a call to another contact during a call.
1 Duringacal, tap : >Add call.

2 Enter a phone number and tap @.
+ The two calls are displayed on the screen at the same time, and the
first callis put on hold.

3 To start a conference call, tap Merge calls.

E + You may be charged a fee for each call. Consult with your service
provider for more information.

Viewing call records

To view recent call records, tap O > (> Call logs. Then, you can use the
following functions:

- To view detailed call records, select a contact. To make a call to the
selected contact, tap &...

- To delete call records, tap : > Delete.
E « The displayed call duration may differ from the call charge. Consult with
your service provider for more information.
+ The deleted call history can not be restored.

« Pinch two fingers or spread your fingers apart to adjust the font size of
call logs or contacts.

Configuring call options
You can configure various call options.

1 TapO>(®> Dial or Call logs.

2 Tap : > Call settings and then configure the options to suit your
preferences.
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Messaging

Sending a message
You can create and send messages to your contacts using the Messaging
app.

5 + Sending messages abroad may incur additional charges. Consult with
your service provider for more information.

1T TpO>0
2 Tap D

3 Specify a recipient and create a message.
+ To use multimedia options, tap .
+ To access optional menu items, tap .

/4 Tap B> to send the message.

Reading a message
You can view exchanged messages organised by contact.

T TpO>0

2 Select a contact from the message list.

+ While on the message list or chat window, you can adjust the font size
by placing two fingers on the screen and either widening or narrowing
the fingers.
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Configuring messaging settings

You can change messaging settings to suit your preferences.
1T TpO>0

2 Tap : > Settings from the message list.

E « You can designate settings for the notice window, blocking calls, disaster
alert, multimedia messages, etc.

Camera

Starting the camera

You can take a photo or record a video to cherish all of your memorable
moments.

TapO> @)
5

Before taking a photo or recording a video, wipe the camera lens with a
soft cloth.

Be careful not to stain the camera lens with your fingers or other
foreign substance.

Images included in this user guide may be different from the actual
device.

.

Photos and videos can be viewed or edited from the Gallery. See Gallery
overview for details.

.

Refrain from using the product for a purpose that may violate someone
else’s privacy or rights.
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Basic features in the Camera app

You can take photos or record videos by selecting a variety of camera
modes and options.

1T TapO> @

2 Tap () totake a photo, or tap @ to record a video.

Rear Camera

Taking a photo
7 Select a camera mode and tap the subject to focus the camera on.

2 Tap () to take a photo.

+ You can also press the Volume Down or Volume Up key to take a
photo.

+ You can take a photo while recording a video by pressing @ on the
screen.

E + You can run the camera app by short-pressing the power key twice. Tap
(O > Settings > Extensions > Shortcuts and then tap Open Camera
to activate it.

+ When the screen is turned off or locked, start the camera by pressing
the Volume Down key twice. Tap () > Settings > Extensions >
Shortcuts and then tap Open Camera () to activate it.
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Recording a video

1 Tap O> @ > Video and tap the subject to focus on.
2 Tap @ to record a video.
To take a photo while recording a video, tap @.

To pause the video recording, tap @. To resume the video recording,
tap (e

+ While recording a video, you may spread or pinch two fingers to
zoom in or out.

While recording a video, you may tap the desired area to adjust the
brightness.

3 Tap (= toend the video recording.

Customising the camera options
You can customise a variety of camera options to suit your preferences.
Tap 63 on the screen.

E - Available options vary depending on the selected camera (front or rear
camera) and the selected camera mode.

« []: Take a photo in FullVision.
* [0]: Select values for aspect ratio and size for taking photos.
+ [ Select values for resolution and size for recording videos.
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Tips

Notifies the user when the subject’s eyes were closed
or the picture is blurry for optimal photography.

Google Lens

When associated info is found in Auto mode, Google

Suggestions Lens will be used.
Obtain photos in vivid colours and get compensated

HDR effects even when they are taken against the light.
These functions are provided by the high dynamic range
(HDR) technology equipped in the camera.

Live photo Record the action before and after you take a photo.

Cheese shutter

Take photos with voice commands.

Steady recording

Minimise motion blur while recording a video.

Tracking focus

Enable the camera to remain focused on the subject
you touch on the screen, even if the subject is moving.
(Available when the Standard camerais in use.)

Tag locations

Save the image with GPS location data.

Display guide grids so that you can take photos or

Grid record videos based on the horizontal and vertical
reference lines.

Add signature Display a personalised signature on the photos.
Select if you want to store the pictures and videos

Storage in the Internal storage or SD card. (Available when a
memory card is inserted.)

Help Provide Help for each camera menu.
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Additional options on the front camera

) Take a selfie by selecting its option between Gesture
Selfie shot shot and Auto shot.
Save as flipped Save as flipped images after taking selfies.

+ You can apply the make-up effect when taking a selfie using the front
camera.

Mode Selection
You can conveniently select from the modes displayed on the screen
which are selected to suit the shooting environment.
Tap O> (&) then tap More.
+ You can change the order of the scene modes by moving the scene
mode icon while pressing and holding the icon.

+ You can download various scene modes from the SmartWorld app by
pressing 4.

ommm—  Oclect More
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Story Shot
You can immediately composite photos taken from the rear camera and
the front camera.
1 Tap > (@) then tap More > 2%,
2 Tap () to take photos.
- Take a photo that will serve as the background of the composite
image.
+ After a short while, the front camera will automatically take a photo.

E - You can also touch B and then select a photo saved in the Gallery for
the background of the composite image.
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Flash Jump-Cut

Photos taken at a regular interval are saved as GIF files.
1 TapO> [ then tap More > 4.

2 Tap (@) to select how many copies of the photograph to take.
+ You can select one among 4, 8, 12, 16 and 20 copies.

3 Tap () to take a photo.
+ Photos are taken every 3 seconds and saved as a GIF file.

- You can press @ before taking the prescribed number of photos to
stop the shooting.

- Photos taken are saved as GIF files.
+ You can see the saved GIF files using the Gallery app.

E + At the moment when the camera takes the photograph, a flash comes
on.

+ At the bottom of the screen, the total number of photographs taken as
well as the number of copies are shown.

- The photographs taken are saved in the GIF format files only.

Cine shot

You can record a moment and make a video with only a part of the scene
in motion.

While recording a video, hold the device steady. After the video is recorded,
rub an area in the video you want in motion. The selected area starts
moving and the rest of the video remains still.

1 TapO>[®, then tap More > .
2 Tap @ to record a 3 second video.
+ Hold the device steady while recording the video.
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3 Tap (#) and rub the area you want in motion with the Cine shot effect.

Undo —¢g
Redo

B — Play forward and backward
repeatedly.

Play forward repeatedly.

Select the area to move. Erase the selected area.

+ Tap (©) to erase the selected area.
- Tap @ to play the selected area in motion forward repeatedly.

- Tap @ to play the selected area in motion forward and backward
repeatedly.

4 Tap SAVE.
+ The selected area will be in motion.

QLens

You can do shopping, search image, or scan QR code by taking a photo
with QLens.

1 TapO> (), then tap More >3,

2 Select the desired option among Visual Shopping, Visual Search or
Scan QR code.

Useful Apps 96



3 Tap the screen to take a photo of the object you want to search or
focus the QR code.
+ The result will appear after a moment.

5

.

This feature is available only when your device is connected to a
network. If you use mobile data, you may be charged for data usage,
depending on your pricing plan.

.

For Visual Search features, you can select the desired area from the
image that you have taken, and then search it again.

.

This feature is available only when the rear camera is in the Auto mode.

.

This function may not be supported depending on the area.

Panorama

You can create a panoramic photo by moving the camera in one direction
to photograph and stitch continuous shots of a wide view.

1 Tap O > @, then tap More >
2 Tap () and then slowly move the camera in one direction.

+ Move the device by following the direction of the arrow in the
guideline.

3 Tap @ to stop capturing the panoramic.
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Slo-mo

Create a fun video by changing the speed of movement. This function is
useful when you want to playback a video at a slower speed compared to
the actual speed of the original clip.

« Slow motion for the entire video
- Slow motion effect is applied to the entire video.
« Slow motion for sections
- Slow motion effect is applied to certain sections of the video.

1 Tap O > (@ then tap More > Q.

2 Select!( section or the entire video and select the desired slow
motion effect.

3 Tap e toshoot video.
« If you shoot slow motion for the entire video, slow motion effect
will be applied to the whole video.
« If you shoot slow motion for sections, slow motion effect will be
applied to the sections where @O was pressed.
- Press @O at the moment where you want the slow motion
effect to be applied.
:With a short-press, slow motion effect will be applied for 0.5
second.
:With a long-press, slow motion effect will be applied until you
release your finger.

- You can press @Q up to five times.

4 If you want to finish shooting, press (=),
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Penta shot
You can take five photos in series using all five camera lenses.

1 TapO> [ then tap More >8],
2 Tap () to take a photo.

- It will take five photos automatically in sequence starting with the

rear cameras.

« A series of five photos is automatically saved in Gallery providing
options to create a collage or GIF

+ While taking a photo, hold the device steady until all 5 photos have
been taken.
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Food

You can take a photo or record a video with adjusting the colour slide bar
and white balance.

1 Tap O> (@ then tap More > S2.

2 Totake a photo, tap
+ Drag the colour slide bar on the screen to adjust the white balance
and select the best colour.
- If the slide bar is not displayed, tap %+ to adjust the white balance.

Night view

You can take vivid and clear night photos. While taking a photo, hold the
device steady. You can adjust photo brightness by dragging the slide bar
left or right.

Tap O > (®), then tap More > (S,
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Manual Video mode

User can manually set various functions for recording video. Adjust audio,
white balance, focus, brightness, ISO, shutter speed, etc.

1 Tap O > then tap More >[X

2 Set the scene menu that is appropriate for the shooting environment.

Adjust audio Reset the settings .

balance.

Adjust shutter
speed.

Adjust ISO speed.

Adjust focus.

Adjust white
balance.

3 Press @ to start recording.

Option Setting
You can set the camera option according to the desired environment.
Press ¢33 on the screen.

+ [1]: Directly switch over to FullVision

+ [31: Select video resolution and size.

Frame rate Select the frames per second value.
Bit rate Select the image quality for videos.
Hi-Fi Record a video with Hi-Fi quality sound.

Save a video in the HDR10 format for high definition and

Save in HDR10 -
vivid colour.
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Steady recording

Minimise motion blur while recording a video.

Tracking focus

Enable the camera to remain focused on the subject you
touch on the screen, even if the subject is moving.

(Available when the Standard cameraiis in use.)

Tag locations

Save the image with GPS location data.

Display guide grids so that you can take photos or record

Grid videos based on the horizontal and vertical reference lines.
Select if you want to store the pictures and videos in the

Storage Internal storage or SD card. (Available when a memory
card is inserted.)

Help Provide Help for each camera menu.

Triple shot

This feature allows you to take a series of photos with different angles of
view and create a video with slide effect.

1 TapO> @ then tap More >3],

2 Tap () to take a photo.
+ The three rear cameras take photos automatically in sequence.

+ The triple shot images are automatically saved in Gallery.

E + While taking a photo, hold the device steady until all 3 photos have

been taken.
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Cine Video

You can record a movie-like video.

1 Tap Q> (@, then tap More > @
2 Tap @ to record a video.

T :Record a video by selecting the point zoom feature to zoom in/
out around a specific desired area.

:Select an effect to apply to the recording. You can also adjust

the vignette and strength for each Cine effect. This feature cannot
be changed after you have started recording.

+ The Point zoom feature supports a zoom speed of up to 3x.
+ This feature only supports video recordings in standard angle.

YouTube Live
You can record a video and directly upload to YouTube.
To use this feature, you need to verify your phone number.

L;'] « YouTube Live is available only when your device is connected to the
Internet. If you use mobile data, you may be charged for data usage,
depending on your pricing plan.
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Manual camera mode

You can create photos featuring professional touch by using a variety
of advanced features. Adjust the white balance, focus, brightness, ISO,
shutter speed and other options.

1 Tap O > ®, then tap Manual Camera.
2 Customise the following camera settings.

—— Reset the settings.

Displays the E‘
various
Graphy options. !-; Adjust shutter speed.

Adjust ISO speed.
S s — Adjust brightness.
Adjust focus.

Adjust white balance.

3 Tap () to take the photo.

E « Selecting the Graphy effects allows you to shoot using the white
balance, shutter speed, and ISO setting values applied to the
recommended photo.

+ You can see a variety of recommended photos if you download the
Graphy app from the Google Play Store.

Useful Apps 104



Customising the camera options
You can customise a variety of camera options to suit your preferences.

Tap €33 on the screen.

« [%]:Take a photo in FullVision.
- [0]: Select values for aspect ratio and size for taking photos.

Adjust the white balance, ISO and shutter speed for the

Graphy photos recommended photo. See Graphy for details.
The image is stored as a RAW file format so that you
Save as RAW can modify it. The DNG and JPEG files are created while

taking a photo, then saved as a non compressed high
resolution image.

Cheese shutter

Take photos with voice commands.

Tracking focus

Enable the camera to remain focused on the subject
you touch on the screen, even if the subject is moving.
(Available when the Standard camera is in use.)

Tag locations

Save the image with GPS location data.

Guide

Display guide grids so that you can take photos based on
the horizontal and vertical reference lines.

Add signature

Display a personalised signature on the photos.

Select if you want to store the pictures and videos in the

Storage Internal storage or SD card. (Available when a memory
card is inserted.)
Help Provide Help for each camera menu.
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Graphy

You can apply the recommended values for the white balance, ISO and
shutter speed as if taken by an expert.

1 Tap O > (& then tap Manual Camera.

2 Tap @ and select the desired scene from the recommended images.

Recommended images

3 Tap () to take a photo.

+ Photographs are taken under the same photograph settings
selected in Graphy.

E « This feature is available only in Manual camera mode.

+ You can add more scenes by tapping i and downloading the Graphy
app from the Play Store. You may be charged for data usage, depending
on your pricing plan.

- Tap £33 then tap @) from the Graphy menu to deactivate this feature.
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Makeup Pro

While taking selfies, you can apply various makeup techniques.

When using the front camera, adjust the skin tone and apply eye and lip

makeups.

1 Tap O >([®, switch to the front camera, then tap .

2 Select a desired makeup option, then drag the slide bar to the left or
right to adjust the effect.
+ When you select None, the slide bar disappears.

Select Make-up Effect
No Effect
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3 Select various makeup effects and apply them to the subject.

- Basic or Makeup Mode, then touch the screen again to apply more
detailed makeup effects.

+ Move the Intensity Adjustment Bar to adjust the intensity with
which the effects are applied.

Touch Default or —==8 "2 T’

o ﬁ

Select Make-up Effect

4 Tap () to take a photo.
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Studio

You can create studio level photos by using Spotlight and Backdrop
features in the camera.

Spotlight
You can apply various lighting effects while taking photos.

1 Tap O> ([ then tap Studio.

2 Tap-()- to select a lighting effect.
- Various lighting effects appear at the bottom of the screen.

Spotlight icon —

3 Tap the desired lighting effect icon.

4 When Studio effect is available. appears on the screen, tap () to
take a photo.

+ The Studio feature may not work if the camera cannot recognise
the subject.
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Backdrop
You can apply various effects for background while taking portrait photos.
1 Tap O>([® then tap Studio.
2 Tap (@) to select a backdrop effect.
« Various background colours appear at the bottom of the screen.

3 Select a background colour you want to apply.

+ You can apply the selected colours to the background apart from
the subject.

17 Backdrop icon
® o

*— Background colours

4 When you see the quiding message Studio effect is available, tap
to take a photograph.

E « If the camera fails to recognise the subject, the studio function cannot
be applied to the saved photograph.

« If the surrounding is dark, the camera cannot apply the studio effects.
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AR features

You can use various AR (Augmented Reality) features with the Camera
app. You can create your own My Avatar, AR Emoji, or AR Sticker for rich
content. My Avatar helps you create a cartoon version of yourself and
customise it. AR Emoji help you create 3D animated animal emojis that
mimic facial expression. AR Sticker allows you to choose from several
different stickers to use on a photo or video while facing your camera.

Creating My Avatar
1 TapO> (@, switch to the front camera, then tap && > ©).
+ You can use this function only in Auto Mode.
2 Tap §3> £ to take a photo.
- Follow the on-screen instructions to align your face on the screen.

- To make My Avatar by using one of the saved photos from Gallery,
tap .
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3 Select My Avatar's gender and select details including avatar type, skin
tone, hairstyle, and clothes, then tap OK.

« Taken photos are saved in Gallery.
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Using My Avatar, AR Emoji, AR Sticker
1 TapO> (@, switch to the front camera, then tap &> ©.

2 Select an option you want to record.

My Avatar AR Sticker

3 To take a photo, tap
To record a video using My Avatar, AR Emojis or AR Stickers, select the
video recording menu, and then tap & > @) to select the desired item,
and tap @ to start shooting the video.

+ Taken photos are saved in Gallery.
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Using Avatar Stickers
1 Tap &) on the LG Keyboard.

2 Select an avatar sticker you want among the self-created My Avatars,
and then select B> to send it.

< oA € woa i

Avatar Sticker —&— @ ek
icon |g ¢ ¢ B ®|v

Using Ani Sticker
1 Tap &) on the LG Keyboard.
2 Select the desired My Avatar.
3 Tap () to record voice and video, and then tap () to save.
+ Ani Stickers with various facial expressions, motions, and voices are
created.
A Tap (») to upload Ani Sticker.
- Tap @ to preview the created Ani Sticker.
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Select an

Ani Sticker

-2

-2

Preview icon —
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Other useful features in the Camera app

Auto-Exposure/Auto-Focus lock

You can fix the current exposure level and focus position by touching and
holding the screen in the Auto mode. To turn off the feature, tap a blank
area on the screen.

E - This feature is available only in specific modes.

Using the Burst Shot

You can take consecutive photos and view them as moving pictures in the
Gallery.

1 Run the camera app and select Photo.

2 Tapandhold
+ Multiple, consecutive photos are taken while you are holding down

E « This feature is available only in specific modes.
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Zoom in or out
You can use zoom in or out on the camera screen while taking a photo or
recording a video.
+ Using the adjustment bar which appears when you use two fingers to
zoon in/zoom out on the camera screen, switch between telescoping
angle, normal angle, and ultra-wide angle.

- Zoom in/out function is not available in the selfie mode (front camera).
« This function is not supported in a number of modes.

Focus peaking

You can adjust the focus on the subject with the focus peaking feature.
Access Focus peaking by tapping the Manual focus (MF) button. When
Focus peaking is enabled, the subject you focus on appears yellow. Move
the the toggle wheel up and down to focus on the desired areg, then take
the photo.

+ Press Focus peaking once again to disable this function.
« This function can be used only when shooting at a normal angle.
- Itis only available for use with the manual focus (MF).

Useful Apps 117



Switching between cameras

You can switch between the front and rear cameras to suit your
environment.

On the camera screen, tap {o} or drag the screen in any direction to switch
between the front and rear cameras.

ans

E « Use the front camera to take selfies. See Selfie shot for details.
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Selfie shot

You can use the front camera to view your face on the screen and take
selfies.

Gesture shot

You can take selfies by using gestures.

Show your palm to the front camera and then clench your fist.

You can also clench your fist and then open it towards the front camera.
+ In three seconds, a photo is taken.

n

W

E - To use this feature, switch to the front camera mode, then tap €§§ >
Selfie shot > Gesture shot.
+ Make sure that your palm and fist are within the reference line so that
the camera can detect them.
« This feature may not be available while using some of the camera
features.
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Auto shot

You can use the face detection feature to take selfies easily and
conveniently. You can set the device so that, when you look at the screen,
the front camera detects your face and takes a selfie automatically.

- The white coloured guide frame appears when the front camera
detects your face. If the subject within the guide frame stops moving,
the guide frame colour turns yellow, then the camera takes a photo.

5 - Tap §63 > Selfie shot > Auto shot to enable the Auto shot feature.

Interval shot
You can take selfies at an interval.

While using the front camera, you can show your palm to the camera,
then clench your fist twice quickly.

- Four photos are taken at regular intervals after a timer delay of three
seconds.

Save as flipped

Before taking a photo with the front camera, tap £63 > Save as flipped.
The image is flipped horizontally.

E + When using the front camerg, you can change how selfies are taken in
the camera options. See Customising the camera options for details.

Signature

You can create a personalised photo by using your signature.
1 Tap O > (&), then tap {33 > Add signature.

2 Enter the signature as desired and tap Add.

E « This feature is available only in specific modes.
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quick share

You can share a photo or video to the app you want immediately after
taking it.

1 TapO>[®, then take a photo or record a video.

2 Tap the app icon that appears on the screen to share it using that app.
You can also swipe the icon towards the opposite direction to see
what other apps you can use to share your photos and videos.

quick share icon

E + The app displayed by the quick share icon may vary, depending on the
type and frequency of access to the apps installed on the device.

« This feature is available only in specific modes.
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Gallery

Gallery overview
You can view and manage photos and videos saved on your device.
1T Tap Oy

- Saved photos and videos are displayed by folder.

2 Tap afolder and select a file.
View the selected file in full-screen mode.

While viewing a photo, swipe left or right to view the previous or
next photo.

While viewing a video, swipe left or right to rewind or fast-forward
the video.

If you save the location information or use a scene mode when
shooting, a sub folder is generated for each video.

- To view photos by location at which the photo was taken, tap O >
(2) > 53> Tag locations, then tap QD). The photos are automatically
grouped by location under the Memory tab of the Gallery app.

E - Some file formats may not be supported, depending on the installed
software.
+ Some files may not be opened due to encoding.
+ Files that exceed the size limit may cause an error.
+ You need to activate the GPS feature to create Memory albums.
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Viewing photos
You can view the photos saved to the product.
Start QLens,

Access additional
| options.

Start the camera.

Add to or remove

from your
favour\tes

Write a memo on a Delete images.
photo. '
View related Share images.
content. J
Editimages.

+ Details menu appears when the screen is lightly touched. Touching the
screen once again makes the menu disappear.

Back to the —g
previous screen. 3

Playing a video

You can view the videos saved to the product.

Pause or play the ) e — Access additional
video. = options.

screen.

Choose screen ———
ratio.

{ e — Lock or unlock the

Edit the video.

DTSX 3D on/off
Making a GIF file.
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5 + To adjust the sound volume, drag the right side of the video screen up
or down.

+ To adjust the screen brightness, drag the left side of the screen up or
down.

- Dragging the screen to the left on the video play screen allows you to
rewind (REW) and dragging to the right allows you to fast forward (FF).

Editing videos
1 While viewing a video, tap £

2 Use avariety of effects and edit tools to edit the video.

Automatically
createa 15 sec,
Adjust the 30 sec or 60 sec
resolution. video clip.
Revert the edit. Create a movie using
l l various effects.

E— Launch the
KineMaster video
editor.

Select a section to
change the play
speed.

***** A b — Adjust the video
duration.

3 Tap Save to save changes.

Creating Video
You can piece together images or videos to create a new video.
For more details, refer to Creating a movie.

Creating GIF
You can conveniently edit the photos and videos you have taken in GIF
For more details, refer to Making a GIF.
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Deleting files

You can delete files by using one of the following options:
+ Touch and hold a file from the file list, then tap Delete.
« Tap {ifj from the file list and delete the desired files.

+ Deleted files are automatically moved to Trash and they can be
restored to the Gallery within 7 days.

- Tap [] to completely delete the files. In this case, the files cannot be
restored.

Sharing files
You can share files by using one of the following options:

+ While viewing a photo, tap «< to share the file by using the method
you want.

+ While viewing a video, : > Share to share the file by using the method
you want.

« Tap < from the file list to select files and share them using the method
you want.
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Contacts

Contacts overview
You can save and manage contacts.
Tap O > Essentials > Contacts.

Adding contacts

Adding new contacts

1 Onthe contact list screen, tap -
- A pop-up appears for selecting the saving location for contact.
Select the location you want.

2 Enter contact details and tap Save.

Importing contacts
You can import contacts from another storage device.

T Onthe contact list screen, tap : > Manage contacts > Import.

2 Select the source and target locations of the contact you want to
import, and then tap OK.

3 Select the contacts and tap Import.

Adding contacts to the speed dial list
T Onthe contact list screen, tap : > Speed dial
7 Tap Add contact from a speed dial number.

3 Select a contact.

E + While adding a new contact, tap {313} to add a speed dial number.
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Searching for contacts
You can search for contacts by using one of the following options:

- Tap the search bar at the bottom of the Contacts screen and enter the
desired contact or phone number you want to search for.

+ Scroll the contact list up or down.
+ From the index of the contact list screen, tap the initial letter of a
contact.

E + Tapping the search bar at the bottom of the Contacts screen and
entering a contact or phone number brings up the integrated search
results from the call history and contacts list saved onto the product.

Contacts list

Editing contacts
1 On the contact list screen, select a contact.
2 On the contact detail screen, tap ¢ and edit details.

3 Tap Save to save changes.

Deleting contacts
You can delete contacts by using one of the following options:

- On the contact list screen, touch and hold a contact you want to
delete, then tap Delete contact.

- Tap : > Delete on the contact list screen.

E « Deleted contacts may not be restored.
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Adding favourites

You can register frequently used contacts as favourites.

1 On the contact list screen, select a contact.
2 On the contact detail screen, tap ¥y

Creating groups

T On the contacts group list, tap -+

2 Enter anew group name.

3 Tap Add members, select contacts, then tap Add.

/| Tap Save to save the new group.

QuickMemo+

QuickMemo+ overview

You can make creative notes by using a variety of options on this

advanced notepad feature, such as image management and screenshots,

which are not supported by the conventional notepad.

Creating a note
1 Tap O > QuickMemo+.
7 Tap @ to create a note.
- @ :Saveanote.
+ <5 :Undo the previous edit.
+ (> :Redo the recently deleted edits.
- T :Enter a note by using the keypad.
£/ :Write notes by hand.
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+ & Erase handwritten notes.
+ {):Zoomin or out, rotate or erase the parts of a handwritten note.
+ ¢ :Access additional options.

3 Tap @ to save the note.

Writing notes on a screenshot
1 While viewing the screen you want to capture, drag the status bar
downwards and then tap 7,
« The screenshot appears as the notepad background theme. Memo
tools appear at the top of the screen.
2 Crop the image (if necessary) and take notes as desired.
« Write notes by hand on the photo.

3 Tap @ and save the notes to the location you want.
- Saved notes can be viewed in either QuickMemo+ or Gallery.

- To save notes in the same location all the time, select the Use as
default app checkbox and select an app.

E « You can capture the entire screen by using the scroll capture feature.

« While using an app such as Message and Chrome, drag the notifications
panel downwards and then tap Capture+ > Extended to capture the
entire screen you are currently viewing as a single file.

- This feature is available only on some apps that support the scroll
capture feature.

Pinch two fingers or spread your fingers apart to change the memo
layout.
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Managing folders

You organise and view memos according to the memo type.

1 Select O > QuickMemo+.

2 Tap = on the top part of the screen and then select the desired
function.
« All Memos: You can collectively view all memos save in Qmemo-+.
+ My Memos: You can view the memos created in Qmemo-+.
+ Capture+: You can view the memos created using Capture-+.
« Trash: You can view the deleted memos.
- New category: You can add folders.

+ ¢ You can change the order of folders or add/delete folders. By
pressing the folder, you can change the folder name.

E + Some folders do not appear when the folder app initially started. Folders
are additionally displayed only when relevant memos exist.
« Deleted memos are moved to the trash bin and can be recovered within
7 days from the day they were deleted. In the Qmemo-+ app, you can
change the display type by placing two fingers on the screen and either
widening or narrowing the fingers.

- Some folders do not appear when the folder app is initially started.
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Clock

Alarm

You can set an alarm to trigger it at a specified time.
1 Tap O > Essentials > Clock > Alarm.

2 Tap-toadd a new alarm.

3 Configure the alarm settings and tap Save.

« If you select a previously set alarm, you can edit the alarm.

- Todelete an alarm, tap : > Delete at the top of the screen. You can also
touch and hold the alarm.

World clock

You can view the current time in cities around the world.
1 Tap O > Essentials > Clock > World clock.
2 Tap-andaddacity.

Timer
You can set the timer to trigger an alarm after a specified period of time.
1 Tap O > Essentials > Clock > Timer.

2 Set the time and tap Start.
+ To suspend the timer, tap Pause. To resume the timer, tap Resume.

3 Tap Stop to stop the timer alarm.
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Stopwatch

You can use the stopwatch to record a lap time.

1 Tap O > Essentials > Clock > Stopwatch.

2 Tap Start to initiate the stopwatch.
+ Torecord a lap time, tap Lap.

3 Tap Pause to suspend the stopwatch.
+ To resume the stopwatch, tap Resume.

+ To clear all the records and restart the stopwatch, tap Reset.

Calendar

Calendar overview
You can use the calendar to manage events and tasks.

Adding events
1 Tap O > Essentials > Calendar.
2 Select a date and then tap €.

3 Enter event details and tap Save.

Syncing events
Tap : > Calendars to sync, and select a calendar to sync.

5

+ When your events are saved from the device to your Google account,

they are automatically synced with the Google Calendar, too. Then, you
can sync other devices with the Google Calendar in order to make those
devices have the same events that your device has and to manage your
events on those devices.
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Tasks

You can register tasks to your device to easily manage schedules.
1 Tap O > Essentials > Tasks.

2 Tap @ to add a task.

3 Enter task details and then tap Save.

Music

You can play and manage songs or music albums.
1 Tap O > Essentials > Music.

2 Select a category.

3 Select a music file.

Set sound effects.

Back to the previous —
screen.

: «— Access additional options.

— Switch to the playlist.

— P, lay.
Turn on/off Boombox — ause or play.

show.
— Turn on/off Flash Light.
Tap to play from the Tap to play the next file /
beginning of the current Touch and hold to fast
file / Double-tap to play l forward.
the previous file / Touch
and hold to rewind. X ke P Ef_
Play in random order ——.] — Selectarepeat mode.
Adjust the sound volume. — ? +e—— Change pitch and speed.

Add to or delete from your - 1

favourites.
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E - Some file formats may not be supported, depending on the installed
software.

« Files that exceed the size limit may cause an error.
+ Music files may be protected by international copyright owners or
copyright laws. You may have to obtain legal permission before copying

a music file. To download or copy a music file, first check the copyright
law for the relevant country.

This model supports Hi-Fi audio playback. Hi-Fi audio files display the
Hi-Fi icon.

+ When the Boombox Show feature is activated, the screen shows visual
effect to the music. And the device vibrates while you shake it.

Game Launcher

You can set whether to use the game launcher where you can view the
list of games installed on the product and select game settings such as
muting media volume, limiting alerts, etc.

1 Tap O > Game Launcher.
2 Select the desired option.

Calculator

You can use two types of calculators: the simple calculator and the
scientific calculator.

1 Tap O > Essentials > Calculator.

2 Use the keypad to make a calculation.
« If you want to calculate from the beginning, tap and hold (<]
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ThinQ
You can easily connect the product with loTl appliances to monitor and

conveniently use the appliances.
Select O > Essentials > ThinQ

E + Washing machine, dryer, styler; dishwasher, oven, and robot cleaner can
only be registered when the product is in the standby mode.

+ Look for the ThinQ mark on the product to see if it can be connected to
ThinQ app.
» Tap = to check various function of the ThinQ app.

E-mail

E-mail overview

You can register an email account to your device and then you can check
and send emails from your device.

« If you use mobile data, you may be charged for data usage depending
on your pricing plan. Consult with your service provider for more
information.

Registering email accounts

When you use the email app for the first time, register your email account.
1 Tap O > Essentials > E-mail.

2 Select an email service provider.

3 Enter your email address and password and then tap Next to register
your account.
+ To manually register an email account, tap Manual setup
(if necessary).
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Managing email accounts

To view or edit your email account settings, tap : > Settings.
+ To add an account, tap Add account.
- To delete an account, tap : > Remove account.

Opening another email account

If several email accounts are registered and you want to view another
account, tap = and select another one from the account list.

Checking email
1 Tap=and select a mail box.

2 Select an email from the email list.
+ The email message appears.

Sending email
1 Tap @.
2 Enter the recipient's email address.

3 Enter a subject and message.
- To attach files, tap =
- To access optional menu items, tap 3.

4 TapB>to send the email

« Pinch two fingers or spread your fingers apart to adjust the font size of
your email list.
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HD Audio Recorder

The HD Audio Recorder allows you to configure the audio settings
manually so that you can record audio based on your environment.

Recording modes

You can record a high definition audio file by selecting and configuring the
desired audio mode to suit the recording environment.

Tap O > Essentials > HD Audio Recorder >=

Normal
You can record audio without extra settings.

Concert
You can record audio in a concert or other music event.

Custom
You can manually configure the desired settings to record audio.

Studio Mode

With Studio mode, you can play an audio file or music and record your
voice at the same time, create a chord by recording your voice multiple
times, and record your comments over the presenter's or speaker’s original
audio file.

1 Tap O> Essentials > HD Audio Recorder > => Custom.
2 Tapd+

3 Select an audio file to use as background music.

4 Tap @ to record voice.

5 Tap @ to save the recorded file.

E + Background music can only be played through earphones. Make sure to
plug in earphones before using this feature.
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Other useful features for use of the HD Audio
Recorder app

GAIN
You can adjust the sensitivity of the sound recorded by the microphone.

The higher the GAIN value is set, the more sensitively the sound is
recorded.

LCF
You can filter any low-pitched noises such as the low hum of the air
conditioner.

The higher the LCF (Low Cut Filter) value is set, the better high-frequency
noises are filtered.

LMT

It can prevent clipping of the recorded sound. The higher the LMT (Limiter)
value is set, the more low frequency sounds that will not get clipped.

E - To change additional settings, tap : > Settings, then customise the file
type, bit depth, sampling rate and other settings.
- When you select a mode from Concert and Custom, Qg appears. Tap Ug
and then select the microphone to use.
+ You can monitor sound quality with the connected earpiece while
recording audio. While recording audio in Studio mode, sound
monitoring is not supported. You can hear only the background music.

Useful Apps 138



LG Health

LG Health overview

You can manage your health and maintain good exercise habits by
keeping track of the exercises you do.

Getting started with LG Health

You can configure LG Health when launching the app for the first time or
after resetting it.

1 Tap O > Essentials > LG Health.

2 Follow the on-screen instructions to complete configuration.

Using LG Health

You can view main information on LG Health and manage the amount of
physical exercise and health information.

1 Tap O > Essentials > LG Health.
2 The following options are available.
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+ = :View your exercise log on the day you want to check.
-+ © :Begin tracking an exercise. The route and amount of your
physical exercise are recorded for each exercise type.

« + :Set your daily exercise goals including calories and steps, or set
various LG Health settings.

E « Health-related information provided by LG Health is designed for user
convenience and cannot be used for purposes of disease prevention,
treatment, diagnosis or other medical issues.

.

LG Health may vary or may not be available, depending on the country
and service provider. LG Health functions that are available and apps
that can be added to LG Health may vary, depending on the country. This
is due to differing laws and regulations.
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Update centre

You can check and install the latest version of the app or software
provided by LG.

Tap O > Management > Update centre.

File Manager
You can view and manage files saved on your device or cloud.
1 Tap O> Management > File Manager.

2 Tap=and select the desired storage location.

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise
it

Tap O > Management > Smart Doctor.

LG Mobile Switch

Easily transfer data from a used device to a new device via LG Mobile
Switch.
1 Tap O > Management > LG Mobile Switch.
You can also tap (O > Settings > System > Backup > LG Mobile
Switch.
« If the app is not installed on the product, download and install the
LG Mobile Switch app from the Google Play Store.

2 Follow the on-screen instructions to select a desired method for
transfer.
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E - Data in a Google Account will not be backed up. \When you synchronise
your Google Account, Google apps, Google contacts, Google Calendar,
Google memo app data and apps downloaded from the Play Store are
stored on the Drive app automatically.

« Fully charge the battery before transferring data to avoid unintentional
powering off during the process.

App trash

You can see the list of apps deleted on the home screen. The app that was
deleted within the last 24 hours can be recovered.

Tap O > Management > App trash.
For more details, refer to App trash.

SmartWorld

You can download a variety of games, audio content, apps and fonts
provided by LG Electronics. Customise your device to suit your preferences
by using Home themes and fonts.

E « If you use mobile data, you may be charged for data usage depending
on your pricing plan.

« This feature may not be supported depending on the area or service
provider.

1 Tap O > Services > SmartWorld.
2 Tap : >LG Account, then sign in.

3 Select and download the desired content items.
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Downloading SmartWorld app

If the Smart\World app is not installed, follow these steps to download it.
1 Tap O > Settings > System > Update centre > App Updates.

2 From the list, select SmartWorld and tap Download.

RemoteCall Service

Your device can be remotely diagnosed for resolving issues. First, make a
phone call to an LG Customer Service Centre as follows:

+ To use this function, first you must agree to usage of the function.

- If you use mobile data, you may be charged for data usage depending
on your pricing plan.

1 Tap O > Services > RemoteCall Service.
7 Connect a call to an LG Customer Service Centre.

3 After the call connects, follow the service associate’s instructions to
enter a six-digit access number.

« Your device is remotely connected and the remote support service
starts.

Cell Broadcast

You can view real-time text broadcasts on emergency situations, such as
typhoons, floods and earthquakes.

Tap O > Services > Cell Broadcast.
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Google apps

You can use Google apps by setting a Google Account. The Google
Account registration window appears automatically when you use a
Google app for the first time. If you do not have a Google Account, create
one from your device. For details on how to use an app, see the Help in
the app.

E + Some apps may not work depending on the area or service provider.

Chrome
A fast, simple, and secure web browser, built for the modern web.

Docs

Docs is a collaborative, word-processing tool that powers productivity. Use
Docs to create, edit and work together in real-time.

Drive

Drive is a file storage and sharing app that makes it easy to find, share and
collaborate on work projects from anywhere, instantly.

Duo

Make simple, high quality video calls to your friends and family on Android
phones and iPhones.

Gmail

Gmail is an easy to use mail app that keeps your messages safe, makes
your inbox smarter; and helps you stay organised.

Useful Apps 144



Google

The Google app keeps you in the know about the things you care about.
Find quick answers, explore your interests, and get a feed of stories and
updates on topics that matter to you.

Maps

Going somewhere? Go with Maps, the app you can rely on for real-time
GPS navigation, traffic, transit, and details about millions of places, such as
reviews and popular times.

News

Comprehensive up-to-date news coverage, aggregated from sources all
over the world by Google News.

Photos

Home for all your photos and videos, automatically organised so you can
share and save what matters.

Play Movies & TV

Use your Google Account to rent or purchase movies. Purchase content
and play it anywhere.

Play Music

Purchase music from the Play Store. Play music saved on your device.

Sheets

Sheets is a collaborative spreadsheet processing tool that powers
productivity. Use Sheets to import, organise and analyse information
together in real-time.

Slides

Google Slides is a collaborative presentation creation tool that powers
productivity. Use Slides to organise information, present results, and make
decisions together in real-time.
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YouTube

Watch your favourite channels, listen to music you love, and upload videos
to share with people around the world.

Keep notes
Create, edit, and share you text and photo notes with Google Account.

Assistant

Your device has the Google Assistant built-in. Find answers and get things
done while on-the-go. To get started, just tap the Google Assistant key
on the side of the phone or touch and hold the home button of the phone.

E + The Google Assistant is not available in certain languages and countries.
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Settings
You can customise the device settings in accordance with your
preferences.

Tap O > Settings.

E « If you enter a keyword on the search window at the top of the screen,
you can conveniently run the items that need to be set.

Network & internet
Wi-Fi

You can connect to nearby devices over a Wi-Fi network.

Connecting to a Wi-Fi network
71 On the settings screen, tap Network & internet > Wi-Fi.
2 TapQDtoactivate it.
+ Available Wi-Fi networks appear automatically.
3 Select a network.
+ You may need to enter the network’s Wi-Fi password.

+ The device skips this process for previously accessed Wi-Fi
networks. If you do not want to automatically connect to a certain
Wi-Fi network, tap the network and then tap Forget network.

Settings 148



Wi-Fi network settings
On the settings screen, tap Network & internet > Wi-Fi.

- Switch to mobile data:If the mobile data connection function is
activated but the device cannot connect to the Internet via Wi-Fi
connection, the device automatically connects to the Internet via the
mobile data connection.

E « This feature depends on the service provider.

-+ :Customise Wi-Fi network settings.

Wi-Fi Direct
You can connect your device to other devices that support Wi-Fi Direct to

share data directly with them. You do not need an access point. You can
connect with more than two devices by using \Wi-Fi Direct.

1 On the settings screen, tap Network & internet > Wi-Fi> ¢ >
Advanced Wi-Fi > Wi-Fi Direct.

+ Nearby devices that support Wi-Fi Direct automatically appear.

2 Select a device.
« Connection occurs when the device accepts the connection request.

E + The battery may drain faster when using Wi-Fi Direct.
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Mobile data

You can turn mobile data on and off. You can also manage mobile data
usage.

Turning on mobile data
71 Onthe settings screen, tap Network & internet > Mobile data.
2 Tap(QDtoactivateiit.

Customising mobile data settings
1 On the settings screen, tap Network & internet > Mobile data.
2 Customise the following settings:

- Mobile data: Set to use data connections on mobile networks.

- Limit mobile data usage: Set a limit for mobile data usage to block
mobile data if the limit is reached.

« + :Customise mobile data settings.

- Data usage volume is measured based on the product, and the
volume calculated by your mobile provider may be different.
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Call

You can customise call settings, such as voice call and international call
options.

+ Some features may not be supported depending on the area or service
provider.

71 Onthe settings screen, tap Network & internet > Call.

2 Customise the settings.

Tethering
USB tethering

You can connect the device to another device via USB and share mobile
data.
7 Connect your device and other devices via USB cable.

2 On the settings screen, tap Network & internet > Tethering > USB
tethering and then tap Q) to activate it.

E + This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ When connecting to a computer, download the USB driver from
wwwilg.com and install it on the computer:

+ You cannot send or receive files between your device and a computer
while USB tethering is turned on. Turn off USB tethering to send or
receive files.

+ Operating systems that support tethering are Window XP or higher, or
Linux.
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Wi-Fi hotspot
You can set the device as a wireless router so that other devices can
connect to the Internet by using your device's mobile data.

1 On the settings screen, tap Network & internet > Tethering > Wi-Fi
hotspot and then tap (D) to activate it.

2 Tap Set up Wi-Fi hotspot, and enter the Wi-Fi name (SSID) and
password.

3 Turn on Wi-Fi on the other device, and select the name of the device
network on the Wi-Fi list.

4 Enter the network password.

+ This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http//www.android.com/tether#wifi
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Wi-Fi hotspot turn off timer

When the Wi-Fi hotspot has not been used for a specific period of time,
it is automatically disconnected. You can set the time for automatic
disconnection.

Bluetooth tethering

A Bluetooth-connected device can connect to the Internet by using your
device's mobile data.

T On the settings screen, tap Network & internet > Tethering >
Bluetooth tethering and then tap (O to activate it.

2 Turn on Bluetooth on both devices and pair them.

E - This option uses mobile data and may incur data usage fees, depending
on your pricing plan. Consult with your service provider for more
information.

+ More information is available at this web site:
http//www.android.com/tether#Bluetooth_tethering

Help
You can view help on using tethering and hotspots.
On the settings screen, tap Network & internet > Tethering > Help.

Settings 153



Airplane mode

You can turn off the call and mobile data functions. \When this mode is
on, functions that do not involve data, such as games and music playback,
remain available.

7 Onthe settings screen, tap Network & internet > Airplane mode.

2 Tap Turn on in the confirmation screen.

Mobile networks
You can customise the mobile networks settings.

T On the settings screen, tap Network & internet > Mobile networks.

2 Customise the following settings:

- Data roaming: Select this option to enable the device to use mobile
data when you are roaming outside your home network area.

- Network mode: Select a network type.

+ Access Point Names: View or change the access point for using
mobile data services. To change the access point, select a choice
from the access point list.

- Network operators: Search for network operators and connect
automatically to a network.
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VPN

You can connect to a safe virtual network, such as an intranet. You can
also manage connected virtual private networks.

Adding VPN
1 On the settings screen, tap Network & internet > VPN.
2 Tap+

5 - This feature is available only when the screen lock is activated. If the
screen lock is deactivated, a notification screen appears. Tap Change
from the notification screen to activate the screen lock. See Setting a
screen lock for details.

3 Enter VPN details and tap Save.

Configuring VPN settings
71 Tapa VPN from the VPN list.

2 Enter the VPN user account details and tap Connect.

- To save the account details, select the Save account information
checkbox.

Private DNIS

You can configure the Private DNS (Domain Name System) options.
71 On the settings screen, tap Network & internet > Private DNS.
2 Select the desired option and tap Save.
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Connected devices

Bluetooth

You can connect your device to nearby devices that support Bluetooth to
exchange data with them. Connect your device to a Bluetooth headset
and a keyboard. This makes it easier to control the device.

Pairing with another device

7 On the settings screen, tap Connected devices > Bluetooth.

2 TapQDtoactivateit.
+ Available devices appear automatically.
+ To refresh the device list, tap (.

5 + Only devices set as visible are displayed on the list.

3 Select a device from the list.

4 Follow the on-screen instructions to perform authentication.

E « This step is skipped for previously accessed devices.

Sending data via Bluetooth

1 Select afile.
- You can send multimedia files or contacts.

2 Tap << > Bluetooth.

3 Select a target device for the file.
« The file is sent as soon as the target device accepts it.

E + File sharing processes may differ, depending on the file.

Settings 156



Screen sharing

You can play the screen and sound of the device on a different device,
such as a TV, that supports the Miracast function.

7 On the settings screen, tap Connected devices > Screen sharing.
2 TapQDtoactivateit.

3 Select a device from the list of nearby devices.
« If the desired device does not appear, tap Search to refresh the list.

+ After connecting to the device, the device displays the screen of
your device.

« Screen sharing turns off automatically if there is no sharing-compatible
device in the vicinity.

NFC

You can use the device as a transportation card or credit card. You can also
share data with the other device.

7 On the settings screen, tap Connected devices > NFC.

2 Tap QD toactivate it.

« Touch your device with other device that supports NFC to allow
sharing data.

E + NFC antenna may be located differently depending on the device type.
See Parts overview for details about the NFC antenna area.

Settings 157



Sharing panel

You can share contents from Gallery, Music and File Manager with nearby
devices. Also you can share the content with specific people in apps that
work with Google Direct Share.

7 Onthe settings screen, tap Connected devices > Sharing panel.

7 Tap @ to deactivate each option.

- Nearby devices: You can display the nearby devices to which you
can share contents on the Gallery, Music, and File Manager apps.

- Direct share: From an app which supports Google Direct Share, you
can display an icon which allows you to share contents to specific
people.

File sharing

You can send and receive files between your device and other LG devices
or tablets.

7 On the settings screen, tap Connected devices > File sharing.
2 Customise the following settings:
- V50 ThinQ: Change the device name.

- Save to: Set the destination folder to save files sent from other
devices in.

+ File sharing: Permit receipt of files sent from other devices.

- SmartShare Beam: Share files with other devices via SmartShare
Beam.

+ Help: You can view help on sharing files.
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Media server
You can share media content on your device with nearby devices that
support DLNA.
71 On the settings screen, tap Connected devices > Media server.
2 Customise the following settings:
- Content sharing: Share content on your device with nearby devices.
- V50 ThinQ: Set your device's name.

E - Depending on the user's product, the menu names may appear
differently.

- Content to share: Select the type of media content to share with
other devices.

- Allowed devices: View a list of devices permitted to access content

on your device.

Not-allowed devices: View a list of devices not permitted to access

content on your device.

LG AirDrive

You can use your LG account to manage files saved on the device from a
computer. You do not need a USB connection.

7 On the settings screen, tap Connected devices > LG AirDrive.

7 Useasingle LG account to sign in to LG Bridge on the computer and
LG AirDrive on the device.
+ LG Bridge software can be downloaded from www.lg.com.

3 Manage files on the device from the computer.
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MirrorLink

You can connect the device to a car via USB to use the MirrorLink app
installed on the device from the infotainment system or the head unit of
the car

- This app is available only in cars that support MirrorLink.

+ Download the MirrorLink app from an app store or market. For more
information, visit https7//mirrorlink.com/apps.

- Some functions may be restricted for driver's safety while using the
MirrorLink feature.

1 On the settings screen, tap Connected devices > MirrorLink.

2 Connect the device to an automobile using the USB cable and turn on
Connect via USB cable.

L;'] « If your device is connected to a vehicle that supports automatic
MirrorLink connection, connect via USB cable is automatically activated

on your device.
- Tap : to configure MirrorLink USB auto-connect.

Printing
You can connect your device to a Bluetooth printer and print photos or
documents saved on the device.
On the settings screen, tap Connected devices > Printing.
- Tap Default Print Service to search for printers you can connect to. Or,
tap : > Add printer to manually add a printer.
+ Tap (+) Add service to download the printer app you want.

E « This is available only when the mobile network or the Bluetooth
function is turned on.
- To down the printer app in (+) Add service, first log on to your Google
account.
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Sound

You can customise sound, vibrate and notification settings.
On the settings screen, tap Sound and customise the following settings:

- Sound profile: Change the sound mode to Sound, Vibrate only, or
Silent.

+ Volume: Adjust the sound volume for various items.
- Ringtone: Select a ringtone for incoming calls. Add or delete ringtones.

- Notification sound: Select a notification ringtone. Set music saved on
the device as a notification ringtone.

- Ring with vibration: Set the device to vibrate and play a ringtone
simultaneously.

- Ringtone ID: Create a ringtone for an incoming call from a particular
contact.

- Flash alert for incoming call: Set the flash to blink according to LG
ringtone.

- Do not disturb: Set the time, range and app type to receive
notification messages. Receive notification messages only on particular
days of the week.

- Sound quality and effects: Use the function to set the sound quality
and effects while playing a song or video.

- Vibration strength: Adjust the vibration intensity.

- Vibration type: You can select the type of vibration when receiving
calls.

- Vibrate on tap: Set the device to vibrate when you tap certain items
on the screen.

- Dialing keypad sound: Enable the keypad sound effect.
- LG Keyboard sound: Enable LG keyboard sound effect.
+ Touch sound: Enable a sound effect for tapping an item.

+ Screen lock sound: Enable a sound effect when the screen is locked
or unlocked.
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Display
You can customise detailed settings for each screen type.
On the settings screen, tap Display and customise the following settings:

- Home screen: Customise settings for the Home screen. See Home
screen settings for details.

- Wallpaper & theme: Select a screen wallpaper, theme, icon, and AOD
for your device.

- Font: Change the font size, bold text or type.

- New Second Screen: Select how the status bar and app corners will
look.

- Navigation bar: Set the navigation bar style. See Changing the style of
the Home touch buttons for details.

- AOD(always-on display): Always display information, such as the date,
time and notifications, even when the screen is turned off. For details,
see AOD(always-on display).

+ Comfort view: Set the device to reduce amount of blue light on screen
to reduce eye strain.

- Night mode: You can apply a dimmed screen theme to avoid glare on
the screen at night time.

« Screen colour: Adjust the colour, colour temperature, or RGB values for
the desired screen.

E - Tap®) toreset the settings.
- Video enhancement: \When playing back a video in full screen mode,

you can change the settings for brighter and more dynamic colour
display.

Settings 162



- App scaling: Adjust the screen size of apps.

Aspect ratio
+ This device uses 19.5:9 aspect ratio.
- Some downloaded apps may not support 19.5:9 aspect ratio.

In this case, select the most optimal screen ratio for the app or
consult the app provider for more information.

- You can select the aspect ratio for individual apps by tapping O >
Settings > Display > App scaling. Select the desired aspect ratio
from Compatibility (16:9), Standard (16.7:9), and Full screen.

- Display size: Set the items on the screen to a size easy for you to see.
Some items may change position.

- Screen resolution: Adjust the screen resolution.

E + When you change the screen resolution, currently running apps are
closed.

Brightness: Use the slide bar to change the device's screen brightness.

Auto: Set the device so that the screen brightness is automatically
adjusted in accordance with the ambient light intensity.

Screen timeout: Automatically turn off the screen when the device is
left idle for a specified period of time.

Auto-rotate screen: Automatically rotate the screen according to the
device's orientation.

Screen saver: Display a screen saver when the device is connected to
the holder or charger. Select a screen saver type to display.

One-handed screen: Make the screen size smaller to conveniently use
the device with one hand. Drag the Home touch button at the bottom
of the screen to the left or right.
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Lock screen & security

You can customise lock screen and security settings.
7 On the settings screen, tap Lock screen & security.
2 Customise the settings.
- Google Play Protect: Scans your device daily for potentially harmful
apps.
- Find My Device: Remotely track the device location. You can also
protect your data securely if you lost your device.

- Security update: Check for software update and configure
automatic installation settings.

- Google Play system update: Check for Google Play system update.

- Select screen lock: Select the desired screen lock method. See
Setting a screen lock for details.

- Customise Lock screen: Change the information displayed on the
locked screen.

- Secure lock settings: Change the secure lock settings.

- Fingerprints: Use your fingerprint to unlock the screen or content.
See Fingerprint recognition overview for details.

- Face Recognition: Allow you to unlock the screen with your face.
See Face Recognition overview for details.

- Content lock: Allow you to set a lock type (password or pattern)
for your QuickMemo+ and Gallery files.

- Encryption & credentials: Configure the settings for SD card
encryption and credentials.

- Encrypt SD card: Encrypt the memory card to prevent use on
another device. See Memory card encryption for details.

- Secure start-up: Protect your device with a lock when it powers
on. See Secure start-up settings for details.

- Credential protection: View the type of the storage where the
security certificate will be saved.
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- Trusted credentials: View your system's root CA certificates and
user-installed CA certificates.

- User credentials: View and change secure certificate information
stored on your device.

- Install from storage: Install a secure certificate from a storage.

- Clear credentials: Delete user-installed secure certificates and
related credentials.

Set up SIM card lock: Lock or unlock the USIM card, or change the

password (PIN).

Phone administrators: Allow privileges to restrict the control or

use of the device to particular apps.

Trust agents: View and use trust agents installed on the device.

Screen pin: Fix the app screen so that only the currently active app

can be used.

Usage access: VView details on usage of apps on the device.

Privacy
You can find and adjust all your privacy settings.
71 Onthe settings screen, tap Privacy.

2 Customise the settings.

Permission manager: Allows you to check and change the
permissions granted to the apps.

Lock screen: Allows you to set natifications to show on the lock
screen.

Make passwords visible: Enable this option to briefly show each
character of the password as you type it so you can see what you've
entered.
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« Auto-fill service from Google: Enable this option to enter your
information saved in your account such as password, address,
or credit card number with a single tap. You can also disable this
option, use the Google Autocomplete feature, or add a new service
account.

-+ Google Location History: Allows you to enable or disable Location
History. When enabled, Google periodically stores and uses your
phone's most recent location data in connection with your Google
Account.

From the Location History screen, tap : to view and/or manage
your location data.

Activity controls: Select activities and information which you want
Google to save.

+ Ads: Allows you to check the advertising ID and set the personalised
ads.

- Usage and diagnostics: Enable this option to help improve the
Android experience by automatically sending diagnostic, device, and
app usage data to Google.

Location

You can check how your location information is shared and configure the
permission to access your location information.

On the settings screen, tap Location and set the desired function.
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Extensions

Smart Doctor

You can use Smart Doctor to diagnose the device's condition and optimise
it.

On the settings screen, tap Extensions > Smart Doctor.

Context Awareness

You can automatically change your device settings according to the usage
pattern and location.

7 Onthe settings screen, tap Extensions > Context Awareness.

7 Activate items you want to automatically change settings for.

- Parking Assistant: This option will store your parking locations. If
you don't want to receive parking notifications around your home or
work place, turn My places notifications off Q). The parking records
are stored in QuickMemo-+.

+ AUTOMATED: You can set the device to change the sound
profile, Bluetooth and Wi-Fi options automatically in different
environments, such as At home, Away from home, At work, and Off
work. You can also set an app to open when earphones are plugged
in or a Bluetooth device is connected.

E « To use this feature, home or work location must be preset in My places.
On the settings screen, tap Location > My places to set the locations.
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Gaming
You can configure settings for game tools, graphics and battery saving
feature.
7 On the settings screen, tap Extensions > Gaming.
2 Customise the following settings:
- Game Launcher: Tap QD to use the game launcher.

- Game tools: You can run the function while playing games by
touching the game tools icon among the home touch buttons.

- Game graphics: Adjust the game graphics.

E + When you change the resolutions on some games, the screen display
feature may not work properly.

« This function may not be available in certain game apps.

- Break time: Reduce the screen brightness and performance
whenever you leave the game running for more than 5 minutes.

Screen recording
You can configure the settings for screen recording.

T On the settings screen, tap Extensions > Screen recording.

2 Customise the following settings:
+ Include yourself in video by: Select one from the following options
and tap Save.

- Image:Includes your profile image in video when recording. After
selecting this, tap @ and select a profile image. Then, adjust the
size of the image using the slide bar.

- Front camera:Includes yourself recorded using the front camera
while recording the screen.

- Never: Nothing is included.

+ Audio source: Choose the audio source between Mic and

Contents.

- Video resolution: Select the resolution for screen recording.
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To record the screen

1 Drag the status bar downward to open the Quick access icons list.

2 (If necessary, swipe left over the Quick access icons area.) Tap Gl

3 Read the disclaimer and tap Start. It will start recording in 3 seconds.

4 To stop recording, tap () located at the bottom right of the screen.
The recorded video will be saved in Gallery.

E - If you violate another person's rights such as portrait right or intellectual
property right or defame another person’s reputation by using the
functions provided for the screen recording service, you may be held
liable to civil, criminal or administrative charges in accordance with the
relevant laws. LG Electronics is not legally responsible in any way for the
acts of users.

Dual App

You can install duplicate messenger apps on the product and use two
accounts at the same time.

1 On the settings screen, tap Extensions > Dual App.
2 After reading the disclaimer, tap Confirm.

3 Inthe list of available apps, tap Install to install a copy of a desired app
and follow the on-screen instructions.

+ On the screen, the list of available dual apps is shown. During
installation, app icons are generated on the home screen.

Floating Bar

You can activate frequently used features including shortcuts,
screenshots, Music, Contacts and more by touching and then swiping the
Floating Bar on the screen. See Floating Bar overview for details.
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Shortcuts

You can use buttons such as the Lock/Power, Volume, and Google
Assistant to run certain apps or functions right away.

71 Onthe settings screen, tap Extensions > Shortcuts.

2 Customise the following settings.

+ View notification panel: Swipe down/up on the fingerprint sensor
for the notification panel.

- Open Camera: Press Power key twice to open Camera.

- Open Capture+: Press Volume Up key twice to open Capture+
when the screen is locked or off.

- Open Camera: Press Volume Down key twice to open Camera
when the screen is locked or off.

- Open Google Assistant: Press the Google Assistant key on the
side of the phone.

- Talk to Google Assistant: Press and hold the Google Assistant key
to quickly talk to your Assistant.

- Show visual snapshot: Press the Google Assistant key twice to see
a snapshot of your day in the Google Assistant app.

E + Google Assistant does not support certain languages.

KnockON

Double-tap the screen to turn the screen on or off.
See KnockON for details.

Increase touch sensitivity

You can set the touch screen more sensitive to your touch. Recommended
to turn this feature on when using a screen protector.

On the settings screen, tap Extensions > Increase touch sensitivity.
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Digital Wellbeing & parental
controls

You can view the product use time and set the timer for each app.
Also, you can manage the mobile phone use time by using the Sleep
Preparation Mode and Focus Mode.

Select Digital Wellbeing & parental controls on the settings screen and
set the desired function.

Apps & notifications

You can check a list of installed apps, and configure the settings for
notifications, app permissions, and more.

T On the settings screen, tap Apps & notifications.

2 Customise the settings.

Battery

You can view the current battery information or turn on power-saving
mode.
71 Onthe settings screen, tap Battery.
2 Customise the following settings:
- Battery usage: View the battery usage details.

- Battery percentage on status bar: Display the remaining battery
level as a percentage on the status bar.

- Optimized charging: Automatically adjust charging speed according
to how you charge to reduce heat and extend lifespan of battery.

- Adaptive battery: Allow you to save the battery by stopping apps
running in the background.
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- Background restrictions: Enable this option to restrict background
apps to save the battery while using the device. Restricted apps
for power saving may not work properly or may not send you
notifications.

- Battery saver: Reduce battery consumption by cutting down some
device settings, such as the display brightness, speed and vibration
intensity.

- Power saving exclusions: Select apps to use without any
functional limitation while in power saving or battery optimisation
mode.

Storage

You can view and manage internal storage on the device or storage space
of the memory card.

1 On the settings screen, tap Storage.

2 Customise the following settings:

- Internal shared storage: View the total storage space and free
space in the device’s internal storage. View a list of apps in use and
the storage capacity for each app.

+ SD card: View the total storage space and free space in the
memory card. This option appears only when a memory card is
inserted. To unmount the memory card, tap

Accounts

You can add users to share your device and register a cloud account.
1 On the settings screen, tap Accounts.

2 Customise the settings.
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Google

You can use Google settings to manage your Google apps and account
settings.

On the settings screen, tap Google.

System

Update centre

You can check and install the latest version of the app or software
provided by LG.

1 On the settings screen, tap System > Update centre.

2 Customise the following settings:

+ App Updates: Check if an app update is available. If available, you
can install the update.

- Software Update: Check if a software update is available. If
available, you can install the update.

Language & keyboard

You can customise language and keyboard settings for your device.
1 On the settings screen, tap System > Language & keyboard.

2 Customise the following settings:
- Language: Select a language to apply for the device.

- Manage keyboards: You can change the product’s basic keyboard
setting, set the use environments for LG Keyboard or other installed
keyboards, and set the speech recognition function for Google Voice
input. Also, you can set whether to display the keyboard button in
the touch button area on the home screen so that you can quickly
switch to another keyboard.
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Physical keyboard: Select to use the physical keyboard, or check
keyboard shortcut keys.

Autofill service: Enable this option to enter your information saved
in your account such as password, address, or credit card number
with a single tap. You can also disable this option, use Google
Autocomplete, or add a new service account.

Text-to-speech output: Configure the settings for text-to-speech
output.

Pointer speed: Adjust the pointer speed of a mouse or trackpad.

Reverse mouse buttons: Reverse the right mouse button to
perform primary direct-manipulation actions.

Date & time
You can customise date and time settings for your device.
1 On the settings screen, tap System > Date & time.

2 Customise the settings.

Memory

You can view the average amount of memory usage over a certain period
of time and the memory occupied by an app.

7 On the settings screen, tap System > Memory.

7 Tap w to set a time slot to retrieve data.
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Backup

You can back up data saved on your device to another device or account.
T On the settings screen, tap System > Backup.

2 Customise the following settings:
+ LG Mobile Switch: Allow you to transfer data from an old LG device
to your new LG device. See LG Mobile Switch for detalls.

- Backup & restore: Back up your device data or restore data to your
device from a backup.

A + Resetting your device may delete backup files saved in storage. Make
sure to copy and store the important backup files to your PC.

+ Google backup: Change Google drive backup settings. You can
also check the backup account currently used, or add a new backup
account.

Restart & reset
You can reset the device including network and app settings.
7 Onthe settings screen, tap System > Restart & reset.

2 Customise the following settings:

- Auto-restart: Automatically restart and optimise the phone at a
set time. Tap QD to activate this feature. The device automatically
restarts at a set time and optimise itself: Select a date and time for
restart.
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E + You can set the device to restart itself once a week. The device
automatically restarts in an hour from the preset time.

« Once the device restarts, notifications and badges are erased. Save
important data before the preset time.

« The Auto-restart feature is not activated in the following situations:
When the screen is turned on, when the device is in use, when the
battery levelis 30% or less, when the USIM card is locked, or when the
device lock is activated while turning on the device.

- Depending on the telecommunication provider, the auto-restart
function may or may not be available.

- Network settings reset: Reset Wi-Fi, Bluetooth and other network
settings.

- Reset app preferences: Reset the settings for an app. The data
saved in the app will not be deleted.

- Factory data reset: Reset all settings for the device and delete
data.

E + Restarting and resetting your device deletes all data on it. Enter your
device name, Google Account and other initial information again.

« After data initialisation, the data cannot be restored.

About phone

You can view information about your device, such as the name, status,
software details and legal information.

On the settings screen, tap System > About phone and view information.

Regulatory & safety
You can view regulatory marks and related information on your device.
On the settings screen, tap System > Regulatory & safety.
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Accessibility
You can manage accessibility plug-ins installed on your device.
T On the settings screen, tap Accessibility.

2 Customise the following settings:

- Vision > TalkBack: Set the device to notify screen status or actions
via voice.

- Vision > Voice notifications: Set the device to read the caller
information via voice.

- Vision > Font: Change the font size, bold text or type.

- Vision > Display size: Set the items on the screen to a size easy for
you to see. Some items may change position.

« Vision > Touch zoom: Zoom in or out by tapping the screen three
times.

- Vision > Window zoom: Zoom in or out within a window and invert
the colour.

- Vision > Large mouse pointer: Magnify the mouse pointer.

- Vision > High contrast screen: Turn the background colour into
black for a high contrast screen.

- Vision > Screen colour inversion:Increase the display colour
contrast for people with low vision.

+ Vision > Screen colour adjustment: Adjust the display colour.
- Vision > Monochrome: Switch the screen to grayscale mode.

« Vision > End call with the Power key: End a call by pressing the
Power/Lock key.

« Hearing > Captions: Turn on the subtitle service when playing
videos for the hearing impaired.

+ Hearing > Blink LED: Indicate device status via LED.

- Hearing > Flash alerts: Set the device to notify you with a blinking
light for incoming calls, messages and alarms.
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- Hearing > Mute all sounds: Mute all sounds and lower volume on
the receiver.

+ Hearing > Audio channel: Select the audio type.

+ Hearing > Sound balance: Adjust the audio output balance. Use the
slide bar to change the balance.

+ Motor & cognition > Touch assistant: Turn on the touch board to
make buttons and gestures easier to use.

+ Motor & cognition > Touch input: Enter text by touching and
holding the screen or modify it by simply touching the screen.

- Motor & cognition > Physical keyboard: Customise the keyboard
settings.

+ Motor & cognition > Auto mouse click: Automatically click the
mouse pointer in case of no movement.

+ Motor & cognition > Touch and hold for calls: Answer or decline
calls by touching and holding the call button instead of dragging it.

+ Motor & cognition > Screen timeout: Turn off the screen
automatically when the device is left idle for a specified period of
time.

+ Motor & cognition > Touch control areas: Limit the touch area
so that only a particular portion of the screen can be controlled by
touch input.

+ Accessibility features shortcut: Quickly access a frequently used
function by tapping O three times.

- Auto-rotate screen: Automatically change the screen orientation
according to the physical position of the device.

- Amazon Assistant: Amazon Assistant provides product
comparisons automatically as you shop in select apps on your
device.

- Select to Speak: Allow you to tap items to hear spoken feedback.

+ Switch Access: Create key combinations to control your device.
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Language Settings
Select a language to use on your device.
- Tap O > Settings > System > Language & keyboard > Language >
Add language, and select a language.
- Touch and hold = and drag it to the top of the language list to set it
as a default language.

LG Bridge

LG Bridge overview

LG Bridge is an app that helps you manage the photos, music, videos

and documents saved on your LG smartphone from your computer
conveniently. You can back up contacts, photos and more to the computer
or update the device software.

E + See LG Bridge help for details.
+ The supported features may vary depending on the device.

+ LG USB driver is a necessary program to connect your LG smartphone
with the computer and is installed when you install LG Bridge.

LG Bridge functions
+ Manage the files on the device from a computer via Wi-Fi connection
or mobile data connection.

+ Back up data from the device to a computer or restore data from a
computer to the device via USB cable connection.

+ Update the device software from a computer via USB cable connection.
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Installing LG Bridge on a computer
1 Go to wwwilg.com from your computer.
2 Select your region.
3 Click Support > Software & Firmware.
4 Enter the name of your device.
OR
Select by the Product Category.
5 Go to PC Sync > LG Bridge to download the setup file.

+ Go to Details to view the minimum requirements for installing
LG Bridge.

Phone software update

LG Mobile phone software update from the

Internet

For more information about using this function, please visit
http//wwwi.lg.com/common/index,sp, select your country and language.
This feature allows you to conveniently update the firmware on your
phone to a newer version from the Internet without needing to visit a
service centre. This feature will only be available if and when LG makes a
newer firmware version available for your device.

Because the mobile phone firmware update requires the user's full
attention for the duration of the update process, please make sure

you check all instructions and notes that appear at each step before
proceeding. Please note that removing the USB cable during the upgrade
may seriously damage your mobile phone.

+ LG reserves the right to make firmware updates available only for

selected models at its own discretion and does not guarantee the
availability of the newer version of the firmware for all handset models.
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LG Mobile Phone software update via Over-
the-Air (OTA)

This feature allows you to conveniently update your phone's software to
a newer version via OTA, without connecting a USB cable. This feature will

only be available if and when LG makes a newer firmware version available
for your device.

To perform the phone software update,

Settings > System > Update centre > Software Update > Check now
for update.

E « Your personal data from internal phone storage—including information
about your Google Account and any other accounts, your system/
application data and settings, any downloaded applications and your
DRM licence—might be lost in the process of updating your phone's
software. Therefore, LG recommends that you backup your personal
data before updating your phone’s software. LG does not take
responsibility for any loss of personal data.

« This feature depends on the area or service provider.
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Anti-Theft Guide

Set up your device to prevent other people from using it if it's been reset

to factory settings without your permission. For example, if your device is

lost, stolen, or wiped, only someone with your Google Account or screen

lock information can use the device.

All you need to make sure your device is protected is:

- Set a screen lock: If your device is lost or stolen but you have a screen

lock set, the device can't be erased using the Settings menu unless
your screen is unlocked.

+ Add your Google Account on your device: If your device is wiped but
you have your Google Account on it, the device can't finish the setup
process until your Google Account information is entered again.

After your device is protected, you'll need to either unlock your screen or
enter your Google Account password if you need to do a factory reset.
This ensures that you or someone you trust is doing the reset.

E « Do not forget your Google Account and password you had added to
your device prior to performing a factory reset. If you can't provide the
account information during the setup process, you won't be able to use
the device at all after performing the factory reset.
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Open Source Software Notice
Information

To obtain the source code under GPL, LGPL, MPL, and other open
source licenses, that is contained in this product, please visit
http://opensource.lge.com.

In addition to the source code, all referred license terms, warranty
disclaimers and copyright notices are available for download.

LG Electronics will also provide open source code to you on CD-ROM
for a charge covering the cost of performing such distribution (such
as the cost of media, shipping, and handling) upon email request to
opensource(@lge.com.

This offer is valid for a period of three years after our last shipment of this
product. This offer is valid to anyone in receipt of this information.

Regulatory information
(Regulation ID number, E-labeling, etc.)

For regulatory details, go to Settings > System > Regulatory & safety.
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Trademarks

« For DTS patents, see http//patents.dts.com. Manufactured under
license from DTS Licensing Limited. DTS, the Symbol, & DTS and the
Symbol together, DTS, and the DTSX logo are registered trademarks
or trademarks of DTS, Inc. in the United States and/or other countries.
© DTS, Inc. All Rights Reserved.

' ®
dts

ek

—

LG Boombox Edition

+ Copyright ©2020 LG Electronics, Inc. All rights reserved. LG and the
LG logo are registered trademarks of LG Group and its related entities.

- V50 ThinQ is a trademark of LG Electronics, Inc.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play,
Android, Chrome, Google Photos, Google Play Protect, Google Calendar,
Google Docs, Google Drive, Google Sheets and other related marks and
logos are trademarks of Google LLC.

- Bluetooth®is a registered trademark of Bluetooth SIG, Inc. worldwide.

- Wi-Fi® and the Wi-Filogo are registered trademarks of the Wi-Fi
Alliance.

- All other trademarks and copyrights are the property of their
respective owners.

HE HEVC \dvance”

Covered by Patents at patentlisthevcadvance.com
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Laser safety statement

Caution!

This product employs a Laser system. To ensure proper use of this
product, please read this owner's manual carefully and retain for future
reference. Should the unit require maintenance, contact an authorised
service centre.

Use of controls, adjustments, or the performance of procedures other
than those specified herein may result in hazardous radiation exposure.
To prevent direct exposure to laser beam, do not try to open the enclosure
or make direct contact with the laser.

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT
LUOKAN 1 LASER LAITE

KLASS 1 LASER APPARAT
CLASSE 1 PRODUIT LASER
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DECLARATION OF CONFORMITY

Hereby, LG Electronics declares that this LM-V500EM product is in
compliance with the essential requirements and other relevant provisions
of Directive 2014/53/EU.

A copy of the Declaration of Conformity can be found at
http//wwwi.lg.com/global/declaration

Contact office for compliance of
this product

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands

Wi-Fi (WLAN)

The use of the 5150 - 5350 MHz band is restricted to indoor use only.

AT |BE|BG|CH|CY|CZ|DE|DK|EE|EL|ES|Fl |FR

QHR HU|IE | IS|IT| L |LT|LU|LV|MT|NL|NO|PL

PT |RO|SE| SI'| SK|UK|AL |ME|RS |MK|TR|BA | XK
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More information

Tempered glass parts

Tempered glass parts of this device are not permanent and they may wear
out over time.

- If you drop your device on a hard surface or subject it to severe impact,
the tempered glass may be damaged.

If this happens, stop using your device immediately and contact an LG
Customer Service Centre.

- You can purchase protective cases to protect your device from damage
on the market.

Note that these protective cases are not covered under the warranty
service provided by LG Electronics and safety is not guaranteed.
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Guide to data transfers

- For the data that can be exchange between LG devices or between the

LG device and a third party device, see the following table.

Third party
LG device Android iOS device
Type Item details - device —
LG device - LG device
LG device

Contacts, messages,

dial logs, calendar, voice @) O O
Personal | recordings
data Memos X O

Alarms X X
Media Photos, videos, songs,
data documents o o O

Home screen settings

(folders and widgets) % X X
Screen
settings Lock screen settings

(screen lock settings @) X X

excluded)

Downloaded apps O O
Apps Personal data of the o X B

downloaded app

Public certificate @) @) X
Others | Settings (Wi-Fi, Bluetooth,

Calls, sound & notification, @) X X

accessibility, battery)

E + Some data may not be transmitted depending on the software version,
app version, operating system, manufacturer or service provider's policy.
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Supported Frequency Bands Transmitter Output power

GSM 900 33.7dBm

GSM 1800 30.7dBm

WCDMA B1 252dBm

WCDMA B8 25.5dBm

LTEB1 252 dBm

LTEB3 252dBm

LTEB7 252 dBm

LTE B8 25.5dBm

LTE B20 255dBm

LTEB28 255 dBm

LTEB38 25.5dBm

LTE B40 252 dBm

SGNRN78 232dBm

BT 2.4GHz 12.5dBm

WLAN 2.4GHz 19.5dBm

WLAN 5.15~5.725GHz 19.0 dBm

WLAN 5.725~5.875GHz 14.5 dBm
NFC -22 dBuA/m

Dual Screen 60.75GHz 1.0dBm
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Disposal of your old appliance

1. This crossed-out wheeled bin symbol indicates that waste electrical
and electronic products (WEEE) should be disposed of separately
from the municipal waste stream.

N 2 Old electrical products can contain hazardous substances so correct
disposal of your old appliance will help prevent potential negative
consequences for the environment and human health. Your old
appliance may contain reusable parts that could be used to repair
other products, and other valuable materials that can be recycled to
conserve limited resources.

3. You can take your appliance either to the shop where you purchased
the product, or contact your local government waste office for
details of your nearest authorised WEEE collection point. For
the most up to date information for your country please see
wwwi.lg.com/global/recycling

Disposal of waste batteries/accumulators

1. This symbol may be combined with chemical symbols for mercury
(Hg), cadmium (Cd) or lead (Pb) if the battery contains more than
0.0005% of mercury, 0.002% of cadmium or 0.004% of lead.

2. All batteries/accumulators should be disposed separately from the

municipal waste stream via designated collection facilities appointed
by the government or the local authorities.

3. The correct disposal of your old batteries/accumulators will help
to prevent potential negative consequences for the environment,
animal and human health.

4. For more detailed information about disposal of your old batteries/
accumulators, please contact your city office, waste disposal service
or the shop where you purchased the product.
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FAQ

This chapter lists some problems you might encounter when using your
device. Some problems require you to call your service provider, but most
are easy to fix yourself.

SIM card error
Make sure the SIM card is correctly inserted.

No network connection or dropped network
Signal is weak. Move to a window or an open area.
You are outside the carrier network area. Move and check the network.

Calls are not available

New network not authorised.

Make sure you have not set call barring for the incoming number:
Make sure you have not set call barring for the number you are dialling.

Device cannot be turned on
When the battery is completely discharged, your device will not turn on.
Fully charge the battery before turning on the device.

Charging error

Make sure device is charging at a normal temperature.
Check the charger and its connection to the device.

Use only in-box accessories which are authorised by LG.

The battery depletes faster than when first purchased

When you expose the device or the battery to very cold or hot
temperatures, the battery life may be reduced.

Battery consumption will increase when you use certain features or apps,
such as GPS, games or the Internet.

The battery is consumable and the battery life will get shorter over time.
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Error messages appear when launching the camera
Charge the battery.

Free some memory by transferring files to a computer or deleting files
from your device.

Restart the device.

If you are still having trouble with the camera app after trying these tips,
contact a LG Electronics Service Centre.

The photo quality is poor
The quality of your photos may vary, depending on the surroundings and
the photography techniques you use.

If you take photos and videos, standard angle quality is better than wide-
angle.

If you take photos in dark areas, at night or indoors, image noise may
occur or images may be out of focus.

If you have any problems, reset the options.

The touch screen responds slowly or incorrectly

If you attach a screen protector or optional accessories to the touch
screen, the touch screen may not function properly.

If you are wearing gloves, if your hands are not clean while touching the
touch screen or if you tap the screen with sharp objects or your fingertips,
the touch screen may malfunction.

The touch screen may malfunction in humid conditions or when exposed
to water.

Restart your device to clear any temporary software bugs.

If the touch screen is scratched or damaged, visit a LG Electronics Service
Centre.
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Hangs or freezes

Restart the device

- If your device freezes or hangs, you may need to close apps or turn the
device off and then on again.

Perform a boot-up

- Asoft reset may be used to reset the device if the screen freezes, or
the buttons, touch screen or device are no longer responding.

- To perform a soft reset of your device, simply press and hold the
Volume Down and Power keys until the device restarts.

Reset the device
- If the methods above do not solve your problem, perform a factory
datareset.
- On the settings screen, tap System > Restart & reset > Factory data
reset.

- This method resets all settings for the device and deletes data.
Before performing the factory data reset, remember to make back-
up copies of all important data stored in the device.

- If you registered a Google Account to the device, you must sign in to
the same Google Account after resetting the device.
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Bluetooth device is not located
Make sure the Bluetooth wireless feature is activated on your device.

Make sure the Bluetooth wireless feature is activated on the device you
wish to connect to.

Make sure your device and the other Bluetooth device are within the
maximum Bluetooth range (10 m).

If the tips above do not solve your problem, contact a LG Electronics
Service Centre.

A connection is not established when you connect the
device to a computer
Make sure the USB cable you are using is compatible with your device.

Make sure you have the proper driver installed and updated on your
computer.

Downloaded application causes a lot of errors
Application has problems.
Remove and reinstall the application.
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LG Dual Screen
(LM-V5S05N)



Getting to Know LG Dual Screen

You can connect an LG Dual Screen (LM-V505N) to this product for use.

E + You can connect the LG dual screen (hereinafter “product”) to a
dedicated mobile device (hereinafter “mobile phone”), to use the
product.

+ Depending on the performance of the a dedicated mobile phone, some
features of Dual Screen may be limited. Also, the product may not
support other mobile devices.

This product is not water resistance. Do not expose the device to liquid
or moisture.

« If the device is wet, the LDl located inside the device changes in colour.
In this case, the device is ineligible for any free-of-charge repair services
provided under the device's limited warranty.

« Your device has a dedicated receiver (57~66GHz) built-in for the V50
ThinQ.

Guidelines for safe and efficient use

Please read these simple guidelines. Not following these guidelines may be
dangerous or illegal.

Should a fault occur, a software tool is built into your device that will gather a
fault log. This tool gathers only data specific to the fault, such as signal strength,
cell ID position in sudden call drop and applications loaded. The log is used only to
help determine the cause of the fault. These logs are encrypted and can only be
accessed by an authorised LG Repair centre should you need to return your device
for repair.

Exposure to radio frequency energy
Radio wave exposure and Specific Absorption Rate (SAR) information.

This device has been designed to comply with applicable safety requirements for
exposure to radio waves. These requirements are based on scientific guidelines that
include safety margins designed to assure the safety of all persons, regardless of
age and health.
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+ The radio wave exposure guidelines employ a unit of measurement known
as the Specific Absorption Rate, or SAR. Tests for SAR are conducted using
standardised methods with the device transmitting at its highest certified
power level in all used frequency bands.

While there may be differences between the SAR levels of various LG device
models, they are all designed to meet the relevant guidelines for exposure to
radio waves.

+ The SAR limit recommended by the International Commission on Non-lonizing
Radiation Protection (ICNIRP) is 2 W/kg averaged over 10 g of tissue.

+ This device meets RF exposure guidelines when used either in the normal use
position against the ear or when positioned at least 5 mm away from the body.
When a carry case, belt clip or holder is used for body-worn operation, it should
not contain metal and should position the product at least 5 mm away from
your body. In order to transmit data files or messages, this device requires a
quality connection to the network. In some cases, transmission of data files
or messages may be delayed until such a connection is available. Ensure the
above separation distance instructions are followed until the transmission is
completed.

Product care and maintenance

+ Use only in-box accessories which are authorised by LG. LG does not guarantee
any damage or failure which is caused by third party accessories.

+ Some contents and illustrations may differ from your device without prior
notice.

+ Do not disassemble this unit. Take it to a qualified service technician when repair
work is required.

+ Repairs under warranty, at LG's discretion, may include replacement parts
or boards that are either new or reconditioned, provided that they have
functionality equal to that of the parts being replaced.

- Keep away from electrical appliances such as TVs, radios and personal
computers.

+ The unit should be kept away from heat sources such as radiators or cookers.
+ Do not drop.

+ Do not subject this unit to mechanical vibration or shock.
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Switch off the device in any area where you are required to by special
requlations. For example, do not use your device in hospitals as it may affect
sensitive medical equipment.

Do not handle the device with wet hands while it is being charged. It may cause
an electric shock and can seriously damage your device.

Use a dry cloth to clean the exterior of the unit (do not use solvents such as
benzene, thinner or alcohol).

Do not subject this unit to excessive smoke or dust.

Do not keep the device next to credit cards or transport tickets; it can affect the
information on the magnetic strips.

Do not tap the screen with a sharp object as it may damage the device.

Do not expose the device to liquid or moisture.

Use accessories like earphones cautiously. Do not touch the antenna
unnecessarily.

Do not use, touch or attempt to remove or fix broken, chipped or cracked glass.
Damage to the glass display due to abuse or misuse is not covered under the
warranty.

Your device is an electronic device that generates heat during normal operation.
Extremely prolonged, direct skin contact in the absence of adequate ventilation

may result in discomfort or minor burns. Therefore, use care when handling your
device during or immediately after operation.

If your device gets wet, immediately unplug it to dry off completely. Do not
attempt to accelerate the drying process with an external heating source, such
as an oven, microwave or hair dryer.

The liquid in your wet device, changes the colour of the product label inside your
device. Damage to your device as a result of exposure to liquid is not covered
under your warranty.

A product requires proper air circulation in order to dissipate heat. Direct skin
contact and inadequate circulation of air flow to the device may cause the device
to overheat. The device must be at least 1.0cm from between the user's body.

Please ensure that the product does not get in contact with liquid. Do not use
or recharge the product if it is wet. Once the product becomes wet, the liquid
damage indicator changes colour. Please note that this will limit you from
receiving any free-of-charge repair services provided under warranty.
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Efficient device operation

Electronics devices
All devices may receive interference, which could affect performance.

+ Do not use your device near medical equipment without requesting permission.
Please consult your doctor to determine if operation of your device may
interfere with the operation of your medical device.

+ Pacemaker manufacturers recommend that you leave at least 15 cm of space
between other devices and a pacemaker to avoid potential interference with the
pacemaker.

+ This device may produce a bright or flashing light.
+ Some hearing aids might be disturbed by devices.

+ Minor interference may affect TVs, radios, PCs etc.

Use your device in temperatures between 0 °C and 40 °C, if possible. Exposing
your device to extremely low or high temperatures may result in damage,
malfunction, or even explosion.

Road safety

Check the laws and regulations on the use of devices in the area when you drive.
+ Do not use a hand-held device while driving.
+ Give full attention to driving.

+ Pull off the road and park before making or answering a call if driving conditions
S0 require.

+ RF energy may affect some electronic systems in your vehicle such as car
stereos and safety equipment.

+ When your vehicle is equipped with an air bag, do not obstruct with installed
or portable wireless equipment. It can cause the air bag to fail or cause serious
injury due to improper performance.

- If you are listening to music whilst out and about, please ensure that the volume
is at a reasonable level so that you are aware of your surroundings. This is of
particular importance when near roads.
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Glass Parts

Some parts of your device are made of glass. This glass could break if your device is
dropped on a hard surface or receives a substantial impact. If the glass breaks, do
not touch or attempt to remove it. Stop using your device until the glass is replaced
by an authorised service provider.

Blasting area

Do not use the device where blasting is in progress. Observe restrictions and follow
any regulations or rules.

Potentially explosive atmospheres
+ Do not use your device at a refueling point.
+ Do not use near fuel or chemicals.

+ Do not transport or store flammable gas, liquid or explosives in the same
compartment of your vehicle as your device or accessories.

In aircraft
Wireless devices can cause interference in aircraft.
+ Turn your device off before boarding any aircraft.

- Do not use it on the ground without permission from the crew.

Children

Keep the device in a safe place out of the reach of small children. It includes small
parts which may cause a choking hazard if detached.
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Product components and

accessories
The following items are included with your product.
+ Product + Quick Start Guide

A + Some of the product parts are made of tempered glass. If you drop your
product on a hard surface or subject it to severe impact, the tempered
glass may be damaged. If this happens, stop using your product
immediately and contact an LG Customer Service Centre.

E + The appearance and specifications of your product are subject to
change without notice.
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Parts overview

LED Indicator

Volume button —E
help key

Google Assistant —
button help key

Space for
receiver hole

Product screen

Front Back
7= NN\\| (77 m
T I
] [EJ'— Hinge holder
7J-— Hinge holder
N 2
Unfolded
_.ﬁ | c—
=] Y N
«—— Space for
Power/Lock
button
Communication

_J /Power terminal

- Do not subject the product to strong impact such as dropping, pressing

or bending it. Pressing the product with excessive force may damage
the product.

I_;'] + The assistant keys and spaces in this product do not work
independently. Be sure to connect the product with V50 ThinQ.
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Inserting the mobile phone to the
product

7 Unfold the product completely.

f(ﬁgf—\\/ )
[E
[C
——)\\ ')

2 Make sure the screen of the mobile phone face upwards and insert
part 1 of the phone into the product as shown in the figure. At this
time, make sure that the communication/power terminal of the
product faces the same direction as that of the terminal of the mobile
phone.
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3 Press part 2 of the mobile phone with your fingertip until the phone
clicks into place.

[2)
= \ J

A + Be careful not to drop the product or the mobile phone while inserting
or removing the phone.

+ Be careful not to damage the product by pressing the phone too hard
when inserting or removing the phone from the product.

« Please make sure your phone is fully inserted into the product before
use.
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Removing the mobile phone from
the product

1 Unfold the product completely and hold it firmly with both hands as
shown in the figure.
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7 Press part 1 of the product with your finger and at the same time
press the back of the mobile phone with another finger to remove the

phone from the product.
o, _

———o
=

;@\V\% N

A « Part of the product is made of tempered glass. Dropping the product
on a hard surface or subjecting it to a strong impact may cause the
tempered glass to break or become worn, damaging the product or
causing injury.

- If this happens, stop using the product immediately and visit your
nearest LG Customer Service Centre for repair.

Do not use or charge the product when there is moisture in the
communication and power terminal of the product. This may cause fire,
electric shock, injury, or product malfunction. If there is moisture, stop
using the product immediately and remove the moisture completely.
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Using the Product

When making a phone call
When making a phone call, you can fold the product outward to 360 ° or
fold it inward to 0 °.
- If you are using the product by folding it 360 °, make sure that the
front and back of the product are in full contact. In this case, the screen
of the product automatically turns off to save the power.

360 ° 0°

+ You can press the Google Assistant key in order to receive an incoming
call while your mobile phone is inserted into the product.
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When using two screens
Unfold the product to put the two screens side by side.

Product ——————
screen

Mobile phone
screen

Using the Product Screen

When using the product screen and the phone screen at the same time,
colour difference may occur between the two screens.

« Try adjusting the colour temperature or RGB levels in O > Settings >
Display > Screen colour on your phone to minimise colour difference.

- Colours may look different depending on the viewing angle, so adjust
the colours in a fully unfolded state.

Using Dual Screen Home

Getting to Know Dual Screen Home

The Dual Screen Home can operate independently of the product’s screen.
« It provides quick launch icons and a home touch bar.
+ You can change the background and set up widgets.

+ On the home screen, you can also run different apps from the apps
drawer and generate or delete folders.
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Getting to know Dual Screen Home layout

You can use various functions by running the icons provided on the home
screen.

=— Quick access area

E + The background of the dual screen may differ from the figure depending
on the manufacturer's policies, user settings, software versions, services
provided by telecommunication providers, etc.

Quick access area: Fix main apps at the bottom of the screen so that
they can be accessed from any Home screen canvas.

+ Home touch buttons: You can swipe the bottom of the Home screen
upwards to see the hidden Home Touch buttons.

- < :Return to the previous screen. Close the keypad or pop-up
windows.

- (O :Tap to go to the Home screen.

- [ :Tap to view a list of recently used apps or run an app from the
list. To delete all the recently used apps, tap Clear all.
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Using the Dual Screen Panel

You can open the Dual Screen Panel by dragging down the top of the
screen.

- You can adjust the screen brightness on the Dual Screen Panel.

- If you activate synchronisation by selecting Sync, the screen
brightness of the dual screen comes in sync with that of the
connected product.

+ You can tap Capture+ to capture the product screen.

- You can save the captured image using QuickMemo+ or save it in
the Gallery.

+ You can turn off the product screen by tapping Dual Screen.
- The dual screen and the connected mobile phone are disconnected.
You can tap [ to enter the settings menu of the dual screen.

) &— Dual Screen settings
Adjust screen

e I:% *

Capture+ —g——=

l | Dual Screen
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Making Changes to Dual Screen Home
Press and hold an empty area on the dual screen home and run a desired
function.
- To add a widget to the Home screen, touch and hold down on a blank
area of the Home screen, then select Widgets.
- To change wallpapers, themes, and icons, touch and hold down on a
blank area of the Home screen, then select Wallpapers.
- To change the default screen, touch and hold down on a blank area of

the Home screen, move to desired screen, tap £}, then tap the screen
once more.

s —— Default screen

Widgets Wallpapers
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Viewing dual screen background

You can view only the background image by hiding the apps and widgets
on the Home screen.

Spread two fingers apart on the Home screen.

- Toreturn to the original screen, which displays apps and widgets, pinch
your fingers on the Home screen or tap <}
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Setting dual screen environment
You can set the dual screen environment on the mobile phone connected
to the dual screen.

1 Select O > Settings > Display > Dual Screen.

E + You must connect your mobile phone to the dual screen to see the
menu item for dual screen environment setting.

2 Select and set the desired functions.

+ Dual Screen Tool: If you connect your mobile phone to the dual
screen, the dual screen tools appear on the screen. The brightness
level is synchronised with that of the product.

- Use Dual Screen: You can turn on and off the dual screen, switch
screens between the mobile phone and the dual screen, and use the
apps.

Brightness: You can adjust the screen brightness by moving the
control bar to the left or right.

- Keep the same as main screen: You can synchronise the
brightness level with that of the connected mobile phone.

Wallpaper: You can select the wallpaper for the Home screen.

- App drawer icon: You can show or hide the App drawer on your
product.

My Pick App: Each time you turn on the dual screen, the preset
dual screen apps run automatically.

E « The list of apps that appear on the screen may differ depending on the
installed apps.
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Using Dual Screen Capture+

Capturing screen using Dual Screen Capture+
Pull down the status bar on the screen that you want to capture, and tap
7, Capture+.

- To save the captured image, tap @ and save it to the desired location.

- You can save the captured image using QuickMemo+ or save it in
the Gallery.

- To always save data in the same location, check Use as default app
and select a desired app.

Writing notes on screen using Dual Screen Capture+
T Pull down the status bar on the screen that you want, and tap 7,
Capture+.
+ The captured image appears as the memo desktop, and the memo
tool appears at the top of the screen.
7 Take notes freely on the captured image.
- Tap Z to make a note on the screen with handwriting.
- Tap T to enter text at the bottom of the screen.

3 To save the memo, tap @ and save it to the desired location.

+ You can save the memo using QuickMemo+ or save it in the
Gallery.

- If you enter text only, it is auto-saved by Qmemo+.

- To always save data in the same location, check Use as default app
and select a desired app.
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Dual Screen Tool

If you connect your mobile phone to the dual screen and turn on the dual
screen, the Dual screen tool &) appear on the mobile phone screen.

When you turn on the dual screen, you can see the Dual Screen Tool as
shown below.

You can tap it lightly to show or hide the Dual Screen Tool.

You can switch screens between the dual screen and the mobile
phone.

You can send the screen from the mobile phone to the dual screen.

You can bring the screen from the dual screen to the mobile phone.

If you use the dual screen only, you can lower the brightness level of
the mobile phone screen (main screen) to save battery. If you do not
want to use this function, swipe the main screen.

If you want the mobile phone and the dual screen to show the same
screen, you can use the Wide View.

® 6 06 06 606 06

You can turn off the dual screen by disconnecting the dual screen
and the mobile phone.

«— Dual Screen Tool
I_ Swap screens
— Show main on Dual Screen

28 *— Show Dual Screen on main

«— Turn off Dual Screen
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E + If you turn off your mobile phone, the dual screen also turns off.
However, if you turn off the dual screen, the mobile phone stays on.

« This feature is not available on the lock screen and is activated when
you unlock the screen.

+ The Wide View icon appears among the dual screen tools only when you
are running the Chrome app.

Using Extended view

You can extend the use of an app to the main screen and the dual screen
for convenience.

E - This function is also available in partner apps in addition to the Camera
and Gallery apps.

+ The Ul may differ depending on the app used.

Using Extended view in Camera app

You can shoot a photograph or video on the product or your mobile phone
and view the result on the dual screen on the other side.

7 Run Camera on the product or your mobile phone and shoot a
photograph or video.

7 After shooting a photograph or video, select Preview icon.

+ You can view the photograph or video you have taken on the dual
screen on the other side.
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Preview icon

5 + If you view a photograph or video by pressing the preview icon once, you
no longer have to press the icon to view the photographs or videos that
are shot on the dual view.

« This function does not remain active if you turn off the Camera app and
turn it on again.
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Using Extended view in Gallery app

Tap (g while running the Gallery app folder on the product or mobile
phone for enlarged viewing of the photo or video on the opposite screen.

T Run the Gallery app on the product or mobile phone.

2 Select the album folder and then tap [0

+ The photo or video will be displayed in an enlarged view on the
opposite screen.

+ Tap pJ(J to quit this function.

Extension icon
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Using My Pick App
Each time you turn on the dual screen, the preset dual screen apps run
automatically.

1 Select O > Settings > Display > Dual Screen > My Pick App.

2 Select the apps that will run automatically each time you turn on the
product screen.

+ Some apps cannot be run as dual screen apps.

« The list of apps that appear on the screen may differ depending on the
installed apps.

Using Dual Screen Wide view

When you are using the Chrome or Naver app, you can use the Wide View
to make the dual screen and the mobile phone screen to show the same
screen.

T While the mobile phone is connected to the dual screen, run the
Chrome app.

2 Among the dual screen tools, select Wide view @).

3 You can extend the screen horizontally or vertically.

E + When you use the Wide view, you can also extend the keyboard input
field to fit the horizontal or vertical mode.
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Moving between app screens on dual screen

You can swipe the screen with three fingers to move an app screen
between the product screen and the mobile phone.
- Swipe the app screen left or right with three fingers to move freely
between the main screen and the dual screen.

Swipe the app screen Move the app screen to the
with three fingers main screen

Swipe the app screen Move the app screen to the
with three fingers dual screen

E + To use this feature, three fingers must touch the screen at the same
time.
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Using Dual Keyboard on dual screen

In landscape mode, you can tap the dual keyboard button &3 to send the
keyboard to the opposite screen at the bottom.

You can expand the keyboard up and down to use the top screen as an
app screen and the bottom screen as a keyboard screen.

7 Switch the dual screen to landscape mode on the keyboard input
screen.
2 Tap 8in the keyboard input window of the dual screen.
+ You can check the keyboard input data on the dual screen and use
the input window on the product.
- Tap Bin the expanded state to return the bottom keyboard to its
original position.

Dual Keyboard

5 - To move the app screen up or down, touch the screen with three fingers
at the same time to move it up or down. See Moving between app
screens on dual screen for details.
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Using Triple Preview

You can simultaneously view three previews of the rear camera on the
dual screen.

1 Tap O > Camera.

2 Tap [0 on the top part of the camera screen.
+ The Triple Preview appear on the dual screen.

+ When you select the desired image from the Triple Preview screen, you
can see it on the main screen.
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Using Mirror Mode

When taking photos using the camera, you can preview the photos on the
dual screen.

1 Tap O > Camera.

2 Tap [0 on the top part of the camera screen.
+ The Mirror Mode appears on the dual screen.

Mirror Mode

E + You can also take pictures or videos directly from the dual screen.

Use the dual screen to adjust the angle for various situations as listed
below.

High angle image capturing: It is used when capturing an image of a lot
of people at a concert or festival or when capturing an image of a large
space.

+ Low angle image capturing: It is used when capturing an image of your
child at the child's eye level or when capturing an image of tall buildings,
etc.

AN

High angle shooting Low angle shooting
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Using Reflector Mode on dual screen
When shooting a selfie, you can use the dual screen as a reflector.
1 Tap O > Camera, and take a picture with the front camera.

2 Tap the Flash button at the upper right corner twice.
+ The dual screen illuminates the object brightly just like a reflector.

'; Reflector mode icon

WB adjustment bar — -

E + Move the WB adjustment bar to adjust the colour of the reflector.
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Using Instant Capture on dual screen
When the mobile phone is connected to the product, an Instant Capture
B9 function is provided in the LG Keyboard.
You can use the keyboard on the main screen, capture the screen on the
dual screen, and insert it directly into the keyboard input window.
Tap [ on the LG Keyboard input screen.

+ The screen on the dual screen is captured and automatically attached

to the keyboard input window.

— Instant Capture

Captured screen

E + You cannot use both screens as the keyboard input screen at the same
time.
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LG Game Pad

You can use virtual controllers on the product screen to play games on the
mobile phone. When playing the game, separate the main screen and the
dual screen so that the controller does not block the game screen.

1 Tap Q> Game Launcher and select LG Game Pad \&

-'i LG Game Pad

+ LG Game Pad appears on the product screen.

2 Tap @ and then swipe it left and right to select your preferred style of
LG Game Pad.
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You can play the game by holding the product as shown below.

E + The LG Game Pad is only available for games that support hardware
game pads.

+ Depending on the game, some apps or buttons may not support the LG
Game Pad.
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Trademarks

+ Copyright ©2020 LG Electronics, Inc. All rights reserved. LG and the
LG logo are registered trademarks of LG Group and its related entities.

+ Google, Google Maps, Gmail, YouTube, Google Duo, Google Play,
Android, Chrome, Google Photos, Google Play Protect, Google Calendar,
Google Docs, Google Drive, Google Sheets and other related marks and
logos are trademarks of Google LLC.

- All other trademarks and copyrights are the property of their
respective owners.

DECLARATION OF CONFORMITY

Hereby, LG Electronics declares that this LM-V505N product is in
compliance with the essential requirements and other relevant provisions
of Directive 2014/53/EU.

A copy of the Declaration of Conformity can be found at
http//wwwi.lg.com/global/declaration

Contact office for compliance of
this product

LG Electronics European Shared Service Center BV.
Krijgsman 1, 1186 DM Amstelveen, The Netherlands

AT |BE|BG|CH|CY|CZ|DE|DK|EE|EL|ES|FI |FR

QHR HU|IE [ IS|IT|L |LT|LU|LV|MT|NL|NO|PL

PT |RO|SE | SI'| SK|UK|AL |ME|RS |MK|TR|BA | XK
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More information

Precautions on product handling
+ This product cannot be used alone.

+ Do not use or charge the product when there is moisture in the
communication and power terminal of the product.

- This may cause fire, electric shock, injury, or device malfunction.

- If there is moisture, stop using the device immediately and remove
the moisture completely.

+ The liquid in your wet device, changes the colour of the product label
inside your device. Damage to your device as a result of exposure to
liquid is not covered under your warranty.

Tempered glass parts

Tempered glass parts of this device are not permanent and they may wear
out over time.

+ If you drop your device on a hard surface or subject it to severe impact,
the tempered glass may be damaged.

If this happens, stop using your device immediately and contact an LG
Customer Service Centre.

- You can purchase protective cases to protect your device from damage
on the market.

Note that these protective cases are not covered under the warranty
service provided by LG Electronics and safety is not guaranteed.

Using the battery
- This product does not use its own battery.

- If the product is mounted with a mobile phone, it uses the battery of
the mobile phone.
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Disposal of your old appliance

1. This crossed-out wheeled bin symbol indicates that waste electrical
and electronic products (WEEE) should be disposed of separately
from the municipal waste stream.

N 2 Old electrical products can contain hazardous substances so correct
disposal of your old appliance will help prevent potential negative
consequences for the environment and human health. Your old
appliance may contain reusable parts that could be used to repair
other products, and other valuable materials that can be recycled to
conserve limited resources.

3. You can take your appliance either to the shop where you purchased
the product, or contact your local government waste office for
details of your nearest authorised WEEE collection point. For
the most up to date information for your country please see
wwwi.lg.com/global/recycling
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